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Ignition User Manual
Welcome to the New Home for Ignition Documentation!

 

Welcome to Ignition by Inductive Automation, a true Industrial Application Platform. It is the next 
generation of accessible, scalable, and data-centric HMI/SCADA software. Ignition was designed from 
the ground up to be approachable and easy to get started with, but highly flexible and capable of scaling 
up to the largest projects.

In this manual, you will find reference information along with step-by-step instructions. The final goal of 
the content and information provided here is to help you gain understanding in regards to Ignition 
concepts and accomplish tasks within Ignition so that you can be productive and effective while working 
on your own projects.

The table of content is organized so you can easily find answers to your questions on all the Ignition features, modules, and scripting functions. The 
Feature section is closely tied with the Inductive University so you can have conceptual understanding from this manual and a visual fast walk-through 
of the feature in the videos. The Modules section provides information relating to each Module. And finally, in the Appendix, you can easily search to 
find the specific function you are looking for.

Some of the things you will learn in this manual are: how to install the software, connect to PLCs and databases, create your own projects, create 
tags, launch clients, set alarms, and generate reports.

Let's !get started

 

 

Answers to your Technical Questions

Inductive University

Inductive University, offered by Inductive 
Automation® SCADA software, is a free 
online learning platform designed to help 
you master Ignition. You can watch over 
500 training videos, test your knowledge, 
and participate in our new credential 
program.

Note the main section of this User Manual 
is organized in a way to match the Courses
in the Inductive University. When you need 
information on any given feature, you can 
read about the feature here in the User 
Manual, then go to the same section in the 
Inductive University Library course list to 
watch the related video.

When there is a corresponding video for a 
feature description, you will see a video link 
as follows:
  

Ignition Video

Watch the Video

Support Team

Support homepage, for one-on-one help 
from our support team, go to the Support 

 and submit a Ticket. One of homepage
our Support Engineers will follow up with 
you quickly.

You can reach us during business hours 
8am-5pm PST at 1-800-266-7798. Support 
charges may apply. 24-hour support is also 
available, at an additional fee.

E-mail support is available at support@indu
.ctiveautomation.com

https://inductiveuniversity.com/
https://www.inductiveuniversity.com/7.8
https://support.inductiveautomation.com/
mailto:support@inductiveautomation.com
mailto:support@inductiveautomation.com


Online Help

You can access this Online Help from the 
Ignition Gateway and the Designer. To 
access online Help from the Gateway 
Webpage, log into the Configure section 

and select System > User Manual. To 
access it from the Designer, click the F1 

key or select Help > Help from the 
menubar.

Other Resources

Ignition How-Tos
White Papers and Articles
Webinars on Demand
Tip Sheets

Blogs

Steve Hechtman's Blog, Inductive 
Automation President

Travis Cox's Blog, Inductive Automation 
Director of Sales Engineering

Third-Party Tutorials

Technical Resources, for some additional 
such as links to sites that information 

contain information about standards, SQL 
tutorials, and more.

These site are not affiliated with Inductive 
Automation but we feel they offer excellent 
advice and information.

 

 

Knowledge Base

Knowledge Base, search and view all the ar
ticles for troubleshooting, known problems, 
and workarounds.

Community User Forum

Forum, get help from our passionate 
community of Ignition users.

The User Forum is one of the most 
effective ways to get help. The forum is 
always available, and is actively patrolled 
by Inductive Automation staff and many 
knowledgeable users. Chances are you will 
find your question already answered in an 
existing post, but if not you can be assured 
that yours will receive a quick reply.

 

Comments, Feedbacks, or Ideas?

We encourage your feedback on both the Ignition Software and Ignition User Manual.

Feedback on the User 
Manual
We encourage you to give us feedback on 
the Ignition wiki User Manual as this will 
help us improve the documentation over 
time. Your feedback can be as small as 
finding typos or requesting new information 
on some concepts or how to do 
something. Now writing Comments and 
giving feedback is easy! Just use the 
comment box at the bottom of each page. 
You can use the keyboard shortcut   to m
jump to the comment box.

Write Comments for the 
User Community
The comment area at the bottom of each 
page is mainly for our user community to 
share and post their questions, answers, 
tips, and comments related to the 
information on that specific page. The 
comments are not monitored by Inductive 
Automation technical writer or Support 
team. Therefore, if you have a question 
that needs an immediate answer, please 
contact us via the Support homepage.

 

 

Give us your ideas on the 
Ignition Software
How can we improve Ignition? Our goal is 
to provide you a powerful yet easy-to-use 
SCADA/HMI software. Let us hear from 
you on new  you have features and ideas
so we can continue to improve Ignition.
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Ignition By Feature
 

This  section shows all of the documentation for Ignition in a format that is listed by Ignition Manual
feature or section of the platform. It provides reference and concept information along with step-by-step 
instructions on how to do just about everything in Ignition.

 

This section is organized in a similar structure as the Inductive University. In this way, you can have a 
conceptual understanding from the information provided here, and a fast visual walk-through of the 
feature by watching the videos. When you need information on any given feature, find and read about the 
feature here in the User Manual, then go to the Inductive University Library to see it in action. On those 
pages you will see a link in the upper right corner that looks like this ->  Video Name

Watch the Video

 

 

New to Ignition?

Lets get started by getting Ignition running on 
your computer!

Our free trial lets you evaluate the full version 
of the software 
without requiring any license.

Download and Install Ignition

On Windows
On Linux
On Mac OS X

The Basics in Ignition

Read these topics and watch the Quick Tour...

What is Ignition?
Quick Tour
Architecture and Modules

 

   

A Simple Workflow in Ignition

Follow a step-by-step walk-through...

To get started with Ignition, its helps to have a general idea about the major steps involved in designing your SCADA/HMI projects. Although, there 
are many creative and innovative ways of using Ignition to do almost anything you want, but most users will go through the steps provided here.

 

https://www.inductiveuniversity.com/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Installing+Ignition+on+Mac+OS+X+-+ZIP+file
https://inductiveautomation.com/scada-software/


Launching the Gateway

 

The Ignition Gateway is a web server. When it is running, you access it through a web browser. For example, if you are logged into the computer 
that you installed Ignition on, open up a web browser and go to the address:
http://localhost:8088

and it will launch Gateway and bring up the Gateway Homepage as pictured here.

The first time you go to the Gateway Homepage, it shows you 5 common steps to help you get started. You can follow along with these steps and
/or with the step-by-step walk through shown on this page, follow the same basic workflow.

Connecting to a Device

See the following links for the device connection you are interested in:

Allen Bradley Ethernet
Modbus
Siemens
UDP and TCP Driver
Third Party OPC Servers

http://localhost:8088/


1.  

2.  

3.  

1.  

2.  

3.  

Connecting to a Database

After you , you can connect it to Ignition. To get detailed descriptions for a number of different database connections, see install your database Conn
. The common steps in connecting to all databases is as follows:ecting to Database

Add a Database Connection
Once you are in the Gateway   section of the Gateway's web interface, use the menu on the left to go to the Configure Databases > 

 section. On at the   page, click on the   link at the bottom of the Connections Database Connections Create new Database Connection...
table.

Pick a JDBC Driver
Ignition connects to databases using JDBC drivers that are unique to each database. Drivers for the most popular databases are included 
so there is usually no need to install the JDBC driver manually. 
Ignition ships with drivers for Microsoft SQL Server, MySQL, Oracle, and PostgreSQL. Pick the JDBC driver for your database, and click 
on the   button. Next
If a suitable driver is not available in the list, you need to add a new JDBC driver for other databases, like IBM DB2, which is not very 
difficult to do, see  .Adding a JDBC Driver
 
Configure the Connection
After selecting the driver, you'll configure the settings for the connection. Some settings, such as the Connect URL are specific to the 
driver that you're using.

Launching the Designer

Click   on the upper-right of any Gateway page.Launch Designer

Your web browser asks you if you want to Keep or Discard a  file.designer.jnlp
 
Click on the   file to start the Designer.designer.jnlp
 The Designer starts up and the login window is displayed.

Enter the default username and password for the Designer.  is the same as for the Gateway Configuration section, enter
Username: admin
Password: password

Note: 
The default   is set in the   section, under  , and going to the   link for the Username Configure Security > Users, Roles manage users User 

named  . Additionally this  must be one of the roles defined in the   section, under Source default Username  Configure Configuration > 
, inGateway Settings  Designer Role(s).



4.  

5.  

Click on  .Login
The   window is displayed giving you two options, to create a new project or open an existing one. As we don't have Open/Create Project
any existing projects yet, we will create a new project. 

In  , enter a name for your new project (no spaces!).Project Name



6.  For  , select a template from the drop-down list, for example, you can select the   template.Project Template   Single-Tier Nav, West & North

Rather than starting from a blank project, the templates let you start from one of the eight skeleton projects that already have navigation 
windows setup. These projects are completely customizable and are designed to help you get started faster.



7.  Click on  .Create New Project
The Designer is now launched and you can work on your project!

Once in the Designer, your can create or open a project using the Designer's  menu. The   window is File > Open Open/Create Project
displayed and you can follow the same steps as above to open existing projects or create a new one.

 

 



1.  

2.  

Creating Tags

Now that you are in the Designer, a good first step is to create some Tags. You'll use these tags for realtime status and control and to store history 
with the Tags Historian. Tags are all configured in the Tag Browser panel.

To create tags by dragging them from OPC

If you have created  a device in the earlier step, the easiest way to create some Tags is by dragging the tags from the OPC Browser.

In the  , select the   folder and click the   icon.Tag Browser Tags Browse OPC Servers

 

The OPC Browser is displayed and you can browse all of your OPC connections.

By default, you've got a connection to the internal  , which has the devices in it you created earlier. Browse the Ignition OPC-UA Server
devices and find some tags that you're interested in.
 
From the  , highlight the tags (for example, as in the picture below, folders inside the   folder) and drag them to the   OPC Browser Sine Tags
folder in the  .Tag Browser

 

You can drag individual tags or folders. When you drag folders, Ignition keeps the same hierarchy as the PLC. As soon as you drag the 
tags into Tag Browser, you can see their values being updated in the Tag Browser, 

That's it! You now have some Tags. You can see their values come in and start updating automatically. By default, they update at a rate 
of 1 per second.



1.  

2.  

3.  

4.  

5.  

6.  

7.  

1.  

Launching a Client

Now that we've  , lets launch a Client to see it in action.created a project

From the Designer toolbar, select   to save your project.File > Save and Publish
 
Go back to the Gateway   page.Home
Your project will appear in the   panel with a big   button to its right.Launch Projects Launch
 
Click on the   button to start up a Client.Launch
 
Login to the Client using
Username: admin
Password: password

By default, a new project uses the same   as the Gateway, so the  credentials will work.user source /admin password 
 
After you logged in, you can see your Client window displaying your project. 
 
Go back into the Designer, make a change to the window, and click  . File > Save and Publish
Your Client will show a notification saying that there are updates to the project. 
 
Click on the notification and the Client will update itself.
 

 

Adding History to Tags

Do the following steps to log history data for your tags:

Go to the Designer, from  , select one or more tags.Tag Browser
For example, select all the   tags in the Sine folder.Sine
 

You can launch as many Clients as you want! If you've got other computers on the same network as the Gateway 

computer try launching on them too. Make sure that your Gateway computer doesn't have a Firewall enabled, otherwise, 

it is allowing traffic on port 8088 - the default port for the Ignition web server.

https://legacy-docs.inductiveautomation.com/display/DOC/Designer+Basics#DesignerBasics-CreatingaProject


2.  

3.  

4.  

5.  

6.  

Right-click on the selected tags, and then select  .Edit tag(s)
The Tag Editor window is displayed. Here, you can edit the tag and change the name, data type, scaling options, metadata, permissions, 
history, and alarming.

 
Click on   on the left side of  .History Tag Editor
 
Click   for  .Yes Store history for this tag
 
Choose a database from the   dropdown.History Provider
For example, choose   as the database you want to log to. mysql
 
Choose   for  .Default Historical Scanclass
This sets the rate at which data is logged. The default is set to 1 second which means data is logged every second.

 



7.  Click  .OK
Now look in the  , to the right of each   tag that is storing history, an icon appears letting you know it is setup.Tag Browser Sine

If you were to look in your database, you can see all the tables and data Ignition has created for you.

Creating a Tag History Graph

You can see the tag history data, by creating a graph. Your graph can include subplots, axes, and a moving average pen. You can view the 
runtime data in realtime or historical mode.

To create a tag history graph



1.  

2.  

3.  

Open your Main Window, from the Charts tab of the Component Palette, drag in the Easy Chart component.

We can add the tags to the graph the same way we created the status and control windows, that is, through drag and drop.
 
Drag all the Sine tags from Tags Browser to the graph.

 
The tags are displayed on your Main Window but because you have just started logging data, not much data will show up.
 
To show more data, set the Chart Mode property of Easy Chart to Realtime.



   

In this section ...

 



Getting Started
   

Ignition, a powerful HMI/SCADA/MES software, uses web technology, databases, and OPC-UA to offer a wide variety of configurations based on the 
customer’s system and plant needs.

 

 

In this section ...  



Introducing Ignition
 

This section introduces you to Ignition and fully explains what it can do, what its basic work flow is, its modular architecture, and its the different 
modules are for your use.

   

   

In this section ...

 

 

 

 

 

 



What is Ignition?
   

Ignition is a software platform for creating custom human machine interface (HMI), supervisory control 
and data acquisition (SCADA), and manufacturing execution system (MES) applications.

Ignition, designed from ground up, is approachable and easy to get started with while it is flexible and 
capable of scaling up to the largest projects.

Ignition is installed as server software and it is:

Web-based
Ignition is installed and deployed using web technologies.

Web-managed
Ignition's platform is managed using web.

Web-launched Designer and Clients
Ignition's Designer tool and network clients are launched using web.

On this page...

What Can Ignition Do?
What makes Ignition Special?
Ignition as a Communication Hub
Next ...

What is Ignition?

Watch the Video

What Can Ignition Do?  

Ignition's unified architecture provides the following functionalities:

Web-based HMI and SCADA applications deployment
Using web technologies, you can access PLCs and connect to SQL databases on any platform. Ignition provides the common HMI/SCADA 
capabilities, but in a lot better way!

 

https://www.inductiveuniversity.com/video/what-is-ignition/7.8


High performance historian
You can use any SQL database with Ignition’s high-performance historian. The Historian includes compression algorithms.

Reporting Engine
You can create dynamic PDF reports using the reporting engine.

Database applications
You can build database applications using Ignition. You can create POS, CRM, and inventory tracking systems. You can bring in data from 
any SQL database in your plant. And you can convert Microsoft Access programs to Ignition allowing multiple people to view the data.

 



Alarming
You can use Ignition’s state-of-the-art alarming engine to send out notifications via voice, SMS, or email.

 

 

MES applications
You can host a variety of MES applications including OEE/Downtime, SPC (quality control), Recipe Management, Instrument Interface, and 
Track & Trace.

 

Mix and match
You can mix and match all of these features in any way you want!

   

What makes Ignition Special?
Here are the key points that set Ignition apart from other HMI/SCADA software.

 



 

1. Hassle-free Licensing

Ignition is sold by server license and you can add unlimited number of clients, screens, tags, connections, and devices.

2. Easy Installation & Deployment

You can install Ignition in less than 3 minutes on any operating system (Windows, Mac, Linux), all you need is a web browser and Java.

 



 

3. Rapid design & development environment

You can use the built-in scripting engine, customize projects, and integrate business processes.

4. Flexible & scalable modular software platform

You can add any HMI, SCADA, MES module to your system and they work seamlessly together from the same platform.

5. Easy to get going

Once you connect to a device and some SQL tags, you are ready to start
creating your first project and to launch your clients.

 

Ignition as a Communication Hub
You can use Ignition as an effective communication hub in your network. This central location is possible because of the following features in Ignition:

OPC-based and communicates with virtually any OPC server
SQL-based (JDBC) and connects to any number of Databases
Built-in PLC drives and connects to any PLC (Allen-Bradley, Siemens, Modbus) through OPC
Supports any web services and Launches anywhere
Connects with other enterprise systems (ERP)
Connects to devices such as barcode scanners, scales, and sensors
Runs on any computer regardless of operating system (OS)
Connects to any mobile device such as wireless smartphones and tablets
Connects to any touch panel screen

 



 

 

Next ...

Quick Tour
Understanding Ignition's Basic Flow

 

   

https://inductiveautomation.com/scada-software/
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Understanding Ignition's Basic Flow
 

Ignition is installed as server software and it is web-based. The basic flow in Ignition is easy, first you 
launch the Designer from the Gateway webpage, then you configure your project in the Designer and 
save it back to the Gateway/Server. Once the project is saved on the server, you will then launch the 
Client, there are no limits to the number of Clients you can launch. When a change is made and saved in 
the Designer, the Clients are all automatically updated.

 

 
Understanding 
Ignition's Basic 
Flow

Watch the Video

   

   

Next ...

About Ignition's Modular Architecture
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About Ignition's Modular Architecture
   

Ignition platform has a modular architecture. Modules are software applications that are built and 
integrated into the platform to offer additional functionality. The modules are similar to applications for a 
smartphone in how they are seamlessly integrated providing additional capabilities.

Most of the main features of Ignition are actually provided by different modules such as the Vision and 
SQL Bridge modules. 

Ignition Software Stack

Looking at the Ignition software stack below, you can see that the HMI/SCADA/MES module layers are 
built on the Ignition platform. 

Here are the different software layers in the Ignitions modular architecture:

OS Layer – the Operating System Layer
Provides basic computing resources such as the file system and access to the network.

VM Layer – the Java Virtual Machine Layer

Ignition is built on Java and so it runs the same on any operating 
system.

Platform Layer
Provides all the basic functionalities such as connecting to devices and databases, licensing, 
launching clients, managing all Ignition modules over the web, and more.

HMI/SCADA Module Layer
Provides the core modules that enable real-time and historical data access, trends, and control.

MES Module Layer

Seamlessly integrates OEE, Downtime, Track & Trace, and other 
modules.

 

About Ignition's 
Modular 
Architecture

Watch the Video

Steve Hechtman Blog

Click the link below to see the blog:

Why your SCADA system should be 
more like your smart phone

 

 

   

   

Next ...

About Ignition's Modules
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About Ignition's Modules
What are Modules?

Modules are applications that are built on the Ignition platform, they are similar to applications for a 
smartphone. The modules are seamlessly integrated onto Ignition's architecture providing you the 
flexibility to choose them based on your system and plant requirements.

HMI/SCADA Modules

The following are some of Ignition's modules. They provide the core functionalities for building your HMI 
and SCADA system:

OPC-UA Module
Lets you connect to PLCs via OPC-UA.
 
SQL Bridge Module
Lets you track and log historical data.
 
Vision Module
Lets you view real-time data via charts, graphs, and more. 
 
Reporting Module
Lets you build dynamic PDF reports.
 
Mobile Module
Lets you access your entire Ignition system via mobile.
 
Alarm Notification Module
Lets you configure how, why, and when to send alarm notifications.
 
Voice Notification Module
Lets you use phone call alarm notifications.
 
SMS Notification Module
Lets you use text message alarm notifications.

About Ignition's 
Modules

Watch the Video

MES Modules
The following Ignition modules provide the functionalities for supervising and tracking work on the plant floor:

Downtime OEE Module
Lets you improve overall equipment effectiveness (OEE) and offers plug-and-play downtime tracking and analysis.

SPC Module
Lets you add statistical process control (SPC) charting capabilities.

Recipe and Changeover Module
Lets you build, manage, and monitor recipes.

Instrument Interface Module
Lets you capture and process data from instruments and devices.

Track and Trace Module
Lets you see the entire manufacturing process in one unified interface.

For more information on the MES modules, see the  of the documentation.MES Module section

https://www.inductiveuniversity.com/video/about-ignitions-modules/7.8
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Ignition's System Architectures
 

Ignition being a modern software and system, it combines web servers, databases, and OPC-UA. This combination allows a wide variety of 
powerful configurations based on the customer’s system and plant needs.

 

 

In this section ...  

   



Standard Architecture
   

This standard server-based architecture provides you a scalable and centrally managed SCADA system 
with unlimited connections to PLCs, SQL databases, and web-launched clients. You can pick and choose 
any modules, such as the Vision, SQL Bridge, Reporting, Symbol Factory, and Alarm Notification 
modules.

Standard 
Architecture

Watch the Video
 

 

 

 

 

   

   

Next ...

Standard Architecture - Multiple Sites
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Standard Architecture - Multiple Sites
   

Using the Standard Architecture you can have a single-server at the central site with connection to PLCs 
and clients at a number of other sites. Therefore, you have access to all PLC and runtime data from all 
sites connected to the central Ignition server. The one drawback with this architecture is that if you loose 
connection to a remote site, all data from that site is lost.

 

Standard 
Architecture – 
Multiple Sites

Watch the Video
 

 

 

 

   

   

Next ...

Hub and Spoke - Reliable Remote Data Logging
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Wide Area SCADA
   

The problem of loosing data at the remote sites when there is only one Ignition server at the central site 
is handled by using the Wide Area SCADA architecture. In this architecture, independent Ignition 
Gateways, for example  are installed in each facility to provide local control and SCADA The Works
functionality. Corporate wide area network (WAN) plus client re-targeting provides a secure and 
seamless access across multiple facilities. Re-targeting allows you to switch from one project on one 
Ignition server to another project on a different Ignition server.

When The Works is installed in each facility, the following modules are available at each independent 
location: the SQL Bridge, Vision, Reporting, Alarm Notification, and Symbol Factory, plus a license for 
unlimited clients and tags. Of course you can pick and choose which modules you want at each site 
depending on the needs of that particular site.

 

Wide Area SCADA

Watch the Video

 

 

Next ...

Wide Area SCADA - Central Database
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Wide Area SCADA - Central Database
   

Multiple independent Ignition Gateways hosted at different locations and connected by wide area network 
(WAN) allow you can log data both locally and centrally into one database. The  modTag History Splitter
ule allows you to login to two places at the same time so you can have access to the data at the other 
sites and log all the data to the central database.

 

Wide Area SCADA 
– Central Database

Watch the Video
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Hub and Spoke - Reliable Remote Date Logging
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Hub and Spoke - Reliable Remote Data Logging
   

Because connections between a database and remote PLCs are usually unreliable, with the hub and 
spoke architecture, the  module in Ignition is installed on embedded data logging computers. SQL Bridge
This module uses the store-and-forward technique to ensure that data is never lost. The system may still 
be accessed through the  , or database-based tags may be used to OPC-UA stand alone architecture
communicate current status. By doing this, it is possible to use Tag Historian and Alarming, both of which 
utilize the store-and-forward system to avoid data loss. This method is ideal for historical data.

Hub and Spoke 
Architecture – 
Reliable Remote 
Data Logging

Watch the Video
 

 

 

 

   

   

Next ...

Hub and Spoke - Local and Remote Logging
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Hub and Spoke - Local and Remote Logging
   

 Combining the Hub and Spoke architecture with the Tag History Splitter module allows you to 
simultaneously log data locally and remotely for redundant data. The one problem here is that if the 
connection between the central and remote site is lost, the clients at the remote site will loose access to 
the central server, but data is not lost as there are remote and central databases.

Hub and Spoke – 
Local and Remote 
Logging

Watch the Video
 

 

 

 

 

   

   

Next ...

Hub and Spoke - With Vision Module
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Hub and Spoke - With Vision Module
   

Typically the Hub and Spoke architecture doesn't include the  Module at the remote sites. You can Vision
add the Vision Module in local client fallbacks to each remote site so that you can keep the project visible 
when you lose communication to the hub.  licenses help lower costs on remote machines.Vision Limited

    

Hub and Spoke – 
With Vision Module

Watch the Video
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Hub and Spoke - With Alarming
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Hub and Spoke - With Alarming
   

In addition to the Vision module, you can add other modules to the remote sites. For example, by adding 
the  Module to a remote site, you can add alarming capabilities to that location. It is best to Alarming
handle alarms at each remote site rather than centrally to avoid any problems in case the connection to 
the central location is lost.

Hub and Spoke – 
With Alarming

Watch the Video
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Hosted Ignition Server
   

Ignition server can be hosted in the Cloud. Cloud providers are: Amazon EC2, Windows Azure, or 
Rackspace. You can have two Ignition servers with redundancy plus the central database in the Cloud. 
The server can connect to the PLCs at the remote or customer sites via Round Robin Poll, Cell Tower, 
Satellite, or Secure VPN. The clients are connected to the Ignition server via Internet.

Hosted Ignition 
Server

Watch the Video
 

 

 

 

 

   

   

Next ...

Mission Critical - Gateway Redundancy
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Mission Critical - Gateway Redundancy
   

Using redundancy, two Ignition installations can be linked together so that when the master fails, the 
backup takes over and continues executing. All of the clients connected are redirected to the backup 
machine, and historical data continues to log.

 

Mission Critical 
Architecture – 
Gateway 
Redundancy

Watch the Video
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Bridging Corporate and Control Networks
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Bridging Corporate and Control Networks
 

The Ignition Gateway supports dual-NIC servers, and can act as a bridge between multiple networks. 
Since clients talk to databases and PLCs through the Gateway, clients can be launched from both a 
corporate network and an isolated control network and provide full access to both.

Network security and easy access without compromise
 

Bridging Corporate 
and Control 
Networks

Watch the Video
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OPC-UA Stand Alone Architecture
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OPC-UA Stand Alone Architecture
   

OPC-UA is a network-based specification, and is ideal for collecting data from remote locations. Ignition 
can operate as an OPC I/O server with just the OPC-UA Module and UA drivers installed. Other OPC-UA 
client software can then access the PLC data through Ignition.

This method only exposes data, however, and the Client must then record it if historical data is desired. If 
the connection goes down, data will not be available. This method offers the lowest cost, and is suited for 
situations where the data is not highly critical or historical, for example, remote realtime monitoring.

OPC-UA Licenses are Free OPC-UA Stand 
Alone Architecture

Watch the Video
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Installing and Upgrading Ignition
Installing Ignition

You can download and install Ignition in just a few minutes! It's very simple:

Download Ignition from your web browser
Run the installer on any any Windows, Mac, or Linux operating system that can run Java 8
The Gateway Webpage opens automatically after the installer finishes so you can get started immediately!

See the links shown below for detailed installation instructions on Windows, Linux, and Mac OS X operating systems.

Upgrading Ignition

The Ignition installer also doubles as an upgrader. Simply download the executable installer from our website for your operating system.
See the links below for upgrading instructions specific to Windows, Linux, and Mac OS X operating systems.

Regardless of which Operating System you are using, upgrading has a simple set of steps:

Download Ignition from your web browser
Run the installer on the computer that has an older version of Ignition (don't forget to backup you work)
The installer automatically upgrades all of your projects and opens the Gateway Webpage!

For a complete guide to protect your projects when upgrading, see the  page.Best Practices when Upgrading
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Installing Ignition on Windows
   

Before you install Ignition, make sure you meet the minimum system requirements:

Java 8+ (server), Java 6+ (client)
Dual-Core Processor (32 or 64 bit)
4GB RAM
10GB free HD space

Also, ensure you have Administrator privileges to run the Ignition installer.

To download and install Ignition on Windows

Go to the Inductive Automation website at
www.inductiveautomation.com 
 
Select Download > Current Release.

 
On the Ignition Downloads page, scroll down to  and select the System Installers ignition-X.X.

 installer.X-windows-x64-installer.exe
If your computer runs on a 32-bit Windows, click the ignition-X.X.X-windows-32-installer.exe 
installer.

 An error window is displayed if you try to install 64-bit Ignition on a 32-bit Windows Note:
system. You are allowed to install 32-bit Ignition on a 64-bit system (however, this is not 
recommended).

After the installer downloads, click on the  executable file to start installation..exe
The Setup window welcomes you to the Ignition Setup Wizard.

Click .Next
 
Click the  button and click .I accept the agreement Next

On this page ...

Automated Installation on 
Windows
Uninstalling Ignition on Windows
Next ...

Installing Ignition 
on Windows

Watch the Video
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6.  

7.  

8.  

9.  

The Installation Directory window is displayed. By default, Ignition is installed under your 
Program Files directory. This is usually a good choice.
 
Make a note of the default installation directory, ,Program Files/Inductive Automation/Ignition
accept the default Installation Directory, and click .Next

The  window is displayed. Installation Mode
 
Select either the  or  mode. Typical Custom
The  installation includes Ignition with all of the HMI/SCADA modules. The only modules Typical
that are not installed by default are the MES modules.
The  installation lets you control and individually select the modules that you want Custom
installed.

Click .Next
The Setup window is displayed. 
If you selected  mode, in the Setup window you can select the check box next to the Custom
modules you want to install as part of the Ignition installation. To see a brief description of the 
module, click on the module name.



9.  

10.  

11.  

Setup Wizard shows Ignition is now ready to install.
If you decide to change your selections, click  to go back and make your changes.Back
 
Click Next.
 
After Setup Wizard shows Ignition installation is finished, make sure that the check box for Start 

 is selected, then click .Ignition now Finish

A splash screen informs you that Ignition is starting. This may take a few minutes to finish.

That’s it! Ignition Installation is complete and the Gateway is then launched.

Your web browser opens the Gateway home page at 
http: //localhost:8088



11.  

1.  

Ignition installs itself as a Window Service (Start > Control Panel > Administrative Tools > 
), so it starts automatically when your computer starts up.Services > Ignition Gateway

   

Automated Installation on Windows
You can automate Ignition installation across different machines using scripts. Ignition is then installed silently from a command shell without showing 
any user prompts. 

Keep in mind that the installer cannot automatically start the Gateway after a silent installation. You can use the following command to start the 
Gateway:
net start ignition
 

Command line example:

Ignition-7.x.x-windows-x64-installer.exe --mode unattended --prefix "C:\some folder" --unattendedmodeui none

net start ignition

Flags:

-- mode unattended (ensures that no prompts appear during installation)
 (optional flag; if a value is set, then Ignition is installed in the specified folder, otherwise Ignition is installed in a -- prefix "C:\some folder"

default location under C:\Program Files)
 (the  flag does not display any sort of graphic during installation; the  flag displays a -- unattendedmodeui none | minimal none minimal

small progress bar and nothing else)

   

Uninstalling Ignition on Windows

Before you uninstall Ignition...

Be sure to back up your Gateway and unactivate your Gateway license.

 

During a new Ignition installation, an uninstaller executable is created.

When Ignition is uninstalled, the settings database and folder in   is backed up to , and modules and user-supplied /data  /data_<current date>
JDBC jars in  are backed up to . Also, the Ignition service is removed from Windows installations /user-lib  /user-lib_<current date>
automatically. 

To run the uninstaller for Windows,

Open the Start menu and navigate to All Programs > Inductive Automation  .> Ignition
 



2.  Select .Uninstall Ignition
The uninstaller wizard guides you through the uninstallation process.

You can also uninstall Ignition from the Windows  section.Control Panel > Programs and Features

   

   

Next ...

Activating Over Internet
Activating Manually
Upgrading Ignition on Windows
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Upgrading Ignition on Windows
   

Before you upgrade Ignition...

You should backup your Gateway, see .Making Gateway Backups

The Ignition installer also doubles as an upgrader, thus upgrading Ignition is very similar to downloading 

a new version and installing from scratch. You can see  by looking in the your current Ignition version Stat
 page of the Gateway.us

To upgrade Ignition on Windows

Simply download the Windows executable installer from our website, and double-click on the 
executable installer.
A window is displayed asking you Continue with upgrade?

 Make sure you download the 32-bit installer for a 32-bit Windows installation, and the 64-Note:
bit installer for a 64-bit Windows installation. If you attempt to upgrade a 32-bit installation with a 
64-bit installer, or vice versa, you will get an error message.
 
Click  to start the upgrade process.Yes
 
 Accept the license agreement.
The  window is displayed.Upgrade Mode

You choose either:
No, just upgrade currently installed modules
The Ignition base installation and the existing modules are upgraded.
 
Or you can choose:
Yes, let me choose which modules to add or remove
The Select Components window is displayed and you can then add a module that was not part 
of the original installation or uninstall/remove a currently installed module. 
You can view a brief description of each module by clicking on the module name.

 next to a module, installs the module as part of the upgrade. Selecting the check box

Clearing the   next to a module, uninstalls the module check box
during the upgrade.
 
Click .Next
The  window is displayed. Ready to Install
Ignition is ready to be upgraded. At this point, you may click  to change your selections.Back

Click   button to finish the upgrade.Next
Once the upgrade process starts, it may take a few minutes to finish. At the end of the 
upgrade process, the Setup window is displayed letting you know that Setup has finished 

.installing Ignition on your computer

Select the check box for  and click Start Ignition now Finish.
A splash screen displays informing you that the Ignition service is starting. Once the Ignition 
Gateway starts up, your web browser opens and brings you to the Gateway Homepage. 

You can go back and check the  page of the Gateway to see that a new version of Status
Ignition is now installed.

Upgrading Ignition 
on Windows

Watch the Video

Tip Sheet

Upgrading from 7.6 or earlier?

Please read this upgrade guide: Igniti
on 7.7 Upgrade Guide 

 

 

 

 

 

   

Automated Upgrading
You can silently upgrade Ignition from a command shell without showing any user prompts. Remember to make a Gateway backup before performing 
any type of upgrade. Also, the installer cannot automatically start the Gateway after a silent upgrade.

Use the net start ignition command as shown below.

 
Command line example:

gwcmd -b C:\backups\mybackup.gwbk

https://www.inductiveuniversity.com/video/upgrading-ignition-on-windows/7.8
https://s3.amazonaws.com/files.inductiveautomation.com/guides/Upgrade_Guide.pdf
https://s3.amazonaws.com/files.inductiveautomation.com/guides/Upgrade_Guide.pdf


Ignition-7.x.x-windows-x64-installer.exe --mode unattended --unattendedmodeue none --autoupgrade true 

net start ignition

Flags: 

  (ensures that no prompts appear during installation)-- mode unattended
 (the  flag does not display any sort of graphic -- unattendedmodeui none | minimal none during installation; the  flag displays a minimal

small progress bar and nothing else)
 (-- autoupgrade true disables any  prompts when running the upgrader so that a user can run an automated upgrade without Are you sure?

any user interaction)

 

   

Next ...

add the link here
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Installing Ignition on Linux
   

Before you install Ignition, make sure you meet the minimum system requirements:

Java 8+ (server), Java 6+ (client)
Dual-Core Processor (32 or 64 bit)
4GB RAM
10GB free HD space

Also, it is assumed that you are familiar with operating a shell, and you have  or  root superuser
privileges to run the Ignition installer.

To download and install Ignition on Linux

Go to the Inductive Automation website at
www.inductiveautomation.com
 
Select  .Download > Current Release
 
On the Ignition Downloads page, scroll down to System Installers and select the 

 installer. ignition-X.X.X-linux-x64-installer.run
If your computer runs on a 32- bit Linux, select the ignition-X.X.Xlinux-32-installer.run.

 If you choose the wrong installer, an Error window is displayed letting you know the Note:
correct installer to use for your machine.
The installers can run in both graphical or command-line mode, allowing Ignition to install on a 
headless Linux server. The installer will install files in the following locations:

/usr/local/bin/ignition
(unless a different installation directory was used) – contains binaries, startup scripts and the 
uninstall executable

/var/lib/ignition/data
contains application-generated files, temporary files and the internal database

/var/lib/ignition/user-lib
contains modules and JDBC jars

/var/log/ignition
contains the wrapper.log and other log files

/etc/ignition
contains configuration files. Symbolic links to these files are created in

/var/lib/ignition/data
 
You must run all the commands as root. Prefix everything with  or first run sudo
sudo su
 
If Java 8 is not already installed, run the following commands to install it: 
sudo add-apt-repository ppa:webupd8team/java
sudo apt-get update
sudo apt-get install oracle-java8-installer

On this page ...

Automated Installation on Linux
Installing using Debian Package 
Management
Uninstalling Ignition on Linux
Next ...

Installing Ignition 
on Linux

Watch the Video
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Open a command shell and navigate to the installer executable, by running the following 
command from the command line:
sudo chmod +x ignition-x.x.x-linux-xxxinstaller.run

Start the installer executable.
The installer can run in a  mode or  mode.graphical command line
If you are running the installer in a shell in a graphical environment, the graphical installer opens 
automatically.
If you are running the installer in a headless Linux installation or through an SSH shell, the text 
installer opens automatically.
To start the text installer in a graphical environment, run the following command:
sudo ./ignition-X.X.X-linux-xxx-installer.run -- mode text

The installer starts running.

Agree to the licensing terms.

Ensure the installation directory is the default directory at:
/user/local/bin/ignition

Specify the user name under which Ignition is to be installed. For Ubuntu installations, the user 
that invoked sudo is used by default. For other Linux installations, this field is initially blank.

The Linux installer requires a user name to set the permissions on the folders created by the 
installer. This user is then able to start and stop Ignition, run the Gateway Control Utility, and the 
command line interfaces.

The binaries in the installation folder are still owned by root and cannot be modified without root 
access. The selected user must already exist on the system before starting the installer.



10.  

11.  

Normally, the installer is capable of auto-detecting a Java 8 installation that has been installed 
through APT or some other Linux package management tool. In these cases, the installer uses 
that Java installation and skips this step.

However, if you have installed Java by extracting the Java binaries to a folder and adding them 
to the system PATH, the installer is unable to find the Java binaries. You must provide the 
installer with a full path to the Java executable.

If the Java Installation window is displayed, type the full path to the Java executable.



11.  

12.  Select either the  or the  installation mode.Typical Custom

The  mode installs everything that you need to get started.Typical

The  mode lets you add optional modules, such as the OEE Downtime module. It also Custom
lets you control and select which modules get installed.

If you select  Mode, the Select Components window is displayed.Custom

 In  to view a brief description of the module, click on the module name. • Graphical mode
Selecting the check box next to a module installs the module as part of the Ignition installation. 
Clearing the check box next to a module prevents the module from being installed.

 In  a list of all the modules are displayed one at a time. Type y to install the module, • Text mode
and type n to prevent the module from being installed.



12.  

13.  

14.  

Ignition is now ready to be installed. At this point, you can click the Back button (graphical 
mode) to change your selections. For the text mode, you can only abort the installation at this 
point by typing n.

Click  (graphical mode) or type y (text mode) to finish the installation.Forward



13.  

14.  When the installation is complete, click  (graphical mode) or type y to start Ignition (text Finish
mode).
Ignition is started as a background process. 

Once the Ignition Gateway starts up, your web browser opens and brings you to the Gateway home page 
at http://localhost:8088.

   

Stop and Start Ignition
After installation, you can start and stop Ignition with the following commands:

/etc/init.d/ignition start
/etc/init.d/ignition stop

   

Ignition as a Service
When installing under Ubuntu, Ignition starts automatically whenever the computer reboots. If you wish to stop this behavior, you need to use the 
update-rc.d tool to remove the service (uninstalling Ignition also removes the service) as follows:

/etc/init.d/ignition stop
update-rc.d -f ignition remove
rm /etc/init.d/ignition

When installing under other Linux distributions, use that distribution's method to automatically start a program after reboot.
For example, this command auto-starts Ignition installed in a Fedora 15 system (run as root user):

chkconfig --level 2345 ignition on

   

Set the system PATH
For Ubuntu installations, the installation directory is automatically appended to the system PATH. You can start programs like the Gateway Control 
Utility from the command line without specifying a complete path to the installation directory.

Note that after installation, you need to close and reopen the command shell for the PATH change to take effect. For other Linux installations, you 
need to manually add  (or your installation directory) to any script that can set the system PATH (such as  or /usr/local/bin/ignition .profile

)..bashrc

   

http://localhost:8088/
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Automated Installation on Linux
You can automate Ignition installation across different machines using scripts. Ignition is then installed silently from a command shell without showing 
any user prompts.

Keep in mind that the installer cannot automatically start the Gateway after a silent installation. Use the  command /etc/init.d/ignition start
as shown in example below.

Command line example

sudo ./ignition-7.x.x-linux-x64-installer.run --mode unattended --prefix /somefolder/bin/ignition --
unattendedmodeui none
/etc/init.d/ignition start

Flags

-- mode unattended (ensures that no prompts appear during installation)
 (optional flag; if a value is set, then Ignition is installed in the specified folder, otherwise Ignition is -- prefix /somefolder/bin/ignition

installed in  by default)/usr/local/bin/ignition
 (allows a Linux system user to be installed (that is, a user that cannot log in to the OS))-- serviceuser username

 | minimal (the  flag does not display any sort of graphic during installation; the  -- unattendedmodeui none none minimal flag displays a small 
progress bar and nothing else)

 

Installing using Debian Package Management
By using the package management tools you can quickly install Ignition on Ubuntu and other Debian-based systems. Debian package management is 
a powerful way to quickly install Linux programs and keep them up-to-date with minimal effort.

Note: that you need to be able to run as sudo to be able to install Ignition. Also, the machine where you want to install Ignition must be connected to 
the Internet so that the installer and updates can be installed automatically. If you are installing Ignition to a non Internet-connected machine, use the 
downloadable Linux installers instead (see the Download and Install on Linux section at the Top of this page for more details).

The Ignition Debian installers are dependent on an existing Java 6 or later installation through APT. Java 7 is highly recommended over Java 6. 
Oracle Java Runtime Environment (JRE) version 7 is officially supported by Inductive Automation, although Ignition runs well in most cases using 
OpenJDK 7.

The installer installs files in the following locations:

/usr/local/bin/ignition - contains binaries and startup scripts
 - contains application-generated files, temporary files and the internal/var/lib/ignition/data

database
 - contains modules and JDBC jars/var/lib/ignition/user-lib

 - contains the wrapper.log and other log files/var/log/ignition
 - contains configuration files. Symbolic links to these files are created in ./etc/ignition /var/lib/ignition/data

When installing Ignition, you can choose whether to use the graphical package management tools, or install completely from the command-line. With 
either option, Linux automatically downloads the correct 32-bit or 64-bit installer depending on your installed system architecture.

Note that the instructions below are for an Ubuntu Linux system, but other Debian systems will contain the same tools, although they may be under 
different menus.

Graphical Installation

Download the Inductive Automation public key file from    .com/ia.public.keyhttp://archive.inductiveautomation

or on the command-line, run 
wget http ia.public.key://archive.inductiveautomation.com/
 
Within Ubuntu, navigate to .System > Administration > Synaptic Package Manager

Within Synaptic Package Manager, navigate to .Settings > Repositories
 
Navigate to the Authentication tab. Click on  and select the downloaded ia.public.key file.Import Key File
 
Navigate to the Other Software tab and click on the  button. Add the following text to the text box:Add
dep ignition non-free://archive.inductiveautomation.com/
 
If you want to add the Ignition beta repository, click the  button again and add this text to the text box:Add
dep http:  non-free//archive.inductiveautomation.com/apt ignition-beta

Be sure to uncheck the check boxes next to repositories ending with , as Ignition does not supply source code with the Source Code
repositories.
 

http://archive.inductiveautomation.com/
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Click the  button. Within Synaptic Package Manager, click the  button. You can now type   into the Quick Filter box and Close Reload ignition
see the latest available Ignition repositories.
 
Right-click on the Ignition repository that you want to install, and select . Then click the  button at the top. Ignition Mark for Installation Apply
will be automatically downloaded and started. Navigate to  to log into the Ignition Gateway.http://localhost:8088

 

Command-line Installation
Run 
wget http://archive.inductiveautomation.com/ia.public.key

Run 
sudo apt-key add ia.public.key

Copy
 /etc/apt/sources.list

to
/etc/apt/sources.list.bak

Edit 
 /etc/apt/sources.list

and add the following lines (the ignition-beta line is optional):
deb   ignition non-freehttp://archive.inductiveautomation.com/apt
deb   ignition-beta non-freehttp://archive.inductiveautomation.com/apt

Run 

$sudo apt-get update

to update the download list within the APT utility.

Run 
 sudo apt-get install ignition

to install the latest stable Ignition version or run 

 sudo apt-get install ignition-beta

to install the latest beta Ignition version.

If you want to run the  or  right after installation, open a command shell in your home folder and run Gateway Command Utility gwcmd
source .profile

This forces your command shell to reload the  script, which has been updated with a path to the Ignition executable .profile
during installation.

Upgrades

During an upgrade, the Ignition internal database, configuration files, and any custom installed modules are not changed. Whenever a new version of 
Ignition is released, the online Debian repositories also get updated with the latest version.

Your Linux environment will list Ignition in the list of package upgrades when a new version is available. As with the installation, you can choose 
whether to upgrade using a graphical environment or using the command-line.

Graphical Upgrade

Ignition will appear as an entry under your system's Update Manager under the  section. If you choose to install updates using the Other Updates
Update Manager, Ignition will be upgraded at the same time as other packages.

You can also manually upgrade Ignition using Synaptic Package Manager. Locate  or  in the list using the Quick Filter.ignition ignition-beta

Ignition can also be found in the World Wide Web section. Right-click and select . Then click  at the top. The latest version of Mark for Upgrade Apply
Ignition will be downloaded and installed.

Command-line Upgrade

To upgrade all installed packages, including Ignition, run 
sudo apt-get upgrade

To only upgrade Ignition, run 
sudo apt-get install ignition

http://localhost:8088
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or 
sudo apt-get install ignitionbeta

The APT utility recognizes that Ignition is already installed, and performs the upgrade.

   

Uninstalling Ignition on Linux

Before you uninstall Ignition...

Be sure to back up your Gateway and unactivate your Gateway license.

During a new Ignition installation, an uninstaller executable is created.

When Ignition is uninstalled, the settings database and folder in   is backed up to  , and modules and user-supplied /data /data_<current date>
JDBC jars in  are backed up to  . Also, the Ignition service is removed from Ubuntu Linux installations /user-lib  /user-lib_<current date>
automatically. 

Linux – Using Downloaded Installer

Ignition 7.3 or later installations on Linux contain an uninstaller executable.

To run the uninstaller,

Open a command shell and navigate to  (or your installation folder)./user/local/bin/ignition
 
As  or , runroot sudo
./uninstall

Linux Ignition installations before 7.3 used a zip file that did not form an installation. Since these installations were never created with an installer 
executable, no uninstaller executable was ever generated. This is true even if using a 7.3 or later installer executable to upgrade an installation from 
before 7.3. For installations before 7.3, you must manually remove the Ignition folders using the commands below.

/etc/init.d/ignition stop
*Ubuntu only* update-rc.d -f ignition remove 
rm /etc/init.d/ignition 
rm -rf /usr/local/bin/ignition 
*Recommended* mv /var/lib/ignition/data /var/lib/ignition/data_<current date> 
*Recommended* mv /var/lib/ignition/user-lib /var/lib/ignition/user_lib_<current date> 
*Recommended* mv /etc/ignition /etc/ignition_<current date> 
rm -rf /var/log/ignition

Linux Uninstallation – Using Ubuntu Package Management

Installation using the Ubuntu Package Manager offers the choice to either remove the installation while keeping the configuration files in , or to /etc
completely remove/purge the installation from the system.

If you choose to remove the installation and then reinstall Ignition, Ubuntu will need to download Ignition again.

To simply remove the installation,

Open a command shell.
Run 

 (for stable installations) or sudo apt-get remove ignition
 (for beta installations)sudo apt-get remove ignition-beta

To completely remove/purge the installation,

Open a command shell.
Run 

 (for stable installations) or sudo apt-get purge ignition
 (for beta installations)sudo apt-get purge ignition-beta

   

   

Next ...

Activating Over Internet
Activating Manually
Upgrading Ignition on Linux
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Upgrading Ignition on Linux
   

Before you upgrade Ignition...

 .You should backup your Gateway, see Making Gateway Backups

Also, you need to be able to run as ROOT (prefix everything with , run , or login as sudo sudo su root
user) to perform the upgrade.

Unlike some Linux operations, the Ignition Linux upgrade process is designed to be as simple 
as possible. Note that while Ignition is currently optimized for Ubuntu Linux, the upgrade process 
will work for any Linux distribution.

The Ignition installer also doubles as an upgrader, thus upgrading Ignition is very similar to downloading 
a new version and installing from scratch. You can see your current Ignition version by looking in the Stat
us page of the Gateway.

To upgrade Ignition on Linux

Simply download the Linux executable installer from our website, and double-click on the 
executable installer.

 Make sure you download the 32-bit installer for a 32-bit Linux installation, and the 64-bit Note:
installer for a 64-bit Linux installation. A 32-bit installer does not launch in a 64-bit system and 
vice versa.
 
After downloading the installer, open a command shell and navigate to the installer executable.
 
Run
chmod 744 *
 
Then run
./ignition_X.X.X-installer.run

If you are running the installer in a shell in a graphical environment, the graphical installer opens 
automatically. 
If you are running the installer in a headless Linux installation, or through a SSH shell, the text 
installer opens automatically.

If you want to run the text installer in a graphical environment, add   to the --mode text
end of the above command.

The installer starts running.
 
Agree to the licensing terms and click .Forward
The Installation Directory window is displayed.
 
Click  to accept the default installation directory.Forward
Linux does not have the concept of a central registry like Windows systems do. Therefore, you 
must provide the location of the existing Ignition installation. By default, this value is /usr

, unless you have installed Ignition in another location. /local/bin/ignition
 
In the  window, click  to continue.Question Yes
This Question window is displayed when the upgrader was able to locate Ignition in the 
specified folder. After you click Yes, the Upgrade Mode window is displayed.

You choose either:
No, just upgrade currently installed modules
The Ignition base installation and the existing modules are upgraded. This is the choice for most 
scenarios.
 
Or you can choose:
Yes, let me choose which modules to add or remove
The Select Components window is displayed and you can then add a module that was not part 
of the original installation or uninstall/remove a currently installed module. 

In graphical mode, you can view a brief description of each module by clicking on the module 
name.

 next to a module, installs the module as part of the upgrade. Selecting the check box
Clearing the   next to a module, uninstalls the module during the upgrade.check box

In text mode, a list of all the modules is displayed, one at a time. Type  to install or upgrade the y
module, and type  to uninstall the module. n
 

Upgrading Ignition 
on Linux

Watch the Video

Tip Sheet

Upgrading from 7.6 or earlier?

Please read this upgrade guide: Igniti
on 7.7 Upgrade Guide 
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Ignition is ready to be upgraded. At this point, you can click  (graphical mode) to change Back
your selections, or you can only abort the upgrade at this point (text mode) by typing .n

To finish the upgrade, click  (graphical mode) or type  (text mode).Next y

When the upgrade is complete, click Finish (graphical mode) or type y to start Ignition or n to 
exit (text mode).
If the box for  was selected, Ignition starts as a background process. Start Ignition now
 

Use a web browser and go to  to confirm that your Gateway is http://localhost:8088
running. 
For instructions on how to stop or start Ignition, see  .Installing Ignition on Linux

   

Automated Upgrading

You can silently upgrad Ignition from a command shell without showing any user prompts. Remember to make a Gateway backup before performing 
any type of upgrade. Also, the installer cannot automatically start the Gateway after a silent upgrade.

Use the  command as shown below./etc/init.d/ignition start
 

Command line example: 

gwcmd -b /var/backups/mybackup.gwbk

sudo ./ignition-7.x.x-linux-x64-installer.run --mode unattended --unattendedmodeui none --autoupgrade true

/etc/init.d/ignition start

Flags:
-- mode unattended (ensures that no prompts appear during installation)

 (the  flag does not display any sort of graphic during installation; the  flag displays a -- unattendedmodeui none | minimal none minimal
small progress bar and nothing else, but only if you are working in a graphical system)

 (runs the installer in upgrade mode)-- autoupgrade true

   

   

Next ...

add the link here

 

 

   

http://localhost:8088
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Installing Ignition on Mac OS X
   

The following feature is new in Ignition version 7.8.0
 to check out the other new featuresClick here

Before you install Ignition, make sure you meet the minimum system requirements:

Java 8+ (server), Java 6+ (client)
Dual-Core Processor (32 or 64 bit)
4GB RAM
10GB free HD space

Additionally, running the installer will require  or privilegesroot administrator 

 

To download and install on Mac OS X

Go to the Inductive Automation website at
www.inductiveautomation.com
 
Select  .Download > Current Release
 
On the Ignition Downloads page, scroll down to  which contains all the System Installers
download zip files.

Download the  file.Ignition-x.x.x-osx-installer.dmg

Download and install Java 8 if it is not already installed. 
Go to 
http://www.oracle.com/technetwork/java/javase/downloads/index.html

Click on the download button under JRE. Accept the license agreement and download jre-8uXX-
macosx-x64.dmg. Once downloaded, run the installer and follow the instructions to install Java.
 
Double click on the DMG. You'll see a window appear that contains a ignition-x.x.x-osx-

fileinstaller.app 

Installing Ignition 
on Mac OS X

Watch the Video

 

 

 

7.8 introduced an OS X installer. Instructions for using the ZIP files can be found on our Installi
 pageng Ignition on Mac OS X - ZIP file

https://docs.inductiveautomation.com/display/DOC/New+in+this+Version#NewinthisVersion-Newin7.8.0
http://www.inductiveautomation.com
http://www.inductiveautomation.com
http://www.oracle.com/technetwork/java/javase/
https://www.inductiveuniversity.com/video/installing-ignition-on-mac-os-x/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Installing+Ignition+on+Mac+OS+X+-+ZIP+file
https://legacy-docs.inductiveautomation.com/display/DOC/Installing+Ignition+on+Mac+OS+X+-+ZIP+file
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Double click on the APP file to start the installer. When prompted, enter your password for 
elevated installation privilege. 

The Setup window welcomes you to the Ignition Setup Wizard.

Click Next

 Click the   button and click  .I accept the agreement Next

 The Installation Directory window is displayed. By default, Ignition is installed under /usr/local
/ignition. This is usually a good choice.
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Ignition will need a user name to be installed under. The user needs to already exist on the 
system.

Select either the   or   mode. Typical Custom
The   installation includes Ignition with all of the HMI/SCADA modules. Typical
The   installation lets you control and individually select the modules that you want Custom
installed.

 
Click  .Next
The Setup window is displayed. 
If you selected   mode, in the Setup window you can select the check box next to the Custom
modules you want to install as part of the Ignition installation. To see a brief description of the 
module, click on the module name.
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15.  
16.  

 

Setup Wizard shows Ignition is now ready to install.
If you decide to change your selections, click   to go back and make your changes.Back
 
 Click Next.
After Setup Wizard shows Ignition installation is finished, make sure that the check box for Start 

 is selected, then click  .Ignition now Finish

 

A splash screen informs you that Ignition is starting. This may take a few minutes to finish.

That’s it! Ignition Installation is complete and the Gateway is then launched.

You can now open a web browser and go to the Gateway home page at  .http://localhost:8088

 

 

 

 

 

Uninstalling Ignition on OS X

http://localhost:8088/


1.  

2.  

 

Before you uninstall Ignition...

Be sure to back up your Gateway and unactivate your Gateway license.

 

During a new Ignition installation, an uninstaller APP is created.

Navigate to /usr/local/ignition

 

Run the uninstall.app file

 
 



3.  The uninstaller wizard guides you through the uninstallation process.
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Activating Over Internet
Activating Manually
Upgrading Ignition on Mac OS X
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Upgrading Ignition on Mac OS X
   

Before you upgrade Ignition...

 .You should backup your Gateway, see Making Gateway Backups

To upgrade Ignition on Mac OS X

From Gateway, go to  .Configure > Backup / Restore

Click on   to back up the entire project from the existing installation.Download Backup
The   backup file is created in the   folder..gwbk Downloads

Shut down Ignition by typing the following from the command-line:

/usr/local/bin/ignition stop

Move the existing installation folder somewhere else. 
 
Unzip the new installation and place it in the location of the old installation. 
 
Start the new installation.

/usr/local/bin/ignition start
 
Go to  and click   to perform the restoration. Configure > Backup / Restore Restore

Upgrading Ignition 
on Mac OS X

Watch the Video

Tip Sheet

Upgrading from 7.6 or earlier?

Please read this upgrade guide: Igniti
on 7.7 Upgrade Guide 
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Installing or Upgrading a Module
All module configuration is done from Gateway in the   section. From here you Configuration > Modules
can add, remove, and restart modules. Modules integrate their settings into the Gateway configuration 
tree, and therefore do not offer settings in this section.

To install or update a module

 On the  page of the Gateway, go to the bottom on the list, find the Configuration > Modules
orange arrow, and click the   link.  Install or Upgrade a Module

 
Click , select a Choose File .modl file that you have previously downloaded.
 

Go to the Inductive Automation .  Search for the module you want and save it to downloads page
your Downloads folder on your computer.  

 

Note:  If you are using Internet Explorer, IE changes the file extension to a '.zip' file.  Rename '.
zip' to '.modl'  (I.e., Production Simulator-module.modl).

Go back to the  screen and browse your Downloads folder for your Install or Upgrade Module
module, select it and click . Ignition will copy the path to the module to the Browse field Open
and all that's left for you to do is click .Install
Click .Install
When the page reloads you can now see the module you installed in the list of modules.

To uninstall a module

On the  page of the Gateway, go to the module you want to uninstall.Configuration > Modules
 
Click the uninstall link on the far-right next to the module entry in the table. 
Another page opens asking you to confirm.
 

Click .Confirm
The module is no longer installed and is removed form the list.

Modules are hot-swappable, this means these actions can be performed while the system is 
running. Furthermore, the isolated nature of modules ensures that performing one of these actions 
only affects that particular module, and any modules which depend on it. For example, uninstalling the 
SQL Bridge module will not affect any running Vision module clients.

Installing or 
Upgrading a Module

Watch the Video

 

 

 

 

 

 

 

   

Next ...  

https://inductiveautomation.com/downloads/ignition
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Gateway Setup
   

The Ignition Gateway is the primary software service that drives everything in Ignition. It is a single application that runs an embedded web server, 
connects to data, connects to PLCs, executes modules, communicates with clients, and more.

The Gateway is accessed through a web browser. The web browser, running on any machine, must have network access to the host that is running 
the Gateway.

By default, Ignition installs by using the  port. For example, if the host's IP address is  , you access the Gateway via the URL:   8088 10.0.28.30 http:
. When Ignition is installed on a computer that you can log into, you access it from .//10.0.28.30:8088  http://localhost:8088

Gateway Configuration

Once you have the Gateway up and running, you start by configuring some or all of the general services in Ignition. You make the configuration 
changes from the   section of the Gateway. The different broad categories of what you can configure are as follows:Configure

System  (Status, Licensing, Backup/Restore, Console, and User Manual) 
Configuration (Projects, Modules, Gateway Settings, and Redundancy)
Security (Users, Roles, and Auditing)
Database (Connections, Drivers, and Store and Forward)
Alarming (General, Journal, Schedules, Notification, On-Call Rosters)
Tags (Realtime and History)
OPC-UA (Certificates, Settings, Devices)
OPC Connections (Servers and Quick Client)
Mobile (Settings)

Depending on what modules you have installed, other categories can be available.

Gateway's Architecture

The Gateway’s architecture contains many parts, each one letting you perform a specific task. The Gateway parts are as follows:

System Management

Project and Module Management

Security and Auditing Settings

Database Connectivity

Alarming and Notification Settings

Tags Provider Settings

OPC Connectivity

Mobile Settings

Projects - the most important part!

The following figure shows the different parts of the Gateway and how projects work within the Gateway.

 

http://10.0.28.30:8088
http://10.0.28.30:8088
http://localhost:8088
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Gateway Basics

The Gateway is at the heart of the Ignition software. It runs as a web server and you can access it 
through a web browser. Once running, you can get various status information about the Gateway, access 
important functions from the Gateway Control Utility, and customize the Gateway's homepage to fit your 
needs.

Gateway Basic Settings

After you launch Gateway, you can define the high-level settings that apply to the entire Gateway by 

going to the Configuration > Gateway Settings page. From this page, you can use the 
default values or define a new setting.

On this page ...

Gateway Basic Settings
Gateway Monitoring
Starting and Stopping the Gateway
Troubleshooting the Gateway
In this section ...

Gateway Settings

System 
Name

Is a unique name for this Ignition installation. It is used to distinguish this server from others on the network when working with multiple 
Ignition installations.

Caution: It is not recommended to change the System Name on a Gateway that is in production. Doing so can cause subsystems 
that reference the name, such as the Tag Historian system, to malfunction.

System 
User 
Source

Is the user source used to secure access to the Gateway, as well as to the Designer.

Gateway 
Config 
Role(s)

Is a comma-separated list of roles, one of which is required to log into the Gateway's configuration section. These roles must be 
defined in the System User Source.

Status 
Page 
Role(s)

The required roles to access the Gateway's  section. Leave blank to remove security restrictions for this section.Status

Home 
Page 
Role(s)

The required roles to access the Gateway's  section. Leave blank to remove security restrictions for this section. Note that this is Home
only used to limit the access to the homepage itself, each project has its own user source for limiting access to the runtimes.

Designer 
Roles

Users must belong to one of these roles in order to have access for logging into the Designer. Multiple roles can be specified by 
separating them with commas.

Global 
Resource
Protection

The roles required to protect or modify a protected global resource such as an alarm pipeline. If blank, anyone that can log into the 
Designer can protect global resources.

Allow 
User 
Admin

Allows the administration of the Gateway's system user source from the Designer and Client. Unless this is enabled, the Vision 
module's  is prevented from altering the Gateway's system user source.User Management Component

Use SSL Forces the clients to use SSL encrypted communication when talking to the Gateway. It is highly recommended that you purchase and 
install a genuine SSL certificate if you use this option. See .Installing a Genuine SSL Certificate

Persist 
Alarms

Whether or not alarm properties such as acknowledgment should persist across Gateway restarts.

Update 
Notificatio
ns

When enabled a notification bar is displayed at the top of the configuration page when a new version of Ignition is available for 
download. This only works if your server is connected to the internet.

Web-Launch Settings



Launch 
Link 
Script 
Policy

Controls how the HTML that launches Clients and Designer functions. If set to  , the links use   to JavaScript javascript

attempt to launch directly using the Java browser plugin. If set to  , the links are direct links to the   files that launch Direct *.jnlp
the Client or Designer.

Allowed 
JREs

A semicolon separated list of allowed JREs for web-launching Clients and Designers. For example:  allows Java 7 and Java 1.7;1.8

8.

Designer 
Memory

The maximum amount of memory that the Designer has access to.

Disable 
Direct3D/

Disable 
DirectDraw

These properties affects launched Clients and Designers on Windows OS only. These flags control whether or not the Java Swing 
windowing subsystem may use Direct3D and/or DirectDraw. Disabling these features can incur a performance penalty, but might be 
required for some video cards that have faulty DirectX drivers.

Local Client Fallback

Enable 
Local 
Fallback

Enables a client to fall back to a project in a local Gateway if communication is lost to the central Gateway. Note that port 6501 must be 
open on the local machine.

Seconds 
Before 
Failover

The number of seconds to wait before switching to the local Gateway project after communication loss.

Fallback 
Project

The local project to use during fallback.

Scheduled Backup Settings

Enable 
Schedule
d 
Backups

Enables the scheduled backup system which automatically makes backups at a scheduled time.

Backup 
Folder

A path to a folder in which to put the scheduled backups.

Backup 
Schedule

A UNIX crontab style scheduling string representing when to make the backups.

Retention
s Count

The number of backups to keep in the backup folder.

Error Reporting

SMTP 
Server

When not blank, user-reported errors are emailed using this SMTP server.

To 
Address

The email address(es) that will receive the error notification. Separate multiple email addresses with a semicolon (;)

From 
Address

The email address that the error notification is from.

SMTP 
Username

A username for the SMTP server, if required.

Change 
Password?

Check this box to change the existing password.

Password A password for the SMTP server, if required.

Password Re-type password for verification.



Multicast Settings

Enable 
Multicast

Allows this Gateway to be discoverable on your local network.

Multicast 
IP 
Address

Gateway messages are broadcast on this address.

Send Port This port must be open on this machine to send multicast messages.

Recieive 
Port

This port must be open on any machine that will receive multicast messages.

Message 
Interval

The interval in milliseconds at which multicast messages will be sent.

 

Schduled Backups

The  (shown in the above table) Scheduled Backup Settings control the Gateway's scheduled backup system. This system is capable of 
automatically making a Gateway backup and storing it to a folder path, which can be a network path.

When you enable this system, you must specify a destination folder. This can be a local folder, for example   or   , or a C:\backups /var/backups
network path such as  .\\fileserver\backups

The scheduled backup system works on a schedule that is specified using UNIX crontab syntax. This is a standard format for specifying a basic 
schedule. The format consists of five space-separated fields, one for minute, hour, day-of-month, month, and day-of-week. The special Gateway 
Configuration 72 character   means  . Slashes can be used to indicate that values should be stepped, for example, */5 in the minutes field means * all
"every 5 minutes", or 0:00, 0;05, 0:10, etc.

Here are some examples:

Examples

0 1 5 * * Once a month, on the 5th day at 1am

5 * * * * Once an hour, on the :05 minute. 0:05, 1:05, 2:05, etc.

30 5 * * Mon Every Monday at 5:30am

* 6-14 * * * Every minute, but only between 6am and 2pm

*/5 8-17 * * 1-5 Every 5 minutes between 8am and 5pm but only during the week (1-5). 0=Sunday,
1=Monday, etc.

*/15 * * * * Every 15 minutes, on the quarter-hour. 0:15, 0:30, 0:45; 1:00, 1:15, etc.

If something is wrong with the scheduled backup system, it will store error messages to the Gateway logs.

Multicast Settings

These properties allow the Gateway to broadcast information about itself via multicast UDP packets. This allows the Gateway to be discoverable by 
any components that are also listening to the same multicast address.

For example, native client launchers listen on a multicast address to provide a list of available Gateways on the network. Verify that the send ports and 
receive ports are open on the Gateway machine in order to be able to broadcast multicast message.

Gateway Monitoring
You can monitor the Ignition Gateway from the  section of the Gateway or from the Gateway Control Utility ( ). Status GCU

The Status section provides detailed information relating to the following parts:

Status 
about ...

Overview Provides a top-down view of many of the components of your Gateway. This view is also useful for determining what step might be 
next when setting up your Ignition Gateway for the first time. You can view the status of your database connections, device 



connections, OPC connections, the number of open Clients and the number of open Designers.

Modules A list of installed modules, their status, as well information about their version and current license state.

Tag Lists information and statistics about all configured Tag Providers as well as a view into the Tag subscription model, scan classes, 
and what tags it is currently subscribed to.

Database 
Connections

This important section shows your database connections, their status, and their current load. Each status panel has information 
about the connection such as queries/second, total queries, and the average query duration.

Store & 
Forward

Shows you what each of your S&F engines are doing. They show the number of pending and quarantined records that exist in the 
various stages of the S&F engines, as well as the throughput of records going through each stage. Note that if the final sink (the 
Database Storage) is available, data will jump directly from the memory buffer to the database storage, skipping the local cache. 
See also: .Controlling Quarantine Data

OPC 
Connections

Shows status details about all of your OPC connections and any subscriptions you have made through these connections. You 
can view the status of any connection as well as find details for trouble shooting when the status is bad. Statistics on the number 
of reads, writes, and updates are also kept.

Sessions Shows status details about all of the Designer and Client sessions that are communicating with this Gateway. You can see 
information such as their subscriptions, user credentials, and so on.

Gateway 
Scripts Status

Shows status details about all the scripts that are running in Gateway. You can see information such as their execution status, 
whether the scripts are running or not, and so on.

Alarm Piplines Shows the status details about the alarm piplines. You can see the status of an alarm and where the alarm is in the pipeline.

Ignition OPC-
UA Server 
(Requires 
OPC-UA 
Module)

This section has two tabs:  and .Devices Server Statistics
The  tab lists of all configured devices, the status for each Devices device, as well as details about the driver that device is using.
The  tab is a set of basic performance statistics accumulated Server Statistics for the duration the server has been running as well 
as a list of subscriptions and their corresponding subscribed nodes that the server currently knows about.

Starting and Stopping the Gateway
After installation, the Gateway starts automatically. You can manually stop and start the service. Depending on the platform you are using, the 
following is how you can manually start and stop the Gateway.

Windows

Access the service control utility at . Then use the  service to control the run Control Panel > Administrative Tools > Services Ignition Gateway
state of the Gateway.

Linux

You can control the service using the  script. It can be called with the and  parameters to perform the relevant operations.ignition.sh start  stop

For example:

>./ignition.sh start

Troubleshooting the Gateway
The Gateway  provides a wealth of information about the running state of the Gateway. These information are mainly used for advanced Console
troubleshooting, and are not often consulted in normal operation.

To access the Console go to,  in the  section of the Gateway. The  page is displayed showing the System > Console Configure System Console
following tabs:

Logs
Of all of the tabs in this section, the Logs tab is the most useful for system administrators. Logs shows the most recent output of Gateway  - Loggers
units in the Gateway application that output information.

Levels
The Levels tab shows all of the registered system , and the  of detail that they should record.Loggers Level

Threads
The Threads tab shows the current state of all system threads.

Memory
The Memory tab provides a breakdown of how much memory is being used by Ignition.

Execution
The Execution tab show a list of all registered "executors"- tasks that perform repeat operations.

Advanced
The Advanced tab is the entry point to the . The Raw Settings Viewer allows advanced users to make queries against the Raw Settings Viewer



internal database for advanced troubleshooting purposes. There is
potential to really do some damage to the Ignition installation if one isn't careful. Use extreme caution when working directly with the internal database.

In this section ...



Gateway Webpage
   

Launching Gateway
The Ignition Gateway is a web server. When it is running, you access it through a web browser. 
For example, if you are logged into the computer that you installed Ignition on, open up a web browser 
and go to the address:
http://localhost:8088

 

Any other computer on the same network can access the Gateway by using the IP Address or Host 
Name of the computer where Ignition is installed: i.e., http://192.#.#.#:8088

and it will launch Gateway and bring up the Gateway Homepage as pictured here.

The first time you go to the Gateway Homepage, it shows you 5 common steps to help you get started. 

Gateway Webpage

The Ignition Gateway is a web server and when it is running you access it from a web browser. In a web 
browser, type   to display the Gateway homepage.   four http://localhost:8088 The Gateway homepage has
buttons across the top of the page that lead you to the key sections of the server: Home, Status, 
Configure, and Launch Designer.

Home

The  button takes you to a page that lets you do the following:Home

Launch Projects in a client
Mobile Launch a project on a mobile device
See the   that are running for your projectTransaction Groups
See a list of all the connected Devices
Download the Native Client Launchers
See a list of all Database Connections

Status

The   button provides in-depth information about the status of the different parts of the Ignition Status
system. The menu on the left of the Status page takes you to the following different parts for detailed 
information:

Overview
Modules
Redundancy
Tags
Database Connections
Store & Forward
OPC Connections
Sessions
Gateway Scripts
Gateway Network
Gateway Tasks
Alarm Pipelines
OPC-UA Server
Reports

On this page ...

Launching Gateway
Gateway Webpage
To Continue on the step-by-step 
simple workflow...
Next ...

Gateway Webpage

Watch the Video

To Continue on the 
step-by-step simple 
workflow...

After you  , Launch Gateway
described on the left, click the link 
below for Step 2 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

 

 

 

 

 

 

 

 

http://localhost:8088/
http://localhost:8088/
https://inductiveuniversity.com/video/gateway-webpage/7.8


Configure

The  button first takes you to a login page. Use   and   as your UsernameConfigure admin password
/Password to login.

Once you are logged in, you are in the Configure page. From this page, you do all the Gateway and 
platform operations. The main menu section on the Configure page changes based on which modules 
are installed and what your settings are but the defaults are as follows: 

System
Configuration
Security
Databases
Alarming
Tags
OPC-UA
OPC Connections
Mobile
Enterprise Administration 

Gateway Console

One of the most important troubleshooting tools of the Gateway Webpage is the  page. Console
This console shows errors caused by Gateway events including things like Database or Device 
connections, Authentication profiles, Alarm Journals and Pipelines, and anything else that is 
Gateway scoped. You can find the console in the  section of the  Configure Gateway Webpage
under .System -> Console

 

 

Launch Designer

The  button, on the top right of the page, directly launches the Ignition Designer.Launch Designer

 

 

Next ...

Gateway Control Utility
Customizing Gateway Homepage

 

   

   



Gateway Control Utility
   

The Gateway Control Utility, simply called the “GCU”, is a lightweight standalone application that 
provides information about the Gateway. You can use the GCU to monitor the Gateway and perform high-
level tasks that aren't available inside of the web application. It provides basic administrative controls, 
such as stopping and restarting the server and setting the ports used between the Gateway and clients.

Note: The Gateway Control Utility must run on the same machine as the Ignition Gateway and requires 
administrative privileges.

To launch GCU in Windows

Fom the   menu, go to Start All Programs > Inductive Automation > Ignition > Launch 
.Gateway Control Utility

You can also launch GCU from the command-line or from the  dialog by typingStart > Run 

launch -gcu

To launch GCU in Linux

Open a command shell and type

gcu

If you receive an error saying , add the Ignition installation directory to your “gcu can't be found”
system path.

If you are running in a headless Linux environment or you have logged into the Linux machine through an 
SSH shell, the GCU functions are still available in command-line form. See  below.Command-line Utility

On this page ...

GCU Window
Command-line Utility
Next ...

Gateway Control 
Utility

Watch the Video

 

 

 

   

GCU Window
When GCU is launched, the following window is displayed:

Status

https://inductiveuniversity.com/video/gateway-control-utility/7.8


On the upper-left of the window,  shows the state of the Tomcat web server and the Ignition Gateway web application. It is possible for the Status
web server to be running while Gateway has failed. For example, this can occur when the Gateway has faulted on startup. You can also see the 
Ignition software version that is running.

Go to web page

On the upper-right of the window,  launches a web browser to the Gateway home page.Go to web page

Restart

On the upper-right of the window,  restarts the Tomcat web server.Restart

Reset Password

On the upper-right of the window,  lets you reset the root password of the system. Normally, this is not considered a security Reset Password
risk, because the GCU can only be used from the machine the software is installed on, which should be secure. However, it is important to know 
about this feature here so that the GCU can be removed if the machine can't be properly secured, for example when the server is also used as a client.

Thread Dump

On the upper-right of the window,  downloads a file with the current states of all threads in the server. Inductive Automation uses this Thread Dump
file for troubleshooting problems. 

Gateway Backup

On the upper-right of the window,  downloads a Gateway backup  file to the local file system. A Save dialog opens to let Gateway Backup .gwbk
you specify where you want to save the  file..gwbk

Port

On the lower-left of the window,  lets the primary, non-encrypted port, used by clients to communicate with the server. You can see the ports that Port
you are using and you can change the ports and click the  button to save the ports to the Gateway. Note that Gateway must be restarted for Save
the changes to take effect.

   

Command-line Utility
All the functions in the GCU are also available as a command-line utility for both Windows and Linux.

To run the utility, open a command shell and type:

gwcmd <option>

Options are as follows:

Options Description

a,-–activate 
<CDk-key> 
Offline 
activation

Creates an activation_request.txt file that can be used to request a license.ipl file from the Inductive 
Automation website. You must specify the CD-key to use for activation. The activation_request.txt file is saved in 
the current directory.

-b,--backup <new 
filepath> 

Downloads a Gateway backup  file and saves the file to the specified .gwbk path. The path can be either an absolute path 
or a relative path. If a new file name is not specified at the end of the path, the file name becomes the current date and 
time along with the  extension..gwbk

You will be prompted whether it is OK to overwrite the file if another  file with the same name .gwbk already exists. You 
can override with the  option to force the file to always be -y overwritten.

-h,--help  Shows the usage for this command.

-i,--info Retrieves server status and port information from the Gateway if it is running.

-k,--port <new 
port>

Changes the Gateway http port.

-l,--sslport 
<new port>

Changes the Gateway https port.

-p,--passwd Resets the Gateway login password.

-r,--restart Restarts the Gateway.



-s,--restore Restores a gateway backup (.gwbk) file.

-t,--tdump Performs a thread dump in the Gateway and prints the dump to the command-line.

-u,--unactivate 
Offline 
unactivation

Creates an  file that you can use to unactivate a license via the Inductive Automation unactivation_message.txt
website. The  is saved in the current directory.unactivation_message.txt file

-w,--uselicense <l
icense.ipl path>

Applies a  file that was downloaded from the Inductive Automation website. You must supply the location of license.ipl
the  file. If it is in the current directory, use  for the location.license.ipl license.ipl

-y,--promptyes Automatically answers  to any prompt that may appear in the above commands, such as permission to overwrite an yes
existing file.
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Customizing Gateway Homepage
   

You can customize the Gateway homepage to display only the information you want. You can show/hide 
and reorder the different sections or panels on the homepage. 

When you first install Ignition, there are a number of homepage panels that are helpful in beginning a 
project, but when it
comes time to deploying to production, all the homepage panels may no longer be necessary.

To change how things are displayed on the Homepage

Go to the  section of the Gateway.Configure
 
Select  .Configuration > Gateway Settings
 
Select the   tab.Homepage Config
You can now see a table that shows all the available panels on the Gateway homepage. 
 
Click the boxes you want to display under   or .Start Expanded Enabled
 
Click  or  at the end of the row showing the panel name to move it up or down.up  down
 
Go back to the  section to see and verify your changes.Home

Customizing 
Gateway Homepage

Watch the Video
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add link here

 

   

   

https://inductiveuniversity.com/video/customizing-gateway-homepage/7.8


Advanced Gateway Settings
   

In addition to customizing the Gateway's homepage, there are a number of advanced features in the Gateway that you can customize, such as 
changing ports, changing the Java version, and changing the allocated memory size.

 

Port References

An Ignition server uses many ports to manage information between itself and other Ignition servers, OPC servers, devices, and other services such as 
SMTP and ERP servers. The following table describes the default ports an Ignition server may use for communication. Most are configurable and 
some of these ports may be on a computer other than the one Ignition is installed on (that is, if MySQL is installed on a different computer, the Ignition 
server will not be using port 3306).

Port Operation Protocol Configurable Description

8088 Listening tcp Yes Default port setting to access the Ignition gateway

8043 Listening tcp Yes Default SSL port setting to access the Ignition gateway

4096 Listening tcp Yes Default port for OPC-UA server

45900 Listening tcp No Callback port for the mobile module

4445 Outgoing udp/broadcast Yes Default send port for a multicast messaged that makes the gateway discoverable on a local 
network

4446 Listening udp/broadcast Yes Default receive port for a multicast messages that makes the gateway discoverable on a 
local network

8750 Listening tcp No Port used for Redundancy/Network Configuration

389 Outgoing tcp Yes Default port for Active directory if this is being used

465 Outgoing tcp No SMTP protocol used if Alarming is configured

5060 Listening tcp/SIP No Send Voice Notification to SIP server

8000 Listening tcp/RTP No Transfer/com for SIP server 

17341 Outgoing tcp No Send port for SMS with Alarming

17342 Listening tcp No Receive Port for SMS with Alarming 

502 Outgoing tcp Yes Default Modbus port

3306 Outgoing tcp Yes Default MySQL port used for connection

1433 Outgoing tcp Yes Default MSSQL port used for connection

1521 Outgoing tcp Yes Default Oracle port used for connection

50000 Outgoing tcp Yes Default IBM DB2 port used for connection

5432 Outgoing tcp Yes Default Postgresql port used for connection

3050 Outgoing tcp Yes Default Firebirdsql port used for connection 

6501 Listening tcp No Server fallback port

5500 Listening tcp Yes Default port for OPC browse of external tags

 

In this section ...
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Changing Gateway Ports

The Ignition web server runs on the 8088 port by default, but you can easily change it from the Gateway 
Control Utility (GCU). You may want to change the default port because the 8088 port is already being 
used by another application, or maybe you just want to use a more user-friendly port, such as 80.

To change the port

Here is how you can change the port:

  .Launch Gateway Control Utility (GCU)
Note that you can't change the port from the Gateway  section.Configure
 
In the lower-left side of GCU, type a different number for   and . Port SSL Port
For example, type   for  and  for .80 Port 443 SSL Port
 
Click .Save
Ignition Gateway restarts. If the port is already in use, Ignition will not start. You can go back to 
GCU and choose another port for the server. 
 
Go to any webpage and if you have set Port to 80, type  instead of  Localhost Localhost:8088
to bring up Gateway.

Changing Gateway 
Ports

Watch the Video

 

Next ...

Changing Gateway Java Version

If using Linux, be aware that ports under 1024 are considered Privileged Ports, and can't be bound to by non-root users. In these cases it's 
generally recommended to set up iptable rules to redirect packets from the privileged ports to non-privileged ports. 

Detailing how to do that is outside the scope of this user manual, but there are plenty of posts and discussions online on the subject. 

https://legacy-docs.inductiveautomation.com/display/DOC/Gateway+Control+Utility#GatewayControlUtility-LaunchingGCU
https://inductiveuniversity.com/video/changing-gateway-ports/7.8
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3.  

4.  

5.  

Changing Gateway Java Version
   

You can change the Java version that the Gateway Service is using by editing the Ignition configuration i
 file. The  page of the Gateway shows the current Java version you gnition.conf Configure>Status

are running.

Here is how you can change the current Java version:

Go to  and find the  Program Files > Inductive automation > Ignition > data ignition.conf
file.
 
Open the  file and scroll down to the   section.ignition.conf wrapper Java Properties
 
Change  
wrapper.java.command=C:/Program Files/ /bin/java.exeJava64
to
wrapper.java.command=C:/Program Files/ /bin/java.exeJava/jre8
 
Save the  file.ignition.conf

Launch the Gateway Control Utility (GCU) and click  to start the Service again.Restart

After Ignition is restarted, you can verify that the Java version is updated by going back to the Configure>
 page to see the Java Version you are now running.Status

Changing Gateway 
Java Version

Watch the Video

 

 

   

   

Next ...

Changing Gateway Memory Allocation

 

   

   

https://legacy-docs.inductiveautomation.com/display/DOC/Gateway+Control+Utility#GatewayControlUtility-LaunchGCU
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Changing Gateway Memory Allocation
You can change the amount of memory (RAM) dedicated to the Gateway service by editing the Ignition 
configuration   file. ignition.conf

The   page of the Gateway shows the current status of the  – how Configure>Status Memory (used/max)
much memory is being used and the maximum amount of memory allocated.

To change the memory allocation

Go to the install directory at   and find Program Files > Inductive automation > Ignition > data
the   file.ignition.conf
 
Open the   file and scroll halfway down to .ignition.conf Maximum Java Heap Size (in MB)

 
Change  
wrapper.java.maxmemory=2048
to
wrapper.java.maxmemory=4096
 
Save the   file.ignition.conf

Launch the Gateway Control Utility (GCU) and click   to start the service again.Restart
If there is not enough memory in the system, Ignition will not restart and you need to go back to 
the   file and change the max memory to the lower number as before.ignition.conf

When Ignition is restarted, you can verify that the memory allocation is updated by going to the Configure
 page and checking the numbers shown for .>Status  Memory (used/max)

Changing Gateway 
Memory Allocation

Watch the Video
 

 

 

 

 

   

Next ...

add link here
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Making Backups and Restoring
   

You can easily backup and restore your Ignition Gateway through a single file. The backup includes all of your projects, tags, and configurations from 
your Ignition server.

   

   

In this section ...

 

 

   

   



1.  

2.  

3.  

Making Gateway Backups
It is a good idea to create backups anytime you make changes to Ignition. You can create an Ignition 
backup in two different ways:

From the Gateway webpage
From the Gateway Control Utility (GCU)

To create a backup from the Gateway Webpage

Go to the   section of the Gateway webpage.Configure

Click on  .System > Backup/Restore
The System Backup/Restore page is displayed.
 
Click the   button.Download Backup
This downloads a  file to your local file system, which includes everything in Gateway, .gwbk
that is, all projects, security profiles, database connections, and configuration but not the 
modules and the data that is in the database (you can backup the database separately).
By default, the  is saved in the  folder. .gwbk Downloads

 

To create a backup from the Gateway Control Utility (GCU)

Once you have the GCU window up, click on  to create the  file.Gateway Backup .gwbk

Note: You can only access GCU and make the backup file ONLY from the same machine that Gateway 
is installed on.

Making Ignition 
Gateway Backups

Watch the Video
 

 

 

 

 

   

 

   

Next ...

Restoring Gateway Backups

 

https://inductiveuniversity.com/video/making-ignition-gateway-backups/7.8
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Restoring Gateway Backups
   

After you created the Ignition backup file, you can restore it using the Gateway Webpage. 

 As ALL the server's current configuration (except the activation status) will be permanently lost, we Note:
 recommend you always make a backup of the existing server before restoring.

To restore the backup file

Go to the  section of the Gateway.Configure
 
Click on .System > Backup Restore
 
On the  page, click the  tab at the top of the page.System Backup / Restore Restore
 
Click on , then go to  folder, choose the  file, and click .Choose File Downloads .gwbk Open
 
Click on .Restore
Gateway stops while restoring the backup file. When restoring is done, restarts itself to apply 
the restored settings and comes up again.

Restoring Ignition 
Gateway Backups

Watch the Video

 

 

 

 

 

   

Next ...

Setting up Automatic Gateway Backups

 

   

   

Restore Disabled Checkbox

If you check the Restore Disabled box, all projects, project 
resources, notifications, alarm journals, database 
connections, OPC connections, devices, scripts and third 
party modules will be disabled upon restart.

https://www.inductiveuniversity.com/video/restoring-ignition-gateway-backups/7.8
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Setting up Automatic Gateway Backups
   

 

You can set up a daily schedule for automatic Gateway backups in the Gateway Webpage.

To setup the automatic backup

Go to the  section of Gateway.Configure
 
Click on .Configuration > Gateway Settings
 
On the  page, scroll down to the bottom of the page to the Gateway Settings Scheduled 

 section.Backup Settings
The properties in this section allow you to enable and set the scheduled backups.
 
Select the check box for .Enable Scheduled Backups
 This enables the automatic backups at a scheduled time.
 
In  , type a path to a folder where the backups should be saved. For example, Backup Folder
you can type:
\\computer\share\backup 

 The path to a folder where the backups are to be saved can be a local folder ( ) or C:\backups
a network path ( ).\\fileserver\backups
 
In , type a UNIX crontab scheduling string to specify when you want to make Backup Schedule
the backups.
For example,  , makes a backup  minutes after  hour every day, every month, and 15 1 *** 15 1
every year.

In , you specify a number which will be the number of backups kept in the Retention Count
backup folder. For example, you can specify 5 if you want to only keep the last 5 backups. 

Click  at the bottom of the page. Save Changes
Now the Gateway will automatically make backups for you.

Setting up 
Automatic Gateway 
Backups

Watch the Video
 

 

 

 

 

 

 

   

Next ...

Making Project Backups
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Making Project Backups
   

From the Gateway webpage, you can easily make a backup file for a project and upload a project from 
an existing backup file.

To back up a project and create a backup file

Go to the   section of the Gateway webpage.Configure
 
Select  .Configuration > Projects
The  page is displayed and you can see your existing projects. Projects

Click on the   link at the right of row for the project you want to backup.export
A   backup file is created..proj

 

 

To upload a project backup file

Do steps 1 and 2 above.

Find the orange arrows and click on .Upload project from a *. proj backup file...
The  page is displayed.Upload Project
 
Click on  and select your  file and click .Choose File .proj Open
 
On  page, click on . Upload Project  Upload
If there is already a project with the same name, the Project Name Conflict page is displayed 
giving you the option to Rename the project or Overwrite it.
 

 the project and click .Rename Apply
The Projects page is displayed again and you will see your new project is added to the list along 
the other the projects. 

 

Making Project 
Backups

Watch the Video
 

 

 

 

 

 

   

Next ...

Project Backups vs. Ignition Gateway Backup
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Project Backups vs. Ignition Gateway Backup
There are two main backup types that can be made in Ignition: a  backup and    backup.Gateway Project

 

Gateway Backup

The  backup (*.gwbk file) includes everything you find in the Ignition Gateway webpage. This Gateway
means all of the projects, global resources, Ignition tags, database connections, OPC and Device 
connections, plus all the settings of the gateway. The only things that aren't included in this backup is 
information stored in other programs, IE: the data in a database, PLC programs, etc.

Note that restoring a Gateway backup is the easiest way to restore your system, but it will overwrite all of 
the existing settings including your projects. There is no merge option for a Gateway backup.

Project Backup

A  backup (*.proj file) is much smaller than a Gateway backup and only includes data from the Project
selected project. This means all its resources such as windows, transaction groups, templates, reports, 
project scripts, etc. Notably missing from the project backup are any Gateway scoped resources, even if 
they are presented in the Designer. IE: Ignition tags, stored raster images, global items like SFCs, alarm 
pipelines, global script functions etc. When a project backup is made, it is recommended to also backup 
your tags, images, and anything else you might be using. While the project may rely heavily on a specific 
database connection or tag provider, those are not included in the project backup.

When you upload/restore a project backup in the Gateway Webpage, it will be merged into your existing 
Gateway. If there is a naming collision, you have the option of renaming the project or overwriting the 
project. Project backups can also be created/restored in the Designer. This will even allow you to select 
which parts of the project backup you want to include and will merge them into the currently open project.

Making Project 
Backups

Watch the Video
 

 

 

 

 

 

Next ...

About Licensing
Making Backups and Restoring
Using Designer User Interface
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Licensing and Activation
 

How Licensing Works
Ignition is a modular platform, therefore it is licensed based on modules. Licensed and unlicensed 
modules can operate side-by-side, so some modules can be tested in trial mode while others are running 
in a licensed state.

How Activation Works

Activation refers to locking down a CD-Key to the install machine and notifying the modules of their 
license state.

CD-Key

When the software and the modules are purchased, you are provided with a six-digit CD-Key. If you add 
a module, your account is updated, and you can re-use your existing CD  to activate the new -Key
features. You can also unactivate your CD-K , and reuse it to activate Ignition on a different machine.ey

Two methods of Activation

You can do the activation in two ways:

Over Internet
Manually – by email or through the Inductive Automation website

On this page ...

How Licensing Works
How Activation Works
CD-Key and License File
Licensing for Production Use
Information Collected at 
Activation
How Un-activation Works
In this section ...

 

 

CD-Key and License File  

Despite the modular licensing, there is only one CD-Key and license file for each server. That is, there is a single license file that specifies which 
modules are currently activated.

When module(s) are purchased, you receive a CD-Key, a six-digit code, that identifies your purchase. You use this CD-Key to activate the 
software through the Ignition Gateway. If you are adding any additional modules, your account is updated and you can re-use your existing CD-Key to 
activate the new features.

You can unactivate your CD-Key, thus freeing it for activation on a different machine.

   

Licensing for Production Use  

One thing to consider when deploying an Ignition installation to production use is the way Ignition will be licensed. 

USB License Key

If you anticipate that the installation might move from server to server frequently, you may want to consider purchasing a USB license key to ease 
transition to new servers. This also makes things more convenient when the server is being deployed in an area without an active internet connection.

File-based Licensing

When the installation is on one server and not moving, you can use a file-based licensing scheme, and with an internet connection you can activate 
the installation online. If you don't have an internet connection, you can download an activation request file and put it on a portable memory device 
and take it to a workstation with an active internet connection.

Then you upload the file to the Inductive Automation website and you will receive a license file, called  , in return. Take this file back to license.ipl
the Gateway you are trying to activate, in the   section under   you can upload and activate the license.Config System > Licensing

 

Information Collected at Activation
When activating an Ignition installation, there are several pieces of information that are communicated to the activation servers and then stored 
internally at Inductive Automation. Some of this information is used to generate a unique license for the server on which Ignition is being installed.

The following are the type of information that is collected at the time of activation:

CD Key

System ID - a hash representing the hard drive serial number (windows) or inode number of the /bin folder (linux)

Java Runtime Version



1.  

2.  

3.  

Java Vendor

Java Version

Java Virtual Machine Name

Java Virtual Machine Vendor

OS Architecture

OS Name

OS Version

Processor Count

Total Physical Memory

 

How Un-activation Works
For a given CD-Key, only one Ignition Gateway instance is allowed to be activated at a given time. If you want to activate Ignition on a different server, 
you must first unactivate the previous server.

To unactivate the Gateway, do the following steps:

From the  section of Gateway, go to . Configure System > Licensing
The  page is displayed and you can see the currently installed License Key.Licensing and Activation

Scroll-down, find the orange arrows, and click on  .Unactivate License
The   page is displayed.Really Unactivate?

Click   to remove the activation from this copy of Ignition.Confirm
If the Ignition server has internet access, the unactivation occurs immediately, and the license is again available for activation on another 
Gateway server.
If the Ignition server has no internet access, an unactivation request file is generated, and the license is not allowed to be activated until the 
file is loaded into the Inductive Automation website, or emailed to Support. See  for step-by-step instruction to activate Transferring a License
the license on a new Gateway server.

 

 

In this section ...
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About Licensing
   

Ignition is a modular platform, therefore it is licensed based on modules. Licensed and unlicensed 
modules can operate side-by-side, so some modules can be tested in trial mode while others are running 
in a licensed state.

To see detailed information about the modules licensing status along 
with the version number for each module

Go to the   section of the Gateway webpage.Configure
 
Select  .System > Licensing
The   page is displayed. Here you can see the CD-Key for the Ignition Licensing and Activation
license plus all the modules that Ignition is licensed for. The version number for each module is 
also shown.
 

 
Go to  .Configuration > Modules
The   page is displayed. Here you can see all the modules that are Module Configuration
currently running with their version numbers and license status. The licenses are either in   Trial,

or  mode. On this page, you can add or remove modules from your Ignition. If Activated,  Free
you are licensed for a module you are running, it will run in  mode. If you are not Activated
licensed for a module you are running, it will run in  mode until the Trial time is expired.Trial
 

 
Compare the module version numbers from Step 2 and Step 3.
If you find from Step 2 that your license has an older version of a module than from Step 3, the 
one you are running in Trial mode, you can continue to use the Trial mode as long as the Trial 
time is not expired.  When a module is in Trial mode, Ignition shows the Trial time remaining in 
the   section of the Gateway webpage under  .Configure System > Status

About Licensing

Watch the Video

 

 

 

 

Next ...

About the Trial Period
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About the Trial Period
   

Inductive Automation offers you an easy way to access and learn Ignition. You download Ignition on the 
web and start using it for 2 hours at a time, with no other restrictions.

When unlicensed, the Ignition Gateway will run for two hours at a time. At the end of the 2-hour period, 
all unlicensed modules are stopped and the system will stop most of its functions. All the different parts of 
the Gateway, including all the modules, share the same clock and will timeout simultaneously. For 
example, all transaction groups will stop logging and clients will show a demo screen.

You can re-start the trial period by logging into the Gateway and enabling another 2 hours of execution. 
The trial period may be restarted any number of times.

You can check the amount of time remaining on the Trial period from the  page of the System Status Con
 section on the Gateway webpage. If you find the Trial period has ended, click on  at figure Reset Trial

the very bottom of the page to start a new 2-hour time.

Depending on the module, you may need to take some additional actions. For example, the Vision 
Clients requires you to log out and back in again in order to continue the trial.

About the Trial 
Period

Watch the Video

   

 

 

   

If you have a license and want to try out other modules, just add them to your gateway.  when Only the modules that are unlicensed will time out
the Trial period ends. All other modules will continue working normally.

If you see the Trial timer when you think you shouldn't, go check the  in the Configure section. Sometimes you have a module installed Modules page
that you didn't know about, or you have a module that is a newer version than your license. 

   

Next ...

Activating Over Internet
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Activating Over Internet
   

Before you do the following steps...

Make sure you have received a  from Inductive Automation.CD-Key

To activate your license over the internet

Go to the Gateway webpage and login to the  section.Configure

From the menu on the left, select . System > Licensing

Look for the orange arrow and click on the  link.Purchase or activate this Ignition Gateway
The  page is displayed.Purchase or Activate?

Click on .Activate

Enter your   and click . CD-Key Activate

The request to Activate is processed over the internet.When you don't have an Internet 
connection, the   page is displayed describing how you can  .Offline Activation activate manually

The  page is displayed. You can see the   along with Licensing and Activation Current License
all the modules that come with your CD-Key.

From the menu on the left, select . Configuration > Modules
The Module Configuration table is displayed. You can see that the license for all the modules 
are now activated. 

Information Collected at Activation

When activating an Ignition installation, there are several pieces of information that are communicated to 
the activation servers and then stored internally at Inductive Automation. Some of this information is used 
to generate a unique license for the server on which Ignition is being installed.

The following are the type of information that is collected at the time of activation:

CD Key

System ID - a hash representing the hard drive serial number (windows) or inode number of the /

bin folder (linux)

Java Runtime Version

Java Vendor

Java Version

Java Virtual Machine Name

Java Virtual Machine Vendor

OS Architecture

OS Name

OS Version

Processor Count

Total Physical Memory

Activating Over 
Internet

Watch the Video

   

   

Next ...

Launching Gateway
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Activating Manually

Before you do the following steps...

Make sure you have received a  from Inductive Automation.CD-Key

To activate your license manually, that is offline, not over internet

When you do not have internet connection, you can do the following steps to activate your license 
manually:

Go to the Gateway webpage and login to the   section.Configure

From the menu on the left, select  . System > Licensing

Look for the orange arrow and click on the   link.Purchase or activate this Ignition Gateway
The   page is displayed.Purchase or Activate?

Click on  .Activate

Enter your   and click  . CD-Key Activate

When you don't have an Internet connection, the  page is displayed Offline Activation
describing how you can activate manually.
In the offline activation process, an activation request file, called  , activation_request.txt

is generated and downloaded.
 
Take the  file to a machine with Internet access and either go to activation_request.txt
the  area on our website to activate there or email it to Support support@inductiveautomation.

. Either way when activation is done, a license file called  is generated.com license.ipl
 
Take the   file back to the Gateway machine to enter it into the license.ipl Licensing and 

 page and click the  button.Activation Activate

Activating Manually

Watch the Video

Next ...

Launching Gateway
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Reloading a License
   

Your license needs to be reloaded once it has been upgraded by Inductive Automation to include new 
modules, removed modules, or a different license level. The same CD-Key is used for the license 
upgrade. You can update your license using the same CD-Key by reloading the license from the same 
location in the Gateway as activation.

With Internet Connection

With internet connection, you do the following steps to update and reload your license:

Go to  section in the Gateway webpage.Configure
 
Click on .System > Licensing
The  CD-Key and activated modules are displays.Current License
 
Find the orange arrows at the bottom of the page and click on . Update License
This connects your machine to the Ignition licensing server. The licensing server verifies your 
license CD-Key to be valid then updates your license. You will see new modules, if you have 
purchased any, and new versions for the modules you already have. 

 

 

Without Internet Connection

If you do not have internet connection and want to reload and update your license, you must unactivate 
and manually activate Ignition. Do the following steps:

Go to   section in the Gateway webpage.Configure
 
Click on  .System > Licensing
The  CD-Key and activated modules are displays.Current License
 
Unactivate Ignition. Find the orange arrows at the bottom of the page and click on . Unactivate
Ignition will attempt to unactivate automatically but if it cannot, a new page will open with 
instructions for manual Unactivation. Follow the steps there. This will include downloading an 
unactivation file and taking it to another computer that has an internet connection. Have a thumb 
drive handy to transfer files if you can't send them directly to another computer.
 

Reloading a License

Watch the Video
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4.  Activate Ignition. With any new activation, all updates to the license will be automatically 
applied. Follow the previous steps but this time click the Purchase or activate this Ignition 

 link. For more help activating Ignition manually, see the  section. Gateway Activating Manually

   

   

Next ...

add link here
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a.  

Emergency Activation
   

What is Emergency Activation?

After activating your License Key in Ignition, you may see a banner that says Ignition is in Emergency 
. Activation Mode

What does this mean?

This means the License Key that you used has already been activated. Either it was used previously on 
another computer, or something went wrong during activation and it registered twice. Fortunately, you 
have plenty of time to fix this problem. Emergency Activation More means you are fully licensed for 7 

, so even at night or over the weekend, you can still run without interruption until it is fixed.days

How do I fix it?

In order to fix your License Key, you must  . You can reach us by email or contact Inductive Automation
by phone and we will walk you through fixing your license. It is usually a very quick procedure that 
involves you re-activating after we have fixed your License Key from our end.

Why does this exist?

Basically: computers sometimes fail and you need to get running again, fast.

When you initially activate your copy of Ignition, it will run as long as your computer does. As we all 
know, sometimes there are hardware failures or your computer just stops working. There are many 
things you can do to minimize this, but once it happens you need to be able to get Ignition up and 
running again quickly. This Emergency Activation Mode allows you to do this without having to involve 
Inductive Automation until after your facility is back on track.

Emergency 
Activation

Watch the Video

 

 

 

   

Quick Disaster Recovery Plan

What you need before an emergency happens

If you already have Ignition installed and running in your facility, it's easy to get back to running quickly. 
Just make sure you have the following stored on a computer or shared drive that is not your Ignition 

:Gateway

A  . If you don't already, you should set up  . Gateway Backup Automatic Backups
Your Ignition License Key. Make sure you store the 6 digit code somewhere that you can easily 
retrieve it if your computer fails.
The  . In an emergency, it's best to have the installer for the version you Ignition software Installer
are currently using. You can always download an archived version from our website, but having 
one on hand is preferred.  : Edit the installer filename to include your License Key so it's Pro tip
easily available.

Emergency Restore Steps

Find another computer or create a new Virtual Machine. You need to get something up and 
running to put Ignition on first. We recommend having something on standby that is the same as 
the original computer. Further considerations:

Set your new computer to the same IP Address of the original Ignition Gateway. This 
way your clients won't need to do anything special to start running again. 
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5.  

Make sure your firewall is set correctly. At minimum, you must have the Ignition port 
open (8088 by default). In an emergency situation, you may want to just disable the 
firewall temporarily.
 

Install Ignition on the new computer. If you don't have Java installed already, Ignition will install it 
for you.
 
Load a Gateway Backup. Everything in Ignition is in the Gateway Backup, once it's loaded, you 
are running again!
 
Activate your License. Your existing License Key will only work normally the first time it is used. 
After that, if you try to use it again, it will instead go into an  . This gives Emergency 7-Day Trial
you plenty of time to get back up and running before you have to deal with the License Key, 
even if your failure is on the weekend or outside Inductive Automation's business hours. 

Contact Inductive Automation. You can reach us by email or by phone ( ) and we 1-800-266-7798
will walk you through fixing your license.
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Transferring a License
   

You can transfer your license from one machine to another by simply unactivating the currently licensed 
machine and activating the other one.

The unactivation process is similar to the licensing activation procedure, but in reverse. If the 
licensed Ignition server has internet access, the unactivation occurs immediately, and the license is again 
available for activation.

If you do not have internet access, an unactivation request file is generated, and the license is not 
allowed to be activated until the file is loaded into the Inductive Automation website, or emailed to 
support.

Transferring Licenses with Internet Access

Lets say you have two different copies of Ignition, an  at:old Ignition

10.20.7.132:8088/main/web

and another  at:localhost Ignition

localhost:8088/main/web

Transferring a 
License
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On the old Ignition

Go to the  , as in our example, go toold Ignition

10.20.7.132:8088/main/web
Go to the   section of the Gateway webpage.Configure

Select  .System > Licensing
 
On the   page, look for your current license CD-Key, and write down the Licensing and Activation CD-Key.
You will need to enter this CD-Key to activate the new Ignition.

Scroll-down, find the orange arrows, and click on  .Unactivate License
The   page is displayed.Really Unactivate?

Click   to remove the activation from this copy of Ignition.Confirm

On the other copy of Ignition

 Go to the other copy of Ignition, as in our example at localhost:

localhost:8088:main/web

Select  .System > Licensing
On the   page you can see that under   there is  .Licensing and Activation Current License No license installed

Find the orange arrow, and click on  .Purchase or activate this Ignition Gateway
 page is displayed.Purchase or Activate?

Click on  . Activate

Enter your   that you wrote down previously and click  . CD-Key Activate

You have now transferred the CD-Key from one copy of the Ignition to another copy of it.

   

Next ...
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Ignition Redundancy

Ignition uses redundancy to maximize uptime execution by using a two-node system, a master node and 
a backup node. In this section you will learn how to set up redundancy and what to consider about 
databases when using this model.

In this section ...



How Redundancy Works
 

Ignition redundancy supports 2-node systems, this means there are two copies of the Ignition Gateway. 
One node (the Master Gateway) is considered the   and the other (the Backup Gateway) is master node
the . Both nodes share the same  or configuration. In other words, all backup node state
projects, Gateway settings, and so on are shared between the nodes. The master node manages the 
configuration then replicates it to the backup node.

When you have the redundant system in place, you can get detailed status information by going to the St
atus tab of the Gateway webpage as shown here and looking at the system's map:
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Node Communication
The master and backup nodes communicate over TCP/IP. Therefore, they must be able to see each other over the network, through any firewalls 
that might be in place. By default, all communication goes from the backup to the master node on port 8750. Therefore, that port must allow 
TCP listening on the master machine. You can change the port from the Gateway webpage in the  settings page.Redundancy

 

Configuration Synchronization
The master node maintains the official version of the system configuration. You must make all changes to the system on the master Gateway, 
the backup Gateway does not allow you to edit properties. Similarly, Designer only connects to the master node.

When changes are made on the master, they are queued up to be sent to the backup node. When the backup connects, it retrieves these updates, 
or downloads a full system backup if it is too far out of date. 

If the master node has modules that aren't present on the backup, they are sent across. Both types of backup transfers,   and  , will trigger data only full
the Gateway to perform a soft reboot.

 

Runtime State Synchronization
Information that is only relevant to the running state, such as current alarm states, is shared between nodes on a differential basis so that the 
backup can take over with the same state that the master had. 

On first connection or if the backup node falls too far out of sync, a full state transfer is performed. This information is light-weight and does not trigger 
a Gateway restart.

 

Status Monitoring
Once connected, the nodes begin monitoring each other for liveliness and configuration changes. While the master is up, the backup runs according 
to the  in the settings.stand by activity level

https://www.inductiveuniversity.com/video/how-redundancy-works/7.8


When the master cannot be contacted by the backup for the specified amount of time, it is determined to be down and the backup 
assumes responsibility. When the master becomes available again, responsibility is dictated by the recovery mode and the master either takes 
over immediately or waits for user interaction.

 

System Activity
When a node is active, it runs fully, connecting to any configured OPC servers, and communicating with devices. When it is not active, its activity level 
is dictated by the settings, either  or .warm cold

In  standby, the system runs as if it were active, with the exception of logging data or writing to devices, allowing for faster fail-over.warm
In  standby, the system does not subscribe to tag values, and does not communicate with any device. This allows the system to standby cold
without putting additional load on the devices and network. Fail-over takes slightly longer, as tags must be subscribed and initialized.

 

Historical Logging
Historical data presents a unique challenge when working with redundancy because it is never possible for the backup node to know whether the 
master is truly down or simply unreachable. If the master was running but unreachable due to a network failure, the backup node becomes active and 
begins to log history at the same time as the master, who is still active.

In some cases this is OK because the immediate availability of the data is more important than the fact that duplicate entries are logged. But in 
other cases, it's desirable to avoid duplicates, even at the cost of not having the data available until information about the master state is available.

Ignition redundancy provides for both of these cases, with the , which can be either  or .backup history level Partial Full

In  mode, the backup node logs data directly to the database.Full
 
In  mode, however, all historical data is cached until a connection is reestablished with the master. At that time, the backup and master Partial
communicate about the uptime of the master, and only the data that was collected while the master was truly down is forwarded to the 
database.

 

Client Fail-over
All Vision clients connect to the active node. When this system fails and is no longer available, they automatically re-target to the other node. 
The reconnection and session establishment procedures are handled automatically, but the user is notified that they have been transferred to 
a different node so that they can notify the system administrator that the system may need attention.
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Setting Up Redundancy
 

Before You Set Up Redundancy

In redundancy, both nodes will share the exact same configuration state. When a backup node joins a 
master node, it downloads a backup of the master's state and restores that backup on itself. Therefore, 
before you set up for redundancy, you need to consider and take care of the following things:

Start with a fresh install for the backup node.
Because the current configuration of the backup node is overwritten, make sure that it does not 
contain anything valuable in it when enabling redundancy.

All system configuration relative to the master node must also resolve on the backup 
node.
For example, OPC-UA connections and database connections must use addresses that resolve 
from both nodes, or any OPC-COM servers must be installed and configured identically on both 
nodes. This means using "localhost" in any of the database connections won't work. You should 
use the IP Address of the computer instead.
 
Configure firewalls between the redundancy nodes. 
Redundant systems need TCP connectivity between each other on a variety of ports. Turning 
off software firewalls or adding special exception rules for each others' addresses is required. 
Specifically, the master node must be able to receive data on TCP/IP  (you can port 8750
change this in the Settings), and the backup node must be able to send outgoing data on that 
port.

To Set Up Redundancy

Once the above two points are done, setting up redundancy is fairly simple. You do the following steps to 
set up your redundant pair:

On the Master Gateway

Go to the  section of the  webpage.Configure Master Gateway
 
Select .Configuration > Redundancy
The  page is displayed showing different sections Redundancy and Network Configuration
and settings.
You can use most of the default settings on this form.
 
Change the following Settings:

Redundancy Settings, set   to Mode Master
Backup Mode Settings, type in the   (for example, 10.20.8.12)Master Node Address
 

Click .Save Changes
 page is displayed.Confirm change to Redundancy Settings

 
Click  to apply your settings. Confirm

Select   to ensure the redundancy mode and state is properly set.System > Status

On the Backup Gateway

Do the exact same steps 1-6 above on the  webpage, except in step 3 set the Backup Gateway
 to .Redundancy Settings Mode Backup

 
Verify the correct port setting in .Network Settings
 
To verify the redundancy setup, that is, to ensure the master and the backup Gateways are 
connected, go the  tab of the Gateway webpage and see the  . The System Status System Map
Map should show the connected nodes and their current states.

After saving, the system connects to the master and downloads a system backup and restarts. 
Once the restart is complete, the backup node is synchronized and in communication with the 
master.

On this page ...

Redundancy Settings
Troubleshooting
Next ...
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The OS platform (i.e. Windows, OS X, Linux) for the Master and Backup must be the same for 
Redundancy. This means that if your Master Ignition is installed on Windows 8, your backup 
can be on a Windows 10 machine, but not on OS X.

https://www.inductiveuniversity.com/video/setting-up-redundancy/7.8


Redundancy Settings
All redundancy settings are configured in the Ignition configuration Gateway under  . Most settings are used by both the Configuration>Redundancy
master and backup nodes, with their individual settings broken out into separate categories.

It is important to know that while the full system configuration is shared between nodes, redundancy settings are not shared between nodes. 
Therefore, it is perfectly acceptable to have different values for the same settings on the two nodes. For example, it is possible to have a different 
Standby Activity Level on both nodes, and, of course, the network settings will often be different.

Redundancy Settings

Mode Independent - Redundancy is not enabled and this Ignition system runs as an independent node.

 - This is the master node, who listens for a connection from the backup node, and is inMaster
charge of managing system synchronization.

 - This is the backup node, who will connect to the master and receive system updates.Backup

Stan
dby 
Activ
ity 
Level

How the node operates when it is not the  node.Active
 - Performs minimal activities, does not connect to devices, and so on. The purpose is to minimize the load onCold

the network and on devices.
 - Connect to devices, subscribe to tags and set up all executing objects. The purpose is to minimize fail-over time.Warm

Fail-
over 
Time
out

The time, in milliseconds, before the opposite node is determined to be unavailable and this node takes over.

Start
up 
Conn
ectio
n 
Allo
wance

The time, in milliseconds, to wait on initial startup for a connection to be established before making a decision on the node's activity level. 
This is used to prevent unnecessary switch over caused by a node starting as active, only to connect and find that the other node is 
active, resulting in one of the nodes being de-activated. It is important to note that this setting can interfere with the Master Recovery 
Mode - if the master is active, it will always request the backup to de-activate. If this setting is low, or 0, the master will always become 
active before connecting to the backup, and thus "manual recovery" will not be possible.

Network Settings

Port  For the master, the port to listen on. For the backup, the port to connect to on the master.

Auto-detect 
Network 
Interface

If true, the system will automatically select which network interface to use on the machine. If false, the system will bind itself to 
the interface of the specified address.

Network Bind 
Interface

The address to bind to if Auto-detect is false.

Auto-detect 
HTTP Address

When clients are launched, they are provided with a list of addresses that they may connect to. If this option is true, the list will 
be generated automatically. If false, they will be provided with the list specified.

HTTP 
Addresses

The list of addresses to give to the clients if auto-detect is turned off. These are the addresses that the clients will attempt to 
connect to, so the HTTP and HTTPS ports must match the configuration of the system in the Gateway Control Utility

Master Node Settings

Reco
very 
Mode

How the master acts when it connects to a backup node that is currently active.
 - The master automatically takes back responsibility, and becomes active. The backup node goes to standby.Automatic

 - The backup node is allowed to stay active. The master will become active if the backup node fails, or if the user requests a Manual
switchover from the Gateway configuration page.

Runt
ime 
Upda
te 

How many "runtime status updates" can be queued up in memory before the system stops tracking them and forces a full refresh. These 
updates represent information that the other node should have in order to have the same running state as the master when it's forced to 
take over. This is most often the values of static tags and the current alarm state. Given that the update buffer is only used once the nodes 
are connected, the default value is usually fine, and only needs to be increased on systems that may have many alarms that change 
together, or many static tag writes.



Buff
er 
Size

Backup Node Settings

Master 
Node 
Address

The address where the master is located.

Ping Rate The time, in milliseconds, between messages from the backup to the master.

Reconne
ct Period

How often in millisecond, to re-attempt connection when the backup node is not connected to the master.

History 
Mode

How history is treated by the backup system. If Full, history will be stored normally, as it would be on the master system. If Partial, 
history will be cached until the master is available again and the backup node is able to determine the exact time that the master 
was down.

 

Troubleshooting

Redundancy Connectivity

When the two redundant nodes are connected, you will be able to see their state details in the   section of the Gateway webpage. There are Status
also various other places where the redundancy state is shown as  .connected

If the two nodes cannot connect, check the following:

Verify that the master address is correct in the backup. Try to ping the master machine from the backup machine, and verify that you're using 
the correct address for the network card that the master is connected through.
If using system names (or domain names), verify that the name is resolving to the correct address by performing a ping. 
Verify that the firewall on the master is set to allow TCP traffic to the designated port.
Verify that the backup is not connecting and then immediately disconnected for some reason. 
Viewing the error log in the gateway console section should show this. If errors are occurring at regular intervals, look at the message for an 
indication of what is happening. An example of a potential problem is when the failover time is set too low for the given network, which results 
in many socket read timeout exceptions, which in turn leads to many disconnect/reconnect attempts.
If errors are occurring, but the cause isn't clear, contact Inductive Automation Support.

Advanced Troubleshooting

A variety of loggers can be found under the Gateway console section by going to "Levels" and searching for "Redundancy". By setting these loggers 
to a finer level, more information will be logged to the console. This is generally only useful under the guidance of Inductive Automation 
support personnel, though more advanced users may find the additional logged information helpful.
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Database Considerations

Given that many parts of the Ignition system interact with the database, it's important to give 
some thought as to how it will be used when redundancy is turned on, and the different 
database architectures that are possible.

Ignition Database Requirements

When evaluating database architectures for use with Ignition, it's important to look carefully at how 
the system will use the database. Which pieces are critical? Which pieces are "optional" so that 
the system continues to function while the database is down? Which pieces can operate in "read-
only" mode if necessary?

Ignition uses the database for many purposes. Here are some common areas where they are used, and 
how availability can impact the system:

Tags

If using the default internal provider,  only rely on the database for tags which execute queries. Tags
These tags will error out if the database is unavailable, but the status and control functionality of the 
system will function on the whole. If using an external provider, which is housed in the database, the tags 
will no longer function. Therefore it's much more important to have a read-capable database connection 
available when using external tags.

History - Tags and Other

All history in Ignition goes through the store-and-forward system, meaning that it will be cached until the 
database is available. However, while the data is cached, it will be unavailable to view or analyze on the 
clients. Therefore, when looking at how the database should be set up, it is necessary to determine how 
crucial rapid-availability of the data is.

Alarming

The alarm status system does not reside in the database, so it will continue to function if the connection 
is down. Alarm log information will go through the store-and-forward system as history data.

Project screens

Almost all projects use database access for providing information on screens. These queries will error 
out as long as the database is unavailable. Screens that only use Tags (in an internal provider) will 
continue to function, so it would be beneficial to make a distinction between status screens and history 
screens, if a failover database is not used.

Database Architectures

Single Shared Server

A single database server is used. The Ignition gateways will both use it, so it is expected to be available 
even when one of the nodes is not. For that reason, it almost always resides externally, on a separate 
server machine. This arrangement is the easiest to use with Ignition. A single database 
connection configured on the master will be replicated to the backup, and both nodes will use the 
connection as necessary.

Clustered/Replicated Database Servers

There is a wide variety of capabilities supported by the different brands of database servers. To obtain 
fault-tolerance on the database front, it is usually necessary to have some sort of cluster/replication 
system in place. However, it can be very important to examine how Ignition is using the databases, and 
what capabilities the clustering solution provides.

For example, in many replication scenarios, the master database copies data to the backup. The backup 
can be used for read purposes, but new data inserted will not be replicated back to the master. 
Therefore, it is possible to have a failover connection to the backup database, so that clients will continue 
to receive data, but it would be necessary to run in partial history mode, so that the historical data was 
cached and inserted only to the master database. The failover connection would be set to standard 
mode, so the primary connection would be used when possible.

In a more complete cluster environment, where writes to either node would be replicated, a sticky failover 
connection could be used with full history mode.

On this page ...
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Pertinent Settings

When working with various database architectures, there are a few settings in various parts of the system 
that are important.

Database connection settings - Failover Datasource

Any database connection can have a failover datasource. If the main connection is unavailable, 
any queries executed on it will pass through to the secondary connection. In this way, a 
secondary database can be used when the first is not available, and the system will continue to function. 
It is important to note that everything passed through to the failover will function normally- no 
special considerations will be made. For example, the system won't cache data for the primary 
connection, it will forward it to the secondary. In cases where you want to allow reading from the 
secondary database, but not writing, you can set up another connection directly to the first database, with 
no failover, and set all of your write operations to use that.

Clustering settings - History Mode

The history mode dictates how history will be treated when the node is not active. If partial, the data will 
be cached, and only forwarded when the master node is available. This mode can be used to prevent 
data from being inserted into a backup database in some cases.

Next ...



Redundant Licensing
 

In redundant systems, both Ignition Gateways need their own licenses. It is possible to use two standard 
Ignition licenses in a redundant system: one license will be applied to the master gateway, and the other 
license will be applied to the backup gateway.

Backup-Only Licenses

Backup-Only licenses are available for purchase. This license force the gateway into a Backup mode, 
and the mode can not be changed while the license is applied. The benefit of this type of license is that 
they come at a discounted price. For more details, contact your Account Representative. 

If using a Backup only license, the Mode property on the Backup Gateway's Redundancy page will look 
like the image below.

Instead of the dropdown list that normally appears on this property, the license has forced this gateway 
into a Backup mode. 

If you would like to change the mode of this gateway, the backup-only license must first be unactivated. 
Once unactivated, a new license will need to be applied, otherwise the gateway will operator under a 2 
hour trial.

 

Redundant 
Licensing
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Designer
   

The Ignition Designer is a web-launched application that lets you configure and build your projects to be viewed by the network Clients. 
The application is launched from the Gateway homepage by clicking on the  button on the top-right of the page.Launch Designer

 

   

In this section ...  

   



Designer Basics
   

The Ignition Designer is where the majority of configuration and design work is done. You  it web-launch
from the Gateway and use it to build projects, which are the major unit of design. The projects are then 
viewed by the Clients. 

What is a Project?

In Ignition, a project is a unit of configuration that contains: Windows, Components, Transaction 
Groups, General Settings, and Security Settings. You use the Designer to configure and create projects. 
The projects are then viewed in the runtime Clients.

Here are two examples of projects as created in the Designer and viewed in the Client:
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When you launch the Designer, you're asked to select or create a project. The Designer then launches the project and you can set and modify the 
different types of project settings and resources. In the Designer, you can create any number of projects. Projects that contains viewable elements, 
such as windows or reports, will have a launch link on the Gateway homepage. Otherwise, the project runs in the Gateway and will not have a Client 
runtime.

There is no limits to the number of projects that can be created on a Gateway, but each runtime Client or the Designer can operate only on one project 
at a time.

After you make all your changes and save the project, all the project settings and resources are sent to the Gateway, where they are handled by the 
appropriate modules.

What is not a Project?

There are a number of settings that are shared by ALL projects on the Gateway system, such as, tag providers, database connections, OPC server 
connections, OPC-UA module device configurations, and alarm notification pipelines. A project does not contain these settings. 

Creating a Project

While launching the Designer, the   window is displayed. You will have the option to create a new project or open an existing Open/Create Project
project.
 



To create a new project, click on   and define following information:New Project

Project Name
A unique name for the project in the system. The name can only consist of alphanumeric characters and the '_' character. Spaces and other special 
characters are not supported. 

 it is not advisable to change the name after it's been created, instead, change the  if you want to change how the project appears Note: Project Title
later.

Project Title
Is how the project will appear to users in runtime Client.

Authentication Profile
The profile to use for granting access to the project. For more information, see .Security

Default Database
All elements of the project will use this default database connection unless explicitly specified otherwise.

Default Tags Provider
The primary tag provider for the project. Most installations will likely only have one provider, but in situations where there are more than one, this is the 
provider that will be used by default.

Project Template
Gives you the option to choose a template for your project. Click the dropdown to see all the available options. 

Managing Projects

You manage the projects from the   section of Gateway by going to  .Configure Configuration > Projects

The   window is displayed and from here your can  ,  ,  ,  , or   each project. Look to the right of the project name, to Project view edit delete copy export
see the link for these actions.
 



 

Note: There are other things you can do to manage your projects in the Designer, such as the Client Poll Rate and Publish Mode. See the Project > 
 sectionGeneral Property Settings  for more information.

Viewing a Project

The   link on the   window, takes you to the   page where you can choose to view the   or view Project Project details for 'Project Name' Published Stagi
 version of the project. ng

Published vs Staging

Each project can have two distinct versions at the same time: the  version and the  version. Having a published version and a Staging Published
staging version allows you to make changes to a project, save the changes, and test out the changes before "publishing" it to a production 
environment.

Usually, Vision module Clients run the published version of a project. However, by launching a Client in a special mode (from the Designer or from the 
Config section of the Gateway), you can launch a Client that runs the staging version of that project. This staging Client will receive updates on every 
save, where the production Clients receive updates only on publish. This lets you test out your changes to the project in an actual Client, which is 
more realistic than the Designer's preview mode. 

Not all aspects that comprise a project use this system. It is primarily intended for systems such as the Vision module's Clients. Features that run 
persistently on the Gateway, such as Tags, the SQL Bridge's Transaction Groups, and Gateway-side scripting always run the most recently 
saved changes (the Staging version). Since these features by definition must run in exactly one place, they cannot be effectively "tested out" by 
simultaneously running a staging version alongside a published version.

In the Designer, choose the   menu item, then go to the  page to set the . By default, a new Project > Properties Project > General Publish Mode
project is configured to be in  publish mode, however you can change it to  publish mode. Auto Manual 

In the default Auto mode, when you want to save your project, Designer lets you do a , which means both the  File > Save and Publish
Staging and the Published versions will be the same and identical.

In mode, when you want to save your project, Designer lets you do both a  or a .  updates the  Manual File > Save File > Publish File > Save
Staging version, and  updates the Published version.File > Publish

Project Versioning and History

Each project keeps a log of recent changes. These include both saves and publishes. Every save increments a number called the "edit count" for the 
project, which can be used like a serial number. The user, time, affected resources, and a commit messages (described next) are logged as well. 

Commit Messages

A project may be configured to prompt the user making changes to describe those changes, either on every publish event, or on every save and 
publish event. These messages, called commit messages, are used to describe the changes that have been made to the project. By inspecting the 
project's history and reading these commit messages, you can learn what changes have been made to the project, for what reason, and by whom.

Editing a Project

To edit some of the project settings, go to the   section of Gateway, and then to  . You will see a list of all your Configure Configuration > Projects
projects. Click  to the right of project name in the list. The   page is displayed. You can now change some of the project settings such edit  Edit Project
as project name, description, and title. You can also change connections to the Authentication profile, default database, and default tag provider.

Deleting a Project

https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Project>GeneralPropertySettings
https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Project>GeneralPropertySettings


Be aware that once you delete a project, it cannot be undone, a deleted project is gone forever (unless it can be recovered from a or backup auto-
.backup

To delete a project, go to the   section of Gateway, and then to  . You will now see a list of all your projects. To the Configure Configuration > Projects
right of the project name in the list, look for  and click on it. This deletes your project.delete

Copying a Project

Copying your project is useful when you need a   of a project before starting major changes, or for creating a starting point for a new project snapshot
based on an old one.

To copy a project, go to the   section of Gateway, and then to  . You will now see a list of all your projects. To the Configure Configuration > Projects
right of the project name in the list, click  . This creates a copy of your project. copy

Exporting and Importing a Project

There are two primary ways to  or  projects:export/backup  import/restore

Project export and import
System backup and restore 

Project export and import

Projects can be exported (backuped) and imported (restored) individually. Project exports only include project-specific elements, like windows and 
groups. They do not include Gateway settings, like database connections and device configurations.

To export the project, go to the   section of Gateway, and then to  . You will see a list of all your projects. To the Configure Configuration > Projects
right of project name, click  . This exports your project as a *.proj backup file.export

To import the project, go to the   section of Gateway, and then to  . You will see a list of all your projects. Below the Configure Configuration > Projects
project table, next to the orange arrow, click the   link. Then choose your backup file and click  .Upload project from a *.proj backup file Upload

System backup and restore

You can backup a project as part of a full system backup. The system backup includes all of the projects in the system, in addition to all of the 
settings. Restoring a system backup replaces all current projects and settings on a Gatew  for more information.ay. See Making Gateway Backups

Concurrently Working on a Project

Often in large projects there are multiple people working on the same project. Multiple Designers can be launched concurrently so everyone can work 
on the same project. When a particular resource is being edited, it will be locked, and the other designers won't be able to modify it. When the project 
is saved, the resource is unlocked. Concurrent edits are received by other designers only when you do a  .File > Update Project

   

   

In this section ...  
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Launching Designer and Opening a Project
 

Now that we have set up some device and database connections (or not, if you skipped the last two 
steps as they were optional, after all), lets web-launch the Designer so you can work on your projects.

Web-launching is one of the best parts about Ignition. This is how we launch both the Designer, where 
you'll configure your projects, and the Ignition Vision Clients, where you can view the projects.

Web-launch technology lets you launch a full-fledged application with zero installation just by clicking a 
link on a webpage. This means that with Ignition, you'll only need to install the Gateway. All of your 
Designers and Clients do not need to be installed and they are always kept up-to-date.

Once you start using web-launched Clients, you'll wonder how you ever did without them!

 

Before you successfully web-launch the Designer, make sure you have Java installed.

If you're on the computer that's running the Ignition Gateway, you already have Java installed, the 
Ignition installer makes sure of that. If you're on a computer that is accessing the Gateway over the 
network, the   panel on the bottom of the Gateway's  page detects whether or Java Detection Home
not Java is installed.

Launching the Designer

Click  on the upper-right of any Gateway page.Launch Designer
Your web browser asks you if you want to Keep or Discard a  file.designer.jnlp
 
Click on the  file to start the Designer.designer.jnlp
 The Designer starts up and the login window is displayed.

Enter the default username and password for the Designer.  is the same as for the Gateway 
Configuration section, enter
Username: admin
Password: password

 

Click on .Login
The  window is displayed giving you two options, to create a new project Open/Create Project
or open an existing one. As we don't have any existing projects yet, we will create a new 
project. 

Launching 
Designer and 
Opening a Project

Watch the Video

To Continue on the 
step-by-step simple 
workflow...

After you Launch the Designer and 
opened your project, as described 
on this page, click the link below for 
Step 5 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

 

 

 

 This assumes that this username and password were never changed between 
installing the database and creating a new project. If this username and password 
does not work then the default username and password are no longer valid. Please 
refer to  to understand further how Ignition manages its users and their Security
passwords.

https://www.inductiveuniversity.com/video/launching-designer-and-opening-a-project/7.8
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In , enter a name for your new project (no spaces!).Project Name

For , select a template from the drop-down list, for example, you can select Project Template  
the   template.Single-Tier Nav, West & North

Rather than starting from a blank project, the templates let you start from one of the eight 
skeleton projects that already have navigation windows setup. These projects are completely 
customizable and are designed to help you get started faster.

Click on .Create New Project
The Designer is now launched and you can work on your project!



7.  

Once in the Designer, your can create or open a project using the Designer's  File > Open
menu. The   window is displayed and you can follow the same steps as Open/Create Project
above to open existing projects or create a new one.

 

Troubleshooting

What is Web-launching 

Web-launching is the mechanism by which Clients and and the Designers are opened on a computer. They are launched from the Ignition Gateway, 
you download and run them without requiring any installation steps.

How Web-Launching Works

Web-launching relies on Java Web Start technology. When the user clicks on a project or the Designer link in the Ignition Gateway (or embedded in a 
separate website), they download a small JNLP file that describes the application. When this file is opened (usually automatically), Java is invoked on 
the user's machine and directed to the remote application. The application is downloaded and cached, and then executed.
The running application (an Ignition Client or the Designer) communicates with the Gateway via HTTP. It is cached for increased subsequent launch 
speed, and can optionally install a link in the Start menu and on the desktop for easy access. By default a shortcut is created for you but this setting 
can be changed in the Java Control Panel.

Troubleshooting Web-launch Problems

There are a few common problems that can cause difficulties with web-launching. Fortunately, they are often easy to fix.

No Java Installed

Before you successfully web-launch the Designer, make sure you have  installed, see  .Java 8 http://www.java.com

If you're on the computer that's running the Ignition Gateway, you already have Java installed, the Ignition installer makes sure of that. If you're on a 
computer that is accessing the Gateway over the network, the  panel on the bottom of the Gateway's   page detects whether or Java Detection  Home
not Java is installed

No Network Connection

Web-launched clients depend on network connectivity to connect to the server. If the network is unavailable, the client cannot be launched. This is 
often a problem with clients and the Designers launched directly from desktop/start menu links.

Cached References to Modified Servers

The cached projects/launch shortcuts contain the address of the Gateway machine. If the server is relocated, these links will no longer work. They can 
be updated by re-launching from the Gateway.

Still having problems?

You can also see .Native Client Launchers

 

 

Next ...

About Project Templates

 

http://www.java.com/


About Project Templates
 

When creating a  in the Ignition Designer, you are given the option to choose from a number New Project
of project templates in the  field of the  window.Project Template Open/Create Project

 

Rather than starting from scratch, you can choose an existing template to create your project much faster 
and easier. The following are the available  you can choose from:Project Templates

Blank (Default)
Start from scratch with an empty project.

Single-Tier Nav, North
Tabbed navigation across the top of the project.

Single-Tier Nav, West
Tabbed navigation on the left side of the project.

Single-Tier Nav, West & North
Tabbed navigation with panels on top and left of the project. 

2-Tier Nav, North
Two layers of tabs docked north of the project. 

2-Tier Dropdown Nav, North
Tabs along top, with a dropdown selector, of the project. 

Multi-Tier Nav, West
Tree-based navigation on the left side of the project. 

Multi-Tier Nav, West & North
Tree-based navigation with a panel on the top and left side of the project. 

Mobile Project
A project template optimized for a small Mobile device. You don't have to use this template to launch in a 
mobile device. If you have the Mobile module, you can use all of the project templates with your mobile 
device.

About Project 
Templates

Watch the Video
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Using Designer User Interface
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Using Designer User Interface
 

Designer's Workspace
The Designer is organized in panels around a central . Some of these panels include:  workspace Project 

, , and . The workspace changes depending on the type Browser Tag Browser Property Editor
of resource that you are currently editing. For example, if you are editing a Window, your workspace will 
be the Window Designer. If you are editing a Transaction Group, your workspace will be the Transaction 
Group Editor, and so on.

There are many dockable and dragable panels that surround the workspace, as well as the familiar menu 
bars and toolbars. The dockable panels can be rearranged as you wish. Each type of workspace can 
have panels that are only valid when that workspace is active. Each workspace remembers its 
own perspective, which is the docking arrangement of the panels around it.

If you have closed a panel and want to get it back, re-enable it from the  submenu. The View > Panels Vie
 will reset the user interface back to its default window arrangement.w > Reset Panels

 

 

On this page ...

Designer's Workspace
Tools Menu
Help Menu
Docking System
Next ...

 

  

Using Designer 
User Interface

Watch the Video

Tools Menu

The   menu in the Designer provides some tools to help you when creating projects. The , , and  Tools Console Image Management Symbol Factory
tools are described here.

 

Tools > Console

The Output  is the script-writers best friend. It is a dockable panel, and you can open it via the   menu or the   keyConsole Tools > Console Ctrl-Shift-C
board shortcut. The output console is most frequently used to test and debug Python scripts in Ignition.

For example, by using the   function in your script, you can observe the inner workings of your script as it executes. If you executed the following print
script:

https://www.inductiveuniversity.com/video/using-designer-user-interface/7.8


# A python script that demonstrates the print statement
 
print "Print me first"
x=10
z=2
print x, y, x/y
 
#Result looks like this:
#Print me first
#10 2 5

 

 

Note: The output console is also available in the Vision Client from Help > Diagnostics.

See also: , Scripting Help Menu

Tools > Image Management

The Image Manager is available from the   menu. This tool is a drag-and-drop browser that helps manage the images Tools > Image Management
that are stored on the Gateway. It is important to realize that these images are shared across all projects: they are not stored inside a project 
itself. Use the toolbar at the top to do common tasks like uploading new images and creating folders. You can drag images and folders from your 
computer's desktop or hard drive into this window to easily upload new images to the Gateway.

You can also get to this tool by putting an   component on a window, and clicking the browse button on the Component Palette > Display > Image
image's   property.Image Path

See also: Images (png, jpg, gif)

Tools > Symbol Factory

If you have the Symbol Factory module installed, you'll be able to open the Symbol Factory browser under the Tools menu in the Designer. You can 
browse through the symbols or use the convenient search function to find the symbol you need.

Once you find a symbol, you can drag-and-drop it into a window. Each symbol is dropped as a shape group. You will be able to un-group it or double-
click into the group just as if you had drawn the symbol yourself using fundamental shapes. This means that you can alter the shape if you need to, or 
bind any colors inside the shape to a tag to make the shape dynamic.

Help Menu

Help > Diagnostics

 

 

The  menu in the Designer and the Vision Client has a   window that contains a number of tabs each providing a useful Help  Diagnostics
troubleshooting feature. You can right-click on any of the tabs to show or hide the other tabs. These tabs or the troubleshooting features are as follows:

Performance Tab
Displays a number of small realtime charts that show various aspects of the currently executing Designer or Client's performance. These charts can 
be very useful to help troubleshoot performance issues, especially slow queries. One of the most common causes of query slowdown is 
simply running too many queries too frequently, and the   chart can help identify when this is occurring.# of Select Queries (Queries/Second)

The statistics shown on this page apply to the current session only, you can see the Gateway statistics from the   section of the  .Status Gateway

Console Tab
Displays the Ignition Output Console.

Log Viewer
Displays the logged events for the current Designer or Client session. Whenever errors occur, they are logged and displayed in this tab. This is a good 
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place to go when troubleshooting an issue, as any errors shown here may illuminate the cause of the problem. To view entries across all categories 
chronologically, uncheck the   checkbox.Group Categories

Logging Levels
Determines the verbosity of a host of internal loggers. Most users will not use this tab unless prompted by a technical support representative.

Thread Viewer
Shows information about the currently running threads. Most users will not use this tab unless prompted by a technical support representative.

Connections
Displays the Gateway connection status as being connected or not.

Docking System

The Designer's docking system provides a very flexible user interface, allowing you to customize the layout as you wish. To re-arrange the dockable 
panels, simply drag on their title bars. As you are dragging the panel, use the highlighted border that appears to gauge where the panel will be moved 
to. Dockable panels can be in one of four modes:

Docked - The panel is visible, and located somewhere around the perimeter of the workspace. If two panels are docked in the same location, 
a tab strip will appear to switch between the two panels.
Floating - A panel can be dragged outside of the workspace perimeter to be floated. The panel can now be positioned anywhere on your 
desktop.
Pinned - Pinning a panel makes it minimize to one of the four sides of the Designer, represented by a small tab. Hover over the tab to use 
the panel.
Hidden - A hidden panel is not shown. You can open it again by selecting it in the   menu.View > Panels

Toolbars can also be rearranged and floated to your liking. Simply drag on the "textured" left edge of the toolbar. If you have re-arranged your panels 
into a layout that you don't like, you can quickly revert back to the default by selecting the   option from the menu bar.View > Reset Panels

 

 

Next ...

About Communication Modes

 

Expert Tip

Your docking preferences are stored under  . If you really want to reset your preferences, remove %USER_HOME%/.ignition/*.layout
these files and restart the Designer.
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About Communication Modes
 

The Designer offers three data communication modes for your projects:  , , Comm Off Comm Read-Only
or  . Comm Read-Only is the default mode, which does not allow writing from the Comm Read/Write
Designer to Tag or Database sources.

 

To set or change the communication mode

There are two ways to set or change the comm mode in the Designer:

Using the   menuProject
Using the   windowProject Properties

Using the   menuProject

On the Designer toolbar, go to the  menu and choose:  ,  , or Project  Comm Off Comm Read-Only Comm 
. See below on this page for a description of these comm modes.Read/Write

Note: The three icons in the toolbar under the   command, correspond to the three comm modes.Project

Using the   windowProject Properties

In the Designer, either double-click on the   node in  , or Project > Properties Project Browser
click on the   command on the top menu.Project > Properties
The   window is displayed.Project Properties
 
Go to the   setting section.Designer > General
 
Under  , for the   Startup Options Initial Gateway Comm Mode, choose from the dropdown Com

,  , or  .m Off Comm Ready-only Comm Read/Write
Note: These property settings are saved on a per-project basis.

Comm Off
In this mode all database query traffic and tag subscriptions and writes are blocked.
Experts often use the   mode while designing a window to temporarily shut off data Comm Off
flow so that they can manipulate component's bound properties without the values being 
overwritten by the data bindings. This is useful to set the values that they want to serialize into 
the window. This can be important for windows with large datasets, clearing the datasets before 
saving the window can significantly reduce the size of the window, improving performance.

 This setting does not affect the execution of a project's transaction groups, Note:
because transaction groups execute on the Gateway, not in the Designer.

Comm Read-Only (default)
Tag subscriptions and SELECT queries work, but tag writes and UPDATE/INSERT/DELETE 
queries are blocked.
The Designer starts up in   mode as a safety mechanism so that you don't Comm Read-Only
inadvertently write to a tag as you are designing. You can customize the Designer's startup mod
e, see the  section.Designer/General Properties

Comm Read/Write
All data is passed through to the Gateway. The mode can be switched at any time via the tri-

About 
Communication 
Modes

Watch the Video
 

 

 

 

 

https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-startup
https://www.inductiveuniversity.com/video/about-communication-modes/7.8


state toggle selection in the main toolbar, or the radio buttons in the Project menu.
A common beginner mistake is to forget to switch the mode to   when attemptiComm Read/Write
ng to test a window's functionality in  mode.Preview
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Previewing the Project

 



Previewing the Project
 

Preview the project by testing and interacting with the screens in the Designer before deployment.

Preview Mode

The window workspace operates in two distinct modes: design mode and preview mode. You can switch 
between these modes with the play/stop buttons in the toolbar or the  menu Project > Preview Mode
item. You can also use the  key to toggle between the two modes.F5

 

 

In design mode, your mouse is used to manipulate components in a window. You can select, drag, and 
resize them. You can alter data bindings and event script configuration. Data bindings are active in 
design mode, but event handlers are not.

In preview mode, you are interacting with a "live" version of the window. Property bindings and 
event handlers will run, just like in the Client.

Preview mode is useful for a quick check of the operation of a window, but it becomes 
cumbersome when trying to test a whole project. For that, we recommend having a launched Client up as 
well, and doing testing in the true Client. You can quickly launch a client in one of the three launch modes 
via the  menu.Tools > Launch Project

 

Previewing the 
Project

Watch the Video
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Using Find and Replace
 

The Edit > Find/Replace menu command in the Designer is a very handy tool. You can search your 
entire project for specific components, properties, scripts, Transaction Groups and more. You can then 
use the replace feature to make mass changes to a project with very little effort.

To Find and Replace

In the Designer, go to  or use the shortcut  .Edit > Find/Replace Ctrl-F
The  window is displayed. Find/Replace

Type what you're searching for in the textbox at the top to search through your project.
You can use the wildcard character (*) which will match anything, and the single-character 
wildcard character (?).
For example, to find all references to a tag that include the string  , you'd search for Motor Motor*

. This would match things like  ,  , and so on, whereas the search query Motor15 MotorHOA Valv

 would match   but not  .e?Status Valve1Status Valve38Status

 
In the   section, narrow down your search by choosing the options you are interested in.Target
It is often useful to specify a narrow search target. Find/Replace searches through many 
different parts of a project as well as through Tags. The target settings let you specify exactly 
what Find/Replace should search through. By unchecking boxes in the Target section, you can 
avoid search results that you aren't interested in.

Click the  button at the top right to execute the search.Find
All matching items appear in the  section. Double-click on an item in the Results table to Results
bring that item into editing focus in the Designer. 
 
To replace a value, select an entry in the Results section and you'll see the Value of that entry 

in the  box of the  section.Current Replace
 

Enter the text you want to use as a replacement in the textbox and a preview of the Replace 
new value is shown in the  box. Preview
 

Click the  button to execute the replace. Replace
This will move your selection down in the Results table so that you can rapidly execute multiple 
replacements. 
If you're satisfied and you'd like to make the identical replacement to many items, select them all 
in the Results table and click the Replace All button.

Using Find and 
Replace

Watch the Video
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Using the Query Browser
 

The  is a very convenient tool that lets you make simple edits in a database table, and Query Browser
interact with all of the databases that Ignition is connected to, for example running queries and browsing 
tables and schemas. Because Ignition is so heavily integrated with databases, it is very common in the 
course of project design to need to inspect the database directly, or to experiment with a SQL query to 
get it just right.

To Edit the Database using the Query Browser

In Designer, go to the   menu item. Tools > Database Query Browser
The   is displayed which lets you see a list of databases that Ignition Database Query Browser
is connected to plus a text box area so you can enter your queries. 
 
Choose a database from the list under .Schema
Notice the database is expanded and the Query textbox shows a SELECT query which includes 
the table's primary key(s) such as,  . Select * From database_name

Click .Execute
See the data that gets filled in the  tab. Resultset
 
Click  to change the values in the Resultset, and click  to commit your edits orEdit Apply  

 to back out.Discard
 You can  the values only when the table is displaying the  numbers (table's primary Note: Edit id

keys), otherwise you can not  the table values.Edit

To verify the changes you made, click .Execute
You should now see what you have modified is actually applied. 

To Monitor the Database using the Query Browser

The Query Browser also lets you monitor a database table for changes by using the  Auto Refresh
button. 

This is often convenient when designing Transaction Groups. As the group runs, you can view the 
table that it is targeting with auto-refresh turned on to watch how the group is altering the table. 

Using the Query 
Browser

Watch the Video
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Using the Popular Keyboard Shortcuts
 

You can interact with screens and more by using some of the popular keyboard shortcuts in the Designer.

 

To... Use these Keyboard Shortcuts

Nudge
Moves selected 
component(s) in the 
direction of the arrow key 
by the default nudge 
distance.

Alt-Nudge
Same as Nudge, but 
uses the “alt-nudge” 
distance.

Resize Right
Moves the right edge of 
the component left or 
right. Add Alt to use the 
alt-nudge distance.

Resize Bottom
Moves the bottom edge 
of the component to top 
or bottom.

Resize Left
Moves the left edge of 
the component left or 
right.

Resize Top
Moves the top edge of 
the component to top or 
bottom.

Move Forward/Move 
Backward
Moves selected 
component(s) in the Z-
order.

Move to Front/Move to 
Back
Moves selected 
component(s) to Front or 
Back.

Copy-Move
Copies the component 
when holding Ctrl while 
doing a mousemove.

Orthogonal-Move
Restricts to only moving 
straight up, down, left, or 
right when holding Shift 
while doing a 
mousemove.

Selection-Move
Drags the current 
selection when holding 
Alt while dragging.

Using the Popular 
Keyboard Shortcuts

Watch the Video
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Copy-Axis-Move
Combines copy move 
with axis move.

Proportional Resize
Resizes a component 
while maintaining its 
aspect ratio.

On-Center Resize
Resizes the selection 
using the center as the 
anchor point.

Select All
Selects all components 
that are siblings of the 
selected component.

Select Same Type
Selects all components 
that are siblings of the 
selected component and 
the same component 
type.

Select Same Type in 
Window
Selects all components in 
a window that are the 
same type as the 
selected component.

Layout
Opens Layout 
Constraints to let you 
specify layout for the 
component(s).

Size & Position
Opens Size & Position to 
let you specify exact size 
and position for selected 
component or window.

Customizer
Opens Custom 
Properties to let you 
configure complex 
component properties.

Customizer 2
Opens the second 
Customizer if available.

Jython
Opens Component 
Scripting to let you 
configure actions for 
component or window.

Security
Opens Security Settings 
to let you set security for 
Component(s) or window.

Script Modules
Opens Script Module 
Editor for reusable 
Jython functions.

Save
Saves the project.



Open
Opens the Open/Create 
Project to let you select a 
different project.

Undo
Undoes the last action.

Redo
Gets rid of the last undo 
action.

Copy
Copies selected 
component(s) or window.

Duplicate
Duplicates selected 
component(s) or window.

Cut
Cuts selected component
(s) or window.

Paste
Pastes selected 
component(s) or window 
in clipboard. Pasted 
component(s) wait for 
position before pasting.

Immediately Paste
Places pasted component
(s) at the same location 
where they were copied
/cut.

Comment/Uncomment 
Lines of Code
Quickly comment or 
uncomment lines of a 
script or query in 
Designer.

Cancel
Cancels a pending paste 
operation, deselects the 
current row of a table, 
cancels dragging 
components onto window.

Find/Replace
Opens Find/Replace to 
let you Search and 
replace the project based 
on string, pattern, or 
regex.

Delete
Deletes the current 
selection.

Snap to Grid
Toggles whether or not 
moving and resizing 
components snaps to the 
grid.

Snap to Guides
Toggles whether or not 



moving and resizing 
components snaps to 
guides.

Console
Opens the Output 
Console.

Help
Launches the Ignition 
User Manual in a web 
browser.

Preview Mode
Toggles preview/design 
mode.

Rename
Renames the selected 
item (tag, window, 
transaction group, 
component, and so on).

Launch Staging Project
Launches the staging 
client from the Designer.

Launch Published 
Project
Launches published 
client from the Designer.

Update Project
Updates project to 
server. Receives 
concurrent edits from 
other Designers.

Zoom
Zooms in/out in the 
Designer.

Lasso Select
Draws a lasso and every 
component in the path 
will be selected.
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Project Properties
 

There are a number of properties you can set or customize for your projects, the Designer, the Clients, and your Mobile device. For example, there are 
properties for setting the touchscreen mode, customizing a client's auto-login, or configuring how the clients receive updates.

 

   

In this section ...  

   



About Project Properties
The property settings on the  window apply to the whole project. Here you can set the Project Property
properties for your project, the Designer, the Client, and your Mobile device. 

To set the Properties

In the Designer, either double-click on the   node in  , or click on Project > Properties Project Browser Pro
 on the top menu.ject > Properties

The   window is displayed.Project Properties

On this page ...

Project/General Properties
Designer/General Properties
Designer/Window Editing Properties
Client/General Properties
Client/Launching Properties
Client/Login Properties
Client/User Interface Properties
Next ...

About Project 
Properties

Watch the Video

 

 

 

For a detailed description on how to set these properties see the following links:

Project 
General
Permissions 
 
Designer
General
Window Editing 
 
Client
General ( ,  )Update Mode Touch Screen
Launching
Login
Timing
User Interface
 
Mobile
General

Project/General Properties 

A project's general properties apply to the project as a whole, across all module functionality. For a new project, there are many default settings that 
you can use (see next). For example, there are default settings for the tag provider, database, publish mode, initial comm mode, window editing, and 
Client launching.

Note: There are a few properties of a project, such as its name, description, and title that are not available from the Designer and you need to set 
them in the Gateway. To do so, go to the Gateway, under the   section, click on the   link next to the project.Configuration > Projects edit

Important Concept: Defaults

Under   is where you set the project's   and its  . It is important to understand how to use Project > General Default Database Default Tag Provider
defaults effectively for proper project design.

https://www.inductiveuniversity.com/video/about-project-properties/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Setting+Client+Minimum+Size#SettingClientMinimumSize-TosettheClientsminimumsize
https://legacy-docs.inductiveautomation.com/display/DOC/Setting+Client+Minimum+Size#SettingClientMinimumSize-TosettheClientsminimumsize


Wherever you use a database connection or a Tag in a project, you are always given the option to use the project's default, or an explicitly named 
connection or provider. If your project is like most typical projects, it primarily uses a single database and a single Tag provider. By consistently using 
the   option, you make your project more resilient to change.default

For example, suppose you have designed a project, and it has a database connection named  . Now you want to adapt the project to Production_DB
a new, similar plant, while leaving the existing project intact. You copy the project and create a new database connection, named  . If New_DB
your project consistently used its default database connection, the switchover will be as simple as changing the copied project's default database. 
However, if you used the explicit   connection in your groups and screens, you will need to laboriously switch the bindings over to Production_DB New

._DB

The following are a description of the project properties you will see under  in the  window:Project/General Project Properties

Tag Settings

Default Provider

The Tag provider chosen here will act as the project's default provider. To use the default provider, simply omit the source section of a tag 
path, or leave it blank, for example: Path/To/MyTag or []Path/To/MyTag. 

See also: Keeping Tags Organized

Client Poll Rate
The Client poll rate is the rate at which a Vision Client or Ignition Designer polls the Gateway for updates to its subscribed Tags.
 

Database Settings

Default Database
This is the default database connection to use for this project. To use the default database connection, use the special   connectio<default>

n, or in scripting, the empty-string connection . ""

 

Security Settings

User Source
Choose the User Source that governs this project's security. The User Sources are all defined in Gateway's  section under the Configure Sec

 page.urity > User,Roles

Required Client Roles
This profile is for Client logins. You can also optionally specify a list of roles that are required for a user to log into this project. Use commas 

to separate the roles. Users must have the roles in order to log in. If no roles are specified, the  at least one of  user only needs to correctly 
authenticate with the User Source in order to log in.
To define the roles, go to the Gateway's   section under the   page, click the   link, and then go Configure Security > User,Roles manage users
to the  tab. Roles

See also: Security

Auditing Settings

Enable Auditing
If auditing is enabled, audit events will be stored that relate to this project in the chosen audit profile.

Audit Profile
The audit profile which will store the audit events when auditing is enabled.
 

Publishing Settings

Publish Mode
Here you specify whether or not a project is to have a separate staging and published versions. 

 In this mode, you can do a  to update the Staging version, and then a  to update the Published version.Manual: File > Save File > Publish
 In this mode, the only command available for saving your project is  which saves and then publishes, so the Auto: File > Save and Publish

two Staging and Published versions are always the same.

See also: Viewing a Project

Commit Messages
You can specify whether or not commit messages are required, and if so, under what conditions. You can specify the condition as:  , None On

, or  .Publish OnSaveandPublish

Designer/General Properties

https://legacy-docs.inductiveautomation.com/display/DOC/Designer+Basics#DesignerBasics-ViewingaProject


These property settings are saved on a per-project basis.

Startup Options

Initial Gateway Comm Mode
Designer starts up in the default Comm Read-Only mode. You can choose any mode you want the Designer to startup in. The options are: Co
mm Off, Comm Ready-only, Comm Read/Write. 

See also: About Communication Mode

Designer/Window Editing Properties

These options affect the operation of the Designer as it applies to the Vision module's window design.

Window & Template Committing

Commit on Close 
By default, every time you close a window, you are prompted whether or not you wish to  the window.Prompt:  commit 
This option allows you to skip the commit prompt, opting to always commit the window on close.Always: 

 
Template Auto-Commit
On: Automatically commits template masters when switching to another window or template.
Off: In this option you commit the templates manually, it reverts all changes to the last time the window was committed.
 

Component Manipulation

These options affect how the user interface acts in manipulating components.

Constrain to Parent Container Bounds
Disabling the constraint on parent bounds allows you to position components outside of their parents bounds, which can be helpful in 
advanced layouts.
 
Nudge Distance
The number in this box is the distance (in pixels) that a nudge moves (when using the arrow keys) or resizes a component.
 
Alt-Nudge Distance
The number in this box is the distance (in pixels) that a alt-nudge moves (when using the arrow keys plus the Alt key) or resizes a component.
Altering the handle opacity can be helpful when dealing with lots of very small components, so that you can see through the resize handles to 
align the component perfectly.
 

Default Component Layout

The layout constraints specified here are the layout constraints used for all newly added components.
 

Layout Mode

Relative
This mode makes a component's size and location relative to its parent's size and location. When the parent changes size, the component 
will change accordingly. This creates components that auto-scale.
 
Anchored
This mode makes the edge of a component's two axes (horizontal and vertical) anchored to the edge or edges of its parent.

Relative Layout Options

Maintain Aspect Ratio
If selected, the component's original aspect ratio is preserved. Otherwise, it can stretch tall or wide.
 
Center
When maintaining the aspect ratio, centers the component with respect to its parent.
 
Leading
When maintaining the aspect ratio, aligns the component with the paper leading edge.
 
Trailing
When maintaining the aspect ratio, aligns the component with the parent's trailing edge.
 
Scale Font
If selected, the component's font will scales along with its size as the relative layout adjusts the component. 
 

Default Color Mapping



The color mapping defined here will be the initial color mapping when configuring a new   property binding.number-to-color

Client/General Properties

These properties apply to the Vision Client in general.

Timezone Behavior

The Vision Client can emulate any timezone. By default, it will appear to be in the same timezone as the  . This has the effect of all Gateway Timezone
Clients behaving the same, regardless of the timezone setting on the Client's host operating system. Depending on your project's requirements, this 
may not be optimal. You can have the Client use the host's timezone by choosing the   option, or you may specify an explicit Client Timezone
timezone for all Clients to emulate.
 

Update Mode
This setting affects how Clients receive updates when the project is saved.

Notify 
This is the default, which means that all running Clients will display a yellow information bar at the top of their display that notifies the 
operator that an update is available. The update gets installed when the operator clicks on the yellow bar. 

Push
This option automatically pushes all project changes and updates to all running Clients with no operator interaction. This is often desirable 
when a Client is running in a situation where keyword and mouse access is inconvenient, such as in a large overhead display.
 

Touch Screen

All Clients can operate in touch-screen mode. When Touch Screen mode is enabled, clicking on numeric and text entry boxes will pop up on-screen 
keyboards that can be used for data entry.

Touch Screen Mode Enabled
By default, this is enabled, which means an operator can activate the mode on the startup screen.

Touch Screen Mode Active on Startup
This option sets the Clients to start up with the touch-screen mode active.

These settings are helpful for mixed-use projects, that is, those that are launched on both touch-screen devices and traditional computers and laptops.

Data

Disable Tag History Data Cache
The Clients normally maintain a cache of data retrieved from Tags History, improving repeat operations on graphs and tables. When this 
option is disabled, no data is cached, and the full queries execute against the Gateway each time data is required.

Client/Launching Properties

These properties apply to the Vision Client launch process.

Gateway Launch Page

 Default Launch Mode
The default launch mode determines what kind of launch occurs when the user hits the  button that appears next to the project in the Launch 
Gateway  page. Each launch mode can also be enabled individually, which will turn the launch button into a split-button, allowing the Home
user to choose the launch mode.
 
Windowed Button/Full Screen Button/Applet Button 
These properties affect how the launched project will display when launched through one of the Java Web Start launch modes: Windowed, 
Full Screen, or Applet.

Launch Icon
The image specified here is used to represent the project on the launch page and desktop shortcut. This needs to be a path to an image that has been 
uploaded to the Gateway. Use the browse button to choose or upload a new image.

Windowed Properties

Vendor 
This property is displayed as the project is launching through Java Web Start, as well as in the JWS application manager.
 
Homepage 
This property is the height of the Client window when launched in Windowed mode.
 



Width
 The width of the Client window when launched in Windowed mode.
 
Height
The height of the Client window when launched in Windowed mode.
 
Screen Index
The number here is the index of the screen to use for Full Screen mode, it starts at 0. This property is not supported on all operating systems.
 
Start Maximized 
If the box is selected, when the Client is launched in Windowed mode, it starts maximized. Note that this is not the same thing as Full Screen 
mode, which is only available when the Client is launched in Full Screen mode. In full-screen mode, the width, height, and start maximized 
properties have no effect. When launched in Full Screen mode, the user is given an   button on the login screen by default. For terminals Exit
where the application should not be exited, this button can be removed by checking the   box.Hide Exit Button
 
Start Centered
If the box is selected, when the Client is launched in Windowed mode, it starts centered.

Hide Exit Button
If the box is selected, when the Client is launched in Full Screen mode, the exit button is hidden to prevent the application from closing.
 

Applet Properties

Width
The width of the Client when launched in Applet mode. 

Height
The height of the Client when launched in Applet mode.
 

Client Memory
The Initial and Maximum properties govern how the Client uses RAM resources on its host machine.

Initial
The initial memory setting is how much memory the Client will require on startup. While this is typically left alone, boosting it a bit can improve 
performance somewhat.

Maximum
The maximum memory setting sets a cap on how much memory the Java VM is allowed to use. When you have launched a Client on a 
machine with plenty of RAM, you'll also need to boost this setting to allow the Client to use more RAM.

See also: , Images Launching Clients

Client/Login Properties

These properties affect how the Vision Client's login process behaves and appears.

Login Screen
These properties affect the appearance of the login screen. By default, the title area of the login screen will contain the project's title (or its name, if the 
title is blank), along with the project's description. You can override this by entering a welcome message for your project here. You may use HTML to 
format the message. You can also set an image to use instead of the Ignition logo on the login screen's header. You may also override the text used 
in the login controls.

Auto Login
By enabling auto-login, you can have the launched Client skip the login process. The Client will log in behind the scenes using the credentials supplied 
here. If they fail, the login screen will be presented.

Client/User Interface Properties

These properties affect how the Vision Client appears and behaves while it is running.

Minimum Size

Width and Height
Typically, a Vision Client is designed to run on multiple different resolution and sizes of monitors. The various component layout features help 
design elastic screens, but sometimes you need to set a lower bound as to how small you'll allow the Client's usable area to shrink. This is 
what the Minimum Size settings are for. You can see these settings visually represented in the Designer as lines on the Vision workspace. 
Whenever the usable space shrinks smaller than these bounds, scrollbars will appear, capping the width and height to these minimums. This 
defaults to 800x600.

Client Background Color
This option allows you to specify the color of the Vision workspace, which will be visible when not obscured by windows.



Client Menu
These options allow you to alter the appearance, or remove completely, the menu bar that appears in a running Vision Client.

See also: , Component Layout Menubar

 

 

Next ...

About Client Updates

 



1.  

2.  

About Client Updates
 

When a Client is launched, the most recent version of the project is used. If you make changes to the 
project and save the changes (by doing a ) while a Client is open, the Client is notified about  File > Save
the updates. The Clients can receive the updates in two different mode:  or   mode.Notify Publish

Notify
This is the default mode to automatically notify operators when project updates are available. In 
this mode, every time you update a project in the Designer and save the changes, Clients will 
display a yellow information bar at the top of their display. This yellow bar notifies the operator 
that an update is available. By clicking on the notification banner, the new project modifications 
are downloaded and applied.

Push
When you save your changes in the Designer, this mode automatically pushes all project 
changes and updates to all running clients with no operator interaction, that is, the new version 
is downloaded and applied automatically. This is often desirable when a Client is running in 
a situation where keyword and mouse access is inconvenient, such as in a large overhead 
display.

To set the Client Update modes

In the Designer, from Project Browser, double-click on , or from the top Project > Properties
menus go to . Project > Properties
The  window is displayed. Project Properties

Go to  page, set either  or  as your client update mode.Client > General Notify Push

About Client 
Updates

Watch the Video

 

 

 

 

https://www.inductiveuniversity.com/video/about-client-updates/7.8


 

 

Next ...

Using Touchscreen Mode
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2.  

Using Touchscreen Mode
 

It is very common to deploy Ignition Vision projects on touchscreen computers. Often, these are industrial 
panel-pcs acting as Human Machine Interface (HMI) or Operator Interface Terminal (OIT). The 
touchscreens simply act like a mouse input device and usually don't have a keyboard attached. For this 
reason, all of the input components in Vision are touchscreen-enabled.

Under normal circumstances, you don't have to do anything special other than enable 
touchscreenmode on your project. This will allow the operator to enable touchscreen mode when they log 
in. You can also enable touchscreen mode via scripting.

 

 

Touchscreen-enabled input components all have an expert level property called  . NorTouchscreen Mode
mally, this is set to Single-Click, meaning that the touchscreen keyboard or numeric keypad (depending 
on the type of input component) will appear on a single click in that component. You can also change this 
to Double-Click, which should be self-explanatory, or None. None means that automatic touchscreen 
support is disabled for this component. You may want to set this to handle touchscreen logic via scripting.

To handle touchscreen logic via scripting, the general pattern is to respond to a mouse event, popup up a 
keyboard, and then set the component's value to whatever was entered in the keyboard. For
example, for a text field, you would write a script like this:

if system.gui.isTouchscreenModeEnabled():
currentText = event.source.text
newText = system.gui.showTouchscreenKeyboard(currentText)

See also: , Client/General Properties system.gui.setTouchscreenModeEnabled

 

Using Touchscreen 
Mode

Watch the Video

Touchscreen support is built into Ignition. Turn it on through the Project Properties or scripting.

To turn on the touchscreen mode

In the Desinger, from Project Browser, double-click on  , or from the top menus go to .Project > Properties  Project > Properties
The   window is displayed. Project Properties

Go to   page, to see the  options.Client > General Touch Screen

Touch Screen Mode Enabled
By default, this is enabled, which means an operator can activate the mode on the startup screen. All Clients can operate in touch-screen 
mode. When Touch Screen mode is enabled, clicking on numeric and text entry boxes will pop up on-screen keyboards that can be used for 
data entry.

Touch Acreen Mode Active on Startup
This option sets the Clients to start up with the touch-screen mode active.

These settings are helpful for mixed-use projects, that is, those that are launched on both touch-screen devices and traditional computers and laptops.

 

https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Client/GeneralProperties
https://legacy-docs.inductiveautomation.com/display/DOC/system.gui.setTouchscreenModeEnabled
https://www.inductiveuniversity.com/video/using-touchscreen-mode/7.8
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Setting up Client Auto Login
 

Clients can log in automatically when launched, once you specify the  settings in the Auto Login Client
 section of the  window./Login Project Properties

To set the Clients to automatically login

In Designer, go to .Project > Properties
The  window is displayed.Project Properties
 
Go to the  page, and select the  box.Client > Login Enable Auto-Login
 
Type any Username and Password you want, for example you can type:
Username: guest
Password: password 

Click  and select the  to save your changes to the Gateway and  OK File > Save and Publish
publish your project.

Go to Tools > Launch Project > Windowed (Published).
This will launch the Client and automatically login you in.

If you want to switch user, from the top-right of the Client window, click on , enter Switch User
your  and , and click . username  password  OK
 

Setting up Client 
Auto Login

Watch the Video
 

 

 

 

 

 

 

Next ...

Setting up Mobile Auto Login

 

https://www.inductiveuniversity.com/video/setting-up-client-auto-login/7.8
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Setting up Mobile Auto Login
 

Mobile Clients can log in automatically when launched once you specify the  settings in the Auto Login M
 section of the  window.obile/General Project Properties

To set the Mobile Clients to automatically login

In Designer, go to  .Project > Properties
The  window is displayed.Project Properties
 
Go to the  page, and select the   box.Mobile > General  Enable Auto-Login
 
Type any Username and Password you want, for example you can type:
Username: guest
Password: password 

Click  and select   to save your changes to the Gateway and publish  OK File > Save and Publish
your project.

Go to the Gateway  page, find the  section, and click on the link.Home Mobile Launch
This launches the Client in your mobile device and automatically logs you in the web browser.

Setting up Mobile 
Auto Login

Watch the Video
 

 

 

 

 

 

 

Next ...

Setting Client Minimum Size

 

https://www.inductiveuniversity.com/video/setting-up-mobile-auto-login/7.8
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Setting Client Minimum Size
 

Typically, a Vision Client is designed to run on multiple different resolutions and different sizes of 
monitors. The various component layout features help design dynamic screens, but sometimes you need 
to set a lower bound as to how small you'll allow the client's usable area to shrink so that the content 
remains readable. This is done with the  settings, which by default it is set to 800X600.Minimum Size

You can see the Minimum Size settings visually in the Designer as lines on the Vision workspace. 
Whenever the usable space shrinks smaller than these bounds, scrollbars will appear, capping the width 
and height to these minimums. This defaults to 800x600 is shown as a square that says Minimum size on 
the right corner.

To set the Clients minimum size

In Designer, go to  .Project > Properties
The  window is displayed.Project Properties
 
Go to the page.Client > User Interface 
You can see the   defaults are set to  .Minimum Size 800X600
These values set the minimum size for the client workspace. If client is made to be narrower 
than this value, scroll bar will appear.

Setting Client 
Minimum Size

Watch the Video
 

 

 

 

 

 

 

Next ...

Hiding Client Menu Bar
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Hiding Client Menu Bar
 

The Client screens display a menu bar with a number of commands on them. You can completely or 
partially hide this menu bar. 

To hide the Client Menu Bar

In Designer, go to  .Project > Properties
The Project Properties window is displayed.
 
Go to the  page.Client > User Interface 
On this page, under , there are two checkboxes:  andClient Menu  Hide Menu Bar  Hide 

.Windows Menu
 
To hide only the Windows menu, select the  checkbox. Hide Windows Menu

To hide all the menus, select the  checkbox.Hide Menu Bar
 
Logout from the Client and log back in to see the menu bar changes. 

Hiding Client Menu 
Bar

Watch the Video
 

 

 

 

 

 

 

Next ...

Customizing Client Login Screen
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Customizing Client Login Screen
 

All of the information shown on the Client Login screen can be modified. You can customize the text 
fields for the description, image, and username/password on the login screen to fit your needs.

To customize Client Login screen

In Designer, go to  .Project > Properties
The  window is displayed.Project Properties
 
Go to the  page.Client > Login 
On this page, under , you can see all the text boxes that you can customize.Login Screen
 
For example, you can change them by entering:

Welcome Message: Welcome to BEST project you have seen!
Welcome Image: click on the icon to the right of the text field and pick an image 
Username Text: Enter your Username
Password Text: Enter your Password
Login Button Text: Click to Login

Select the check box.  Always Show Locale Selector 
When there is a  component in your project and you have this selected this Language Selector
option, you will see a  box on the Client login page which gives you the option to Language
choose a language.

 Click   and save your project with  .OK File > Save and Publish
 
Open the Client to see all your changes to the Login screen.

Customizing Client 
Login Screen

Watch the Video
 

 

 

 

 

 

 

Next ...

Setting Project Polling Base Rate

https://www.inductiveuniversity.com/video/customizing-client-login-screen/7.8
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Setting Project Polling Base Rate
 

SQL Query bindings have three  options: Off, Relative, and Absolute. The  mode Polling Mode Relative
has an adjustable  setting. You can set this  so it applies to all the SQL Base Rate Polling Base Rate
Query bindings for the whole project.

To set the Polling Base Rate for the whole project

In Designer, from the toolbar go to  .Project > Properties
The  window is displayed. Project Properties

Go to the  page.Client > Timing 
You can see the  along with other timing settings on this page.Polling Base Rate

Keep the default 5000 (5 sec) or change the  to how often you want the data Polling Base Rate
to refresh. For example, you can change the default and set it to 1000 (1sec).

Click  and save your project with .OK File > Save and Publish
The SQL property bindings that have the Relative rate/mode selected are now polled at a 1 
second rate and the Client data is now updated at a 1 sec rate. 

Setting Project 
Polling Base Rate

Watch the Video

 

 

 

   

 

Next ...

add link here

The project's base polling rate as set in the Project Porperties window will ONLY apply to the 
SQL bindings that are polling at the Relative Mode. Therefore, before you set the Polling Base 
Rate for the project, select the Relative mode as the Polling Mode for all the SQL Query 
bindings you wish.

https://www.inductiveuniversity.com/video/setting-project-polling-base-rate/7.8


 



Clients
   

The web-launched Vision Clients in Ignition are the "runtimes" of the Vision module. You can launch one or more Clients to display the projects you 
created in the Designer. They run as full applications and feel like a traditional installed Client, without the need to install and manually synchronize 
projects.

See also: About Client Updates

 

 

In this section ...

Ignition Clients may look differently on Windows than on Linux. This is because Linux does not have the default Arial font that Windows 
uses. To have Linux use the same font, it will need to be download. Check out a forum post where a user goes over how to do this: https://fo
rum.inductiveautomation.com/t/java-fonts-and-linux/1112

https://forum.inductiveautomation.com/t/java-fonts-and-linux/1112
https://forum.inductiveautomation.com/t/java-fonts-and-linux/1112
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Launching Clients
   

Clients are launched from the Gateway   page, for a specific project. They run as full applications Home
and feel like a traditional installed Client, without the need to install and manually synchronize projects.

There are three ways to run Clients:  ,  , and  . You can choose the mode Windowed Full Screen Applet
from the dropdown next to the project name. By just clicking on the project name, the project is launched 
in the default mode. Certain modes may not be available, depending on project settings.

Using the  OptionWindowed

The Windowed launch mode is the Standard launch method. The Client will be web-
launched using Java Web-Start and will have its own window. In this mode, the Client runs as a 
full, independent application. After being launched, the browser can be closed and the project 
can be launched from a shortcut on the desktop.
 
Using the  OptionFull Screen
The   launch mode is similar to the Windowed mode, and will also use web-Full Screen
launching to run the Client as a full, independent application. In this mode, however, the Client 
will occupy the full screen, and will not have a title bar. This mode is ideal for touch-screen 
display panels, and other
displays where the Ignition project is the sole focus on the screen. 
 
Using the  OptionApplet
Selecting   launch mode will run the Client application as an applet embedded in your Applet
web browser. Applet mode is most commonly used to integrate Vision projects into existing web 
sites, such as in a corporate intranet setting. See  for detailed information.
 
Using the  OptionMobile
If you have the  module installed, you can launch projects on your smartphone or tablet Mobile
as well. All the user has to do to launch a mobile Client is to connect their mobile device to the 
wireless network and point the web-browser to the Gateway's LAN address. At this point, they'll 
be presented with a mobile-optimized version of the Ignition Gateway homepage, where they 
can select a project to launch. Note that projects must have at least one window defined and be 
enabled for mobile launching in order to show up in this list. After selecting a project and logging 
in, they can use the project like a normal project. To access the mobile project context menu, 
press and hold on your touch-sensitive device. A circular menu will appear allowing you to 
switch between pointer and pan/zoom mode, as well as options for logging out and entering text 
input. 

 

    

To Continue on the 
step-by-step simple 
workflow...

After you  , as Launched your Client
described on this page, click the link 
below for Step 7 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

 

 

 

 

Launching a Client

Now that  launch a Client to see it in action.we've created a project, lets

From the Designer toolbar, select  to save your project.File > Save and Publish
 
Go back to the Gateway  page.Home
Your project will appear in the  panel with a big  button to its right.Launch Projects Launch
 
Click on the  button to start up a Client.Launch
 
Login to the Client using
Username: admin
Password: password

By default, a new project uses the same  as the Gateway, so the credentials will work. user source   /admin password 
 
After you logged in, you can see your Client window displaying your project. 
 
Go back into the Designer, make a change to the window, and click . File > Save and Publish
Your Client will show a notification saying that there are updates to the project. 
 
Click on the notification and the Client will update itself.

https://legacy-docs.inductiveautomation.com/display/DOC/Designer+Basics#DesignerBasics-CreatingaProject
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See also: Launching Clients and Using the Native Client Launchers.

 

Local Client Fallback  

Ignition  s are fully dependent on being able to communicate with a Gateway. If Gateway communication is lost, the   suspends operation Client Client
while it attempts to reconnect with the Gateway. This can be a problem when you need the   to monitor critical operations on a plant floor.Client

Ignition provides a     fallback mechanism that lets you to use a Gateway running on the   machine. In normal operation, your   can local Client local Client
connect to a central Gateway located somewhere on the network. The central Gateway would be responsible for all data aggregation, such as storing 
historical data in a database. But if communication to the central Gateway is lost, the   can automatically retarget to a project that you specify in Client
the   Gateway. This project should contain the minimal realtime information that you need to keep your operation running. Note that in order to use local

 fallback,  must be open on the   machine.local port 6501 local

To enable   fallback, do the following steps:local

Go to in the   Gateway.    Configuration > Gateway Settings local

Scroll down to the   section and select the Enable   Fallback.   FallbackLocal Client Local
 
Select a Fallback Project from the dropdown list.
Note that the project that you select must be published in the   Gateway and it must have at least one main window.local
 
Optionally, you can change the Seconds to Failover setting to a value other than 60 seconds.
This setting controls the number of seconds to wait before fallback automatically starts. During comm failure, you can also click a button to 
load the   fallback project immediately.local

When   fallback is enabled, the   attempts to open port 6501 on the   machine. If the port can be opened successfully, the   reads local Client local Client
fallback settings from the   Gateway and shows a  button on the bottom of the  window. You can click local Fallback Project Gateway Connection Lost
this button at any time to load the fallback project, or simply wait for the fallback project to automatically load. You may want to set the     to local Client
automatically log in to avoid typing in a username and password when the   loads. This can be set in the Login section of the project's properties.Client

Testing Local Fallback

Testing   fallback is highly recommended before you start to depend on it in a production setting. The easiest way to test fallback is to simply local
unplug the network cable to the   machine, or disable the network card on the machine. If the  button is not visible on the Client Fallback Project Gatew

 window, check your   Gateway console and verify that the message   is present in the ay Connection Lost local Started Fallback Socket on port 6501
console. Any other error message related to the  indicates that some other problem has occurred (most likely the port Fallback Socket Controller
cannot be reserved) and   fallback is not available to  s.local Client

Client Retargeting

Client Retargeting is the method by which Clients running a particular project switch to a different project on the fly, even if the other project is hosted 
on a different Ignition Gateway. Retargeting is a key feature used to build distributed systems. It allows you switch between projects and servers as 
easily as switching between windows. Using Retargeting, even geographically dispersed projects can be presented as a single cohesive unit.

Reconnect to Central

In many circumstances, the communication loss to the central Gateway is only a temporary event. To minimize the amount of time that you need to 
run the    , you can add some functionality to the   that allows you to check on the status of the central Gateway. One way to do this is to local Client Client
add a timer script to your    . The script calls the  function at regular intervals and updates an item local Client system.util.getGatewayStatus()
such as a   tag with the Gateway status. Then, you can bind an indicator component to the   tag and get ongoing visual feedback on the Client Client
central Gateway status. As soon as you can confirm that the central Gateway is running again, you can call the  function system.util.retarget()
in a button to seamlessly direct the   back to the central Gateway.Client

 

 

In this section ...  

   

You can launch as many Clients as you want! If you've got other computers on the same network as the Gateway computer try 
launching on them too. Make sure that your Gateway computer doesn't have a Firewall enabled, otherwise, it is allowing traffic on 
port 8088 - the default port for the Ignition web server.
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Using the Windowed Option
 

Clients can be launched with Java Web Start in Windowed mode from the Gateway Webpage or the 
Designer. Windowed mode creates a Client that appears as a normal windows program.

To launch a Client in Windowed mode

Go to the Gateway  page.Home
 
Click on the  button for the project you wish to open in the Client.Launch
This will launch the Client in the default  mode. Windowed
 
Click   on the small dialog box that appears on the bottom-right of your window, and then Keep
click on the  file to start the Client..jnlp
The login screen for the Client is displayed. You can keep the Client screen as large as the 
whole screen or as small as you wish.

Type in the  and  to see your project.Username Password
Your project is now displayed in the Client.

Using the 
Windowed Option

Watch the Video
 

 

 

 

 

 

 

Next ...

Using the Full Screen Option

 

https://www.inductiveuniversity.com/video/using-the-windowed-option/7.8
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Using the Full Screen Option
 

Clients can be launched with Java Web Start in Full Screen mode from the Gateway Webpage or the 
Designer. Full Screen mode creates a Client that takes up the entire monitor including the Windows 
Taskbar. Settings and programs other than Ignition are required to block the user from getting to their 
desktop.

To launch a Client in Full Screen mode

Go to the Gateway   page.Home
 
From dropdown of the   button, select the  mode to launch the project you Launch Full Screen
wish to open in the Client.
 
Click  on the small dialog box that appears on the bottom-left of your window, then click on Keep
the   file to start the Client..jnlp
The login screen for the Client is displayed covering the full size of your screen. In the Full 

 mode, you can not make the screen smaller as you could do with the  mode.Screen Windowed

Type in the   and   to see your project.Username Password
Your project is now displayed in the Client.

Using the Full 
Screen Option

Watch the Video
 

 

 

 

Next ...

Using the Applet Option

 

https://www.inductiveuniversity.com/video/using-the-full-screen-option/7.8
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Using the Applet Option
   

Clients can be launched in a web browser with Java in Applet mode from the Gateway Webpage or the 
Designer. 
 

To launch a Client in Applet mode

Go to the Gateway   page.Home
 
Select the   mode from the drop down option associated with the launch button Applet
associated with your project.

The project should launch in its own window on your web browser.

Using the Applet 
Option

Watch the Video

 

 

 

   

 

Next ...

Using the Mobile Option

 

 

The google chrome web browser platform will no longer support Java applets starting in 2015. 
However, Java applets will still be available on other web browsers. Also, your browser may 
block a Java Applet from launching, therefore you may need to unblock access to Java 
Applets.

https://www.inductiveuniversity.com/video/using-the-applet-option/7.8
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Using the Mobile Option
 

Clients can be launched on a mobile device using the Mobile Module. They are opened behind the 
scenes on the server and sent using the mobile device's web browser, not as a native App. A desktop 
environment (that is, X Window) is required for Linux servers.

To launch a Client on a Mobile device

Go to the Gateway   page.Home
 
From the  section, click on the Mobile Launch http://localhost:8088/main/system

 link./mobile
The Ignition Mobile launch page is displayed showing a list of all your projects. 
 
Click on your project name.
This downloads and displays your project.

Using the Mobile 
Option

Watch the Video
 

 

 

 

 

 

 

Next ...

Using the Direct Launch Links

 

https://www.inductiveuniversity.com/video/using-the-mobile-option/7.8
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Using the Direct Launch Links
 

Clients can be opened with the Direct Launch Links in addition to using the Gateway Home page. These 
links can be used in any browser on the network and will launch the  files without a desktop shortcut..jnlp

To open a Client with the Direct Launch Link

Go to the  section of the Gateway.Configure
 
Go the the  page.Configuration > Projects
You will see a list of your projects on the  page. Projects
 
Click the  link to the far right of the row for the project you want.view 
The  page is displayed. You can see the  Project details for 'your_project_name' Published
and  launch links.Staging
 
Right-click on  and choose .Published/Windowed Copy link address
 
Go to a browser, paste the link, and click enter to launch the Client.

Using the Direct 
Launch Links

Watch the Video

 

 

 

 

 

Next ...

Using the Native Client Launchers

 

https://www.inductiveuniversity.com/video/using-the-direct-launch-links/7.8


Using the Native Client Launchers
 

The Ignition Gateway contains downloadable native executables that can launch Clients directly without 
invoking Java Web Start. Using the native executables you can set up Clients in ways that are impossible 
to achieve with Java Web Start, such as being able to launch Clients automatically as part of a machine 
startup script.

The Native Client Launcher automatically searches the network for existing Ignition Gateways and lists 
existing projects. It is a more robust shortcut than the default desktop shortcuts created by Java.

Note: The Native Client Launchers require Java to be installed on the Client machine.

Download and Installation

Native client launchers are available on the Gateway home page for Windows, Linux and Mac OSX. Click 
on the Download link to download the native launcher that you need for your operating system. You can 
hide the native client launcher section on the gateway home page by disabling the section under the 
Gateway Settings page -> Homepage Config tab.

Windows Installation

Move clientlauncher.exe to a convenient location after it has downloaded to your local machine. Double-
client clientlauncher.exe to start.

Linux Installation

Open the downloaded .tar.gz file using an archive manager, or use on the command line. Run  tar -xvf 
clientlauncher.sh (the file is already executable, so you can simply double-click on the file).

Mac OSX Installation

Double-click on the ClientLauncher.dmg file. Drag the Client Launcher .app into the Applications folder. 
Double-click the Client Launcher.app to get started.

Java Requirements

The client launchers require a installed Java Runtime Environment (JRE) with the same minimum JRE 
version as the Ignition client. However, if you are using a Windows machine, and you are in a situation 
where you cannot install a JRE, you can still use the client launchers. You will need to package the JRE 

Using the Native 
Client Launchers

Watch the Video

 

 

Ubuntu 14.04 users! Starting in 14.04, Ubuntu has turned off the list of execution options that 
pops up after double-clicking on a .sh file (display the file, execute directly, or execute in a 
shell). This means that double-clicking clientlauncher.sh will open the text editor and display a 
bunch of garbage. To re-enable the list of execution options, open a File Manager. Navigate to 
the Edit menu -> Preferences and click on the Behavior tab. Change the Executable Text Files 
setting from "View executable text files when they are opened" to "Ask each time".

https://www.inductiveuniversity.com/video/using-the-native-client-launchers/7.8
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installation folder on another machine as a .zip file, and extract the zip to a /jre folder next to 
clientlauncher.exe. The client launcher will use your JRE both for its own execution and for the launched 
client.

 

Configuration

When the client launcher opens for the first time, you must select a Gateway on the Gateway Configuration screen. If your Gateways have multicast 
enabled, and multicast transmission is allowed on your network, you can see a list of Gateways under the Available Gateways tab. Select a Gateway 
from the list and click the Select Gateway button. The client launcher will attempt to connect to the Gateway that you selected.

 If you do not see your Gateway, you can still manually enter Gateway address under the Manually Input Gateway tab. The format is " ":host:port

//Examples
127.0.0.1:8088
 
//The following will connect to a Gateway running on the local machine
localhost:8088

 After you have entered your address, click the Apply button. The client launcher will attempt to connect to the Gateway that you selected.

 After you have selected a Gateway, the client launcher will attempt to contact the Gateway and will update the Status field at the top of the screen. If 
there was an error while attempting to contact the Gateway, you can hold your mouse over the Status field to see what the error was. You can also 
check   for error information. Keep in mind that you cannot use a client launcher to <user home folder>/.ignition/clientlauncher-data/clientlauncher.log
connect to older Gateways. The minimum Gateway versions that can be used by client launchers are 7.5.11 for the 7.5 Ignition platform and 7.6.4 for 
the 7.6 Ignition platform. Any 7.7 or later Ignition platform can be used with the client launchers.

 

To use the Native Client Launchers

Go to the   page on the Gateway.Home
 
Scroll to the bottom of the page to see the   section.Native Client Launchers
 
Click on the   button to download the native launcher that you need for your operating system.Download

• For  , you will see a   file.Windows clientlauncher.exe
• For  , open the downloaded .tar.gz file using an archive manager, or use tar -xvf on the command line. You will see a   Linux clientlauncer.sh
file.
• For  , double-click the   file, drag the Client Launcher .app into the Applications folder.Mac OS X clientlauncher.dmg
 
Click on the  , , or  file (depending on your OS) to open the page that shows URL for available Gateways..exe  .sh  .app
 
Choose the Gateway you want, click the   button, and click  .SELECT Gateway Save & Close
On the window that is displayed you can launch your project.

If your Gateways have multicast enabled (  check box is selected on the   page), and multicast Multicast Enable Gateway Settings
transmission is allowed on your network, you can see a list of Gateways under the   tab.Available Gateways

 
Select a Gateway from the list and click the   button.SELECT Gateway
The Client launcher will attempt to connect to the Gateway you selected.
 
If you don't see your Gateway, you can manually enter the Gateway address under the   tab, the format is  . Manually Input Gateway host:port

For example, you can input   or   to connect to a Gateway running on your local machine. After you have 127.0.0.1:8088 localhost:8088
entered your address, click  . Apply
The Client launcher will attempt to connect to the Gateway you selected. 
After you have selected a Gateway, the Client launcher will attempt to contact the Gateway and will update the Status field at the top of the 
screen. If there was an error while attempting to contact the Gateway, you can hold your mouse over the   field to see what the error Status
was. You can also check   for error information.<user home folder>/.ignition/Clientlauncher-data/Clientlauncher.log
Keep in mind that you cannot use a Client launcher to connect to older Gateways. The minimum Gateway versions that can be used by 
Client launchers are 7.5.11 for the 7.5 Ignition platform and 7.6.4 for the 7.6 Ignition platform.

You can hide the   section on the Gateway   page by disabling it in the   Native Client Launcher Home Gateway Settings > Homepage Config
tab.

Managing Multiple Gateways

It is possible to configure the client launcher to always start on the Gateway Configuration screen. This allows you to connect to any number of 
Gateways using the same launcher. To enable this configuration, open the launch.xml file (details on this file are in the Custom Launch Settings 
section below). Set the initconnect property to false and save the file.

 



Gateway Favorites

If you are managing multiple Gateways, it may be helpful to mark some Gateways as favorites. These Gateways are always listed first when 
accessing the Gateway Configuration screen. You can also filter out non-favorite Gateways by checking the Favorites Only checkbox on the Gateway 
Configuration screen. By setting the initconnect property to false (as documented above in the Managing Multiple Gateways section), you can force 
the client launcher to always display your favorite Gateways list any time you start the launcher.

 

Launching Projects

After the Gateway has been configured, you can launch a client project or the Designer from the Projects screen. After a project has been launched, a 
desktop shortcut is created. You can use the desktop shortcut to directly launch the project from the client launcher without needing to select the 
project again from the Projects screen. A client project will not be visible for launch unless all the conditions below are satisfied:

 

The project has at least one main window
The project is not disabled in the Gateway
The project is not hidden from launch via the project properties
The project's configured window launch mode matches the client launcher window mode. For example, if a project's default launch mode is 
Windowed mode and the "Full Screen" button is not enabled in the project's properties, this means that the project cannot be launched when 
the client launcher is running in fullscreen mode.

 

If a project is no longer available in the Gateway, launching the desktop shortcut for the old project will cause the client launcher to display the Projects 
screen along with an error message at the top of the screen.

 

Temporary Configuration

The client launcher is typically used to open different projects residing on a single configured Gateway. However, you can also create temporary 
connections to other Gateways by checking the "Temporary Connection" checkbox on the Gateway Configuration screen. This prevents the selected 
Gateway from being saved in launch.xml, which may be helpful if you have already configured a default Gateway and you do not want to lose its 
connection settings. After the connection has been established and saved, the Projects screen will be shown for the temporary Gateway. You can 
then launch a project or the Designer as you normally would. If the "Create desktop icon" checkbox is checked for the launched project, the temporary 
Gateway network address is saved in the desktop shortcut.

 

Redundancy

The client launcher can take advantage of a redundant Gateway setup. Whenever a connection is established with a master Gateway, the backup 
Gateway IP address is automatically stored in the client launcher configuration file. If the master Gateway cannot be contacted the next time the client 
launcher is run, an attempt is made to contact the backup Gateway. If the backup cannot be contacted, the client launcher switches between 
contacting the primary Gateway and the backup Gateway until one responds or the user closes the launcher.

 

Custom Launch Settings

Client launcher configuration settings, log files and temp files are stored by default in  . The <user home folder>/.ignition/clientlauncher-data/
following settings can be configured in launch.xml:

Setting 
Name

Setting Description Example 
Setting

gateway.
addr

The gateway that you have configured which contains your launchable projects 10.20.7.122
:8088

gateway.
backup.
addr

Automatically set by client launcher when using a redundant setup 10.20.7.122
:8088

timeoutse
cs

The maximum number of seconds allow for any gateway communication. Any communication that exceeds this 
amount will cause the client launcher to abort the communication and try again if configured.

30

retries How many times to attempt to contact a gateway again if an error occurred during communication. The default setting 
of -1 cause the client launcher to try again forever until the client launcher is manually closed. A setting of 0 will 
cause the client launcher to abort communication after the first failure and display the Gateway Configuration screen. 
A setting of 1  or more will cause the client launcher to make X more attempts before aborting and showing the 
Gateway Configuration screen.

-1,0,1

windowm
ode

Controls whether or not to launch the client launcher in fullscreen mode. The fullscreen setting will cause the client 
launcher to take over the entire screen. When launching a client that also has fullscreen mode configured, the 

window, 
fullscreen



fullscreen client will replace the fullscreen client launcher after launch. The default setting is "window", which 
launches the client launcher in windowed mode.

screen The screen index indicates which monitor to use when launching in fullscreen mode. 0,1

show.
closebutton

When this is set to false, all close buttons on the client launcher are hidden. Use this setting along with the fullscreen 
mode to set up a dedicated touch-screen terminal.

true,false

multicast.
addr

This setting must match the gateway's multicast address setting in order to see a list of available gateways on the 
Gateway Configurations screen.

231.1.1.1

multicast.
receive.
port

This setting must match the gateway's multicast receive port in order to see a list of available gateways on the 
Gateway Configurations screen.

4446

initconnect When this is set to false, the client launcher will not attempt to contact the configured Gateway, but instead will 
immediately open the Gateway Configuration screen. This allows you to choose different Gateways using a single 
client launcher.

true,false

tempconn
ection

When this is set to true, the Temporary Connection checkbox on the Gateway Configuration screen will be checked 
when the client launcher is started. By setting this property to true and setting the initconnect property to false, you 
can use the client launcher to access any number of Gateways without saving the selected Gateway address in 
launch.xml.

true,false

jvm-args Allows JVM-specific settings to be set on the client that is launched, such as MaxPermSize memory allocation. -XX:
MaxPermSi
ze=512m

other-args See the "Setting client tags" section below  

Startup Parameters

The settings below can also be passed to a client launcher executable as startup parameters. Note that many of the settings overlap with the custom 
launch settings above, and if present, they will override the settings in launch.xml.

Setting 
Name

Setting Description Example 
Settings

gateway.
addr

The gateway that you have configured which contains your launchable projects 10.20.7.122
:8088

gateway.
backup.
addr

Automatically set by client launcher when using a redundant setup 10.20.7.122
:8088

timeoutse
cs

The maximum number of seconds allow for any gateway communication. Any communication that exceeds this 
amount will cause the client launcher to abort the communication and try again if configured.

30

retries How many times to attempt to contact a gateway again if an error occurred during communication. The default setting 
of -1 cause the client launcher to try again forever until the client launcher is manually closed. A setting of 0 will 
cause the client launcher to abort communication after the first failure and display the Gateway Configuration screen. 
A setting of 1  or more will cause the client launcher to make X more attempts before aborting and showing the 
Gateway Configuration screen.

-1,0,1

windowm
ode

Controls whether or not to launch the client launcher in fullscreen mode. The fullscreen setting will cause the client 
launcher to take over the entire screen. When launching a client that also has fullscreen mode configured, the 
fullscreen client will replace the fullscreen client launcher after launch. The default setting is "window", which 
launches the client launcher in windowed mode.

window, 
fullscreen

screen The screen index indicates which monitor to use when launching in fullscreen mode. 0,1

show.
closebutton

When this is set to false, all close buttons on the client launcher are hidden. Use this setting along with the fullscreen 
mode to set up a dedicated touch-screen terminal.

true,false

scope Indicates whether the project being launched is a client (scope C) or a Designer (scope D) C,D

project The project name. This field is required if the scope is set to C, indicating that a client is being launched. myproject

initconnect When this is set to false, the client launcher will not attempt to contact the configured Gateway, but instead will 
immediately open the Gateway Configuration screen. This allows you to choose different Gateways using a single 
client launcher.

true,false

jvm-args Allows JVM-specific settings to be set on the client that is launched, such as MaxPermSize memory allocation. Note 
that you need to substitute the '#' character for the '=' character, so that the command line can be parsed properly by 
the client launcher.

-XX:
MaxPermSi
ze#512m

true,false



tempconn
ection

When this is set to true, the Temporary Connection checkbox on the Gateway Configuration screen will be checked 
when the client launcher is started. By setting this property to true and setting the initconnect property to false, you 
can use the client launcher to access any number of Gateways without saving the selected Gateway address in 
launch.xml.

Client Startup Examples

Windows: 
"C:\ClientLauncher\clientlauncher.exe" scope=C project=myproject windowmode=window
 
Linux: 
./clientlauncher.sh scope=C project=myterminal windowmode=fullscreen screen=0 show.closebutton=false

Setting client tags

Client tag values in Ignition clients can be set by the client launcher upon startup. There are two ways you can do this. The first way is to add the tag 
info to the other-args section in launch.xml, as shown below. These settings would take effect for all clients started from the client launcher. The 
examples below assume that you have two client tags in the root folder of your project, called "LaunchTag" and "LaunchTag2".

<other-args>
<arg>-Djavaws.launchparams=LaunchTag;LaunchTag2</arg>
<arg>-Djavaws.launchparam.LaunchTag=AAA</arg>
<arg>-Djavaws.launchparam.LaunchTag2=ZZZ</arg>
</other-args>

 

The other way is run the client launcher from a command line or a desktop shortcut and add these lines to the end of the command:

-Djavaws.launchparams="LaunchTag;LaunchTag2" -Djavaws.launchparam.LaunchTag="A A"-Djavaws.launchparam.
LaunchTag2="B B"

Starting the client launcher from a command line in this case would look like the example below (Linux example shown)

./clientlauncher.sh scope=C project=myterminal windowmode=window -Djavaws.launchparams="LaunchTag;
LaunchTag2" -Djavaws.launchparam.LaunchTag="A A" -Djavaws.launchparam.LaunchTag2="B B"

Other tricks

The client launcher can be pre-configured locally and then deployed to remote client machines via a zip file. Using this capability allows a client 
launcher to immediately connect to a Gateway on the very first launch.

First, you need to configure a client launcher on a local machine to point to a Gateway. 
Next, copy the   folder next to the launcher executable. <user home folder>/.ignition/clientlauncher-data
Zip everything together and distribute the zip to other machines. 
For Window and Linux machines, the launcher can use the clientlauncher-data/ folder that was placed next to the executable. For OSX 
machines, you need to copy the clientlauncher-data/ folder to the user's home directory and place the Client Launcher. app wherever 
convenient.

Next ...

Setting Up Mobile Clients

For another example of automatically launching clients with the Native Client Launcher, please see the following Knowledge Base Article: La
unch Project to Multiple Monitors

Client tags that are set by the client launcher cannot contain spaces in the tag names!

https://support.inductiveautomation.com/index.php?/Knowledgebase/Article/View/89/0/launch-project-to-multiple-monitors
https://support.inductiveautomation.com/index.php?/Knowledgebase/Article/View/89/0/launch-project-to-multiple-monitors
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Setting Up Mobile Clients
   

With the Mobile module installed, you can launch your projects on any modern smartphone or tablet. This ability does not require any re-design of 
your projects – a mobile Client launches the same projects that the Vision Clients launch.

See the   for more information.Mobile Module

To set the Mobile Module Settings

There is very little setup involved with the mobile module. Usually, with the exception of the the Server Address setting, you can keep all the the 
default settings.

Go to the   section of the Gateway.Configure
Scroll down and go to   page.Mobile > Settings

Here you will see all the settings and shown in the following table:

Settings

Java 
Path

The path to the Java executable on the Ignition Gateway server machine. The Java 8 JRE is required for the mobile module. The default is j
, which assumes that Java 8 is on the path and can be invoked merely with the  keyword.ava java

Clien
t 
Mem
ory

The max amount of heap space allowed for each mobile client VM that is launched. Mobile clients are virtual clients that are launched on 
the server. All of the work is done on the server and transmitted to the mobile device so keep in mind that more mobile clients means more 
memory and CPU consumption on the server.

JVM 
Optio
ns

Command-line JVM options to use when launching mobile client VM's. Multiple options are separated with spaces. This option is made 
available mostly for troubleshooting by technical support staff, but if you are familiar with java and comfortable with command-line 
arguments, you can specify ones you may find useful.

Envir
onm
ent 
Varia
bles

The environment variables to pass to the mobile client VM process. Use the NAME=VALUE format, one per line.

Idle 
VMs

The number of client VMs to startup and wait for incoming mobile connections. These will start when the Gateway is started and sit idle until 
a mobile connection is made. This should be left at the default value of 0 unless it is taking a long time to launch a mobile client. It's 
important to note that the VMs that are sitting idle are not connected to a project so it will still take time to load the selected project.

Serv
er 
Addr
ess

This is the address to use when launching from the QR code on the launch page. This is a setting that often causes confusion. Initially this 
value is blank by default which results in the QR code pointing to the address of  . Since Ignition is not running on your http://localhost:8088/
mobile device, this address will not actually launch the mobile homepage. This should be set to the Ignition server address that can be 
reached by the mobile device.

Networking

Callb
ack 
Port

The port that the mobile Client VMs use to communicate to the Gateway on. The default is 45900, but if this port is already in use, you need 
to change this to an available port.

Callb
ack 
Interf
ace

The interface that mobile client VMs should use to communicate back to the Gateway on. The default, localhost, makes use of the loopback 
adapter, however if this host doesn't have a loopback adapter or if there are two network cards, set this to the IP address of the NIC that 
should be used for local loopback.

AJA
X 
Time
out

The max time, in milliseconds, that each request has to complete. The default is 10,000 (10sec).

Advanced Properties

 The Mobile Module also has an option to allow VNC connections. This allows certain thin clients that do not 
support the Java Runtime Environment and also do not have an HTML 5 compatible browser to launch Ignition 
clients. The settings listed under the advanced properties section all have to do with configuring the VNC 
connection.

VNC Settings



Enab
le 
VNC

Allows direct thin-client connection over VNC (also known as, RFB) protocol.

VNC 
Port

The port used for the VNC connections.

Proje
ct 
Name

The Mobile module only allows one of the projects on the Ignition Gateway to be viewed through VNC so you have to specify that project 
here. Unlike the normal mobile launch screen that allows you to choose a project, the project that you specify in this setting will be 
automatically launched when you connect via a VNC viewer application.

Proje
ct 
Width

The width of the project when it's launched.

Proje
ct 
Heig
ht

The height of the project when it is launched.

 

 

In this section ...  
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About Mobile
 

Mobile Clients require the Mobile module. Mobile Clients are headless Clients launched behind the 
scenes on the server and the Client is shown on the mobile device using its web browser instead of a 
native App. HTML 5 allows users to interact with the browser as if it was a normal Client.

See also: Mobile Module

To launch the Mobile Client

Go to the Gateway  page.Home
 
In the  section, click on  .Mobile Launch http://ipaddress:8088/main/system/mobile
The Client launches on your mobile device.
 
Choose the project you want to open, then login with your username and password.
The Project is displayed. If there is only one project in the mobile project list, the list will be 
skipped and you will be sent directly to the login screen.
 
To check how many Clients are launched, go to the  page of the Gateway and see the Status Cli

 box which shows how many are open.ents

About Mobile

Watch the Video

   

Launch Mobile Client without viewing the mobile project selection page

It is possible to bypass the mobile project selection page by adding the project name to the URL: http://ipaddress:8088/main/system/mobile?
project=projectName

 

Mobile Module Tags

Using the Mobile Module adds additional (client scoped) tags to the System Tags folder under . This adds Remote Address and System -> Mobile
User Agent values. If location is enabled in the mobile browser, the Location tags will show Latitude, Longitude, etc.

 

Next ...

Setting Mobile Size and Fit to Device

 

http://localhost:8088/main/system/mobile
https://www.inductiveuniversity.com/video/about-mobile/7.8


Setting Mobile Size and Fit to Device
 

Mobile Clients can be set to specific sizes or told to fit themselves to the device.

To set the Mobile size and Fit to device

In the Designer, go to the , and then to .Project > Properties Mobile > General

You can see that the  is selected by default.   will resize itself when the device Fit to Device Fit to Device
is rotated. You can also choose  and specify any size you wish. Custom

Setting Mobile Size 
and Fit to Device

Watch the Video

 

 

Next ...

Setting Java Path

 

https://www.inductiveuniversity.com/video/setting-mobile-size-and-fit-to-device/7.8
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2.  

3.  

Setting Java Path
 

The mobile clients can either use the same Java version as the Ignition server or it might be necessary to 
set a specific path to the Java version that you want the mobile clients to access. A likely scenario for this 
is if the Ignition server is upgraded to run on Java 9 but the underlying technology that the Mobile client 
uses to run can be limited to Java 8 pending technological upgrades in the future. Regardless, setting the 
Java path will result in more control over which version of Java runs the mobile clients. The settings take 
either the system path such as  or a full path to the  file.Java java.exe

To set the Java Path

Go to the  section of the Gateway.Configure
 
Scroll down, go to  page.Mobile > Settings
See the  setting with  as the default path to the Java executable.Java Path java
 
Enter the path in  , for example, for Java 8 JRE you enter,Java Path
C:\Program Files\Java\jre8\bin\java.exe

Setting Java Path

Watch the Video

 

 

Next ...

Setting Max Mobile Clients

 

https://www.inductiveuniversity.com/video/setting-java-path/7.8


1.  
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Setting Max Mobile Clients
 

You can set the max number of concurrent mobile Clients in the Gateway  page. This is a safety Home
measure, because each Client consumes resources on the Gateway. Limiting the number of Clients to 
be launched prevents overloading the Gateway server.

To set the max number of Mobile Clients

Got to the  section of theConfigure  Gateway. 
 
Scroll down, go to  page.Mobile > Settings
You will see the  setting which is set to 15 by default.Max Clients
Max Clients is the max number of concurrent mobile clients. This number is set as a safety 
measure, because each client consumes resources on the Gateway, and limiting clients 
prevents overloading the Gateway server.

Setting Max Mobile 
Clients

Watch the Video

 

 

Next ...

add link here
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Mobile Project Launch Links
 

Mobile project shortcuts can easily be added to the home screen of a mobile device. The links can point 
to either the project listing page, or directly to a single project. 

 

Example - Adding a shortcut to the home screen of a mobile 
device

 

The following requires that the mobile device has  to the Ignition Gateway.  network access
Additionally, at least a single project exists on the Gateway, and the project must be enabled for mobile 
launch. This property can be found under Project Properties:

 

 

Step 1 - Launch the project on the mobile device

The Home tab of the Gateway Webpage contains a Mobile Launch link.

 

Launch a mobile project on the device by either using a barcode scanner app, or type the launch link into 
a browser on the device.

 

Since the mobile device has network access to the Ignition Gateway, the browser on the 
device can navigate to the Gateway Webpage directly. This way the project can be launched 
by clicking on the link from the device.

 



 

If only a single mobile-enabled project exists on the Gateway, then a login page will appear.

 

If multiple mobile-enabled projects are present, a project listing page will appear.



 

Step 2 - Add a shortcut to the device's home screen

Select a device:

 

 

Next to the page's URL, press the More icon

 

A list of options will appear. Press the 'Add to Home screen' option

 

The following instructions assumes Chrome will be used. If using a different browser, please 
see the browser's documentation for adding a link to the Home screen.



 

Name the link that will appear on the Home screen, and press ADD.



 

The link will now be available on the Home screen.

 

 

At the bottom of the browser, press the Share button.

The following instructions assumes Safari will be used. If using a different browser, please see 
the browser's documentation for adding a link to the Home screen.



 

Scroll to the right until the 'Add to Home Screen' icon appears, and press it.

 

Name the link that will appear on the Home Screen, and press 'Add' when finished.

 

The link will appear on the Home Screen.



 

 

Next ...

add link here

 



Database Connections

Providing access to relational databases is at the heart of the Ignition platform. Ignition can connect to 
any SQL database that has a JDBC driver, though depending on the database's capabilities, some 
features may not be available.

By connecting Ignition to one or more SQL databases, you can query existing data, update data, store 
historical information, and more.

Why use Databases?

Ignition can perform many tasks without the use of a database. For instance, the Vision and OPC-
UA modules let you create powerful HMI status and control screens ,or Tags can be used to generate 
alarms that can be sent over email. However, a tightly integrated database access is a key feature that 
makes Ignition stand out from its competitors.

Modern relational databases offer amazing storage and querying capabilities with great performance at a 
price that is incomparable to older legacy historians. While it is true that historians still have a place in the 
industry, for most applications relational SQL databases not only suffice, but offer much more than what 
was previously available. Using SQL, you can store and track production information with ease. 
However, you can also correlate that data to who was on shift, previous runs, downtime, inventory levels 
and more, naturally and easily. Make the data available to more people using the Vision module's web-
launch clients, or integrate the data directly into your company's internal or external website. SQL 
databases are at the heart of the web and modern corporate IT systems, and now thanks to Ignition, the 
plant floor as well.

      

On this page...

Why use Databases?
How are Databases used in Ignition?
Getting Started with Databases
Database Drivers and Translators
Monitoring Connection Status
In this section ...

How are Databases used in Ignition?

While connecting to a database is not required for basic status and control functionality, it can dramatically increase the possibilities that the system 
offers. There are a few places where databases are used in Ignition, such as historical data logging, reporting, storing alarm logs, and as your tags 
storage.  

Historical Data Logging

Logging data for historical analysis, either through Tags Historian or with the SQL Bridge module, requires a database connection. Databases are 
great at handling historical data, and by using a standard relational database your data is stored in an open format that can be used in many ways.

Reports, Graphs and Charts

The Vision module makes it easy to present data stored in databases in a variety of ways. You can quickly create charts that show performance over 
time, locate anomalies, detect trends, and more. Furthermore, it's important to remember that it is possible to pull data from any database that 
Ignition is connected to, even if the data wasn't placed there by Ignition. This means you can tie in data from other sources or areas of your company, 
such as pulling in inventory and staff information, as well.

Storing Alarm Logs

Store alarm information historically and examine it later for patterns or trouble spots.

Database-driven Tags

You can use a SQL database as your Tags repository. Any other Ignition system with access to the database will be able to share and contribute tags, 
allowing you to create highly integrated distributed systems. For example, multiple plant sites can use Tags to report current status over a secure 
network connection to a central corporate headquarters.

Getting Started with Databases

The first step in using a database with Ignition is to identify a database server. Many companies already have database servers maintained by their IT 
departments. If you do not, or wish to set up your own database server for Ignition, the Supported Databases section below offers some advice on 
choosing a database vendor.

 Once you've identified a server, all you need to do is create a connection to that server to get up and running.

Supported Databases in Ignition

Ignition has been tested with the following databases, and can connect to them directly after installation. You can connect to other databases by 
installing additional JDBC drivers (the Java database connection specification), which are often provided by database vendors.

http://confluence.ia.local/display/DOC/Connecting+to+Databases
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2.  

3.  

4.  

5.  

Database Version

Full Support (sorted by our current user install base)

MySQL 5.0+ for full support. Ignition can connect to 4.x, but many features such as Tags are not tested.

Microsoft SQL 
Server

2005, 2008, full, and express editions. Ignition can connect to 2000, but has not been fully tested.

Oracle 10g, 11g, full, and express.

PostgreSQL 8.0+

Limited support

Other JDBC 
drivers

Due to variances in databases, some features may not work fully through other non-tested JDBC drivers. However, it is usually 
possible to get full functionality though the careful use of the database translator feature.

Installing and Connecting to a Database

Once you've identified a server, all you need to do is create a connection to that server to get up and running. See the   and Installing Databases Conne
 sections for details about how to install and connect to different databases through Ignition.cting to Databases

Database Drivers and Translators

What is JDBC?

JDBC stands for the Java DataBase Connectivity API. It is a standardized way for Java-based applications to interact with a wide range of databases 
and data sources. A JDBC Driver enables Ignition to connect to, and use data from, a particular database system.

JDBC in Ignition

Ignition, being a Java-based application, leverages JDBC in order to connect to a variety of data sources. This enables Ignition to offer a standardized 
set of functionality on a wide range of different systems and databases. This includes not only commonly-used databases such as MySQL, Microsoft 
SQL Server, and Oracle, but additionally other lesser-known systems as well, provided the manufacturer offers a JDBC driver for the system.

JDBC vs. ODBC

JDBC differs from ODBC (Microsoft's OpenDataBase Connectivity standard) primarily in the fact that JDBC is written in Java, and thus can be used 
without modification in cross-platform environments. Additionally, whereas ODBC is a complex standard that is becoming technically outdated, JDBC 
is a modern, clean specification for cross-vendor database access.

Can I connect using ODBC?

While it is indeed possible to connect to an ODBC data source using the JDBC-ODBC bridge, this is generally not advised. The bridge is designed to 
offer a minimal amount of functionality, and is considered a "transitional solution", meaning that it should only be used when JDBC is not available. In 
other words, if a JDBC option is available, ODBC should not be used.

Since most commercial databases offer JDBC drivers, transition is usually as simple as recreating your database connections inside of Ignition. The 
lack of a JDBC connection inside of Ignition does not necessarily indicate that JDBC isn't available for your particular database. Licensing 
restrictions sometime prevent the inclusion of drivers with 3rd-party software. Therefore, before using ODBC, due diligence should be taken to verify 
that no JDBC solution is available.

Adding a JDBC Driver

To add a new JDBC driver to Ignition, do the following steps:

In Gateway on the  page, click on .Configure Databases > Drivers
The  page is displayed.Database Drivers & Settings
   
Find the orange arrow and click on the  link.  Create new JDBC Driver...

In the  field, type the full name of the JDBC driver, see the manufacturer's documentation to get the name.Name
   
In the  field, specify the core Java JAR file that contains the driver, as well as any other required JARs.JAR File(s)

Use the default settings for the following properties:

Driver Defaults and Instructions

Driver Is the brand of database. This is used for optimizations in the Gateway, if in doubt, select GENERIC.



5.  

6.  

1.  

2.  

3.  

Type

URL 
Format

Is a default value for the connect URL. This provides a hint addto the format of the connect URL that this driver requires while 
ing a datasource connection. For example, the hint for the format can be, jdbc:dbtype://host:port/database

URL 
Instructions

Free form instructions that are shown to help the user to create a connection.

Default 
Connection

Properties

Any additional properties to add by default to the connection string.

Connectio
n 
Properties
Instructions

Tips about which connection properties might be useful.

Default 
Validation
Query

The default query that is used to verify that the connection is available.

SQL Language Compatibility

Default 
Translator

The database translator that is used by default for connections from this driver.

       
Click the  button, located at the very bottom of the page, to create the new driver.Create New JDBC Driver

Database Translators

Despite the presence of a SQL standard, many database system vary in how they implement or accomplish various tasks. The JDBC driver system 
tries to hide these differences as much as possible, but unfortunately some differences persist.

The  system in Ignition navigates these differences as they apply to the system. It provides a way to define certain key operations database translator
that are commonly different between database vendors, such as creating auto-incrementing index columns, and the keywords used for different data 
types.

Translator Management

Database translators are managed in the Gateway from the   tab. Ignition comes pre-configured with translators Databases > Drivers > Translators
for the major supported databases, but you can edit and remove them, as well as create new translators. It is necessary to create a new translator 
only when adding a new JDBC driver for a database that does not share syntax with any of the existing translators.

Creating a New Translator

To add a new database translator to Ignition, do the following steps:

In Gateway on the  page, click on  .Configure Databases > Drivers
The   page is displayed.Database Drivers & Settings

Go to the  tab, find the orange arrow, and click on the  link. Translators  Create new Database Translator...
The  page is displayed showing a list of all the translator properties. New Database Translator
 
Define the tokens used with the translator properties on the   page.New Database Translator

For most of the properties, you need to define special token markers to indicate places where other values are placed. For example, the 
default   entry looks as follows:Create Table Syntax

CREATE TABLE {tablename} ({creationdef}{primarykeydef})

Where:
,  , and   are all tokens that are expanded. tablename creationdef primarykeydef  is replaced directly with the table, tablename creati

 is a list of columns, and ondef  is the phrase created by the   entry in the translator.primarykeydef Primary Key Syntax

The possible tokens are as follows:

Token Description



3.  

4.  

tablename The name of the table being created.

indexname The name of the index to create, when adding a column index to the table.

primarykeydef A clause that defines a primary key for a new table.

creationdef The list of columns to create in the table.

alterdef A list of columns to add/remove/modify in the table.

columnname The name of a column.

type The data type of a column.

limit The value of the limit clause.

Other Properties

Limit Position Defines where the limit clause should be placed. , the limit is placed at the end of the query. , places Back Front
it directly after the SELECT keyword.

Column Quote 
Character

All columns are created and accessed with the defined quote, which tells the database to use a specific casing, 
as well as avoiding collisions between the column name and database keywords.

Supports Returning 
Auto-generated Keys? / 
Fetch Key Query

Indicates whether the JDBC driver supports the return of generated keys. If the driver does not support this 
feature, the  is used to retrieve the last key.Fetch Key Query

Date Type Mapping

All data types The keywords that are used when creating columns of the given types.

Click the  button, located at the very bottom of the page, to create the translator.Create New Database Translator 

Monitoring Connection Status
The state or status of a database can be monitored from the  section of the Gateway, under . The status Status Status>Database Connections
panels show the current state and a fault message, if applicable, or throughput statistics if the connection is active.

When a connection is not available, it is re-tested every 10 seconds, and the status is updated.

In this section ...



Installing Databases
   

It is important to note that Ignition does not install any databases. You need to choose the database solution that is best for you and then install it. You 
can install it either on the server that Ignition resides on or a server that can be reached over the network from the Ignition server.

 

 

In this section ...  

   



1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

Installing MySQL
 

To install the MySQL server and workbench

Go to the MySQL website at
http://dev.mysql.com/downloads/mysql/

Scroll-down to
Windows (x86,64-bit), MySQL Installer MSI

Click on the  button.Download
 
Scroll-down to mysql-installer-community-x.x.xx.x.msi

Note: MySQL Installer is 32-bit, but will install both 32-bit and 64-bit binaries.

Click the  button.Download

On the next page, click the . No thanks, just start my download

The  file starts downloading..msi
 
Click the  file to run it and to configure the installer..msi

The  window is displayed.Welcome
 
Select the  action.Install MySQL Products

Installing MySQL

Watch the Video
 

 

 

 

 

http://dev.mysql.com/downloads/mysql/
https://www.inductiveuniversity.com/video/installing-mysql/7.8
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On the  page, click the  box and click .License Agreement  I accept the license terms Next

On the  page, click  to check for installer updates from MySQL. If Find latest products Execute
you want to use the version you have, you can select the skip option. When checking is 
complete, click .Next

On the  page, the simplest option is to select  and Choosing a Setup Type Developer Default
click  . The only drawback is that the install will be much larger.Next
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12.  

13.  

, you can select the   option and remove everything except the Optionally Custom MySQL 
 object. You can include the   if you want, it is nice to have if you ever Server MySQL Workbench

want to modify the raw structures

On the  page, click  to make sure all required prerequisites are Check Requirements Execute
met. Follow any instructions to install any missing prerequisites. Click  once all Next
prerequisites are met.

On the  page, click  to install all of MySQL products.  Installation Progress Execute
The  and the  will both be installed. Once all of the products MySQL Server MySQL Workbench
are installed click .Next



13.  

14.  

15.  

16.  

17.  

On the  page, click  to setup the configuration.Configuration Overview Next

On the  page (1/3), make sure the default   is , MySQL Server Configuration Port Number 3306
keep all the defaults and click .Next

On the next  page (2/3), choose a password for the root user, MySQL Server Configuration
type it in, and write it down so you have it for future, then click .Next

Make sure the following two items are selected by default: 
•   Start the MySQL Server at System Startup
• Standard System Account
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18.  

19.  

20.  

21.  

22.  

This installs MySQL as a Service and starts MySQL automatically each time you start your 
computer.
 
Click . The  page is displayed and shows the MySQL server Next Configuration Overview
installation is complete.

Click .Next

The  window is displayed and shows the check box for Installation Complete Start MySQL 
 is selected.Workbench after Setup

Click  to close the Wizard and complete the installation.Finish

The  window is displayed. MySQL Workbench lets you to administrate the MySQL Workbench
MySQL server.

Click on   to connect to the newly installed MySQL server.Local instance MySQL
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24.  

25.  

 Enter the root  you earlier entered into the installer and click .password OK

The  graphical user interface is displayed.Local instance MySQL

You are now connected and can see, in the Navigator, the default databases. Older versions of 
MySQL will start with a database named   where new ones may not. test

If you want to create a new schema with a new name (like  ), right-click in the white test
background of the Object Browser (next to the rest of the schemas) and select . Create Schema
Name it and click the  button in the lower right.Apply

 

 

Next ...

Installing Microsoft SQL Server Express
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Installing Microsoft SQL Server Express
 

You need to download and install both the   and the SQL Server 2014 Express SQL Management Studio
before you connect to the database.

To download SQL Server 2014 Express

Go to http://www.microsoft.com/en-us/server-cloud/products/sql-server/
 
Click   and under  click on .Products  SQL Server SQL Server Editions

Choose the  tab and click on .Express Download SQL Server 2014 Express
    
Click on the  file to run the executable.SQLEXPR_x64_ENU.exe

On the  window, click on the SQL Server Installation Center New SQL Server stand-alone 
 link.installation or add features to an existing installation

    
On the  window, choose  and click .License Terms I accept the license terms Next

On the  window, click  to start installing the SQL Server.Product Updates Next
    
On the  window, stay with the default selections and click .Feature Selection Next
     
The  window shows , you can keep it  Instance Configuration Named instance: SQL Express
or change it if you like, click .Next

On the  window, choose  from the dropdown under Server Configuration Automatic Startup 
 for the  service, and click .Type SQL Server Browser Next

     
On the  window, for  choose Database Engine Configuration  Authentication Mode Mixed 

, enter a , and click  .Mode password Next
       
On the next few windows, continue clicking  until it shows installation is .Next Complete
The   is now installed. SQL Server 2014 Express
Microsoft SQL Server Express installs with a  that wipes its data whenever the tempdb
computer is restarted.

To download SQL Management Studio

Go to http://www.microsoft.com/en-us/download/details.aspx?id=8961
 
Click on the  button.Download

Click on the  file to run the executable.SQLManagementStudio_x64_ENU.exe
 
On the SQL Server Installation Center window, click on the New SQL Server stand-alone 
installation or add features to an existing installation link.
 

On the Installation Type, keep the defaults and click Next.
 
On the   window, choose   and click  .License Terms I accept the license terms Next
 
On the   window, click   to start installing the SQL Server.Product Updates Next
 
On the   window, stay with the default selection of  and Feature Selection Management Tools
click  .Next

On the   window, for  choose Database Engine Configuration  Authentication Mode Mixed 
, enter a  , and click  .Mode password Next

On the next few windows, continue clicking   until it shows installation is  .Next Complete
The  is now installed.Management Tools

To run the program, go to Start > Programs > Microsoft SQL Server > SQL Server 
.Management Studio

Click on  to connect to the Microsoft SQL Server.Connect

In , you can now see some databases under .Object Explorer Databases > System Databases

Installing Microsoft 
SQL Server Express

Watch the Video

 

 

 

http://www.microsoft.com/en-us/server-cloud/products/sql-server/
http://www.microsoft.com/en-us/server-cloud/products/sql-server/
http://www.microsoft.com/en-us/download/details.aspx?id=8961
https://www.inductiveuniversity.com/video/installing-microsoft-sql-server-express/7.8
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Right-click on  and select .Databases New Databases...
The  window is displayed.New Databases

In , enter , click  and then  .Database name test Add, OK
Now you can see the  database in the  folder and can connect Ignition to it, seetest Databases  C

.onnecting to Microsoft SQL Server Express

 

 

Next ...

add link here
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Installing Oracle Express
 

To download and install Oracle Express

Go to the Oracle website at http://www.oracle.com

Click on , and then under , click on Downloads Database Oracle Database 11g Express 
.Edition

Accept the Licensce agreement and select the download version you are interested in. 
For example, you can download the Oracle Database Express Edition 111g Relase 2 for 

database.Windows x64 
The  file is downloaded.OracleXE112_Win64.zip
 
Unzip the   file by right-clicking on the file and selecting , then click  on .zip  Extract All...  Extract
the next window.
You will now see a DISK1 folder, and inside it is the  executable file.setup.exe
 
Double-click on  to start the Oracle database installation.setup.exe

On the  window, click .Welcome to Install Wizard Next
 
Accept the terms in the license agreement, and click .Next

Enter a password, and click .Next
This is the password to the SYSTEM account and you can use any password you wish just note 
it down.
 
Continue on the next windows, click  to install the database, and click  once Install Finish
installation is complete.
 
If the completion of the previous step does not automatically take you to the 
database administrative window in your browser, you can manually open your browser 
and access the database administrative screen by typing the following URL into your browser: 
http://localhost:8080.

Installing Oracle 
Express

Watch the Video
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Installing PostgreSQL
 

To install the PostreSQL database

Go to the  website atPostgre SQL
http://www.postgresql.org

Click on  , look for and click on the  link.Downloads Windows
 
On the  page, find the  link and click on it, and on the next page Windows installers Download
select the installer you are interested in.
For example, you can select the .Wins x86-32

From you Download folder on your computer, click on the Postgre  file to install the .exe
database.

Go through all the windows of the  until installation is complete. Install Wizard

From the Windows  menu, open the  database.Start Postgre pgAdmin
 
In the  of the  window, right-click on , select , Object browser  pgAdmin PostgreSQL Connect
enter your  to connect to the Server, and click .password OK
You will now see the  folder in the Object browser.Databases

Installing 
PostgreSQL

Watch the Video
 

 

 

 

 

 

 

Next ...

add link here

 

http://www.postgresql.org
https://www.inductiveuniversity.com/video/installing-postgresql/7.8
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Connecting to Databases
   

Many of the advanced features of Ignition, such as the Transaction Groups and Tags Historian require a 
connection to an external database. If you don't have a database, like Microsoft SQL Server, MySQL, or 
Oracle installed, don't worry - you can come back to this step later.

Now that we've installed your database, lets connect to it. You can find detailed descriptions for many 
database connections in this User Manual (see on this page), however they all include the following Next 
three main steps: 

Add a Database Connection
Once you are in the Gateway  section of the Gateway's web interface, use the menu Configure
on the left to go to the  section. On at the  Databases > Connections Database Connections
page, click on the  link at the bottom of the table.Create new Database Connection...

Pick a JDBC Driver
Ignition connects to databases using JDBC drivers that are unique to each database. Drivers for 
the most popular databases are included so there is usually no need to install the JDBC driver 
manually. 
Ignition ships with drivers for Microsoft SQL Server, MySQL, Oracle, and PostgreSQL. Pick the 
JDBC driver for your database, and click on the  button. Next
If a suitable driver is not available in the list, you need to add a new JDBC driver for other 
databases, like IBM DB2, which is not very difficult to do, see  .Adding a JDBC Driver
 
Configure the Connection
After selecting the driver, you'll configure the settings for the connection. Some settings, such as 
the Connect URL are specific to the driver that you're using.

Main Database Connection Properties

Name Each database connection needs a name, which consists of letters, numbers and 
underscores.

Con
nect 
URL

A string that instructs the driver how to connect to the database. This string is the 
server address, and may include the port, instance name, database name, and so on. 
The format and parameters depend on the driver being used.

User
name

The username to use when connecting. Some databases support other authentication 
methods, such as Windows authentication, in which case this field is not used.

Pass
word

The password to use for the given username.

Extr
a 
Con
necti
on P
rope
rties

Depending on which database you are connecting to, there will be different 
default values placed in this box. MS SQL Server requires you to place your 
database name here, but for other databases you can usually leave this at its default 
values.
Each database has its own set of available extra connection properties so you must 
refer to your Database documentation to determine what is valid here.

Ena
bled

Lets you to enable or disable a database connection.

Failo
ver 
Data
sour
ce

The connection to use when this connection is not available.

Failo
ver 
Mode

Lets you select how to handle failover and recovery. 
Database connections support , this means that the objects which use a failover
database connection, will use a different connection if the one they are using 
becomes unavailable. The   property determines which Failover Datasource
connection is used, and the   determines when, if ever, the connection Failover Mode
is switch back to the primary connection. 
There are two failover modes:
•  mode dictates that the secondary connection will be used only until the STANDARD
primary connection is available again.
•  continues to use the secondary connection until that connection fails, or STICKY
until the system is restarted.

Slow
Quer

Queries that take longer than this amount of time, in milliseconds, are logged making 
it easier to find queries that are not performing well. 

To Continue on the 
step-by-step simple 
workflow...

After you  , Connect to a Database
as described on the pages of this 
section, click the link below for Step 
4 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

 

 

 

https://legacy-docs.inductiveautomation.com/display/DOC/Database+Connections#DatabaseConnections-AddingaJDBCDriver
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y 
Log 
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Advanced Settings

There are a many advanced settings that you don't need to change under 
normal circumstances. See the description for each property on the settings page.

 

 

In this section ...  
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Connecting to MySQL
 

To connect Ignition to MySQL database

From the Gateway, go to the  section.Configure
 

 From the menu on the left, select .Databases > Connections
The Database Connections page is displayed.
 
 Look for the orange arrow, click on Create new Database Connection....

Select the  driver and click .MySQL ConnectorJ Next

Database connections in Ignition are powered by JDBC drivers. Ignition ships with drivers for 
Microsoft SQL Server, MySQL, Oracle, and a few others.
 
On the  page, enter the following information:New Database Connection

Name:  (use a meaningful name such as )MySQL MySQL

Connect URL:  (By default MySQL creates an empty jdbc:mysql://localhost:3306/test
database called )test

 

As you see in the example above, MySQL uses the following  format:Connect URL
jdbc:mysql://hostaddress:3306/database

Where   is the address of the machine with MySQL installed, for example: hostaddress
localhost, 192.168.1.1, db-server, etc.
and  specifies the database schema the connection will target. It's important to  database

Connecting to 
MySQL

Watch the Video

 

 

 

https://www.inductiveuniversity.com/video/connecting-to-mysql/7.8
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understand that a MySQL server can host many database files. The connection will target 
one database.
 
To configure the connection, enter the following information:

Username: root

Password:  (password is what you entered during MySQL server installation,  is the mysql mysql
password for this example)

Extra Connection Properties: Leave at the default value. By default, the zeroDateTimeBehavior
parameter is defined and it is usually not necessary to add more parameters.

Click on  at the bottom of the form. Your connection is now Create New Database Connection
created and the Database Connections page is displayed showing the  of your Status
connection as .Valid

To display the details about the status of your database connection, see the   on the above Note
window and click on the  link. This will display any errors if your Database Connection Status
status is Faulted, in this example it shows the status as being Valid.
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About Store and Forward
OPC-UA and Device Connections
Designer

 



1.  

2.  

3.  

4.  

5.  

6.  

Connecting to Microsoft SQL Server Express
 

To connect Ignition to Microsoft SQL Server

From the Gateway, go to the  section.Configure
 
From the menu on the left, select .Databases > Connections
The  page is displayed.Database Connections
 
Look for the orange arrow, click on  .Create new Database Connection...
 
Select  and click .Microsoft SQLServer JDBC Driver Next

The  page is displayed.New Database Connection
 
On the  page, enter the following information:New Database Connection
Name: SQLServer
Connect URL: jdbc:sqlserver://localhost\SQLEXPRESS

 We are connecting to the express edition of SQL Server using the default instance name. Note:
have the full SQL Server with default settings, replace SQLEXPRESS with If you 

MSSQLSERVER.
 
username: sa
password:  (password is what you entered during the SQL Server installation. For this sqlserver
example, password is )sqlserver

 
At the bottom of the form, click on .  Create New Database Connection
Your connection is now created and the  page is displayed showing the Database Connections

 of your connection as .Status Valid

On this page...

Microsoft SQL Server Connection 
Guide
Different Ways of Connecting to 
SQL Server
Troubleshooting
Next ...

Connecting to 
Microsoft SQL 
Server Express

Watch the Video

 

 

 

https://www.inductiveuniversity.com/video/connecting-to-microsoft-sql-server-express/7.8
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To display the details about the status of your database connection, see the   on the above Note
window and click on the  link.Database Connection Status

 

Microsoft SQL Server Connection Guide

This guide helps you with any difficulties you may have in getting the correct settings and parameters when connecting Ignition to Microsoft SQL 
Server, a popular and robust relational database.

Multiple Instances of Database

Microsoft SQL Server supports multiple instances of the database running concurrently on the same computer. Each instance has its own name and 
set of system and user databases that are not shared between instances.

Applications, such as Ignition, can connect to each instance on a computer in much the same way they connect to databases running on 
different computers.

By default, each instance gets assigned a dynamic TCP/IP port on startup that listens for any incoming requests. Since the port is dynamic and the 
application does not know what the new port is, it must connect using the instance name. 

So if the communication is over TCP/IP and the application knows the instance name, how does the application find which port to communicate to? 
The answer is the   service. The Microsoft SQL Server Browser program runs as a Windows service and listens for Microsoft SQL Server Browser
all incoming requests for resources and provides information, such as the TCP/IP port, about each instance installed on the computer. Microsoft SQL 
Server Browser also contributes to these two actions: browsing a list of available servers and connecting to the correct server instance.

If the Microsoft SQL Server Browser service is not running, you can still connect to SQL Server if you provide the correct port number. For 
example, you can connect to the default instance of SQL Server with TCP/IP if it is running on port 1433.

Check 1: Make Sure the Database has TCP/IP is Enabled

Ignition connects using TCP/IP, therefore make sure your database has TCP/IP enabled.

To check if TCP/IP is enabled

Open the   from SQL Server Configuration Manager Start > All Programs > Microsoft SQL Server Version # > Configuration Tools > 
 SQL Server Configuration Manager

The   window is displayed.Sql Server Configuration Manager
 
To see all the instances setup on that machine, expand  .SQL Server Network Configuration

Find the database (or instance) you plan on using. To the right, all of the protocols the database supports are shown. Find the   protocoTCP/IP
l and select it.
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Make sure the   next to TCP/IP is  . If not, double-click   and choose   from the drop-down next to Enabled and click Status Enabled TCP/IP Yes OK
.

 

 

Check 2: Make Sure Microsoft SQL Server Browser is Running

If you ARE connecting to your database using a NAMED INSTANCE, you must make sure that the Microsoft SQL Server Browser is running. As 
mentioned earlier, the Microsoft SQL Server Browser translates the instance name to a TCP/IP port in order for Ignition to connect to it.

To check if Microsoft SQL Server Browser is running
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Open the   from SQL Server Configuration Manager Start > All Programs > Microsoft SQL Server Version # > Configuration Tools > 
SQL Server Configuration Manager

Select the   section.SQL Server Services

On the right, see all of the services installed. One of the services is . Make sure this service is in fact running. If the  SQL Server Browser
service is not running, right-click and select  .Start

 The service could be disabled, so you may need to double-click it to enable the service before starting it up.Note:

 

Different Ways of Connecting to SQL Server

Now that you have ensured that TCP/IP is enables and the Microsoft SQL Server Browser is running, you can connect to Microsoft SQL Server in 
four different ways (all using TCP/IP communication) as follows:

Connect using an Instance Name and SQL Authentication
 
Connect using an Instance Name and Windows Authentication (this is the most common method)
 
Connect using a Port and SQL Authentication
 
Connect using a Port and Windows Authentication

Scenario 1: Connect By Using an Instance Name and SQL Authentication

By default, Microsoft SQL Server only allows Windows authentication since it is more secure. But because we are using SQL authentication, we 
must enable Microsoft SQL to allow this type of authentication.

To enable SQL authentication

Open the   window from Microsoft SQL Server Management Studio Start > All Programs > Microsoft SQL Server Version # > SQL 
Server Management Studio

The window is displayed showing connections to your database.
 
Right-click the top-level database in the   and select  .Object Explorer Properties
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From the Server Properties window, on the left side, select  .Security

 
Verify that   mode is selected. SQL Server and Windows Authentication
If not, select it and click  . OK

Now you need to restart the   service so that this setting takes effect.SQL Server Windows
 
Open the   at SQL Server Configuration Manager
Start > All Programs > Microsoft SQL Server Version # > Configuration Tools > SQL Server Configuration Manager

Select the   section and restart the   item.SQL Server Services SQL Server (Instance Name)



6.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

a.  

b.  

8.  

9.  

1.  

 
Now that Microsoft SQL Server accepts SQL authentication, we can configure Ignition.

To configure the database connection in Ignition

Go to and login to the Ignition Gateway configuration page from your webbrowser at 
http://hostname:8088/main/web/config/

Select   from the menu.Databases > Connections
 
Click on  .Create new Database Connection
 
Select  and click  . Microsoft SQL Server JDBC Driver Next
 
In the   window, enter the following information:New Database Connection

Name:   (no spaces)SQLServer_SQLAuth

Connect URL: jdbc:sqlserver://Hostname\InstanceName

where   is your databases IP address or hostname and   is your databases instance name, for example:Hostname InstanceName
jdbc:sqlserver://localhost\SQLEXPRESS
jdbc:sqlserver://10.10.1.5\MSSQLSERVER
 
Set the username and password to a valid SQL authentication user. For example,  is the default administrator account you can use.sa
 
To add your own user account, open the SQL Server Management Studio and expand the   folder.Security > Logins
You will see all the current logins including   and you can add a new login.sa
 

To add a new login, right-click on the   folder and click  .Logins New Login...
The   window is displayed.Login
 
Choose the   mode and type in a Login name and password.SQL Server authentication

 You will also have to add permissions to your database by mapping db_datareader and   to the new user Note: db_datawriter
in the   section of the Login window. If you want Ignition to be able to create tables (ie: for Tag History), you also need User Mapping
to give table creation access such as db_owner.
 

Go back to the   page in the Gateway, enter the name of your database, for example, in the New Database Connection Extra Connection 
 enter:   (replace   with your database name, not the instance name)Properties databaseName=test test

 
Click  .Create New Database Connection
The Database Connection page is displayed showing the Status as  after a couple of seconds. If the connection is  , click on Valid  Faulted
the Database Connection Status link to find out why. Typically, the username/password is incorrect or the user doesn't have the right 
permissions.

Scenario 2: Connect By Using Instance Name and Windows Authentication

In Windows authentication mode, the username and password used to connect comes from the Ignition Windows Service logon. By default, 
the Ignition Windows Service is set to local system account which usually doesn't have privileges to connect.

To set up the service to use Windows Authentication

You must install the Microsoft JDBC driver package (version 3) before attempting to connect using Windows Authentication. You can 
download the file .here
 

http://hostname:8088/main/web/config/
http://files.inductiveautomation.com/sqlserver_winauth_dlls/auth.zip
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Extract the files to your desktop. Locate the   file from the correct architecture folder (x86 for 32-bit and x64 for 64-sqljdbc_auth.dll
bit) inside of the  .enu/auth folders in the zip file
 
Copy the   file to the  folder in your install directory. If you have the default install directory, it's in the following sqljdbc_auth.dll lib
location: 
C:\Program Files\Inductive Automation\Ignition\lib\
 
The account used to connect will be the account that Ignition is running under in the services menu. To setup Ignition to logon using the right 
Windows account, open the  from Start > Control Panel > Administrative Tools > ServicesServices Control Panel
 
Right-click the   service and choose  .Ignition Properties
 
Select the   tab.Log On
 
Choose the  radio button and enter in your Windows username and password.This account
 
Click   to save.OK
 
Now restart the Ignition service to make this change take effect. Click the   button in the menubar to restart the Action > Restart
Ignition service (or your can stop and start from the right-click menu).

To configure the database connection in Ignition

Go to and login to the Ignition Gateway configuration page from your webbrowser at   http://hostname:8088/main/web/config/
 
Select   from the menu.Databases > Connections
 
Click on  .Create new Database Connection
 
Select   and click  .Microsoft SQL Server JDBC Driver Next
 
On the   page, enter the following information:New Database Connection
Name:   (no spaces)SQLServer_WinAuth

Connect URL: jdbc:sqlserver://Hostname\InstanceName

where   is your databases IP address or hostname and   is your databases instance name, for example:Hostname InstanceName
jdbc:sqlserver://localhost\SQLEXPRESS
jdbc:sqlserver://10.10.1.5\MSSQLSERVER

: leave blankusername
: leave blankpassword

Extra Connection Properties:
 (replace test with your database name)databaseName=test; integratedSecurity=true;

 
Click on  .Create New Database Connection
The Status should be Valid after a couple of seconds. Again, if the connection is Faulted, click the Database Connection Status link to 
find out why.

Scenario 3: Connect By Using Port and SQL Authentication

Connecting by using a port and SQL authentication is just like scenario 1 above except you specify a port instead of the instance name in the New Dat
 page.abase Connection

Enter the following:

Connect URL: jdbc:sqlserver://Hostname:Port

where   is your databases IP address or hostname and   is your databases TCP/IP port (SQLSERVER default port is 1433), for example:Hostname Port
jdbc:sqlserver://localhost:1433
jdbc:sqlserver://10.10.1.5:1433

Scenario 4: Connect By Using Port and Windows Authentication

Connecting by using a port and Windows authentication is just like scenario 2 above except you specify a port instead of the instance name in the New
 page. Database Connection

Enter the following:

Connect URL: jdbc:sqlserver://Hostname:Port

where   is your databases IP address or hostname and   is your databases TCP/IP port (SQLSERVER default port is 1433), for example:Hostname Port
jdbc:sqlserver://localhost:1433
jdbc:sqlserver://10.10.1.5:1433

   

http://hostname:8088/main/web/config/


Troubleshooting  

TCP/IP Communication Not Enabled

SQL Server requires that you explicitly turn on TCP connectivity. To do this, use the SQL Server Configuration Manager, located in the  menu Start
under . Under , select your instance, and then enable TCP/IP Microsoft SQL Server > Configuration Tools SQL Server Network Configuration
in the panel to the right. You need to restart the server for the change to take affect.

Window Firewall

When connecting remotely, make sure that Windows Firewall is disabled, or set up to allow the necessary ports. Normally ports 1434 and 1433 must 
be open for TCP traffic, but other ports may be required based on configuration.

SQL Server Browser Process Not Running

To connect to a named instance, the  service must be running. It is occasionally disabled by default, so you need to verify that SQL Server Browser
the service is not only running, but set to
start automatically on bootup. The service can be found in the Windows Service Manager ( ).Control Panel > Administrative Tools > Services

Mixed Mode Authentication Not Enabled

Unless selected during setup,  or  is not enabled by default. This mode of authentication is the  mixed mode SQL authentication username/password
scheme that most users are used to. When not enabled, SQL Server only allows connections using Windows Authentication. Due to the ease of using 
SQL Authentication over Windows Authentication, we recommend enabling this option and defining a user account for Ignition.

To enable this, open the SQL Server Management Studio and connect to the server. Right click on the instance and select . Under Properties Security
, select SQL Sever and Windows

.Authentication mode
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Connecting to Oracle Express
 

To connect Ignition to the Oracle Express database

 From the Gateway, go to the   section.Configure
 
From the menu on the left, select  .Databases > Connections
The   page is displayed.Database Connections
 
Look for the orange arrow, click on  .Create new Database Connection...

 
Select the   and click  .Oracle JDBC Driver Next

 
Enter the following information:
Name: Oracle

(  is the System ID in Oracle)Connect URL:   jdbc:oracle:thin:@localhost:1521:XE XE
username: SYSTEM
password:   (password is what you entered in during the Oracle server installation, in this oracle
example, the password is  )oracle

Click   at the bottom of the form.Create New Database Connection
The Database Connections page is displayed showing the   of your connection as  .Status Valid
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7.  To display the details about the status of your database connection, see the   on the above Note
window and click on the   link.Database Connection Status
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Connecting to PostgreSQL
 

To connect Ignition to the PostreSQL database 

 From the Gateway, go to the   section.Configure
 
From the menu on the left, select  .Databases > Connections
The   page is displayed.Database Connections
 
Look for the orange arrow, click on  .Create new Database Connection...

 
Select the   and click  .PostgreSQL JDBC Driver Next
 
Enter the following information:
Name: PostgreSQL
Connect URL: jdbc:postgresql://localhost:5432/test
username: postgres
password: password is what you entered in during the Postgres installation.

Click   at the bottom of the form.Create New Database Connection
The Database Connections page is displayed showing the   of your connection as  .Status Valid
 
To display the details about the status of your database connection, see the   on the above Note
window and click on the   link.Database Connection Status
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About Store and Forward
   

The store-and-forward system provides a reliable way for Ignition to store data to the database. In Ignition, systems such as Tag Historian and 
Transaction Groups use store-and-forward to ensure that data is not lost and is reached its destination in the database, and is stored in an efficient 
manner. The store-and-forward system can be configured in a number of ways, offering both memory buffering for performance and local disk caching 
for safe storage.

Store-and-forward engines are automatically created for each Database Connection.: Note

Primary Features and Benefits

The store-and-forward system offers a number of benefits over other systems that log directly to the database, such as:

Data loss prevention
Data is removed from the system only when the write to the database has executed successfully.
 
Guaranteed ordering
Data is forwarded in the same order that it arrived.
 
Enhanced performance
By first buffering the data in memory, the store-and-forward system can optimize writes, and prevent the originating systems from blocking. 
This means that the system is less likely to lose data samples in the event of system slow downs.
     

Store and Forward Data Flow

Although the system offers settings that can affect the pipeline, by default the data flow occurs as follows:

Data is generated in some system.
Data is placed in a memory buffer.
If not removed from memory buffer in some time (the ), or if a certain amount of data Write Time accumulates ( ), it is placed in the Write Size
local cache.
The data sink, based on a database connection, pulls data in first from the local store, and then the memory buffer, based on the   Write Time
and   settings under  .Write Size Forward Settings
If the data fails to forward, either due to an error in the connection or in the data itself, it is returned to the buffer or cache.
If the data errors out too many times, it becomes quarantined.
Quarantined data can be managed through the Gateway, and can be deleted or un-quarantined, once the error is resolved.

Understanding the Forward Triggers

Data is forwarded from one stage to the next based on the   and   triggers. These settings work as an   manner, meaning Write Time Write Size either/or
that if either of them is surpassed, the data is forwarded. One important point to note is that the   setting influences the transaction size of Write Size
similar data to be forwarded, and therefore can have a big impact on performance. As a result, the   should normally be used as the Write Time
controlling factor, with the   set to something that will provide reasonable transactions, like 100.Write Size

Store and Forward for Reliability

The store-and-forward system settings, while seemingly limited, offer a good deal of flexibility in tuning. Different types of situations and goals will 
likely require different configurations.

When the safety of the data is a concern, the goal is to get the data stored to disk as quickly as possible in order to minimize risk of loss due to a 
power outage or system failure. The local cache plays a crucial role in this, allowing the system to store data locally for any amount of time until 
the remote database can accept it. This protects against network failures and database failures, as well.

By setting the  and  of both the local cache and forwarder to low values, the data spends less time in the memory buffer. While write size write time
the memory buffer can be set to 0 to bypass it completely, this is not usually recommended, as the buffer is used to create a loose coupling between 
the history system and other parts of Ignition that report history. This disconnect improves performance and protects against temporary system 
slowdowns. In fact, it is recommended that for reliable logging, this value be set to a high value, to allow the maximum possible amount of data to 
enter the system in the case of a storage slowdown.

Store and Forward for High-speed Buffering

When configuring the store-and-forward system for high-speed buffering, you are expecting the case that data will come in quick bursts. By buffering 
the data, the system can accommodate more information than would be possible going directly against the database.

The key points in configuring a buffering system is to avoid expensive operations like storing and reading from the local cache, and to set the memory 
buffer large enough to accommodate the expected burst sizes.

Recommended Settings



The following recommended   (at   from the   section of Gateway) are merely a starting Engine Settings Database > Store and Forward Configure
point, you can adjust them to fit your goals: 

Buffer Settings

Memo
ry 
Buffer
Size

Set to 500 or higher. It should be high enough to accommodate several bursts of data. For example, if you expect data to be logged at 100 
ms burst for 10 seconds at a time, 100 records would be the minimum value. Data is forwarded as it comes in, according to the forward 
settings, but you should not rely on any particular throughput in order to avoid data loss.

Store Settings

Disk 
Cach
e 
Enabl
ed

Unselect this check box. Depending on your requirements, disable the disk store, or at least set to a high write size/count settings. Writing 
and reading from the cache is much slower than memory, so it is desirable to avoid it. Of course, the cache should only be disabled if it is 
ok to lose some data, should the database connection be down for a period of time.

Forward Settings

Write 
Size

This value should be larger than the expected burst size. Burst data is from the same source, and therefore will benefit heavily from the 
optimizations in the buffer.

Write 
Time

This value should be balanced in order to give the buffer time to receive multiple records that can be optimized, as described in Write Size 
above. However, it should not be so long that too much data becomes scheduled to write, which could cause a system slowdown/back up.

 

   

In this section ...  
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Using Store and Forward
 

All the database connections in Ignition use the  system. This system offers a Store and Forward
number of benefits over other systems that log directly to the database. The main benefits are: data loss 
prevention and enhanced performance.

To monitor the Store and Forward engine

Go to the Status section of the Gateway.
 

Click on Store & Forward from the left menus. 

The Store & Forward Engines page is displayed showing each store-and-forward engine along 

with the current throughput and capacity of its Memory Buffer and Local Cache.
 

You can click enable live values on the top-right of the page to refresh and update the 
displayed values.

 

 

 

The following status information are shown on the  page:Store & Forward Engines

Memory Buffer

Memory buffering provides database performance.

Available
Shows the whether or not the memory buffer is available.
 
Pending
Shows the maximum number of records that can accumulate in the memory buffer before being 
written to the cache as you have set with the  property.Store Settings-Write Size

Maximum
Shows the maximum size of the in-memory buffer as you have set it with the Memory Buffer 

 property.Size

Local Cache

Local disk caching provides safe storage.

Available
Shows the whether or not local cache is available.
 
Pending
Shows the number of records waiting to be forwarded as you have set with the Forward 

 property.Settings-Write Size
 
Quarantined
The number of quarantined records for the cache.
 
Maximum
Shows the maximum number of records that can be cached as you have set with the Store 

 property.Settings-Max Records

Using Store and 
Forward

Watch the Video
 

 

 

 

 

https://www.inductiveuniversity.com/video/using-store-forward/7.8


Database Storage

Available
Shows the status of database storage as being available or not. If it is available, you can see 
that the local cache is empty. But if the database storage is not available, you need to find out 
how much time on your local cache you have left before it is maxed out.

Throughput, Total, and Duration

Shows the diagnostic information and statistic relating to the throughput and duration. It is important to 
remember how the data flows when interpreting the statistics. The number of rows that have gone to 
the database will be the number forwarded from the local cache, and then the number forwarded 
from the memory buffer, minus those that entered the cache from there.

 

 

Next ...

Configuring Store and Forward
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Configuring Store and Forward

Store-and-forward engines are directly Each database connection has its own store and forward settings. 
correlated to database connections, and are automatically managed so that each connection has an 
engine defined.

 You can create multiple database connections pointing to the same database if you wish to Tip:
configure multiple store-and-forward engines for different purposes. 

To configure the Store and Forward engine for your database, do the following steps:

Go to the Gateway   section and select  . Configure Databases > Store and Forward
The  page is displayed and you will see a store-and-forward setting for each Store and Forward
of your database connections and you can edit these settings.

On the  page, look for  at the far right of the table and click on it to see Store and Forward edit
all the store-and-forward settings.
The settings of a store-and-forward engine define how and when data is moved through the 
system. You must understand these settings so that you can carefully set them according to 
your goals.

Store and Forward Settings

Buffer Settings

M
e
m
or
y 
B
uf
fe
r 
Si
ze

The number of records that can be stored in the memory buffer, the first stage of the 
store-and-forward chain. Other settings define when the data will move from the memory 
buffer forward, this setting only determines the maximum size. If the max size is reached, 
additional data will error out and be discarded. The memory buffer cannot quarantine 
data, so if there are errors and the disk cache is not enabled, the data will be lost.
If set to 0, the memory buffer will not be used. 

Store Settings

These settings apply to the local disk storage cache.

E
n
a
bl
e 
Di
sk
C
a
c
he

Turns on the hard-disk cache. Data is stored here if it cannot be forwarded in a timely 
manner. The cache also stores quarantined data (that is, data with errors).

M
a
x 
R
e
c
or
ds

The maximum size of the cache. After the max is reached, data is backed up into the 
memory buffer, and once that is full, it is dropped. The default value is 25,000. 

Note: The disk cache is intended to be a short term storage system. It is not 
recommend to increase the Max Records beyond 50,000. 

W
rit
e 
Si
ze

The number of records that should be accumulated in the memory store before written to 
the cache. Writing data in blocks can increase performance, but too large of a size 
increases the risk of data being lost in the event of a power outage or system failure.

W
rit
e 
Ti
me

The max age of records in the memory buffer before they are stored to the cache. This 
setting is used in combination with the write size in order to give the forwarder the 
opportunity to retrieve data directly from the memory store and avoid the write to disk 
entirely.

Configuring Store 
and Forward

Watch the Video

https://www.inductiveuniversity.com/video/configuring-store-forward/7.8
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Forward Settings

These settings govern when data is forwarded to the database. The 
data is pulled first from the local cache, and then from the memory 
store. When no data is present in the cache, it is pulled directly from 
the memory store.

W
rit
e 
Si
ze

Same as disk cache setting above.

W
rit
e 
Ti
me

Same as disk cache setting above.

E
n
a
bl
e 
S
c
h
e
d
ule

If enable schedule is selected, the forward engine will only be enabled during the times 
specified by the pattern. The pattern can specify specific times and ranges using a 
simple syntax.

S
c
h
e
d
ul
e 
P
at
te
rn

The schedule is specified as a comma separated list of times or time ranges. You can 
use the following formats:

24-hour times, that is   (for 8am through 3pm) or  (9pm through 8:00-15:00 21:00-24:00
midnight).

12-hour with am/pm (if not specified,   is considered noon): 12 8am-3pm or 9pm-12am

Note: When the time period is over, any queued data will remain cached until the next 
execution period. That is, the forward engine does not run until all data is forwarded.

Once you made the changes you want, click  at the bottom of the page.Save Changes
This will take you back to the Store and Forward page. 

Next ...

Controlling Quarantine Data



1.  

2.  

3.  

4.  

Controlling Quarantine Data
 

Quarantined data is data that has erred-out multiple times during attempts to forward it or data that could 
not be stored because of some configuration issues. It is removed from the forward queue to allow other 
data to pass. The most common reason for data quarantining is an invalid schema in the database for 
the data that is being stored. Quarantined data is held indefinitely the issue is resolved, then you can 
either delete it or re-insert it into the queue. 

To handle the quarantined data

From  section of the Gateway, go to .Configure Databases > Store and Forward

Go to the   tab and look for the problem/error.Quarantine Control
Here you will see any quarantined data which are listed according to store-and-forward engine 
and the data format, with a description, the error that caused the quarantine, and the number of 
quarantined records. On the right side of these records you can see  or .retry delete

Fix the problem/error you found that caused the quarantine data.
 
Click either on  orretry  delete.

 will un-quarantine the data and place the engine back in the forward queue.retry
 will permanently delete the data in the selected row. All transactions of the selected type delete

are deleted.

Controlling 
Quarantine Data

Watch the Video
 

 

 

 

 

 

 

 

Next ...

Connecting to Databases
or 
Connecting to a Device
or 
Tag Historian

 

 https://www.inductiveuniversity.com/video/controlling-quarantine-data/7.8
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OPC-UA and Device Connections
   

Note: Connecting to a device at this point is an optional step! You can come back to it later. However, 
the next steps will be more interesting if you add a device now.  

Now that we've installed Ignition and have logged into the Configuration section of the Gateway web 
interface, lets connect to a device. You can find detailed descriptions for many device connections in this 
User Manual, but they all include the following three main steps: 

Create new Device 
From the left side configuration menu of the Gateway, you go to the  OPC-UA > Devices
section. Once at the  page, click on the  link at the bottom of the Devices Create new Device...
table.

  A device is a named connection to an industrial device like a PLC. There are also  Simulator  de
vices in Ignition that you can connect to which act like a real device connection in case you 
don't have one available. Device connections are done over the Ethernet for those devices that 
have an Ignition device driver.
 
Choose a Driver 
A list is displayed so you can choose the driver for the device you want. If you don't have a 
device that matches one of the available drivers, you can add a  device so you have Simulator
some data to play with.
 
Configure the Device 
After you choose the driver, you give your device a name and set some options. Typically, the 
options are just an IP address to connect to. After configuring the device, click the Create New 

 button to add your device. You can check the connectivity status of your device in the Device
Gateway Status section, under Ignition OPC-UA Server.

Connecting to a Device

See the following links for the type of device connection you are interested in:

Allen Bradley Ethernet
Modbus
Siemens
UDP and TCP Driver
Third Party OPC Servers
Connecting to DNP3 Devices

What is OPC?

OPC is a specification for the transport and use of industrial data. It is published and maintained by 
the OPC Foundation, an organization comprised of hundreds of member companies that strives to 
ensure interoperability on the plant floor and beyond.

History

The original OPC specifications used Microsoft DCOM technology to provide a uniform way for 
industrial applications to share data. There were several separate specifications that provided functions 
such as Data Access (OPC-DA), Alarms and Events (A&E), Historical data (HDA) and more.

DCOM always proved difficult to work with, and by 2004 it was clear that a more modern solution 
was needed. Therefore, a new specification was developed that used common networking principals 
instead of DCOM, was platform independent, and combined the various separate specifications into one: 
OPC-UA. 

OPC-UA

OPC-UA is the leading industrial standard for platform and vendor-neutral data access. Connecting any 
PLC device to Ignition is easy with OPC-UA. Device connections are done over the Ethernet for those 
devices that have an Ignition device driver. The OPC-UA Module in Ignition, makes Ignition act as an 
OPC-UA server, serving data collected by its built in drivers to other Ignition modules, as well as to third-
party OPC-UA clients.

OPC-UA is the latest revision of the OPC specification, which offers platform and vendor neutral transfer 
and use of industrial data. The specification plays a crucial role in Ignition, and is the primary data access 
specification used in the Gateway. Ignition supports connections to any number of OPC-UA servers 
created by any manufacturer, provided that they are compliant to the specification. The data is then used 
to drive all aspects of the system. Creating connections to OPC-UA servers is described below in Connec

.ting to OPC-UA

To Continue on the 
step-by-step simple 
workflow...

After you  , as Connect to a Device
described on this page, click the link 
below for Step 3 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

Steve Hechtman Blog

Click the link below to see the blog:

OPC-UA goes mainstream

 

 

 

 

 

 

 

 

http://computingwithoutboundaries.blogspot.com/2014/04/opc-ua-goes-mainstream.html
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Distributed Systems with OPC-UA

OPC-UA breaks down boundaries and enables free data flow. Using standard TCP/IP instead of 
legacy DCOM, OPC-UA makes it easy to securely transfer data between networks and though firewalls. 
All OPC-UA connections are based on the same technology, which means that a connection to your 
local machine is not entirely different than a connection to a machine that's far away. This enables 
the creation of highly distributed system, and in combination with other features of Ignition can lead 
to much more connected enterprises.

For example, imagine a corporate network with an office in the center, and remote processes connected 
through a VPN, which would pass through a variety of connections. Each remote site could have an 
Ignition installation running only an OPC-UA module that would report data back to a central facility and 
record it in a database. The overall system cost would be very low, the data could be managed centrally 
in a single location, and then made available to all interested parties through the Vision module or any 
application that could access the database.

Servers and Clients

When discussing OPC (as the specifications are often called collectively), it is common to hear about OP
 and  . An OPC Server is a piece of software that implements the OPC interface C servers OPC clients

and provides data. An OPC Client is an application which connects to an OPC Server and uses the 
specification to retrieve and work with data.

The Ignition platform inherently offers OPC-UA client functionality. That is, even with no 
modules installed, the Gateway can connect to any compliant OPC-UA server and work with data. With 
the addition of the OPC-UA Module, Ignition becomes an OPC server as well, hosting device drivers 
that read and publish data.

The OPC-COM module is available to provide client access to older, DCOM based, OPC-DA servers.

Technology

The OPC-UA specification offers a wide range of flexibility in choosing technologies, from the 
transport mechanism, to the way data is encoded, to the encryption used to secure the data. Ignition 
supports the UA/TCP transport with the UA/Binary encoding scheme for maximum performance.

Additionally, Ignition supports all of the common encryption schemes. This means that Ignition connects 
to OPC-UA servers (and allows connections from clients) over TCP/IP, using encryption, and sends data 
by first encoding it into an efficient format defined by the OPC-UA specification. This is in contrast to 
other schemes outlined in the specification, which can use web services and XML encoding, and are not 
as efficient.

   

Connecting to a OPC Server

OPC-UA Server

An OPC-UA Connection is used to communicate with an OPC-UA compliant server, such as the one the OPC-UA module provides.

The following steps walk-through connecting Ignition (as an OPC-UA client) to a OPC-UA server:

On the   page of the Gateway, go to Configure OPC Connections > Servers.
The   page is displayed.OPC Server Connections
 
Click on the   link.Create new OPC Server Connection
 
Select   from the list and click  .OPC-UA Connection Next
The  page will appear.Discover OPC-UA Endpoints 

 
Type in a OPC-UA endpoint for the OPC-UA Server Ignition should connect to. The format should be as follows: opc.tcp://IpAddress

 :Port
Ignition can connect to it's own OPC-UA server's endpoint by using localhost and the default port of 4096: opc.  tcp://localhost:4096

A hostname could be used instead of an IP address: opc.  tcp://myhostname:4096

 
Once an endpoint has been entered, click the   button. A list of available Security Policies and Message Security options will Discover
appear.

tcp://IpAddressPort
tcp://IpAddressPort
tcp://localhost:4096
tcp://myhostname:4096


5.  

6.  

7.  

Select a Security Policy and Message Security configuration to use when connecting to the endpoint.  SecurityPolicies and Basic128 Sign
 MessageSecurity are more secure than If available,  should be selected. AndEncrypt None. Basic256

Once an endpoint configuration has been selected, click the   button.Next
On the  page, give the connection a name.New   OPC UA Connection Settings 

Some OPC-UA servers may require a Username and Password, but this is not always the case. Check with the OPC-UA server's 
documentation for more details. 

By default, Ignition's OPC-UA server requires the following credentials:

Username opcuauser

Password password

 
Once credientials have been entered, click the  button.Create New OPC Server Connection

Ignition is now connected to the OPC-UA server.

OPC-UA Server properties

Main

Name A name used to identify this connection.

Description Short description of this connection.

Read-only Puts the connection into read-only mode. All writes sent to this server will fail.

Enabled Disable the connection to the OPC server.

Authentication

Username 
and 
Password

If a username and password are specified, they are used as a user identity token when connecting to the specified OPC-UA 
server.
The internal OPC-UA server provided by the OPC-UA module uses an Ignition security profile to govern who can connect to it. 
This can be configured in the  section.OPC-UA > Settings

Change 
Password?

Enable this property to change the configured password.

Advanced

Host 
Override

When specified, if the endpoint address returned by the OPC server has a different IP address or hostname than the discovered 
endpoint, the overridden value will be used. Expects just an IP address or hostname. Example: 192.168.1.10

Max Per 
Operation

Specify the maximum number of nodes to read, write, subscribe, or unsubscribe to in any given UA server request. 
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Failover Settings

Failover 
Enabled

When enabled, if this OPC-UA server connection is faulted, requests will be sent to a failover OPC-UA server.

Failover 
Endpoint

The endpoint of the failover server. 
: opc.Example tcp://192.168.1.0:4096

Failover 
Threshold

The number of retry attempts before the failover connection is used. 

The following feature is new in Ignition version 7.8.3
 to check out the other new featuresClick here

Failover Settings

Backup Discovery URL  The discovery URL for the backup server's OPC-UA server. Expects the following format:
opc.tcp://hostname:port

Backup Endpoint URL The full endpoint URL for the backup gateway. An example endpoint would look like the following:

opc.tcp://10.20.1.100:4096/iaopcua/Basic128Rsa15

Failover Versus Backup Properties 

The   properties should be used when a single Ignition gateway needs to connect to a pair of redundant OPC-UA servers. The failover OPC-Failover
UA server will be used in the event the primary OPC server goes down.  To enable failover, set the   property to true, and specify the Failover Enabled

. The   can be adjusted if desired. Failover Endpoint Failover Threshold

The   properties should be used when a pair of redundant Ignition gateways are trying to look at the same OPC-server. Both the Backup Backup 
 and   properties need to be configured. Discovery URL Backup Endpoint URL

Connecting to OPC Classic (COM)

The OPC-COM module provides the ability to connect to OPC servers that only communicate using the older COM based OPC-DA standard. If you 
have an OPC server that is not capable of accepting OPC-UA connections and you need to talk to a PLC for which Ignition has no supported driver, 
you'll have to use the OPC-COM module to make your device data available in Ignition. Connections to OPC servers will be held open while the 
Ignition Gateway is running. All subscriptions to the server will use the same connection.

This section provides a brief walk-through of how to set-up a new Local or Remote OPC-DA server connection using the COM module. Due to the 
complications that Windows DCOM security settings can cause, this set-up guide is followed by the Troubleshooting OPC-COM Connections section 
that deals with an overview of how to deal with a faulted server connection due to DCOM security settings as well as other possibilities.

To Install OPC Core Components

. Register at  www.opcfoundation.org  
 The OPC-COM module relies on a .dll package provided by the OPC Foundation (  www.opcfoundation.org ) called the OPC Core 

Components. You can download the OPC Core Components Redistributable from the OPC Foundation's website under the downloads 
section. Registration with the OPC Foundation is required before you can download the package, but the registration process is free 
and painless.
 
Download appropriate OPC Core Components Redistributable package.  
There are two packages to choose from, the 32-bit (x86) and the 64-bit (x64), make sure you get the correct one for the version of Java and 
Ignition you are running. 64-bit Java and Ignition needs the 64-bit Core Components package and likewise 32-bit installations needs the 32-

How do I determine the Endpoint for my backup?  

See step 5 in the Connecting to a  guide above. Clicking the Discover button will show a list of available endpoints to OPC-UA Server
connect to.

Classic OPC is based on COM, which is a technology in Microsoft Windows. Therefore, the information in this section only applies to 
Ignition Gateways installed on Windows. For other operating systems, OPC-UA must be used.

tcp://192.168.1.0:4096
https://docs.inductiveautomation.com/display/DOC/New+in+this+Version#NewinthisVersion-Newin7.8.3
tcp://hostnameport
tcp://10.20.1.100:4096/iaopcua/Basic128Rsa15
http://www.opcfoundation.org
http://www.opcfoundation.org
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bit package. 

Install Core Components on Ignition server.
It should be noted that if you are going to connect to an OPC server on a remote machine, you must also install the appropriate version of the 
Core Components on that server as well. The version type, 64-bit or 32-bit, does not need to be the same across the two servers. Just be 
sure to install the version that is appropriate for the OPC Server and Windows architecture.
 
(Remote) Install Core Components on remote machine running the OPC-DA server. 
Once you have the correct package downloaded you can extract the contents of the .zip file and then run the installer. With the core 
components installed you can now proceed to setting up your OPC-DA server connection in Ignition.

Connecting to OPC-DA Server

With the OPC Core Components now installed the next step is creating/configuring a new OPC-DA server connection.

To Install OPC-DA server connection

Go to the Ignition Gateway  section (Configure  http://localhost:8088/main/web/config).
Go to  and then select .OPC Connections > Servers Create new OPC Server Connection...  
 

 connection or if the OPC server resides on a Choose the  and then sOPC-DA COM Connection elect whether you want to make a  Local  Re
 machine. For the most part, setting up a local or remote connection to an OPC-DA server is the same. There are only a couple mote

of differences for a remote connection that will be highlighted along the way. 
 - Selecting a local connection takes you to a screen that contains a list of the available and running OPC servers located on the local Local

 machine.
 - For a remote connection you first have to specify the host name or IP address of the machine the the OPC server resides on and Remote

 then (as of Ignition 7.4) you are redirected to the available servers list.
 
Select the OPC server that you wish to connect to from the list. In the case where your server is not listed, see the OPC server is not 

the   section.listed...    Troubleshooting OPC-COM Connection  

Unique Remote Connection Settings
Remote connections have a few unique settings that you can specify. You can get to these settings by selecting the Show advanced 

 check box. As of Ignition 7.4 these should all be set for you (except for the CLSID which should no longer be necessary but is properties
 still available for you to set if you wish).

 Remote Server
 Specifies that the server is remote and that a DCOM connection will be used.

 Host Machine
 The computer name or IP address of the machine on which the remote server is running.

 CLSID
This is no longer required as of Ignition 7.4, but it is still made available for you. It can be used in place of the ProgId because the ProgId is 

 really just used to lookup the CLSID in the registry. This id can be found in the registry of the machine hosting the server under:
 HKEY_CLASSES_ROOT\OPCServerName\CLSID

 
All of the settings for the server connection are rather straight forward and each property has a description of its functionality. Most of these 
settings should be fine when left at their default values. The only setting that could possibly give you some trouble is the ProgId. If 
you selected your OPC server from the list on the  page, this will be filled in for you. However, if for whatever reason Choose OPC-DA Server
your server wasn't listed and you choose the   option, you will have to know the ProgId for your server and specify it here. The Other Server
ProgId is used to look up the CLSID of the OPC Server in the Windows Registry and without this a connection cannot be made. 
 
When you are finished fine tuning these settings click . You will be redirected to the OPC Server Create New OPC Server Connection
Connections page and your new server connection should be listed. The status of your connection will read  if Ignition was able Connected
to successfully connect to the third-party OPC server.

Connection is Faulted

In the case where your connection status is reporting Faulted, the troubleshooting process begins. As previously stated, configuring the DCOM 
settings on your machine can be a headache. The  section next is an attempt to ease the process of   Troubleshooting OPC-COM Connections
determining why your connection is faulted and how to go about fixing the issue. If after exhausting the options presented to you, you are still having 
issues getting you server connection up, give our Inductive Automation tech support line a call and one of our representatives will be happy to assist 
you.

Troubleshooting OPC-COM Connections

This section provides you with a list of common OPC-COM connection problems with their possible solutions. It would be impossible to give an 
exhaustive list of everything that can go wrong but this should give you a good start on the troubleshooting process. If you do not see your 
problem listed and your connection status is faulted, try following the steps outlined in the  Ignition Server DCOM Settings and OPC Server DCOM 

sections. Settings

Common Problems

http://localhost:8088/main/web/config).
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OPC server is not listed in  list when first creating a connectionChoose OPC-DA Server

There are some cases in which an OPC Server that is installed will not show up in the generated list. This list is generated by the OPC Server 
Enumerator which is part of the OPC Core Components, so when a server you have installed on the machine does not appear in this list it is likely due 
to the OPC Core Components not being installed correctly.

Try reinstalling the Core Components and going through the process of creating a new server connection in Ignition again. If the server still does not 
appear and you have the ProgId (or the CLSID for a remote connection) for the OPC server, you can just select the  option and then Other Server
click . In this situation you will have to enter the ProgId manually on the  page.Next New OPC-DA Server

With all the correct information about the OPC server we can sometimes still make a valid connection to the OPC Server even when it is not detected 
automatically. This however is rare. Most of the time when the server is not detected, any connection attempts Ignition makes will fail.

Connection status is  but data quality is bad or the connection goes after trying to read tag dataConnected Faulted 

Usually this occurs when the DCOM settings for the machine on which Ignition is running are not correctly configured. DCOM connections go in both 
directions. Ignition must be able to send requests to the OPC server and the OPC server must also be able to callback to Ignition. If the DCOM 
settings on the Ignition server are not configured correctly those callbacks will fail and the server connection that initially had a status of “Connected” 
will either fault or all the tags that you have configured will come back with bad quality.

This is a problem that can affect both local and remote server connections.

Follow the steps outlined in the “Ignition Server DCOM Settings” section to ensure that you have correctly configured the DCOM security settings on 
the Ignition server machine.

Ignition launches second instance of an already running OPC server and is unable to see any data

It is important to note that Ignition runs as a service under the Windows System account. This can cause some issues with OPC servers that are 
meant to run interactively, meaning they run under the user account that is currently logged on. When Ignition attempts to make a connection to the 
OPC server, it will attempt to find an instance running under the same account and if it doesn't find one it will launch its own instance under the 
System account. Even if there are other instances running, Ignition will choose the one that was launched under the System account for its connection.

Many OPC servers maintain an instance running under the interactive user account that has been configured by the user and maintains all of the 
device connection information. When Ignition launches a new instance, this configuration information is lacking and none of the desired data can be 
seen or accessed. To get around this problem, you must specify in the DCOM settings for the OPC server that it always identify itself with the 
interactive user. Essentially this will force Ignition to use the currently running instance of the OPC server.

To set the OPC server to run as Interactive User

The DCOM settings are found in the Component Services manager. Right-click the entry for your OPC server under the DCOM Config folder 
and select properties from the popup menu.
Select the Identity tab, select the option that reads , and click .The interactive user OK
Close out of component services and kill any extra instances of the OPC server you see running in the Task Manager.
Go edit and save the OPC server connection in the Ignition Gateway.

Faulted status with E_CLASSNOTREG error reported on OPC connections status page

This is almost always caused by the OPC Core Components not being installed correctly. Download and install the correct version(s) for your system
(s) from the OPC Foundation (www. ). Remember, if you are making a remote connection you must install these components on both opcfoundation.org
the Ignition server as well as the machine on which the OPC server is running.

DCOM Settings

Ignition Server DCOM Settings

Follow these steps to open up the DCOM security settings on the machine that is running Ignition:

Open the , located in the  section of the  .Windows Component Services Administrative Tools Control Panel
 
Browse down through the  tree until you see , right-click and select .Component Services My Computer Properties
 
We want to focus on the COM Security tab. There are two sections,  and . Each Access Permissions and Launch Activation Permissions
section has an  and     button. You must add the ANONYMOUS and Everyone accounts under each of the four Edit Limits... Edit  Defaults...
areas making sure that the  option is checked for each of the permission settings. If you skip adding both of these to either the limits or Allow
defaults areas under either of the two sections there is a good chance your connection will not be successful.
 
You can also try setting the  to  and the  to  on the Default Default Authentication Level None Default Impersonation Level Identify
Properties tab. This isn't always necessary but it can sometimes help.

OPC Server DCOM Settings

Follow these steps to open up the DCOM security settings on the machine that is running the OPC server:

Open up , located in the  section of the  .Windows Component Services Administrative Tools Control Panel
Browse down through the  tree until get to the DCOM Config folder.Component Services
Locate the entry for your OPC server that you wish to make a connection to, right-click and select properties.

http://opcfoundation.org
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Click the  tab and you will see three sections, ,  , and Security Launch and Activation Permissions Access Permissions Configuration 
. There are two options to choose from for each section. If you already added the ANONYMOUS and Everyone accounts to the Permissions

COM Security section from the  section then you can go ahead and just select the  option for Ignition Server DCOM Settings Use Default
each of the three areas. The second option is to edit each of the groups that have  selected. You will have to add both the Customize ANONY

 and  accounts with all privileges.MOUS Everyone
Now select the  tab. You will notice that you can choose which account you want to run the OPC server under. Select the Identity Interactive 

 option. This ensures that if Ignition launches an instance of the OPC server, it will run under whichever user is currently logged into the User
system.

Creating an OPC-HDA Connection

The process of connecting to an OPC-HDA server is similar to that of a DA server. Instead of going to the "OPC Connections" section, however, you 
define the server as a Tag History Provider.

Navigate to the Ignition gateway configuration section, as outlined above.
Under Tags, History, select "Create new Historical Tag Provider..."
Select "OPC-HDA Provider"
Follow the step outlined above, for DA connections.
Once complete, the status on the Tags>History screen will show the state of the connection. If Connected, you should now be able to browse 
and query the server through the Ignition designer.

Example - Adding OPC-HDA data to a chart

Open the designer, and create or open a project.
Create a window, and add an Easy Chart component.
Double-click on the chart, or right click and select Customizers>Easy Chart Customizer to bring up the chart customization window.
Next to the "Tag History Pens" table, select the first button, "Browse for tags". This will display a tree for browsing all historical tags.
Browse through your defined HDA server. Once you find a tag, select "ok" to add it to the chart.
You may edit the tag to alter its aggregation mode, though the HDA provider will select a supported mode automatically if the specified mode 
does not exist in the server.
Once you save the configuration, the chart should update with the requested data.

A similar procedure can be used anywhere Tag History can be bound or used.

OPC Quick Client

You can access the OPC Quick Client from under the  section of the Ignition Gateway   section. It allows for quick, simple OPC Connections Config
testing of any devices connected to the server. 

You can browse by expanding tree nodes and read/write to tags by clicking on the [r] and [w] buttons next to those tags.

Subscriptions can be made by clicking on the [s] button. Clicking on the  link will automatically refresh subscriptions and show live enable live values
value changes (if there are any).

Ignition OPC-UA Server

You can see the following OPC-UA Server Settings by going to the  section of the Gateway and then choosing .Configure OPC-UA > Settings

Authentication

Authentica
tion Profile

The User Source that the OPC-UA module will use to authenticate incoming connections against. By default, this is set to the opcua-
This profile is included in the default installation and has the following as its default settings: User Source. module

 user: opcuauser
password: password

Allowed 
Roles

Roles within the given User Source that are allowed to connect to the server. Multiple roles should be separated by a comma, for 
example, .Administrator,user,manager

Allow 
Anonymou
s Access

If checked, will allow anonymous connections to the server. Not checked by default.

Server

Server 
Port

The port the OPC-UA module runs on.

Endpoint 
Address

This is the local address that the Ignition UA server will bind to. It is also the address that will be used in a GetEndpointResponse, so it 
is important that this be an address reachable by any clients that wish to connect. Requires a module restart to take effect. This is 
useful if the server machine has a VPN connection or multiple adapters and is returning the wrong address.

Minimum 
Sampling 

The fastest rate (in milliseconds) that the server will use to sample its underlying data sources. Requires a module restart to take 
effect. The default is 100.



Interval

Discovery Server

Discovery 
Server 
Enabled

Select the check box if the local discovery server should be enabled. Requires a module restart to take effect. By default, the check 
box is selected or True.

 Expose Configured Tags 

Expose 
Tag 
Providers

If enabled, Ignition tag providers will be exposed through the OPC-UA server, allowing third party clients to access the tags configured 
in the system. By default, the check box is not selected or False.

 Other  

Stale 
Threshold

The multiplier by which the server determines that updates from a driver have become stale. This period will be calculated as the 
fastest sampling rate for that node multiplied by this settings value. Default is .5

Allow 
Untrusted 
Certificates

Whether or not to automatically accept incoming certificates or to rely upon them being placed into the trusted certificate list before 
allowing a connection. By default, the check box is selected or True.

Discovery 
Server

 Address of the discovery server to register with. Default is .localhost

Discovery 
Registratio
n 
Frequency

Frequency (in minutes) at which the server will attempt to register with the discovery server. Default is .10

Auto-cast 
Writes

 Attempt to auto-cast incoming writes to the correct DataType before rejecting them with a . By Bad_InvalidType StatusCode
default, the check box is selected or True.

Creating a New Device

To add a new Device go to the  section of the OPC-UA module configuration in the Ignition Gateway, go to the  section of the Devices Configure
Gateway and then to  . Once at the   page, click on the   link at the bottom of the table. You will be OPC-UA > Devices Devices Create new Device...
taken to a page where you can select the driver to use. Choose your driver and click  .Next

The  settings common to all devices are as follows:General

General

Name The user-defined name for this Device. The name chosen will show up in  and under  of the OPC Item Paths OPC-UA Server > Devices
 page of the Gateway. The Device Name must be alphanumeric.Status

Enable 
Device

Only devices that are enabled appear in       OPC-UA Server > Devices of the Status page of the Gateway and thus have their tags 
available for use.

Connectivity

The settings under  are device-specific settings and unique to each driver.Connectivity

Timeout The timeout settings refer to the communication between the device driver and the OPC-UA server and usually can be left at their 
default values.

 

Verifying Device Connectivity

Device connectivity can be verified in the following three places:

In the  Status page of the Gateway under OPC-UA Server > Devices
In the  page of the Gateway under  boxStatus Overview > Device Connections
In the   page of the Gateway under    boxStatus Overview >  OPC Connections

Drivers

Allen Bradley Drivers

ControlLogix 5500



You will see the following  settings on the  page accessed from the  section of the Gateway under Connectivity New Device Configure OPC-UA > 
.Devices

Connectivity

H
os
tn
a
m
e

This is the IP Address of the ControlLogix Ethernet module (1756-ENET) to route through to connect a ControlLogix processor. EthernetIP 
protocol on TCP port 44818 (0xAF12) is used to communicate to ControlLogix processors.

Ti
m
eo
ut

After sending a request to the ControlLogix processor, the Communication Timeout setting is the amount of time in msec to wait for a 
response before treating it as a failure.

Sl
ot 
N
u
m
ber

The Slot Number value is the zero based ControlLogix chassis slot number of the ControlLogix processor to connect to.

C
on
ne
cti
on
P
ath

The Connection Path value is used to define the route of the PLC-5 processor to connect to. Currently routing through the ControlLogix 
Ethernet Communication Interface Module (1756-ENET) to the ControlLogix Data Highway Plus-Remote I/O Communication Interface Module 
(1756-DHRIO) and on to a PLC-5 processor of the DH+ network is supported.

The Connection Path format contains 4 numbers separated by commas. The first number is always 1 and tells the 1756-ENET module to route 
through the backplane. The second number is the slot number of the 1756-DHRIO module of the DH+ network the PLC-5 processor is 
connected to. The third number is the channel of the 1756-DHRIO module that the PLC-5 processor is connected to. Use 2 for channel A and 
3 for channel B. The final and fourth number is the DH+ node number. This number is in octal and is the same as configured in the PLC-5 
processor. See the ControlLogix Ethernet Communication interface Module User Manual for more information.

Connection Path Format: 1,<1756-DHRIO slot number>,<1756-DHRIO channel>,<DH+ node number>

The valid range for the 1756-DHRIO slot number is between 0 and 16 but depends on the chassis size. The 1756-DHRIO channel is either 2 
for channel A or 3 for channel B. The DH+ node number range is from 00 to 77 octal. 

For a more in depth explanation of connection paths, see  .Allen Bradley Connection Paths Explained

Supported Connection Methods

ControlLogix 5500 connected through 1756-ENET/A or 1756-ENET/B.

C
on
cu
rr
en
t 
R
eq
ue
sts

The number of requests that Ignition will try to send to the device at the same time. Increasing this number can sometimes help with your 
request throughput, however increasing this too much can overwhelm the device and hurt your communications with the device.

 

MicroLogix 1100/1400

MicroLogix 1100/1400 Connectivity Settings

Hostname The Hostname value is the IP Address of the MicroLogix 1100 processor, MicroLogix 1400 processor or 1761-NET-ENI Ethernet 
interface. EthernetIP protocol on TCP port 44818 (0xAF12) is used to communicate to the listed devices.

Communicat
ion Timeout

After sending a request to the MicroLogix processor, the Communication Timeout setting is the amount of time in msec to wait for a 
response before treating it as a failure.

Browse 
Cache 
Timeout

When the data table layout is read from the MicroLogix processor, the Browse Cache Timeout value is the amount of time in msec 
to cache the results.

 

Supported MicroLogix Connection Methods



MicroLogix 1100 and 1400 direct
MicroLogix 1100 and 1400 connected through 1761-NET-ENI
MicroLogix 1100/1400 connected through Spectrum Controls WebPort 500

 MicroLogix 1200 and 1500 are not fully supported. Browsing is not available on these devices.Note:

PLC-5

PLC-5 Connectivity Setting

Hostna
me

The Hostname value is the IP Address of the PLC-5 processor. The protocol that the PLC-5 processor supports is automatically 
detected. It will use either CSP protocol on port 2222 (0x8AE) or EthernetIP protocol on port 44818 (0xAF12).

Commu
nication
Timeout

After sending a request to the PLC-5 processor, the Communication Timeout setting is the amount of time in milliseconds to wait for a 
response before treating it as a failure.

Browse
Cache 
Timeout

When the data table layout is read from the PLC-5 processor, the Browse Cache Timeout value is the amount of time in milliseconds 
to cache the results.

Connec
tion 
Path

The Connection Path value is used to define the route of the PLC-5 processor to connect to. Currently routing through the ControlLogix 
Ethernet Communication Interface Module (1756-ENET) to the ControlLogix Data Highway Plus-Remote I/O Communication Interface 
Module (1756-DHRIO) and on to a PLC-5 processor of the DH+ network is supported.

 

More Information On Connection Path

The Connection Path format contains 4 numbers separated by commas. The first number is always 1 and tells the 1756-ENET module to route 
through the backplane. The second number is the slot number of the 1756-DHRIO module of the DH+ network the PLC-5 processor is connected to. 
The third number is the channel of the 1756-DHRIO module that the PLC-5 processor is connected to. Use 2 for channel A and 3 for channel B. The 
final and fourth number is the DH+ node number. This number is in octal and is the same as configured in the PLC-5 processor. See the ControlLogix

User Manual for more information. Ethernet Communication interface Module

Connection Path Format: 1,<1756-DHRIO slot number>,<1756-DHRIO channel>,<DH+ node number>

The valid range for the 1756-DHRIO slot number is between 0 and 16 but depends on the chassis size. The 1756-DHRIO channel is either 2 for 
channel A or 3 for channel B. The DH+ node number range is from 00 to 77 octal.

For a more in depth explanation of connection paths please read:  .Allen Bradley Connection Paths Explained

Supported PLC-5 Connection Methods

PLC-5 L/20E, L/40E, L/80E direct
All PLC-5 processors connected through DH+ via the 1756-DHRIO module.

SLC 505

SLC Connectivity Settings

Hostna
me

The Hostname value is the IP Address of the SLC processor. The protocol that the SLC processor supports is automatically detected. It 
will use either CSP protocol on port 2222 (0x8AE) or EthernetIP protocol on port 44818 (0xAF12).

Commu
nication
Timeout

After sending a request to the SLC processor, the Communication Timeout setting is the amount of time in milliseconds to wait for a 
response before treating it as a failure.

Browse 
Cache 
Timeout

When the data table layout is read from the SLC processor, the Browse Cache Timeout value is the amount of time in milliseconds to 
cache the results.

Connec
tion 
Path

The Connection Path value is used to define the route of the SLC processor to connect to. Currently routing through the ControlLogix 
Ethernet Communication Interface Module (1756-ENET) to the ControlLogix Data Highway Plus-Remote I/O Communication Interface 
Module (1756-DHRIO) and on to a SLC processor of the DH+ network is supported.

 

More Information On Connection Path

The Connection Path format contains 4 numbers separated by commas. The first number is always 1 and tells the 1756-ENET module to route 
through the backplane. The second number is the slot number of the 1756-DHRIO module of the DH+ network the SLC processor is connected to. 
The third number is the channel of the 1756-DHRIO module that the SLC processor is connected to. Use 2 for channel A and 3 for channel B. The 
final and fourth number is the DH+ node number. This number is in octal and is the same as configured in the SLC processor. See the ControlLogix 
Ethernet Communication interface Module User Manual for more information. 
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Connection Path Format: 1,<1756-DHRIO slot number>,<1756-DHRIO channel>,<DH+ node number>

The valid range for the 1756-DHRIO slot number is between 0 and 16 but depends on the chassis size. The 1756-DHRIO channel is either 2 for 
channel A or 3 for channel B. The DH+ node number range is from 00 to 77 octal.

For a more in depth explanation of connection paths please read:  .Allen Bradley Connection Paths Explained

 Supported SLC Connection Methods

SLC505 direct
SLC505, SLC504, SLC503 connected through 1761-NET-ENI
SLC504 connected through 1756-DHRIO
SLC505, SLC504, SLC503 connected through Spectrum Controls WebPort 500

Allen Bradley Connection Paths Explained

Connections to ControlLogix, CompactLogix, PLC-5, MicroLogix and SLC Allen-Bradley processors through a ControlLogix Gateway require a 
connection path. The connection path is unique to your setup and is dependent on what modules the connection is being routed through. With there 
being nearly an endless number of ways to route your connection from device to device it is impossible to give an example of every possible 
connection path, but in general there is a pattern to how the connection path is specified.

Follow the Path

A connection path is exactly what it sounds like. It is a path that when followed will lead a processor residing in a numbered slot of a chassis 
somewhere on site. You merely have to follow the path and build the connection path as you go. The first connection point between Ignition and the 
device is a ControlLogix Ethernet module such as an ENET, ENBT or EN2T module. The slot number of this module doesn't matter and there is no 
need to specify it in the connection path. The first entry in any connection path will be a 1, which specifies moving to the back plane. You then specify 
the slot of the module you wish to move to, followed by the port or channel of that module that you wish to exit through. Finally you specify the address 
of your entry point to the next module and the process starts all over again. This process may sound complicated at first but after some practice it will 
get easier.

Steps

Move to the backplane.
Specify the slot number of the module you are moving to.
Specify the exit port or channel.
Specify address of entry point (DH+ Station Number / ControlNet Address / IP Address of ethernet module).
Move to the backplane.
Specify processor slot number OR the slot number of the module you wish to exit through.

Connection Path Entries for Different Module Types

How you specify your exit point from a module is slightly different depending on which module type you are using. You can only move in two directions 
once you are "in" a module: out to the back plane, or out through the module port/channel. Ethernet modules have ethernet ports and an IP 
address; ControlNet modules have ControlNet Ports and ControlNet addresses; DHRIO modules have channels and station numbers. Below is a list 
of different kinds of modules and what numbers you specify in the connection path when you are exiting or entering those modules. When in a 
module, an entry of 1 will always take you to the backplane.

ENET, ENBT, and EN2T:
Exiting
1 = Backplane
2 = Ethernet Port
Entering
IP Address

CNB:
Exiting
1 = Backplane
2 = ControlNet Port
Entering
ControlNet Address

DHRIO
Exiting
1 = Backplane
2 = DH+ Channel A
3 = DH+ Channel B
Entering
DH+ Station Number (an octal value between 0-77)

You use these numbers to specify how to move out of the module, then you specify where you are moving to by either specifying the DH+ station 
number, ControlNet address, or the IP address of another ethernet module. Your connection path will always be an even number of entries due to 
the fact that you always move in two steps: out of a module and then in to another module. So if your connection path ends up with an odd number of 
entries you have missed a step somewhere and you'll have to go back and trace the path again.



Some examples have been included to help illustrate the process of tracing a connection path. The first three examples illustrate how to build your 
connection path when going from one ControlLogix Gateway to another. The last example shows connecting through a ControlLogix Gateway to 3 
different SLC 5/04 devices via DH+.

 

Creating an OPC-  ConnectionHDA
The process of connecting to an OPC-  server is similar to that of a DA server. Instead of going to the "OPC HDA
Connections" section, however, you define the server as a Tag History Provider.

 

1. Navigate to the Ignition gateway configuration section, as outlined above.

 
 

2. Under Tags, History, select "Create new Historical Tag Provider..."

 
 

3. Select "OPC-  Provider"HDA

 
 

4. Follow the step outlined above, for DA connections.

 
 

5. Once complete, the status on the Tags>History screen will show the state of the connection. If Connected, you 
should now be able to browse and query the server through the Ignition designer.

 
 

Example - Adding OPC-  data to a chartHDA

 

1. Open the designer, and create or open a project.

 
 

2. Create a window, and add an Easy Chart component.

 
 

3. Double-click on the chart, or right click and select Customizers>Easy Chart Customizer to bring up the chart 
customization window.
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4. Next to the "Tag History Pens" table, select the first button, "Browse for tags". This will display a tree for browsing 
all historical tags.

 
 

5. Browse through your defined   server. Once you find a tag, select "ok" to add it to the chart.HDA

 
 

6. You may edit the tag to alter its aggregation mode, though the   provider will select a supported mode HDA
automatically if the specified mode does not exist in the server.

 
 

7. Once you save the configuration, the chart should update with the requested data.

 
 

A similar procedure can be used anywhere Tag History can be bound or used.

A Frequently Asked Question

How to I get data from my PLC?

Getting data from your PLC into Ignition is a two step process:

Add a device, see .Connecting to a Device
Add some tags, see .Creating Tags

It requires you to touch both the Ignition Gateway and the Ignition Designer. There are also some limitations as to what kind of devices you can 
connect to Ignition and these are explained throughout the user manual, however included below is an overview of what you can expect when it 
comes to compatibility.

Brief summary of device connection in Ignition

Ignition can only connect directly to devices over Ethernet. 
Ignition can only connect directly to devices for which there is an Ignition device driver. Included drivers are:

Allen Bradley - ControlLogix 5500, CompactLogix, MicroLogix 11/1400, PLC-5, SLC 505
Siemens - S7-300, S7-400, S7-1200
Modbus - The Modbus driver connects to any ethernet enabled device that uses the Modbus protoco

Ignition can connect to third party OPC servers via OPC-UA or OPC-DA (using the OPC-COM module) for devices that do not have a 
supported driver.

Adding a Device to Ignition

Ignition Supported OPC-UA Device

Most commonly you will be adding a device that is supported by one of the built-in device drivers. The first step is connecting your device to Ignition. 
This is done through the Ignition Gateway Configuration section under the OPC-UA -> Devices page.

Click "Add a device..."
Select the driver for the device you wish to add
When adding a device you will notice that there are some common settings that are shared by all devices. You can find an explanation of 
these settings here: Adding a New Device
Specify any of the required device specific settings for the device (For example, hostname, etc.)
Check the status of your device to see if it is connected.

As long as all the device information you entered was correct you should see your device in a "Connected" state. The only exception to this is if you 
chose to add a Siemens or Modbus device. Since these devices don't support the browsing of tags you will have to create and address some tags in 
the Ignition designer before the device will stop cycling from a connected to disconnected state.

If you need to address your tags for your Siemens or Modbus device you'll want to read about adding Tags in the Ignition Designer as well as how 
addressing works for the different protocols. You will have to first add a tag in the Ignition designer and then edit the OPC Item Path of the tag using 
the appropriate addressing scheme.
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Adding Connection to 3rd Party OPC Server via OPC-UA

If your device does not have an Ignition driver, you can use a 3rd party OPC server to connect to your device and then have Ignition connect to the 
server as a client. If the OPC server talks OPC-UA, you can add a new OPC-UA server connection in the Ignition Gateway. Configuration will be 
different depending on what OPC server you are using but the following is an example of a popular solution, connecting to KEPServer via OPC-UA, 
see  .Connecting to Kepware OPC-UA

Adding Connection to 3rd Party OPC-Server via OPC-COM

The following section provides a detailed walk-through on how to connect to an OPC server using the OPC-COM module. If Ignition doesn't have a 
driver for your device and you don't have an OPC server that talks OPC-UA, you have to connect using the OPC-COM module, see    Connecting to 

. OPC Classic (COM)

Adding tags for Allen Bradley devices

Tags are how Ignition represents your PLC tags. You create Tags in the Ignition Designer and then you can use these tags to store history or display 
PLC data in your projects.
For the most part, Allen Bradley devices support browsing of tags in the PLC. There are a few exceptions like the MicroLogix 1200/1500 for which you 
have to manually address your tags. For now we will focus on creating tags from devices that support browsing.

Open the Ignition Designer.
Drag desired tags from the OPC Browser to the Tag Browser as described here:   (if you don't know what  means Creating Tags Tag Provider
don't worry, merely drag them into the   folder). You should now see some tags in the Tag Browser that show the current values of the Tags
respective tags in your PLC. Don't stop here. You should read through the related links below so you can learn more about Tags and how 
they work.

Simulator Drivers

Generic Simulator

The generic simulator provides a variety of tags that offer different data types and value generation styles. For example, there are ramps, sine waves, 
and random values. Additionally, there is a set of static writable tags whose values will persist while the device is running.

There are no configurable settings for the generic simulator.

Simulator tags

ReadOnly - static values that do not change for read only purpose.

ReadOnlyBoolean1 - false
ReadOnlyBoolean2 - true
ReadOnlyShort1 - 1
ReadOnlyShort2 - 2
ReadOnlyInteger1 - 1
ReadOnlyInteger2 - 2
ReadOnlyLong1 - 1
ReadOnlyLong2 - 2
ReadOnlyFloat1 - 1.1
ReadOnlyFloat2 - 1.2
ReadOnlyDouble1 - 1.1
ReadOnlyDouble2 - 1.2
ReadOnlyString1 - "ABCDEFG"
ReadOnlyString2 - "ZYXWVUT"

Writeable - static values that you can read/write to, initial values below.

WriteableBoolean1 - false
WriteableBoolean2 - false
WriteableShort1 - 0
WriteableShort2 - 0
WriteableInteger1 - 0
WriteableInteger2 - 0
WriteableLong1 - 0
WriteableLong2 - 0
WriteableFloat1 - 0
WriteableFloat2 - 0
WriteableDouble1 - 0
WriteableDouble2 - 0
WriteableString1 - "" (empty string)
WriteableString2 - "" (empty string)



Random - Random values updating at some rate, they follow Java Random(rate) - rate is the seed.

RandomBoolean1 - 10 sec
RandomShort1 - 5 sec
RandomInteger1 - 1 sec
RandomLong1 - 2 sec
RandomFloat1 - 10 sec
RandomDouble1 - 10 sec

Sine - Different sine waves with frequency, amplitude and offset (listed in that order)

Sine1 - 0.1, 100.0, 0.0
Sine2 - 0.01, 50.0, -25.0
Sine3 - 0.02, 10.0, 10.0
Sine4 - 0.04, 100.0, 0.0
Sine5 - 0.08, 100.0, 0.0

Ramp - Ramp signals starting from 0 going up to some value at the specified rate. When they reach their upper limit, they are reset to zero.

Ramp1 - 0 - 100 @ 10 ms
Ramp2 - 25 - 75 @ 100 ms
Ramp3 - 0 - 100 @ 50 ms
Ramp4 - 0 - 100 @ 25 ms
Ramp5 - 0 - 100 @ 12.5 ms

Realistic - Values determined by adding a random number (between -1 and 1) to the current value.

Realistic1 - -50 - 50 @ 500 ms
Realistic2 - -50 - 50 @ 1000 ms
Realistic3 - -50 - 50 @ 1500 ms
Realistic4 - -50 - 50 @ 2000 ms
Realistic5 - -50 - 50 @ 2500 ms

Allen Bradley SLC Simulator

The SLC simulator driver creates a simple device whose address structure mimics a basic SLC structure. There are currently no configurable 
parameters.

   

   

In this section ...  



Allen Bradley Ethernet
   

Ignition contains several Allen Bradley drivers, they are: ControlLogix, CompactLogix, PLC-5, MicroLogix, and SLC Allen-Bradley. These drivers can 
connect directly through the Gateway to devices that support Ethernet communications. This section contains step-by-step instructions for connecting 
to these drivers.

 

 

In this section ...  

   



1.  

2.  

3.  

4.  

5.  

6.  

7.  

Connecting to CompactLogix
 

To connect Ignition to an Allen-Bradley CompactLogix device

Go to the  section of the Gateway webpage.Configure
 
Scroll down and select .OPC-UA > Devices
 
On the  page, find the orange arrow and click on .Devices Create new Device
 
On the  page, select , and Add Device Step 1: Choose Type Allen-Bradley CompactLogix
click . Next
 
On the  page, leave all the default values and type in the following fields:New Device
Name: CompactLogix
Hostname: type the  for the PLC, for example 10.20.4.55IP address
 
Click .Create New Device
The  page is displayed showing the  device is added to Ignition. The Devices CompactLogix Sta

 will show as Disconnected and then Connected.tus
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the   folder and in the   folder you can see PC Quick Client CompactLogix Global
all the tags.

Connecting to 
CompactLogix

Watch the Video

 

 

 

 

 

Next ...

add link here

 

https://www.inductiveuniversity.com/video/connecting-to-compactlogix/7.8
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Connecting to ControlLogix
To connect Ignition to an Allen-Bradley ControlLogix device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and clickAdd Device Step 1: Choose Type Allen-Bradley ControlLogix  

.Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: ControlLogix
Hostname: type the   for the PLC, for example 10.20.4.50IP address
 
Click  .Create New Device
The  page is displayed showing the  device is added to Ignition. The Devices ControlLogix Status
will show as Disconnected and then Connected.
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the  folder and in the  folder you can see all PC Quick Client ControlLogix Global
the tags.

Connecting to 
ControlLogix

Watch the Video

 

 

 

 

 

Next ...

add link here

 

 

https://www.inductiveuniversity.com/video/connecting-to-controllogix/7.8
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Connecting to ControlLogix v21
 

To connect Ignition to an Allen-Bradley ControlLogix v21 device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and Add Device Step 1: Choose Type Allen-Bradley Logix5000 Driver
click . Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: ControlLogix
Hostname: type the   for the PLC, for example 10.20.4.57IP address
 
Click  .Create New Device
The  page is displayed showing the  device is added to Ignition. The Devices ControlLogix Status
will show as Disconnected and then Connected.
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the   folder and in the   folder you can see all PC Quick Client ControlLogix Global
the tags.

Connecting to 
ControlLogix v21

Watch the Video

 

 

 

 

 

Next ...

add link here

 

 

https://www.inductiveuniversity.com/video/connecting-to-controllogix-v21/7.8
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Connecting to MicroLogix
To connect Ignition to an Allen-Bradley MicroLogix device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and clickAdd Device Step 1: Choose Type Allen-Bradley MicroLogix  N

.ext
 
On the   page, leave all the default values and type in the following fields:New Device
Name: MicroLogix
Hostname: type the   for the PLC, for example 10.20.7.77IP address
 
Click  .Create New Device
The   page is displayed showing the  device is added to Ignition. The   Devices MicroLogix Status
will show as Disconnected and then Connected.

 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the  folder which contains all the folders with the PC Quick Client MicroLogix 
individual tags.

Connecting to 
MicroLogix

Watch the Video
 

 

 

 

 

   

Supported MicroLogix Connection Methods
 

MicroLogix 1100 and 1400 direct
MicroLogix 1100 and 1400 connected through 1761-NET-ENI
MicroLogix 1100/1400 connected through Spectrum Controls WebPort 500

 

 

 

 

Next ...

add link here

 

Important

MicroLogix 1200 and 1500 are not fully supported. Browsing is not available on these devices, so the 'Disable Processor Browse' advanced 
property will need to be set to True on the device connection.

Additionally, the MicroLogix driver can not access Input Parameters.

Some Micrologix devices may get stuck in a 'Browse Pending' status. In this case setting the connection path property to 1,0 should resolve 
the issue.

https://www.inductiveuniversity.com/video/connecting-to-micrologix/7.8
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Connecting to PLC5
 

 

 

To connect Ignition to an Allen-Bradley PLC5 device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Allen-Bradley PLC5  Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: PLC5 
Hostname: type the   for the PLC, for example 10.20.4.56IP address
 
Click  .Create New Device
The   page is displayed showing the  device is added to Ignition. The   will Devices PLC5  Status
show as Disconnected and then Connected.
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the  folder which contains all the folders with the individual PC Quick Client PLC5 
tags.

Connecting to PLC5

Watch the Video
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add link here

 

ASCII data types from a PLC5 are not supported by the Allen-Bradley PLC5 driver

https://www.inductiveuniversity.com/video/connecting-to-plc5/7.8
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Connecting to SLC
 

To connect Ignition to an Allen-Bradley SLC (5/05 and 5/04) device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Allen-Bradley SLC  Next
Note that these PLCs do not have a native Ethernet connection, therefore another device like a 
Net ENI or an ENBT must be used for the connection.
 
On the   page, leave all the default values and type in the following fields:New Device
Name: S C L
Hostname: type the   for the PLC, for example 10.20.4.56IP address
 
Click  .Create New Device
The   page is displayed showing the  device is added to Ignition. The   will Devices SLC  Status
show as Disconnected and then Connected.
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the  folder which contains all the folders with the individual PC Quick Client SLC
tags.

Connecting to SLC

Watch the Video
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https://www.inductiveuniversity.com/video/connecting-to-slc/7.8


ControlNet Example
 

Before we show you how to connect to a PLC5 through a ControlLogix Gateway using ControlNet, you 
need to understand what a  is and how to build one.connection path

Connection Paths

Connections to ControlLogix, CompactLogix, PLC-5, MicroLogix and SLC Allen-Bradley 
processors through a ControlLogix Gateway require a connection path. The connection path is unique to 
your setup and is dependent on what modules the connection is being routed through.

Follow the Path

A connection path is exactly what the name implies. It is a path that when followed leads to a 
processor residing in a numbered slot of a chassis somewhere on site. You only have to follow the path 
and build the connection path as you go. 

The first connection point between Ignition and the device is a ControlLogix Ethernet module such as an 
ENET, ENBT, or EN2T module. The slot number of this module doesn't matter and you don't need to 
specify it in the connection path.

Building the Connection Paths Entries

You need to have 6 numbers/entries to specify the connection path. The way you find each number is 
described in the following table:

1st 
Number

Is 1 and means move to the back plane

2nd

 Number

Is the slot number of the module you want to move to

3rd

 Number

Is the exit port or channel of that module that you want to exit through

4  th

Number

Is the address of entry point to the next module (DH+ Station Number / ControlNet 
Address / IP Address of ethernet module)

5th 
Number

Is 1 and means move to the back plane (from this 5  Number, it starts repeating as the 1th

 Number)st

6th 
Number

Is the processor slot number OR the slot number of the module you want to exit through

The process of coming up with these numbers may sound complicated at first but after some practice it 
gets easier.

 

Here is an example, as pictured below, that has a  of  going from  to connection path  1,4,2,12,1,0  PLC 1  
. The following table shows the walk-through for these numbers:PLC 2

1 Move out of ENBT Module to the backplane

4 Move to ControlNet Module in Slot 4

2 Move out ControlNet Port

12 Move in ControlNet Module at ControlNet Address 12

1 Move out of ControlNet to the backplane

0 Move to the Processor in Slot 0

On this page ...

Connecting to a PLC5 using 
ControlNet
Connection Path Entries for 
Different Module Types
Next ...

ControlNet Example

Watch the Video

 

 

 

 

 

https://www.inductiveuniversity.com/video/controlnet-example/7.8
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Connecting to a PLC5 using ControlNet

To connect to a PLC5 through a ControlLogix Gateway using ControlNet in Ignition, do the following 
steps:

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Allen-Bradley PLC5  Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: PLC5 
Hostname: type the   for the PLC, for example 10.20.4.62IP address
Connection Path: (  means going to ControlLogix and going to the backplane in PLC 1,1,3,2,14 1  

 is the slot number of the ControlNet module to move to in this example,  is the exit port of the 3  2
ControlNet module,  is the address of entry point to the ControlNet module in PLC 2) 14
 
Click  .Create New Device
The   page is displayed showing the  device is added to Ignition. The   will Devices PLC5  Status
show as Disconnected and then Connected.
 
To see all the tags, go to   in the  section, on the OPC Connections > Quick Client  Configure O

 page expand the  folder which contains all the folders with the individual PC Quick Client PLC5 
tags.

Connection Path Entries for Different Module Types

How you specify your exit point from a module is slightly different depending on which module type 
you are using. You can only move in two directions once you are  a module, either out to the back in
plane, or out through the module port/channel.

Ethernet modules have ethernet ports and an IP address. ControlNet modules have ControlNet Ports 
and ControlNet addresses. DHRIO modules have channels and station numbers.

Below is a list of different kinds of modules and what numbers you specify in the connection path when 
you are exiting or entering those modules. When in a module, an entry of 1 will always take you to the 
back plane.

ENET, ENBT, and EN2T

Exiting

1 = Backplane
2 = Ethernet Port

Entering

IP Address

CNB

Exiting



1 = Backplane
2 = ControlNet Port

Entering

ControlNet Address

DHRIO

Exiting

1 = Backplane
2 = DH+ Channel A
3 = DH+ Channel B

Entering

DH+ Station Number (an octal value between 0-77)

You use these numbers to specify how to move out of the module, then you specify where you 
are moving to by either specifying the DH+ station number, ControlNet address, or the IP address 
of another ethernet module. Your connection path is always an even number of entries because there 
are two steps: out of a module and then in to another module. So if your connection path ends up with an 
odd number of entries, you have missed a step somewhere and have to go back and trace the path 
again.

 

 

Next ...

An ENBT Example
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An ENBT Example
 

Before we show you how to connect to a ControlLogix through a ControlLogix Gateway using ENBT, you 
need to understand what a   is and how to build one, see the , connection path Connection Paths  Follow 

, and  sections. the Path Building the Connection Paths Entries

Here is an example, as pictured below, that has a  of  going from connection path  1,3,2,192.168.0.56,1,0  
 to . The following table shows the walk-through for these numbers:PLC 1  PLC 2

Example  

Connection Path Walk-through from PLC 1 to PLC 2

1 Move out of ENBT Module to the backplane

3 Move to ENBT Module in Slot 3

2 Move out Ethernet Port

192.168.0.56 Move in EBNT Module at IP Address 192.168.0.56

1 Move out of EBNT to the backplane

0 Move to the Processor in Slot 0

      

An ENBT Example

Watch the Video

 

 

 

 

To connect to a ControlLogix through a ControlLogix Gateway using ENBT

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Allen-Bradley ControlLogix  Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: ControlLogix
Hostname: type the   for the PLC, for example 10.20.4.62IP address
Connection Path:  means going to ControlLogix and going to the back plane in PLC#1,   is the slot number of the 1,2,2,10.21.4.52,1,0 (1 2
EBNT module to move to in this example,   is the exit port of the ControlNet module,  is the IP address of entry point to the 2  10.21.4.52
ControlNet module in PLC#2)
 
Click  .Create New Device
The   page is displayed showing the   device is added to Ignition. The   will show as Disconnected and then Devices ControlLogix Status
Connected.
 
To see all the tags, go to   in the  section, on the   page expand the OPC Connections > Quick Client  Configure OPC Quick Client ControlLo

 folder and in the   folder you can see all the tags.gix Global

 

https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-ConnectionPaths
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-FollowthePath
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-FollowthePath
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-BuildingtheConnectionPathsEntries
https://www.inductiveuniversity.com/video/an-enbt-example/7.8
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A DH+ Example
 

Before we show you how to connect to an SLC through a ControlLogix Gateway using Data Highway 
, you need to understand what a   is and how to build one, see the Plus (DH+) connection path Connectio

,  , and   sections. n Paths Follow the Path Building the Connection Paths Entries

The example here, as pictured below, shows connecting through a ControlLogix Gateway to 3 
different SLC 5/04 devices via DH+.

The connection paths are:

SLC A   1,3,3,21
SLC B   1,3,2,40
SLC C   1,3,2,41 

The following table shows the walk-through for these numbers:

Example  

Connection Paths Walk-through from PLC 1 to SLC A, B, & C

1 Move out of ENBT Module to the backplane

3 Move to DHRIO Module in Slot 3

2 (for SLC B&C)

3 (for SLC A)

Move out DH+ Channel A, B, or C

21 (for SLC A)
40 (for SLC B)
41 (for SLC C)

Move in DH+ Station Number

A DH+ Example

Watch the Video

 

 

 

 

 

To connect to an SLC through a ControlLogix Gateway using Data Highway Plus (DH+)

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Allen-Bradley SLC  Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name: SLC
Hostname: type the   for the PLC, for example 10.20.4.62IP address
Connection Path:   means going to the back plane,   is the slot number of the DHRIO Module to move to,   is the DH+ Channel A 1,6,2,1 (1 6 2
moving out of DHRIO Module, is the SLC station number) 1 
 

https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-ConnectionPaths
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-ConnectionPaths
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-FollowthePath
https://legacy-docs.inductiveautomation.com/display/DOC/ControlNet+Example#ControlNetExample-ControlNetExample-BuildingtheConnectionPathsEntries
https://www.inductiveuniversity.com/video/a-dh-example/7.8


6.  

7.  

Click  .Create New Device
The   page is displayed showing the device is added to Ignition. The   will show as Disconnected and then Connected.Devices SLC  Status
 
To see all the tags, go to   in the  section, on the   page expand the  folderOPC Connections > Quick Client  Configure OPC Quick Client SLC
and you can see all the tags.

 

DHRIO Example

 

Next ...

add link here

 



Modbus
   

The generic Modbus driver allows the Ignition OPC-UA server to communicate with any device that supports Modbus TCP protocol.

The Modbus driver can connect directly to devices that support Ethernet communications. It can also connect to Modbus devices through the Gateway.

It is important to only add one Modbus device in the Ignition Device List for each IP address. When communicating to multiple Modbus devices 
through Gateway, where each has a unique unit ID, either include the unit ID in the Modbus specific address or set it in the address mapping for the 
device.

The Connecting to Modbus Device section contains step-by-step instructions on how to connect to a Modbus device.

 

 

In this section ...  
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Connecting to Modbus Device

To connect Ignition to a Modbus device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select , and click .Add Device Step 1: Choose Type Modbus TCP  Next

There are two modules to choose from

 Modbus RTU over TCP
Which connects to devices that implement the Modbus RTU protocol over TCP.
Modbus TCP
Which connects to devices that implement the Modbus TCP protocol. 

.Typically, you connect using the Modbus TCP driver as we have in step 4
 
On the   page, leave all the default values and type in the following fields:New Device
Name: Modbus
Hostname: type the  , for example 10.20.8.117IP address

You can check the box for  to see the additional settings, but you Show advanced properties?
can keep all the defaults.

Click  .Create New Device
The   page is displayed showing the  device is successfully created and added Devices Modbus
to Ignition. The   will show as Disconnected and then Connected.Status
 

Unlike other PLCs, Modbus devices do not support browsing, therefore you can not browse the tags by 
going to the   in the  sectioOPC Connections > Quick Client  Configure n of the Gateway. To see and 
browse the tags, you need to create the tags as described in the  section.About Modbus Addressing

Connecting to 
Modbus Device

Watch the Video

Modbus Drivers using Ethernet

The generic Modbus driver allows the Ignition OPC-UA server to communicate with any device that supports Modbus TCP protocol. The Modbus 
driver can connect directly to devices that support Ethernet communications. It can also connect to Modbus devices through a Gateway.

It is important to only add one Modbus device in the Ignition Device List per IP address. When communicating to multiple Modbus devices through a 
Gateway each with a unique unit ID, either include the unit ID in the  or set it in the  for the device.Modbus specific address address mapping

Supported Functions Codes

The Modbus driver supports the functions codes listed below. In some cases, a device may not allow certain function codes. To remedy this, 
advanced properties on the device connection can restrict or force specific functions codes. See the  table on this page for more Driver Properties
details. 

Function Name Code Hex

Read Discrete Inputs 02 0x02

Read Coils 01 0x01

Write Single Coil 05 0x05

Write Multiple Coils 15 0x0F

Read Input Register 04 0x04

Read Holding Register 03 0x03

Write Single Register 06 0x06

Write Multiple registers 16 0x10

Read/Write Multiple Registers 23 0x17

Driver Properties

https://www.inductiveuniversity.com/video/connecting-to-modbus-device/7.8


Connectivity

Hostname Is the IP Address of the Modbus device.

Port Is the port to use when connecting to a Modbus device. The Modbus TCP port specified in the Modbus specification is 
502, but it can be changed to a different port.

Communication 
Timeout

Is the amount of time in milliseconds to wait for a response before treating it as a failure, after sending a request to the 
Modbus device.

Advanced

Max 
Holding Registers 
per Request

Is the the maximum number of Holding Registers the device can handle. Because some Modbus devices cannot handle 
the default of requesting 125 Holding Registers in one request, to accommodate this limitation you can change this 
setting.

Max 
Input Registers 
per Request

Is the the maximum number of Input Registers the device can handle. Because some Modbus devices cannot handle 
the default of requesting 125 Input Registers in one request, to accommodate this limitation you can change this setting.

Max Coils 
per Request 

Is the the maximum number of Coils the device can handle. Because some Modbus devices cannot handle the default 
of requesting 2000 Coils in one request, to accommodate this limitation you can change this setting.

Max 
Discrete Inputs 
per Request 

Is the the maximum number of Discrete Inputs the device can handle. Because some Modbus devices cannot handle 
the default of requesting 2000 Discrete Inputs in one request, to accommodate this limitation you can change this setting.

Reverse 
Word Order 

When reading and writing 32bit values from/to a Modbus device, the high word comes before the low word. By checking 
this option, the low word comes before the high word. The Modbus specification does not include a section for reading 
and writing 32bit values and as a result device manufacturers have implemented both methods.

One-based 
Addressing

When this option is checked, the address range for each area starts at 1. If unchecked, the range starts at 0.

The Modbus specification states that Modbus addresses are to be zero based. Meaning Modbus addresses start at 0 
instead of 1. To read a value from Modbus address 1024, 1023 is sent to the device. When connecting to devices that 
do not adhere to zero based addressing, make sure this option is not selected. This will cause 1024 to be sent to the 
device to read Modbus address 1024.

Span Gaps When this option is checked, it spans address gaps when optimizing requests, reducing the number of requests but 
increasing the amount of data requested at once. If unchecked, it does not span the address gaps.

Allow Write 
Multiple Registers 
Request

Enable or disable Modbus function code 0x10, Write Multiple Registers. Some devices may not support this function 
code.  disabling this option will break the ability to write 32-bit and String values correctly to registers.Caution:

Force Multiple 
Register Writes

Force the use of Modbus function code 0x10, Write Multiple Registers, on write requests.

Allow Write 
Multiple Coils 
Request

Enable or disable Modbus function code 0x0F, Write Multiple Coils. Some devices may not support this function code.

Allow Read 
Multiple Registers 
Request

If disabled all registers will be read in individual read requests. Disable with caution.

Allow Read 
Multiple Coils

If disabled all coils will be read in individual read requests. Disable with caution.

Allow Read 
Multiple Discrete 
Inputs

If disabled all discrete inputs will be read in individual read requests. Disable with caution.

Note: Function code 0x02 is always used to read Discrete Inputs, regardless what this property is set to.

When checked forces a reconnect after 3 consecutive timeouts.

When working with a Modbus RTU over TCP connection, each "device" would be an individual Modbus 
device on the Modbus network.



Reconnect After 
Consecutive 
Timeouts

StringHandling

Reverse String 
Byte Order 

When reading and writing string values from/to a Modbus device, the low byte comes before the high byte. By checking 
this option the high byte comes before the low byte. If reading a string value from a device should read ABCD but BADC 
appears in Ignition, then check this option. 

Right Justify 
Strings

Strings stored in a Modbus device may contain leading spaces or trailing spaces. This can produce unwanted results so 
that Modbus driver removes spaces or zeros when reading string values. By default, left justify string handling is used 
when reading and writing strings. When you check this option, right justify string handling is used.

Read Raw Strings Whether or not to read the entire length of a string, ignoring any null bytes encountered.

Next ...

About Modbus Addressing



1.  

2.  

1.  

2.  

3.  

About Modbus Addressing
 

Modbus doesn't support tag browsing, this means you can not view the tags in the  orOPC Browser  Tag 
 of the Designer or from the   in the  section of the Browser OPC Connections > Quick Client  Configure

Gateway.

There are two ways you can create tags so that you can browse them:

By manually specifying each address
This is done from the Designer by entering Modbus Specific Addresses into the  OPC Item Path
of an OPC Tag. See below for detailed information.
 
By specifying the address mapping
This is done from the Gateway, see the  section.About Modbus Address Mapping

To manually specify each address

You can enter Modbus Specific Adresses into the OPC Item Path of an OPC Tag by using the following 
designators along with the Modbus address:

In the  , right-click on   folder, and then go to  .Tag Browser Tags New Tag > OPC Tag
 
In the   window, as an example, you can set the following values:Tag Editor
Name: Temp
Data Type: Int4
OPC Server: choose  from the dropdown Ignition OPC-UA Server
OPC Item Path:   , the   device name goes in the square brackets then [Modbus]HR1 Modbus
you give the address to PLC which in this case is the   designator plus   as the Modbus HR 1
address. The   section below, explains how your can construct Modbus Specific Addressing
these addresses.
 
Click  .OK
Now you can see the   tag in the  .Temp Tag Browser

About Modbus 
Addressing

Watch the Video
 

 

 

 

 

 

   

Modbus Specific Addressing

Per the Modbus protocol specification, the following  can be read from a device: four basic types of addresses

Holding Registers (read/write 16 bit words)
Input Registers ( read only 16 bit words)
Coils (read/write bits)  
Discrete Inputs (read only bits associated with device input points)

To manually create an address for a single tag

To manually enter Modbus Specific Addresses into the  of the  window, use one of the following designators plus the OPC Item Path Tag Editor
Modbus address:

 Other OPC servers represent each type by starting the OPC address with a number, for example, 4 for holding registers.Note:
 

Designator Description

HR  for 16 bit signed Holding Register (HR1, equivalent to 40001 in other applications)

IR  for 16 bit signed Input Register (IR1, equivalent to 30001)

C  for Coil (C1, equivalent to 00001)

DI  for Discrete Input (DI1, equivalent to 10001)

An example of using these designators with the Modbus address is to enter  in the   of an OPC Tag in the   window, HR1 OPC Item Path Tag Editor
which is the  designator plus the Modbus address .HR 1

Because some devices that support Modbus protocol store data in , there are two additional designators. These designators convert the BCD format
data from BCD format to decimal when reading data from the device and convert data from decimal to BCD when writing to the device.

Designator Description
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HRBCD for Holding Register with BCD conversion.

HRBCD_32 for 2 consecutive Holding Registers with BCD conversion.

IRBCD for Input Register with BCD conversion.

IRBCD_32 for 2 consecutive Input Registers with BCD conversion.

 

To accommodate other data encoding commonly used by Modbus supported devices, the following designators are available for Modbus specific 
addressing:

Description Holding Register Designator Input Register Designator

Float/Double

2 consecutive Registers with Float conversion. HRF IRF

4 consecutive Registers with Double conversion. HRD IRD

Integer

Holding Registers with 16 bit unsigned integer conversion. HRUS IRUS

2 consecutive Registers with 32 bit integer conversion. HRI IRI

2 consecutive Registers with 32 bit unsigned integer conversion. HRUI IRUI

4 consecutive Registers with 64 bit integer conversion. HRI_64 IRI_64

4 consecutive Registers with 64 bit unsigned integer conversion. HRUI_64 IRUI_64

To read or write string values from/to a Modbus device, the following designation is available for Modbus specific addressing:

Designator Description

HRS read or write consecutive Holding Registers as a string value.

Note: There are 2 characters for each word and the order of which character comes first is controlled by the   device Reverse String Byte Order
setting as described in the  section. Because two characters are stored in a word, the string length must be an even Connecting to Modbus Device
number of characters.

HRS FORMAT: HRS<Modbus address>:<length>
 

Examples Description

[DL240]HR1024 Read 16bit integer value from Holding Register 1024.

[DL240]HRBCD1024 Read BCD value from Holding Register 1024.

[DL240]IR512 Read 16bit integer value from Input Register 512.

[DL240]C3072 Read bit value from Coil 3072.

[DL240]IR0 Read 16bit integer value from Input Register 0.

[DL240]HRS1024:20 Read 20 character string value starting at Holding Register 1024.

Unit ID

You can also specify the Modbus unit ID by pre-pending it to the Modbus address. For example, to access Modbus unit ID 3 and read 
HR1024, the full OPC path is:

[DL240]3.HR1024



Bit-level addressing

You just append a period and the bit number you want to read and write to a bit, your Modbus device must support the   command, and Mask Write
your device documentation should specify if it does.

To read or write to a specific bit within a holding register, simply append the location of the bit as demonstrated in these examples:

[DL240]HR1024.0 will read and write to the first bit of the holding register.

[DL240]HR1024.10 will read and write to the 11th bit of the holding register.

 

 

Next ...
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About Modbus Address Mapping
 

Because it can be very tedious manual entering OPC Tag information one-by-one, the driver offers 
an address mapping feature. This feature allows entering blocks of common addresses and the driver will 
create the individual addresses and display them in the OPC browser.

Another benefit of address mapping is that the addresses inside a device can have a different 
numbering scheme than the Modbus address. The Direct Automation DL240 is a perfect example of this. 
Address V2000, capable of holding a 16 bit integer, is Modbus Holding Register 1024. In addition, the 
DL240 addressing is in octal meaning there are no 8 or 9s. The sequence of addresses are: V2000, 
V2001, V2002, V2003, V2004, V2005, V2006, V2007, V2010, V2011.... V3777. This is not very straight 
forward.

Address Mapping Properties 

Name Description

Prefix A prefix applied to each mapped address as they appear in the OPC browser. Must 
compose of letters, numbers, and underscore characters. The following values are 
reserved, and may not be used: , , , or  HR IR C DI

Start 
and 
End

Numerical values will be assigned to each mapped addresses. These properties 
determine the range of the numerical assignments. Follows the Prefix. The difference 
between these two values determines how many mapped addresses will be created. 

Step When enabled, adjacent addresses will be combined. This is commonly used to combine 
two words (16-bit addresses) into a double word (32-bit addresses). Please see the Floati

 for more details.ng Point or 32-bit Address Mapping

Radix The base number of unique digits for modbus addresses. Determines what format 
addresses in the device are incremented and labeled (HR0, HR1,...HR9, HR10, HR11). 
Common values are 10 (decimal system) or 16 (hexadecimal). 

Unit ID The Unit Id for the device to use. When several Modbus devices are connected to a 
single IP address, the step determines which device the mapping should be applied 
against. A value of 0 means the first device, and should be used when only a single 
Modbus device is connected. See  for more details.Address Mapping Multiple Devices

Modbus
Type

The table each mapped address should run against, as well as the type and size of each 
address. 

Modbus
Address

The address in the device that mapping will begin at. Note that since the table has 
already been selected by the Modbus Type property, this number should range between 
1-9999. 

Simple Mapping Demonstration

Temperature readings are being stored in 10 16-bit addresses: 40,010 - 40,019. There is a single 
Modbus device at the IP address (unit ID 0), and the addresses are decimal. The mapped addresses 
should appear in the OPC Browser as "Temp1", "Temp2", and so-on. The following configuration would 
be used:

Prefix: Temp
: 1Start

: 10End
: FalseStep

: 0Unit ID
: Holding Register (Int16)Modbus Type

: 10 Modbus Address

The above configuration would result in the following items appearing in the OPC Browser:

On this page ...

To specify the address mapping
Address Mapping Multiple Devices
Floating Point or 32-bit Address 
Mapping
Import / Export Address Mapping
Next ...
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1.  

2.  

3.  

To specify the address mapping

Click on  to the right of your Modbus device.Addresses

 
Click on  .Add Row

Enter the mapping as follows:

Prefix: V
Start: 2000
End: 3777
Modbus Type: Holding Register (int16)
Modbus Address: 1024
Radix:   (8 causes the addresses to be in octal, also known as base 8)8



3.  

4.  
5.  

 

These settings map the    in octal to Modbus  address range V2000 to V3777 Modbus Holding 
.Register addresses 1024 to 2047

 The mappings for string data types cannot be entered. Strings can only be read or written Note:
using  . Modbus Specific Addressing
Click  .Save
Go to the   in Designer or the   (on Gateway), OPC Browser OPC Connections > Quick Client
open the   folder.Modbus

You can now see all the Modbus addresses from V2000 to V3777 in octal.

Here is an example of mapping for all of the Modbus DL240  addressing.



5.  

    

   

Address Mapping Multiple Devices

It is not recommended to communicate to multiple Modbus devices through a Modbus Gateway where Gateway has the same address. Therefore, do 
not add multiple Modbus devices with the same IP address. 

Only add one Modbus device to the Ignition OPC-UA Server device list for Gateway and specify the different unit IDs in the address mapping. The 
unit ID is specified for each entry in the address mapping for the Modbus device. Notice in the example below, the Prefix, Start, End, Modbus Type 
and Modbus Address can be the same for two entries provided that the Unit IDs are different.

 

Now when browsing the Modbus device, the unit ID will show as a folder and the OPC tag path includes the unit ID as shown below. This only 
happens when more than one unit ID is specified in the address mapping otherwise the unit ID is eliminated.



Floating Point or 32-bit Address Mapping

Modbus only supports reading and writing to memory types of bits and 16-bit words. This is not very useful when reading from or writing to float 
point or 32-bit integers.

To workaround this problem, the Modbus driver is designed to read 2 consecutive 16-bit words and encode it into the desired data type.

To map float point addresses

The Modbus address mapping below shows how to map float point addresses starting at 1024 and ending at 1030. With the box in the  column Step 
checked, the addresses on the Ignition side will index by 2. In this case, R1024, R1026, R1028 and R1030 will be created.

Because   is selected, the driver will read two consecutive 16-bit words and convert it to a floating Modbus Type of Holding Register (Float)
point value. It also indexs the Modbus Address by 2 for each entry. In this case, R1024 reads from Modbus addresses 1024 and 1025 and converts 
them into a floating point value. When writing, the reverse of converting a floating point value into two 16-bits words is done before sending them to 
the device.

 

 

The following window shows what is displayed in the OPC Browser. Notice that the numbering is indexed by two and that it matches the 
Modbus address. With some devices, this allows the addresses displaying in the OPC Browser to match the addresses in the device.



Import / Export Address Mapping

The mapping configuration can be exported to a comma separated values (CSV) file. The CSV file can later be imported in other Ignition 
installations or similar devices.

You can find a few examples of CSV files on our website. To see the examples, go to:

http://inductiveautomation.com/downloads/extras

Scroll down to  and double-click on the template files to see an example of the CSV file. Modbus Templates
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Siemens
 

The Siemens drivers in Ignition support connections to S7-300, S7-400, and S7-1200 PLCs via TCP/IP using the S7 protocol. For step-by-step 
instructions to connect to a Siemens device, see Connecting to S7 Devices.

 

 

In this section ...

   



1.  

2.  

3.  

4.  

5.  

6.  

7.  

Connecting to S7 Devices
To connect Ignition to a Siemen S7-1500, S7-1200, S7-400, or S7-300 
device

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, select  , and click .Add Device Step 1: Choose Type Siemens S7-1200  Next

There are four modules to choose from

Siemens S7-1500
Which connects to Siemens S7-1500 PLCs over Ethernet.

 Siemens S7-1200
Which connects to Siemens S7-1200 PLCs over Ethernet.
Siemens S7-300
Which connects to Siemens S7-300 PLCs over Ethernet.
Siemens S7-400
 Which connects to Siemens S7-400 PLCs over Ethernet.

On the   page, leave all the default values and type in the following fields:New Device
Name: S71200
Hostname: type the  , for example 10.20.4.71IP address

You can check the box for   to see the additional settings, but you Show advanced properties?
can keep all the defaults.

Click  .Create New Device
The   page is displayed showing the  device is successfully created and added Devices Siemens
to Ignition. The   will show as Disconnected and then Connected.Status

Unlike other PLCs, but just like Modbus, Siemens devices do not support browsing, therefore you can not 
browse the tags by going to the   in the  section of the OPC Connections > Quick Client  Configure
Gateway. To see and browse the tags, you need to create the tags manually as described in the About 

 section.Siemens Addressing

Connecting to S7 
Devices

Watch the Video
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1.  

2.  

3.  

About Siemens Addressing
 

The S7 protocol does not support tag browsing. Therefore, you must configure all tags in the Designer. 
This can be done either manually, as needed, or by importing bulk using the Tags CSV import 
functionality.

To manually specify each address

From the Designer, in the  , right-click on   folder, and then go to Tag Browser Tags New Tag > 
.OPC Tag

 
In the   window, as an example, you can set the following values:Tag Editor
Name: Tag
Data Type: Int4
OPC Server: choose  from the dropdown Ignition OPC-UA Server
OPC Item Path:   , the device name goes in the square brackets then you [S71200]IW0 S71200 
give the address to PLC which in this example is  ( . The IW0 Word at Offset 0 in the Inputs area)

 section below, explains how your can construct these Configuring Siemens Addressing
addresses.
 
Click  .OK
Now you can see the   tag in the  .Temp Tag Browser

Configuring Siemens Addressing

You need a device name plus a tag address to create a tag. The device name is a known, but the tag 
address needs to be configured. Once you have both the device name and tag address you enter them 
in the in the OPC Item Path field of the  window using the Tag Editor [device_name]address format, 

 is the configured tag addresswhere device_name is the name of the device and address  which is 
described here.

Tag addresses are made up of three different components: , , and .Area DataType Offset

  Area Syntax  

DataBlocks  DBn,  

Inputs  I  

Outputs  Q  

Flags  M  

Timers T  

Counters  C  

  Data Type Syntax Signedness

Bit X N/A

Byte B Unsigned

Char C Signed

Word W Unsigned

Int I Signed

DWord D Unsigned

DInt DI Signed

Real REAL Signed

String STRING or STRING.LEN N/A

 

To form an address, you combine syntax for the desired Area and DataType with an Offset into that area.

Examples  

About Siemens 
Addressing

Watch the Video
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Area+Data Type+Offset  

IB0 Byte at Offset 0 in the Inputs area

IW0 Word at Offset 0 in the Inputs area

DB500,DI8 DInt at Offset 8 in DataBlock 500

ISTRING24.50 A String of length 50 starting at offset 24 in the
Inputs area

IX20.3 Bit 3 of the Byte at Offset 20 in the Inputs area

T0 Timer at offset 0 (No DataType is specified for
Timers)

C0 Counter at offset 0 (No DataType is specified for
Counters)

Offsets

It is important to note that offsets are absolute.  and  share a byte. To get 2 consecutive, non-IW0 IW1
overlapping words you need to address  and .IW0 IW2

Bits

Bits are addressed by using the Bit DataType (X) and appending  to the end, where bit is in the .bit
range [0-7]. When addressing a Bit at a given offset, that offset is always treated as a Byte.

Strings

Strings are assumed to be in the S7 string format and have a max length of 210.

Timers

Timers are scaled up to a DWord and converted from S5 time format so they can represent the time 
in milliseconds without requiring any multipliers. When you write to a timer it is automatically 
converted from milliseconds into S5 time format for you. A DataType is not specified when accessing 
Timers.

Counters

Counters in the PLC are stored in BCD. The driver automatically converts to/from BCD for you 
and exposes any counter tags as UInt16 values. A DataType is not specified when accessing Counters.
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UDP and TCP Driver
 

The TCP driver allows Ignition to communicate to barcode scanners, scales, and more. They are strictly passive listeners and are configured to 
connect to one or more ports on a given IP address and any ASCII characters that are brought in as tags. For step-by-step instructions to connect to a 
TCP Driver, see Connecting to TCP Device.

UDP and TCP Drivers

The UDP and TCP drivers are strictly passive listeners. These drivers are configured to connect and   to one or more ports on a given IP listen
address. Rules are configured that dictate how the incoming data is interpreted.

Structure in the Address Space

A device using the UDP or TCP driver appears in the  folder of the OPC-UA server with the name it was configured to use. Browsing the Devices
device will yield one folder per port configured to listen on. Browsing the port folder will yield 1 variable node containing the entire message received 
as well as an additional variable node per field configured. A device configured with a field count of 4 would have 5 nodes total -1 for the message and 
4 for the fields.
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Connecting to TCP Device
To connect to a barcode scanner or scale

You can connect to a barcode scanner or scale by using Ignition's UDP and TCP driver.

Go to the   section of the Gateway webpage.Configure
 
Scroll down and select  .OPC-UA > Devices
 
On the   page, find the orange arrow and click on  .Devices Create new Device
 
On the   page, scroll all the way down and select  , Add Device Step 1: Choose Type TCP Driver
and click . Next
 
On the   page, leave all the default values and type in the following fields:New Device
Name:  , the name you specify here will appear under  folder on the  Scale  Devices  Quick Client
page in the Gateway.
Port(s):  , as an example12345
Hostname: type the  , for example 10.20.6.108IP address

You can check the box for   to see the additional settings, but you Show advanced properties?
can keep all the defaults.

Click  .Create New Device
The   page is displayed showing the   device is successfully created and added to Devices Scale
Ignition. The   will show as  .Status 1/1 Connected

Go to the   in the  section of the Gateway, under OPC Connections > Quick Client  Configure
the   folder you will see the   and the   folderDevices>[Scale]>12345 Last Receive Time Message
s. 
Next to each tag, under the   column, you will see Action [s][r][w].

Click on   which means  . You will be able to see the   of the tag displayed [s] Subscription Value
on this  page.OPC Quick Client 

Connecting to TCP 
Device

Watch the Video

 

 

 

   

Device Properties

The properties on the  page of the Gateway for the TCP and UDP devices are as follows:New Device

General  

Name Name of the device using this driver. This name will appear in the Devices
folder when browsing the OPC-UA server.

Enables When selected, the device is enabled. When not selected, disabled devices will not make a
connection attempt.

Connectivity  

Port(s) On the UDP driver, this is the port(s) to listen on.
On the TCP driver, this is the port(s) to connect to.
Separate multiple ports with a comma.

Address On the UDP driver, this is the IP address to listen to.
On the TCP driver, this is the IP address to connect to.

Inactivity Timeout The number of milliseconds without receiving data from the source before a disconnect/reconnect is made. Set to 0 to disable.

Message  

Message 
Delimiter Type

Sets the method used to determine how much or what data length constitutes a full .message
Assumes that whatever arrives in one packet, regardless if length or content, is the message.Packet Based: 

Content is appended to a message buffer until the given character arrives, at which point the contents of Character Based: 
the buffer are considered the message.

Content is appended to a message buffer until some fixed number of bytes is received, at which point the contents Fixed Size 
of the buffer are considered the message.

Message 
Delimiter

If the message delimiter type is , this will be the character used to identify a message.Character Based
If the type is , this will be the size used to identify a message.Fixed Size

Field Count The number of fields within a message must be fixed. This property dictates how many fields will be present in each message. 
When the number of fields received does not match the designated count, all nodes will receive quality 
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BAD_CONFIG_ERROR.

Field Delimiter This is the character(s) that are used as field delimiters. For example, the message  with a field delimiter of  woulda|b|c|d |
be split into four fields: , , , and . The field count would have to be set at 4.a b c d
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DNP3
   

The DNP3 driver can connect directly through the Gateway to devices that support Ethernet communications. The  section contains step-by-step DNP3
instructions for connecting using this driver.
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Connecting to DNP3 Devices
 The DNP3 module allows the Ignition OPC-UA server to communicate with other devices that support 
the DNP3 protocol (DNP3 outstations).

To connect Ignition to a DNP3 device

Go to the  section of the Gateway webpage.Configure 

Scroll down and select  .OPC-UA > Devices

On the  page, find the orange arrow and click on  .Devices  Create new Device

On the page, select  , and click  . Add Device Step 1: Choose Type  DNP3 Driver Next

On the  page, leave all the default values and type in the following fields:New Device 

Name: DNP3
Hostname: type the IP address, for example 10.20.8.51

You can check the box for  to see the additional settings, but you Show advanced properties? 
can keep all the defaults.
 
Click  .Create New Device
The  page is displayed showing the  device is successfully created and added to Devices  DNP3 
Ignition. The  will show as Disconnected and then Connected or Idle, depending on the Status 
status of the device.

On this page...

To connect Ignition to a DNP3 
device
Connection Settings
Internal Indicators
Terminology
Next...
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Connection Settings

General

Name The name of this DNP3 device connection.

Description Device connection description (optional). Can be used to provide any useful information / comments about 
this connection.

Enabled If True (checked), the connection is enabled; if False ( unchecked), the connection is disabled.

Main

Hostname The IP Address of the Modbus device.

Port The port to use when connecting to a DNP3 device. The default port is 20000.

Source Address The address of the master station, default is 3.

Destination Address The address of the outstation, default is 4.

Integrity Poll Interval The interval at which to perform an integrity poll, in millis, default is 3,600,000.

Direct Operate Enabled When true, the Direct-Operate function code is used on a write, otherwise Select-Operate is used, default 
is true.

When true, the outstation may send unsolicited messages for Class 1, 2, and 3 data, default is false.
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Unsolicited Messages 
Enabled

Advanced  

Message Fragment Size The maximum size of a message fragment in the application layer, default is 249.

Message Timeout The amount of time to wait for a message response from the outstation, default is 5,000.

Retries The number of retries on a message timeout, default is 0.

Link Layer Confirmation When true, a link layer confirmation will be required from the outstation when sending messages, default is 
false

Notes

Source Address and Destination Address: These addresses are assigned to the computers and should be the same across all settings, 
because of this the settings in Ignition and the settings in the device are the opposite of each other. For example, if the device is 
configured with an address of 4 and Ignition has an address of 3: 

the settings in Ignition should have the Source Address set to 3 and the Destination Address set to 4.
the settings in the Device should have the Source Address set to 4 and the Destination Address set to 3.

Unsolicited messages enabled property: setting this property to True (checking the box) allows the outstation to send unsolicited messages 
to Ignition. This means that Ignition will connect to the outstation, but not request any data from it.  Ignition waits for the outstation to send 
data.   Not all devices support this option; those that do need to be configured to use it. Please refer to your device's documentation for more 
information. 

 

Internal Indicators

Each response received from a connected outstation will contain an Internal Indication (IIN) bit field.  This field indicates certain states or error 
conditions in the outstation. IINs are mapped to read-only points, indicating the following:

Broadcast message received ( )Broadcast
Additional Class 1, 2, or 3 event data is available ( )Class 1 Events, Class 2 Events, Class 3 Events
Time synchronization required in the outstation ( )Need Time
Some output points are in local mode ( )Local Control
An abnormal condition exists ( )Device Trouble
The outstation device has restarted ( )Device Restart
Function code not implemented ( )No Func Code Support
Object Unknown ( )Object Unknown
Request parameter error ( )Parameter Error
Outstation event buffer overflow ( )Event Buffer Overflow
An operation is already executing ( )Already Executing
Configuration corrupt ( )Config Corrupt

 

Terminology

unsolicited response: An Application Layer message from an outstation to a master for which no explicit request was received.  The 
request is implied by the act of a master enabling unsolicited reporting of various points within an outstation.
integrity poll: Requests all event data, followed by the static data of all points assigned to one of the four classes (static Class 0 or event 
Class 1, 2, or 3).
DNP3TIME: Univeral Coordinated Time (UTC) time expressed as the number of milliseconds since the start of January 1, 1970.  The 
effective date for using the UTC time base is January 1, 2008.  Prior to this, DNP3 did not require a specific time reference.
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About DNP3 Addressing
 

Browsing DNP3 Points

When the driver (master) connects to a device (outstation), an integrity poll is performed. Any DNP3 
objects returned in the response that fall under the Point Type categories listed in the table on the right 
are mapped to the OPC server with the appropriate index. (For example, g40v1i2 corresponds to an Anal

 point, variation 1, index 2.)ogOutput

To see the points mapped, you can go to the Designer, open the OPC Browser, and drill down to the 
DNP3 connection node.

On this page...

Browsing DNP3 Points
Point Types
Aliased Points

 

About DNP3 
Addressing

Watch the Video

https://inductiveuniversity.com/video/about-dnp3-addressing/7.8


Point Types

Type Name Group Supported Variations

SinglBitBinaryInput 1 1 - Packed format

2 - With flags



DoubleBitBinaryInput 3 1 - Packed format

2 - With flags

BinaryOutput 10 1 - Packed format

2 - With flags

Counter 20 1 - 32-bit with flags

2 - 16-bit with flags

5 - 32-bit

6 - 16-bit

FrozenCounter 21 1 - 32-bit with flags

2 - 16-bit with flags

5 - 32-bit with flags and time

6 - 16-bit with flags and time

9 - 32-bit

10 - 16-bit

AnalogInput 30 1 - 32-bit with flags

2 - 16-bit with flags

3 - 32-bit

4 - 16-bit

5 - Float with flags

6 - Double with flags

FrozenAnalogInput 31 1 - 32-bit with flags

2 - 16-bit with flags

3 - 32-bit with time of freeze

4 - 16-bit with time of freeze

5 - 32-bit

6 - 16-bit

7 - Float with flags

8 - Double with flags

AnalogOutput 40 1 - 32-bit with flags

2 - 16-bit with flags

3 - Float with flags

4 - Double with flags

OctetString 110 0 - 255

 

Aliased Points

Aliased points allow the user to assign meaningful names and descriptions to DNP3 points. They are also useful for addressing any points that were 
not returned by the initial integrity-poll on connection.

Point Address The group, variation, and index that fully describe a point.  A full address consists of all three parts:

Group – An integer prefixed with  .  For example, g g40
Variation – An integer prefixed with  . For example, v v2
Index – An integer prefixed with  . For example, i i5



Example: g30v1i20

Path A “/” separated folder hierarchy in which to create the aliased point.
 Example: Facility1/Voltage

Description  A user-defined description of the point mapping.
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Omron
 

To Connect Ignition to an Omron Device

Go to the  section of the   webpage.Configure  Gateway
 
Scroll down and select  .OPC-UA > Devices
 
On the  page, find the orange arrow and click on  .Devices  Create new Device
 
On the page, select  , and click  . Add Device Step 1: Choose Type  Omron Driver Next
 
On the  page, leave all the default values and type in the following fields:New Device 

Name: Omron
Hostname: type the IP address, for example 74.125.224.72
Check the box for Show advanced properties? to see the additional settings, but you can keep all the defaults.
 

 Click .Create New Device
The   Devices page is displayed showing the Omron device is successfully created and added to Ignition. 

On the  page, click the tags link next to the newly created device.Devices
The  page is displayed, allowing you to configure which variables in the device will show up as tags in Ignition.Manage Tags

Gateway Settings

General  

Name  The name of the device connection, as Ignition will reference it.

Enabled  Determines whether or not to enable this device connection.

Main  

Hostname The hostname or IP address of the device.

Timeout The request timeout, specified in milliseconds. The default is 2,000.

Concurrency The number of concurrently issued requests allowed. There is a 1:1 correlation between concurrency and the number of CIP 
connections used.

Advanced  

Connection 
Size

The CIP connection size to use. The default (and maximum) is 1,994 bytes.

Slot Number The slot number in the backplane in which the CPU is located.

 

Exporting from the Device

To export variables from Sysmac Studio, navigate to the global variables and select Tools > Export Global Variables > CX-Designer.



The variables will be saved to the clipboard in tab-separated format.  You can now paste the contents into an empty text file for use with importing into 
the Ignition Gateway.

 

Managing Tags

In order to browse tags in the Designer, you must first create a mapping for the device in the gateway.  The  page can be accessed by Manage Tags
navigating to the Omron device and clicking the  link.tags

Importing Tags

Once on the  page, you can manually enter the tags, or import them from a tab-separated file.Manage Tags

When importing, first choose a file, then click the  button.  The default option when importing is to replace the  table with tags from the Import Tags
import.  Select the append option to append tags to the table.





Once you save any changes made to the tag mapping, you can view the tags in the Designer OPC Browser.



Addressing

In the  table of the  page, we have four columns of configuration per tag:Tags Manage Tags

Name - The corresponding address of the variable found in the Omron device.  Struct members are separated with periods.
Datatype - The datatype of the variable found in the Omron device.
Chars - The maximum number of characters that a String tag will contain.
Elements - Denotes whether the tag is considered a scalar or array.  See below for more detail on specifying the number of elements to read 
from the device.
R/W - Specifies read / write access permissions on the tag.

 

Scalars

Leaving the  column blank will result in a scalar tag.  When reading from the device, only one element will be requested.Elements

Arrays

Specify the number of elements in an array in the form of  .  The initial index 0 is always included, so an array mapped with 0..4 elements is a 5 0..N
element array.

Multi-Dimensional Arrays

Multi-dimensional arrays are specified in the same way as arrays, with each group of indices separated with a comma.

 



 

Strings

The number of characters for String variables is specified in the  field.Chars

String arrays are mapped using both the  and  field.Chars Elements

 

Optional Format

Array elements may also be specified with a single number equaling the total number of elements.



Third Party OPC Servers
 

Ignition can easily and quickly connect to third party OPC servers via OPC-UA or OPC-DA (using the OPC-COM module) for devices that do not have 
a supported driver.  For step-by-step instructions to connect to a Siemens device, see Connecting to Kepware OPC-UA.
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Connecting to Kepware OPC-UA
 

OPC-UA makes connecting to third party OPC servers quick and easy without all the 
headaches associated with COM. This is a detailed step-by-step guide to connecting to KEPServerEX 
from Ignition using OPC-UA.

To connect to KEPServerEX from Ignition using OPC-UA

In the   section of the Gateway, go to  .Configure OPC Connections > Servers
The OPC Server Connection page is displayed showing the OPC-UA servers you Ignition is 
connected to. 
Find the orange arrow and click on  .Create new OPC Server Connection…
The   page is displayed.Add OPC Server Connection Step 1: Choose Type

Choose  as the connection type and click  .OPC-UA  Next

The next steps depends on the version of Ignition being used. 

 

 Ignition 7.8 and up

On the   page, type in the endpoint of the OPC-UA server Ignition Discover OPC-UA Endpoints
should connect to. The format should be as follows:

opc.tcp://IpAddress:Port
 
#Examples
 
#If KepServer is installed on the same server as Ignition and uses 
the default port, the following endpoint could be used:
opc.tcp://localhost:49320
 
#If KepServer is installed on a different server from Ignition, then 
the IP address would be used:
opc.tcp://10.1.1.10:49320

Once an endpoint has been entered, click the   button. A list of available Security Discover
Policies and Message Security options will appear.
 
Select a Security Policy and Message Security configuration to use when connecting to the 
endpoint. Both   and   offer a higher level of security.Basic256 SignAndEncrypt

Once an endpoint configuration has been selected, click the   button.Next

On the  page, give the connection a name and click the New OPC UA Connection Settings  Cre
 button. A Username and Password do not need to be given, ate New OPC Server Connection

and should be left blank.
The connection will appear as  . This is expected because KEPServerEX is denying Faulted
access to the Ignition OPC-UA Client. The next step is to have KEPServerEX trust the Ignition 
OPC-UA Client.

Right-click on the   icon on the desktop KEPServerEx is installed on and from the KEPServerEX
menu select  .OPC UA Configuration
The   is will appear. OPC UA Configuration Manager
On the   window, go to the  tab, click on OPC UA Configuration Manager  Trusted Clients Igniti

, click the button, and click  .on OPC-UA Client  Trust  Close
Now the   page shows the   of   to be  .OPC Server Connections Status Kepware Connected

 If   does not read  , click the   link next to the server Troubleshooting: Status Connected edit
connection, scroll down to the bottom of the connection configuration page, and click  . If Save St

 is still reading something other than  , click the   link at atus Connected OPC Connection Status
the bottom of the   page and see if there are any useful messages to OPC Server Connections
help troubleshoot the issue. Also ensure your firewall is not blocking traffic on the port that 
KEPServerEX is using to communicate.

Go to the   in the  section of the Gateway, under OPC Connections > Quick Client  Configure
the   folder you will see the   folders. Kepware > Channel1 > Device1 Tag

Ignition 7.7 and prior

Connecting to 
Kepware OPC-UA

Watch the Video
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In the   section of the Gateway, go to  .Configure OPC Connections > Servers
The OPC Server Connection page is displayed showing the OPC-UA servers you Ignition is 
connected to. 
 
Find the orange arrow and click on  .Create new OPC Server Connection…
The   page is displayed.Add OPC Server Connection Step 1: Choose Type

Choose  as the connection type and click  .OPC-UA  Next

On the  page, leave all the default values and type in the New OPC Server Connection 
following fields:
Name:  , the name you specify here will appear under  folder on theKepware  Devices  Quick 

 page in theClient  Gateway.
Host:  , if the Kepware server is hosted on your own machine otherwise use the actual localhost
IP address of the machine
Port:  , which is the default port49320
 
Right-click on the   icon on your desktop and from the menu select KEPServerEX OPC UA 

.Configuration
The   is displayed. OPC UA Configuration Manager

Go to the   tab, check the URL to ensure it shows your localhost and the Server Endpoints
49320 port, and click  .Close

Go back to the   page, make sure you have the following default New OPC Server Connection
settings:
Security Policy: Basic128Rsa15
Message Security Mode: SignAndEncrypt 

Leave the fields empty and click . Password   Create New OPC Server Connection
The   page shows the   of   to be   and not OPC Server Connections Status Kepware Faulted
connected. The reason for this is that Kepware is denying access to the Ignition OPC-UA Client. 
 
To make the Ignition OPC-UA Client a trusted client, go back to the   icon on your KEPServerEX
desktop and from the menu select  . OPC UA Configuration
 
On the   window, go to the  tab, click on OPC UA Configuration Manager  Trusted Clients Igniti

, click the button, and click  .on OPC-UA Client  Trust  Close
Now the   page shows the   of   to be  .OPC Server Connections Status Kepware Connected

 If   does not read  , click the   link next to the server Troubleshooting: Status Connected edit
connection, scroll down to the bottom of the connection configuration page, and click  . If Save St

 is still reading something other than  , click the   link at atus Connected OPC Connection Status
the bottom of the   page and see if there are any useful messages to OPC Server Connections
help troubleshoot the issue. Also ensure your firewall is not blocking traffic on the port that 
KEPServerEX is using to communicate.
 
Go to the   in the  section of the Gateway, under OPC Connections > Quick Client  Configure
the   folder you will see the   folders. Kepware > Channel1 > Device1 Tag

Other UA Servers

While the above example is specific to KEPServerEX, the same concepts apply to connecting to any 
other third party OPC server that accepts OPC-UA client connections. The only difference may be in 
the way that the certificates are accepted on the server.

The Ignition OPC-UA server sends the client certificate to the third party OPC server when it tries to 
make the connection, however if the OPC server is not designed to expect these certificates then there 
may not be a straight forward way to accept them. In these cases you can manual download a client 
ticket from Ignition and supply it to the OPC server in the appropriate manner.

To download a client certificate manually

Go to  section in the Gateway.Configure
 
Select  from the left side of the page.OPC-UA > Certificate
The  page is displayed.Manage Certificate
 
In the  tab, click the download link under , and save the This Gateway  Ignition OPC-UA Client
certificate somewhere to disk.
This certificate is then supplied to your third-party OPC server in a way specific to that server. 
For more information, check respective server's documentation.
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Vision Windows
   

Every Ignition project contains a collection of Windows. The windows are the fundamental building blocks for projects using the Vision module. 

 

 

In this section ...  
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About Vision Windows
 

Windows are the top-level design units for Vision projects. Windows are made up of components and come in different types such as main, popup, 
and docked windows.

Creating Windows

Creating windows is as easy as pressing the  button in the toolbar, or by navigating to the  menu. There are three New Window File > New > Window
types of windows you can create: a window, a  window, or a  window. These three windows are described in the main  popup docked Window Types 
page. 

To create a Window

Lets create a window so we can use our tags for some basic status and control.

Click on the   icon in the toolbar or use the .New Window File > New > Main Window
Tags are used in windows to power property bindings on components. The easiest way to make some components that are bound to tags is 
to simply drag and drop some tags onto your window. 
 
Drag a tag onto a window.
You'll get a popup menu asking you what kind of component to make. You can Display the tag with some components, and control the tag 
with other components. 
 
Drag a few more tags onto the screen to experiment with the different options.
 
As you're editing your project, you can click the  icon on the toolbar to save your changes. Save
In Ignition, you're not editing a file, your Designer is linked to the Ignition Gateway. When you click save, the project is saved back on the 
central Gateway. All running Clients are notified that there is a new version of the project available.

Naming and Renaming a Window

In the Project Browser, right-click on the window and choose   or press  . Enter a new name for the window. The name must be unique in its Rename F2
folder.

Organizing Windows

You can also create folders to organize your windows. A window's name must be unique among the windows in its folder. A window's name and folder 
path is very important - it will be how other windows reference it.

Accessing windows from the Client

In the Project Browser, right-click on the window and select the check box next to  . Once checked, the window will be accessible "About" Window
from the  menu in the Client, which opens the appropriate window.Help > About This Application

Adding Notes on Windows

Through the right-click menu on a window in the  you can access the window's . This free-form text field is provided to let the Project Browser, Notes
designer document the purpose and any technical information about how the window works.

Importing and Exporting a Window

You can import and export windows to external files by using the right-click menu in the . Simply select the windows in the export Project Browser
wizard that you'd like to export, and choose a path for the resulting  file.*.vwin

Setting the Window's Security

You can configure security settings that control who can and who can't open a window. While the window is open, right-click on a window in the Projec
 and select  Window Security is configured the same way that Component Security is configured.t Browser  Security.
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Anatomy of a Window
 

Name and Path

Windows are the top-level unit of design for Vision projects. A window is identified by its path, which 
is the name of all its parent folders plus its name, with forward slashes (/) in between. For example, 
the path to a window in the top level called   would simply be its name, whereas the path to MainWindow
a window named   under a folder called   would be:  UserOptions OptionsWindows OptionsWindows

./UserOptions

Root Container

Inside a window is always the Root Container. This is a normal container component except that 
it cannot be deleted or resized - its size is always set to fill the entire window. The Root Container 
is where you will place all of your components in the window.

Titlebar and Border

A window may display a titlebar and/or a border. The titlebar allows the user to drag the window around, 
and houses the window's close and maximize/restore buttons. The border of a window can be used to 
resize the window when it is floating or docked. Whether on not the titlebar and border are displayed 
depends on the values of the window's titlebar and border display policy properties, and its current state. 
Commonly, a window will display both a titlebar and border when it is floating, but only a titlebar when 
maximized. It is often desirable to remove titlebars and borders on maximized windows.

Anatomy of a 
Window

Watch the Video
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Window Types
 

Windows come in three flavors: main screens, popups, and docked windows. 

Main Windows

A   is one that is set to start maximized, and has its border and titlebar display policies set Main Window
to When Not Maximized or Never. This will make the window take up all available space (minus space 
used by any "docked" windows). This makes the window act much like a typical "HMI screen." There can 
by many main windows in a project, but only one should be open at any time. 

Popup Windows

A   is a window whose Dock Position is set to Floating and is not maximized. Its border Popup Window
and titlebar display policies are usually set to When Not Maximized or Always, so that they can be 
manipulated by the end-user. These windows are often opened by components in a main window, and 
are meant to be on top of the screen. To this end, they may have their Layer property set to a number 
higher than zero so they don't get lost behind the main window. To get a window to pop-up at a specific 
position, edit the Window's Starting Location property. 

Popup windows are often parameterized so they can be re-used.

    

Window Types

Watch the Video
 

 

Docked Windows

A  is one whose Dock Position is set to anything but Floating. This will make the window stick to one side of the screen, and nothing Docked Window
can overlap it. It will also typically have its border and titlebar display policies set to Never. This makes the "docked" window appear to be joined 
seamlessly with the current "screen" window.

These screens are usually tall and skinny or short and wide, depending on the side they're docked to. The purpose of a docked window is to make 
some information always available; typically navigation controls and overall status information. Using docked windows can help eliminate repetitive 
design elements from being copied to each screen, making maintenance easier.
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Window Properties
 

There are a number of window properties that change the way the windows look and behave. These 
properties are: Closable, Maximizable, Resizable, Start Maximizable, Title, Border Display Policy, 
Titlebar Display Policy, Dock Position, Dock Index, and Layer.

You can modify these window properties, just like a component's property. Simply select the window, 
either by clicking on its title bar, or clicking on the window's node in the Project Browser, and while it is 

open, set the property in the Property Editor.

Window Properties

Watch the Video
 

 

Behavior

Dock Position Determines the position this window is docked to, or if it is floating.

  Scripting name dockPosition

  Data type int

  Values 0 Floating

3 West

4 South

2 East

1 North

Closable Closable Determines whether or not to draw the close (X) button in the upper right corner.

  Scripting name closable

  Data type boolean

Maximizable Determines whether or not to draw the maximize button in the upper right corner.

  Scripting name maximizable

  Data type boolean

Resizeable Determines whether or not to let the user resize the window.

  Scripting name resizable

  Data type boolean

Start Maximized When set to true, the window will become maximized when it is opened.

  Scripting name startMaximiz
ed

  Date type boolean

Cache Policy By default this property is set to  , which keeps a window in a memory cache for a while after it is closed, so that if it is Auto
opened again it will be quick. The window isn't "active" while it is closed: all of its bindings and scripts are shut down.

Setting this property to  causes a fresh copy of the window to be deserialized every time it is opened. This is a  Never
performance hit, but it also is a convenient way to "clear out" the values of the window from the last time it was opened, which 
can be helpful in data-entry screens.

Setting the property to  will trade memory for higher performance, causing the window to always remain cached after  Always
the first time it is opened. This means the window will open very fast, but your Client will need lots of memory if you do this to a 
large amount of windows.

  Scripting name cachePolicy

  Data type int

https://www.inductiveuniversity.com/video/window-properties/7.8


  Flags expert

  Values 0 Auto

1 Never

2 Always

Appearance    

Title  The title to be displayed in this window's titlebar.

  Scripting name title

  Data type String

Border Display 
Policy

Determines if window's border is shown in various window states.

  Scripting name borderDispla
yPolicy

  Data type int

  Values 0 Always

1 Never

2 When Not 
Maximized

Titlebar Display 
Policy

Determines if window's titlebar is shown in various window states

  Scripting name titlebarDisp
layPolicy

  Data type int

    0 Always

1 Never

2 When Not 
Maximized

Titlebar Height The height of the window's titlebar.

  Scripting name titlebarHeig
ht

  Data type int

Titlebar Font The font of the window title in the titlebar.  

  Scripting name titlebarFont

  Data type Font

Layout  

Location The location that this window will open up at. Only applicable to floating windows that are not set to start maximized. Also, you 
must un-check the   checkbox on the open-window navigation action in order for this location to take effectCenter Window

  Scripting name startingLoca
tion

  Data type Point

Size The dimensions of the window. This can be manipulated by selecting the window and dragging the resize handles along the 
windows right and bottom edges.

  Scripting name size

  Data type Dimension

Minimum Size The minimum size that this window will allow itself to be resized to.  

  Scripting name minimumSize



  Data type Dimension

  Flags expert

Maximum Size The maximum size that this window will allow itself to be resized to.  

  Scripting name maximumSize

  Data type Dimension

  Flags expert

Layer Sets the layer that this window is in. Default layer is 0, which is the bottom layer. Windows in higher layers 
will always be shown on top of windows in layers beneath them.

 

  Scripting name layer

  Data type int

  Flags expert

Dock Index Determines the order of windows docked to the same side.  

  Data type int

  Scripting name dockIndex
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Open Static Window(s) on Startup
   

You can have a static set of windows automatically open when a client is opened.

To open a static window on startup

Lets say you want the Main Window and the Navigation Window to open in the Client on Startup.

In the Designer, right-click on a window and choose  .Open on Startup
An icon is displayed next to the window so you can see visually which ones will be opened on 
start up.
 
Go to your Client, logout and log back in.
Now you can see the Main Window and the Navigation Window open automatically.

Open Static Window
(s) on Startup

Watch the Video
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Open Dynamic Window(s) on Startup
 

Sometimes a project needs to change its startup windows depending on who logged in, what 
security roles they have, or what computer the Client is launched on. In these cases, rather than setting a 
static startup window, you can write a Client Startup Script that uses the  library to open a system.nav
dynamic set of windows based on hostname, IP address, user who logged in, and more.

Open Dynamic 
Window(s) on 
Startup

Watch the Video
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Docked Windows - Axis Precedence and Dock Index
Docked windows fill up the edges of the Client. When you have more than one docked window that share 
a corner, you can specify which window will take control over that corner.

To set the docked window order precedence

Go to  .Project > Properties
The Project Properties window is displayed.
 

Go to page.  Client > User Interface
Select a value for the For example, if you choose  Docking > Axis Precedence  drop-down.  Nor

 then North and South docked windows will take precedence or over the East and th/South
West windows. 

Save and Publish your project.
 
Open your project in the .Client

For Testing

Docked Windows - 
Order Precedence

Watch the Video
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Make sure to set the  property on your windows (North/South/East/West) Dock Position

Set the  option for each docked window.  logging in is the only way to Open on Startup Note:
activate the  settings.Open on Startup



Examples of Docked Windows

North/South Docking Axis Precedence

East/West Docking Axis Precedence
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Locate All Opened Windows In Client
 

You can locate all of the currently opened windows in a Client from the  menu command.Windows

Open Windows and Performance

While a window is open, its query bindings are running, its tag bindings are keeping tags subscribed, and 
its event scripts are being executed. This means that an open window is actively using system resources, 
both on the Client's host machine, and on the Gateway's server machine as its queries and tag 
subscriptions must be handled. For these reasons, it is important that you properly implement 
a navigation strategy that prevents windows that are no longer being used from being held open.

The most common mistake that will cause windows to stay open unintentionally is to implement 
a swapping navigation system using the   function on windows that are not maximized. When you swapTo
do this, the   function cannot calculate the window to swap from, thereby simply opening the swapTo
window, and not closing any windows. It is easy to check the Windows menu to see what windows are 
currently open. If there are more windows listed there than you can currently see, there is a problem in 
your navigation logic that is failing to close windows properly.

Locate All Opened 
Windows In Client

Watch the Video

   

   

Next ...

add link here

 

https://www.inductiveuniversity.com/video/locate-all-opened-windows-in-client/7.8


Navigation Windows
   

Setting up a navigation strategy allows you to navigate between different windows in the runtime Client. There are several different navigation 
strategies you can use and choose from.

 

In this section ...  

   



1.  

2.  

3.  

4.  

Navigation Strategies
 

There are several different types of runtime navigational strategies you can use when designing your 
Ignition project. A typical navigation strategy for a Vision project is as follows:

Have a    window or two, usually docked North and/or West.Docked
 
Have a single  window visible at a time.Main
 
Use swap navigation to swap between the  windows. This ensures that only one main Main
window is open at a time. 
 
Use standard open navigation to open various  windows as necessary.Popup

This style of project is so common, that the default operation of the   component expects Tab Strip
it. When it is in its default automatic operation, it expects that each tab represents a "screen" 
window, and will automatically swap from the current screen to the desired screen.

Furthermore, the   tag is calculated based on this strategy: [System]/Client/User/CurrentWindow

its value is the name of the current maximized window. This navigation strategy is used in the Ignition 
 that you can download from our website.Online Demonstration

Navigation 
Strategies

Watch the Video
 

 

 

 

Next ...

Swapping vs. Opening

 

http://10.20.1.135:8090/display/DOC/Tab+Strip
https://inductiveautomation.com/products/ignition/demo/online
https://inductiveautomation.com/products/ignition/demo/online
https://www.inductiveuniversity.com/video/navigation-strategies/7.8


1.  

2.  

3.  

Swapping vs. Opening
 

The two primary window navigation operations are: swapping and opening.

To set the Open or Swap option

In the Designer, right-click on a component and choose .Scripting
The Component Scripting window is displayed.
 

Go the to  tab and click the  button.Navigation Open/Swap
 

Select  or  as your Navigation strategy. Open Swap
Typically you want to use the Open option for Popup and Docked windows and the Swap for the 
Main windows that will be in the background as you can only view one at a time.

Swapping

In general, swapping involves closing one window, and then opening another window in its place. 
This operation can be performed on windows in any state: docked or floating, maximized or not. The Start

 and   properties of the window that is being swapped in will be ignored - it  Maximized Dock Position
will take the dock and maximized state of the window that it is replacing.

This operation is so common in the typical navigation strategy that there is even a   the version of
swapping function dedicated to it, the   function. This function eliminates the need to specify the swapTo
window to swap from - you only need to specify the window to swap to. It will take the current window - 
that is, the current maximized window - as the window to swap from.

See the following functions for more information:

system.nav.swapWindow
system.nav.swapTo

Opening

Opening and closing are the basic window navigation options. Opening a window opens the window 
at the same size it was in the Designer, unless the   property is  or the Start Maximized true Dock 

 is .Position not Floating

To make a floating popup window open at a specific location, make sure to set the  property of Location 
the window in the Designer. If the window was recently open, it will open in its last state due to window 
caching. See the Window's   property for more information.Cache Policy

See the following functions for more information:

system.nav.openWindow

Swapping vs. 
Opening

Watch the Video

   

   

Next ...

Navigation - Tab Strip

 

https://legacy-docs.inductiveautomation.com/display/DOC/system.nav.swapWindow
https://legacy-docs.inductiveautomation.com/display/DOC/system.nav.swapTo
https://legacy-docs.inductiveautomation.com/display/DOC/Window+Properties#WindowProperties-CachePolicy
https://legacy-docs.inductiveautomation.com/display/DOC/system.nav.openWindow
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1.  

2.  

3.  

Navigation - Tab Strip
 

It is very common to use tabs for navigation in Ignition.

To configure the Tab Strip in the Designer

Go to Project Browser, expand the  window, to see the  component inside of it.Navigation Tabs
The  component, has a  property which is set to .Tabs Navigation Mode Swap to window
 
Right-click on the tab component, choose .Customizers > Tab Strip Customizer
Here you can specify which window to open with each tab. 
 
Save you project and open it in the runtime to see that each tab now goes to a different window.

Navigation - Tab 
Strip

Watch the Video

 

 

Next ...

Navigation - 2 Tier

 

https://www.inductiveuniversity.com/video/navigation-tab-strip/7.8


Navigation - 2 Tier
 

2 Tier Navigation involves using 2 sets of tabs to navigate around various areas of your project.  Ignition 
has a built-in skeleton project that you can start from to build your new project in the Designer and 
customize it to fit your needs.  It uses a typical navigation strategy.  There are 2 windows that open up on 
startup:  a docked north window that contains tabs that are always open to do navigation, and the main 
window at the bottom which fills in the rest of the space.
 

In the docked north window there are 2 sets of tabs.  The first tier component has the ' ' and 'HMI Screens
' tabs which contain multiple main windows. The HMI Screens tab has one main window Administration

on the second tier called Overview, and the Administration tab contains 3 main windows.  Each second 
tier tab represents a main window and when clicked will swap out the bottom window ensuring only one 
main window is visible at a time. This 2 Tier Navigation strategy lets you organize all your windows into 
different groupings by having the first layer of tabs. 

In the , you will see multiple Tab Strip components.  In this example, there are two tabs  Project Browser
named ‘ ’ and ‘ ’.  Click on the . You will notice that the HMI Screens Administration  first tier tab   Navigatio

 property is set to  and does not have any navigation functionality. n Mode Disabled

 

In the same example, the  component has 3 tabs named ‘ ’, 'Adminisration Tab User Management Sched
' and ‘ ’.  Click one of these .  Tule Management Roster Management second tier tab strip components

he property for the second tier tabs is bound to a simple expression looking at the first tier tab. Visible 
You can see the expression by clicking on the binding icon for the  property. Visible

Navigation - 2 Tier

Watch the Video

 

 

https://www.inductiveuniversity.com/video/navigation-2-tier/7.8


The second tier tabs will only be visible based on which first tier tab is selected as shown in the example 
below. When the  is selected, Ignition displays the  components: Administration tab Administration Tab
User Management, Schedule Management and Roster Management. 

 

In the , click on the  component.  You will notice that theProject Browser Administration Tab  
property is set to .  Each tab on a second tier tab strip represents a Navigation Mode Swap to window

main window, and when clicked it, will swap out the main window ensuring only one main window is 
visible at a time.

You can also go into the Navigation Tab Strip Customizer to configure tabs on both tiers that best fit your 
requirements.  

The 2 Tier Navigation strategy lets you organize your main windows into different sections making 
navigation easy for users.

 

 

Next ...

Navigation - Tree View

 



1.  

2.  

3.  

Navigation - Tree View
 

You can navigate through your project using the multi-tier  component. In fact there is a built-in Tree View
project template that you can use to get started with this navigation strategy. The key is the Tree View 
component that provides the navigation for the project.

To use a Tree View Component for Navigation

Select the  component from the Navigation window or drag a  component Tree View Tree View
onto a docked window.

From Property Editor, find the  property and click on the  icon.Items Dataset Viewer
The  is displayed which contains information about the tree nodes and folders.Dataset Viewer

You can also manage the Dataset by right-clicking on the Tree View component and choosing C
, however in this example we use the Dataset icon which is ustomizers>Tree View Customizer

located next to the Items property's binding icon.
 
If you are using the existing Navigation window from the Template Project, there will be a windo

 column on the left that will determine the folder organization of the  wPath Tree View
component, while the  column will determine the name of the node on the Tree View path
component. If you are using a new  component, add a column names windowPath Tree View
that is a string type.
 
The  component needs to have a script that executes when the user double-clicks on Tree View
one of the nodes in the  component. Here is the script that is executed on the Tree View Tree 

's  event handler, copy it in if needed.View mouseClicked

#If the user performs a double click, open the appropriate window. 
if event.clickCount == 2: 
        row = event.source.selectedItem 
        data = event.source.data 
        if row != -1: 
                #Grab the window path value out of the trees view's 
items dataset 
                windowPath = data.getValueAt(row, "windowPath") 
                system.nav.swapTo(windowPath)

Navigation - Tree 
View

Watch the Video

   

 

Next ...

Navigation - Back and Forward Buttons

 

https://www.inductiveuniversity.com/video/navigation-tree-view/7.8


1.  

2.  

3.  

Navigation - Back and Forward Buttons
 

Another navigation strategy in Ignition is to have Forward and Back Buttons on your main screen to 
navigate between different windows.  This navigation strategy does not have a docked window, tree view 
or tabs to navigate around.  It is one big main window and has buttons to navigate forward and back from 
one Main Window to another.  

This navigation strategy is very simple to setup in Designer.  You can start by creating your project using 
a blank template.  

In the , right click on the Main Windows folder and select .  You Project Browser Main Window
have the option of renaming your Main Window to whatever best describes your window.  In this 
example, it’s called Main Window 1.  You don’t need to have a header on each window, but for 
this example, a label was added for clarity and called .  Repeat this step to Main Window 1
create Main Window 2 and Main Window 3.

 

From the  in Designer, select and drag a  component to your Main Component Palette Button
Window 1.  Label the button, .  In the , add a right green arrow Main Window 2 Property Editor
to your button component from the .   To get the arrow to move to the right Image Path folder
side of the button, click the  and enter .   The Icon-Text Icon-Text Spacing property -200
Spacing property is used to move the location of the green arrow within the button.  Select a 
desired value and the green arrow will move within the button component.

 

Now you need to tell the Main Window 2 button what to do when someone clicks on it.  Right 
click on the Main Window 2 button and select .  Scripting

Navigation - Back 
and Forward 
Buttons

Watch the Video

https://www.inductiveuniversity.com/video/navigation-back-and-forward-buttons/7.8


3.  

The component scripting dialogue box will open.   Under the Event Handlers folder, open the 
action folder and select .  Click the  and radio actionPerformed Open / Swap Swap 
buttons.  The Swapping function is used to put buttons on windows for easily building simple 
scripts to go back and forth between different main windows.  The Swap function ensures only 
one main window is open at a time. 

From the , select .  Click .  Window dropdown box Main Windows/Main Window 2  OK Save 
your project.and Publish 

, click on the   button and Ignition swaps the Main Window 1 with Open a Client Main Window 2
Main Window 2.



3.  

4.  

5.  

  

Repeat Steps 2 and 3 to create Main Windows 2 and 3 respectively.   Make sure for Main 
Window 2, you have a button for both Main Windows 1 and 3. Your window path for the Main 
Window 1 button is set to Main Windows/Main Window 1.  For the Main Window 3 button, set 
the window path to Main Windows/Main Window 3.   
 
In the following example, each button navigates you to the next main window.  Click on the Main

 button and Ignition navigates you to Main Window 1.  It swaps out Main Window 2 Window 1
with Main Window 1 so you always have 1 main window open.  Click on the Main Window 3 
button and Ignition swaps out Main Window 2 with Main Window 3.  

 

Navigating between all 3 windows is easy using the Back and Forward Buttons navigation 
strategy in Ignition.   

 

 

 

Next ...

Navigation - Drill Down

 



1.  

2.  

3.  
a.  
b.  

4.  

Navigation - Drill Down
 

You can navigate through your project using a map to drill into different areas of your project. A popular 
option is to have a main window that has an image representing the facility. The image has various 
boxes that overlay the image. When the user selects one of the boxes, the Client swaps windows with a 
window that displays the information that pertains to the selected area.

To create a navigation drill down

Create a box on the Main window.
 
Right-click the box and select .Scripting
 
Select the  event handler and with the  tab selected. mousePressed Navigation

Select the  radio button.Open/Swap
From the  drop-down box, select the window that relates to the selected area.Window
 

Click .OK

A on the area window would navigate you back to the main window.back button 

Navigation - Drill 
Down

Watch the Video

 

 

 

 

Next ...

add link here
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Popup Windows
   

Popup windows are often opened by components in a main window, and are meant to be on top of the screen. They are used to view setpoints or 
zoom into a specific area and more.

   

   

In this section ...  

   



1.  

2.  

Open Popup Window
 

In order to open a Popup window, you first have to create a .  You can add a Popup Popup Window
window to any folder in the Designer.  

In this example, a Popup folder already exists so we will right click on the Popup folder to create 
a new ‘ ’ window.  Right click on the  then rename it to ‘  or give it Popup Popup window Popup’
an appropriate name. 

You can make the Popup window as big or small as you want.  You can also set properties in 
the Property Editor by making the window Closable, Resizable, and giving it a Title.  You can 
even setup the Border or Title Bar to show-up on the window.

Once the window is created, you can open up the Popup window from any other window.  For 
example, you can open it up from any Main Window.  You can open a Popup window from a 
button, a label, an image or any component you like. 
 
In any Main Window, drag a Button component from the Component Palette to your window.   

Do a slow double click on the word ‘Button’ and change the text to ‘Open Popup.‘

Now you need to tell the Open Popup button what you want it do when you click it.  Select the O
pen Popup button, right click and select Scripting from the dropdown.

 

 

Open Popup 
Window

Watch the Video
 

 

https://www.inductiveuniversity.com/video/open-popup-window/7.8


2.  

The Component Scripting dialogue box will open.  Select actionPerformed, and click the Open 
/ Swap then   options on the Navigation tabOpen and Center .    From the Window dropdown 

 box, set the window path to Popups/Popup.  Click OK.  Save and Publish your project.  

Open a  and click the  button on your Main WindowClient Open Popup .  It opens the Popup 
window and you can move it around, make it bigger and close it.  

 

Another behavior of the Popup window occurs when you open up the Popup window and click 
on Main Window 4.  It looks like the Popup window disappears, but it’s actually behind Main 

Window 4.  Go to Windows on the menu bar and click Popup to bring the Popup window back 



2.  

3.  

4.  

to focus. 

 
 
There is a property on the Popup window that will force the popup to stay on top of the Main 
Window.  In the , click on your Popup window in the Project Browser (not the Root Designer
Container), go to the  and click the  property.  The higher the Layer Property Editor  Layer

, they are all number, the more on top it will be.  If your 'windows’ Layer properties are set to 0
going to share the same layer.  They can go back and forth each other.  If you set the over 
Layer number to for this example, the Popup window will always be on top.   1  Save and Publish
your project.  

 After you update the Client, you will see your Popup window.  Click your Main Window and 
you’ll see that your Popup window will stay on top.

 



4.  

5.  

It is possible for you to open and set a specific location where you want the Popup window to be 
located.  In , click on your  window and go to the .  Click on the Designer Popup Property Editor

 property and set  and .  Location X to 300 Y to 300

 

Go to  double click   to open the Component Scripting dialog your Main Window, Open Popup
box and uncheck ‘  so your Popup window will automatically open up in that specific and Center’
X, Y location.

 

Save and Publish and update your Client, click on Open Popup.   The Popup window will open 
at the X 300 and Y 300 coordinates instead of opening it in the center of the screen. 

 

In  drag a  component from the  to your window.   Do a  any Main Window, Button Component Palette
slow double click on the word ‘ ’ and change the text to ‘ .‘Button Open Popup



 

 

Next ...

Parameterized Popup Window

 



1.  

2.  

3.  

4.  

Parameterized Popup Window
A parameterized popup window lets you pass information from one window to another window, where the 
receiving window would display the relevant information. Also, this allows you to maintain a single 
window that can be used to display similar information.  For example, suppose you have 3 compressors 
organized in the following folder structure:

Comppressors

   C1
      HOA
      AMPS

   C2 

      HOA
      AMPS

   C3
      HOA
      AMPS

The only difference is the compressor number. Imagine clicking on a compressor on your main window 
and a popup displays the diagnostic information about the compressor. What is passed is simply the 
number, therefore a single diagnostic window can represent many different compressors.

   

Parameterized 
Popup Window

Watch the Video

To pass parameters to the popup window

To pass parameters from one window to another, the receiving window must have Custom properties that receive the passed parameters. These 
parameters are passed to the receiving window's  properties on its Root Container. Once the event on the parent window is called, the Custom
parameters are passed to the receiving window's Custom properties on its Root Container. The com ties on the receiving window can ponent's proper
use the Root Container's Custom properties to address their bindings.

Let's suppose you have a window called CompressorPopup that you want to use to pass the compressor number to this window.

Right-click on the window and select  .Customizers > Custom Properties
The Custom Properties window is displayed. 
 
Specify a for the  Property, for example name it nd click .Name  Custom compNum, a OK

The  property is now created and displayed at the bottom of the .Custom Property Editor

Use   in your tag bindings for the controls on your screen using  . compNum indirect tag bindings

For example, you might bind the control and indicator properties of a  to an indirect tag binding like:Multi-State Button 
Compressors/C{1}/HOA

where the {1} paremeter is bound to the property path: Root Container.compNum

You could use a similar indirect binding to display the amperage in an analog Meter component.
 
Now, when opening the window, use a script like the following to open it to control compressor #6. Of course, you probably wouldn't write this 
script by hand, you'd use the navigation script builder. But it is useful to know what the script would look like.

system.nav.openWindow("CompressorPopup", {"compNum":6})

 

 

Next ...

Popup Window - Multiple Instances

Do not bind these  properties to anything, leave them unbound so you can pass values into them without any other values Custom
to override them. 

https://inductiveuniversity.com/video/parameterized-popup-window/7.8


 



Popup Window - Multiple Instances
 

By default Ignition only opens a single copy of each window in the client. However, you can open multiple 
copies (or instances) of the window in the Client.

Opening multiple copies

By default, opening a window will only ever open one copy of any given window. If the window is already 
open, it simply brings it to the front. Normally this is the desired behavior. For example, if you opened the 
compressor popup window for compressor #6, and then opened it for compressor #4, the window that 
had been controlling #6 will switch to controlling #4. 

Sometimes you may want to open a separate popup, one for #6, and one for #4, both at the same time. If 
this is the case, use the   function call to open your window.system.nav.openWindowInstance

Popup Window - 
Multiple Instances

Watch the Video
 

 

   

 

Next ...

Parameterized Popup Window and UDTs
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1.  

2.  

Parameterized Popup Window and UDTs
Before we dive into Parameterized Popup Window and UDTs, a small Glossary of terms is provided to help you understand the terminology on this 
page.

Glossary

Name Description

Custom 
Property

A property you add to a component or container. A custom property is a variable that 
you customize for your particular use.

User Defined 
Type (UDT)

Is a User-Defined data Type defined by its structure, tags, attributes and settings. 
UDTs are used to design re-usable, parameterized, and extendable data types.

Element / 
Parameter of 
a UDT

A dynamic value inside of a Custom Property, assuming the Custom Property is a 
UDT type.

Parameterized 
Popup Window and 
UDTs

Watch the Video
 

 

When you pass an entire UDT into a popup window, you can take advantage of passing all the parameters inside of that UDT at once.  By passing the 
entire UDT, you have every single value available to you that is inside the UDT. 

In this example, we have a  popup window with a data type called ' .' 'Tank Detail' Tank
On the root container, right click and select Customizers > Custom Properties.
Click the  and add a property called and select the  data type from the dropdown list.plus icon  'passIn_TankData'    'Tank'
Click . Note: parameters that are passed into a window can only be passed into properties that are on the .OK Root Container

UDT and matching Tank Template must be created to do this exercise

The examples in this section assume you have a UDT and matching Tank template (that uses the UDT) created. To learn more about 
creating UDTs and Templates go to  and  sections of this user manual.UDT Parameter Template Basics

https://www.inductiveuniversity.com/video/parameterized-popup-window-and-udts/7.8


1.  

2.  

3.  

In the Property Editor you will see the Custom Property called  It was assigned a unique name so it is clear exactly what 'passIn_TankData.'
the Tank property is doing.  It will hold the UDT that is passed in from another window.  
Click on the  and see all the elements that are inside of the Tank UDT; (i.e., HOA, level_PV, temp_PV, etc.). All of the magnifying glass
values will be NULL if you just added the property, they will get filled in later when tested in preview mode.

Now, you can bind components inside the Tank Detail window to elements of the Tank UDT. 

For example, let’s bind the HOA Control.  Click on the  in your Tank Detail window.  Multi-state Button
In the , click the  next to the Control Value to open the Property Binding window.   Property Editor binding icon
Select the  of the Tank UDT and  to make it bidirectional. HOA property check the Bidirectional box
Click .  OK

By using the entire Tank UDT and all of its parameters, you have all the properties available to you making it very easy to configure the 
components in this popup window. You can now bind properties on the window without having to use indirect tag bindings. Bind the rest of 
your components to the appropriate tags in the Root Container UDT.



3.  

4.  
  
Now that there is a property to pass into, we need to set up the script to pass a Tank UDT into the Tank Detail window.  A great place to do 
this is from the Tank template definition.  The Tank template is using the same parameter as the Tank Detail window, but for clarity, it was 
assigned a unique name called ‘template_TankData.'

Navigate to your  and right click on the Tank Template gray area of the canvas and scroll down to Scripting.
Under Event Handler, select 'mouseClicked.'  

window.In the Navigation tab, click Open / Swap, Open and Center and under the  dropdown, select your Window ‘Tank Detail' 
Check the  box.  Press the green plus icon to add a row and click in the  cell. This is a dropdown list that Pass Parameters 'Parameter Name'
shows all of the custom properties on the Root Container of the selected window.  Select the  parameter to pass in to.'passIn_TankData'

 property. The is the value we are passing Select the whole row and click the choose property link icon and select the 'template_TankData'
to the window.
Click OK. 



4.  

5.  

 
 

 Open the  and go to any window that uses your tank template.  We used the exact same UDT that is in the Tank template and Runtime
passed it to the Tank Detail Popup window.  

 

 Click on one of the Tanks (ie: Tank 100) and it will open your Tank Details window and display all the details about Tank 100.  You can do 



5.  

this with any Tank in your runtime.

 

 

 

 

Next ...

Property Binding
Template Repeater Component
Component and Window Security

 



Components and Property Binding
   

Components are visual elements that range in complexity from a single Button to the powerful Easy Chart  component. A component gets connected 
to the real world through its property binding.

   

   

In this section ...  

   



Understanding Components
 

Components are what fill up your windows with useful content. Anyone familiar with computers should already understand the basic concept of a 
component - they are the widgets that you deal with every day, such as: buttons, text areas, dropdowns, charts, and so on. The Vision module comes 
with a host of useful components out of the box, many of which are specialized for industrial controls use. Other modules, like the Reporting module, 
add more components for specialty purposes.

Configuring components will likely be the bulk of a designer's work when designing a Vision project. The basic workflow is to take a component from 
the palette and drop it into a container on a . From there, you can use the mouse to drag and resize the component into the correct position. window
While the component is selected, you can use the  panel to alter the component's , which changes the component's Property Editor properties
appearance and behavior.

Shapes are components too. Each shape may be individually selected, named, and has its own properties. Shapes have some additional capabilities 
that other components don't have, such as the ability to be rotated. Shapes are created using the shape tools, not dragged from the 
component palette.

To make the component do something useful, like display dynamic information or control a device register, you configure  for the property bindings
component. To make the component react to user interaction, you configure  for it.event handlers

 

   

In this section ...  

   



Component Overview
 

Components are what fill up your windows with useful content. They are the widgets that you deal with 
every day – buttons, text areas, dropdowns, charts, and so on. The Vision module comes with a host of 
useful components out of the box, many of which are specialized for industrial controls use. All 
components have position, layout and other customizers, some of which are highly specialized for the 
individual component. Other modules, like the Reporting module, add more components for specialty 
purposes.

Component 
Overview

Watch the Video
 

 

 

 

Next ...

Creating Components
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1.  

2.  

1.  
2.  

Creating Components
   

Use the different tools in Ignition such as components, shapes, images, Symbol Factory graphics, and 
Scalable Vector Graphics (SVGs) to create the components.

There are two primary methods for creating components:

Select the component in the palette, and then use the mouse to draw a rectangle in a 
container. While a component is selected in a palette, the mouse curser will be a crosshair (+) 
when hovering over a container that the component can be dropped in. Draw a rectangle in the 
container to specify where the component should be placed and what size it should be.
Drag a component's icon from a palette onto a container. The component will be placed where 
you dropped it at its default size. It can then be resized.
 

Creating 
Components

Watch the Video

Choosing the Component Palette

There are two styles of component palette in Ignition Vision: the tabbed palette and the collapsible palette. These palettes work in the same way, but 
the tabbed palette is meant to dock to the north or south edge of the  , and the collapsible palette is meant to dock to the east or west workspace

edge. By default, the tabbed palette is visible in the window workspace. To switch palettes, navigate to the   menu, and select the View > Panels Tabbe
 or the  .d Palette Collapsible Palette

Creating a Custom Palettes

Custom palettes are like expanded copy/paste clipboards. You can put customized components or groups of components into a palette for quick 
access.

To create a custom palette, right-click on a tab in the tabbed palette or a header in the collapsible palette, and choose New Custom Palette. Your 

custom palette will appear as the last palette. Your custom palette has one special button in it, the capture button ( ). To add components to 
your palette, select them and press the capture button. This effectively does a copy, and stores the captured components as a new item in the 
clipboard. You can then use that item much like a normal component, and add multiple copies of it to your windows. 

Note that these are simple copies, and are not linked back to the custom palette. Re-capturing that palette item will not update all uses of that item 
across your windows.

Creating Components using Tags

Components can also be created by simply dragging a tag onto a container. Depending on the datatype of the tag, you will get a popup menu 
prompting you to select an appropriate type of component to display or control that tag.

For example, suppose you have an Int4 type tag, if you drag the tag from the Tag Browser panel onto a component, you will be prompted either to 
display or control the tag with a variety of labels, level indicators, numeric entry fields, and control buttons.

This technique is great for beginners and for rapid application design. By dropping a tag into a container and choosing a component type, a few steps 
are happening:

The component that you chose is created at the position you dropped it.
A variety of property bindings are created automatically. 

The bindings depend on what kind of tag was dropped and what kind of component was created. For example, lets suppose you have a Float8 point 
that represents a setpoint, and you want to set it. Drop the tag onto a container and choose to control it with a Numeric Text Field. The following 
bindings will be set up automatically:

The text field's   property gets a bidirectional tag binding to the tag's  property.doubleValue Value 
The text field's   and   properties get tag bindings to the tag's   and   properties, respectively.minimum maximum EngLow EngHigh
The text field's   property gets a tag binding to the tag's  property. decimalFormat FormatString 
The text field's   property gets a tag binding to the tag's   property.toolTipText Tooltip

It is important to realize that multiple property bindings are created when creating components this way. These bindings not only using the tag's value, 
but much of the tag's metadata as well. Using the tags metadata in this way can greatly improve a project's maintainability. For example, if you 
decide that the setpoint needs 3 decimal places of precision, you can simply alter the tag's  to be  , and anywhere you used FormatString  #,##0.000
that tag will start displaying the correct precision because of the metadata bindings.

See also:  , Property Binding Tag Metadata Properties

Creating Components using Shapes
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All of the shapes that you can draw using the shape tools are themselves components. As such, they have properties, event handlers, names, layout 
constraints, and all of the other things that you'll find on other components. They also have some things that normal components don't.

Binding Shape Position

One such thing that shapes have that normal components don't is a set of properties that control their location. These properties are called relX, relY, 
relHeight, and relWidth. The "rel" prefix stands for "relative". This comes from the fact that the values of these properties are always treated as relative 
to the shape's parent container's width and height, even in a running Client where that container may be a wildly different size due to the layout 
mechanism.

For example, let's say that you have a shape that is located at x=100, y=100, and was 125 by 125 inside a container that is 500 by 500. If you want to 
animate that shape so that it moves back and forth across the screen, you'd set up a binding so that relX changed from 0 to 375. (You want X to 
max out at 375 so that the right-edge of the 125px wide shape aligns with the right edge of the 500px
container).

Now, at runtime, that container might be 1000 by 1000 on a user's large monitor. By binding relX to go between 0 and 375, the true X value of your 
shape (whose width will now be 250px due to the relative layout system), will correctly move between 0 and 1750, giving you the same effect that 
you planned for in the Designer.

Long story short, using the rel* properties let you animate the shape using bindings and not worry about the details of the layout system and how 
they'll resize the coordinates at runtime.

Binding Rotation

Another ability unique to shapes is the ability to be rotated. Simply click on a selected shape and the resize controls become rotate controls. There's 
even a rotation property that can be edited directly or bound to something dynamic like a tag.

Because of this effect, if you wish to both dynamically rotate and move a component, special care must be taken since rotation alters the position. You 
don't want your position binding and the rotation binding both fighting over the position of the component. The way to both rotate and move a shape is 
as follows:

Bind the rotation on your shape as you wish.
 
Create a shape (for example, a rectangle) that completely encloses (in other words, it's bigger than) your shape at any rotation angle.
 
Set that rectangle's visible property to false.
 
Select your shape and the rectangle and group them.
 
Bind the position on the resulting group.

If you follow these steps you can animate both the rotation and position of a shape.

 

 

Binding the rotation comes with one big warning: observe that when you change a shape's rotation, its position also changes. The position 
of any shape is the top-leftmost corner of the rectangle that completely encloses the shape.
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Scalable Vector Graphics (SVGs)
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Scalable Vector Graphics (SVGs)
 

Ignition can import SVGs (Scalable Vector Graphic) into a window. Once imported, SVGs can be 
modified and styled. To use an SVG in your project, simply drag the SVG file directly onto the window 
you want the SVG to appear on. The SVG becomes a new polygon component on the window.

Sometime the way the SVG imports may result in the SVG appearing very small, in which case you can 
manually expand the SVG to your desired size.

Using the Symbol Factory

If you have the Symbol Factory module installed, you've got nearly 4,000 industrial symbols at 
your fingertips to use in your projects.

To open the Symbol Factory Browser

Launch the Designer and open your project.

Choose   under the   menu or the project navigation tree.Symbol Factory Tools
If you can't find these, the Symbol Factory module probably isn't installed.
The Symbol Factory browser opens as a pop-up window that stays on top of the Designer. 

Browse the different categories to explore what symbols are available, or search to find a 
specific symbol.

Find a symbol that you'd like to use and drag it onto an open Vision window. 
The symbol will become a group of shapes. Just like any group, you can double-click it to get to 
the shapes inside, or simply un-group it. This way you can edit the symbol if you need to. 

 If the Symbol Factory module is in trial mode, you'll only be able to use the first Note:
symbol from each category.

Scalable Vector 
Graphics (SVGs)

Watch the Video

 

 

Next ...

Images (png, jpg, gif)

 

Some SVGs make use of additional effects , such as Gaussian blurs. These SVGs are not 
supported, and can not be imported.

https://inductiveuniversity.com/video/scalable-vector-graphics/7.8
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Images (png, jpg, gif)
 

Images such as PNGs, JPGs, or GIFs can be imported and used inside of windows in Ignition.

To use an image on a window

Drag an  component onto the window.Image
 
In the image component's  property, click on the icon.Image Path Browse 
 
From the , find an image file you want and double-click on it to display it in your Image Browser
window.
The path to the image is now displayed in the components  property.Image Path

Image Manager

In addition to the method described above, you can also import images using the   Manager Image

available from the  menu. Tools >   ManagementImage

Exporting and Importing Projects

When the project is exported, the images are not included only the path associated with the Image Path 
property of the image component is. When you import the project into a different Ignition server, the file 
paths associated with the image components will not have any images to display. It is possible to export 
the images to a local disk that can accompany the project. The export function is located on any Browse 
icon associated with Image Path properties.

Images (png, jpg, 
gif)

Watch the Video

 

 

 

Next ...

Selecting Components

 

Ignition does not support bitmap files.

https://www.inductiveuniversity.com/video/images-png-jpg-gif/7.8


Selecting Components
 

There are a number of different ways to select components within a window, each of which have 
their own advantages.

Mouse Selection

Using the mouse is the most common way to select components. Make sure that the selection tool ( ) 
is the active tool. Simply click on a component to select it. If the component you want to select 
is obscured by other components, hold-down  and keep clicking, the selection will step down Alt
through the z-order. 

You can also select components using window-selection. Click-and-drag in a container to draw 
a selection rectangle. If you drag the window left-to-right, it will select all components that are 
contained within the rectangle. If you drag the window right-to-left, it uses window-crossing selection. 
This will select all components that are contained within the rectangle or intersect the edge of the 
rectangle. Lastly, you can start dragging a window selection and then hold-down the  key to use touch Alt
selection. This will draw a line as you drag, and any components that the line touches will 
become selected. As you're using these techniques, components that are about to become selected will 
be given a yellow highlight border.

Tree Selection

By selecting nodes in the  tree you can manipulate the current selection. This is Project Browser
a handy way to select the current window itself, which is hard to click on since it is behind the 
Root container. However, you can click to it, using  to step down through the z-order. It is also Alt-click
the only way to select components that are invisible.

Selecting 
Components

Watch the Video

 

 

 

 

 

Next ...

Manipulating Components
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Manipulating Components
 

Manipulating components can be done with both the mouse and the keyboard. You can move 
components around, resize them, and rotate them.

Resizing

When you select the component you want to resize, they'll get 8 resize-handles displayed around the 
edge of the selection. These handles look like double-sided arrows around the perimeter. Use the mouse 
to drag them to change the size of the components in the selection. To maintain the selection's aspect 
ratio, hold down   as you resize. To resize around the center of the current selection, hold down  .Ctrl Shift

You can also resize the current selection using the keyboard. To nudge the right or bottom edge of 
the selection in or out, use   combined with the arrow keys. To nudge the top or left edge of Shift
the selection, use   combined with arrow keys. These nudge actions will resize one pixel at Ctrl-Shift
a time. To resize faster, add the   key.Alt

Moving

To move the component, simply drag it anywhere within the component's bounds. You can also 
move whatever is currently selected by holding down   while dragging, regardless of whether or not Alt
the mouse is over the current selection. This is important because it is the primary way to move 
a Container component. (Normally, dragging in a container draws a selection rectangle inside 
that container).

While a component is selected, you may also use the keyboard's arrow keys to move a 
component around. The arrow keys will move the selection one pixel at a time. Just like resizing with the 
arrow keys, to move faster, add the   key. Components can be easily duplicated by dragging them as if Alt
you were going to move them and holding down the   key. This will drop a copy of the component at Ctrl
the desired drop location. It is often useful to also hold down Shift as you do this to ensure exact 
alignment. You may also use the   shortcut to quickly duplicate a component in place.Ctrl-D

Rotating

Shapes can be rotated directly using the selection tool. Other components cannot be rotated in 
this manner. To rotate a shape, first select it using the selection tool so that you see the resize 
handles around it. Then simply click on it once again and you'll see the rotation handles appear. Clicking 
(but not double-clicking) on selected shapes toggles back and forth between the resize handles and 
the rotation handles.

Once you see the rotation handles, simply start dragging one to rotate the shape or shapes. 
Holding down the   key will snap your rotation movements to 15° increments. When the rotation Ctrl
handles are present, there is also a small crosshair handle that starts in the middle of the selection. This 
is the rotation anchor: the point that the selection will rotate around. You can drag it anywhere you'd 
like to rotate around a point other than the center of the shape.

Manipulating 
Components

Watch the Video
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Component Properties
Each component has a unique set of properties. A property is simply a named variable with a distinct 
type that affects something about the component's behavior or appearance. Hover your mouse over the 
property in the  panel to see its  and scripting name.Property Editor data type

The Property Editor

The  is a dockable panel that appears in the Designer's , usually under Property Editor central workspace
the  . It displays the properties of the selected component. If more than one Tag Browser component is 
selected, it will show all properties that the current selection set have in common.

Component 
Properties

Watch the Video

Filters

It is common for components to have many properties, so by default, the Property Editor only shows the basic properties. These are the properties 
that you'll most commonly want to set or bind for a given component. There are also the standard properties. This is a larger set of properties that 
includes the basic properties and many other useful properties. Some properties are expert properties. These are properties that are either uncommon 
to set or whose purpose might require an in-depth understanding of the inner-workings of the component. You can change the filter using the   buttfilter

on ( ) in the  's toolbar.Property Editor

Status Indication

The name of a property in the   conveys important information about that property:Property Editor

A   indicates that the property is blue name a  property.custom 
 

A   with a link icon   indicates that the property is bound usinbold name g a  .property binding
 

A   with a color palette icon   indicates that the property is being affected by the  settings.bold name component styles
 

A   name with   a warning icon indicates that the property is double-bound. This means that two things, a property binding and the red bold
styles settings are both trying to drive the property value. This is almost assuredly a mistake.

The Binding Button

To the right of most properties is the binding button ( ). Use this button to modify the property binding that is driving that property. You can only use 
this button when the window workspace is not in preview mode. Some properties cannot be bound because their datatype is not supported by 
the binding system. You can still use scripting to affect these properties.

Data Types

There is a wide variety of datatypes across all of the Vision Module's components. Each property has a distinct type. Here are the most common types 
that you'll find on the .Property Editor

Numeric Types

Boolea
n

A true/false value. Modeled as 0/1 in Python. Technically, 0 is false and anything else is true.

Short A 16-bit signed integer. Can hold values between -215 and 215-1. Thats -32,768 to 32,767, inclusive.

Intege
r/int

A 32-bit signed integer. Can hold values between -231 and 231-1. Thats -2,147,483,648 to 2,147,483,647 inclusive.

Long A 64-bit signed integer. Can hold values between -263 and 263-1. Thats -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807 
inclusive.

Float A 32-bit signed floating point number in IEEE 754 format.

Double A 64-bit signed floating point number in IEEE 754 format.

Non-Numeric Types

String A string of characters. Uses UTF-16 format internally to represent the characters.

https://www.inductiveuniversity.com/video/custom-properties/7.8


Color A color, in the RGBA color space. Colors can easily be made dynamic or animated using Property Bindings or Styles.

Date Represents a point it time with millisecond precision. Internally stored as the number of milliseconds that have passed since the "epoch", 
Jan 1st 1970, 00:00:00 UTC.

Datase
t

A complex data structure that closely mimics the structure of a database table. A Dataset is a two-dimensional matrix (also known as, a 
table) of data organized in columns and rows. Each column has a name and a datatype.

Font A typeface. Each typeface has a name, size, and style.

Border A component border is a visual decoration around the component's edges. You can make a border dynamic by using , the Styles toBorde
expression function, or Java scripting. r()

See also: Working with Different Datatypes  

 

Common Properties

Every component has properties arranged into groups based on what his has available. IE: Common, Data, Appearance, etc. Each component has 
a different list of properties to effect how it behaves, but every component has the  group or properties at the top. Note: When you first open Common
the designer, the property editor is set to only show basic properties. To see all of them, change the property filter to .All

These  properties will behave the same for all components. Here's a list for each property and when it might be used.Common

 

Name

The name of the component. This string is used to identify your components in the Project Browser. This is especially important for Bindings and 
Scripting. Binding is allowed on this property but it is recommended to  Binding it can break your scripts, bindings, and never bind this property.
cause errors.

Enabled

This Boolean controls whether a component can be interacted with. Most commonly used with data entry components to allow the user to see the 
value but not change it.

Visible

This Boolean controls whether the component is shown on the window. You can bind this property to show/hide the component based on any logic 
you want. IE: security, process step, etc.

What is the difference between Integer vs. Int?

The difference is that an Integer property will accept the special null (or None in Python-speak) value, while an int property will not. This 
distinction holds true for all of the numeric types: the type name that starts with a capital letter accepts null, while the all-lowercase version 
does not.

Expert Tip!

Most of these datatypes are actually defined by Java. For example, the  datatype is really an instance of a . This means Date java.util.Date
that you can use the  class to manipulate them, and the  class to format and parse them.  java.util.Calendar java.text.SimpleDateFormat
Learn more about these classes in the Java 2 Platform online documentation at http://java.sun.com/j2se/1.5.0/docs/api/index.html

https://legacy-docs.inductiveautomation.com/display/DOC/toBorder
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Border

The border that surrounds the component. There is a dropdown to select from a list of common borders, and a button to the right to manually edit a 
border from several different options with a second tab that shows Titled Borders. When binding this property, note that this is a complex data type. It 
is a Java   data type, not a string or an enumeration. The common ways to make this property dynamic are to bind it with an Expression binding Border
type or to set it through a script, but using the Expression binding is preferred. If you are using an Expression binding, you must use the  toBorder()
expression function to return the correct data type. If you are using a script, you need to make sure you use the Java  data type. See the Border Java 

 for more information on setting a border through scripting.documentation

Mouseover Text

The text that is displayed when a user moves the mouse over the component. This string is commonly used to provide your operators more 
information about an object. IE: showing the PLC address of an on-screen value, or telling the operator exactly what will happen when a button is 
pressed.

Cursor

The mouse pointer image to use when the operator moves the mouse over the component. This int property is an enumeration of a list. That is; a 
value of 0 gives the first option ('default'), 1 is the second, and so on. Selecting 'default' means the operating system decides what pointer to use. 

 

Next ...

Custom Properties
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Custom Properties
 

You can add your own custom properties to the basic component properties in Ignition. Think of these 
custom properties as your own variables in the window. The custom properties are extremely useful as 
they let you turn a "plain" component into one customized for your particular use.

Ignition provides a number of   to configure components in ways that are too complex or Customizers
cumbersome for basic properties. In this page, the  and the Customizers > Custom Properties Customi

 are described. These two Customizers are used repeatedly for many different zers > Styles Customizer
components. But there are other Customizers that are unique for a specific component, such as the Easy 

.Chart Customizer

Root Container Custom Properties

Properties on the window's Root Container are special in that they double as a window's parameters. For 
more information, see .Parameterized Popup Windows  

Custom Properties

Watch the Video

   

Configuring Custom Properties

You can use the custom properties like any other properties - with data binding, scripting, styles, and so on.

To configure the custom property

Right-click on a component and go to . Customizer > Custom Properties
The Custom Properties window is displayed.
 
Click the  icon to add text boxes to the table.green +
 
Add a , , and  for each custom property you want to add.Name Type Description
 
Click . OK
Notice the custom properties you added are displayed in the   in Property Editor blue.

 

Configuring the Style Customizer

Many components support the  which lets you define a set of visual styles that change based on a single . Style Customizer Driving Property
Typically, you'll have a property (often a custom property) on your component that you want to use as a driving property, usually a discrete state, and 
you have multiple visual properties, like the font, border, foreground color, visibility, and so on that you want to change based on that one driving 
property. Style Customizer lets you define these relationships all at once, and lets you preview them too!

To configure the style using the Style Customizer

Right-click on a component and go to . Customizer > Style Customizer
The Style of Component window is displayed.
 
Choose a . Driving Property
This is the property whose value will determine the current style.
 
Choose one or more . Styled Properties
These are the properties that will change as the style changes.
 
Add the values of the driving property that define the styles.
For example, 0=off, 1=hand, 2=auto.
 
Customize the values of the styled properties for each style.

Expert Tip

Often, a Customizer is really just a user-friendly user interface to one or more expert 
properties. For example, all the Easy Chart Customizer really does, is to modify the contents 
of the pens, tagPens, calcPens, axes, and subplots Dataset properties. Knowing this is very 
powerful, because this means you can also use Property Bindings and scripting to modify the 
values of these expert properties at runtime, giving you the ability to dynamically perform 
complex manipulations of components.

To add a custom property, right-click on the component and choose the Customizer menu, or 

use the Customizer split-button ( ) icon in the Vision main toolbar.

https://legacy-docs.inductiveautomation.com/display/DOC/Easy+Chart
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Example 1

Lets say that you have a   component that is displaying the level in a tank. Lets say that you want to have its appearance change based Level Indicator
on the alarm state of the tank's temperature. You can add an integer custom property, call it  , to the level indicator that you'll bind to the tank Severity
temperature tag's   property.AlertCurrentSeverity

Now go to the . Choose your property as the driving property, and the   and  properties as the styled Style customizer Severity Border Filled Color
properties. Add states for -1 (not in alarm), 2 (Medium alarm) and 4 (High alarm). Leave the -1 state alone. Use a red border for state 2 and an orange 
fill color. For state 4, you can animate it to get a flashing effect. Add two animation frames and set their delay to 500ms each. Configure the frames 
differently from each other so that you can get a flashing effect. Click  and notice that the styled properties you chose are now bold and have the OK

styles indicator (  ) next to them. This is to help remind you that those properties are being driven, so if you change their values directly, you 
changes will be overwritten.

Example 2

Let's look at another example that will use the Custom Properties and the Styles feature together. Take the lowly  component. It seems pretty Label 
plain at first - it just displays a String. Of course, you can use its foreground color, background color, and border to make it look interesting. Add an 
integer custom property on it and name it  , and bind that property to a discrete state tag coming out of a PLC. Now use the   property to drive state state
its Styles configuration to make the component look different and display different things based on the state being 0, 1, or 2 (maybe for a Hand/Off
/Auto indicator).

We could have used the from the very beginning, but understanding this example will let you create your own types of    component Multi-State Indicator
components by combining the existing components in creative ways.
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Component Grouping
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Component Grouping
 

Shapes and components can be grouped together so that they act like a single component in 
the Designer. Grouping components is very similar to putting them in a Container. In fact, it is the 
same thing as cutting and pasting them into a perfectly-sized container and then putting that container 
into group mode, with one exception. If the group contains only shapes and no other kinds of 
components, it will be a special shape-group that has the ability to be rotated and has some other shape-
like properties.

When components or shapes are in a group, clicking on them in the Designer will select the 
group instead of the shape. If you double-click on a group, it will become "super-selected", which will 
allow you to interact with its contents until you select something outside of that group. 

Layout also works differently for groups. The layout setting for components and shapes inside a group is 
ignored. All members of a group act as if they are in relative layout with no aspect ratio restrictions. This 
special group-layout mode is also active when resizing a group inside of the Designer, 
whereas traditional layout doesn't take effect in the Designer.

Groups can contain other groups, creating a nested structure. Groups themselves are also components, 
meaning that you can add custom properties to groups, bind them, and so on.

Component 
Grouping

Watch the Video
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Component Layout
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Component Layout
 

Layout is the concept that a component's size and position, relative to its parent container's size 
and position, can be dynamic. This allows the creation of windows that resize gracefully using either Anc

 or  layouts and can optionally keep the original aspect ratio. hored Relative

This is a very important concept because of the web-launched deployment of Vision clients - they often 
end up being launched on many different monitors with many different resolutions.

This is also important for components that have user-adjustable windows like popup windows. Imagine a 
popup window that is mostly displaying a large table or chart. If you're running on a large monitor, you 
may want to make the window bigger to see the table or chart easier. Of course, this is only useful if the 
table or chart actually gets larger with the window.

Changing a component's layout is as simple as right-clicking on the component and opening the Layout 
dialog box. You can also alter the default layout mode that gets assigned to new components. See Desig

.ner/Window Editing Properties

 

Component Layout

Watch the Video

Relative vs Anchored Layout

There are two layout modes, and they are set on a per-component basis. Both affect the component's size and position relative to its parent container. 
The root container's size is dictated by the window size. To edit the layout of a component, right-click on the component and select   from the Layout
menu. the Layout Constraints window displays showing all the default settings. These default settings can be altered in the Project Properties.

Layout Modes

Relative
This mode makes a component's size and location relative to its parent's size and location. When the parent changes size, the component 
changes accordingly. This creates components that auto-scale.
 
Anchored
This mode makes the edge of a component's two axes (horizontal and vertical) anchored to the edge or edges of its parent.

Relative Layout

Relative layout is the default mode. This is a simple and effective layout mode that simply keeps a component's size and position constant relative to 
its parent container, even when the parent container grows or shrinks. More precisely, it remembers the component's position and size as a 
percentage of its parent's bounds at the last time the window was saved. Relative layout also has the option of scaling a component's font 
appropriately.

https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Designer/WindowEditingProperties
https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Designer/WindowEditingProperties
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Note that relative layout mode respects aspect ratio. So if the parent component is distorted, the contents will not be. The extra space is distributed 
evenly on both sides of the contents.

Relative Layout Options

Maintain Aspect Ratio
If selected, the component's original aspect ratio is preserved. Otherwise, it can stretch tall or wide.
 
Center
When maintaining the aspect ratio, centers the component with respect to its parent.
 
Leading
When maintaining the aspect ratio, aligns the component with the paper leading edge.
 
Trailing
When maintaining the aspect ratio, aligns the component with the parent's trailing edge.
 
Scale Font
If selected, the component's font will scale along with its size as the relative layout adjusts the component. This will override other font size 
settings. If this setting is applied to a Group, then all components in the group will use this setting.

Anchored Layout

Anchored layout lets you specify various "anchors" for the component. The anchors dictate how far each of the 4 edges of the component stay from 
their corresponding edges in the parent container. For example, if you anchor top and left, then your component will stay a constant distance from top 
and left edges of its parent. Since you didn't specify an anchor for the right or bottom sides, they won't be affected by the layout.



If you anchor bottom and right instead, the components will again stay the same size (since you didn't specify an anchor for their other edges, but they 
will stay a constant distance from their parent's right and bottom edges.

Anchored Layout Options

North/South
If one of these is selected, the distance between that edge of the component and that edge of the container is preserved. If both are selected, 
the component will stretch its  to maintain both distances.height
 
West/East
If one of these is selected, the distance between that edge of the component and that edge of the container is preserved. If both are selected, 
the component will stretch its  to maintain both distances.width
 
Center Vertically
When selected, both top and bottom buttons will be deselected. This option maintains the height of the component and centers it  in vertically
the container.
 
Center Horizontally
When selected, both left and right buttons will be deselected. This option maintains the width of the component and centers it  in horizontally
the container.

 

Of course, you can mix and match the various modes for the different components in a given container. The following image shows the following:

The   uses a horizontal and vertical centering anchor. It is centered, and stays the same size.square
The   is anchored south and west.triangle
The   is anchored north, west, south, and east. This means that its edges are all anchored and stay a fixed distance to each of its circle
parent's edges, so it grows.



Client Minimum Size

Clients can define a minimum size, because even with dynamic layout, you usually don't want the client to get too small. This is because it would 
become unusable and unreadable. This is what the Minimum Size property is for. By default it is set to 800x600, but you can adjust it. For more 
information, see  .Client/User Interface Properties

 

 

Next ...

Multi-Line Labels and Buttons
Template - Resizing and Enable Layout
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Multi-Line Labels and Buttons
Labels and Button's have single lines of text by default. If the text of the label or button exceeds the 
space the component has made available, the component cuts the text off and trails it with three dots.

You can use HTML to format the text to have line wrapping for a long line of text, and to insert a line 
break any place inside a text to have multiple lines of text.

To auto line wrap the text

Select the component that needs the automatic line wrapping.
 
Select the component's Text property.
 
Insert  before the start of the text and press enter.<html>

To insert a line break inside the text

Select the component that needs the line break.
 
Select the component's Text property.
 
Insert  before the start of the text.<html>
 
Select the part of the text that you want to see the break occur and type  in this location <br>
and press enter.

Multi-Line Labels 
and Buttons

Watch the Video
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Adding Icons to Labels and Buttons
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Adding Icons to Labels and Buttons
Most components have an  property, which augments the text property of a component by Image Path
placing an image next to it. The image can be an icon that is included with Ignition or an image such as a 
.jpeg or .png file.

The location of the image in relationship to the component's text is configured in the component's layout 
section of its Property Editor.

Adding an Icon to a Label

Create an Label on your window.
 
Go to the component's Property Editor and select the folder icon from the Text property.
 
From the resulting popup, navigate to the icon of your choice and double-click it using your 
mouse.

The component's Horizontal Text Position and Vertical Text Position properties will change the location 
of the icon in relationship to the text.

Adding Icons to 
Labels and Buttons

Watch the Video
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HTML in Ignition

 

https://inductiveuniversity.com/video/adding-icons-to-labels-and-buttons/7.8


1.  

2.  

1.  

2.  

HTML in Ignition
 

Many Ignition components display a text string. By default, a component's text is displayed in a single 
font and color and will not wrap when its content exceed the space the component has made available to 
the text.

HTML stands for HyperText Markup Language. It is commonly used to style text within webpages. The 
features that HTML brings to style web pages can be applied to many components within Ignition to style 
the text within components.

You can use HTML if you want to mix fonts or colors within the text or if you want formatting such as 
multiple lines. HTML formatting can be used in Ignition components such as buttons, labels, and tables. It 
can be used in common properties such as the mouse over text property.

To specify that a component's text has HTML formatting, just put the   element at the beginning of <html>
the text, then use any valid HTML element in the remainder.

HTML in Ignition

Watch the Video

   

Common HTML Elements

HTML tags are the special characters that instruct text to become stylized differently than other text within the same text. The following table describes 
the most common HTML elements that you can use within Ignition.

HTML Element Name Description

<html>...</html>   Initiates an html formatting. In most cases closing the html with </html> is optional.

<b>...</b> Bold Applies a bold style to the contents of these elements.

<br> Break Applies a line break at this specific location.

<li>...</li> List Item Used to represent a list item. Should be contained in an order list (<ol>) or unordered list (<ul>).

<ol>...</ol> Ordered List Places the text into an ordered list. Text inside list items are ordered by number.

<ul>...</ul> Unordered List Places the text into an unordered list. Text inside list items are ordered by bullets.

<u>...</u> Underline Underlines the text contained within the elements.

<center> Center Centers the contents of the text. Used directly after the HTML tag (that is, <html><center>...)

<font color="red">...</font> Font Colors the contents red. Works with standard color names, hex numbers, or RGB numbers.

 

Applying HTML to Components

In Ignition, you can add HTML to the text property of any component such as, a label, button, or table.

Adding HTML into a Label

Suppose you want to make a label appear like this: This is a  wordbold

Create a label on your window.
 
Select the label's text property and enter the following text: <html><b>This is a <b>bold</b> word

Adding HTML into a Button

Suppose you want to make a button appear with the following words: S  Processtop the . 

The word "Process" starts on a new line. Also, the words must be centered on the button.

Create a button on your window.
 
Select the buttons text property and enter the following text: <html><center>Stop the <br><font color="red">Process</font>

Closing the HTML element is optional. In other words there is no need to place a </html> at 
the end of your stylized text.

Also, the HTML elements are not case sensitive.

https://inductiveuniversity.com/video/html-in-ignition/7.8
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Adding HTML into a Component's Mouseover Text Property

The mouse over text property creates a popup when the user places their mouse over the component for an extended period of time. The mouse over 
text is an excellent way of giving the user additional information. The mouse over text property also handles HTML formatting.

Suppose you want a list of instructions to appear in the mouse over text of a component as the following:

These are the instructions:

Stop this process.
Check on this.
Remove that.

To create this type of mouse over text, do the following:

Create or choose a component on your window.
 

Select the components mouse over text property and select the property's text editor icon ( ) to edit the text. 

 
Enter the following text: 
 

<html>
These are the instructions:
<ol>
<li>Stop the process.</li>
<li>Check on this.</li>
<li>Remove that.</li>
</ol>

Adding HTML into a table

The contents of a table will render HTML formatting. The HTML formatting has to be part of the specific cell. If you want to have HTML formatting 
affect all rows of the data then it will be necessary to concatenate the HTML markup into the source of the data that is populating the table.

Suppose that you wanted to edit a cell of a table in order to render its contents with HTML formatting. Simply access the table's underlying data and 
enter the HTML formatting into the cell that you would like to format. The same techniques used for HTML formatting throughout Ignition apply to the 
cells of a table as well.

 

 

 

Next ...

Component Data Types

 

Note that this technique allows you to format the text across multiple lines. Line breaks do not occur unless they are explicitly 
declared with the <br> element or the component wraps the contents because of the lack of space for its contents.



Component Data Types
 

There is a wide variety of   across all of the Vision Module's components. Here are the most common types that you'll find.datatypes

 

Numeric Types

 

Boolean A  /  value. Modeled as  /  in Python. Technically,   is  and anything else is  .true false 0 1 0 false true

Short A 16-bit signed integer. Can hold values between -2  and 2 -1.15 15

Thats -32,768 to 32,767, inclusive

Integer / int A 32-bit signed integer. Can hold values between -2  and 2 -1.31 31

Thats -2,147,483,648 to 2,147,483,647 inclusive

Long A 64-bit signed integer. Can hold values between -2  and 2 -1.63 63

Thats -9,223,372,036,854,775,808 to 9,223,372,036,854,775,807 inclusive

Float A 32-bit signed floating point number in IEEE 754 format.

Double A 64-bit signed floating point number in IEEE 754 format.

 

 

Non-Numeric Types

 

Stri
ng

A string of characters. Uses UTF-16 format internally to represent the characters.

Col
or

A color, in the RGBA color space. Colors can easily be made dynamic or animated using Property Bindings or Styles

Date Represents a point it time with millisecond precision. Internally stored as the number of milliseconds that have passed since the " ", epoch
Jan 1st 1970, 00:00:00 UTC.

Dat
aset

A complex datastructure that closely mimics the structure of a database table. A Dataset is a two-dimensional matrix (a.k.a. a table) of 
data organized in columns and rows. Each column has a name and a datatype.

Font A typeface. Each typeface has a name, size, and style.

Bor
der

A component border is a visual decoration around the component's edges. You can make a border dynamic by using Styles or the 
toBorder expression.

 

  The difference is that an   property will accept the special   (or   in Python-speak) value, Whats the difference: Integer vs int?  Integer null None
while an   property will not. This distinction holds true for all of the numeric types: the type name that starts with a capital letter accepts null, while int
the all-lowercase version does not.

 

   Most of these   are actually defined by Java. For example, the Date datatype is really an instance of a . This Expert Tip: datatypes  java.util.Date
means that you can use the  class to manipulate them, and the  class to format and parse them. Learn  java.util.Calendar  java.text.SimpleDateFormat
more about these classes in the Java 2 Platform online documentation at http://java.sun.com/j2se/1.5.0/docs/api/index.html

 

See also:

Working with Different Datatypes
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Drawing Tools
   

The drawing tools are provided so you can create your own shapes such as lines, rectangles, and circles. These shapes are components with their 
own set of properties.

   

   

In this section ...  

   



Drawing Tools Overview
 

Shapes or graphics such as lines, rectangles, and circles can be created using the 2D drawing tools in 
Ignition. All SVG (Scalable Vector Graphics) images are importable in ignition.

Shape Tools

Shapes such as lines, rectangles and circles are created using the shape tools. By default the 
shape toolbar appears alongside the right-hand edge of the Designer window, but you can drag it to 
wherever you prefer. There are a number of tools here for your use, and each one makes the window 
editing workspace act differently when active.

Shape tools allow you to create various shapes as well as edit them after they are created. Click on the 
tool's icon to make it the active tool. You can also double-click on a shape to change to that shape's 
native tool.  When a shape tool is active, a toolbar will appear that has specific actions and settings for 
that tool.

After a shape is created, you can change its fill color, stroke color, and stroke style. See   foFill and Stroke
r more information. All shapes can be treated as paths and be used with composite geometry functions to 
alter or create other shapes. For more information, see  and .Bezier Curves Editing Shape Paths
 

Drawing Tools 
Overview

Watch the Video

Selection Tool

Normally the selection tool ( ) is active. When this tool is active, you can select shapes and components. Selected components can be moved, 
resized, and rotated. For more on using the selection tool to manipulate components and shapes, see  .Manipulating Components

Rectangle Tool

The rectangle tool ( ) creates and edits rectangle shapes. To create a rectangle, select the tool and drag inside a window to create a new rectangle. 
Hold down  to make it a perfect square. Once a rectangle is created, you can use the square handles to change the rectangle's height and width. Ctrl
This is important because it is the only way to resize a rotated rectangle and let it remain a rectangle. If you resize a non-orthogonally rotated 
rectangle using the selection tool, it will skew and become a parallelogram, but if you double-click on it so that the rectangle tool is active, you can 
change the rectangle's width and height using the tool-specific handles.

There are also small circle handles that allow you to alter the rectangle's corner rounding radius. Simply drag the circle down the side of the selected 
rectangle to make it a rounded rectangle. Hold down control to drag each rounding handle independently if you want non-symmetric corner 

rounding. You can use the   button in the rectangle tool's toolbar ( ) to return a rounded rectangle to be a standard, straight-corner Make Straight
rectangle.

Ellipse Tool

The ellipse tool ( ) creates and edits circles and ellipses. It is used in much the same way as the rectangle tool. While it is the active tool, you can 
drag inside a window to create a new ellipse. Hold down   to make it a perfect circle. When an ellipse is selected, use the width and height Ctrl
handles to alter the shape.

Polygon / Star Tool

The polygon tool ( ) is used to create polygons and stars. Use the toolbar that becomes visible when this tool is active to alter the settings of the 
shape that is created when you drag to create a polygon.
This tool can be used to make any polygon with 3 corners (a triangle) or more. Once created, you can use the center square handle to move the 
polygon around, and the diamond handles to alter the size and angle of the polygon. Hold down   to keep the polygon's rotation an even multiple of Ctrl
15°.

Arrow Tool

The arrow tool ( ) is used to create single or double-sided arrow shapes. When it is active, simply drag to create a new arrow. Use the checkbox on 
the toolbar to choose a single or double-sided arrow. To alter the arrow, use the diamond handles to change the two ends of the arrow, and the 
circle handles to change the size of the shaft and the head. When changing the arrow's direction, you may hold down   to snap the arrow to 15° Ctrl
increments. 

Pencil Tool

The pencil tool ( ) is used to draw freehand lines and shapes. When this tool is selected, you can draw directly on a window by holding down the 
mouse button. Release the mouse button to end the path. If you stop drawing inside the small square that is placed at the shape's origin, then you 
will create a closed path, otherwise you'll create an open path (line).

https://www.inductiveuniversity.com/video/drawing-tools-overview/7.8


On the pencil tool's toolbar, there are options for simplification and smoothing, as well as a toggle between creating straight line segments or curved 
line segments. The simplification parameter is a size in pixels that will be used to decrease the number of points used when creating the line. 
Points will be in general as far apart as this setting. If you find the line isn't accurate enough, decrease this setting. If you choose to create curved 
segments, then the segments between points will be Bézier curves instead of straight lines. The smoothing function controls how curvy these 
segments are allowed to get.

Line Tool

The line tool ( ) can be used to draw lines, arbitrary polygons, or curved paths. Unlike all of the other tools, you don't drag to create new paths with 
the line tool. Instead, you click for each vertex you'd like to add to your path.

To draw a straight line, simply click once where you want the line to start, and double-click where you want the line to end. To make a multi-vertex 
path, click for each vertex and then double-click, press enter, or make a vertex inside the origin box to end the path. 

As you draw the line, "locked-in" sections are drawn in green and the next segment is drawn in red. Hold down   at any time to snap the next Ctrl
segment to 15° increments. 

On the line tool's toolbar, you can choose between three modes:

normal line mode
perpendicular mode
curve mode

Perpendicular mode is just like line mode except that each segment is restricted to either horizontal or vertical. Curve mode will create a Bézier curve 
path by attempting to draw a smooth curve between the previous two vertices and the new vertex.

Path Tool

All shapes and paths can be edited directly by using the path tool. This tool lets you directly modify the nodes in the path, adding new nodes, removing 
nodes, and toggling segments between straight or curved. Learn more about paths in the Geometry and Paths section.

Gradient Tool

The gradient tool is used to affect the orientation and extent of any gradient paints. Learn more about gradients in the Fill and Stroke section.

Eyedropper Tool

The eyedropper tool is used to set the selected shape(s) and/or component(s) foreground/background or stroke/fill colors by pulling the colors from 
somewhere else in the window. When this tool is active, left-click to set the selection's fill or background, and right-click to set the selection's stroke 
or foreground. Note that this tool works on most components as well as shapes. For example, right clicking will set the font color on a Button, or left-
clicking will set the background color.

 

 

Next ...

Drawing a Line

 



Drawing a Line
 

The line tool ( ) lets you create shapes and graphics by drawing lines, arbitrary polygons, or curved 
paths. Unlike all of the other tools, you don't drag to create new paths with the line tool. Instead, you click 
for each vertex you'd like to add to your path.

To draw a straight line, simply click once where you want the line to start, and double-click where you 
want the line to end. To make a multi-vertex path, click for each vertex and then double-click, press 
enter, or make a vertex inside the origin box to end the path. 

As you draw the line, "locked-in" sections are drawn in green and the next segment is drawn in red. Hold 
down   at any time to snap the next segment to 15° increments. Ctrl

On the line tool's toolbar, you can choose between three modes:

normal line mode
perpendicular mode
curve mode

Perpendicular mode is just like line mode except that each segment is restricted to either horizontal or 
vertical. Curve mode will create a Bézier curve path by attempting to draw a smooth curve between the 
previous two vertices and the new vertex.

Drawing a Line

Watch the Video
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Fill and Stroke
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Fill and Stroke
 

All shapes have three properties that affect how they look: Fill Paint, Stroke Paint, and Stroke Style. 

Fill Paint is a property of type  that represents the interior color of the shape.Paint 
Stroke Paint property (also a  ) represents the color of the shape's outline.Paint
Stoke Style property is a property of type   that affects the thickness, corners, and dash Stroke
properties of the shape's outline.

Fill and Stroke

Watch the Video

Editing Paints

Both the fill and stroke paints can be a variety of different kinds of paints. To edit a shape's fill or stroke paint, you can either use the paint dropdown in 

the property editor table by clicking on the  icon ( ) or open up the dedicated  panel from the  menu.pencil  Fill and Stroke View

Paint Types

The top of the paint editor is a selection area that allows you to choose between the five different kinds of paints.

The first paint type is no paint ( ). If used as a fill paint, then the interior of the shape will be transparent. If used as the stroke paint, then 
the paint's outline will not be drawn at.    

The second paint type is a solid color ( ). This paint type is equivalent to the Color type used elsewhere throughout the component library. 
A solid color is any color, including an alpha (transparency) level.
 

The third paint type is a linear gradient ( ). Linear gradients smoothly blend any number of colors along a straight line across the shape. 
Each color is called a Stop. Each stop is represented as a drag-able control on a horizontal preview of the gradient in the gradient editor. You 
can click on a stop to select it and change its color or drag it to reposition it. You can right-click on it to remove it. You can right-click on the 
preview strip to add new stops and change the gradient's cycle mode.
 

The fourth paint type is the radial gradient (  ). Radial paints are very much like linear paints except that the colors emanate from a point 
creating an ellipse of each hue. Radial paints are configured in the same way as linear paints.
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The fifth paint type is the pattern paint (  ). This paint uses a repeating pixel-pattern with 
two different colors. You can pick a pattern from the dropdown or create your own using the built-
in pattern editor.

 

Gradient Paint Bounds

The two gradient paints are more than a list of colored stops, they also need to be placed relative to the shape. The same gradient may look wildly 
different depending on how it is placed against the shape. By default, a linear gradient will run horizontally across the width of the entire shape, but 

this is readily changed. By switching to the Gradient Tool ( ), you can drag around handles that control how the gradient is applied.

Gradient Cycles

The two gradient paints (linear and radial) both have a cycle mode that you can change by right-clicking within the preview strip. The cycle modes are 
illustrated below:

No Cycle. The first and last stops are repeated forever after the edge of the paint bounds.

Reflect. Beyond the bounds of the paint, it will be reflected and drawn in reverse, and then reflected again, creating a smooth repetition.

Repeat. Beyond the bounds of the paint, it will be repeated forever.

Stroke Style

A shape's stroke paint is only half the story. The stroke style is also an important component of how an outline is drawn. Primarily the style controls the 
thickness of the line drawn, but it also can be used to create a dashed line. The setting for thickness is specified in pixels, and creating a dashed line 
is as easy as picking the style from the list. 

The effect of the thickness and dash pattern settings is fairly self-explanatory, but the other stroke settings are a bit more subtle. You can notice their 
effect more readily on thick lines.

Cap style is a setting that controls what happens at the end of a line segment. You can either have the line simply be terminated with no decoration 
(#1), round-off the end with a semi-circle (#2), or cap the end with a square (#3).

Join style is a setting that affects how a line is drawn where two segments meet (a corner). The default setting is called a miter join (#1), where the 
stroke is extended into a point to make a sharp corner. The other options are rounded corners (#2) or beveled edge corners (#3).



Miter style joins can become a problem for very sharp angles. With a sufficiently sharp angle, the miter decoration can become extremely long. To 
control this, there is a miter length setting to limit the length of a miter decoration. The illustration on the left shows the same miter join with two 
different miter length settings. The first drawing illustrates the length of the miter join.
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Gradients
 

Gradients smoothly blend any number of colors and can be positioned along a straight line or form an 
ellipse across the shape.

Gradients

Watch the Video
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Shape Geometry
     

Shape geometry allows you to apply functions such as a union (combine), difference (exclusion), and 
intersection (division) on multiple shapes to get the resulting shape that you want.

Creating and Editing Shapes Using Constructive Area Geometry

Editing paths directly can be a bit awkward. Using Constrictive Area Geometry is usually a much easier 
and more intuitive way to get the shape that you want. These functions are accessed from the meShape 
nu and operate when two (or more) shapes are selected. Note that the order that you select the shapes 
is important for many of these functions. Typically, the first shape you select is the shape you want to 
retain, and the second shape is the shape that you want to use as an "operator" on that first shape.

Union

The  function combines two or more paths into one. The resulting shape will cover the area union
that any of the shapes covered initially. The example shows how the union of a circle, rectangle, 
and triangle can be unioned together to create a basic pump symbol. Creating the symbol using 
this method took a few seconds, whereas attempting to draw this shape by hand using paths would 
be quite frustrating.

Difference

The  function can be thought of as using one shape as a "hole-punch" to remove a section difference
of another shape. The example shows how a zigzag shape drawn with the line tool can be used to 
punch a cutaway out of a basic tank shape. The level indicator is added behind the resulting shape to 
show how the area where the zigzag shape was is no longer part of the tank shape.

Intersection

The result of an  function will be the area only where where two shapes overlap. intersection
The example shows how the "top" of the tank in the difference example was easily made using 
two ellipses.

Exclusion

Shape Geometry

Watch the Video
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The  function, sometimes called X-OR, creates a shape that occupies the area covered exclusion
by exactly one of the source shapes, but not both.

 

Division

The  function divides or cuts one shape up along the outline of another shape.division
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Bezier Curves
 

 

   

A Bézier curve, also sometimes called a quadratic curve, is a type of curved line used in vector graphics 
that connects two points, allowing you to create smooth vector graphic shapes. A Bézier curve is 
configured using four points: the two end-points and two control points. The curve starts along the line 
between the an endpoint and the first control point, and then curves to smoothly meet the line between 
the second control point and the other endpoint.

 

Bezier Curves

Watch the Video
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Editing Shape Paths
 

Editing the paths of your vector graphic shapes is done by using the path tool ( ). Simply select any 
shape or line while the path tool is active to start editing it. If the shape is already a path, you can switch 
to the path tool by double-clicking on the shape. You can convert any shape into a general path by 

selecting the   ( ) function under the  menu. Shapes will also implicitly be turned into To Path Shape
paths if they are altered in a way not supported by the underlying shape. For example, if you stretch a 
rotated rectangle, thereby skewing it into a parallelogram, it will become a path automatically.

Each point on the path is represented by a diamond-shaped handle when the path editor is active. These 
handles can be dragged to move them around. They can also be selected by clicking on them or 
dragging a selection rectangle to select multiple points. This allows groups of points to be 
altered simultaneously. Bézier segments also have handles on their control points, represented by 
small circles with a line drawn back to an endpoint that can be dragged to change the curvature of 
the segment.

To change a segment between open, straight, and curved, simply use the toolbar functions that become 
visible when the path editor tool is active. Points can also be added and removed using the functions on 
the path editor toolbar. Filled shapes have two fill settings that control whether or not holes in the shape 
should be filled. To remove the fill entirely, simply set the fill paint property to .No Paint

Editing Shape Paths

Watch the Video

 

 

 

 

 

Next ...

Eyedropper Tool

 

When editing paths directly, it is often useful to be zoomed in on the path. Don't forget that 
you can zoom in on a location by holding down   and using your mouse wheel to zoom in ctrl
on a particular area without having to zoom in and then scroll. Also, if you press your mouse 
wheel in, you can pan around your window.

https://www.inductiveuniversity.com/video/editing-shape-paths/7.8


1.  

2.  

3.  

4.  

Eyedropper Tool
 

The  tool is used to set the selected vector graphic shape(s) and/or component(s) foregroundEyedropper
/background or stroke/fill colors by pulling the colors from somewhere else in the window.

To change the foreground/background color of a component

Select the object that you want to change.
 
Select the  tool from the group drawing tools on the far right of the Designer.Eyedropper
 
Select a color from any object on the Root Container of the window and left-click to set the 
background color and the right-click to set the foreground color.
The technique works the same on other components by affecting the component's  colo Fill Paint
r property and the  color property.Stroke Paint
 
To exist the , select the Selection Tool (the mouse pointer icon) from the drawing Eyedropper
tools menu.

Eyedropper Tool

Watch the Video

 

 

Next ...

add link here
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Binding Properties
   

Property Binding is perhaps the most important concept to understand when designing a project using the Vision module. It is primarily through 
property binding that you bring windows to life, and have them do useful things. A property binding simply links one component's property to another 
on the same window.

When you initially place a component on a screen, it doesn't really do anything. Changing its properties in the Designer will make it look or act 
different, but it has no connection to the real world and this is what property binding adds.

Property binding, as its name suggests, lets you bind a property to something else, and that something else could be:

An OPC Tag
The results of a SQL query executed against a remote database
Some other component's property
An expression involving any of these things
The results of a Python script
and so on...

For example, bind the Value property of an LED Display to an OPC Tag, and voilà - the value property will always be the value of that tag - creating a 
dynamic display. Bindings can also work the other way, using a bidirectional binding. Bind the value of a numeric text box to a tag, and that tag will be 
written to when someone edits the value in the text box.

The power of property bindings comes from the variety of different binding types that exist, and the fact that you can bind nearly any property of a 
component to anything else. Want its foreground to turn red when an alarm is above a certain severity? Bind its LED Lit ( ) color to glyphForeground
a tag's   property. Want it to only appear if a supervisor is on shift? Bind its visible property to the result of a SQL query that AlertCurrentSeverity
joins a personnel table with a shift table. The possibilities are, quite literally, endless.

Property Binding Types

A property can have many different types of binding, for example it can have a Tag or an Expression binding. The following is a list of the 
different binding types for a property:

Tag
Indirect Tag
Tags Historian
Property
Expression
Database Browse
SQL Query
Cell Update
Function

Copying Bindings

When you copy a component, all bindings, scripts, etc. are copied along with it, but you can also copy a property binding from one property to 
another.  This can be on the same component or a completely different component. The only prerequisite is that both property bindings must use a 
compatible property type. I.E. A binding that resolves to a string will not work on an integer property, etc.  

Here's how to copy a binding property:

In the Designer, click on a  .component
Select the   and right click.bound property



Choose  .Copy Binding

 

 

In this section ...  

   

   



Property Binding
 

A property binding is a very simple type of binding. It simply binds one component's property to another. 
When that property changes, the new value is pushed into the property that the binding is set up on. 

Property Binding

Watch the Video

   

How Bindings Work: Event-based vs. Polling

While there are quite a few different binding types, they all boil down into two broad categories: event-based and polling. Some complex bindings can 
span both categories.

Event-based bindings are evaluated when the object they are bound to changes. For example, when you bind a property to a tag, that binding listens 
to the tag, and every time the tag changes, it assigns the tag's new value into the property that it is on. If you bind the value of a Cylindrical Tank to the 
value of a Slider, every time the slider changes, it fires a propertyChangeEvent. The binding is listening for this event, and when it is fired, updates the 
tank's value. The following bindings are event-based:

Tag bindings
Property bindings

Polling bindings are evaluated when a window first opens, on a timer, or when they change. For example, if you bind the data property of a Table to 
the results of a SQL query, that query will run on a timer, updating the Table every time it executes. The following bindings are based on polling:

SQL query bindings
Some expression functions, like runScript() or now()

Many bindings can combine elements of a polling binding and event-based binding. An expression binding may combine lots of other bindings to 
calculate a final result. A query binding will often itself be dynamic, altering the query based on other bindings.

For example, you might have a dropdown on a window that lets the operator choose a type of product that is produced. Then you can use a query 
binding like the following to calculate the defect rate for the given product:

SELECT
   SUM(defective) / COUNT(*) AS DefectRate
FROM
   production_table
WHERE
   productCode = '{Root Container.ProductPicker.selectedValue}'

The  codeblue  is a property binding inside of the query binding. Every time this (event-based) binding fires, the query will run again. Using bindings 
like this, you can create highly dynamic and interactive screens with no scripting whatsoever.

Polling Options

The following are the options you can choose from for bindings that poll:

Polling Off
A polling-off binding will execute once when the window is opened, and then it will only execute again if it changes. The typical example of a 
binding that can change is a SQL query binding where it uses the brace-notation ( {} ) to include dynamic information inside the query. When 
this dynamic information changes the query, it will run again.
 
Relative Rate
The binding will execute at a regular rate, based on a delta off of the project's base polling rate, see . This is Setting Project Polling Base Rate
usually a good idea so that you can speed up or slow down an entire client's polling system in one place.
 
Absolute Rate
Using this option, you can specify an absolute rate for the binding to execute at, instead of one that is based off the relative rate.

 

Why aren't all properties listed?

You may notice that the list of properties available to bind to is smaller than the list of all 
properties. While nearly all properties can be bound, only some properties can be bound to. 
Only properties for which a  is fired may be bound to.propertyChangeEvent
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Next ...

Property Binding - Bidirectional

 



Property Binding - Bidirectional
 

Tag bindings and Query bindings can be set as bidirectional bindings. This means that not only is the 
binding assigning the tag value or query value into the property, but it is also listening for changes to that 
property, which will then be written back to the tag or the database.

Tag Bindings

Tag bindings can be made bidirectional simply by checking the  checkbox at the bottom of Bidirectional
the  window. Property Binding A tag can be set as a bidirectional binding, if it has a read/write 

e amoun thpermission and if the user has the security permission to write to the tag.The Fallback Delay is
t of time that the value will remain at the written value, waiting for a tag change to come in. If no tag 
change comes in within the allotted time (specified in seconds), the property will fall-back to the value as 
it was before the write. This is needed, because sometimes even if a write succeeds, another write or 
ladder logic in a PLC might have written something different, even the old value, in which case no tag 
change event will be generated. As a rule of thumb, the fallback delay should be twice the tag's scan 
class rate. 

Query Bindings

When a query binding is made bidirectional, it needs an UPDATE query to execute when the 
property changes. You can use the special marker   as a placeholder for the new {this}
value. Bidirectional query bindings are only available on scalar-typed properties, that is, not Datasets.

Property Binding - 
Bidirectional

Watch the Video

 

 

 

 

Next ...

Tag Binding
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Tag Binding
 

A tag binding is a very straight-forward binding type. It simply binds a property directly to a tag. This sets 
up a tag subscription for that tag, and every time the chosen property changes, the binding is 
evaluated, pushing the new value into the bound property.

If the tag is a leased scan class, this binding will activate the lease while the window is open. If you 
choose a tag in the tree, and not a property, the Value property is assumed.

Tag Binding

Watch the Video

 

 

Next ...

Tag Binding - Drag and Drop

 

https://www.inductiveuniversity.com/video/tag-binding/7.8


Tag Binding - Drag and Drop
 

You can quickly bind a tag by dragging it from the Tag Browser into a component or into the 
component property. In the Property Editor, the properties that have the new bindings will display in bold 
font along with a binding icon.

Binding to a Component

Ignition automatically creates the tag bindings to several of the component properties when you choose 
to bind a tag to a component by dragging and dropping . In addition, some of the bindings will be 
bidirectional or they may be expression bindings. How Ignition handles the binding depends on the 
disparity between the datatypes of the tag and the target component. For example, binding a numerical 
tag to a label component will result in an expression binding that formats the number to more conducive 
to a label component.

Binding to a Component Property

Ignition automatically creates a tag binding to the property that you dropped the tag on to resulting in the 
property binding to the value of the tag. In addition, it is possible to bind the tag attributes to the 
component's property. For example, the tag's engineering high limit attribute could be bound to the 
capacity property of a cylindrical tank component.

Tag Binding – Drag 
and Drop

Watch the Video

 

 

Next ...

Tag Binding - Bidirectional
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Tag Binding - Bidirectional
 

Choosing bidirectional will make the tag bindings also write to the chosen tag when the property 
changes. The fallback delay is the amount of time to keep the property at the written value waiting for a 
new tag value update to come in. If no update arrives within the given timeout, the property falls back to 
the original value.

See also: Property Binding - Bidirectional

Tag Binding - 
Bidirectional

Watch the Video

 

 

Next ...

Tag and Component Overlays
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Tag and Component Overlays
 

It is especially important in HMIs to be able to gauge the health and accuracy, also called quality, of what 
is displayed at a glance. For these reasons, components show visual overlays for various reasons to 
indicate that the data they are displaying is of poor quality or is pending a reply from the device.

Choosing Overlay Opt-out option will ignore the quality of the chosen tag, making it have no effect on 
the component's quality overlay. The Overlay Op-out option is located in the tag bindings for 
components. If this option is chosen the user would have no indication that the underlying tag quality is 
something other than of good quality therefore it is possible the user.

Tag and 
Component 
Overlays

Watch the Video

 

 

Next ...

Indirect Tag Binding
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1.  

2.  

Indirect Tag Binding
 

An indirect tag binding is very much like a standard tag binding, except that you may introduce any 
number of indirection parameters to build a tag path dynamically in the runtime. These parameters are 
numbered starting at one, and denoted by braces, for example, {1}.

The binding will be bound to the tag represented by the tag path after the indirection parameters 
have been replaced by the literal values they are bound to. An indirection parameter may represent 
a property on any component in the same window, or the value of any tag.

Indirect tag bindings can use bidirectional mode just like standard tag bindings.

Making bindings indirect is an important part of the binding system. Indirect Tag, Expression, and 
SQL Query bindings can all be made indirect. All this means is that what the binding is bound to can 
be changed based on the value of something else.

For example, instead of binding straight to a tag's path, like

[TagProvider]MyPlant/EastArea/Valves/Valve4/FlowRate

you can use other properties to make that path indirect. Suppose the "area" and valve number that 
we were looking at was passed into our window via parameter passing. Then we might use 
those parameters in the tag path, like this:

[TagProvider]MyPlant/{1}Area/Valves/Valve{2}/FlowRate
{1}=Root Container.AreaName
{2}=Root Container.ValveNumber

Now our binding will change what tag it is pointing to based on the values of those root 
container properties.

Making query bindings indirect, or dynamic, is so common that there are probably more indirect 
query bindings than direct ones. All this means is that the query is calculated dynamically. A 
common example of this would be to use a dynamic start date and end date in a query. Suppose we had 
a Classic Chart that we're binding to a range of history, and a Date Range that we wanted to have 
the operator use to select a time period. Then we could use an indirect query binding like this:

SELECT
   t_stamp, flow_rate, amps
FROM
   valve_history
WHERE
   t_stamp >= '{Root Container.DateRange.startDate}' AND
   t_stamp <= '{Root Container.DateRange.endDate}' AND
   valve = {Root Container.ValveNumber} AND
   area = '{Root Container.AreaName}Area'

Indirect Tag Binding

Watch the Video

Creating Indirect Tag Bindings

Indirect tag bindings are an important part of Ignition and the binding system. This means that what the binding is bound to, can be changed based on 
the value of something else. For example, you can have a selection from a drop-down list to choose which tags to look at on the screen.

We have four motor UDT tags and a motor template. Let's create a single window with one drop-down list and one motor template. The drop-down 
list gives the option of which motor to look at. The motor tags look like this:

Motors/Motor 1
Motors/Motor 2
Motors/Motor 3
Motors/Motor 4

The only difference between each motor is the number.

To create a window with a drop-down list and a motor template

From Project Browser, under  , drag in a template, in this example it is a   template.Templates Motor
 

https://www.inductiveuniversity.com/video/indirect-tag-binding/7.8


2.  

3.  

4.  

5.  

6.  

7.  

From the   tab of  , drag a   component.Input Component Palette Dropdown List

Now we need to setup the options for the drop-down list in the  . The drop-down component has the   property which is Property Editor Data
a dataset. There are three ways to set up the dataset and the corresponding behavior is as follows:

One Column [String] Apples
Oranges
Bananas

• Drop-down displays values from the first column.
• Selected Value is undefined.
• Selected String Value represents value from first column.
• Selected Label represents value from first column.

Two Column [Integer, String] (Default) 201 Apples
202 Oranges
203 Bananas

• Drop-down displays values from second column.
• Selected Value represents value from first column.
• Selected String Value represents value from second column.
• Selected Label represents value from second column.

Two Column [String, String] APL Apples
ORN Oranges
BAN Bananas

• Drop-down displays values from second column.
• Selected Value is undefined.
• Selected String Value represents value from first column.
• Selected Label represents value from second column.

Let’s use the default mode which is the second option above,  , to setup the options in the drop-down list.Two Columns [integer, string]
 
Select the drop-down component and click the  icon next to the  property.Dataset view Data
 
On the right side of   window, click the   icon four times to add 4 rows.Dataset Viewer + green row
 
Set the rows to the following values:

 1     Motor 1
 2     Motor 2
 3     Motor 3
 4     Motor 4

Click  to save.OK
 
Set the  property to .Selected Value 1
Notice the values for  and  fill in for you.Selected String Value Selected Label



7.  

8.  

9.  

10.  

We want to use the Selected Value in an indirect binding on the template to dynamically select which motor to look at.
 
Select the Motor template on the window and bind the Motor UDT property to an Indirect Tag.

The easiest way to use the indirect tag binding, is to select a tag as a starting point and then make it dynamic.
 
Click the Tag button on the right of Indirect Tag Path and select the Motor 1 tag as the reference.

The drop-down list contains which motor number to look at. So we need to link the Motor tag number to the drop-down’s selected value.



9.  

10.  

11.  

12.  

Highlight the number 1 (in Motors/Motor 1) in the Indirect Tag Path, then click on the link button to the right to bring in the drop-down's 
Selected Value property.

Ignition replaces the 1 with a {1} and links it to the drop-down. That means Ignition substitutes {1} with the value of the drop-down allowing 
it to select which motor tag to look at.

Click .OK
Now you can try it out.

Save your project and open the runtime.
You can change the drop-down list and it will select a different motor.

 It is as easy as that to setup tag indirection. You can apply this method to popups or anywhere in Ignition.

See also: Parameterized Popup Windows

 

 

Next ...

Tag History Binding

 



Tag History Binding
 

The Tag Historian binding type, which is only available for Dataset type properties, runs a query against 
the Tag Historian.

Selected Historical Tags

For this type of query, you must select at least one tag path to query. The Dataset returned by the query 
will have a timestamp column, and then a column for each path that you select here.

These paths may use indirection following the same rules as the Indirect Tag Binding. Simply type the 
indirection parameters (for example, {1}) into a selected tag path by double-clicking in the list of selected 
paths. All valid parameters will appear in the lower indirection table.

Date Range

Choose either a Historical or Realtime query. Historical queries use a date range that must be bound in 
from other components on the screen, typically a  or a pair of . Realtime Date Range Popup Calendars
queries always pull up a range that ends with the current time, so all they need is a length.

Sample Size and Aggregation Mode

The sample size determines how the query results will look.

Natural - A Natural query will look up the logging rate for the queried tags (when possible), and 
return results spaced apart at that rate. This means that the return size will vary with the date 
range.
On Change/Raw - An On Change query will return points as they were logged, and can be 
thought of as a "raw" query mode. This means that the results may not be evenly spaced. Also, 
it is important to note that every changed value will result in a row, and therefore if you are 
querying multiple tags and once, you may end up with more rows than you anticipated. For 
example, if tag A and tag B both change, you would end up with [[A , B ],[A , B ], [A , B ]]. 0 0 1 0 1 1
Note: If you want to essentially retrieve raw values, while coalescing them down into fewer rows, 
try using the Interval sample mode, with an interval set to your largest acceptable time between 
rows, and select "prevent interpolation" from the advanced settings.
Fixed - A Fixed query will return the given number of rows. Where data was sparse, 
interpolated values will be added. Where data is dense, the Aggregation Mode will come into 
play.
Interval - Similar to fixed, but with the spacing based on time, rather than the number of 
requested results.

 

The aggregation mode dictates what happens when multiple raw values are encountered for a given 
sample window (the size of which is determined by the number of requested rows, or the interval size).

 

Min/Max - The minimum and maximum values will be returned for the window. In other words, 
two rows will be returned. If only one value is seen in the interval, only one row will be returned.
Time-weighted Average - The values are averaged together, weighted for the amount of time 
they cover in the interval.
Closest Value - The value closest to the ending time of the interval will be returned.
Simple Average - The values are summed together and divided by the number of values.
Sum - The values in the interval are summed together.
Maximum - The maximum value in the interval.
Minimum - The minimum value in the interval.
Duration On - Returns the number of seconds that the value was recorded as non-zero.
Duration Off - Returns the number of seconds that the value recorded as zero.
Count On - Returns the number of times the tag's value went from a zero value to non-zero: i.
e., 
Count Off - Returns the number of times the tag's value changed from a non-zero value to 
zero.

The following feature is new in Ignition version 7.8.1
 to check out the other new featuresClick here

Count - Returns the number of times a value was recorded 

Tag Historian 
Binding

Watch the Video
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The following feature is new in Ignition version 7.8.3
 to check out the other new featuresClick here

Percent Good - Time-weighted percentage of good values over the date range. 
Percent Bad - Time-weighted percentage of bad values over the date range.
Range - Returns the range between the highest and lowest value for the period.
Standard Deviation - Returns the standard deviation of values, or how much spread is present 
in the data; low standard deviation shows the values are close to the mean, and high standard 
deviation shows that the data points are spread out over a large range of values. Only good 
quality values are used when calculating. 
Variance - Returns the variance of values. Similar in concept Standard Deviation. Only good 
quality values are used when calculating. 

Return Format

Return format dictates how the requested data will be returned. The options are "wide" (default), in which 
each tag has its own column, and "tall", in which the tags are returned vertically in a "path, value, quality, 
timestamp" schema.

Advanced Options

These option affect the query results in more subtle ways.

Ignore Bad Quality - Only data with "good" quality will be loaded from the data source.
Prevent Interpolation - Requests that values not be interpolated, if the row would normally 
require it. Also instructs the system to not right result rows that would only contain interpolated 
values. In other words, if the raw data does not provide any new values for a certain window, 
that window will not be included in the result dataset.
Avoid Scan Class Validation - "Scan class validation" is the mechanism by which the system 
determines when the gateway was not running, and returns bad quality data for these periods of 
time. By enabling this option, the scan class records will not be consulted, which can improve 
performance, and will not right bad quality rows as a result of this check.

 

 

 

Next ...

Expression Binding
Tag Historian
Data Types in Component Properties
system.tag.queryTagHistory

 

Tags Historian information is often easiest to work with in the  component, Easy Chart
which handles all of these options automatically.
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Expression Binding
 

An expression binding is one of the most powerful kinds of property bindings.

It uses a simple expression language to calculate a value. This expression can involve lots of dynamic 
data, such as other properties, tag values, results of Python scripts, queries, and so on. 

You can use expressions for many different purposes. Anytime information needs to be massaged, 
manipulated, extracted, combined, split, and so on - think expressions!

Example 1

You have 3 bits in a PLC, only one of which will be on at a time. You want to turn these three bits into a 
single integer (0,1,2) to drive a component's Styles. Bind a custom integer property to:

binEnum({MyTags/Bit1}, {MyTags/Bit2}, {MyTags/Bit3})

Example 2

You have a Date, and need to extract the year, and concatenate the word "Vintage" to the end for a label 
display. Bind a label's text property to:

 dateExtract({Root Container.VintageDate}, 'year') + ' Vintage'

Example 3

You have a button that starts a batch, but you only want to let it be pressed after the operator 
has entered a scale weight. Bind the button's enabled property to: 

 {Root Container.EntryArea.WeightBox.doubleValue} > 0.0

Example 4

You want to display a process's current state, translating a code from the PLC to a human-
readable string, use of these two expressions (they're equivalent)

if ({CurrentProcessState} = 0, "Not Running",
if ({CurrentProcessState} = 1, "Warmup phase - please wait",
if ({CurrentProcessState} = 2, "Running", "UNKNOWN STATE")))

- or -

switch ({CurrentProcessState},
   0,1,2,
   "Not Running",
   "Warmup phase - please wait",
   "Running",
   "UNKNOWN STATE")

 

See also: Expression Overview and Syntax 

Expression Binding

Watch the Video
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Expression Binding - Concat Strings
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Expression Binding - Concat Strings
 

You can use an expression binding to concatenate strings resulting in a new string that reflects the 
concatenation of different strings.

The function starts with  and inside the function is a list of strings. They can be manually typed CONCAT()
like  or they can come from tags or properties."42"

The following is an example:

concat("The answer is: ", "42") //returns "The answer is: 42"

For more information see the .Appendix

Expression Binding 
– Concat Strings

Watch the Video
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Expression Binding - Celsius to Fahrenheit
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Expression Binding - Celsius to Fahrenheit
 

Use an expression binding to convert a temperature from Celsius to Fahrenheit. This is an example of 
how expression binding can handle calculations.

{celsiusTemp} * 9/5 + 32

The reference to the Celsius temperature can come from a property or a tag. As the property or the tag 
changes, so does the expression binding.

Expression Binding 
- Celsius to 
Farenheit

Watch the Video
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Expression Binding - Format Date
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1.  

2.  

3.  

Expression Binding - Format Date
 

You can format a date in an expression binding by using the  and  functions.dateFormat now

To make a label that updates to show the current time

Let's create a label that updates every second to reflect the current time.

Drag a  component onto the window.Label
 
Select the label's  property binding icon and select  binding.Text Expression
 
Enter the following code into the expression, and click .OK

dateFormat(now(1000), "MMM d, yyyy hh:mm:s a") 

The  function takes two arguments. The first argument is any date type dateFormat
variable. The second argument refers to the date format that you want returned. The   functionow
n returns the current time and in this case it will update every second. 

 .For more information see the Appendix

Expression Binding 
– Format Date

Watch the Video

   

   

Next ...

Expression Binding - Date Manipulations

 

https://legacy-docs.inductiveautomation.com/display/DOC/dateFormat
https://inductiveuniversity.com/video/expression-binding-format-date/7.8


Expression Binding - Date Manipulations
 

You can manipulate dates in expression bindings such as a date addition/subtraction with the dateArit
 function. This is important when you want to use the expression bindings to select a date that is hmetic

offset by a certain amount.

The following example will return the time 15 minutes ago by using the dateArithmetic expression 
function:

 dateArithmetic(now(), -15, "minute")

See the dateArithmetic expression function, in the Appendix.

Expression Binding 
– Date 
Manipulations

Watch the Video

 

 

Next ...

Expression Binding - Bit Functions

 

https://legacy-docs.inductiveautomation.com/display/DOC/dateArithmetic
https://inductiveuniversity.com/video/expression-binding-date-manipulations/7.8


Expression Binding - Bit Functions
 

You can use various bit functions in expression bindings like  to return individual bits of a word.getBit

Example

Assuming a tag path 'Folder/BitTag', the following would return the binary representation of the tag's 
value at the 0 position

getBit({Folder/BitTag}, 0)

 

For more details on the getBit function please see the  in the Appendix. getBit page

 

 

Expression Binding 
- Bit Functions

Watch the Video

 

 

Next ...

Expression Binding - Switch
getBit

 

https://legacy-docs.inductiveautomation.com/display/DOC/getBit
https://www.inductiveuniversity.com/video/expression-binding-bit-functions/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/getBit


Expression Binding - Switch
 

You can use the switch function in expression bindings to evaluate conditional statements. This function 
acts like the switch statement in C-like programming languages. It takes the value argument and 
compares it to each of the case1 through caseN expressions.

The following example returns the string  when it is given the value of . Its options are , , "Running" 1 0 1
and . And when comparing the value to the options the switch statement returns one of the 2
corresponding results. If a result cannot be found, a fail-over option is returned.

switch(
1,
0, 1, 2,
"Off","Running","Fault",
forceQuality("!BAD STATE!",0))

 .You can see more examples in the Appendix

Expression Binding 
– Switch

Watch the Video

   

 

Next ...

Expression Binding - Checking Conditions

 

https://legacy-docs.inductiveautomation.com/display/DOC/switch
https://inductiveuniversity.com/video/expression-binding-switch/7.8


Expression Binding - Checking Conditions
 

You can use expression bindings to return true or false based on different conditions.

 

Example 1

Consider the following expression that references the tag with a path of 'Folder/Machine State':

{Folder/Machine State} = 0

The above expression simply tests the value of the Machine State tag. If the value of the Machine State 
tag is ever equal to 0 then the above expression would return true. In every case where Machine State is 
not equal to 0, then the expression would return false. 

 

Example 2

It is possible to check for multiple conditions in the same expression. If you have two boolean tags and 
you only want the expression to return true if both tags are true then the binding would look like:

{boolTag1}=True && {boolTag2}=True 

Expression Binding 
- Checking 
Conditions

Watch the Video
 

 

 

 

Next ...

DB Browse Binding
Expression Overview and Syntax

 

https://www.inductiveuniversity.com/video/expression-binding-checking-conditions/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Expression+Overview+and+Syntax


DB Browse Binding
 

The DB Browse binding is technically equivalent to the SQL Query binding, except that it helps write the 
queries for you. Using the database browser, you can pick the table that you want to pull content from. If 
you have a fixed range of data to choose, simply select it in the table, and watch the query get generated.

In the browse tree, you can choose which columns should act as your keys (these columns get put in the 
WHERE clause based on your selection) and which columns should be used to sort the data (these 
columns are put in the ORDER BY clause).

DB Browse Binding

Watch the Video

 

 

Next ...

DB Browse Binding - Dynamic Filters

 

This binding type also serves as a convenient jumping-off point for the more flexible SQL 
Query binding. Construct the basic outline of your query in the DB Browse section, and then 
flip over to the SQL Query binding. Your query will be retained and can then be improved by 
hand.

https://www.inductiveuniversity.com/video/db-browse-binding/7.8


DB Browse Binding - Dynamic Filters
 

You can use the DB Browse binding to filter results from values on the screen.

DB Browse Binding 
- Dynamic Filters

Watch the Video

 

 

Next ...

SQL Query Binding

 

https://www.inductiveuniversity.com/video/db-browse-binding-dynamic-filters/7.8


SQL Query Binding
 

The SQL Query binding is a polling binding type that will run a SQL Query against any of the database 
connections configured in the Gateway.

Dynamic Queries

Using the brace notation, you can include the values of component properties (within the same window) 
and tag values inside your query. This is a very common technique to make your query dynamic. The 
values of the property or tag represented are simply substituted into the query where the braces are.

Note that because the substitution is direct, you'll often need to quote literal strings and dates to 
make your query valid. If you're getting errors running your query complaining about syntax, it is 
important to realize that these errors are coming from the database, not from Ignition. Try copying and 
pasting your query into the Query Browser and replacing the braces with literal values.

Example

A common requirement is to have a query filter its results for a date range. You can use the Date Range 
component or a pair of Popup Calendar components to let the user choose a range of dates. Then you 
can use these dates in your query like this:

SELECT
   t_stamp, flow_rate, amps
FROM
   valve_history
WHERE
   t_stamp >= '{Root Container.DateRange.startDate}' AND
   t_stamp <= '{Root Container.DateRange.endDate}'

Notice the single quotes around the braces. This is because when the query is run, the dates will 
be replaced with their literal evaluations. For example, the actual query sent to the database might 
look like this:

SELECT
   t_stamp, flow_rate, amps
FROM
   valve_history
WHERE
   t_stamp >= '2010-03-20 08:00:00' AND
   t_stamp <= '2010-03-20 13:00:00'

Fallback Value

If the property that is being bound is a scalar datatype (that is, not a Dataset), the value in the 
first column in the first row of the query results is used. If no rows were returned, the binding will cause 
an error unless the Use Fallback Value option is selected. The value entered in the fallback value text 
box will be used when the query returns no rows.

When binding a Dataset to a SQL Query, no fallback value is needed, because a Dataset will 
happily contain zero rows.

See also: , Setting Project Polling Base Connecting to Databases

SQL Query Binding

Watch the Video

 

 

Next ...

SQL Query Binding - Polling

 

https://www.inductiveuniversity.com/video/sql-query-binding/7.8


SQL Query Binding - Polling
 

There are several polling modes (polling off, relative, and absolute) that work with the SQL Query binding.

SQL Query Binding 
- Polling

Watch the Video

 

 

Next ...

SQL Query Binding - Dynamic Filters

 

https://www.inductiveuniversity.com/video/sql-query-binding-polling/7.8


SQL Query Binding - Dynamic Filters
 

Make your SQL queries dynamic by including property values and tag values in the query.

SQL Query Binding 
- Dynamic Filters

Watch the Video

 

 

Next ...

SQL Query Binding
SQL Query Binding - Scalar Query and Fallback

 

https://www.inductiveuniversity.com/video/sql-query-binding-dynamic-filters/7.8


SQL Query Binding - Scalar Query and Fallback
 

You can bind a scalar property to a SQL query and return the fallback value when no rows are returned.

SQL Query Binding 
- Scalar Query and 
Fallback

Watch the Video
 

 

 

 

Next ...

SQL Query Binding - Scalar Query and Update

 

https://www.inductiveuniversity.com/video/sql-query-binding-scalar-query-and-fallback/7.8


SQL Query Binding - Scalar Query and Update
 

You can bind an input component bidirectionally to a SQL query to allow data be retrieved and updated 
in the database.

SQL Query Binding 
- Scalar Query and 
Update

Watch the Video
 

 

 

 

Next ...

Cell Update Binding

 

https://www.inductiveuniversity.com/video/sql-query-binding-scalar-query-and-update/7.8


Cell Update Binding
 

The Cell Update binding enables you to easily make one or more cells inside a dataset dynamic. This is 
particularly useful for components such as the Linear Scale or the Easy Chart, that store configuration 
information inside datasets.

For example, when you configure indicators on a  component using that Linear Scale
component's customizer, the indicators that you set up are stored in the  property on the Indicators
scale. Suppose you wanted high-setpoint and low-setpoint indicators on the scale that weren't simply 
static values, but actually bound to a tag indicating the realtime high and low setpoints. To do this, you'd 
set up a  binding on the Linear Scale's Indicators property. You would configure two cell Cell Update
bindings - one for the low setpoint indicator's Value column, and one for the high setpoint. You would 
then bind these to the appropriate tags.

As another example, let's say you had an  on a window that displayed 5 pens Easy Chart
representing the history of a Compressor: running status, amperage, rpm, output pressure, and so on. 
Using Tag Historian, you had simply dragged the 5 applicable tags onto the Easy Chart. But now you 
want to use that same Easy Chart to dynamically display the same 5 pens of any of the many 
compressors in your system. To do this, you could pass the compressor number into the window as a 
parameter, and use it to calculate the tag path of the folder containing the pens. Then set up a Cell 
Update binding on the Easy Chart's  property, dynamically altering the pens' tag paths. Now Tag Pens
you have a generic chart window that you can use for any compressor.

Note that this binding type is only applicable for Dataset-typed properties.

Cell Update Binding

Watch the Video

 

 

 

 

 

Next ...

Function Binding

 

https://www.inductiveuniversity.com/video/cell-update-binding/7.8


Function Binding
 

The function binding is a generic binding type that lets you bind a dataset property to the results of a 
function. It allows any of the function's parameters to be calculated dynamically via tag and property 
bindings. The function that you choose determines the parameters that are available. The following are 
the three different functions you can use for function binding:

Alarm History
Alarm Status
Audit Log

Function Binding

Watch the Video

 

 

Next ...

Component Styles

 

https://www.inductiveuniversity.com/video/function-binding/7.8


1.  

2.  

3.  

Component Styles
 

The  feature in Ignition allows you to define a set of visual styles for a component that Style Customizer
will change based upon a single driving property.  To use the Style Customizer, you need a numeric or 
Boolean property on your component to use as the driving property. Custom properties on your on your 
component can be used as a driving property.

With the , you can change multiple property values on a component in a single Style Customizer
location.  Without styles, you have to go to every property and bind them all individually.

Some components have styles already setup and others do not.  Let’s do an example that already has 
styles setup on the component.

Drag in a  from your component palette on to your window.  Right click on  Multi-State Indicator
the component and notice in the Property Editor that several properties appear in bold with a 
paint canvas icon next to them letting you know that they are used in styles.

Right click on the Multi-State Indicator component and scroll down to Customizers > Style 
Customizer. 

Since styles is already setup on this component, you’ll notice that it already has a driving 
property selected.  The driving property is  and it uses multiple visual properties like State Backg

, ,  and  which are already configured.round Color  Border Foreground Color Text

Styles are totally customizable.  If you don’t like the pre-defined style for the preset values for 
the Multi-State Indicator, you can change them.  You can add or remove styled 

properties.  Adding and removing a styled property affects all the Values under the 

component.  In this example, the Font property was added.  

Component Styles

Watch the Video

https://legacy-docs.inductiveautomation.com/display/DOC/Custom+Properties#CustomProperties-ConfiguringtheStyleCustomizer
https://www.inductiveuniversity.com/video/component-styles/7.8


3.  

4.  

5.  

 

For each  property, you can change its styled property to fit your requirements. Value

Click the   and see all the styles for the .   Expand icon Value '0' Starting with Background 
Color, click on the dropdown list to change the color.  You can configure all the styles you want 
to change: Border, Font, Foreground Color and Text.   

You can change the styles for any Value in this Multi-State Indicator component. You can Preview
each change after you make it.   

 

With the styles feature you can  between different styles on the same ‘Animate’ State.  To Anim
ate, you can add one or more rows and set the style for what you want those new rows to look 
like.

In this example, expand  and you will see that the  box is checked.  Two rows Value '3' Animate
were added and each animation step has a different background and foreground color set along 
with a  set in milliseconds to control the blinking between the 2 steps.  You can Step Duration
add many steps and each step can have a different duration.   See how it works in . Preview

Press .OK



5.  

6.  Change the  to  to see the component blink  and switch between the State  '3' ‘Faulted’
background and foreground colors you setup.  

Once your styles are setup, you can see styles coming through on the Multi-State Indicator component 
as it moves through the different States. In the Property Editor, you will notice that the Border, 
Foreground Color and Background Color properties are bold letting you know that they are used in styles

You cannot bind a property that is already being used by styles, otherwise, you get an error.  The 
property name turns red in the In the Property Editor.
 



 

So as you can see, it's easy to change all the properties from one location using the Styles Customizer.

 

 

Next ...

add link here

 



1.  

2.  

3.  

4.  

Some Useful HMI Examples
   

The HMI examples in this section show you how to tint vector graphics components, to make tank cutaways, and to animate components.

The following HMI examples use the symbols from the Symbol Factory module:

Animating the Tint on a Grayscale Symbol
Using Cutouts on Tanks

Using the Symbol Factory

If you have the Symbol Factory module installed, you've got nearly 4,000 industrial symbols at your fingertips to use in your projects.

To open the Symbol Factory Browser

Launch the Designer and open your project.

Choose   under the   menu or the project navigation tree.Symbol Factory Tools
If you can't find these, the Symbol Factory module probably isn't installed.
The Symbol Factory browser opens as a pop-up window that stays on top of the Designer. 

Browse the different categories to explore what symbols are available, or search to find a specific symbol.

Find a symbol that you'd like to use and drag it onto an open Vision window. 
The symbol will become a group of shapes. Just like any group, you can double-click it to get to the shapes inside, or simply un-group it. This 
way you can edit the symbol if you need to. 

 If the Symbol Factory module is in trial mode, you'll only be able to use the first symbol from each category.Note:

 

 

In this section ...  

   



Color SVG Dynamically
Introduction

In Ignition, one useful HMI technique is to color an individual component of the SVG (scalable vector 
graphic).  Whether you are bringing in a vector graphic from the Symbol Factory or importing an SVG 
from your computer, you can easily color in individual components of your SVG.   

As with almost everything in Ignition, there are multiple ways of accomplishing the same result.  For each 
component of the SVG, there are different binding types you can use to dynamically change the color 
based on a value. 

 

Reference Information

There are a few pieces of assumed knowledge in this article that are common to all the coloring 
options. Click to learn more about each.

There can be many components inside an SVG. These components are often referred to by a number 
of different names: sub-components, members, parts, pieces, etc. All these names mean the same 
thing. For clarity, we will refer to an individual item inside an SVG as a 'component of the SVG.'
The Symbol Factory has a library of symbols to choose from. Choose your symbol and drag it to your 
workspace.

In Designer, open the Symbol Factory  in the Component Palette and drag a motor on to your 
workspace.  

When you drag a vector graphic into a window, it’s not just one flat image, it’s actually comprised of 
many individual components.

Expand the vector graphic in the Project Browser. You can see that the Motor is made up of many 
different components of the SVG.  Each of these components can be colored independently.  

In this example, let's select the square as the individual component of the SVG. Double click on the M
otor, double click the square, and then single click on the square again.

Color SVG 
Dynamically

Watch the Video

https://www.inductiveuniversity.com/video/color-svg-dynamically/7.8


Every individual component of the SVG has a Fill Paint property that can dynamically change based 
on a value. Click on the Fill Paint property binding icon.  

Once you have the Fill Paint selected, you can combine it to a tag. Since there are a number of ways 
to bind the tag, let's explore our options in the following sections.
This page talks about coloring a specific part or parts of an existing SVG. There is also a way to tint 
the entire SVG one color. Click here to learn more about applying a .Tint to the entire SVG
While testing, if you are unable to write to a tag in the Tag Browser or through buttons in the designer, 
you might not have it set to allow writes. The first time you try to write, a window will popup in the 
Designer stating you are in Read Mode. Choose  so you can write to your 'Enable Read/Write Mode'
tags for testing.

Number-to-Color Translation Table

The Fill Paint property uses the Number-to-Color Translation table in Ignition, commonly known as Color 
Mapping.  This is where you map a value to a color.  For every number range there is a set color. You 
can choose a different color for each value, and even make it blink between two different colors. 

If you need to add or remove a value, simply use the add row   and remove row icons   on the 
right side of the Number-to-Color Translation table. 

In this SVG example, value  is set to , value  is set to  and value  is set to blink between '0' red '1' green,  '2'
 and . If you are using this as a tint overlay, make sure each color is semi-transparent so yellow orange

you can see the actual symbol behind it. 

There is a  option so when a value falls below your lowest value, a default color can Low Fallback Color
be set.

Tag Binding

A Tag Binding is a very straight-forward binding type. It simply binds a single property directly to a tag. 
For this example, every time the tag binding is evaluated, the Fill Paint property changes, pushing the 



new color to the component of the SVG. To learn more about tags, refer to the section on Understanding 
.Tags

Bind the   property to any numeric tag  If you are not familiar with numeric, it's any number Fill Paint . 
value.  Integers are the best, but you can also use a boolean float, etc. In this example,   ‘WriteableIntege

was selected.r5’ 

Set the values in the  table to drive the color of a component of an SVG.  Number-to-Color Transition 

On Value  , make the component   by double clicking on the first row.  Under  , select 0 red Color red
 and press  . OK
On Value  , make the component  . Double click the second row and under  , select 1 green Color g

 and press  .reen OK
Add a row by clicking the   icon          .Add Row
On  , make the square component blink between   and  . Double click the Value 2 yellow orange
third row and check the   box  and select the colors   and  .Blink , yellow orange
Press  . OK

Once you press OK button, you’ll notice that the component of the SVG changed color based on the 
current value of the tag. The Value is set to and the color is  . '0'  red

To change the tag value, go to the  , double click on your tag value, and change the value Tag Browser
from to .  Press  .  The component of the SVG will change from red to green. Now, change '0'  '1' Enter
the Value from  to , and the color will blink  and  . '1' '2' yellow  orange

Property Binding

You can use the same number to color translation table with a property binding.  Custom properties are 
extremely useful because they can turn your plain component into one customized for your particular 
use.  Adding Custom properties like Status or Level can transform your SVGs into more than just an 
image. Refer to sections on  and  to learn more.Property Binding Custom Properties



Drag in a Motor SVG and create a custom property on the Motor called   In this example, right 'Status.'
click on the  and select .  Enter the name  and use the Motor  Customizers > Custom Properties 'Status'
default  type. Press .  'Integer' OK

Click the  icon, and select the  binding type.  Under the object, select your  Fill Property Property Motor 
new property. Choose your colors and values.  Press .  'Status (Integer)'    OK

Once you press OK, you’ll notice that the square component of the SVG changed color based on the 
value of the tag. An Integer value defaults to  and in this case the color is  . '0'  purple

To change the tag value, go to the  , double click on the property value, and Property Editor Status 
change the value from  to  .  Press  . The component of the SVG will change from purple to '0'  '1' Enter
whatever color you set  too. '1'

Style Customizer



You can also use the Style Customizer to achieve the same result as with the Property Binding.  Like the 
previous example, we will need a Status property to drive the style. Let's create that same Status 
property on the inner component of the SVG. Select the component of the SVG, right click and scroll 
down to .   Enter the name   and use the default    PrCustomizers > Custom Properties 'Status' 'Integer.'
ess  .  OK

With the inner component still selected, right-click and select  .  Select Customizers > Style Customizers
the  property as the driving property, select  from the list of , and then Status Fill Paint Styled Properties
choose your colors for each value, adding values if needed.  Press . OK

To change the tag value, go to the  , double click on the  property value, and Property Editor Status 
change the value from  to  .  Press  . The component of the SVG will change from purple to '0'  '1' Enter
whatever color you set it too. 

In the event you see the Fill Paint property highlighted in red, this is a warning message that you have 
two competing property bindings that should be resolved. In this case, this warning message popped up 
because the  property has both a , and a  applied to it. Fill Paint Binding Style

Direct Bindings

There are several types of Bindings that can be used to set colors directly, without using a mapping 
table. 

Expression Binding

You can use the expression language to calculate a value.  If you have a color that depends on multiple 
properties, then using an express is recommended to evaluate correctly. Here are a few examples.  The 
first example returns a static color using the Fill Color property.



Expression

// binding on the Fill Color property
color(255,0,0) // static red color

This example takes a tag value and translates it to a color that ranges from white to blue and the tag 
value increases.

Expression

// binding on the Fill Color property
color(255,255,255-({tag value}/100*255)) // fades from white to blue when 
tag value goes from 0 to 100 %

If you have multiple properties or tags, you can use the logic Expression Functions to select between a 
few colors.

Custom Properties

if({Tag1}>50, 
        if({Tag2},
                3, // if tag1>50 and tag2 is true
                1), // if tag1>50 and tag2 is false
        if({Tag3},
                2, // if tag1<=50 and tag3 is true
                0)) // if tag1<=50 and tag3 is false

This example takes one integer value and selects from several options.

Expression Referencing a Tag

 // binding on the fill color property
switch({HOA tag},
        0,1,2, // off, on, hand
        color(255,0,0), color(0,255,0), color(255,255,0), // red, green, 
yellow
        color(0,0,0)) // black (fallback color)

SQL Binding

SQL Query bindings only have to return an string that can be translated to a color. Any set of RGB 
values can be listed using an integer representation ie: "255,0,255" or HEX "FF00FF".

 

SQL Binding

-- A basic static query that returns the hex code for teal
SELECT "00FFFF"

SQL Binding

-- A static query that concatenates integers to return a string RGB Code 
for yellow: "255,255,0"
SELECT CONCAT(255, ',', 255, ',', 0)

 

In most cases you will be using a table in the database. Assuming the following table (where background 
and foreground are strings):



SQL Query Binding

-- This query returns the background string RGB code for state #3 from the 
colors_table
SELECT background
FROM colors_table
WHERE state = 3

 

 

Next ...

Tint SVG
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Tint SVG
 

Here is an example of how to apply a tint on SVGs (vector graphics) and Symbol Factory graphics.

Symbol Factory Example: Animating the Tint on a Grayscale Symbol

Lets say you have chosen one of the many grayscale symbols, such as the  symbol from the  3-D Valve V
 category, and you want to tint the valve green when the valve is open, red when the valve has a alves

fault, and keep it gray when the valve is closed. Suppose you have a tag called  , that is 0 for ValveStatus
closed, 1 for open, and 2 for faulted.

To tint the symbol 

Drag the symbol onto the screen.
 
Duplicate the symbol by selecting it and choosing   from the   menu, or pressing Duplicate Edit CT

. RL-D

Now, select the duplicate symbol, which will be above the original.
 

Press the Union button ( ) in the toolbar or find the   item under the   menu. Union Shape
This will flatten the duplicated shape into a single shape.
 
Remove the outline by setting the   property to  .Stroke Paint No Paint
 
Bind the   property to your   tag. Fill Paint ValveStatus

Add three entries into the number-to-color translation table: 

fully transparent for zero
40% opaque green for 1
40% opaque red for 2

In summary, what we did to tint the symbol was to make a flat shape that had the exact same outline as 
the symbol, and used semi-transparent fills to achieve a tint effect for the underlying symbol.

Tint SVG

Watch the Video

 

 

 

 

 

Next ...

Tank Cutaway

 

https://www.inductiveuniversity.com/video/tint-svg/7.8
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Tank Cutaway
 

Here is an example of how to cut out a shape on a tank (SVG) and use a level indicator to create a 
custom tank.

Symbol Factory Example: Using Cutouts on Tanks

The symbols in the Tank Cutaways category work well when combined with the symbols in the 
Tank. Use the following technique to make a dynamic cutaway tank display:

Drag a tank and a cutaway symbol onto the window. 
 
Align the cutaway symbol on the tank where you'd like the cutaway to be placed.
 
Select the tank symbol, and then select the cutaway while holding   to select both symbols. CTRL
 

Press the  button ( ) to use the cutaway symbol to (you guessed it!) cut away that Difference
area out of the tank.
 
Place a  component on the area removed by the cutaway.Level Indicator
 
Push the Level Indicator below the tank, and bind it to a SQL tag to create a dynamic display.
 

Tank Cutaway

Watch the Video

 

 

 

 

 

Next ...

Component Animation

 

https://www.inductiveuniversity.com/video/tank-cutaway/7.8


Component Animation
 

Once you select a component or a group of components, you can resize, rotate, and move them using 
the mouse and keyboard. SVG images have  ,  ,  ,  , and   properties to make X Y Width Height Angle
animation easy.

See also: Manipulating Components

 

Component 
Animation

Watch the Video

 

 

Next ...

add link here

 

https://www.inductiveuniversity.com/video/component-animation/7.8


Using Special Components
   

The Designer offers some special components you can use when creating your projects. Control components, advanced tables, and PDF viewers are 
some examples of these special components.

 

 

In this section ...  

   



Control Components
 

You can use various  components (such as Numeric Text Field, Spinner, or Slider) and  Input Buttons
(such as 2 State Toggle, Multi-State, One-Shot, or Momentary) to write values back to the database or 
PLC.

Input Components

The input components are the core of data entry in Ignition. These are the most commonly used 
components to allow data entry and along with labels and a submit button they make up almost all your 
forms in Ignition.

Touchscreen Mode

Ignition has a built-in Touchscreen Mode that allows access to Input components on computers that don't 
have a keyboard or mouse.  This means that whenever  is turned on, a keyboard will Touchscreen Mode
be displayed when a user touches an Input component that expects a value to be entered.  IE: Text field, 
Numeric Text Field, etc...

Defer Updates

Many of the Input components have a  property that is True by default.Defer Updates

If True, then any edits to the component's value will not be submitted until the enter key is 
presses.  For example: if you type a word into a Text Field, the text property will not be updated 
until enter is pressed.
If False, then the component's value will be submitted when each key is pressed.  For example: 
if you type a word into a Text Field, the text property will be updated once for each letter in the 
word.

You can leverage this when you use an Input component as part of a filter for a SQL query on another 
component.  In this case, turning off Defer Updates would re-run the query every time a key is pressed. 
This allows you to make your tables filter what rows are show as the operator starts typing.

Important: You should  turn off  when using a bi-directional Tag binding for two not Defer Updates
reasons. 1) Writes are sent immediately but these bindings update at a set rate. This means your 
operators may not see the update and type in odd values. 2) When using Input components that have a 
numeric or text Format Pattern, this formatting will be applied at every keystroke. That means decimals 
can be truncated if the number is entered incorrectly.

Control 
Components

Watch the Video
 

 

 

Next ...

Dropdown Component
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Dropdown Component
 

Dropdown lists are used when you want to select a single item from a list of options.  The Dropdown 
component is under the Input section of the component palette.  Simply drag it on to your window.  The 
most important property of a Dropdown component is the Data property.  It is a Dataset that contains one 
or more rows of data.  Each of the rows are different options that you see on the component.  Select the 
Dropdown component and click on the Dataset Viewer icon for the  property to manually add some Data
options.

There are 3 ways you can use the  property’s dataset: a number/label pair, a single label column, Data
and a code/label pair.  Which mode is used depends on what columns are in the  property’s dataset, Data
and will determine the values of the ,  and  Selected Value Selected String Value Selected Label
properties.  Any additional columns that are added to the dataset will not affect these properties.

In the first mode, the first column is an integer (often an id) and the second column is a string (often a 
label).  The first column is the  column which is invisible to the user and is usually used in binding. Value
The second column is the  column and is visible to the user in the dropdown list. Label

In this example, the dataset has 2 rows.  Under the  column, you see the integers  and  Value '1'  '2'
respectively.  Under the  column, you see the  and  options. Label 'Realtime' 'Historical'

In , select from the list of dropdown options.  Notice, you can only see the options in the Preview Mode La
 column.  Select the  option.  You can see under the Data property section, the bel  'Realtime' Selected 

 is  which is the first (integer) column in the dataset and is not visible to users.  The Value '1' Selected 
 and the  are the same and show the  option which is the second String Value Selected Label 'Relatime'

(string) column in the dataset. 

Dropdown

Watch the Video
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The second mode you can use is a string/string combination which are 2 columns that are both 
strings.  Remove the  column from our example by selecting a cell in that column and clicking on Value
the vertical x icon.  Add another column by clicking on the verical plus icon.  Call the new colum  'code,'
set the column position to  and make it a   Both columns are now strings.  Under the  '0' 'String.'  'code'
column enter  and   'v1' 'v2.' Press OK.  



Because we added the  column in position  the users will see the same 2 options in the  'code'  '0,'
dropdown list:  and .'  If you see  and  instead, that means your  'Realtime'  'Historical 'v1' 'v2' 'code'
column is not the first column.

In , click on  and you can see the  is  because the Preview Mode  'Historical' Selected String Value  'v2'
value is in the first column and the  is Selected Label 'Historical.'
 

 

The third mode you can use is simply one string column. Remove the  column and keep the   ‘code’ ‘Label’
column the same. Again, you are going to see the same 2 options in the dataset viewer:     ‘Realtime’ and

Note, that this only applies if there is exactly one column in this dataset.‘Historical.’  
 

 

 

 In , select the  option.  You will see the same value in the  and Preview Mode ‘Realtime’ Selected Label
 properties since there is only the one column.Selected String Value

 



 

 

Now, you can set these dropdown options manually or bind the Data property.  In this example, you can 
take a Dropdown List on the window and bind the Data property using a SQL query. 

Click on the binding icon for the Data property.  Select the SQL Query Binding Type and type a query 
that brings back an ID and Name from one of your tables in the database.
 

 

Click OK to see all the options that came back from the database.  In , select any one of Preview Mode
these options and you can see the , , and  as Selected Value Selected String Value Selected Label
shown in the following example.

 

 
Another feature of the Dropdown component is you can show more than one column to a user.  Drag 
another Dropdown component to your window.  Go to the Dataset viewer and add some options 
manually.  Instead of having only one or two columns you can add as many as you want.  The first 
column needs to be either an integer or a string.  Any additional columns will show up in the dropdown.



Open the Dataset View, under , enter  and   Under , enter ‘ ’ and ‘ .’   Value ‘1’  ‘2.’ Label Realtime Historical
Add another column and call it ‘ ’ and make it a string and enter  and .’Col3 ‘This is real’ ‘This is historical
 

 
Press OK.   Go to the  and set the  to  Property Editor > Appearance Dropdown Display Mode ‘Table’
to see both columns.
 

Now you can see  and  and select between those different rows.  It’s a nice way to show more Label Col3
information in the Dropdown list. The , , and  Selected Value Selected String Value Selected Label
properties will behave the same as previous examples ignoring any columns beyond the second.
 



 

 

Next ...

Table Component

 



Table Component
 

The  component is very powerful, very flexible, and easy to configure. It allows you to easily display Table
your tabular data in a variety of ways.

Table

Watch the Video

 

 

 

Next...

Power Table Component
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Power Table Component
 

The  is a much more customizable version of the table component, and has many more Power Table
features. The Power Table contains advanced features for displaying your tabular data, such as drag-
and-drop rows, multi-column sorting, column filtering, and cell-spanning. Much of the customization 
comes through extension functions which are available to configure how each cell of the table looks, how 
the headers look, and more.

Power Table

Watch the Video

 

 

 

Next...

Tree View Component
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Tree View Component
 

The   component displays and organizes data in a dataset in a tree hierarchy.  The Tree View Tree View
component is found under the Tables tab of the component palette.  Drag the Tree View component on 

In , expand the folders to see the data.   The Tree View component to your window.    Preview Mode
can be used for navigation in Ignition.  

 

In fact, Ignition has a built in skeleton project called Multi-tier Navigation that uses the Tree View 
component specifically for that purpose.  There is one difference between the Multi-tier Navigation and 
the Tree View component.  The Multi-tier Navigation has one extra column in the Dataset Viewer called ‘

 that does not show up in the Tree View Customizer.  You will need to open the Dataset windowPath’
Viewer to modify it.   

To configure the Tree View component, go to the  called  next to the Dataset Data property ‘Items’
Viewer.  This contains all the items in the tree.   on the  and scroll Right click Tree View component
down to   to configure these items.    Customizers > Tree View Customizers

 

You can add one or more rows of data in the Tree View Customizer.  Every row must have a  and path te
 to display.  In the example below, look at the first and second rows.  The path is East Areaxt

/Refrigeration.  This path denotes which folder to put an item inside of.  The path is separated by a   ‘/’
which is a by default, and shows that there is an East Area inside a Refrigeration Separation Character 
folder containing 2 items called Compressor 1 and Compressor 2.   You will notice in the Tree View 
Customizer that you have other columns you can customize based on how you want particular items to 
look.  

Tree View

Watch the Video
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In the following example, you can add another row after the last item in the Tree View Customizer 
window and set the path to  For this example, enter the name of your item as  in Folder A.   ‘New Item’
the field.  You can also set an icon, the foreground, a tooltip, border, when the item is selected and text 
when it’s not selected if you desire.  Make sure the name of the item is the same for the  and text selecte

 fields.  You can add one or more rows and move them up and down. dText
   

 

When you press , your new row will be saved in the dataset and you can see it on the Tree View.  If OK
you expand Folder A, you will see the  with the icon that you specified.  ‘New Item’

 

The Tree View component has a couple of other properties that are important like the Separation 
which we are using in our path name.  By using the  or , the path is Character Separation Character  ‘/’

broken up into folders. 

There is a property called  that automatically sorts all the items in the tree into alphabetical Auto Sort
order.  If you uncheck , it will be sorted by the order of the dataset as shown in the example Auto Sort
below.

There is another property called .  If set to True, the folders will all automatically be Auto Expand
expanded.  If your Tree View is not expanded, right click to close the window, and by opening it again 
you will see that all the folders are now expanded in the Tree View.  



 

Now, the dataset has all items shown in the tree view.  You can bind this to a SQL query to bring back 
data from the database in order to organize this data into the tree. 

  

 

Next...

IA Labs PDF Viewer

 

 

https://legacy-docs.inductiveautomation.com/display/DOC/IA+Labs+PDF+Viewer


Web Browser Component
 

The  comp  Web Browser onent in Designer allows you to embed a full web browser inside of an Ignition 
Client. This component becomes available in Designer after you download the Web Browser module 

le installs the same way as any other from the Inductive Automation's website. The Web Browser modu
modules. Once this component is added onto a window, it will behave just like any other web browser 
when it is inside a Client.

Web Browser

Watch the Video

 

 

Basic Usage

To add the Web Browser component to Ignition, first install the   (make sure you save your project before installing the module Web Browser Module
as the designer will need to restart). A new section titled 'Web Browser' will appear in the Designer's Component Palette. Drag the Web Browser on to 
a Vision window just like any other component.

Behavior

Popups AllowedPopups are allowed by default. If unchecked, popup windows will not be shown to the user.Zoom LevelZoom level is set to 0.0 by 
default. Positive numbers zoom in, negative numbers zoom out. The zoom level will not be applied until the page has finished loading.Show 
Navigation ButtonsShow Navigation Buttons is checked by default. If unchecked, the user will not see the forward, back, or reload buttons, and will not 
be able to type a URL into the navigation bar. They will still be able to navigate by clicking links on web pages.

Data

   

Mode Mode controls whether Starting URL or Starting HTML will be used.

Starting URL Starting URL is blank by default. When the client is started, the Web Browser will navigate to the URL entered here if mode is 
URL.

Starting HTML Starting HTML is

<html><body>&nbsp;</body></html>

by default, which gives a blank page. When the client is started, the Web Browser will load the HTML entered here if the mode 
is HTML.

Use Proxies Use Proxies is unchecked by default. If checked, the Web Browser will try to use the proxy settings below.

HTTP Proxy 
Server

HTTP Proxy Server sets the proxy server for HTTP connections. This setting is only used when Use Proxies is checked.

HTTP Proxy Port HTTP Proxy Port sets the proxy port for HTTP connections. This setting is only used when Use Proxies is checked.

HTTPS Proxy 
Server

HTTPS Proxy Server sets the proxy server for HTTPS connections. This setting is only used when Use Proxies is checked.

HTTPS Proxy 
Port

HTTPS Proxy Port sets the proxy port for HTTPS connections. This setting is only used when Use Proxies is checked.

FTP Proxy 
Server

FTP Proxy Server sets the proxy server for FTP connections. This setting is only used when Use Proxies is checked.

FTP Proxy Port FTP Proxy Port sets the proxy port for FTP connections. This setting is only used when Use Proxies is checked.

Proxy Exceptions Domains listed here, such as <local>, will not use the proxy server. This setting is only used when Use Proxies is checked.

Use Proxy 
Authentication

If Use Proxy Authentication is checked, the browser will use the username and password below for proxy authentication. This 
setting is only used when Use Proxies is checked.

https://inductiveuniversity.com/video/web-browser/7.8


Proxy Username The username to use for proxy authentication. This setting is only used when Use Proxies and Use Proxy Authentication are 
checked.

Proxy Password The password to use for proxy authentication. This setting is only used when Use Proxies and Use Proxy Authentication are 
checked.

 

Advanced Usage

The underlying browser component is available in scripting through the getBrowser() method. Documentation on the browser component is available 
at the  . The Inductive Automation support team is unable to provide detailed advice on scripting with this component. JxBrowser Programmer’s Guide
Furthermore, they are unable to provide troubleshooting beyond the basic functionality of the module.

Linux Distributions

Some 32-bit Linux distros are missing a needed library for running the Web Browser: libXss.so.1

Steps that fixed it in Ubuntu 12.04:

sudo apt-get update
sudo apt-get upgrade
sudo apt-get install ia32-libs-multiarch

 

Next...
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High Performance HMI Techniques
 

High performance HMI techniques and practices allow the designer to create designs and displays which help the viewer make the best decision in 
the shortest amount of time after interacting with the HMI.

High performance HMIs often look basic and even boring. Advocates of high performance HMI design would argue that boring is appropriate for a 
process that is running smoothly. The power of this design philosophy is when something does go wrong. A high performance HMI will quickly guide 
the user to the source of the problem through its innovative use of color and alarms. 

In Ignition, you create the high performance HMIs by using components such as , , and  . Here is moving analog indicators sparkline charts radar charts
a comparison of a traditional HMI next to a high performance HMI.

 

Traditional HMI High Performance HMI

 

 

In this section ...

 



Use of Color
 

Colors are an important consideration when designing a high performance HMI where gray-scale colors 
are used instead of the traditional bright red, green, and blue colors.

The person that designs the HMI must understand the diverse audience that may view the HMI. For 
example, an operator may look at a motor on a traditional HMI. If it the HMI has colored the motor green, 
the operator may conclude that the motor is running. However, if a maintenance technician looks at the 
same motor, he may conclude that the motor is not faulted. These are logical conclusions. They reflect 
the respective interest of the person viewing the HMI where the operator wants the motor to run and the 
maintenance technician wants it to be working. 

In reality, the motor is simply "scheduled" to run, meaning when it runs depends on its control 
mechanism. For example, the motor may run when there is product on the line or boxes on the conveyor. 
In other words, the motor may be periodically starting and stopping automatically. 

A high performance HMI can eliminate this confusion by introducing a color that signifies a state of 
"scheduled." A common high performance HMI practice is to use a dark gray to signify a "scheduled" 

should never compete with more alerting colors that "pop" from the HMI state for equipment. This color 
resulting in the viewer's eye's being drawn to the portion of the HMI where the problem may be occurring.

    

Use of Color

Watch the Video
 

 

 

 

 

Colors and Alarm Indicators

Color can play an important role in how an operator responds when problems do occur. High performance HMI design refrains from coloring 
equipment when the equipment is in a state of fault. For example, some equipment may still run when faulted. Instead, an optimized solution is to 
place an   near the equipment in such a way that when the equipment is undergoing some fault, the alarm indicator renders with the alarm indicator
appropriate color and shape. The object and the consequential color should signify the most important alarm state occurring for the equipment at that 
current time.

Technical Considerations with Colors

Some HMIs in industrial settings may temporarily lose their ability to render color because of various environmental factors. High performance HMI 
design incorporates this possibility by encouraging the use of descriptive text with color. For example, motors of two different colors may look the 
same on a color deficient HMI resulting in confusion for the viewer. Even worse, the viewer may misinterpret the motor state and assume everything is 
fine. However, if each motor has a descriptive text such as "Motor 1 is Faulted" and "Motor 2 is Running", the problem associated with a faulty HMI 
failing to display color is largely reduced by the HMI's high performance design.

Accommodating Color Blind Viewers

Common color combinations such as red and green and blue and purple cannot adequately be distinguished by those with color blindness. High 
performance HMI design accommodates color blind uses by combining colors with descriptive text as well as incorporating  in unique alarm indicators
shapes.  

 

Next...

Alarm Indicator

 

 

https://inductiveuniversity.com/video/use-of-color/7.8


Alarm Indicator
 

The high performance HMI design techniques make use of an object called the  which Alarm Indicator
displays a colored shape when there is a problem. This works well with the high performance HMIs as 
color is only used when there is a problem. The Alarm Indicator can contain descriptive text in addition to 
the shape and color, and is usually placed near the component that is causing the problem. You can 
import the Alarm Indicator, shown in the example below, from the .Cloud Templates

The Alarm Indicator represents different levels of alarm with different shapes, color, and descriptive 
text. For example, a motor that exists in an industrial setting is monitored by a high performance HMI. 
There are two alarms on the motor. The first is a critical alarm associated with the motor becoming 
seized, will display as a red rectangle with the letter 1. The second is a high priority alarm associated with 
the motor when overheating, will display as a yellow triangle with the number 2. An Alarm Indicator is 
placed near the motor, positioned in such a way to clearly show motor that the indicator is referring to.

Given this scenario, a high performance HMI will show the Alarm Indicator as in the following examples:

Alarm Indicator

Watch the Video

 

 

 

Example 1

The motor is critically faulted. This is the 
highest priority.

Example 2

Motor is overheating resulting in a high alarm.

 

     

Reducing Ambiguity

A high performance HMI design technique to reduce ambiguity incorporates a line from the Alarm Indicator to the object experiencing the alarm.

The following example shows how this technique can ensure that the viewer associates the correct Alarm Indicator with the correct motor.

 

Next...

Moving Analog Indicator
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1.  

2.  

Moving Analog Indicator
 

The Moving Analog Indicator in Ignition, is another component, on the Display tab of the Component 
Palette, that fits with the high performance HMI techniques and practices. This component displays an 
analog value in context with other information about that value so that you can visually quickly see if the 
value is in the normal range or not. 

When the screen shows just a number on the screen, it is very difficult to see if that number is within the 
normal range or outside of it.

To use the moving analog indicator component

In Designer, drag the   from the   tab of the Component Palette Moving Analog Indicator Display
to your workspace.
 
Use the different properties (for example, Range High, Range Low, and Process Value) in Prope

 to set the different range values.rty Editor
The Desired High and Desired Low properties set the normal ranges in a blue color. 

Moving Analog 
Indicator

Watch the Video
 

 

   

Next...

Sparkline Chart Component
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1.  

2.  

Sparkline Chart Component
 

The sparkline chart is a minimalistic chart component that displays a line-chart history for a single 
datapoint also known as trends. Sparkline or trend charts were invented as a way to show a great deal of 
contextual information in a very small amount of space. 

To use the sparkline chart component

In the Designer, drag the   from the tab of the Component Palette to Sparkline Chart Charts 
your workspace.
 
Use the properties in   to set the different range values.Property Editor
For example, you can use the Desired High and Desired Low properties to set the normal 
ranges in a blue color, as shown below.
The red dot on the Sparkline chart represents the most latest value.

Sparkline Chart

Watch the Video
 

 

 

 

   

 

Next...

Radar Chart Component
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1.  

2.  

Radar Chart Component
 

Another high performance HMI technique is using the Radar Chart. Radar Charts (also know as, spider 
charts or spider plots) are useful for displaying several values at once. Each value is plotted on a 
separate axis. The chart draws a line between the different values, which create a shape that changes as 
those values change. Inside the chart, there is a circle that represents what the chart would look like if all 
of its values were in their ideal range. So the chart lets you quickly see where the values are in 
comparison to where they should ideally be.
 

To use the Radar Chart component

In the Designer, drag the   from the  tab of the Component Palette to your Radar Chart Charts 
workspace.
 
Click on the  icon for the  property in   to set the values.Dataset Viewer Data Property Editor
For each value you enter, an axis is created. For example, you can see below that there are 8 
values in the Dataset Viewer which corresponds to the 8 axis on the Radar Chart. The Min and 
the Max represent the acceptable limits of the Value.
 

You can show live tag values on the Radar Chart by binding the Data property to the Cell 
Update binding type. For example, suppose you had a group of motors. Each motor had a value 
for is current amps, a minimum number of amps, and a maximum number of amps. A Cell 
Update binding can represent each motor. The value, min, and max columns of the Radar 
Chart's dataset can be bound to each motors value, minimum, and maximum amps. The result 
is that different motors with different thresholds of tolerance can be visually represented on 
the Radar Chart.

Radar Chart

Watch the Video
 

 

 

 

 

 

   

 

Next...
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Templates
   

Templates are a simple but a very powerful feature in Ignition that you can use with the Vision windows. The power comes from the ability to 
modify only the template in one location while affecting all of the instances used throughout the project.

HMI and SCADA systems typically have a lot of repetitions in their screens. You might use a group of the same components over and over within 
your project. The data driving each set of graphics is different, but the graphics themselves are copies of each other. You can make a single template 
and use instances of the template over and over again.

 

 

In this section ...  



Template Basics
 

When using templates, you define the graphical display in one place, called the master template. You then use this master template many times in 
your project on multiple windows, thus making a number of template instances. Any changes made to the master template are then instantly reflected 
in all of the template instances. Using templates early in your project development for any repeating displays, can save a significant amount of time 
later on.

Without templates, the only way to do this is to copy-and-paste the components each time you want to represent lets say, a motor. This is simple, and 
it works, but it can cause major headaches and time consuming corrections later on. Because if you ever want to make a change to how motors are 
represented, you're stuck making the change to each copy of the group.

Template Properties

Because the primary use of templates are the ease of maintaining repeated user interface elements, correct use of parameters is of high 
importance. Parameters allow each template instance to reference different data elements of repeated data configurations.

This is very similar to the concept of  . In that case, any   property on the   of the window is used Parameterized Popup Windows Custom Root Container
as a parameter, and is passed into the window when it is opened. Templates take this idea one step further.

Template Parameters and Internal Properties

When you open the  window (r ), you'll Custom Properties ight-click the checkered-box of the template and select Customizers > Custom Properties
notice it is different than all other components. There are two kinds of custom properties here, as follows:

Template Parameters
These parameters appear on each template instance, allowing each instance to be configured differently. Commonly, this is some sort of 
indirection. For example, if you have a template representing motors, you might have MotorNumber as a parameter property. Then you can 
use that property as an indirection variable in other bindings within the template. Parameter properties are not bindable from within the 
template master design. When you use the template to create a template instance, the property becomes bindable. This ensures that the 

 property only has a single binding configured for it.
 
Internal Properties
These properties cannot be used as parameters. It shows up when designing the template master, but it does not show up on the template 
instances. Internal properties are bindable from within the template master design. These properties are intended to be used for the internal 
workings of the template.

Indirection and UDT Tags

There are two primary ways to achieve indirection when using templates. Let's continue to use the example of a motor. Your system has many 
motors in it, and your template is used to display the status of the motors and control the motor's running mode. The goal is to be able to drop 
instances of the template onto your windows, and configure them in a single step to point to the correct motor's tags.

If the tags representing the datapoints of each motor are arranged in an orderly way in folders or with a consistent naming convention, you can 
use standard indirection to configure your template. You can add a parameter such as MotorNum to the template. Then you configure the contents of 
the template using indirect tag binding, where the value of MotorNum is used for the indirection.

If your motors are represented by a custom tag data type, you can save some effort and use a property of that tag type directly. Make your indirection 
property the same type as your custom data type. Then you can use simple property bindings to configure the components inside your template. 
When you create a template instance, you can simply bind that property directly to the correct Motor tag, and all of the sub-tags of motor are correctly 
mapped through the property bindings.

The Drop Target Parameter

When you specify parameters in the  window (right-click the checkered-box of the template and select Custom Properties Customizers > Custom 
), you can set one of the parameters as the Drop Target. This allows you to drop tags onto your template instances to facilitate even Properties

quicker binding. For example, let's say that you have a parameter that is an integer and you've made it the drop target. If you drop an integer tag onto 
a window, your template appears in the menu dropdown list of components which is displayed. Choosing your template creates a template instance 
and binds that parameter to the tag.

This also works for UDT tags. Lets say you have a custom data type called Motor and a template with a Motor-typed parameter set as the drop 
target. If you drop a motor tag onto a window, it creates an instance of your template automatically. If you have more than one template configured 
with Motor drop targets, you have to choose which template to use.

   

   

In this section ...  

   

   



1.  

2.  

About Templates
 

Templates are a simple but very powerful feature that you can use with your Vision windows. Using 
templates, you would define the graphics and parameters in one place, called the master template. You 
then create instances throughout your project that update whenever the master/parent template is 
changed.

To create a Template

Right-click  and choose  from the  the Templates node in the Project Browser  New Template me
nu.
Or you can choose File > New > New Template from the Designer's menu bar.

A checkered box is displayed in the Designer's workspace.
 
Configure the master template the same way you would design windows: by adding 
components to it, and configuring those components using property bindings and scripting.

 See Basic Template for detailed information on creating a template.

 

About Templates

Watch the Video

 

 

Using the Template

Once you have a template, here are some of the things you can do with it. 

Renaming the Template

You can rename your template by clicking on its name in the Project Browser and pressing F2, or changing the name in the Property Editor.

Creating the Template Instances

Once you've made your template, you can use it on any of the windows in your project by doing any one of the following steps:

You can drag the template from the Project Browser into an open window just like you can drag components into the window for display.
You can right-click on the template and choose , which will let you place the template inside a window with another click.Use In Window
You can drag a tag from the Tag Browser to a window and from the pop-up menu, which is displayed, you can choose a template.

The template instance can then be moved and resized like any other component.

Binding Template Properties

Templates have the capability to incorporate custom properties. In this way, they are the same as any other Ignition components. The main difference 
between the custom properties for an Ignition component and a template is that the template has internal properties and template parameters.

 Internal Properties
Internal properties help facilitate the bindings within a template in the same way that a window's root container will help facilitate bindings 
between components that make up the template. When a template is deployed onto a window the internal custom properties are not exposed 
to the world outside the template.
 
Template Parameters
The template parameters are the template's custom properties that are exposed to the outside world. In other words, when a template is 
deployed onto the root container of a window, the template parameters are available for binding with the objects on that window or to tags. 

Editing a Template

You can open a template for editing by double-clicking on it in the Project Browser, or by double-clicking any instance of that template within a 
window. You design your template the same way you design windows: by adding components to it, and configuring those components using 
property bindings and scripting.

There are a few differences between templates and windows from an editing perspective. Templates, unlike windows, have a transparent background 
by default. This can be changed simply by editing the background color of the template. Templates also do not have the concept of the "Root 
Container" - the template itself acts like a container.

Once you change the master template, all the instances of that template are updated.

 

 

Next...

Basic Template

https://www.inductiveuniversity.com/video/about-templates/7.8
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Basic Template
 

Here we create a basic template. After the template is configured, you can create multiple instances of it 
throughout your project.

To create a Basic Template

In the Project Browser, right-click  and select .Templates New Template

A checkered box is displayed in the design space where you design your template. The 
checkered box means that the template is completely transparent. You can set a background if 
you want.

Right-click on   and click  to change its name to something else, lets say New Template Rename
.Motor

 
Right-click on the checkered-box and select .Customizers > Custom Properties

The  window is displayed. Here you can set both the  Custom Properties Template Parameters
and . Internal Properties Template parameters appear on each template instance, allowing 
each instance to be configured differently, this is some sort of an indirection variable. Internal 
properties show up when designing the template master, but they do not show up on the 
template instances.

Each template needs at least one Template Parameter property so that it can exist on 
every instance you put on the screens. Then each instance can bind the parameter property to 
a tag.
In the  window, click the  icon in the to add the Custom Properties  + Template Parameter area 
values.
 
Enter the following and click .OK
Name: value
Type: Integer
Drop Target: select the check box 
 

Basic Template

Watch the Video
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7.  

8.  

9.  

Go to the checkered area of your template, from the Symbol Factory and Component Palette 
drag one or a few components such as a motor, a label, and a Level Indicator.

Resize the checkered area to fit all your components, and not larger, to remove all the unusable 
space.

Now we need to link one of the components, lets say the Level Indicator, to the Template 
Parameter  we created earlier.value

Select the Level Indicator and go to the Property Editor, click on the binding icon for the  Value
property.
The Property Binding window is displayed.

Click the   button, choose the  property, and click .Property value OK

You now have configured a motor template, with a parameter property called  with an  data value integer
type. Use this template to create many instances of it in your project.

 

Next...

Custom Input Template
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Custom Input Template
 

Sometimes you may need to have text fields in your project for the user to input data. Rather than 
copying and pasting these text fields into each window, you can create a template for them that includes 
a label and a text field. A template can contain scripting to validate the data in the text field.

To create a custom input template

In the Project Browser, right-click   and select  .Templates New Template

Right-click on   and click   to change its name it to something, lets say New Template Rename Tex
.t Entry

 
To add a parameter as you always do when creating a template, right-click the checkered area 
and select  .Customizers > Custom Properties
 
In the  window, add two  by clicking the  icon twice Custom Properties Template Parameters  +
and entering the following:
1st Parameter
                          Name: display
                          Type: String 
2nd Parameter
                          Name: text
                          Type: String
 
Click .OK
 
From the Component Palette, drag a  and a  to the checkered area of the Text Field Label
template.
 
Resize the size of the root container's area, the checkered area, so that the label and the text 
box occupy the majority of the space.
 
Select the  component, go to , and click on the binding icon of the   Label Property Editor Text
property.
The Property Binding window is displayed.
 
In the  window, click on , choose the  property.Property Binding Property display

Make sure the  Box is not selected, and click Bidirectional OK. 
Don't worry if the label on the template disappears. Its is simply displaying the value of the 
display custom property which is currently blank.
 
Now select the  component, go to  , and click on the binding icon of Text Field Property Editor
the   property.Text
 
In the Property Binding window, click on Property, choose the text property, and click OK.
 
Make sure the Bidirectional Box is selected.

Suppose you want data validation on the Text Field. We can have the background color of the 
Text Field change depending on whether the user has entered a text value or not. We can set 
the field to red when its empty, and white when it has a value.
 
While the   component is still selected, go to  , and click on the binding Text Field Property Editor
icon of the  property.Background 
 
In the Property Binding window, click on Expression, enter the following expression:

//Inside the if statement is the len and the trim functions that are 
availible when doing expression bindings.
//The trim function will trim the blank spaces from the text 
therefore validating that there is actual text rather than spaces.
//The len function will count the lenth of the recently trimmed text.
//The if statements asks the question: Is the length of the trimmed 
text greater than zero?
if(len(trim({textBox.Text Field.text}))>0,color(255,255,255),color
(255,0,0))

 

Custom Input 
Template

Watch the Video
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Click .OK
 
Close the template, click  on the prompt window, and click .Save OK
 
To set data validation, drag the  template from  to the screenText Entry Project Browser
/window.
Notice that the text field is red.
 
In the , go to the custom property and enter your name. Property Editor text 
Notice your name in the Text Field and that the background color changed to white.

 

 

Next...

Template - Resizing and Enable Layout

 

 



Template - Resizing and Enable Layout
 

You can configure the layout of each template so it resizes properly.

By default, when you drag a template into the window from the Project Browser, the size of the instance 
is exactly the same size as the master template. You can make the size larger or smaller. To go back to 
the same size as the master template, right-click on the instance and choose .Revert to Master size

For every component or template instance you add to the window, you can pick a Layout option as to 
how it is going to resize in the Client. Right-click on the instance, select  from the menu, the Layout
Layout Constraints window displays showing all the default settings.

To learn more about layout, .see the   pageComponent Layout

 

 

If your template instance resizes in the client, then it will stretch all of the components inside it in the 
same way a  works. That is: it will ignore any layout settings and stretch without Component Group
maintaining aspect ratio. If you want the template instances to respect your layout settings, set the Enabl

 property to true in the template definition. e Layout

 

 

Template - Resizing 
and Enable Layout

Watch the Video
 

 

 

 

 

 

Next...

Template - Indirect Binding
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Template - Indirect Binding
 

You can create templates that point indirectly to a set of tags based on a simple parameter. This is very 
helpful when you have a large number of UDTs with the same type of tags that only differ in one 
parameter. For example, lets say you have 100 Motor UDTs that all have the same kind and number of 
tags. The only thing that is different is the Motor number.

If each tag inside the UDT has a tag path that looks like this:

Motors/Motor 1/AMPS

You can create a Template Paramenter property on the Custom Properties window and make it to point 
to one of the tags indirectly, for example, you can call it  .motorNumber

For every component within the template the tag path can be bound with indirection in such a way that 
the Custom property of  substitutes the motor number therefore resulting in a valid tag MotorNumber
path that points to the desired motor.

To learn about indirect tag binding, see Indirect Tag Binding.

Template - Indirect 
Binding

Watch the Video

 

 

   

 

Next...

Template - UDT Parameter
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Template - UDT Parameter
 

User Defined Types (UDT) parameters are properties that you can bind the template components to. 
Since the UDT parameter is a Custom property that encapsulates the UDT tags and some meta 
properties you can access all this information through a custom property.

To add a component to the template and bind it to parts of UDT

Start with a blank template.
 
Add components to the template.
 
Create a  property on the template's Root Container, and make the Custom property's Custom T

 a  type instead of a  data type. ype User Defined Standard
 
Click .OK
 
Select a component on the template, in the component's , click the binding icon Property Editor
next to the property that you want to influence. 
 
Select the  binding and choose the tag from the UDT that you would like the binding to Property
occur. 
 
Click .OK

Template – UDT 
Parameter

Watch the Video

 

 

   

 

Next...

Template Composition
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2.  

Template Composition
 

You can embed templates inside of other templates. The nested template behaves like a component.

To nest a template inside another template

Drag an existing template from the  into the template that you are currently Project Browser
working on.
 
Bind the nest template properties to the properties located on the parent template's  Custom
properties such as UDT parameters. Template 

Composition

Watch the Video

 

 

   

 

Next...
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Template Features
   

Some of the advanced template features in the Designer are: changing Template Path using Template 
Repeater and Cloud Templates.

 

   

   

In this section ...  

   

   



Changing Template Path
 

An instance of a template on a window has a property called . You can change Template Path
this property on a window dynamically, and it can be bound to anything that produces a valid template 
path.

For example, if there are two tank templates in a folder called Tanks, one template is called Tank A and 
the other is called Tank B. Each tank has a different look, but they have the same Custom properties. 
Their respective template paths are Tanks/Tank A and Tanks/Tank B. The template rendered on a 
window can swap between Tank A and Tank B by binding the template's property to any string reference 
that says Tanks/Tank A or Tanks/Tank B.

 
Changing Template 
Path

Watch the Video

   

 

Next ...

Template Repeater Component
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4.  

Template Repeater Component
The  component lets you easily create multiple instances of a master template for Template Repeater
display on the HMI. Each instance shown in the Template Repeater has the same look, feel, and 
functionality of the master template. The instances can be arranged vertically, horizontally, or in a "flow" 
layout, which can either be top-to-bottom or left-to-right. If there are too many instances to fit, a scrollbar 
is added to the display.

 

To customize a template for use in a Template Repeater

By default, the Template Repeater uses integers to manage the templates it displays. The template 
intended for use inside the Template Repeater must therefore be configured so that it can accept these 
integers as pass-through parameters from the Template Repeater.

Let’s customize a template so we can use it with the Template Repeater.
 

Template Repeater

Watch the Video
 

 

In  , right-click  , select   to create a new template.Project Browser Templates New Template
 
Right-click on the New Template, select   and change the name to  .Rename Motor Repeater

We have previously created a  template that includes a Motor (from the Symbol Factory), an LED Display, and a Multi-Motor with Control
State Button. 
 
Drag a   template inside the new   template.Motor with Control Motor Repeater

Select the , right-click on the gray area of Motor Repeater, select  to create a new Motor Repeater Customizer > Custom Properties
custom parameter.

Additional information on the Template Repeater can be found on the Template Repeater page
in the appendix.

https://www.inductiveuniversity.com/video/template-repeater/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Template+Repeater
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In the Custom Properties window, click the  icon for  and type:green + Template Parameters
Name: MotorNumber
Type: Integer

 is the custom property that is required by the Template Repeater component to create and manage all the template instances.MotorNumber
 
Click .OK
 
Select the nested  template.Motor with Control
 
In the Property Editor, under , select the binding icon for the  UDT.Template Properties Motor



8.  

9.  

10.  

In the Property Binding window, click on the tag icon for the Indirect Tag  , select , and click .Path Motor/Motor 1 OK
 

Change  to .Motor/Motor 1 Motor/Motor {1}



10.  

11.  

This indirectly binds the tag path to the address of the motor UDT with the indirection occurring on the number portion of the address.

 
In the  section, click in the area under Ref.# and then click the binding icon, select the  property, and click .References MotorNumber OK
Now, when we pass a number into the Motor Repeater, the number will populate the nested template’s information.

To test the new template, select the Motor Repeater template, change  to a different number, and see the Motor number MotorNumber
changes as well to the same number you specified.



11.  

1.  

2.  

3.  

4.  

That’s it! The Motor Repeater template is now configured to accept integers from the Template Repeater component. 

To use a Template Repeater and fill it with a template

Let’s use the Template Repeater component from the Component Palette and fill it with our newly created Motor Repeater template.

Go to a Main Window, and from the Component Palette, drag the Template Repeater component into the window. 
The Template Repeater displays as a small dashed box.

 

Resize it to at least twice the height and width of your Motor Repeater template.
 
While the Template Repeater is still selected, go to Property Editor.
 
Click the dropdown for  and select the  template.Template Path Motor Repeater
The dropdown menu shows all three templates we created earlier.



4.  

5.  

6.  

 

Below the  property is the  property which has a dropdown menu with two options, they are:Template Path Repeat Behavior

Count
Repeats the template a number of times, assigning each template an index number. The Count number starts at zero and increments 
upwards.

Dataset
Repeats the template once per row in the  dataset.Template Parameter

We will look at using both options. First, let’s use the  option.Count
 
Select  from the dropdown menu of .Count Repeat Behavior

 
 
Set  to the number of times you want the Template Repeater to repeat the template.Repeat Count

For example, here we set Repeat Count to 2, and so 2 templates are repeated in Template Repeater.



6.  

7.  

8.  

 

Change the  entry in   to  to apply the MotorNumber custom property to the Template Repeater.index Index Parameter Name MotoNumber
The Template Repeater now fills with the motors starting with Motor 0. As there is no Motor 0, the Template Repeater displays the motor 
as “unfound” and is displayed in black. 

Again, notice that the Count property begins its count at zero.

 
Now lets use the Dataset option.

Select  from the dropdown menu of the .Dataset Repeat Behavior
This allows the Template Repeater to index through a dataset. 



8.  

9.  

10.  

11.  

The Dataset option overcomes the “unfound” problem we had with the Count option and offers a lot of flexibility in how the motors are 
created and displayed in Template Repeater.
 
Click on the Dataset Viewer icon for .Template Parameters
 
In the Dataset Viewer window, click the Add Column icon, type   as the Column Name and select Integer as the column type, MotorNumber
then click .OK
Now we have a one column dataset with a header name that is the same as the Custom property on the Template Repeater.

Click the Add Row icon four times to get four rows, and change the row numbers from 0 to 1-4 to display Motors 1-4, and click OK.



11.  

12.  

 

The Template Repeater component now fills with the motors as you specified them. In this case, they are displayed as One column of 1-4.
 
Go to Preview Mode and notice that the Scroll bar allows for you to view all the Motors.



12.  

 

Next...

Cloud Templates
Template Repeater
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2.  

Cloud Templates
 

Cloud Templates is a free online repository of templates hosted by Inductive Automation. You can share 
your templates publicly or store them privately as well as browse the library of templates to help get your 
project off the ground faster.

Importing Cloud Templates

Cloud Templates give the Ignition community access to pre-built templates and allows users to share 
their own templates. Using Cloud templates, an Ignition developer can store templates for private use or 
public access outside the local Gateway, and make the templates available from any 
Designer regardless of the project or Gateway.

Because the templates are accessible from any Designer, there is no longer the need to manually port 
the templates from Gateway to Gateway.

The Cloud templates are entirely customizable after you import them from the Cloud. And unlike other 
Ignition templates, changes to the templates in the Cloud do not affect those template instances 
previously downloaded. Note that the public Cloud Templates are all free to use.

  

Cloud Templates

Watch the Video

To import a Cloud template

Let’s import a template from the Cloud.

From the  expand .Project Browser Project
 
Right-click on  and select  from the popup menu.Templates Cloud Templates Browser

 
The  is displayed.Cloud Templates Browser

The list of categories of Cloud templates for download are located on the left of the browser. This list is divided into  and  Private Public
templates. The   templates are displayed by default, but to see your templates, you must sign in with your Inductive Automation Public Private 

https://inductiveuniversity.com/video/cloud-templates/7.8
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account.

 

 
Select  from the  list.Alarms Public
All publicly available templates for the Alarms category are displayed along with a description for the selected template.
 
Select the  template and click .Alarm Indicator Import Template

A new popup appears allowing you to confirm import on the template.
 
Click  to confirm importing the template.Import



5.  

 
 

The template is now imported and available for use within the section of your . You can drag your new template Templates  Project Browser
on a window or modify it however you like!

 

Next...
 

 





SQL in Ignition

What is SQL?

SQL or Structured Query Language is a standard computer language for accessing and manipulating database systems. SQL statements are used to 
create, maintain, and query relational databases.

Examples

SELECT Firstname FROM Contacts WHERE Lastname = 'Smith'
INSERT INTO Contacts VALUES ('Joe', 'Smith')
UPDATE Contacts SET Lastname = 'Howard' WHERE ID = 1
DELETE FROM Contacts WHERE Lastname = 'Smith'

Tables

The foundation of every database system is a table. Every database consists of one or more tables, which store the database’s data/information. Each 
table is identified by a name, for example, or , and consists of columns and rows. Customers Orders

The database table columns have their own unique names and have a pre-defined data types. Table columns can have various attributes defining the 
column functionality (such as the primary key, index, default value, and so on).

While table columns describe the data types, the table rows contain the actual data for the columns.

Primary Key

A primary key is a way to uniquely identify each row in a table. Every table must have a primary key. A primary key comprises of a single column or 
set of columns.
No two distinct rows in a table can have the same value (or combination of values) in those columns.

The Primary Key can be:

Auto-incrementing
Statically defined

Index

Indexes speed up the querying process by providing swift access to rows in the data tables, similarly to the way a book’s index helps you find 
information quickly within that book.

Indexes are extremely important when querying large sets of data. You should create an index for each set of columns you specify in a  clause. where
For example, you should add an index on the timestamp
column of a historical table when querying the table by a start and end date.

Foreign Key

A foreign key is a referential constraint between two tables. The foreign key identifies a column or a set of columns in one (referencing) table that 
refers to a column or set of columns in another (referenced) table.

The columns in the referencing table must be the primary key in the referenced table.

Examples

Supplier ( SupplierNumber, Name, Address, Type )
Invoices ( InvoiceNumber, SupplierNumber, Text )

For information about databases and how they are used in Ignition, see the   section.Database Connections



NULL Value

NULL is a special marker used in SQL to indicate that a data value does not exist in the database.

SELECT Command

The SELECT statement is used to select data from a database. The result is stored in a result table, called the result-set.

Examples

SELECT * FROM Customers
SELECT Name FROM Customers
SELECT Name, Address FROM Customers

UPDATE Command

The UPDATE statement is used to update records in a table.

Examples

UPDATE Customers SET Name = 'Inductive Automation'
UPDATE Customers SET Address = '2110 21st Street' WHERE ID = 1

INSERT Command

The INSERT statement is used to insert a new row in a table.

Examples

INSERT INTO Customers (Name, Address, City, State, Zip, Country, Phone)
VALUES ('Inductive Automation', '2110 21st Street', 'Sacramento', 'CA',
'95818', NULL, '800-266-7798')
INSERT INTO Customers SELECT * FROM OtherCustomers

DELETE Command

The DELETE statement is used to delete records in a table.

Examples

DELETE FROM Customers
DELETE FROM Customers WHERE Name = 'Inductive Automation'

WHERE Clause

The WHERE clause is used to extract only those records that fulfill a specified criterion. Operators Allowed in the WHERE Clause are as follows:

= Equal
<> Not equal
> Greater than
< Less than
>= Greater than or equal
<= Less than or equal
BETWEEN Between an inclusive range
LIKE Search for a pattern
IN If you know the exact value you want to return for at least one of the columns

The AND & OR operators are used to filter records based on more than one condition.

Examples



SELECT * FROM Customers WHERE State = 'CA'
SELECT Name FROM Customers WHERE Address LIKE '%St%' AND State = 'CA'

ORDER BY Clause

The ORDER BY keyword is used to sort the result-set by a specified column. The ORDER BY keyword sort the records in ascending order by default. 
If you want to sort the records in a descending order, you can use the DESC keyword.

Examples

SELECT * FROM Customers ORDER BY Name ASC
SELECT * FROM Customers ORDER BY State ASC, Name DESC

Joins

The JOIN keyword is used in an SQL statement to query data from two or more tables, based on a relationship between certain columns in these 
tables. Tables in a database are often related to each other with keys. A primary key is a column (or a combination of columns) with a unique value for 
each row. Each primary key value must be unique within the table. The purpose is to bind data together, across tables, without repeating all of the 
data in every table.

JOIN: Return rows when there is at least one match in both tables
LEFT JOIN: Return all rows from the left table, even if there are no matches in the right table
RIGHT JOIN: Return all rows from the right table, even if there are no matches in the left table
FULL JOIN: Return rows when there is a match in one of the tables

Example

SELECT * FROM Contacts ct JOIN Customers cn ON cn.ID = ct.CustomerID

GROUP BY Clause

The GROUP BY statement is used in conjunction with the aggregate functions to group the result-set by one or more columns.

Example

SELECT SUM(Duration) FROM Downtime GROUP BY CauseID

 

 

In this section ...

 



Querying, Adding, and Editing Data
 

Ignition offers a number of built-in scripting functions for you to use when running queries against the database. Depending on the type of your query 
and the sort of results you want, you will use a different function. The following functions are the ones you will use most:

Scripting Function Description

system.db.runPrepQuery  Use this function to run basic SELECT queries against your database using a special placeholder (?) to allow for 
dynamic   building.query

system.db.runPrepUpdate Use this function to run queries that change the data in the database. This function also makes use of the (?) 
placeholder.

system.db.runScalarQuery Use this function when you want only the value from the first column of the first row of your query to return.

system.db.createSProcCall
and
system.db.execSProcCall

Use these functions together to execute any stored procedures you may have in your database.

Note the options provided by each of the different functions. For example, the options that return auto-generated key for insert queries can be 
extremely helpful and eliminate the need to hit the database multiple times.

You can find examples of each of these functions in their linked topic sections.

 

In this section ...
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Querying Data from Database
 

Use binding to bring back data from your database. By using the Polling Mode of the property binding, 
you can specify how often or at what rate you want to bring back the data.

To display data from the database on a table component

If a database is connected to your ignition server, you can display data from that database on a table 
component.

In the Designer, from the Component Palette, drag a  or  component to your Table Power Table
window.
While the component is selected, you can see all the properties that are related to the 
component in the Property Editor.
 
In the , click the binding icon of the  property.Property Editor Data
The Property Binding window is displayed.
 
Select the  database option.DB Browse
 
Under the  box, find the table from the list of database connections and Browse Database
expand the table to inspect the table's columns.
 
By default, the query is built with a  clause. If you want to return all the data from the where
table, deselect the primary key option associated with the table's primary key by selecting the 
column and clicking the  icon. To access the key column, select the column that is bold and Key
then deselect the Key icon.
 
To choose which columns are returned, select individual columns from the column selector, or 
hold the shift button and select multiple columns.
 
Select the  to specify how the Client will refresh the table data with new Polling Mode
information from the database.
When Polling Mode is set to OFF, this ensures the SQL query on a SQL binding only runs when 

.the window is opened or a referenced property changes value

As you build a query with this method, the resulting SQL statement is being built in the bottom part of the 
property binding management screen.

Querying Data from 
Database

Watch the Video

 

 

 

Next...

Filter Data in Table
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Filter Data in Table
 

Filtering table data by using a drop-down box is possible, if the  component's  property is Table Data
bound to a SQL query, thus dynamically modifying the  clause of a query, or creating a whole WHERE
custom  clause. To implement this solution, you must have a  component and a WHERE Table Dropdown 

 component on a window.List

Many SQL queries have clauses that filter the result returned from the database. When a SQL WHERE 
query examines the contents of a table it evaluates each row against the  clause. If the clauWHERE WHERE 
se is true, the row is included in the data-set, otherwise, it is not included in the data-set. 

With SQL queries you can use the  clause to your advantage when building interactive WHERE
screens. For example, the following SQL query will filter the result set in such a way that the data-set 
returns only tanks from Area A.

SELECT * FROM tanks WHERE area = "Area A"

While the following query will return everything, but still will evaluate the query's  clause.WHERE

SELECT * FROM tanks WHERE 1=1

In this case  will always evaluate as true, therefore the query will return every row.1=1

Imagine if you had a drop-down component near the table, and the drop-down component's  Data
property was populated with the following data:

Value Label

0 Area A

1 Area B

2 All

This data can help to create the  clause. The first step is to create a  property on the drop-WHERE Custom
down list.

Right-click on the drop-down component and select .Customizers > Custom Properties
 
Create a new property and name it , and it must be a  data type. WhereClause String
 
Click .OK
 
Select the binding icon for the new  property and select  binding.Custom Expression
 
The expression binding should look something like this:

if(
{Root Container.Dropdown.selectedStringValue}="All", //Evaluate this and 
return a true or a false.
"1=1",  //Return 1=1 if the statement was true.
"Area = '"+{Root Container.Dropdown.selectedStringValue}+"'")   
//Otherwise return a different where clause.

When you select a different option from the drop-down component the binding gets re-evaluated on the 
table's data binding resulting in the query executing with the new  clause.WHERE

You may want to turn Polling Mode off on the tables Data property binding in order to limit the periodic 
querying of the database.

Filter Data in Table

Watch the Video

 

 

   

 

Next...

Add Data to Database
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Add Data to Database
 

A common way to insert information into a database is to execute a SQL query after the user presses a 
button. The button can run a script to collect the information it needs to go into the database and then 
execute a SQL  statement.INSERT

Suppose you had a window that had three components and a button. A script executed on the button's ac
 event handler would collect the relevant properties and insert them into a database. Here tionPerformed

is some example code:

firstName = event.source.parent.getComponent('FirstName').text
lastName = event.source.parent.getComponent('LastName').text
age = event.source.parent.getComponent('Age').intValue
 
query = "INSERT INTO people (FirstName, LastName, Age) VALUES (?,?,?)"
args = [firstName, lastName, age]
system.db.runPrepUpdate(query, args)

This code assumes that there is a table that exist with the correct column names. Also, it probably has an 
auto-incrementing ID column as many tables do.

Add Data to 
Database

Watch the Video
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Edit Data in Database
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Edit Data in Database
 

A table component can do more than show data from a database. A properly configured table can make 
the data of the table accessible to the client and allow the user to edit the data in realtime. Suppose your 
database had a table like this:

 

id UserName FirstName LastName Notes

1 JS John Smith Likes bikes

2 LJ Luke Johnson Lives in town

3 PB Peter Burke Enjoys cooking

The following is an example of using the  component as opposed to the  component.Table Power Table

Start with a window that has a  on it.Table
 
Bind the Table's  property to a SQL table. Data
The data will appear in the table.
 
Right-click on the  and select  .Table Customizers > Table Customizer
 
Select the  check box for each of the table's columns that the user will be editing.Editable
 
Right-click the table and select . Scripting

 
Create a script in the table's  event handler. cell > cellEdited
Using the following script will allow your table to be editable from a Client. The script works with 
a table that looks like the table above. Your table may be different.

id = event.source.data.getValueAt(event.row, 'id')        #Get the 
id of the database column.
headers = system.dataset.getColumnHeaders(event.source.data)   #Get 
the headers
query = "UPDATE User SET %s = ? WHERE id = ?" % (headers[event.
column])
args = [event.newValue, id]
system.db.runPrepUpdate(query, args)

The following is an example of using the  component.Power Table

Start with a window that has a   on it.Table
 
Bind the Table's   property to a SQL table. Data
The data will appear in the table.
 
Right-click on the   and select  .Table Customizers > Table Customizer
 
Select the   check box for each of the table's columns that the user will be editing.Editable
 
Create a script in the table's  extension function by selecting the onCellEdited onCellEdited
extension function. Enable the function.
Using the following script will allow your table to be editable from a Client. The script works with 
a table that looks like the table above. Your table may be different.

id = self.data.getValueAt(rowIndex, 'id')        #Get the id of the 
database column.
query = "UPDATE User SET %s = ? WHERE id = ?" % (colName)
args = [newValue, id]
system.db.runPrepUpdate(query, args)
system.db.refresh(self,"data")

Edit Data in 
Database

Watch the Video
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Refreshing SQL Data on Component
 

The SQL query that populates a data property on a component will refresh its data periodically if the 
polling mode is set to either relative or absolute. However there are times when you want the data to 
query the database once when the window is opened and then retain explicit control over each 
subsequent refresh. The most common way to do this is to have a button near the component that 
instructs the component's data property to refresh. Any property that is refreshed can be any property 
that has a binding to a SQL database.

To update a component's property with scripting

Select the property on the component that you want to manually update.
 
Create the SQL binding on that component, and for , select .Polling Mode Off
 
Create a  inside the same  as the component that has the SQL binding.Button Root Container
 
Access the Button's scripting by double-clicking on the  and selecting the  Button Script Editor
tab.
 
Using the  nter your script that updates the  property on the system.db.refresh() function, e Data
component with the SQL binding. This required you to select a reference to the component, and 
the name of the property to refresh. IE:

system.db.refresh(component, "propertyName")

Click .OK

 

 

Refreshing SQL 
Data on Component

Watch the Video
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Deleting Multi-Selected Rows from Table
 

A common user experience is to select multiple rows of a table and then delete those rows from the 
database by clicking a Delete button. When the user selects more than one row in a table, there is a 
special function available on the table that makes accessible the row indexes of the table as a Python 
list. This list can be iterated through in order to delete the selected rows from the database as shown in 
this example code that can be called from a button's  event handler.actionPerformed

data = event.source.parent.getComponent('Table').data   #Get the data from 
the table and assign it to the variable called data.
rows = event.source.parent.getComponent('Table').getSelectedRows()   #Get 
the rows of the data that the user has currently highlighted.
 
for row in rows:        #Iterate through each row of the list that is 
associated with the rows variable.
        id = data.getValueAt(row, "id") #Get the value associated with the 
current row and the the column called "id"
        system.db.runPrepUpdate("DELETE FROM tableName WHERE id = ?", 
[id]) #Run the query to delete from the database.

This code makes a few assumptions. First that there is table named  in your database, and tableName
that the table's Data property is bound to the same table.

Deleting Multi-
Selected Rows 
from Table

Watch the Video

 

 

 

Next...
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Database Examples
   

Here are examples on how to store information in a database to do more with Ignition.

 

 

In this section ...
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Comments Panel Component
 

The following feature is new in Ignition version 7.8.1
 to check out the other new featuresClick here

There are many ways to set up the  component, but the same first few steps exist in all Comments Panel
cases to get started. To set up a simple  example, here are the basic steps:Comments Panel

Add the   component to a window.Comments Panel
 
Create or locate a database table to store notes in. You can follow the sample table in the "data" 
property of the  Component.Comments Panel
 
Add a SQL query to the "data" property of the component to fetch the notes. Make sure to sort 
the records by timestamp so your newest comments are on top.
 
Save your project and test it out! 

 

By default, a certain database structure is expected. If you want to use different tables, the Extension 
Functions on this component must be modified.

 

 

Example 

Three-Table (default) Configuration

Three-Table Configuration: Required Database Tables

The default behavior of the component expects three database tables be present under the same database connection, and each table needs 
to have certain columns with specific names.

 

Table:Notes 

Column 
Name

Description Data Type

id An auto-incrementing integer that is the primary key. This maps to the ID field in the 
dataset.

Integer

whoID A mapping to the Username field in the dataset Integer

tStamp A mapping to the Timestamp field in the dataset Date or Datetime

note A mapping to the NoteText field in the dataset Varchar

filename A mapping to the AttachmentFilename in the dataset Varchar

sticky A mapping to the Sticky field in the dataset Boolean or Integer

Looking for documentation on the legacy Comments Panel component? Please see the Legac
 page.y Comments Panel

Not sure which version you are looking at? The Legacy version of this component has several 
properties that the new one does not: "Insert Query 1", "Insert Query 2", "Delete Query", 
"Unstick Query", and "Download Attachment Query".

Additional documentation on the Comments Panel component can be found in the Appendix

The following section assumes the default configuration: all Extension Functions on the component are disabled.

https://docs.inductiveautomation.com/display/DOC/New+in+this+Version#NewinthisVersion-Newin7.8.1
https://legacy-docs.inductiveautomation.com/display/DOC/Legacy+Comments+Panel
https://legacy-docs.inductiveautomation.com/display/DOC/Legacy+Comments+Panel
https://legacy-docs.inductiveautomation.com/display/DOC/Comments+Panel


attachment A column to hold the attachment data. LongBlobs do not exist in MSSQL, so a 
varbinary type must be used

LongBlob or Varbinary (depending on 
database)

 

Table: ItemNotes

Column 
Name

Description Data 
Type

accountId  An automatically generated UUID for the Comment Panel instance. You can use the accountId in a WHERE clause 
on the data property so that the component only shows notes from a particular Comments Panel in the project.

Varchar

noteId An integer that maps to the ID column on the Notes table Integer

Tables: Users

Column Name Description Data Type

id An integer that is inserted into the whoID column on the Notes table Integer

username  The username of the user that created the note Varchar

Three-Table Configuration: Configuring the Data property

This component expects that its dataset is populated with the following columns. The names do need to be exact, but different names can be 
used as long as the query that builds the dataset uses aliases. The data type for each column in your notes table must match the table below.

Column Name Description Data Type

id an integer that should be the primary key for the notes table. Used for deleting and looking up 
attachments

integer

username (or 
whoid)

the user who added the note string/varchar

tstamp when the note was added date or dateTime

note The text of the note itself string/varchar

filename filename for a file attached to the note string/varchar

sticky 0 or 1 indicating whether or note the note is "sticky", which means it gets highlighted and put at the 
top

boolean or 
integer

The comments panel also has a set of default queries to handle adding, deleting, and unsticking comments. The default queries expect certain 
database tables and columns to be set up. If your database is set up differently, or your dataset is different than the default, remember to enable 
the Extension Functions and provide the correct names.

Example

The following query returns note data from the above tables, and displays the data on a Comments Panel component. This query should be 
placed in a SQL Query binding on the Data property

 SELECT 
        notes.id,
        users.username 
as whoid, 
        notes.tstamp, 
        notes.note, 
        notes.filename, 
        notes.sticky
        
FROM 
        notes
        JOIN users
        ON notes.whoid 
= users.id



        
ORDER BY
        notes.tstamp 
DESC

 

 

 

 

 

Next...

Storing Files in a Database
Comments Panel
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Storing Files in a Database
 

Ignition can display and store PDF files from data stored in databases.

Displaying PDF files from the database

Ignition can render the PDF inside the PDF viewer component. The PDF viewer component is included 
with the . To view PDF files in the Client, your Ignition server must have this Reporting Components
module. Once the module is installed, you can load the bytes from the database into the PDF viewer 
component with the following script which is enacted on a drop-down component property event handler.

id = event.newValue  #First get the id from the dropdown.
bytes = system.db.runScalarQuery("SELECT data FROM documents WHERE id = %
d" % id)  #Query for the raw pdf data by using the id.
name = system.db.runScalarQuery("SELECT name FROM documents WHERE id = %d" 
% id)   #Query for the file's name by using the id.
event.source.parent.getComponent('PDF Viewer').loadPDFBytes(bytes, name) 
#Load the bytes and the name into the PDF viewer component.

Uploading PDF files to the database

Ignition can upload PDF documents to a database. Imagine the user selecting a button, a file browser 
pops up, the user selects the PDF file, presses enter and the file gets uploaded into the database. The 
following script demonstrates how this might work:

path = system.file.openFile("pdf")   #Find the path to the PDF file.
data = system.file.readFileAsBytes(path)   #Read the file as bytes.
name = system.gui.inputBox("Enter a name for the file")   #Have the user 
enter a name for the file.
system.db.runPrepUpdate("INSERT INTO documents (name, data) VALUES (?,?)", 
[name,data])  #Insert the data and name into the database.

Storing Files in a 
Database

Watch the Video

 

Next...
 

 

ach column In a database, e
is a certain datatype. The 
datatype where you can 
store PDF bytes is a 
LONGBLOB datatype, 
therefore to insert the PDF 
file's bytes to a column the 
column's datatype must be a 
LONGBLOB.

https://legacy-docs.inductiveautomation.com/display/DOC/PDF+Viewer
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Scripting
   

Scripting is used in many places in Ignition to add a significant degree of flexibility and customization where pre-canned options fall short. There are 
two major scripting languages in Ignition, Python and the Expression Language. It is important to understand the differences between the two, and to 
know where each is used.

What is Python?

Most of the time when we talk about "scripting" we're talking about Python scripting. Python is a general purpose programming language that was 
developed in the early 90's and has gained significant popularity in the 2000's. We like it because it is extremely readable, elegant, powerful, and easy 
to learn. As an added bonus, it gracefully interacts with Java, giving programmers an extremely powerful tool when paired with Ignition, which is 
written in Java.

Since Python is such a popular and well-regarded language, there are many high-quality tutorials available on the web. The official Python tutorial, 
written by the inventor of Python himself, Guido van Rossum, is very good. https://docs.python.org/2/tutorial/index.html

Python or Jython?

You'll often hear Python referred to as "Jython" by advanced users of Ignition. Python is the language, Jython is the implementation of the language 
that we use. Most users of Python use the implementation called "CPython" - they just don't realize it. See http://en.wikipedia.org/wiki/Python_

.(programming_language)#Implementations

Why not VBA?

Many HMI/SCADA packages use VBA, or Visual Basic for Applications. As such, many engineers switching to our software inquire about it. There are 
a variety of reasons we don't use VBA:

It is not compatible with Java, the language that Ignition is written in. This also means that it is not cross-platform.
It is a dying language (Microsoft has phased it out as of July, 2007).
It is full of security holes.
It is an ugly language!

Where is Python Used?

Python is used in many places in Ignition. The most apparent place is in component  . Project   are another major place event handlers event scripts
where Python is used.

Which version of Python is Used?

Ignition uses Jython 2.5. Jython is the Python programming language implemented over the Java Virtual Machine. When looking at outside 
documentation, such as on  , verify that you are looking at the correct version of the documentation.www.python.org

   

What is the Expression Language and how is it different from 
Scripting?

The Expression Language is a simple language that we invented (very similar to many other existing 
expression languages), and is different from the Python scripting you will find in Ignition.  The expression 
language is a very simple kind of language where everything is an expression - which is a piece of code 
that returns a value. This means that there are no statements, and no variables, just operators, 
literals, and functions. The most common expression language that most people are familiar with is the 
one found in Microsoft Excel. You can have Excel calculated a cell's value dynamically by typing an 
expression like  . Our expression language is similar. It is used to define dynamic values =SUM(C5:C10)
for tags and component properties.  The Expressions and Python are often confused but they are used in 
very different spaces.  The Expression language is most commonly used in  , and the expression bindings
Python language is used in Ignitions  .Events

 

   

In this section ...  
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Scripting Basics
 

In this section ...

 



Scripting Intro
   

About Python

While it is entirely possible to create a complete and powerful project in Ignition without writing a line of 
script, many designers will find that in order to complete projects with specific requirements, they need to 
learn at least a little Python. In our experience, most industrial projects involve lots of very complex and 
specific requirements. 

The good news is that learning Python is easy and . Python is one of the most beautiful  enjoyable
programming languages we've ever encountered. It is very easy to read - even if you don't know it at all, 
you will probably be able to understand a basic Python script. It is frequently called "executable 
pseudocode". We've included a short tutorial here which should help get you started. If you find yourself 
doing a lot of scripting, you may want to pick up a basic reference book about Python.

Getting Help with Scripting

Scripting is one of the topics in Ignition that users frequently need help with, because it is used to achieve 
some of the most complex requirements of a project. If you get stuck designing a script, or would like 
help getting started, don't hesitate to get some help from our user forum at http://www.

, it is by far the best place for scripting help.inductiveautomation.com/forum

When asking for scripting help - be precise and complete. If you're working through an error - include the 
text of the error, the circumstances, and the offending code. If you're stuck on something, it is helpful to 
describe the broader goals of what you're trying to accomplish - there is often an easy way and a hard 
way. Don't be shy to simply ask for some direction getting started.

Under the Hood - Python in Java

The implementation of Python included in Ignition is Jython 2.5. While this is not the "latest" version of 
Python, it supports the vast majority of what people consider "python". The latest version of Python, 
version 3, is actually more of a branch, with many significant changes. The vast majority of sample code 
to be found was written against version 2.

One of the powerful things about using Jython is that your script has access to the entire Java standard 
library. In the Client, this will be Java 5 or above. When running under the Gateway, this will be Java 6 
and above. For more information, see  .Accessing Java

Many scripting users are blown away by their script's speed. We can't take credit for this - the Jython 
engine hot-compiles (compiles the code when it is run) your Jython code to Java bytecode, which means 
it runs natively in the JVM, which in turn can hot-compile it to machine code. It's fast.

  

Scripting Console

Watch the Video
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Scripting Console
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Scripting Console

 

The Script Console is a live python terminal that is only accessible in the Designer. It is a great way to 
very quickly test a script as it does not rest on a scripting event or specific component.

The Script Console can be opened via the   menu. It consists of two parts: a Tools > Script Console
Multiline Buffer, and an Interactive Interpreter. Code can be typed into both sides.

Due to the scope of the Script Console, it can not interact with components on a window.

It can call Project and Shared scripts. If a Project or Shared script was recently added, then the conosle 
will need to be reset before they may be called. This can be accomplished by clicking on the Reset 
button.

 

Scripting Console

Watch the Video

 

 

Features

There are two buttons located on the right side of the console.

 
 

Clear   clears the text from the Interactive Interpreter. 

Reset   clears the text and deletes all user defined objects (variables and functions) from the interactive Interpreter. 

 

Gateway scoped information will not appear in either the Script Console or Output Console. 
Instead they will output to the wrapper.log file. Alternatively  will send system.util.getLogger()
messages to the Gateway Console, and is a preferred method of troubleshooting gateway 
scoped scripts.

https://inductiveuniversity.com/video/scripting-console/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/system.util.getLogger


 

Multiline Buffer

The Multiline Buffer, located on the left side of the Script Console, allows for multiple lines of code to be entered and then executed by clicking on the 

 button. All print statments will output to the Interactive Interpreter. Supports code folding for function definitions and comments.

 

Font Size Adjustment

The Font size in the Multiline Buffer can be adjusted by holding Ctrl and scrolling the mouse wheel

Right Click Menu

Right clicking on the Multiline Buffer opens a menu. Most of the options in the menu are self explanatory. The rest are defined below:

Folding

Name Description

Toggle 
Current 
Fold

Expand or collapse the fold where the text cursor is located.

Collapse 
All 
Comments

Collapse all instances of multi-line comments. Only contiguous comments are collapsible. 

Collapse Collapse all expanded folds.



All Folds

Expand 
All Folds

Expand all collapsed folds

Autocompletion

Name Description

Automatic 
Activation 

Determines if the Autocompletion window to automatically appear. When set to true, the window will appear after a second of 
inactivity once at least "system." has been typed. When set to false, the window can still be brought up manually by pressing Ctrl+S
pace

Show 
Descriptio
n Pane

Determines if the Description pane should appear in the Autocompletion window.

Themes

Name Description

Default Uses the default theme with light background, dark characters

Dark Uses a dark theme with dark background, light characters

Visual 
Studio

Uses a theme reminiscent of Visual Studio. Light background, dark characters

 

Find/Replace

Pressing while the text cursor is in the Multiline Buffer opens a Find and Replace window. This will search for instances of text throughout the Ctrl+R 
Multiline Buffer, and allows the user to replace all or some instances with new text.

Keyboard Shortcuts

The following shortcuts apply only to the Multiline Buffer

Key(s) Description



Ctrl + </> (on the number pad) Collapse all folds

Ctrl + <*> (on the number pad) Expand all folds

Ctrl + <-> (on the number pad) Collapse the fold on the same line as the text cursor

Ctrl + <+> (on the number pad) Expand the fold on the same line as the text cursor

Ctrl + <Space> Open Autocompletion window. By default, the window will automatically open once " " has been typedsystem.

Ctrl + <R> Open Find/Replace window

Ctrl + <Mouse Wheel Scroll> Increase and decrease the font size

Interactive Interpreter

The Interactive Interpreter is located on the right side of the Script Console, and allows you to run a single line of code at a time. Code is executed 
from the Interactive Interpreter by pressing the Enter key. Print statements from both sides of the Script Console will appear in the Interactive 
Interpreter. 

The Interactive Interpreter has access to the current working environment, so items such as Project and Autocompletion window available in the 
Shared scripts will appear. This will automatically appear, but can be called manually.

Keyboard Shortcuts

The following shortcuts apply only to the Interactive Interpreter

Key
(s)

Description

Ctrl + 
<L>

Clear the Interactive Interpreter. Functionally the same as clicking the Clear button

Ctrl + 
<R>

Reset the Interactive Interpreter. Functionally the same as clicking the Reset button

Up 
arrow

Cycle backward through command history

Down 
arrow

Cycle forward through command history

Ctrl + 
<C>

Keyboard interrupt

Ctrl + 
<Space>

Open Autocompletion window. By default, the window will automatically open once "<object>." has been typed (assuming a valid 
object such as "system" or "project" if a Project script has already been defined

Ctrl + 
<A>

Move the text cursor to the start of the line. Similar to pressing the Home key



Output Console

The Output Console is the script-writer's best friend. It is a dockable panel, and can be opened via the   menu or the   keybTools > Console Ctrl-Shift-C
oard shortcut.

The output console is most frequently used to test and debug Python scripts on components in Ignition. By using the  keyword in your script, you  print
can observe the inner workings of your script as it executes. For example, if you executed the following script:

# A function that intercepts tag writes, printing out the previous value first
def writeToTag(path, value):
   prevValue = system.tag.getTagValue(path)
   print "Writing value '%s' to %s, was previously '%s'" % (value, path, prevValue)
   system.tag.writeToTag(path, value)
 
writeToTag("Compressor/HOA", 2)

It would print the following to the console:

Writing value '2' to Compressor/HOA, was previously '0'

 The output console is also available in the Vision Client from  .Note: Help > Diagnostics

 

Next...

Python Variables

 

 



Python Variables
 

Variables are created by simply assigning a value to them. Variables do not need to be declared, 
because Python has a  . That means Python figures out the type of the variable on dynamic type system
the fly, when the script is executed.

The following script would print out: 15

x=5
y=3
print x*y Python Variables

Watch the Video

 

 

 

 

Next...

Python Datatypes

 

 

https://inductiveuniversity.com/video/python-variables/7.8


Python Datatypes
 

Strings, Numbers, and Booleans

Literal strings can be typed in using either double quotes or single quotes. This can be handy when your string contains one quote or the other. You 
can also use the backslash character to escape special characters. Strings that contain characters beyond 7-bit ASCII, such as é or  need to be 
marked as unicode strings by placing the letter u in front of the string. There is no harm in marking all strings as unicode strings. The following prints a 
unicode string:

print u'été'

The None Value

There is a special value in Python called   (with a capital N). This is simply a special value that means: no value. This value is equivalent to Java's None
 value.null

List

In Python, lists (arrays) are a built-in type that contains multiple other values. Lists can contain any type of items, and the items in a list do not all need 
to be the same type. You can create a list by enclosing multiple items in square brackets ( ), separated with commas. You can pull items out of a list []
with the square-bracket list index notation. Note that lists are zero-indexed, meaning that the first item in the list is at position 0. This code will print out 
" ".a list

Basic Operators

Python has all of the normal arithmetic operators you'd expect, addition( ), subtraction( ), division( ), multiplication( ), modulus( ), etc.+ - / * %

The comparison operators are just like in C: equals( ), not equals( ) greater than ( ), greater than or equal( ), etc.== != > >=

The logical operators are just typed in plain text: ,  ,  . and or not

These are just the basics. There are other operators, like bit shift operators. Read about them at: http://docs.python.org/library/stdtypes.html

White Space

Perhaps its most unique feature, logical blocks are defined by indentation in Python. A colon ( ) starts a new block, and the next line must be indented :
(typically using a tab of 4 spaces). The block ends when the indentation level returns to the previous level. For example, the following will print out "5 4 

". The final print is not part of the loop, because it isn't indented.3 2 1 Blast-off

countdown=5
while countdown > 0:
   print countdown,
   countdown = countdown - 1
print "Blast-off!"

 

Next ...

Control Flow Logic

http://docs.python.org/library/stdtypes.html


Control Flow Logic
Control flow are the parts of a language that make it do things differently based upon various conditions. In other words: ifs and loops. Python has all 
of the basic control flow statements that you'd expect.

if Statements

Literal strings can be typed in using either double quotes or single quotes. This can be handy when your string contains one quote or the other. You 
can also use the backslash character to escape special characters. Strings that contain characters beyond 7-bit ASCII, such as é or  need to be 
marked as unicode strings by placing the letter u in front of the string. There is no harm in marking all strings as unicode strings. The following prints a 
unicode string:

print u'été'

If statement should be familiar to anyone with a passing knowledge of programming. The idea of an   is that you want your script to execute a block of if
statements only if a certain condition is true. For example, this script won't do anything.

x = 15
if x < 10:
   print "this will never show"

You can use the if...else form of an  statement to do one thing if a condition is true, and something else if the condition is false. This script will if
print out this will show!

x = 15
if x < 10:
   print "this will never show"
else:
   print "this will show!"

Lastly, you can use the   form. This form combines multiple condition checks.  stands for . This form can optionally have a if...elif elif else if
catch-all  clause at the end. For example, this script will print out :else three

x = 3
if x == 1:
   print "one"
elif x == 2:
   print "two"
elif x == 3:
   print "three"
else:
   print "not 1-3"

 

Next ...

Control Flow Loops 



Control Flow Loops
While Loop

A while loop will repeat a block of statements while a condition is true. This code will print out the contents of the items in the list. This code uses a func
tion called len, which is a built-in function that returns the length of a list or string.

listOfFruit = ['Apples', 'Oranges', 'Bananas']
x = 0
while x < len(listOfFruit):
   print listOfFruit[x]
   x = x + 1

For Loop

Python's for loop may be a bit different than what you're used to if you've programmed any C. The for loop is specialized to iterate over the elements 
of any sequence, like a list. So, we could re-write the example above using a for loop eliminating the counter x:

listOfFruit = ['Apples', 'Oranges', 'Bananas']
for item in listOfFruit:
   print item

Much more graceful! You'll often see the for loop used instead of the while loop, even when you simply want to iterate a given number of times. To do 
this with the for loop, you can use the built-in function range. The range function returns a variable-size list of integers starting at zero. Calling range(4) 
will return the list [0, 1, 2, 3]. So, to have a for loop repeat 4 times, you simply can do:

for x in range(4):
   print "this will print 4 times"

Break and Continue In Loops

You can stop a loop from repeating in its tracks by using the break statement. This code will print out "Loop" exactly two times, and then print "Finished
".

for x in range(10):
   if x >= 2:
      break
   print "Loop"
print "Finished"

You can use the continue statement to make a loop stop executing its current iteration and skip to the next one. The following code will print out the 
numbers 0-9, skipping 4

for x in range(10):
   if x == 4:
      continue
   print x

 

Next ...

Functions



Functions
 

Functions are code that can be called repeatedly from other places. Functions can have parameters passed into them, and may return a resulting 
value. Some functions, like  , are built-in. Some functions, like  , are part of the scripting libraries provided by Ignition. len system.gui.messageBox()
Some functions, like  , are provided by the Python standard libraray.math.sqrt()

Functions are   by using their name followed by an argument list surrounded in parentheses. If there are no arguments, you still need an open invoked
and close parenthesis.

Defining Functions

Functions are defined using the   keyword. A function needs a name, and needs a list of the arguments that it can be passed. For example, this def
code defines a function that tests whether or not a number is odd. It returns a true value (1) if the number is odd. It is then used in a loop to print out 
the odd numbers between 0 and 9.

def isOdd(num):
   return num % 2 == 1 # uses the modulus (or remainder) operator
 
for x in range(10):
   if isOdd(x):
      print x

Function Arguments

When a function accepts arguments, the names of those arguments become variables in the function's namespace. Whatever value was passed to 
the function when it was invoked becomes the value of those variables. In the example above, the value of   inside the   loop gets passed to the x for isOdd
 function, and becomes the value of the   argument.num

Arguments can have default values, which makes them optional. If an argument is omitted, then its default value will be used. The following code 
defines a function called , which will take a number, and make sure it is within an upper and lower limit. The limits default to 0 and 100.cap

def cap(x, min=0, max=100):
   if x < min:
      return min
   elif x > max:
      return max
   else:
      return x
 
# This will print out "0"
print cap(-1)
 
# This will print out "100"
print cap(150)
 
# this will print out "150", because it uses a max of 200
print cap(150, 0, 200)

Keyword Arguments

Arguments can also be specified by keyword instead of by position. In the above example, the only way someone would know that the 200 in the last 
call to   specified the max is by its position. This can lead to hard-to-read function invocations for functions with lots of optional arguments. You can cap
use keyword-style invocation to improve readability. The following code is equivalent to the last line above, using 200 for the   and the default for max
the  .min

print cap(150, max=200)

Note that not all functions in the standard library and the Ignition library can be called with keyword invocation. Functions that accept keyword 
 invocation, like system.tag.queryTagHistory, will say so in their documentation.

Functions are Objects

Perhaps one of the most foreign concepts for new Python users is that in Python, functions are first-class objects. This means that functions can be 
passed around to other functions (this concept is similar to the idea of  in C or C++). function pointers

https://support.inductiveautomation.com/usermanuals/ignition/system_tag_querytaghistory.htm


Lets go back to the   example above. Suppose we wanted a more general way to filter a list. Maybe sometimes we want the odd entries, while isOdd
other times we want even ones, or entries less than 3, etc. We can define a function called   that takes a list and  , and returns extract another function
only entries that "pass" through the other function.

def isOdd(num):
   return num % 2 == 1 
 
def isEven(num):
   return num % 2 == 0
 
def isLessThan(num, max=3):
   return num < max
 
def extract(filterFunction, list):
   newList = []
   for entry in list:
      if filterFunction(entry):
         newList.append(entry)
   return newList
 
# prints out [0, 2, 4, 6, 8]
# notice that isEven as not _invoked_, but passed to the filter function
print extract(isEven, range(10))

Now, it just so happens that Python has a built-in function that does exactly what our   function does - its called  .extract filter

We would also be remiss at this point if we didn't mention another language feature called  . This is a great little bit of syntax that list comprehensions
helps make new lists out of other lists. Instead of using our filter function, we could have simply done this:

def isEven(num):
   return num % 2 == 0
 
print [x for x in range(10) if isEven(x)]

If that looks cool to you - read more about list comprehensions at http://docs.python.org/tutorial/datastructures.html#list-comprehensions

In Ignition, you'll most commonly see functions used as objects when using the   function. This function takes a function and system.util.invokelater
executes it after all pending event handling has finished processing.

 

 

Next ...

Python Comments

http://docs.python.org/tutorial/datastructures.html#list-comprehensions
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Python Comments
 

Comments start with a hash sign. By adding comments to your code, you know what the code is trying to do when you go back to it after a long time.

# Prints out 'Hello World' 5 times.
for x in range(5):
   print 'Hello world'

 

Next ...

System Library



System Library
 

Ignition comes with a group of system functions, called the system library. Using a system function is simple. For example, the following code will 
access the value of a tag.

value = system.tag.value("tagPath").value

The appendix is full of built-in functions such as this. 

 

 



Component Scripting
 

Event handling allows you to use scripting to respond to a wide variety of events that components fire. This lets you configure windows that are very 
interactive, and are an important part of project design in the Vision module.

Events

An event can be many things, like a mouse click, a key press, or simply a property changing. Whenever these events occur, a script can be called to 
"handle" the event. Different components can fire different types of events. For example, mouse events are very common and are fired by almost 
all components. The   event, on the other hand, is only fired by the   component.cellEdited Table

Configuring Handlers

To configure event handlers for a component, right-click on the component and choose the  from the pop-up window. You can also get to Scripting 

this button from the toolbar (  ) or the Component menu. From the component scripting window, you can pick the appropriate event handler.

Script Builders

All events are handled with scripting, but you frequently don't need to write the scripts by hand. This is where the Script Builders come in. For each 
event, you can choose a common way of handling the event. This can be a navigation action, setting a tag value, and so on. To write an arbitrary 
script, choose the   tab. Script Editor

For example, one of the most common uses of event handlers is to open a window when a button is pushed. To do this, simply select the actionPer
 event, and select the   tab. Here you can simply pick the navigation action  , and choose the window to open. If you're formed Navigation Open

curious, you can peek over at the   tab to see the underlying code that makes this action work, but you certainly don't have to.Script Editor

Common Component Functions

The following functions are common to all components in Ignition:

requestFocusInWindow() - requests that the component be given input focus. See also:  Events.focus
 - sets the value of a component's Custom property.setPropertyValue(name, value)

 - gets the value of a Custom property.getPropertyValue(name)

Moving/Resizing Components and Windows

You can use scripting to move and resize a component at runtime. The functions system.gui.moveComponent, system.gui.reshapeComponent and 
system.gui.resizeComponent are used for this.

They simply take a component, and a new size, location, or both. Locations are always measured in pixels from the upper left point of the 
component's parent container.

Note that if you're moving a component that is set to relative layout, your coordinates will act as if they were coordinates to the sizes of the relevant 
containers last time they were saved in the Designer, not the current real coordinates of the runtime. This is very helpful for creating animations. In 
effect what this means is that the coordinates fed into these functions "respect" the relative layout system automatically.
You can move and resize windows as well. If you have a reference to a window, you can set its size and location directly with setSize() and 
setLocation(). For example, if you wanted to move a window named "Popup" to a certain location:

setSize and setLocation

try: 
        window = system.gui.getWindow("Popup") 
        window.setSize(250,600) 
        window.setLocation(0,0) 
except ValueError: 
        pass # ignore error with a pass keyword pass

 

 

In this section ...
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Component Event Handlers
 

When you're writing component event handlers, you'll do a lot of work with components. You'll need 
to reference various components on the window or on other windows, you'll need to reference and 
set properties of the component, you may even want to move components around on the screen.

Finding Components

When you have an  object, that object becomes your window into the entire component hierarchy. event
 references the component that fired whatever event you're responding to. event.source event.

 references the container that component is in . source.parent event.source.parent getCompone
 finds a sibling component with a certain name. The manual page for the event object nt("Name")

covers this topic in more detail.

These are all of the event types that are fired by the various components in the Vision module. 
Events are organized into event sets. For example, the mouse event set includes  , mouseClicked mouse

, and  . All of the events in an event set share the same properties for their Pressed mouseReleased eve
. objectnt

Event Sets

Each component can have its own set of events, however most components share events, therefore, 
understanding the way one event works with one component will result in understanding how it works will 
all other components that have the same event.

The most common event sets are as follows:

action
cell
focus
internalFrame
item
key
mouse
mouseMotion
paint
propertyChange

 

 

 

 

 

action Events

Events

actionPerformed

Properties in 'event'

source

The   event is fired when an "action" occurs. What that "action" is depends on the component. The most common example is the actionPerformed B
component. You should always use the action event on a button instead of a mouse click, because it will be fired whenever the button utton 

is pressed, whether it is via the mouse or the keyboard (via a mnemonic shortcut or tabbing over to the button and pressing enter or space). The Timer
 component is another example of a component that fires an action event. In this case, the action is the timer firing.

 

cell Events

Events

cellEdited

Properties in 'event'

source
oldValue - the previous value in the cell

 - the newly entered value for the cellnewValue
row
column

https://legacy-docs.inductiveautomation.com/display/DOC/Button
https://legacy-docs.inductiveautomation.com/display/DOC/Button
https://legacy-docs.inductiveautomation.com/display/DOC/Timer


Cell events a s editable columns. When a user edits a cell, this event will fire. The   and   propre fired by a Table component that ha oldValue newValue
erties in the event can be used to determine what value the cell used to hold, and what new value the user has entered. The   and  propertirow column 
es, both integers, show what position in the table's data property the edit occurred at.

Example

Commonly, the event handler for a cell event will issue a SQL update query to persist changes to the table back to an external database. You can use 
the row to determine what the primary keys were for the row that was edited by looking at the table's data property. You can use the column index to 
find the column name of the edited column.

columnName = event.source.data.getColumnName(event.column)
primaryKeyValue = event.source.data.getValueAt(event.row, "keycolumn")
query = "UPDATE mytable SET %s=? WHERE keycolumn=?" % columnName
system.db.runPrepUpdate(query, [event.newValue, primaryKeyValue])

focus Events

Events

focusGained
focusLost

Properties in 'event'

source
oppositeComponent - the component that either gave up focus to this component, or took it away

Focus events are fired for components that can receive input focus. For both the focus gained and focus lost events, you can also access the 
"opposite" component. For a focus gain, this is the component that previously had the focus. For a focus lost event, the opposite component is 
the component that took the focus away.

 

internalFrame Events

Events

internalFrameActivated - fired when the window becomes the focused window
 - fired after the window is closedinternalFrameClosed

 - fired just before the window is closedinternalFrameClosing
 - fired when the window loses focusinternalFrameDeactivated

 - fired the first time a window is opened after not being in the cacheinternalFrameOpened

Properties in 'event'

source

Internal frame events are fired by windows. (They are known as "internal frames" in the underlying Java windowing system that the Vision component 
uses). Note that the source of these events is the window itself. To get the root container of the window, use  , not event.source.rootContainer e

.vent.source.getComponent("Root Container")

The Activated/Deactivated events get fired when the component receives or loses input focus. The Activated event is a more reliable event to use as a 
window startup event than the Opened event, because the Opened event will not be called if the window was opened when it was already cached.

See also: Window's Cache Policy

 

item Events

You can programatically request that focus be given to a component by calling the function   on that function. requestFocusInWindow()
This function is actually defined by Java's JComponent class, from which all Vision components extend.

If you are trying to alter the focus from within a focus event handler, you must wrap your code in a call to . system.util.invokeLater
This will let your focus change be processed after the current focus change event that is being processed has a chance to finish.

https://legacy-docs.inductiveautomation.com/display/DOC/Window+Properties#WindowProperties-CachePolicy


Events

itemStateChanged

Properties in 'event'

source

stateChange - a code that will be equal to either the SELECTED or DESELECTED constants.

SELECTED - a constant representing a selection event.

DESELECTED - a constant representing a deselection event.

The   event is used by components that choose between a selected or deselected state. For examitemStateChanged ple, a   or Check Box Radio 
 can respond to this event to be notified when the state has changed (via any mechanism - click, keyboard, property bindings, and so . YouButton

on). To check whether the event represents a selection or a deselection, you compare the event's stateChange property with the SELECTED or 
DESELECTED constants, like this:

if event.stateChange == event.SELECTED:
   print "Turned ON"
else:
   print "Turned OFF"

 

key Events

Events

keyPressed - fires when a key is pressed while the source component has input focus. Works for all keyboard keys.

keyReleased - fires when a key is released while the source component has input focus. Works for all keyboard keys.

keyTyped - fired when a character key is pressed and then released while a component has input focus.

Properties in 'event'

source

keyCode - an integer code representing the key that was pressed or released. Only valid on   and   events. See table keyPressed keyReleased
below.

keyChar - a string that represents the character that was typed, if applicable (e.g. used for letters, but not an F-key). Only valid on keyTyped event.

keyLocation - the location of the key. E.g. to differentiate between left shift from right shift.

altDown - true (1) if the alt key was held down during this event, false (0) otherwise.

controlDown - true (1) if the control key was held down during this event, false (0) otherwise.

shiftDown - true (1) if the shift key was held down during this event, false (0) otherwise.

Key events are used to respond to keyboard input. They will only be fired on components that receive input focus. Handling key events often involves 
checking exactly what key was pressed. These events make a distinction between character keys ( ) and non-printable keys (A,B,C... F3,Esc, 

). All keys will get   and   events, but only character keys will get   events. For   events, checking Enter keyPressed keyReleased keyTyped keyTyped
what key was pressed is relatively simple, you can simply do a comparison on  , like  . For other keys, however, keyChar event.keyChar == 'a'
you need to compare the keyCode to a constant, enumerated below. These constants can be referenced through the event object itself, like: event.

.keyCode == event.VK_ENTER

 

Key Code Constants

VK_0 - VK_9 VK_END VK_PAGE_UP

VK_A - VK_Z VK_ENTER VK_RIGHT

VK_F1 - VK_F24 VK_HOME VK_SHIFT

VK_ALT VK_INSERT VK_SPACE

VK_CONTROL VK_LEFT VK_TAB

https://legacy-docs.inductiveautomation.com/display/DOC/Check+Box
https://legacy-docs.inductiveautomation.com/display/DOC/Radio+Button
https://legacy-docs.inductiveautomation.com/display/DOC/Radio+Button


VK_DOWN VK_PAGE_DOWN VK_UP

VK_ESCAPE

Location Code Constants

KEY_LOCATION_LEFT KEY_LOCATION_RIGHT KEY_LOCATION_UNKNOWN

KEY_LOCATION_NUMPAD KEY_LOCATION_STANDARD  

 

mouse Events

Events

mouseClicked - fired when the mouse is pressed and released in the same spot on the component.
 - fired when the mouse is moved so that it is hovering over the componentmouseEntered

 - fired when the mouse had been hovering over the component and exitsmouseExited
 - fired when the mouse is pressed within the bounds of the componentmousePressed

 - fired when the mouse is released after having been pressed within the bounds of the componentmouseReleased

Properties in 'event'

source

button - an integer code representing the button that was clicked. Use the constants  ,  , and  .event.BUTTON1 event.BUTTON2 event.BUTTON3

clickCount - an integer count of the number of successive clicks.

Click Count

#Use code like this to ensure a specific number of clicks before your code runs.
if event.clickCount == 2:
        print "I was clicked twice!"

x - the x-axis location of the mouse click, with (0,0) being the upper left corner of the component.
 - the y-axis location of the mouse click, with (0,0) being the upper left corner of the component.y

 - true(1) if this mouse event should pop up a context menu. Meaning is OS-dependent. On windows, it is a release of  .popupTrigger BUTTON3
 - true (1) if the alt key was held down during this event, false (0) otherwise.altDown

 - true (1) if the control key was held down during this event, false (0) otherwise.controlDown
 - true (1) if the shift key was held down during this event, false (0) otherwise.shiftDown

mouseMotion Events

Events

mouseDragged - fires when the mouse is pressed within the component, and then moved. Will continue to fire until the button is released, even if the 
mouse moves outside the component.

 - fired when the mouse moves over the component.mouseMoved

Properties in 'event'

See mouse events.

 

paint Events

Events

All of this information comes straight out of the Java documentation for  .java.awt.KeyEvent
See http://java.sun.com/j2se/1.5.0/docs/api/java/awt/event/KeyEvent.html

mouseMotion events will not trigger when the project is viewed from a mobile project as these gestures are used by the browser/device to 
zoom or pan.

http://java.sun.com/j2se/1.5.0/docs/api/java/awt/event/KeyEvent.html


repaint

Properties in 'event'

source

graphics - An instance of   that can be used to paint this component. The point (0,0) is located at the upper left of the java.awt.Graphics2D
component.

 - The width of the paintable area of the component. This takes into account the component's border.width
 - The height of the paintable area of the component. This takes into account the component's border. height

This event is fired by mponent. This component is provided for highly scriptliterate users, and is decidedly not user-friendly.  the   coPaintable Canvas
Don't say you weren't warned. It allows you to use Java2D through Python to programatically "paint" your own dynamic, vector-based component. 
This event is called every time the component needs to repaint. It will repaint when any of its custom properties change, or when   is .repaint()
called on it. Drop a Paintable Canvas onto a window and look at the paint event handler for an example.

 

propertyChange Events

Events

propertyChange

Properties in 'event' 

source

newValue - The new value of the property.

oldValue - The previous value of the property. Not all properties provide this information.

propertyName - The name of the property that has changed.

The   event is called any time a bindable property changes on a component. This includes all custom properties. This can be a very propertyChange
useful tool, allowing you to respond via scripting when a property changes. Because this one event handler is called for multiple properties, it is typical 
for a handler to first have to filter based on the  , so that it is responding to a specific property changing.propertyName

Example

#This script might go on a Table whose data must be filled in before continuing
if event.propertyName == "data":
   newData = system.db.toPyDataSet(event.newValue)
   if len(newData)>0:
     # Data exists - let the user know they may proceed
     system.gui.messageBox("You may proceed.")

 

Next ...

Accessing Component Properties
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Script Builders
When creating an event handler, you can use one of the handy   instead of writing script builders
the script by hand. In the Event handlers configuration window, the script builders are accessible as 
tabs along the top. The last tab,  , lets you write an event handler by hand. You can also Script Editor
use it to view the script that was generated by the  , which is a good way to get script builder
started learning how to write event handlers by hand.

Script Builders

Watch the Video

 

Action Qualifiers

All of the script builders allow you to put security and/or confirmation qualifiers onto the event handler. The security qualifier lets you restrict the event 
handler from running if the current user doesn't possess a set of roles. Use CTRL-select to pick multiple roles. The confirmation qualified will prompt 
the user with a popup   box. The action will only be executed if the user chooses  .Yes/No Yes

Navigation

The navigation script builder has various functions that deal with opening and closing windows.

Open / Swap

Opening is a very straight-forward operation - it simply opens the specified window. You are also given options to center that window within the Client, 
and to close the window that the event was fired from.

Swapping is the practice of opening another window in the same size, location, and state as the current window, and closing the current window. This 
gives the appearance of one window simply swapping into another, seamlessly. The navigation builder uses the swapWindow version of 
swapping, but most "by hand" script authors will us the swapTo version. This last version relies on the fact that the windows being swapped are both 
maximized windows. See the typical navigation strategy section for more information.

You can also pass parameters to the opened or swapped-to window. The names of these parameters must match names of custom properties on the 
root container of the target window. The values can either be literals or values of other properties from the source window. To use a property, highlight 

an empty cell in the Value column of the parameter table, and press the Insert Property ( ) button. See the parameterized windows section for more 
information.

Forward / Back

These action give you a simple way of implementing  -style forward/back buttons in your client. Note that you must be using the default browser
navigation strategy for this to work, because these functions rely on calls to   in order to keep track of what the sequence of system.nav.swapTo
recent windows has been.

Closing Windows

These options allow for an easy way to have an event handler close the window that it is a part of, or any other window. Refer to the following sections 
for more information:

Parameterized Windows
Navigation Strategies
system.nav.openWindow
system.nav.swapWindow

Set Tag Value

This event handler script builder will respond to an event by setting the value of a Tag. You can set the tag to either a literal value directly typed in, or 

you can use the Insert Property ( ) button to have the handler use the value of another property from the same window.

SQL Update

This script builder helps you build an update query using a database browsing interface. Choose a spot in your target database and the update query 
will be built for you. By setting columns as key columns, you can have the filter correctly filter to the right row. You may use either literal values or 

property values by using the Insert Property ( ) button next to the Update Value text box.
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Set Property

This script builder will respond to an event by altering a property in the window. You must choose the property to alter, and the value that you wish to 

assign to it. The value can be a literal value or the value of any other property on the window by using the Insert Property ( ) button.

 

Next ...

Event Object



Event Object
 

Event handling scripts are just regular Python scripts except for one important detail. They all have 
a special variable defined in their namespace called  . This is an object that represents information event
about the event that just occurred. For example, the   object for a mouse click will have the x and y event
coordinates where the click occurred. A key press event, on the other hand, will have a keycode, but not 
a coordinate.

In addition to information about the event that has just occurred, the   object has a  propertevent source 
y. The source of an event is the component that fired it. This is a crucial concept to understand. The 
reference to the component is your handle into the entire hierarchy of the window that your script is 
contained in.

Example

Suppose you're handling the mouse-pressed event of a   component. The following script would print label
out the coordinates of the click, as well as the text of the label:

currentText = event.source.text
print 'Mouse clicked on label "%s" at %dx%d' % (currentText, event.x, 
event.y)

The output would look like this if the label's text was "this is my label":

Mouse clicked on label "this is my label" at 27x99

Event Object

Watch the Video

 

Using the   object to access the component hierarchyevent

Because   is the component that fired the event, you can use this reference to access the entire hierarchy of your window. This means event.source
you can access properties of any other component in the window. You just need to know how to navigate up and down the component tree. 

To navigate   the component tree (going from a component to its parent container), simply use the parent property.up

To navigate   the component tree (going from a container to one if its children), use the   function.down getComponent(name)

To navigate   (getting a reference to a sibling component), simply go up one level and then back down.sideways

Example

Suppose the component hierarchy in our window looked like this:

 

Root Container
   HeaderLabel
   StartButton
   Options
      ProductCode
      BatchSize
   PreviewTable

This window has a start button, a header, some options, and a preview table. Lets say that it is a window that lets the operator start a new batch. It 
has some options that are grouped into their own container. Lets say that the Root Container also has some parameters that our start button needs 
to know about.

The following table shows some script expressions and what they will evaluate to if you're writing an event handler for the   component:StartButton

event.source #The start button
event.source.parent # The root container
event.source.parent.MyProperty #The value of custom property "MyProperty" on the Root Container
event.source.parent.getComponent("Options") #The Options container
event.source.parent.getComponent("Options").getComponent("ProductCode").selectedValue #The selected value of 
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the ProductCode dropdown component
event.source.parent.getComponent("PreviewTable").selectedRow #The index of the selected row in the 
PreviewTable

 

Next ...

Accessing Component Properties

There is one exception to the pattern of using  to go up the hierarchy and using  to go down. The parent .parent .getComponent(name)
of a root container is not the window, and a reference to the window does not have a  function. To get a reference .getComponent(name)
to a window, simply use  with any component's  object as the parameter. Once you have a reference to system.gui.getParentWindow event
a window, you can use its  property to get to the root of the component hierarchy, and from here you can follow the rules .rootContainer
laid out above.
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Accessing Component Properties
 

The properties of a component can be influenced through scripting. Each component property comes 
with a scripting reference. Once you have a reference to a component, you can treat it just like any 
Python object. You can call functions on it, and you can reference its properties, both standard and 
dynamic, with the "." accessor.

Example 1

To change the visibility of a component, access the component and set the property scripting name to 
either True or False to make the component visible or invisible.

event.source.parent.getComponent('Some Component').visible = False

Example 2

You could put this in a button next to the table, which would tell the user which row was selected, then 
clear the selection, and then print the table.

table = event.source.parent.getComponent("Table")

# Referencing properties of a component
row = table.selectedRow
system.gui.messageBox("The selected row is : %d" % row)

# Setting properties of a component.
table.selectedRow = -1

# Calling functions on components
table.print()

Accessing 
Component 
Properties

Watch the Video

 

 

   

 

Next...

Finding Components on Other Windows
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Finding Components on Other Windows
 

In Ignition, you can obtain and use information from components on other windows. To access the 
information, first you need to know the window name, component name, and the property that you want 
to obtain. In addition, if the window is not open an error will occur. This error can be handled with normal 
exception handling.

The following example demonstrates how to access the contents of a text field on a different window 
from where the scripting occurred.

try:
        window = system.gui.getWindow("Other Window")
        text = window.rootContainer.getComponent("Text Field").text
        print text
except ValueError:
        print "Other window is not open"

Sometimes you may want to reference components on other windows. Or maybe you don't have 
an 'event' object because you're writing a project . In this case, you'll need to look up event script
the containing window first. You can do this with the  function. This function  system.gui.getWindow
will throw a ValueError if the given window isn't open, so you should make sure your code handles 
that gracefully. Once you have a Window, you can use its  property to get into rootContainer

the standard component hierarchy. This code will look up the HeaderLabel on a window named "Overvi
 and set its text and foreground color.ew"

try:
   window = system.gui.getWindow("Overview")
   label = window.rootContainer.getComponent("HeaderLabel")
   label.text = "Notice Me!"
   label.foreground = (255,0,0)
except ValueError:
   # ignore error with a pass keyword
   pass

Finding 
Components on 
Other Windows

Watch the Video

 

 

 

Next...

Reading and Writing Tags
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Reading and Writing Tags
   

Using the system functions, you can read from a tag and write to a tag in Ignition.

Reading from a tag

Reading a tag with scripting using a  function requires the tag path and will return system.tag.read()
a 'Qualified Value.' A qualified value is the tag value that has three attributes; Value, Quality, TimeStamp.

value = system.tag.read("tagPath").value
quality = system.tag.read("tagPath").quality
timestamp= system.tag.read("tagPath").timestamp

Writing to a tag

Writing to a tag with the  function requires the tag path and the value to write to system.tag.write()
the tag.

system.tag.write("tagPath","Hello World")

Reading and 
Writing Tags

Watch the Video

 

 

 

 

Next...

Navigation Functions
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Navigation Functions
   

The system.nav functions allow the user to navigate between windows.

Navigation 
Functions

Watch the Video

 

 

   

   

Next...

Retargeting
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Retargeting
Retargeting is accomplished through scripting, usually as a response to a button press or 
other component event. The  function allows you to 'retarget' the Client to a different system.util.retarget
project and/or different Gateway. You can have it switch to another project on the same Gateway, or 
another Gateway entirely, even across a WAN. This feature makes the vision of a seamless, enterprise-
wide SCADA application a reality.

The retarget feature will attempt to transfer the current user credentials over to the new project / 
Gateway. If the credentials fail on that project, the user will be prompted for a valid username and 
password. Once valid authentication has been achieved, the currently running project is shut down, and 
the new project is loaded.

You can pass any information to the other project through the parameters dictionary. All entries in this 
dictionary will be set in the global scripting namespace in the other project. Even if you don't specify any 
parameters, the system will set the variable _RETARGET_FROM_PROJECT to the name of the current 
project and _RETARGET_FROM_Gateway to the address of the current Gateway.

Retargeting

Watch the Video

 

 

   

   

Next...

Working With Different Datatypes
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Working With Different Datatypes
 

You'll encounter lots of different datatypes when scripting in Python.

This guide can help you through the snags of working with some of the more complex types. The 
University Video shows how you can work with colors and dates in the scripting language.

Numbers

Working with numbers is very easy in Python, and requires no special considerations. You can use the 
built-in function  to attempt to coerce values to integers, and  to coerce values to floating-int() float()
point values. Both will throw  if the coercion fails.ValueError

Strings

Strings are used frequently in scripting. Strings can be defined using double quotes or single 
quotes. Learning how to use is a very useful technique. You can user the built-in String Formatting 
function   to coerce values into strings.str()

Colors

Working with colors in Python is remarkably easy. You can simply use any tuple of 3 or 4 integers 
to represent a color in RGB or RGBA. For example, to set a label's text color to red, you can simple 
do something like this:

label = event.source
label.foreground = (255,0,0)

Dates

Dates are one of the trickier datatypes to deal with in scripting. It turns out that it is easier to deal 
with dates using the Java classes  and  than it is to java.util.Date java.util.Calendar
use Python's  module.time

Creating Dates

To create an arbitrary date, you can use the  class. It has various functions  java.util.Calendar
to alter the calendar fields, like Calendar.HOUR, Calendar.MONTH, and so on. After you're done 
manipulating the Calendar, you can use its  function to retrieve the Date represented by the getTime()
calendar. It also has a handy  function that takes the common parameters of a Date. The one set()
major "gotcha" here is that January is month zero, not month one. For example:

from java.util import Calendar
cal = Calendar.getInstance()

# set year, month, day, hour, minute, second in one call
# This sets it to Feb 25th, 1:05:00 PM, 2010
cal.set(2010, 1, 25, 13, 5, 0)
myDate = cal.getTime()

Date Arithmetic

Often you'll have a Date object from a component like the  and want to alter Popup Calendar
it programmatically. Say, subtracting 8 hours from it, or something like that. The  java.util.Calendar
class is used for this as well. Following the example above, this code would subtract 8 hours from the 
variable .myDate

Working with 
Different Datatypes

Watch the Video

 

 

If you are new to programming, the following might throw you off. Python, like nearly all 
programming languages, uses integer division when dividing two integers. This means that 1

 will result in . This is because both 1 and 2 are integers, so the result of the division must /2 0
be an integer. The result of  gets truncated to . If either operand is a float, the result will 0.5 0
be a float, so  will result in .1/2.0 0.5
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from java.util import Calendar
cal = Calendar.getInstance()
cal.setTime(myDate)
cal.add(Calendar.HOUR, -8)
myNewDate = cal.getTime()

Date Formatting

To format a date as a String, you can use the system function . This system.db.dateFormat
function uses a  to give it a hint as to how you want your date formatted. The format string is format string
full of various placeholders that will display different parts of the date. These are case-sensitive! The 
most common placeholders are:

y Year

M Month

d Day

E Day of Week

a am/pm marker

H Hour of day (0-23)

h Hour in am/pm (1-12)

m Minute

s Second

S Millisecond

z Time zone

These placeholders can be repeated for a different effect. For example, M will give you 1-12, MM will 
give you 01-12, MMM will give you Jan-Dec, MMMM will give you January-December. Here are 
some examples:

from java.util import Date
now = Date() # creates a new date, for right now

# Common format for databases
print system.db.dateFormat(now, "yyyy-MM-dd H:mm:ss")

# Nice human-readable format for just the date
print system.db.dateFormat(now, "MMM d, yyyy")

# Formating just the time in am/pm style
print system.db.dateFormat("h:mm a")

 

Next...

Working with Datasets

 

 



Working with Datasets
 

It is very common to deal with datasets in scripting, as datasets power many of the interesting features in 
Ignition, like charts and tables. The   library provides various functions for manipulating system.dataset
and creating datasets.

The main confusion when dealing with datasets is the difference between the DataSet object and 
the PyDataSet object. DataSet is the kind of object that Ignition uses internally to represents 
datasets. When you get the data property out of a Table, for example, you'll get a DataSet. The 
PyDataSet is a wrapper type that you can use to make DataSets more accessible in Python. You can 
convert between the two with  and .system.dataset.toPyDataSet system.dataset.toDataSet

Accessing data in a DataSet

DataSets have various properties and functions that you can access through Python.

rowCount
Returns the number of rows in the dataset.

columnCount
Returns the number of columns in the dataset.

getColumnName(index) 
Returns the name of the column at the given index.

getValueAt(row, column) 
Returns the value from the dataset at the given location. can be either an integer or a column column 
name, which is treated case-insensitive.

For example, you could iterate through every item in a DataSet in scripting like this:

# Pull the dataset property off a Table component
data = event.source.getComponent("Table").data

for row in range(data.rowCount):
   for col in range(data.columnCount):
      print data.getValueAt(row, col)

or you could find specific values from each row in a DataSet like this:

# Pull the dataset property off a Table component
data = event.source.getComponent("Table").data

for row in range(data.rowCount):
   temp = data.getValueAt(row, "Temperature")
   speed = data.getValueAt(row, "Speed")
   print temp, speed

Accessing data in a PyDataSet

You can convert a dataset to a PyDataSet, which lets you use it more like a Python sequence. You don't 
have to do this, its purely a convenience. A PyDataSet is like a list of dictionaries, and so it can use the 
normal for loop syntax. These examples are equivalent to the examples above.

Iterating through a PyDataSet

# Pull the dataset property off a Table component
data = event.source.getComponent("Table").data

# Convert to a PyDataSet
pds = system.dataset.toPyDataSet(data)

for row in pds:
   for value in row:
      print value

Working with 
Datasets

Watch the Video
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Finding specific values in a PyDataSet

# Pull the dataset property off a Table component
data = event.source.getComponent("Table").data

# Convert to a PyDataSet
pds = system.dataset.toPyDataSet(data)

for row in pds:
   temp = row["Temperature"]
   speed = row["Speed"]
   print temp, speed

Accessing specific elements in a PyDataSet

# Pull the dataset property off a Table component
data = event.source.getComponent("Table").data

# Convert to PyDataSet
pds = system.dataset.toPyDataSet(data)

# Grab the first item of the first row
value = pds[0][0]
print value

Altering Datasets

Technically, you cannot alter a dataset. Datasets are immutable, meaning they cannot change. You can, 
however, create new datasets. So to change a dataset, you really create a new one and then replace the 
old one with the new one. Because this is so common, there are special functions under system.

 that are designed for this.dataset

You can use the following functions to create datasets that are altered version of existing datasets:

system.dataset.addRow

system.dataset.deleteRow

system.dataset.setValue

system.dataset.updateRow

The important thing to realize about all of these datasets is that, again, they do not actually alter the input 
dataset. They return a new dataset. You need to actually use that returned dataset to do anything useful.

For example, the following code would set the  column in the selected row of a table to 15.8:Quantity

table = event.source.parent.getComponent("Table")
selRow = table.selectedRow
if selRow != -1:
   # Create a new dataset
   newData = system.dataset.setValue(table.data, selRow, "Quantity", 15.8)

   # Replace the Table's data property with the new dataset
   table.data = newData

Creating Datasets

Sometimes you'll want to create a new dataset from scratch. This can be easily done with the system.
 function. All it needs are the column headers and a list of the rows in the dataset. dataset.toDataSet

Each row must have the same number of elements as the header list.

For example, the following code would create a dataset that contained some information about US cities:
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headers = ["City", "Population", "Timezone", "GMTOffset"]
data = []

data.append(["New York", 8363710, "EST", -5])
data.append(["Los Angeles", 3833995, "PST", -8])
data.append(["Chicago", 2853114, "CST", -6])
data.append(["Houston", 2242193, "CST", -6])
data.append(["Phoenix", 1567924, "MST", -7])

cities = system.dataset.toDataSet(headers, data)

 

Next...

Exporting Data to CSV

 

 

 



1.  

2.  

3.  

Exporting Data to CSV
 

You can export a dataset from a query or table to a CSV file.

To export a dataset to a CSV file

Identify the dataset that you want to export to a CSV file. 
The source of the dataset is irrelevant because Ignition will treat all datasets the same.
 
Create a Button on the window.
 
Use the scripting function to export the dataset to a CSV file.system.dataset.exportCSV 

Exporting Data to 
CSV

Watch the Video

 

 

 

Next...

Component Extension Functions
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Component Extension Functions
 

Some advanced components can be customized by using the extension functions. These functions will 
be called by the component itself when appropriate. For example, the Power Table component exposes 
an extension function called . By implementing this function, you getBackgroundColorAt()

can control the background color of each cell of the table component using scripting.

Extension functions allow you in a loose sense to create a custom "sub-class" of the base 
component type, from an object-oriented point of view. Your sub-class can then override/implement parts 
of the functionality of the component itself, in python. This is a very powerful, if somewhat advanced, way 
of configuring the component. Each component extension function comes with its own 
documentation built-into the function's default implementation using a standard Python "doc-string". You 
will find that you are unable to edit the function's signature or docstring. Changing the method's 
signature (arguments or function name) would prevent the component from calling it correctly. Changing 
the docstring could be misleading or confusing as you'd lose the documentation for how 
your implementation of the function should work.

Following Python object-oriented methodology, you'll notice that each extension function's first argument 
is called "self". That is because these are methods belong to the component's class itself. That is, they 
are instance methods. The value of  will always be the component itself. Notice that this is different self
than component event handler scripts. In those scripts, you are given an  object in your scope. event
The component that fired the event will be under . When you write an extension function, event.source
there is no  object. The component is given to you as the  object instead.event self

Component 
Extension 
Functions
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Next...

Component Custom Methods
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Component Custom Methods
 

 

Custom methods can be added to components and templates. Custom methods allow scripts to be 
defined on a component, and call the same script from another event.

 

In the image below, a Button component has a custom method called printHello. The method takes a 
single parameter called customMessage, concatenates the value of customMessage with a static string, 
and calls system.gui.messageBox to show the message.

Calling a custom method requires a  , as well as the path to the component where the method resides
name of the method. To call the printHello method from the actionPerformed event on the same button, 
the script would look like the following:

 

 

Custom methods can be called from scripts on other events and components. A script on a Label 
component located in the same container as the Button can call the printHello method. 

 

Component 
Custom Methods

Watch the Video

 

 

Example - Error Checking User Input

The following example will create a custom method that reads input from several components, and 
checks the values to make sure valid data was entered. 

 

 

Step 1 - Creating the Custom Method

The image below shows a container named Text Field Container. Inside are four Text Field components 
can enter data into. The container also has a Button component that will read the values from each 
component. 
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The error checking method will be placed on Text Field Container since all of the components that will be 
checked are inside this container. To create a custom method, right-click the Text Field Container 
component, and select Scripting

 

Right-click on Custom Methods, or double-clicking the   green plus button will also 
create a new custom method. 

 



A new custom method will appear. The new method can be renamed, and parameter names for the 
method can be defined. 

 

Rename the method to errorChecking. This method will not accept parameters, so leave the Parameters 
Text Field blank. Expand and copy the example below and paste it into the Script text area. Make sure 
the indentation matches the image below. 

 

errorCheck

        #Build a list of names from each Text Field component that will be 
checked for errors 
        textFieldNames = ["First Name","Last Name", "Account", "Address"]
        
        #Initialize a list to store the values of each Text Field
        textFieldValues = []
        
        #Initialize a sting that will show each error detected
        errorMessage = ""
        
        #Iterate through each component
        for component in textFieldNames:
                
                #Retrieve the value for the current text field
                value = self.getComponent(component).text
                
                #Add the value to textFieldValues.
                textFieldValues.append(value)
                
                ####Begin Error Checking
                
                
                ####Check for blank values
                if value == "":
                        
                        #Add a message to errorMessage describing the 
problem. 
                        #The "\n" characters denote a new line in Python 
strings
                        errorMessage += "The %s Text Field is empty. 
Please enter a value\n" % (component)
                
                ####Check for additional errors by adding more if-
statements below, and add the new message errorMessage 
                
                
                ####End Error Checking        
                
        #After the for-loop finished looking for errors, check if any 
errors have been added to errorList
        #If the amount of characters in errorMessage is more than 0, we 
can assume an error message has been added,
        #so check the amount of characters in errorMessage with Python's 
len()
        if len(errorMessage) > 0:        
                #Show the user the errors



                system.gui.messageBox("The following errors were 
detected\n" + errorMessage, "Errors detected")
        
        else:
                #No errors were detected, so do something useful with the 
values here. Otherwise show the user the values...
                system.gui.messageBox(str(textFieldValues))  

 

Step 2 - Calling the Custom Method

Now that a custom method had been created, a script needs to call the method. Add a script to the 
button in Text Field Container on the actionPerformed event.

 

Invoke errorCheck

#Call the errorCheck method on the button's parent 
#container: Text Field Container
event.source.parent.errorCheck()

 

 

Step 3 - Testing the Custom Method

Click OK to close the Component Scripting window, save the project, and put the designer into preview mode. Add some data to some of the text 
fields, but leave at least one blank. Clicking on the button will display which text fields were empty. The image below shows the Last Name and 
Address text fields are empty, and the script detected this. 



Now any script that has access to this window can check the text fields for errors. This example could be expanded to look for additional errors, such 
as checking for prefixes in some or all of the values. 

 

Next...

Exporting Data to CSV

 

 



Advanced Scripting
 

There are many places scripting can be used in Ignition, there are Gateway and Client scripts, startup, shutdown, time scripts and more.

Script Modules

A project's Script Modules are a global library of scripts that can be called from anywhere within the scope of a project. These scripts are organized as 
named modules that all live under the  module. To open the Script Module Editor double-click on the  node in the app Configuration > Script Modules

 or navigate to the  menu.Project Browser  Project > Script Modules

Rule of Thumb: Never Copy-and-Paste a Script

If you're unsure of when to put scripts in a script module vs. embedding the script directly in an event handler, follow this simple rule. If you ever find 
yourself copying a script from one event handler to another, stop and refactor the script into a global script module! Then simply call your new 
module from the event handler. This rule will help prevent code duplication across your project, a major maintenance liability.

How to use Script Modules

To add a script module, simply right click the package and click the  button. Each module is a python script library[project]  New Module
script that may define many functions. You may also organize modules in subpackages if you'd like. Lets suppose you added a script module named m

, whose body was:yfuncs

def callMe(message):
    system.gui.messageBox(message)

Now, anywhere in your project you can call:

project.myfuncs.callMe('Hello World')

To import System or not to import System

Frequently in Ignition, your scripts get  (the built-in library package in Ignition) and imported for you automatically.system shared or project 

Subsequent versions of Ignition beyond version 7 no longer need import system every time you create a new scope. However versions prior to version 
7 still require an import system every time a system associated function is called inside a function.  Ignition versions prior to version 7 still need the 
import system when system functions are called inside functions. Regardless, typing import system in any version of Ignition will result in the system 
library being available for use inside the function.

See also: , Scripting Intro Scope and Import

 

   

In this section ...  

   

https://legacy-docs.inductiveautomation.com/display/DOC/Scripting+Overview+and+Syntax#ScriptingOverviewandSyntax-scopeandimport


Gateway vs. Client Event Scripts
 

Your projects can execute scripts in response to a variety of events and actions that occur within the 
project's lifecycle. There are two major scopes for scripting: Gateway scripts and Client scripts. 

Gateway Scripts

Gateway scripts execute on the Ignition Gateway, which means that they always execute in one place.

Client Scripts

Client scripts execute in the running Client, which means that they may never execute (if no clients are 
running), or they may execute many times. Client scripts will also execute in the Designer, but only in 
Preview Mode. 

Because Clients are full-fledged applications, the scripts run on the computer running the Client, not on 
the Gateway's host server computer. This means that they don't have access to the Gateway's file 
system, and so on. It also means that if no clients are launched, the scripts will not be executing.

Note that these global project event scripts are not to be confused with the   scripcomponent event handler
ts.

 

Gateway vs Client 
Event Scripts

Watch the Video

 

Next...

Startup Scripts

 

 

https://inductiveuniversity.com/video/gateway-vs-client-event-scripts/7.8


Startup Scripts
 

These script types are available in both Gateway and Client scopes. These scripts will be run when 
the project starts up or shuts down. 

In the Gateway scripting scope, this means that the script will run when the Gateway starts up or is shut 
down, and whenever the scripting configuration changes via a Designer save action. This means that 
while designing, the startup and shutdown events may happen frequently.

In the Client scripting scope, these scripts run after a user successfully logs in or out, or when the client 
is closed.

Startup Scripts

Watch the Video

 

 

   

 

Next...

Shutdown Scripts

 

 

https://inductiveuniversity.com/video/startup-scripts/7.8


Shutdown Scripts
 

This script type is only available in the Client scope. This is a special script that will be called when the 
user tries to exit or close the client, that is, shutdown the Client. This script is run with a special event 
variable in its namespace. When the script terminates, if  is 1, the shutdown will be event.cancel

aborted, and the client will remain open. Otherwise, the normal shutdown script will be called, and the 
client will close.

Example

if "SuperUser" not in system.security.getRoles():
        system.gui.warningBox("Exit not allowed for non-admin user.")
        event.cancel=1

Shutdown Scripts

Watch the Video

 

 

 

Next...

Keystroke Scripts

 

 

https://inductiveuniversity.com/video/shutdown-scripts/7.8


Keystroke Scripts
 

Keystroke scripts are only available in the Client scope. These are scripts that run on a certain 
key combination. You may add as many keystroke scripts as you'd like, as long as each one has a 
unique key combination. The keystroke event scripts fire on the Client when a user performs a certain 
key stroke.

When choosing a keystroke, you may choose any number of modifiers, which are keys or mouse buttons 
that must be down to activate the keystroke. You can also choose whether or not the keystroke is on the 
pressed or released event of a keyboard key, or upon the typing of a character. Special keys like the F-
keys, ESC, etc, are only available in the pressed and released actions. Keystroke Scripts

Watch the Video

 

 

 

 

Next...

Tag Change Scripts

 

 

https://inductiveuniversity.com/video/keystroke-scripts/7.8


Timer Scripts
 

Timer scripts are available in both Gateway and Client scopes. These scripts execute periodically on a 
timer at a fixed delay or rate. Remember that Client timer scripts may never execute (if no clients are 
open) or may execute many times (once per open client). If you need scripting logic that occurs centrally, 
make sure you use Gateway scoped scripts.

Fixed delay or fixed rate?

A fixed delay timer script (the default) waits for the given delay between each script invocation. 
This means that the script's rate will actually be the delay plus the amount of time it takes to execute 
the script. This is the safest option since it prevents a script from mistakenly running 
continuously because it takes longer to execute the script than the delay.

Fixed rate scripts attempt to run the script at a fixed rate relative to the first execution. If the script takes 
too long, or there is too much background process, this may not be possible. See the documentation for j

 for more details.ava.util.Timer.scheduleAtFixedRate()

Shared thread or dedicated thread?

All timer scripts for a given project that choose  will all execute in the same thread. Run in shared thread
This is usually desirable, to prevent creating lots of unnecessary threads. However, if your script takes a 
long time to run, it will block other timer tasks on the shared thread. The rule of thumb here is that quick-
running tasks should run in the shared thread, and long-running tasks should get their own thread.

Timer Scripts

Watch the Video

 

 

 

Next...
 

 

http://docs.oracle.com/javase/1.5.0/docs/api/java/util/Timer.html#scheduleAtFixedRate(java.util.TimerTask, long, long)
http://docs.oracle.com/javase/1.5.0/docs/api/java/util/Timer.html#scheduleAtFixedRate(java.util.TimerTask, long, long)
https://inductiveuniversity.com/video/timer-scripts/7.8


Tag Change Scripts
 

Tag Change scripts are available in both Gateway and Client scopes. Each tag change script can 
be given a list of tag paths. Whenever one of these tags changes, the tag change script will execute. 
They will also get an initial execution whenever the scripting system starts up.

Each tag change script can be given a name for organizational purposes. To specify multiple tag for 
a given script, enter them one per line in the tag paths text area. To quickly import many tags, you 
can drag-and-drop tags from the Tag Browser window onto this text area.

These scripts receive three special variables in their namespace when they are run: , event initialCha
, and . The  variable is a flag (0 or 1) that indicates whether or not this nge newValue intialChange

event is due to initially subscribing or not. The event variable is a   object, which itself TagChangeEvent
contains the properties: , , and . The third, , is the new value for tag tagPath tagProperty newValue
the tag property that is subscribed. These values are objects themselves that contain a value, quality, 
and timestamp. The following example script should be a good starting point:

print "Received tag change event for %s" % event.tagPath
value = newValue.value
quality = newValue.quality
timestamp = newValue.timestamp
print "value=%s, quality=%s, timestamp=%s" %(value, quality, timestamp)

Tag Change Scripts

Watch the Video

 

 

 

Next...

Tag Scripts

 

 

The TagPath object that you access via  is itself a complex object. You can event.tagPath
turn it into a string if you want the whole tag path by using the  function. You can also str()
access individual parts of the tag path. The most useful is usually the  property, itemName
which is the name of the tag represented by the path. To get the name of the tag, you can use 

.event.tagPath.itemName

https://inductiveuniversity.com/video/tag-change-scripts/7.8
https://legacy-docs.inductiveautomation.com/pages/createpage.action?spaceKey=DOC&title=Tag+Scripts&linkCreation=true&fromPageId=1704568


Tag Event Scripts

Each tag has five special events, each with their own event handler that can run a script when the event 
occurs similar to event handlers on components. Those events are

Value Changed
Quality Changed
Alarm Active
Alarm Cleared
Alarm Acknowledged

Each event is unique and can have specialized arguments depending on the event. Also, because tags 
are stored in the gateway, all of these scripts fire in the gateway scope.

Tag Scripts

Watch the Video

Getting Started
Each tag has the option to have tag event scripts on it. When you edit a tag, you can navigate to the Tag Events section to see a list of all of the tag 
scripts. You can then select which event you would like to write a script for. You can even write a script for multiple events if you would like.

Value Changed

The Value Changed event is fired whenever the value of this particular tag changes. This event has a variety of arguments available for use in the 
script:

String tagPath - The full path to the tag.

Object previousValue - The previous value. This is a qualified value, so it has value, quality, and timestamp properties.

Object currentValue - The current value. This is a qualified value, so it has value, quality, and timestamp properties.

Boolean initialChange - A boolean flag indicating whether this event is due to the first execution of the initial subscription.

Boolean missedEvents - A flag indicating that some events have been skipped due to an event overflow.

Quality Changed

The Quality Changed event is fired whenever the quality of this particular tag changes. Since tags use a 'qualified value', which include a value, 
quality, and timestamp, this script will fire whenever any of those change. This event has a variety of arguments available for use in the script:

String tagPath - The full path to the tag.

Object previousValue - The previous value. This is a qualified value, so it has value, quality, and timestamp properties.

Object currentValue - The current value. This is a qualified value, so it has value, quality, and timestamp properties.

Because these scripts are gateway scoped, certain things like print statements will not print to 
the designer console, but will print instead to the wrapper logs. Keep that in consideration 
when doing any testing.

The currentValue and previousValue arguments are qualified values. This means that to get to the actual current value, it would look like 
currentValue.value.

https://inductiveuniversity.com/video/tag-scripts/7.8


Boolean initialChange - A boolean flag indicating whether this event is due to the first execution of the initial subscription.

Boolean missedEvents - A flag indicating that some events have been skipped due to an event overflow.

Alarm Active

The Alarm Active event fires whenever an alarm becomes active on the tag.This event has a variety of arguments available for use in the script:

String tagPath - The full path to the tag.

String alarmName - The name of the alarm. This does not include the full alarm path.

Object alarmEvent - The full alarm event object. The properties available to this object are:

id
source
name
priority
displayPath
displayPathOrSource (the display path if it is set, otherwise the source)
state (the current state, active/cleared + acked/unacked)
lastEventState (the last transition)
cleared (a boolean if the alarm is currently cleared)
acked (a boolean if the alarm is currently acknowledged)
shelved (a boolean if the alarm is currently acknowledged)
notes

String alarmPath - The full alarm path.

Boolean missedEvents - A flag indicating that some events have been skipped due to an event overflow.

Alarm Cleared

The Alarm Cleared event fires whenever an alarm becomes cleared on the tag.This event has a variety of arguments available for use in the script:

String tagPath - The full path to the tag.

String alarmName - The name of the alarm. This does not include the full alarm path.

Object alarmEvent - The full alarm event object. See the Alarm Active alarmEvent object for the full list of available properties.

String alarmPath - The full alarm path.

Boolean missedEvents - A flag indicating that some events have been skipped due to an event overflow.

Alarm Acknowledged

The Alarm Acknowledged event fires whenever an alarm event becomes acknowledged on the tag.This event has a variety of arguments available for 
use in the script:

String tagPath - The full path to the tag.

String alarmName - The name of the alarm. This does not include the full alarm path.

Object alarmEvent - The full alarm event object. See the Alarm Active alarmEvent object for the full list of available properties.

String alarmPath - The full alarm path.

String ackedBy - The full path to the user that acknowledged the alarm.

Boolean missedEvents - A flag indicating that some events have been skipped due to an event overflow.

Examples

Printing all parameters

#This script will fetch all of the possible parameters in the tag changed script. 
#Note that this will not print out to the console, but it will print to the wrapper logs located on the 
gateway.

path = tagPath
prev = previousValue
cur = currentValue
init = initialChange
missed = missedEvents
print path, prev.value, cur.quality, init, missed



Automatic Reset

#This code can be used on a Value Changed script, and will automatically reset the value of the tag to 0 
after it goes above 3000
#This can be useful for counter tags.
if currentValue.value > 3000:
                system.tag.write("IntegerCounterTag", 0) 

Copy to another Tag

#This code can be used on a Value Changed script, and will record the highest value of the current tag onto 
another memory tag.
#This can be useful for recording the highest temperature.
highestRecordedTemp = system.tag.read("HighestTempTag").value
if currentValue.value > highestRecordedTemp:
        system.tag.write("HighestTempTag", currentValue.value)

Next...

Menubar



Menubar
 

The Client's menu bar is configured and customized through the Client Event Scripts dialog box. Each 
node in the menu bar that does not have children executes a script when the user presses it. Most 
commonly, these scripts will execute navigation actions, opening, or swapping a window.

See also: , Navigation Strategies Client/User Interface Properties

Menu Bar

Watch the Video

 

Next...

Shared Scripts

 

 

 

https://legacy-docs.inductiveautomation.com/display/DOC/About+Project+Properties#AboutProjectProperties-Client/UserInterfaceProperties
https://inductiveuniversity.com/video/menubar/7.8


Shared Scripts
 

You can use the "shared" script library to add script functions that your whole Gateway can use.

Shared Scripts

Watch the Video

 

 

 

Next...

Project Scripts

 

 

 

https://inductiveuniversity.com/video/shared-scripts/7.8


Project Scripts
 

Learn to use the script library to consolidate frequently used script logic into one place. project

Project Scripts

Watch the Video

 

 

 

Next...

 

 Script Messaging

 

 

https://inductiveuniversity.com/video/project-scripts/7.8


Script Messaging
 

Message handler scripts run when system.util.sendMessage() is called on a remote Client or on the 
Gateway to send a message. Message handlers can be created for both Gateway and Client scopes. To 
create a message handler within a Designer, navigate to Project -> Gateway Event Scripts or Project -> 
Client Event Scripts. Click on the Message type on the left side, and then click on the '+' icon at the 
bottom to add a new script.

Threading
By default, all message handlers for a project execute on a single shared background thread. This 
arrangement is normally the most efficient. However, if a message handler is performing a lengthy 
operation, messages may become backed up while waiting for the shared thread. In order to prevent this, 
you can specify that a message handler runs on its own dedicated thread by setting the Threading value 
to "Dedicated".

WARNING: Both the shared thread and dedicated threads run in the background, meaning that if you 
need to update a component in the GUI (window navigation, setting and getting component properties, 
showing error/message popups, etc) you must wrap the code in a function and use system.util.
invokeLater() to run the function as shown in the example below. An alternative is to set the threading 
value to "EDT". This value will execute the message handler code directly on the Event Dispatch Thread 
(EDT). The disadvantage of this approach is that your entire Client will freeze if the message handler 
script does not execute its code quickly.

Message payload
A message sent using system.util.sendMessage() may optionally contain a message payload Dictionary 
object to access custom message parameters. This Dictionary can be accessed from the "payload" 
variable as shown in the example below. If no Dictionary was passed when sending the message, then 
the "payload" variable will be an empty Dictionary.

Example send script

payloadDict = {}
payloadDict['first']="Hello"
payloadDict['second']="World"
system.util.sendMessage("ProjectX","myHandler",payloadDict)

 

Example message handler using invokeLater()

def handleMessage(payload):
        """
        message = "Message received by ProjectX myHandler. "
        if payload.has_key('first'):
                message += "First param=" + str(payload['first']) + ". "
        
        if payload.has_key('second'):
                message += "Second param=" + str(payload['second']) + ". "
        def handleMessage(theMessage=message):
                import system
                window = system.gui.getWindow("Main Window")
                rootContainer = window.getRootContainer()
                textarea = rootContainer.getComponent("receivedMessages")
                textarea.text += theMessage + "\n"
        system.util.invokeLater(handleMessage)

Script Messaging

Watch the Video

 

 

 

Next...

Timer Scripts

 

 

https://inductiveuniversity.com/video/script-messaging/7.8


Schedule and Holiday Scripting
 

 

Schedule and 
Holiday Scripting

Watch the Video

 

Next...
 

 

https://www.inductiveuniversity.com/video/schedule-and-holiday-scripting/7.8


1.  
2.  

Web Services & SUDS
   

Web Services Overview

Web services are software solutions that allow for interacting with machines residing on a network.  In short, web services are nothing more than web 
pages for machines. They provide a standard way for a third party to request and receive data from a piece of hardware on the network without having 
to know anything about how that machine works.  Other programs interact with the service through an interface defined by a WSDL (Web Services 
Description Language) file.  This WSDL describes how to talk with the device and what should be expected back in response. Messages to and from 
the web service are formatted XML and while you need very little knowledge of XML to use the SUDS library, many times a web service will return a 
formatted XML string that you will have to parse through manually in order to make the data presentable.

What if I do not have the SUDS library?

Some installations of Ignition may not have the SUDS library, but it can easily be added following the steps below:

Download the SUDS library: https://fedorahosted.org/suds/
Place the library into Ignition's installation directory: Knowledge Base - Importing 3rd party modules

When working with Web Services, the SUDS   and the   are a good place to start.documentation PyDocs

   

   

In this section ...  

   

Did you know?

SUDS doesn't actually stand for anything! It's a lightweight version of SOAP, hence the name SUDS. SOAP stands for Simple Object 
Access Protocol, and is commonly used for Internet communication.

https://fedorahosted.org/suds/
https://support.inductiveautomation.com/index.php?/Knowledgebase/Article/View/98/0/importing-and-using-3rd-party-python-libraries-in-ignition
https://fedorahosted.org/suds/wiki/Documentation
http://jortel.fedorapeople.org/suds/doc/


1.  

Overview & Simple Arguments
 

The SUDS Library

The SUDS library is a SOAP-based web services client developed for Python.  It is extremely simple to use and practically eliminates the need for the 
user to understand or even view the WSDL of a web service.  The SUDS library interprets the WSDL file for you and through a couple simple function 
calls allows you to get a list of the available methods provided to you by the web service. You can then invoke these methods in Ignition through event 
scripting to send and receive data in your projects.  You will have to familiarize yourself with the SUDS library in order to make use of it.

A Simple Example

If you read through the SUDS documentation you'll see that the Client object is the primary interface for most users.  It is extremely simple using this 
object and a few print statements to view a list of available methods provided by the web service you are connecting to.  This example will illustrate 
how to make an initial connect to a web service, print out the list of available methods, and then call one of these methods and display the resulting 
value in a label on an Ignition window at the push of a button.  The below example uses a public web service and is available for anyone to test 
against.

 

First, we can use the script playground to test out some scripting calls and see the output.  The 
below example shows how to get a reference to a client object.  By printing this client object to 
the console we get an output of all the available methods, types and other information about the 
web service as defined in the WSDL file.
 

Example Code

from suds.client import Client
client = Client("http://www.w3schools.com/xml/tempconvert.asmx?WSDL")
print client

 

This WSDL defines two functions: CelsiusToFahrenheit(string Celsius)  and FahrenheitToCelsius
(string Fahrenheit).  These are the functions that this web service makes available to you.  Don't 
worry about the fact that the methods are listed twice.  This is just because the WSDL has two 
definitions of the functions that are formatted for different SOAP version standards.  To call these 
functions in Ignition scripting you have to make use of the "service" member of the client object.

 

2. To make a simple conversion window in an Ignition project you can add two buttons, a numeric 
textbox, and a lable to a window.  Then on the button to be used to calculate a Fahrenheit to 
Celsius calculation you would place something like the following:
 

F -> C Example Code:

 

 

 

 

 

The information below assumes the SUDS library is already in Ignition's installation directory. If the example below fails because SUDS is 
not present, .click here to learn about importing the SUDS library

https://legacy-docs.inductiveautomation.com/pages/viewpage.action?pageId=4497963#WebServices&SUDS-install


from suds.client import Client
client = Client("http://www.w3schools.com/xml/tempconvert.asmx?WSDL")

far_value = event.source.parent.getComponent('Numeric Text Field').
floatValue
cels_value = client.service.FahrenheitToCelsius(far_value)

event.source.parent.getComponent('Label').text = cels_value

 

 

 

3. Then on the second button do the opposite.
 

C -> F Example Code:

from suds.client import Client
client = Client("http://www.w3schools.com/xml/tempconvert.asmx?WSDL")

cels_value = event.source.parent.getComponent('Numeric Text Field').
floatValue
far_value = client.service.CelsiusToFahrenheit(cels_value)

event.source.parent.getComponent('Label').text = far_value

 

 

 

 

 

 

4. With your scripts in place your window should now function as a simple temperature conversion 
tool!
 

 

Beyond the Example

This example is extremely simple and rather straight forward.  The main steps to remember when attempting to use the SUDS library in scripting are 
as follows:

#Import the SUDS Client object
from suds.client import Client
 
#Instantiate a new Client Object



client = Client("url_to_your_wsdl")
 
#Call the desired method using the service instance variable
client.service.MyMethod(myArgument)

Next...

Complex Arguments

 



Complex Arguments
 

In the overview example the methods provided by the web service were very simple and took simple argument types.  Sometimes however the web 
service will describe complex types and allow you create instances of these types that can then be added to the system/machine that the web service 
is providing an interface for.

 

A simple, hypothetical example of this would be a system that stores contact information of clients and can be used as an address book of sorts by 
other systems on the network.  It may provide not only a way to pull contact information for a certain individual out but also a way to insert new 
contacts.  We'll keep the example simple and say that contacts have only a name and a phone number.

 

This example is completely hypothetical.  It is intended to give insight into complex types.  It does not make use of an an actual functional 
web service.  A very similar example can be found in the SUDS documentation.

Say we create and print the client object we associated with our web service in the following manner

 

from suds.client import Client
url = 'http://localhost:7575/webservices/hypothetical_webservice?wsdl'
client = Client(url)
print client

And the resulting output is the following:

Suds ( https://fedorahosted.org/suds/ )  version: 0.4 GA  build: R699-20100913
 
Service (hypothetical_webservice)
   Prefixes (0):
   Ports (1):
     (Soap)
       Methods:
         addContact(Contact contact, )
         getContactList(xs:string str, xs:int length, )
         getContactByName(Name name, )
   Types (3):
     Contact
     Name
     Phone

 

Here you can see that, while not too complicated the web service defines more than just methods that take simple type arguments and return the 
same.  Under the Types section you can see there are three "complex" types.  These are basically just objects like one creates in an object oriented 
programming language like java.  The SUDS Client object has an instance variable called "factory" that allows you to create these complex types so 
you can use them to invoke methods defined by your web service that take complex arguments.

 

If we wanted to add a contact using the addContact() method we have to create a contact object first:

contact = client.factory.create('Contact')
print contact

 

The create function creates a new contact object that knows its own structure.  We can view this structure by calling print on this new object and see 
that it prints the following:

(Contact)=
  {
    phone = []
    age = NONE



    name(Name) = 
        {
            last = NONE
            first = NONE
        }
   }

By examining the Contact type object we can see its structure and know what we need to create in order to have a valid Contact to add to the address 
book.  We could then do the following to supply the necessary information for the Contact object and then call our addContact function.

 

 

 

phone = client.factory.create('Phone')
phone.arecode = '916'
phone.number = '5557777'
 
name = client.factory.create('Name')
name.first = 'John'
name.last = 'Doe'
 
contact.name = name
contact.phone.append(phone)
 
client.service.addContact(contact)

 

 

 

After execution a new contact will have been added via the web service.  There is also a way to use python dictionaries to specify complex arguments 
that is detailed in the SUDS  .documentation

 Steps to remember when using complex types:

#Create a new type object using the factory instance variable of the Client object
my_type = client.factory.create('MyType')
 
#If you don't know the structure of the newly created object then print it to the console
print my_type

 

 

 

Next...

Parsing XML Results

 

 

https://fedorahosted.org/suds/wiki/Documentation


Parsing XML Results
 

 

It's quite easy deal with return values of method calls when they are simple none structured values like floats or integers.  However it's not always the 
case that you will have simple single values returned from a method call.  Many times web services will return values that have some sort of structure 
to them like a dataset.  Since there is no way for the web service to know how this value should be represented in the language/environment that 
called the method it is common that the result will be returned in an XML formatted string.  Dealing with these strings is not really part of the SUDS 
library but an example of XML string handling is included here for completeness.  This example makes use of the xml.dom.minidom python module to 
parse the XML string and pull out the data.

Periodic Table Example - Using xml.dom.minidom XML parsing

One of the public web services that are available has a method for returning the elements in the periodic table in a structured string.  This example will 
show you how you can take that string result, parse through it and then create an Ignition dataset that can be displayed in a table component.  The 
xml.dom.minidom library provides the functionality for parsing XML strings and returning what is called an XML Document (in fact DOM stands for 
Document Object Model).  This Document has functions that allow you access the elements within the document by specifying their respective XML 
tags.  Most of this library is out of the scope of this document but if you have any questions about the functions being used they can be found   and here

.here

 

1. The call to the web service to get the list of elements

from suds.client import Client
from xml.dom.minidom import parseString
client = Client("http://www.webservicex.net/periodictable.asmx?WSDL")
elements = client.service.GetAtoms()

 

2. The elements variable will now contain a structured string of the following format.  We take note of this format so we will know how to parse the 
string.

 <NewDataSet>
 <Table>
  <ElementName>Actinium</ElementName>
 </Table>
 ...
</NewDataSet>

3. Now we can parse the string and create a list of the element data

dom = parseString(xml_string)
xmlTags = dom.getElementsByTagName('ElementName')
xmlData = []
for tag in xmlTags:
        xmlData.append(tag.firstChild.data)

4. The xmlData list now contains all of the names of the elements from the periodic table.  Now let's get separate lists for all of the atomic numbers, 
atomic weights, and element numbers in the same order as our element list

element_weights = []
element_numbers = []
element_symbols = []
for name in element_names:
        weight = (parseString(client.service.GetAtomicWeight(name)).getElementsByTagName('AtomicWeight')[0].
firstChild.data)
        number = (parseString(client.service.GetAtomicNumber(name)).getElementsByTagName('AtomicNumber')[0].
firstChild.data)
        symbol = (parseString(client.service.GetElementSymbol(name)).getElementsByTagName('Symbol')[0].
firstChild.data)
        element_weights.append(weight)

http://docs.python.org/library/xml.dom.minidom.html
http://docs.python.org/library/xml.dom.html#module-xml.dom


        element_numbers.append(number)
        element_symbols.append(symbol)

5. With our four lists we can now go about building a dataset and then use the dataset to set the data property on a table

headers = ["Name", "Symbol", "Weight", "Number"]
i = 0
rows = []
for name in element_names:
        oneRow = [name,element_symbols[i],element_weights[i],element_numbers[i]]
        rows.append(oneRow)
        i += 1
data = system.dataset.toDataSet(headers, rows)
event.source.parent.getComponent('Table').data = data

 

6. Put all of that together and throw it on a button's actionPerformed event inside a window with a table on it and test away!  It should be noted that 
this script will take a couple minutes to run since there is no function to get all of the weights, numbers or symbols in one method call.  Be patient.

 

 

 

Next...
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Security
   

Users, Roles, and User Sources

Ignition uses the concept of role-based security throughout. Role-based security is the concept that each user may be assigned to various roles. 
Security policies are then defined in terms of these roles, rather than defined for specific users. This allows users to be reassigned, removed, and 
added without affecting the logic of the security policy.

The users and their roles are defined in User Sources. An Ignition Gateway may have many different User Sources defined, each governing the 
security of different aspects of the Gateway. For example, logging into the Gateway configuration web interface might be governed by one User 
Source, while the security for a project is governed by another. 

There are many different types of User Sources that offer various features. For example, the Internal User Source offers the ultimate in ease-of-use: 
you simply define the users, their passwords, and the roles within the Ignition Gateway configuration web interface. In contrast, the Active-Directory 
User Source offers the power of integrating Ignition with a corporate security infrastructure. Users, passwords, and roles would be managed centrally 
by the IT department.

Security policies can be defined for many different parts of the system. For example:

You can alter the roles required to log into the Gateway configuration section.
You can define roles required to write to or even read from a Tag.
You can define roles required to view a Component.
You can access the security system in a script to restrict the operation of the script to authorized users.

Which User Source Controls What?

With potentially multiple User Sources defined, you need to understand which User Sources are controlling which aspects of Ignition. To know what 
kind of User Source is governing what, do the following steps:

To manage users and passwords for logging into the Gateway Configuration section, you'll need to see what User Source is currently set as 
the Gateway's User Source. You can check this under   by looking at the System User Source field Configuration > Gateway Settings
and the Gateway Config Role(s) field.
 
To manage users and passwords for logging into the Designer, you follow the same steps as in #1, except that you need to look at the 
Designer Role(s) field to see what roles are allowed to log into the designer.
 
To manage users and passwords for logging into a Vision Client, you go to the   section. Look at the project in Configuration > Projects
question and you can find its User Source listed there.
 
Now that you know what User Source you need to manage, you can find out what kind it is under the   section.Security > Users, Roles

Contact Information and Schedules

User Sources are also used for other aspects of the system besides security. For example, the alarm notification system also uses users from User 
Sources to know who to send alarm notification messages to. For this reason, more information can be associated with a user. Contact info can 
be added to support the alarm notification system. A schedule can be defined on a user which can control when they are able to log in and receive 
alarm notification messages. Language preferences can be defined on a per-user basis to better support individual user's preferred language.

Managing Users

User Sources support managing the users and roles from within Ignition to varying degrees. Some User Sources are fully manageable, meaning that 
you can administer the users, roles, contact info, and so on from within the Ignition Gateway, as well as inside a Vision Client. Other User Sources do 
not support this at all, while yet others only partially support it. Make sure you understand how and where the administration takes place before you 
choose a User Source type.

For User Sources that support it, you can manage the users and roles from within the Ignition Gateway's web config interface under Configure > 
. Click on the  link next to the User Source you want to administer.Security > Users, Roles manage

Often it is desirable to let some management or administrative users of a Vision project manage other users without having to log into the Gateway's 
Configure section. To do this for a User Source that supports being managed, you can simply use the built-in User Management Panel that comes 
with the Vision Module.

 

 

In this section ...

 



Gateway Security
 

The Gateway's web interface can be secured in two ways:

Password protected (see  )Changing Admin Password
Encrypted communication (see  )Requiring SSL

 

   

In this section ...  
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Requiring SSL

To enhance security in Ignition, you may opt to enable SSL encryption. This will affect all communication 
to and from the Gateway that is done over the HTTP protocol. This includes not only browsers interacting 
with the Gateway's web interface, but all Vision Client communication as well. Turning on SSL will 
encrypt all data sent over HTTP. This protects your installation from anyone "snooping" the data as it 
passes over the network. This may be important if data transferred between the Gateway and Clients is 
sensitive in nature. This also helps to thwart a security vulnerability known as "session hijacking".

To turn on SSL

Go to the  section of the Gateway.Configure

Choose  from the menus on the left.Configuration > Gateway Settings

Select the check box for  and click on  at the very bottom of the page.Use SSL Save Changes
After SSL is enabled, all Clients, Designers, and web browsers are redirected to the SSL port if 
they try to use the standard HTTP port. By default, the SSL port is 8043. You can change it to 
the standard SSL port of 443. To do this, follow the directions in  .Setting the Port

Requiring SSL

Watch the Video

Enabling SSL

Enable SSL communications in Ignition to set up secure communication to the Gateway webpage as well as Client/Designer communication with the 
Gateway. You need to acquire and install an SSL Certificate for Ignition. It is highly recommended that you purchase an SSL certificate from a 

  .certificate authority if you turn this feature on, see Installing a Genuine SSL Certificate

Installing a Genuine SSL Certificate

When you turn on SSL in Ignition, the web browser uses what is called a "self-signed" certificate. This gives you the encryption benefits of SSL, but 
not the identity validation, and it isn't a "real" certificate. This is why a web browser will display nasty warnings to users that they shouldn't trust the 
website.

We are not able to ship a real certificate with Ignition because SSL certificates have to be purchased individually from a certificate authority, such as 
Verisign, GoDaddy, or Comodo.

This guide shows you how to purchase and install a real SSL certificate from a certificate authority and install it in Ignition. You'll need to be 
comfortable executing command-line programs to complete this guide. The examples in this guide assume a Windows environment, but the 
general procedure would be identical in Linux.

Install the Java Development Kit (JDK).
There are some command-line tools you'll need to use to create a certificate request and to install your certificate. These tools come with the 

have the Java Runtime Environment (JRE) installed. Go toJava Development Kit (JDK). It is likely that you only    http://java.oracle.com and 
click on Java SE. Download the Java SE 6 JDK and install it.
 
Open a command prompt.
Open a command prompt from   and change directory into your JDK tools directory.Start > Run > cmd
cd C:\Program Files\Java\jdk1.6.0_24\bin
 
Create your KeyStore.
SSL certificates for Ignition are stored in a file called a K . You'll need to create your own K  file with a certificate in it before eyStore eyStore
you can purchase the SSL certificate.

Enter the following command:
keytool -genkey -alias tomcat -keyalg RSA -keysize 2048 -keystore C:\ssl.key
you can put the file wherever you want for now, but you should call it ssl.key

At the prompt, enter a password. Use the password: ignition

At the prompt, you are asked for your . Do not use your first and last name. This value must be one of the first and last name
following for your Ignition Gateway:

Fully Qualified Domain Name, for example secure.yourdomain.com
Public IP address, for example 202.144.8.10
Full Server Name of your internal server, for example scadaserver
Private IP address, for example 192.168.0.1
 

At the prompt, you are asked for information about your company. Input all data accurately, as the certificate authority needs to 
verify this information.
 

https://inductiveuniversity.com/video/requiring-ssl/7.8
http://java.oracle.com
http://secure.yourdomain.com


3.  

e.  

4.  

5.  

6.  

a.  

b.  

c.  

d.  

7.  

Lastly, at the prompt, you are asked for the password for alias <tomcat>. Press RETURN to use the same password as the Key

Store file.

 
Generate a Certificate Signing Request.
You have a K  file named  at the root of your  drive (or wherever you eyStore ssl.key C:\ specified it to be in step 3a).

In your command prompt window, enter this command:
keytool -certreq -alias tomcat -file C:\csr.txt -keystore C:\ssl.key

It will prompt you for the K  password ( ). You now have a certificate request file at eyStore ignition C:\csr.txt
 
Buy the SSL certificate.
Now you need to get your SSL certificate signed by a certificate authority. When you go to a certificate authority (Verisign, GoDaddy, 
Comodo, and so on), they'll ask for your CSR, which is the  file that you created in step 4. Typically they'll ask you to paste your csr.txt
CSR into their web form. Open  in notepad, and copy-and-paste it into the certificate authority's form.csr.txt
If prompted what software generated the CSR, choose Tomcat or Java. After the certificate authority has processed your payment and 
reviewed your CSR, they will send you your certificate via email.
 
Install the SSL certificate.
After your SSL certificate has been emailed to you, follow the instructions provided for installing the certificate into a Java KeyStore. Your 
certificate authority provides these instructions. The following is the procedure for installing a Comodo SSL certificate, provided as an 
example:
 

Extract the certificate files that were emailed to you, in this example they were extracted to  C:\cert
 
Install the root certificate with the following command:
keytool -import -trustcacerts -alias root -file C:\cert\AddTrustExternalCARoot.crt -keystore C:
\ssl.key
 
Install the COMODO intermediate certificate:
keytool -import -trustcacerts -alias INTER -file C:\cert\COMODOHigh-AssuranceSecureServerCA.crt -
keystore C:\ssl.key
 
Install your server's certificate:
keytool -import -trustcacerts -alias tomcat -file C:\cert\192_168_1_7.crt -keystore C:\ssl.key
 

Replace Ignition's default K .eyStore
You now have a K  file at  that holds your SSL certificate. The certificate alias is and the password is eyStore C:\ssl.key  tomcat ignition
. You can now replace the K  file that ships with Ignition with your file. Make a backup of the file at eyStore C:\Program 

 and replace it with your K  file. You need to restart the Ignition Files\Inductive Automation\Ignition\tomcat\ssl.key eyStore
service after replacing this file.
Make sure your SSL port is allowed through your server's firewall. The default SSL port is 8043, and can be changed to the standard SSL 
port (443) through the Gateway Control Utility (GCU).
If you have a redundant installation, you'll need to repeat this procedure on your backup server and buy a second certificate for it.

Next...

Changing Admin Password



Changing Admin Password
 

The first step in securing your Ignition installation is to change the default username/password.

Password Protection

By default, the   section of the Gateway is password protected, and this cannot be removed. Configure
You can also optionally protect the   and the   sections. You can also change the roles Status Home
that are required to access any of these sections under  .Configuration > Gateway Settings

Changing admin 
Password

Watch the Video

 

 

 

Next...

Role-based Access
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Role-based Access
 

Security is based on the roles that are assigned to specific users. Roles do not have any structure or 
hierarchy by default, but can be created. You can create a hierarchy based on users with a greater role 
being assigned all matching lesser roles. Each user can have no role or many roles. 

To create a role

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Security > Users, Roles
The User Sources page is displayed.
 
Click on the   link for the  you want to manage.manage users User Source
 
Click the  tab, look for the orange arrow and click the  link.Roles Add Role
 
Name the role by entering it in   and click on  to add the role.Role Name Add Role
The role is now available to be associated with specific users.

To assign roles to users

Go to the   section of the Gateway.Configure
 
Choose   from the menu on the left.Security > Users, Roles
The User Sources page is displayed.
 
Click on the   link for the   you want to manage.manage users User Source
 
Click on the   link for the User Source you want to edit, or look for the orange arrow and click Edit
the   link.Add User
 
Click the   tab, select which roles you want this user to have from the roles section of the Roles
user properties. 
The  role is the only role until more roles are added, therefore no other roles will Administrator
appear until they are created. Once they are created, they appear as check boxes just like the 
Adminstrator option.
 
Click  .Save Changes
The user now has the privileges associated with each role.

Role-based Access

Watch the Video

 

 

Next...

Internal Authentication

 

https://inductiveuniversity.com/video/role-based-access/7.8


Internal Authentication
   

Ignition's default authentication profile stores its user information internally. This video shows how to add 
and edit users and roles to the profile using the Gateway interface and the User Management 
component. The Gateway Allow User Admin setting must be enabled to make changes using the User 
Management component in the Designer or Client.

Internal User Source

The internal User Source is very easy to use. You get this User Source when you first installed Ignition 
and had the default user/password combination of admin/password. You can of course continue to use 
this default internal User Source for your project(s), or you may choose to use other User Sources 
instead.

The internal User Source is fully from withinmanageable  Ignition.

Internal 
Authentication

Watch the Video

 

 

   

 

Next...

Database Authentication
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Database Authentication
 

Add an additional authentication profile to store user information using an existing database connection. 
This video addresses the internal authentication profile Failover Source and the differences between a 
Hard and Soft Failover mode. It also includes information about the automatically created database 
tables.

Database User Source

The database user source uses an external database connection to find its users, their passwords, and 
their roles. When you create a database user source, you have the option of setting it up in automatic or 
manual modes.

Automatic Mode

In this mode, the user source will create and manage the database tables for you. In this mode, the user 
source will be fully from the Gateway and the Vision Clients using the user management manageable 
component. You can specify a prefix for the tables that are created, but their names after the prefix are 
chosen by the user source.

Manual Mode

In this mode, you must provide SQL queries for various functions of the user source. In this mode, 
the user source will not be manageable from the Gateway or the Clients. You'll have to manage the 
users yourself directly through the database. Examples for each of the queries are given on the user 
source setup page. Make sure to return the columns that are defined in each query's description.

Database 
Authentication

Watch the Video

 

 

 

Next...

Active Directory Authentication
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Active Directory Authentication

Let's add an additional authentication profile to fetch user information from Active Directory (AD). This 
video explains the Domain and LDAP settings, and using SSO (Single Sign On) and enabling it in each 
project. Active Directory Groups are used as Ignition's roles and user-role mappings. 

Active Directory User Source

The active directory User Source will communicate with a Microsoft Active Directory server through 
the LDAP protocol. Administration of the users and roles must be done through Active 
Directory's management tools. This User Source is a good choice when integration with a corporate 
authentication scheme is a requirement.

To set up an active directory User Source, you must specify the host that is acting as your 
primary domain controller. You can also use a secondary domain controller in case the primary is 
unavailable. You'll also need to specify the name of the domain and credentials for the Gateway itself to 
use for authentication for when it queries the list of roles.

This style of User Source is not manageable within Ignition. You'll need to administer the users 
through Active Directory itself.

Next...

AD Database Hybrid



AD Database Hybrid
 

Add an additional authentication profile to fetch the user list from Active Directory, but store all role 
information in a database. This authentication profile stores users, roles, and mappings in the database 
similar to the Database Authentication profile, but validates against passwords stored in Active Directory.

AD/Database User Source

The active directory/database hybrid profile type is a combination of the active directory User Source and 
the database (manual mode) User Source. This means that for any username/password combination, 
active directory gets to decide whether that user is a valid user, and if they are considered valid, then the 
other information for that user (roles, contact info, and so on) are retrieved from an external database 
connection.

Just like the AD/Internal User Source, this is very handy for projects that are required to integrate 
with IT's centrally managed security, but negotiating the management of roles with IT would be 
too cumbersome. This User Source is not  from within Ignition. Users/passwords must manageable
be administered through active directory, and roles, contact info, and so on, must be administered 
directly through the database.

AD Database Hybrid

Watch the Video

 

 

 

Next...

AD Internal Hybrid
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AD Internal Hybrid
 

Let's add an additional authentication profile to fetch the user list from Active Directory, but store all role 
information internally in Ignition. This authentication profile stores users, roles, and mappings in Ignition 
similar to the Internal Authentication profile, but validates against passwords stored in Active Directory. 

AD/Internal User Source

The active directory/internal hybrid profile type combines the internal User Source type with the 
active directory User Source type. Active Directory is used to find all of the users, and to check 
their credentials when they attempt to log in. However, it allows assigning of roles, contact info, and 
other meta-information about a user through Ignition, all of this information is then stored as if it were 
an internal User Source.

This way, Active Directory can be consulted to see if a user is valid, but the management of roles 
does not require coordination with the I.T. department, who typically control the Active Directory 
system. This "best of both worlds" approach is popular for many users of Active Directory.

The AD/Internal hybrid User Source is partially  . Users cannot be added or removed. manageable
Their usernames and passwords cannot be changed. This is because this information resides in 
Active Directory, not within Ignition. Other information, such as a user's roles, contact info, schedule, and 
so on, is manageable.

AD Internal Hybrid

Watch the Video

 

 

   

 

Next...

Verifying an Authentication Profile
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Verifying an Authentication Profile
 

You can verify that a user exists in a given authentication profile and if the password is correct.

To verify a user

Go to the  section of the Gateway.Configure

Choose  from the menu on the left.Security > Users, Roles
The  page is displayed.User Sources
 
Select the  link.Verify an Authentication Profile
 
In the resulting menu, choose the , , enter the  , and click Profile Username Password Test 

.Login
Ignition will test the credentials then display the results of the validity test.

Verifying an 
Authentication 
Profile

Watch the Video

 

 

Next...

Locking the Gateway
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Locking the Gateway
 

You can set up security for the Gateway webpage sections and Designer. The Gateway can use any 
existing authentication profile independent of any projects. Each of the Status, Home, and Configure 
pages can be restricted by role. Outside of logging into a Client, the Designer as well can require a 
special role.

To setup security for the Gateway

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Configuration > Gateway Settings
The  page is displayed. Gateway Settings
 
Enter the roles the user must have in order to access the , Gateway Config Roles Status Page 

, , and  .Roles Home Page Roles Designer Roles
Each option can accept any number of roles as long as they are separated by commas. Also, if 
the option is blank, any user with any role can log in. The  will Global Resource Protection
shelter the Global Resources from edits by users with roles other than what is stated here.

Locking the 
Gateway

Watch the Video

   

 

Next...
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Project Security in Client
 

You configure security in the Client on each component, window, or tag. Or you may simply want to make the entire Client read-only without having to 
setup security on each component.

 

In this section ...
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Project Security
 

You can change the Authentication profile used by a project and add the required user roles for a Client. 
A user must have at least one of the roles to open the Client.

To add a new role for a Client

From the Designer, go to  and go to the  section.Project > Properties General
 
In the Project Properties window, under , select the User Source from the Security Settings
drop-down menu.
 
Enter the  the Client will have to have in order to access the Client.Required Client Roles
 
Click  to save the settings.OK

Project Security

Watch the Video

 

Next...

 

 Tag Security
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Tag Security
 

You can add read/write security to individual tags through the Designer. Custom Access Rights must be 
set to use the Role-based permissions.

To set the access rights to a tag

Edit a tag by double-clicking on the tag.
 
In the  tab, from the  drop-down, select  , and click .General Access Rights Custom  OK
 
Go to the  tab, from the  drop-down select the role, and click the  Permissions Add a Role Add
button.
 
Change each roles rights by selecting the   or  options.Access Read/Write Read Only
 
Click .OK
Now the user must have appropriate permissions to write to interact with the tag.

 

Tag Security

Watch the Video

 

Next...

Component and Window Security
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Component and Window Security
 

Component security works on the component, group, container, and window levels. Also, each one of 
these has special categories of security that help with tuning security to various design considerations.

To change the security settings on a component

Right-click on a component and select .Security
The Security Settings panel is displayed.

Deselect the   check box.Inherit Permissions
 
Select the role that the user must have. If the roles do not appear, right-click the area and select 

.Refresh
 
In the  section, select the option that will enact if the user does not have the Restrictions
selected role.
 
Keep the panel or close it, the security settings are immediate.

Component and 
Window Security

Watch the Video

   

 

Next...

Securing Event Handlers
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Securing Event Handlers
 

You can set up security in an event script using the  function, and use system.security.getRoles
the function in any script in Ignition that runs in a Client.

To ensure the person invoking the script has sufficient privilages, use the following code:
 

if u'Administrator'in system.security.getRoles():
        #This part of the script will run if the user has the correct 
priviliges. For example:"
        print "this script will run if the user has a the administrator 
role."
else:
        system.gui.errorBox('Insufficient security privileges.')

If the person does not have sufficient privilages, the script will show an error box. The script can be 
embeded into any event handler.

Securing Event 
Handlers

Watch the Video

   

 

Next...

Setting Client Read-Only
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Setting Client Read-Only
 

There are times when it is best to open a Client in a read-only mode to eliminate the possibility that a 
Client will affect a device or database. The Client event start up script to set the Client mode to read-only 
is an easy way to accomplish this. Similar to the buttons in the Designer, this function can be used to set 
Disconnected, Read Only, and Read/Write modes in any script in Ignition that runs in a Client.

To set the Client to be Read-Only

From the Designer, go to  .Project Browser > Scripts > Client Event Scripts
The Client Event Scripts window is displayed.
 
In the  script enter this code:  where 2 Startup system.util.setConnectionMode(2)
means read-only.
 
Click .OK
The start-up script will run the next time a user opens the Client, resulting in the Client being 
read-only. 

Setting Client Read-
Only

Watch the Video

 

Next...

Custom Security
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Custom Security
 

Normally, security is handled according to the users roles, however sometimes it is important to control 
access by the location of the Client computer. For example, Clients with certain IP addresses can have a 
certain level of access, but Clients from computers with different IP addresses can have limited access. 
Likewise, the computer's host name is also a option.

This practice makes use of the system tags located in these location:

[System]Client/Network/Hostname
[System]Client/Network/IPAddress

Each Client will have access to distinct hostname and IP addresses. These can be used in Client startup 
scripts that evaluate the Client's information and compares it to a list of acceptable host names or IP 
addresses. This information can come from a database or a set of tags.

A Client startup script can make the comparison and make the appropriate decision. For example, it can 
set the connection state to read-only with the following function:

system.util.setConnectionState(2)

Or it can prevent a Client from logging in with the following script:

system.security.logout()

Custom Security

Watch the Video
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1.  

2.  

Project Security in Designer and Gateway
   

You can place security on Ignition itself. The security placed on Ignition Gateway Configure page, affects 
how people can login to the Configure page, Designer, Home page, and Status page.

Controlling who Logs into a Project

You can control who gets to login to a project by assigning roles and giving permissions to those roles in 
the   property which you set up in the Designer.Required Designer Roles
 

 

To access the Required Designer Roles property

In the Designer, choose .Project > Properties
The  window is displayed.Project Properties
 
Go to  page.Project / Permissions
In the text boxes on this page, enter a comma-separated list of role names that are required to 
access the project. If a user doesn't have the required role for any actions such as View, Save, 
or Delete, they cannot perform those actions in the project.

Ignition and Security

Ignition uses what's known as role-based security. Logging in to the Gateway, logging in to a project, 
access to windows in a project, any type of security configuration relies on users and their 
associated roles. Users and all their associated roles are stored in user sources that you configure in the 
Ignition Gateway. See the section for a quick explanation of how security in Ignition Security in Ignition 
works.

After finishing the initial installation of Ignition a default user source is set up automatically for you to use. 
It is an internal profile that cannot be deleted but can be modified to include more users and roles.

The default user source

You can manage the default user source by navigating to the Configure > Security > Users, Roles 
section of the Gateway. The manage users link will allow you to add new users, modify roles and 
passwords for existing users, remove users, and add/remove roles from the user
source. Choosing to edit a user will bring you to the following page allowing you to make any necessary 
changes to that user.

 



Types of user sources

Internal user source - This is a simple to setup, internally managed user source. All information in this 
type of profile is stored in the internal database used by Ignition. These types of profiles can only be 
managed from the Ignition Gateway, so they are not ideal for situations where you wish to create an user 
source that is modifiable at project runtime.

Database user source - All roles, users, and passwords are stored in a database that you 
specify. Managing users is done via direct interaction with the database so this kind of profile is best 
suited for managing users and roles during your project at runtime.

Active Directory user source - Roles and users are managed by Active Directory.

AD/Internal user source - Users managed by Active Directory and roles stored internally.

AD/Database user source - Users managed by Active Directory and roles stored in an external

   

In this section ...  

   

   



1.  

2.  

3.  

Project Permissions
 

Permissions are set on a per-project basis. This pertains to not only if a user can open and log into a 
project, but also what a person can do to the project that exists in the Gateway.

To set the permissions and the Designer roles

In the Designer, select  to access the project's properties.Project > Properties
 
In the  window, go to the  section.Project Properties Project > Permissions
 
Enter the the different options of the  .Required Designer Roles
There are five options and each accepts a list of roles separated by a comma. 
The following table describes each of these five options:
 

Option Affect

Publish User must have at least one of these roles to publish the project.

View User must have at least one of these roles to view the project in the 
Designer.

Save User must have at least one of these roles to save the project.

Delete User must have at least one of these roles to delete the project.

Protect 
Resources

User must have at least one of these roles to access protected resources.

Project Permissions

Watch the Video
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Locking Project Resources
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Locking Project Resources
 

You can lock individual project-level resources in the Ignition Designer using  and Project > Properties
the   window and adding a role to the  project setting.Project Properties Protect Resources
 

Role-based access

Security is configured using roles. This simple concept just means that instead of granting or revoking 
privilege based on user, you do so based upon the more abstract concept of a role, and then you assign 
users to belong to one or more roles. 

The maintenance ramifications of this separation are fairly obvious - you define your security based upon 
the process, not the people. Ideally, the process remains constant even if the cast of characters changes. 
As people are hired, transferred, promoted, fired, etc, the security management simply becomes the re-
assigning of roles, not the re-designing of your project.

Project Required Roles

The coarsest level of security for a Vision project is the project's   property. This is a Required Roles
list of roles that the user must have all of in order to log into the Client.

See also: Project/General Properties, Security

Tag Security

Tag security is often the best way to configure security for data access. By defining security on a tag, you 
affect the tag across all windows in the project, as opposed to configuring component security on each 
component that displays or controls that tag.

If a user opens a window that has components that are bound to a tag that the user doesn't 
have clearance to read or write to, the component will get a forbidden overlay.

See also: , Quality Overlays Permission Properties

Component Security

Each window and component can define its own security settings. These settings determine who can see 
and/or use the component. To define security for a component, right click on it and choose Component 

. Here you can choose to implement a security policy different than that of your parent.Security

In the Client, if the user does not match the role filter that you define, the component will be disabled 
or hidden and disabled. If a user with higher privileges logs in, the component will be useable again. 

Locking Project 
Resources

Watch the Video
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Securing event handlers

Event handlers often execute logic that must be secured. The various script builders all have 
special security qualifiers that can be enabled. These qualifiers get translated into the generated script 
by accessing the user's current roles via scripting.

Example

if 'Administrator' in system.security.getRoles():
productCode = event.source.productCode
qty = event.source.parent.getComponent("QuantityBox").intValue
query = "UPDATE my_secure_table SET quantity=? WHERE product=?"
system.db.runPrepUpdate(query, [qty, productCode])
else:
system.gui.errorBox('Insufficient security privileges.')

See also: , Script Builders system.security.getRoles

 

Next...

Locking Global Resources

 

 

If you choose to disable a component, make sure that it is a component that actually 
does something different when it is disabled. For example, buttons and input boxes can't be 
used when they are disabled, but disabling a label has no effect.

https://legacy-docs.inductiveautomation.com/display/DOC/system.security.getRoles


Locking Global Resources
 

You can lock individual global resources in Ignition using the protection option.  Global Resources can be 
locked in 2 different locations: in the Designer and on the Gateway webpage using the Global Resource 
Protection setting. 

To lock Global Resources in the Designer, go to the Global section of your Project Browser.   

Right click on one of the objects under the Global section and select   This example uses the  Protect.
Basic Email Pipeline object, but any object can be protected.  To remove the protection, simply right click 
the object and select the   option again to unprotect it.  Once an object is protected, you will see Protect
that you can still modify it.  

To block certain users, a role requirement must be added on the Gateway Webpage under the Configure 
section.  On the left side under Configuration, click Gateway Settings and locate the Global Resource 
Protection option.  

Locking Global 
Resources

Watch the Video
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You can add or modify the roles you want in the Global Resource Protection field to protect the global 
resources.  In this example, you can enter multiple role names separating them with commas.  Once you 
enter the required roles, anyone without one of these roles will not be able to modify protected objects.

Before assigning a role, typically an Administrator or the person adding Global Resource Protection 
needs to identify what role is required and who has that role so the proper protection is placed on global 
resource objects.  

 

Next...

Tag Provider Security
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Tag Provider Security
 

Sometimes only certain users with certain roles can alter tags in the Designer. Tag provider security 
allows you to reserve the right to alter tags in the Designer to only a selected number of roles.

To configure tag provider security

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Tags > Realtime
The  page is displayed.Realtime Tag Providers
 
Click  to modify the real time Tag Provider that you want to apply the roles to.edit
 
In , enter the roles that you want to limit the ability to edit the tags while the Tag Editor Roles
user is in the Designer. 
 
Click on .Save Changes

Tag Provider 
Security

Watch the Video
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Project Creation and Publishing
 

Publish Selected Resources

It's possible to publish individual resources on a project as they are finished instead of publishing the 
entire project.  This is helpful if you want to get resource updates to users or into production quicker 
rather than waiting for the entire project to be published. 

It’s important to note that the Publish Selected option is only available in the Publish Mode when 
set to Manual.  If it is set to Auto, you will not be able to publish your project resources 
individually.  To check, go to Project > Properties.  Under Project > General, set the Publish 
Mode to Manual, and press OK.

 

Go to your  and open a window. To publish selected resources, go to Designer File > 
Published Selected.  Here you can specify which Global and Project resources you would like 
to publish. Select the resources to publish, and press Publish.  

In this example, you will notice that the Historical Group was created as a new resource in the 
project, but is grayed out.  This is because the project was not saved.  You can only publish 
items that were saved in your project.  So keep in mind, when you see that an item is grayed 
out, go back and save your project.  Then you can select your item and publish it.  

 
 

Project Creation 
and Publishing

Watch the Video
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1.  

As you can see, using the Publish Selected option gives you another way of publishing your project 
resource updates, and can even get them to your users more rapidly.

Restrict Project Creation

There is a   setting that allows users with the specified role to create new projects Create Project Role(s)
on the Gateway.  This is ideal for production systems where you don’t want other users creating new 
projects. 

Go to  , and scroll down to  .   Enter the Configure > Gateway Settings Create Project Role(s)
role which permits users to create new projects in Designer.  This example uses an Admin 
role.  Click  . Save Changes

   

   

Next...
 

 



Using Audit Profiles
 

Auditing allows you to store any audit event to a database automatically. You can see who logs in to a client, unites, and tags, who writes to the 
database, and more.
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1.  

Project Auditing

Ignition supports audit logs for your project. An audit log will record to a database the interactions that 
your users have with tags and databases. An Ignition Gateway can have more than one audit log but a 
project can only have one of these audit logs. Multiple projects can feed into a single audit log. When an 
audit log is active on a project data is written into a database. Ignition configures the database table for 
you. The following table describes the audit table as it exist in the database:

Column 
Name

Description

AUDIT_EVE
NTS_ID

The id of the row.

ACTION Brief description of the action.

ACTION_TA
RGET

The target of the action.

ACTION_VA
LUE

The value acted upon the action target.

ACTOR The logged in user when the action occurred or a description of the system that 
generated the action.

ACTOR_HO
ST

The host computer where the action occurred.

EVENT_TIM
ESTAMP

The time when the action occurred.

ORIGINATI
NG_CONTE
XT

A numerical description of the origin of the originating system. 

Scope Value

Gateway 1

Designer 2

Client 4

ORIGINATI
NG_SYSTEM

The name of the project or system where this action occurred.

STATUS_C
ODE

A 32 bit integer that represents a bitmask of severity (good, bad, uncertain). The 
bitmask represents the status of the action recorded. For example, a tag write failing 
would result in a "bad" with an appropriate sub code.  

To create an audit log

Go to the Configure section of the Gateway.
 
Choose   from the menu on the left.Security > Auditing
The   page is displayed. Audit Profiles
 
Click the   link.Create a new Audit Profile
 
Select   and click  .Database Next
 
Enter the  of the audit log and the   time. Name Retention
 
Under the  , select the  where the table will be stored, select the Database Settings Database Au

 check box, and enter the desired  .to Create Table Name
 
Click .Create New Audit Profile

To use an audit log

Go to the Designer, open the project that you want to enable auditing on, and go to Project > 
.Properties

 

Project Auditing

Watch the Video

https://inductiveuniversity.com/video/project-auditing/7.8


2.  

3.  
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Go to the  section, select the  check box, and select the  General Enable Auditing Audit Profile
from the drop-down menu. If the new audit profile does not show up, click Refresh. 
 
Click .OK

 your Project. Save

Next...

Alarm Notification Auditing
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Alarm Notification Auditing
 

Alarm Notification profiles can be set to store information in an Audit Profile.

To store alarm notifications in an audit profile

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Alarming > Notification
The Alarm Notification Profiles page is displayed.
 
Edit the appropriate notification profile by clicking the  link.edit
The Edit Alarm Notification Profile page is displayed. 
 
Scroll down to the  section, and select the  from the drop-down menu.Auditing Audit Profile
 
Click .Save Changes

Alarm Notification 
Auditing

Watch the Video
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View Audit Information
 

Audit profiles store information into a database, you can then display that information and see what 
information is stored. Since Ignition makes accessing data from databases seamless it is possible to bind 
a data property of a table directly to database table. Alternatively, it is possible to access the contents of 
the audit log with a table functions.

To access the audit log with table functions

Drag a  component on a window.Table
 
In the , click on the binding icon from the tables  property.Property Editor Data
The Property Binding window is displayed. 
 
Select  from the various binding options.Functions
 
For , select the Audit Log from the drop-down menu.Binding Function
 
Select the appropriate options from the resulting menu as well as the .Polling Mode
 
Click .OK

View Audit 
Information

Watch the Video
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Localization
 

Localization allows you to translate text to multiple languages. The user can choose which language their Client displays. Text contained in 
components, that have their properties correctly mapped with localization, will change to reflect the language the user has selected. The Language 

 component is a dropdown list that displays the language options for these translations.Selector

A central term database and support is built into all component text properties, as well as other text-based properties, such as alarm messages. Aside 
from defining translations for terms, there is usually no other work needed to take advantage of the translation system.

Translation Database and Term Lookup

All translations are stored centrally in the Gateway and are distributed to each Client and Designer. All projects share the same translations, and those 
translations can be used in other locations, such as Gateway scripts, and alarm messages. Terms are referenced in the translation database using 
direct string comparison. The term  belong to the "base language", which by default is English. The English key will return if no match is found for Keys
the requested language. It is possible to define an alternate "translation" for the base language. The base term may be a user-readable string, such as 
"Start", or a special code, such as "START_COMMAND", which would have an "alternate translation" defined for "Start." 

The full translation database can be viewed and edited in the   panel located in the Designer. The translation manager allows Translation Manager
you to import and export a translation database. It also has the ability to define new languages. 

Global and Component Scopes

The translation database and term lookup rely on two different scopes for term lookup: global scope and component scope.

Global Scope

A single language selector on a window has the potential to trigger translations on all windows. This way a single language selector component can 
exist on a navigation window and provide language translations for all components on all windows.

Component Scope

The component scoped translation terms can display special translations that may be more relevant to the given context of the translation. For 
example, if the English language has one word that shares meaning between context while the alternate language has two words that differentiate 
between the two context then the component level translation may be appropriate. If the component level translation is not configured on the 
component then the translation term is automatically taken from the global scope. Component level translation will reflect on all components that occur 
on a single window. Component level translations does not encompass terms beyond the window on which they are configured.

Expression and Scripting Functions

You can look up translations using the following functions:

Expression Function
translate()

Scripting Functions
system.util.translate()

system.util.modifyTranslation() scripting functions. 

Translations are matched by looking for the base language value in the translation database.

System Considerations During Translation

perating system and Java configurations may affect Ignition's ability to provide a complete translation in certain circumstances.Inherent o

For example, suppose a user has selected the Spanish option from their Language Selector component. An English to Spanish translation term exist 
for the word "Information" as well as "Start." The message box script takes two parameters: one for the content while the other parameter is optional. If 
the second parameter is not included in the function then the resulting title of the message box will include the English word "Information." The 
following code is executed on a button clicked event handler. 

message = system.util.translate("Start")
system.gui.messageBox(message)

What results is a message box with a translated content while the title remains in English. In addition, the accept button is translated as well even 
though the English word for "OK" does not exist in the Translation manager. This is due to the system level translations that exist 
for inherent language support.

A similar occurrence exist with the file open dialog window. The following code is executed on a button clicked event handler.



system.file.openFile()

The result is a translation for the title as well as the open and cancel buttons while the references to the "File Name" and the "Files of Type" remain in 
the operating system's language and thus are beyond the scope of Ignition's ability to translate.

Similar occurrences will appear in print and dialog boxes.error 

Previewing Translations

You can preview the translations in the Designer with the preview mode in several ways. Using the Language Selector Component or scripting will 
temporarily change the current language, but the language will revert back to the base language (which is normally English) when preview mode is 
disabled. To change the preferred language for preview mode, use the Preview Language menu item under the Project menu in the Designer. This 
selection will persist even after preview mode is disabled and will persist when the Designer is restarted. Currently, you can not define translations 
while displaying in a different language.

 

 

In this section ...
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Introduction to Project Translation
 

Project translation is also known as Client localization. This is how the user can choose their language-of-
choice for the project they are working with. When the user selects a language, the Client will change its 
text in accordance with the project's translation settings.

To choose the language for your project - Global Translation

Go to .Tools > Translation Manager
 
Add a language, for example . Spanish
 
Add terms and phrases to be translated.
The translation database shares terms across all projects.
You can use codes for the Key field of your Terms like '#stop' or '#welcome_screen_info' (the # 
is just for convention, it is not a special character), to help manage longer instruction sets.
 
Add a Language Selector Component to your client.
Now your users can move easily between languages.
There is no binding involved because the languages are compared directly against the 
Translation Manager database. 

Component Translation

Alternatively, you can right-click on the Root Container of a window and select  . The Translations Transla
 panel will provide all the terms on the window. This can provide a central place to manage table Terms

all the translations associated with the window. The difference between the Global and the Component 
translations is that the Component translations are stored on the component instead of in the translation 
manager's database.

Introduction to 
Project Translation
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Import and Export translations
 

Often projects are build with a single language in mind. However Ignition's Language Selector 
components will allow the user to translate the text of a window or a project to the language of their 
choice. To ensure all the terms are correctly translated in anticipation of a user using the Language 
Selector, it is important to leverage the import and export translation features associated with Ignition's 
Translation Manager.

To export all the terms from a window

Right-click on an existing window's  and select .Root Container Translations
The  panel is displayed on top of the Property Editor.Translatable Terms
 
Select all the available Component Terms and mark the terms for translation by clicking the 
Earth icon with the green plus sign.  the list of available terms are based on the Note:
components in the Root Container. If you have no available terms, try adding a label or button to 
the window.
 
Select .Tools > Translation Manager
 
Export the terms by selecting the  icon on the right of the .Export Terms Translation Manager

 

Select the  location, , and the appropriate .Folder Base file name Languages
 
In the  drop-down select either  or , they both behave the same. The Format PROPERTIES XML
only difference is that the XML format supports UTF-8 encoding directly.
A person can now translate the XML file directly and the XML file can be imported back into 
Ignition's Translation Manager.

To import terms into Ignition's Translation Manager

Go to , and select the  icon from the right of the Tools > Translation Manager Import Terms
Translation Manager.
 
Choose the file from the  window, and Click .Open Open
 
In the , choose the correct Language and choose to import all or the Translation Manager
selected terms.
The terms are imported into the Translation Manager.

Import and Export 
Translations
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Switching the Current Language
   

The currently displayed language can be changed in a number of ways:

On the  page.project Login
The user can select their desired language when they login to the project. 

Using a  component in the project. Language Selector
This component displays the languages that have translations available, and changes the 
current language based on selection.
 
With the  function. system.util.setLocale()
This function takes an ISO 639-1 two-letter code for the language to use (for example, "en", "fr", 
"de", "es", and so on).

Switching the 
Current Language
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Tags
 

Tags provide a consistent data model throughout Ignition, and offer the easiest way to get up and running creating realtime status and control 
systems. The phrase "realtime status and control system" is sort of an industry buzz word.

Despite their low initial learning curve, however, Tags offer a great amount of power in system design and configuration. The ability to aggregate 
tags from a variety of installations in a central SQL database means that you can build widely distributed SCADA systems more easily than ever 
before with a high level of performance and relatively easy configuration.

Tag Configuration in the Gateway

While the goal of Tags is to create an easy yet powerful tag model, the variety of options and terminology can sometimes make configuration 
confusing. The goal of this section is to provide a clear overview of the Tag landscape, and provide a clear guide to the configuration of 
various architectures.

Note that you will use both the Gateway and the Designer for tag configuration.

In the  , as described in this section, you perform the tag configuration by specifying such things as the realtime/historian providers Gateway
and internal/external databases. The tag configurations in the Gateway apply globally to all your projects.

In the  , when working on your project design, you will create the different types of tags such as an OPC tags, memory tags, and Designer
expression tags. You will then set the tag properties and other functionalities such as alarming. You will also gain a working knowledge of 
what tags are and how they are executed.
 

Tag Providers and Drivers

At the highest level of configuration is the Tag Provider. A provider is a tag database (a collection of tags) and a name. An Ignition Gateway can have 
any number of tag providers, and therefore the name is used to distinguish which provider a tag comes from. Tag Providers can be set up with 
security or even disabled independent of each other.

Every provider holds tags, but not every provider is a Tag driver, or a tag executor. Some tag providers simply make tags available to use, and the tag 
execution is performed by a different driving provider elsewhere. For example, the Database Provider is a Tag provider that simply watches a tag 
database stored in an external database. It does not execute tags, it only monitors the values of the tags present. Somewhere else there is a tag 
driver such as a Driving Datasource Provider or a legacy FactorySQL that is executing the tags and storing the values to the database.

Realtime vs. Historian Providers

As discussed above, all Tags reside in a tag provider and provide realtime values. Additionally, there is the concept of tag historian providers, which 
can store and query historical data for tags. Each tag can optionally have a historian provider assigned to it to whom it will report value changes 
for historical storage.

Realtime Providers - Internal vs. External

The Tags "tag database", or how Tags tag configuration is stored, can take two forms. For internal tags, the configuration is stored in the Ignition 
Gateway. In the external form, tags are stored in a SQL database, outside of the Ignition Gateway.  The two different storage mechanisms have 
different pro and cons, and so it is a good idea to acquaint yourself with each of them.

Internal Tags Provider

The internal Tags provider manages the tags inside the Ignition Gateway. This is the most common method and is optimized for the best scaling and 
performance.

It is possible to create multiple internal providers per Gateway. The tags can be exposed to other Gateways on the network through the Gateway's 
OPC-UA settings.

External Tags Providers

There are two types of external Tags providers in Ignition:

Database Provider
Database Driving Provider (provided by the SQL Bridge module)

The driving provider, as mentioned above, will execute tags as well as make available tags driven by other external drivers looking at the same 
database, such as other Ignition Gateways using the driving provider, or legacy FactorySQL installations.

The primary benefit of external providers is that the data is stored in a central database, and is therefore accessible to other data consuming systems 
that do not have the capabilities to connect to Ignition's OPC-UA server as an OPC-UA client yet still require the need to consume realtime tag 
information.



The negative side to external providers is that all tag values must be written to the database and then polled for change, which is a less efficient 
method than internal provider's method. In other words the inherent architecture of the external model does not scale as well as the internal provider 
model.

Configuring Realtime Tags

Realtime Tags providers are configured in the Gateway's . After installation, the Ignition Gateway will start    section under Configure Tags > Realtime
with an internal provider defined. You can edit its name and settings by selecting  to the right of its entry in the table, or create new providers by edit
selecting   below the table.Create new Realtime Tag Provider

There are three types of  that you can choose from:Realtime Tag Provider

Standard Tag Provider
Tag Consuming Provider
Tag Driving Provider 

The settings for each of these tag providers are shown next.

Standard Tag Provider

Tags are stored inside of Ignition and executed by the system.

Name The name of the provider.

Description The description of the provider.

Tag 
Editing 
Role (s)

Users must belong to one of these roles in order to edit this provider's tags in the Designer. Multiple roles can be specified by 
separating them with commas. If blank, tag editing for this provider will not be restricted in the Designer.

Default 
Database

The default database connection to use for expression tags that run SQL queries. All query tags with default database providers 
selected with run their queries against this database source.

Tag Consuming Provider

Reads tags stored in an external database and driven by a different instance. Only consumes tags provided by 
other systems, does not write tag values back to the database.

Name The name of the provider.

Description The description of the provider.

Tag 
Editing 
Role (s)

Users must belong to one of these roles in order to edit this provider's tags in the Designer. Multiple roles can be specified by 
separating them with commas. If blank, tag editing for this provider will not be restricted in the Designer.

Database The database connection where the tag database resides.

Poll rate The rate in milliseconds at which value and configuration changes will be polled.

Poll 
overlap

The amount of time, in milliseconds, to overlap the polling time span.

Tag Driving Provider

Stores and executes tags in an external database.

Name The name of the provider.

Descri
ption

The description of the provider.

Tag 
Editin
g 
Role 
(s)

Users must belong to one of these roles in order to edit this provider's tags in the Designer. Multiple roles can be specified by separating 
them with commas. If blank, tag editing for this provider will not be restricted in the Designer.

Datab
ase

The default database connection where the tag database resides.



Driver
name

The unique name of this driver. Since the tags are stored in a central database, there may be multiple providers and drivers operating on 
them. This name will be used to identify this driver instance, and the tags that it executes. While the driving provider will read all of the tags 
stored in the database, it will only execute those tags that are assigned to it. 

Poll 
rate

The rate in milliseconds at which value and configuration changes will be polled.

Poll 
overlap

The amount of time to overlap polls by. If set to 0, the config scan will look for changes only since the last execution. However, on 
databases that do not support millisecond resolution or are performing less-than-optimally, this could result in missed changes. This setting 
will expand the window in order to avoid missing these changes.

Enabl
e 
brows
ing

Allows remote browsing of the OPC servers available to this driver over TCP/IP. This allows other Gateways to remotely browse and add 
tags assigned to this driver into the central database.

Brows
e port

The port to listen on for remote connections. This port must not be in use by any other entity on the machine. Also, each driving provider 
that wishes to support browsing must have its own port.

Brows
e 
addre
ss

The IP address/network name that remote Gateways will use when browsing. Therefore, care must be taken that the address is available 
from the Gateways that will try to connect. Also, since it is used for access by remote systems, it should not be the loopback address 
(localhost or 127.0.0.1).
The browse address and port will be stored in the Tags database so that other Gateways can easily look them up. After the settings are 
configured, you should immediately see the driver name in the OPC browse list for the external provider on other systems looking at the 
same database.

 When using remote browsing, make sure that the local firewall has an exception for the port that is used to listen. Otherwise, remote Note:
machines will not be allowed to connect.

External Provider Reference

Important

The information provided here requires an understanding of Tags and how they work. It is an advanced reference to how the tables of external Tags 
providers are structured and an overview of the concepts of tag execution. If you are a new user, it is suggested that you read the  Understanding Tags
section first.

Basic Concepts and Data Flow

Tags operate through tables created in the database.

Tag Configuration Table Names and Descriptions

sqlt_c
ore

The core tag information table, has one entry per tag. Defines fundamental properties like data type, as well as the current value of the tag. 
Is monitored by the provider to determine value and configuration changes.

sqlt_
meta 

Provides additional properties for tags. Only consulted when tag configuration has changed.

sqlt_as Provides alert state configuration for tags which utilize alerting.

sqlt_p
erm 

Provides custom permission settings for tags set to use them.

Operations Table Names and Descriptions

 sqlt_
sc

Contains the definitions of scan classes, which dictate how tags are executed. 

 sqlt_
sci

Contains an entry for each scan class from sqlt_sc, for each driver currently driving tags. Used to verify that drivers are properly executing.

 sqlt_
drv

Contains an entry for each Tags driver. Only really used for browsing tags.

 sqlt_
err

Contains errors that have occurred executing tags.

sqlt_
wq  

The "write queue". All write requests are entered into this table, where the driver will detect and execute them. The result will be written 
back by the driver, and will be noticed by the provider.

Tag Execution Concepts



Polling – Many operations require polling of the database by either the driver or the provider. To ensure efficiency, all polling operations utilize 
indexed timestamp fields. This allows the database to do very little work when nothing has changed.

Tag Configuration – Tags are configured by inserting or modifying the appropriate entries in the configuration tables above. Configuration change is 
signaled to the provider by updating the   of  to be the current time. Deleting a tag works by setting its  column and configchange sqlt_core deleted
then  config change. This will inform all drivers and providers to remove the tag from memory. At some point later, a daemon will delete the touching
tag information from the database.

Tag Execution, drivers – Each tag has a  property that indicates which driver is responsible for executing it. Other drivers and providers drivername
with different names will treat the tag as an  tag – a tag driven by a different entity – and will only monitor its value.external

Tag Execution, scan classes – Each tag is assigned to a scan class. The idea is that scan classes will define how often the tag should execute, as 
well as provide more advanced options like leased and driven execution. In reality, the tag driver is free to execute tags as it desires, but it is important 
to understand how the scan classes and the  table are expected to work, as that is how the provider will verify that the tags are being sqlt_sci
executed.

Tag Monitoring – Both providers and drivers generally monitor tag value and configuration changes. In general, the entities will monitor tags whose dr
 isn’t equal to their own, which for providers means all tags, since providers don’t have a driver name. Monitoring occurs by selecting the tag ivername

values (or any information desired) from the appropriate table where one of the indexed timestamp columns is greater than the last checked time. The 
provider/driver will then store that time in memory as the last check, and will use it in the next poll.

 

Table Reference

The following is a reference list for the table structures of all the tables listed above. In general, all integer time values are in milliseconds.

sqlt_core

Column Data Type Notes

id integer Auto-incrementing, unique id for 
the tag

name string Name of tag

path string Folder path, in form of path
/to/

drivername string Name of driver responsible for 
executing tags

tagtype integer / TagType 
enum

The type of tag - that is, OPC, 
DB, and so on

datatype integer / DataType 
enum

The type of data provided by the 
tag

enabled integer (0 or 1) Whether the tag is enabled for 
execution

accessrights integer / 
AccessRightsenum

Access permissions for the tag

scanclass integer ID of the scan class for the tag

intvalue integer Value column used if tag has 
integer data

floatvalue double Value column for float/real data

stringvalue string Value column for string data

datevalue datetime Value column for date data

dataintegrity integer / 
DataQualityenum

Current quality of the value

deleted integer (0 or 1) Whether the tag is deleted or not

valuechange datetime The last time that the value 
changed

configchange datetime The last time that the tag's 
config changed

sqlt_sc

Column Data Type Notes

id integer Auto-incrementing unique id

name string Name of the scan class

lorate integer The slower rate to run at, in 
milliseconds. Only rate
used if scan class mode is direct

hirate integer Higher rate, in ms. Only used if 
scan class is driver
or leased

drivingtagp
ath

string Path to tag to watch if mode is 
driven

comparison integer / 
Comparison 
enum

Operation to apply to driving tag in 
driven mode

compareval
ue

double Value to compare driving tag to 
for driven mode

mode integer / Scan 
class mode
enum

The mode of the scan class

staletimeout integer Time, in milliseconds, before scan 
class is
determined to not be running

leaseexpire datetime The time that the lease should 
expire, if using
leased mode

configchange datetime The last time that the scan class 
has been modified

deleted integer (0 or 1) Whether the scan class has been 
deleted

sqlt_sci

Column Data 
Type

Notes



sqlt_meta

Column Data Type Notes

tagid Integer ID of tag that the property belongs to

name string The well-known property name

intval integer Value, if property has integer type

floatval double Value if property has float type

stringval string Value, if property has string type

sqlt_as

Column Data Type Notes

id integer Unique id of alert state

statename string Name of alert state

severity integer /Severity 
enum

 

low double Low setpoint

high double High setpoint

flags integer / Alert 
Flags

Flags that dictate how the state acts

lotagpath string Path to tag that provides low 
setpoint, if low driven
flag is set

hitagpath string Path to tag that Provides high 
setpoint, if high driven
flag is set

timedeadba
nd

double Time deadband value

timedbunits integer / 
TimeUnits enum

Time deadband units

sqlt_perm

Column Data Type Notes

tagid integer ID of tag that the permission 
belongs to

rolename string Name of the role that this 
permission is applied to

accessrights integer / 
AccessRights 
enum

Access rights for the given role 
on the given tag

sqlt_drv

Column Data 
Type

Notes

name string Name of the tag drive

ipaddr string Address of browser server, blank or null if 
browsing isn't available

port integer Port of browse server

sc_id integer The id of the scan class represented

drivername string The driver executing this instance

lastexec datetime Last time that the scan class executed

lastexecrate integer The rate of the scan class at last execution

lastecexdur
ation

integer Time, in ms, that the scan class took to 
execute

lastexecopc
write

integer Writes to OPC performed during last 
execution

lastexecopc
reads

integer Value updates from OPC processed in last 
execution

lastexecdb
writes

integer Writes to DB performed during last 
execution

lastexecdbr
eads

integer Value updates from the database 
processed during the last execution

lastecexdel
ay

integer The delay between when the scan class 
should have ran and when it actually ran for 
the last execution

avgexecdur
ation

integer The average duration time of the scan 
class, in ms

execcount integer The number of times the scan class has 
executed

nextexec datetime The next time that the scan class should 
execute

sqlt_wq

Column Data Type Notes

 id  integer  Auto-incrementing unique id for 
the write operation

tagid   integer  ID of the tag to write to

intvalue   integer  Value, if tag has integer data 
type

floatvalue double Value, if tag has float or real 
data type

stringvalue string Value, if tag has string data type

datevalue datetime Value, if tag has date data type

responseco
de

integer / Write 
Responseenum

The state of the write request. 
When created, the
response code should be set to 
2 - Pending

responsemsg string Write error if operation failed

t_stamp datetime The time that the write request 
was created

objectid integer ID of the object with the error

objectype integer / Object 
Type enum

The type of object. Used with 
objectid to identify the
item that caused the message

lifecycleid integer/ Lifecycle 
enum

When the message was 
generated

msgtype integer / Message 
Type enum

 

errormsg string The primary message



stack string Additional error information

t_stamp datetime When the message was 
generated

 

Enum Reference

There are known values for many of the objects in the Ignition Tags. Almost every list in Ignition has an enumeration that starts at 0 and counts down 
the list. Below are a few:

Basic Tag fields

Tag Type

0 OPC Tag

1 DB Tag

2 Client Tag

6 Folder Tag

Data Types

0 Byte

1 Short

2 Integer

3 Long

4 Float

5 Double

6 Boolean

7 String

8 Date

9 Integer Array

10 Long Array

11 Double Array

12 Boolean Array

13 String Array

14 DataSet

Access Rights

0 Read Only

1 Read/Write

2 Custom

Scan Class Modes

0 Direct

1 Driven

2 Leased

Write Response

Quality

Data Quality

0 Bad Data from OPC

4 CONFIG_ERROR

8 NOT_CONNECTED

12 DEVICE_FAILURE

16 SENSOR_FAILURE

20 Bad, showing last value

24 COMM_FAIL

28 OUT_OF_SERVICE

32 WAITING

64 UNCERTAIN

68 UNCERTAIN showing last value

80 SENSOR_BAD

84 LIMIT_EXCEEDED

88 SUB_NORMAL

28 SERVER_DOWN

192 Good Data

216 Good, with local override

256 OPC_UNKNOWN

300 Config Error

301 Comm Error

310 Expr Eval Error

330 Tag exec error (fsql)

340 Type conversion error

403 Access Denied

404 Not Found

410 Disabled

500 Stale

600 Unknown (loading)

700 Write Pending

Alarms

Comparison Mode

0 Equal

1 Not Equal

2 Less Than

3 Less Than Equal

4 Greater Than

5 Greater Than Equal

Alert Flags

0x01 Low Exclusive

0x02 Low Infinite

0x04 High Exclusive

0x08 High Infinite

0x10 Any Change

0x20 Low Driven

0x40 High Driven



0 Failure

1 Success

2 Pending

     

In this section ...



Understanding Tags
 

What is a Tag?
Tags are points of data and may have static values or dynamic values that come from an OPC address, an expression, or a SQL query. The values 
can be used on screens, in transaction groups, and more.

Tags are stored in tag providers. By default, a fresh Ignition installation will have an internal tag provider - this can be thought of as a standard 
internal tag database. Additionally, it is possible to create external Database-based tag providers, thus turning your SQL database into the tag 
database. This ability opens up some very flexible architectures.

Despite their low initial learning curve, however, Tags offer a great amount of power in system design and configuration. The ability to aggregate tags 
from a variety of installations in a central SQL database means that you can build widely distributed SCADA systems more easily than ever before, 
with a high level of performance and relatively easy configuration. Tag User Defined Types (UDTs) provide an object-oriented approach to tag 
building, allowing you to define parameterized data types, extend and override types, and then rapidly generate instances. A change to the type 
definition is then inherited by all instances, drastically saving time when making routine changes. The UDT data types are fully supported by Vision 
templates, which means you can configure templates for your custom data types and take advantage of drag-and-drop binding to rapidly build 
complex screens.

 

Main Benefits of Tags
Tags work naturally and easily with Ignition to offer the following features:

Drag and Drop Screen Design
Using the Vision module, you can drag and drop tags to a window to automatically create new bound components. Drag tags to 
existing components or properties to quickly bind them to the data. Creating powerful status and control screens is literally just clicks away! 

Object-oriented Design 
Use Tag UDTs (User Defined Types) to design re-usable, parameterized, and extendable data types. You can create and configure new 
instance tags in seconds, saving a great amount of time over traditional tag systems.

Performance and Scalability
Tags offer a great performance on both the Gateway and Client. On the Gateway, the system can support thousands of value changes per 
second and hundreds of thousands of tags. On Client, Tags improve efficiency with their lightweight subscription architecture. Adding 
additional Clients creates a nearly negligible effect on the database and the Gateway performance.

Integrated Component Feedback
Tags offer a quality and overlay system for Vision module components. If a tag's data quality is anything but good, a component that depends 
on it gets a visual overlay. Input components display an animated overlay while write pending requests are being written. These features 
effectively communicate the status of the system at a glance.

Historical Logging
Tags Historian™ makes it easier that ever to store and use historical data. When you simply select a check box on a tag, historical data is 
stored in an efficient format in your SQL database. This data is then available for querying through scripting, historical bindings, and 
reporting. Also, you can drag-and-drop tags directly onto an Easy Chart to create trends or onto a table to display historical values. Tags 
Historian's robust querying provides you great flexibility in how you retrieve the data.
 
Powerful Alarming Model
Each tag can have any number of alarms configured on it. There are many different alarm modes accommodating simple digital alarms, 
analog high/low value alarms, as well as more specialty alarms like bad data quality and bit-packed alarms. The settings for alarms can 
bound to other tags, making the alarm configuration dynamic. You can attach associated data to alarms to turn the alarm journal into a 
forensic tool to help determine the state of your process when issues occurred.

 

Creating Tags

The easiest way to create a tag is from the OPC Browser. But you can also create tags manually using the menu items, or by converting a tag type to 
a new type. 

Creating From OPC Tags
The easiest and most common way to create Tags is to drag tags into the Tag Browser from the OPC Browser. After browsing OPC and 
finding the tags that you want, simply drag and drop them onto the correct tag provider, and the system will create OPC Tag for each.
 

Creating Tags Manually
The above method only works for OPC tags, and then only for browsable tags. For other types of tags, as well as OPC tags that cannot be 

obtained through browsing, you can, in the Tag Browser, click on the New Tag icon or right-click on the provider node and select New Tag.
 



Converting Tag Types
Once created, it is possible to convert a tag to a different type – such as from OPC to Expression. To do this, right-click on the tag, and select 

Convert Tag Type.

Re-naming Tags

Tags can be named anything (inside the rules of allowed characters). In other words, it is not necessary that tag's name be related at all to its 
underlying data source (opc path, for instance). This provides a level of indirection that is convenient for systems whose underlying data storage 
changes, or for system with many repeat tag structures. By providing tags with meaningful names and arranging them in hierarchical folders, indirect 
binding can be used to create robust screens that can be used for multiple systems.

 

 

In this section ...



Tags Intro
 

Tags are points of data and may have static values or dynamic values that come from an OPC address, 
an expression, or a SQL query. The values can be used on screens, in transaction groups, and more. 
Additionally, tags offer a core set of features above and beyond simple values, such as the scaling, 
alarming, meta information, and history facilities.

Depending on the specific type of tag, even more options are available. In general, Tags provide a 
common interface for tying together many types of data in Ignition.

Historical Tag data is stored in the database connection associated with the selected history tag provider. 
Ignition creates and manages several tables within the Tag database that the historian uses to not only 
store your data but also make it easily available within your Ignition projects.

There are several types of Tags that are similar in their configurations, but differ in how the value is 
generated. The different types of Tags are: OPC Tags, Memory Tags, Query Tags, Complex Tags, 
System Tags, and Client Tags.

Tag Configuration in the Designer

To configure a tag, right-click the tag, then from the popup menu go to   and select the type of New Tag
tag you want to configure. The   window is displayed and you can now set the properties for Tag Editor
that tag. The   window has the following sections: General, Numeric, Metadata, Permissions, Tag Editor
History, Alarming, SQL Query, Expression, and Tag Event. The description for the properties in each 
section is described next.

On this page ...

Tag Configuration in the Designer
General Properties
Numeric Properties
Metadata Properties
Permission Properties
History Properties
Alarming Properties
Expression/SQL Properties
Next ...

Tags in Ignition

Watch the Video

General Properties

Properties common to most tags are as follows:

Property  Binding  Name Description

Name  Name  How the tag will be presented and referenced in the system. The tag path will be the provider, the folder structure, 
and this name.

Value  Value  The value of the tag. Can only be modified if the tag allows value writing and the user has sufficient privileges.

Data Type Datatype The type of the value. It is important that this be set as correctly as possible with regards to the tag's underlying 
data source. The Tags system will attempt to coerce any raw incoming value (for example, from OPC or a SQL 
query) into the desired type.

Enabled Enabled Whether the tag will be evaluated by the scan class. If false, the tag will still be present, but will have a bad quality.

Access 
Rights

AccessRig
hts

Specifies the access level allowed to the tag: , , or . If Custom, the tag will use the Read/Write Read only Custom
permission settings.

Scan Class ScanClass The scan class that will execute the tag. The scan class dictates the rate and conditions on which the tag will be 
evaluated.

Additional Properties - OPC Tags

OPC Server OPCServer The server against which to subscribe the data point.

OPC Item 
Path

OPCItemPa
th

The path to subscribe to on the server. The point will be subscribed at the rate dictated by the scan class.

Additional Properties - Tag in External Providers

Driver DriverName The name of the Ignition Gateway that will be responsible for the execution of the tag. All other Gateways will 
monitor the value.

Numeric Properties

https://inductiveuniversity.com/video/tags-in-ignition/7.8


The numerical properties are available to OPC, DB, and Client tags whose data types are numeric.

Property  Binding  Name Description

Scale mode ScaleMode  If and how the tag value will be scaled between the source, and what is reported for the tag.

Raw Lo RawLow Start of the "raw" value range.

Raw Hi RawHigh End of the "raw" value range.

Scaled Lo ScaledLow Start of "scaled" value range. Raw low will map to Scaled low for the tag.

Scaled Hi ScaledHigh End of "scaled" value range. Raw high will map to Scaled high for the tag.

Clamp mode ClampMode How values that fall outside of the ranges will be treated. "Clamped" values will be adjusted to the low/high scaled 
value as appropriate.

Scale Factor ScaleFactor For single parameter modes (currently only Exponential Filter), the factor parameter for the equation.

Deadband  Deadband  A floating point value used to prevent unnecessary updates for tags whose values "float" by small amounts.

Deadband 
Mode

DeadbandMo
de

There are two modes to choose from: Absolute or Percentage.

Metadata Properties

The metadata properties provide informational properties for a tag. The values of these fields can be read and modified through scripting, or bound to 
properties such as range, tooltips, and so on.

Property  Binding  Name Description

Format String FormatStr
ing 

How the value should be formatted when converted to a string (only applies to numerical data types).

Eng Unit EngUnit  The engineering units of the value.

Engineering 
Limits Low

EngLow  The lowest expected value of the tag.

Engineering 
Limits High

EngHigh  The highest expected value of the tag.

Engineering Limit 
Enforcement

EngLimitM
ode 

Dictates how the engineering range should be enforced on the tag. If not "none", the tag will change to bad 
quality ("limit exceeded"), when the value exceeds the specified range.

Tooltip  Tooltip  The tooltip provides a hint to visual components as to what should be displayed when the user hovers their 
mouse cursor over the component that is being driven by the value of this tag.

Documentation  Documenta
tion 

A freeform text property for information about the tag.

Permission Properties

Note: Make sure your tag's  (in the General section of the Tag Editor window) is set to  for these permissions to have an Access Rights Custom
effect. Users must have at least one role in this list in order to have access to the tag. If a user has more than one of the roles in the list, the role with 
the highest privilege will apply.

By default, a tag's  property is set to , which means that any user can read the value of the tag and write to the tag. Access Rights Read/Write Read-
 mode makes the tag non-writeable for allonly

users.   mode allows the tag to assign read/write or read-only privileges to individual roles. Any roles not explicitly granted a right by using the Custom
custom permissions editor will not be able to read the tag's value or write to the tag.

History Properties

The properties on the  tab of the  window, specify if and how the tag's history will be stored in the Tags Historian system.History Tag Editor

Property  Binding Name Description

Store History HistoryEnabled Whether the tag will report its history to the Tags Historian system.

History Provider PrimaryHistoryProvider Which Tag Historian data store the tag will target. A particular tag can only target one history 
store.



Historical 
Scanclass

HistoricalScanclass The scan class to use to evaluate tag history. This allows the tag's history to be stored at a 
slower rate than the status is updated at.

Historical 
Deadband

HistoricalDeadband A deadband that applies only to historical evaluation.

Max time 
between records

HistoryMaxAgeMode / 
HistoryMaxAge

The maximum amount of time that can pass before a new record is logged for the tag. See Max 
 below.Time Between Records

Timestamp Source HistoryTimestampSource Which timestamp is used for the value of the tag. See  below.Timestamp Source

Value Mode InterpolationMode How interpolation will be handled for the tag in querying. See  below.Value Mode

Value Mode

The value mode,  or , dictates the type of value that the tag represents, and will affect how the deadband is applied to values, and how analog discrete
interpolation should be performed when querying. Interpolation is the method in which the Tag Historian query system generates values for a 
tag when the desired time does not fall directly on a sample timestamp. 

Discrete

 - The deadband will be applied directly to the value. That is, a new value (V ) will only be stored when: |V -V | >= Deadband.Storage 1 1 0
 - The value will not be interpolated. The value returned will be the previous known value, up until the point at which the next Interpolation

value was recorded.

Analog

 - The deadband is used to form a corridor along the trajectory of the value. A new value is only stored when it falls outside the Storage
previous corridor. When this occurs, the trajectory is recalculated, and a new corridor formed. See below for an example.

 - The value will be interpolated linearly between the last value and the next value. For example, if the value at Time  was 1, Interpolation 0
and the value at Time  is 3, selecting Time  will return 2.2 1

Max Time Between Records

Normally Tag Historian only stores records when values change. By default, an "unlimited" amount of time can pass between records – if the value 
doesn't change, a new row is never inserted in the database. By modifying this setting, it is possible to specify the maximum number of scan class 
execution cycles that can occur before a value is recorded. Setting the value to 1, for example, would cause the tag value to be inserted each 
execution, even if it has not changed. Given the amount of extra data in the database that this would lead to, it's important to only change this property 
when necessary.

Timestamp Source

When a Tag executes, there are two possible timestamps that can be observed: the time associated with the data, and the time that the tag was 
evaluated. The first case is generally only interesting when the value is provided by an OPC server. In most cases, the time provided by OPC, which in 
Ignition is referred to as the "Value" time, will be very close to the system time. Some servers, however, either due to their location or how they 
function (history playback, for example), will provide times that are very different than the current time.

It is generally desirable to store the System time, as it is the time that the value was actually observed by the system, and it creates a uniform 
timeframe for all realtime data. However, in the later case, it is necessary to store the time provided by the OPC server. Using the Value timestamp 
source has several consequences: the system is no longer able to validate the tag quality against the scan class' execution, and tag value 
interpolation will behave differently.

The validation of the scan class execution is generally not a concern when recording historical playback data. Interpolation only occurs when the value 
mode is Analog, and when there is not a value for every time window. Using System time, the value is only interpolated during the last "scan 
class execution window", that is, one scan class timeframe before the next value. Using Value time, however, the value is interpolated for the entire 
time between two data points.

The Deadband, and Analog Compression

As described above, the deadband value is used differently depending on whether the tag is configured as a Discrete tag, or an Analog tag. Its use 
with discrete values is straight forward, registered a change any time the value moves +/- the specified amount from the last stored value. With 
Analog tags, however, the deadband value is used more as a compression threshold, in an algorithm similar to that employed in other Historian 
packages. It is a modified version of the 'Sliding Window' algorithm. Its behavior may not be immediately clear, so the following images show the 
process in action, comparing a raw value trend to a "compressed" trend.



1.  
2.  

3.  

4.  
5.  

In this image, an analog value has been stored. The graph has been zoomed in to show detail; the value changes often and ranges over time +/- 10 
points from around 1490.0. The compressed value was stored using a deadband value of 1.0, which is only about .06% of the raw value, or about 5% 
of the effective range. The raw value was stored using the Analog tag mode, but with a deadband of 0.0. While not exactly pertinent to the explanation 
of the algorithm, it is worth noting that the data size of the compressed value, in this instance, was 54% less than that of the raw value.

By looking at one specific sequence, we can see how the algorithm works:

The sequence starts with the second stored compressed value on the chart.

A value is stored. No further action is taken.
The next value arrives. A line is made through the value, with the size of the specified deadband value. A line is projected from the last stored 
value to the upper (line U1), and lower (line L1), bounds of this new value line. This establishes the initial corridor.
A new value arrives. The same procedure is taken, and new lines are created. However, only lines that are more restrictive than the previous 
are used. In this case, that means only line U2, the new upper line.
Another value arrives, causing a new lower line (L3) to be used.
Finally, a value arrives that falls outside of our corridor. The last received value (value 4) is stored, and a the process is started again from 
that point.

Alarming Properties

Tags have the ability to define any number of alarms. Each alarm is a condition that will be evaluated when the value of the tag changes. When the 
condition becomes true, the alarm is said to be active. When it becomes false, the alarm is said to be clear.

Binding

Many alarm properties are bindable, which means they can be bound to other tags in the system, or expressions. For example, you might bind the 
enabled property to another tag which represents whether or not your process is running, thereby disabling the alarm when production is stopped. 
Or, you might bind the setpoint of an alarm to a tag that operators can manipulate, thereby letting the setpoint be changed at runtime.

To bind a tag, simply click on the binding icon ( ), and the binding UI will slide in from the right. From here you can select the binding type (No Binding, 
Tag, Expression, or UDT Parameter, if applicable). Note that the expression can reference many useful values such as the tag's value and other 
settings of the alarm. When you've configured the binding to your liking, click on the button.Back 

Associated Data



Associated data are custom alarm properties that can be added to any alarm. These properties will often be bound to other tags that represent 
associated contextual data that may be related to the alarm. A snapshot of the values of these properties will be taken when the alarm becomes 
active. These values will be attached to the alarm event as it moves through the rest of the alarming system, meaning that the values will be available 
from the alarm status system, the alarm journal system, and in the alarm notification system.

Main Alarm Settings

Alarm Name

Each alarm has it's own name. For example, if the tag is representing a level, the alarm name might be .High Level

Enabled

This boolean determines whether or not the alarm will be evaluated. A disabled alarm's condition will not be evaluated, and thus will not generate any 
alarm events.

Priority

An alarm's priority can affect how is appears in an alarm status table, or can affect how it is escalated through a pipeline. The priorities, which can be 
referenced by their integer equivalent in scripts and expressions, are: Diagnostic [0], Low [1], Medium [2], High [3], Critical [4]

Timestamp Source

Chooses where the timestamp for the alarm event should come from: the system time of when the event was generated, or the timestamp of the value 
that tripped the event.

Display Path

This is a string value that will be used to display the alarm to operators. If this is blank, the operator will see the path to the tag instead. Please use the 
forward-slash character to separate hierarchy levels in this path, for example: East Area/Boilers/Boiler5

Ack Mode

Dictates how acknowledgement works for the alarm.

Unused - Acknowledgement will not be used for this tag, and any alarm that is generated will automatically be marked as acknowledged.
Auto - The alarm is acknowledged automatically when the alarm becomes cleared.
Manual - The alarm is never set to be acknowledged by the system, and it is up for the user to manually acknowledge alarms.

Notes

A place for any free-form documentation about the alarm that can be displayed to operators.

Ack Notes Required

If this setting is true, the operators will be unable to acknowledge this alarm without entering  some notes.

Shelving Allowed

If this setting is true, the shelving feature will be unavailable for this alarm.

Alarm Mode Settings

Mode

This setting controls what condition this alarm is evaluating. The available modes are as follows:

Equal - Active when the tag's value equals the alarm's setpoint.

Not Equal - Active when the tag's value does not equal the alarm's setpoint.

Above Setpoint - Active when the tag's value is above the alarm's setpoint.

Below Setpoint - Active when the tag's value is below the alarm's setpoint.

Between Setpoints - Active when the tag's value is between the low and high setpoints. If any change is true, an event will be generated for each 
value change between the setpoints.

Outside Setpoints - Active when the tag's value falls outside the low and high setpoints. If any change is true, an event will be generated for each 
value change outside the setpoints.

Out of range - The same as Outside Setpoints, but uses the tag's Engineering High and Engineering Low as the high and low setpoints.



Bad Quality - Active if the tag value becomes a bad quality, for example, on comm loss.

Any Change - An alarm event is generated every time the tag value changes. Note that this alarm will never be "active" because each active event is 
paired with a matching clear event, instantly. 

Bit State - This alarm mode is used to alarm when a specific bit out of an integer tag becomes high. You must specify which bit position to use, with 
zero being the least significant bit. The On Zero property is used to invert the logic and alarm when the bit is low. 

On Condition - This free-form alarm mode is used for when you want to specify the condition using an expression or another tag. To do this, bind the 
"Is Active" property to an appropriate expression or tag.

Setpoint / Low Setpoint / High Setpoint

The setpoint properties are used for many alarm modes to specify in what range the alarm becomes active.

Inclusive / Low Inclusive / High Inclusive

These settings correspond to a setpoint. If true, the range will be active if the value is exactly equal to the setpoint, not only above or below it.

Deadbands and Time Delays

Deadband Mode

Absolute - The deadband setting is considered to be an absolute value.

Percent - The actual deadband is calculated as a percent of the tag's engineering unit span.

Deadband

The value for the deadband, interpreted according to the deadband mode. Note that all alarms are only evaluated after the tag's value changes, which 
means that the tag's own deadband will be considered first.

When the deadband positive, an active alarm condition needs to clear its setpoint(s) by the amount of the deadband for the alarm to clear. For 
example, suppose you had a Between Setpoints alarm with a low setpoint of 50 and a high setpoint of 70, with a deadband of 2. The alarm will go 
active if the value is between 50 and 70, but will only clear if the value falls below 48 or rises above 72.

Active Delay

The time, in seconds, before the alarm will be considered active after the alarm's condition becomes true. Also known as a "rising edge time 
deadband".

Clear Delay

The time, in seconds, before an active alarm will be considered clear after the alarm's condition becomes false. Also known as a "falling edge time 
deadband".

Notification Settings

Active Pipeline

The name of an alarm notification pipeline to put this alarm into when it becomes active in order to send out active alarm messages. Many alarms may 
share a single pipeline.

Clear Pipeline

The name of an alarm notification pipeline to put this alarm into when it becomes clear in order to send out clear messages.

Email Notification Settings

Custom Subject

A string that will be used as the subject line of an email notification message. If blank, the message settings defined on the notification block that sent 
the email out will be used instead.

Custom Message

A string that will be used as the body of this alarm's email notification message. If blank, the message settings defined on the notification block that 
sent the email out will be used instead.

Extended Configuration Settings

Modules may add additional properties to alarms. They will appear in the list as standard properties, unless the module is no longer available, in which 
case they'll appear as Associated Data.



Expression/SQL Properties

DBTags have the ability to use an expression or a SQL query as their value instead of an OPC item path. This can be used to select information from 
the database or create your own formulas to manipulate other tag values.

Expression

In expression mode, the tag can use all of the features available in the expression language. It can refer to other tags, and use operators and 
functions to calculate a value for the tag. 

SQL Query

In this mode, the tag's value will be the result of the specified SQL query. The query can be any valid query, but should result in only one value. Note 
that insert and update queries can be used, and will often result in an integer value, so the tag's data type should be set accordingly.

Like SQL Query bindings in the Vision module, the queries for tags can refer to other tag values. The values of referenced tags will inserted as literal 
text in the query before being sent to the database.
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Types of Tags
 

Ignition supports many different types of tags. There are Gateway, System, and Client tags and the tags 
behave differently depending on which of the three scopes they belong to.

Tag Scope

The three major scopes are Gateway, System, and Client. Every tag belongs to a scope and the scopes 
play a role in how the tags behave. 

Gateway Executed Tags (includes: OPC Tags, Memory Tags, Expression Tags, Query Tags, 
and complex Tags (UDTs)
Gateway System Tags
Client Tags

While in discussing "Tags", we commonly mean Gateway executed tags, but System and Client tags can 
play an important role in the overall design of a project.

Gateway Executed Tags

Tags executed in the Gateway support all of the primary features of Tags: scaling, alarming, history, and 
role-based permissions. They are identical in their configurations, apart from defining how the value is 
generated.

OPC Tags

The OPC tags specify an OPC server and address which drives their values. The OPC address will 
be subscribed at the rate of the tag's scan class.

Memory Tags

The Memory tags are simply values. The value is specified during configuration, and is stored when 
written (if the tag allows writing).

Expression Tags

The Expression tags are driven by an expression. The expression syntax is the same as for 
property bindings, and allows mathematical operations, references to other tags, logic operations and 
more.

SQL Query Tags

The SQL Query tags execute a SQL Query, whose result provides the value for the tag. Like SQL 
binding in Vision, SQL Query tags can reference other tags to build dynamic queries.

Complex Tags (UDTs)

The Complex tags are created out of standard tag types, but offer a variety of additional features. 
In simple terms, you can think of them as a way to create "data templates", where a particular structure 
of tags is defined, and can then be created as if it were a single tag.

Gateway System Tags

The Gateway System tags provide status about the system, such as memory usage, performance 
metrics, and so on.   You can modify the Gateway System tags They exist for the Client and the Gateway.
to use alarming, history, and scaling but additional System tags cannot be added to the System folder. 
The tag names and folder structure is managed by the Ignition Gateway.

Client Tags

The Client tags, as the name implies, are only available for use in Clients. They are scoped at the client 
level unlike the Gateway executed tags. All clients will have the same client tags however the actual 
values the client tags represent will be independent of each other. In other words even though they are 
created in the Designer, each client will create their own instances. This makes them very useful as in-
project variables, for passing information between screens, and between other parts of the clients, such 
as scripting.

Client tags do not have a scan class. When set to run as an expression or query, a poll rate is specified 
dictating how often the value should be calculated.

On this page ...

Tag Scope
Gateway Executed Tags
Gateway System Tags
Client Tags
Next ...
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Client tags support datasets in addition to all the other datatypes such as integers and date-times.
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Keeping Tags Organized
 

It is important to give Tags a meaningful structure (you can also rename the Tags independent of their 
Item Path) and arrange them in hierarchical tag folders so that they are easy to understand and identify 
for all developers.

Tag Paths

Tags and their properties can be referenced by a string-based path. Each tag has a unique absolute path 
and often has many equivalent relative paths when referenced from other tags. You most often generate 
these paths by browsing or through dragging. However, it's a good idea to understand how tag paths 
work, particularly if you get into indirect tag binding or scripting. 

A tag path looks something like this: [Source]folder/path/tag.property

The   portion of the path may contain the following:folder/path/tag.property

A tag
Any number of nested folders followed by a tag, separated by forward slashes (/).
A period (.) followed by a property name after the tag. Omitting this is equivalent to using the .
Value property.

Keeping Tags 
Organized
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The  portion surrounded by square braces can have the following options:[Source]

Source Option Meaning Applicability

[Tag Provider Name] The name of the tag provider that hosts the tag. OPC and Expression tags

[] or not specified The default tag provider for the current project. OPC, Expression tags

[.] Relative to the folder of the tag that is being bound. Expression, Client tags

[~] Relative to the tag provider of the tag that is being bound (root node). Expression, Client tags

[Client] Refers to a client tag. Client

[System] Refers to a system tag. System

 

Using Relative Paths

Paths that begin with [.] or [~] are known as . They are used inside Tags that bind to other tags, and are relative to the host tag's relative paths
path. Using the relative path syntax helps to avoid problems caused by moving tags and renaming providers.

[.] refers to the tag's current folder. By using [.], tags can be moved from folder to folder without problem (provided that all of the applicable tags are 
moved together). Additionally, you can use . . to go back one folder from the current relative position, for example [~]../../tag allows you to reference a 
tag two folders up.

[~] refers to the tag's provider root. It can replace the explicit provider name, and thus protect against provider renames and importing/exporting
/moving tags between different providers. 

Tag Path Manipulation

Ignition provides a great deal of flexibility for tag addressing since tag paths and tag properties are string-based. The underlying strings that compose 
a valid tag path can be assembled from many different parts in with the eventual construction resulting in a valid tag path.

The following scripting demonstrates this concept. Suppose there was a tag path to a level indicator in a tank. In this case it is the default tag provider, 
Tanks folder, Tank 1 Folder, and the Level tag.

tagPath = "[default]Tanks/Tank 1/Level"

But suppose that there was more than just Tank 1 and instead there was Tank 2, Tank 3, Tank 4, etc. 
Dynamically changing the tag paths is simple with Ignition's tag paths being nothing more than string 
representations. The following takes the tank number and inserts it into a new tag path. The tankNumber 
variable changes the eventual creation of the tagPath.

tankNumber = 2
tagPath = "[default]Tanks/Tank %i/Level" % tankNumber
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The result of the tagPath variable will be [default]Tanks/Tank 2/Level which is a valid tag path to the the level sensor for Tank 2.
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Tag Quality and Overlays
 

Data Quality is the measure of how reliable a particular Tag's data is. If a tag's quality is not , the Good
value generally should not be trusted and an overlay is shown to make the bad quality visible. There are 
a wide variety of causes of bad data, from network disconnections, to software failure to invalid tag 
configuration.

The quality is a property of the tag called "Quality", and you can see it in the Tag Browser once you 
expand (click on the + icon) a tag. Additionally, bad tag qualities are reflected in components bound to 
tags through the quality overlay system.

The following table outlines the primary data qualities. The most important is , and that has a value Good
of .There are more values, but these represent the most common:192

 

Quality Value Meaning

Good 192 The data has met all criteria for being considered reliable.

OPC_Bad_D
ata

0 The data is not reliable, further data isn't available.

OPC_Not_C
onnected

8 The OPC server driving the tag is not currently connected OR a value has 
not yet been received by the tag from the server.

Config_Error 300 There is a problem with the tag's configuration. The error log may provide 
more information as to the exact problem.

Comm_Error 301 There is a problem in communication somewhere between the tag and its 
data source.

Expression_
Eval_Error

310 The expression in the tag generated an error during execution. The error 
log should provide more information on the error.

Tag_Exec_E
rror

330 There was an error when evaluating the tag.

Type_Conve
rsion_Er
ror

340 The value of the tag could not be converted to the requested data type. 
Check the assigned data type of the tag.

Driver_Demo
_Timeout

900 The system driving the tag is operating in demo mode and has timed out.

Access_Deni
ed

403 The tag permission settings do not allow the current user to view the tag.

Not_Found 404 The tag, or a tag referenced from inside of it, could not be found (incorrect r
eference path).

Disabled 410 The tag's "enabled" property has been set to false.

Stale 500 The tag has not been evaluated within the expected time frame. There is 
likely a deeper problem with the tag provider.

GW_Comm_
Off

901 When viewing Tags in the Designer, the tags will have this value if commun
ication with the Gateway is turned off from the toolbar.

Tag Quality and Referenced Tags

When tags reference other tags, such as in expressions, they will often pass the worst sub-quality up as 
their own. For example, even though a particular tag's expression executes without problem, if 
the expression references a tag whose quality is "Bad", the expression tag will also report "Bad".

 

Tag Quality and 
Overlays
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Quality Overlays

It is especially important for operators to be able to gauge the health and accuracy of what is displayed at a glance. In a highly distributed system like 
Ignition, it is especially important, as the client may be located at quite a distance (maybe across the world) from the physical process it is monitoring 
and controlling.
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For these reasons, components will get visual overlays for various reasons to indicate that the data they are displaying is not good. Each data binding 
that drives a component is evaluated for quality. If any of these qualities becomes poor, the component will show an overlay. The different overlays 
can mean different things, denoting their underlying cause. What they indicate is based on the Quality properties of Tags.
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Tag Metadata Properties
 

The metadata properties provide informational properties for a Tag. The values of these fields can be 
read and modified through scripting, or bound to properties such as Format, Engineering Units, 
Engineering Low, Engineering High, Engineering Limits, Tooltip, and Documentation. 

Property  Binding  Name Description

Format String FormatStr
ing 

How the value should be formatted when converted to a string (only 
applies to numerical data types).

Eng Unit EngUnit  The engineering units of the value.

Engineering 
Limits Low

EngLow  The lowest expected value of the tag.

Engineering 
Limits High

EngHigh  The highest expected value of the tag.

Engineering 
LimitEnforce
ment

EngLimitM
ode 

Dictates how the engineering range should be enforced on the tag. If 
not "none", the tag will change to bad quality ("limit exceeded"), when 
the value exceeds the specified range.

Tooltip  Tooltip  The tooltip provides a hint to visual components as to what should be 
displayed when the user hovers their mouse cursor over the 
component that is being driven by the value of this tag.

Documentatio
n 

Documenta
tion 

A freeform text property for information about the tag.

Tag Metadata 
Properties
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Tag Scaling Properties
 

Configuring a tag's scaling properties will condition the data for use within the Ignition Designer. Scaling 
will take the raw value driving a Tag, and scale the value. For example, if the capacity of a tank is 5250 
Gallons but the tanks fill level is better represented in the Designer as percentage of 0 through 100, 
configuring the tag's scaling property will result in the tag displaying 0 through 100 while the actual tank 
fill moving is between 0 and 5250 Gallons. 

Scaling is not available on Memory Tags: Memory Tags are not driven by an external source such as a 
PLC or SQL query, so scaling will never be applied. In these scenarios, it is recommended to scale the 
mechanism that is writing to the Memory Tag instead. 

Numerical properties of tags can be scaled allowing automatic bi-directional conversion outside of the 
PLC. Scaling types include Linear scaling, Square Root scaling, and Exponential Filter scaling.

The numerical properties are available to OPC, DB, and Client tags whose data types are numeric.

Property  Binding  Name Description

Scale mode ScaleMode  If and how the tag value will be scaled between the source, and what 
is reported for the tag.

Raw Lo RawLow Start of the  value range.raw

Raw Hi RawHigh End of the  value range.raw 

Scaled Lo ScaledLow Start of  value range. Raw low will map to Scaled low for the scaled
tag.

Scaled Hi ScaledHigh End of  value range. Raw high will map to Scaled high for scaled
the tag.

Clamp mode ClampMode How values that fall outside of the ranges will be treated. 
"Clamped" values will be adjusted to the low/high scaled value as 
appropriate.

Scale Factor ScaleFact
or

For single parameter modes (currently only for Exponential Filter), the 
factor parameter for the equation.

Deadband  Deadband  A floating point value used to prevent unnecessary updates for tags 
whose values  by small amounts.float

Deadband 
Mode

DeadbandM
ode

There are two modes to choose from: Absolute or Percentage.

Linear Scaling

The value will be scaled linearly between the low and high values, and clamped as appropriate.
The linear equation is:

 

ScaledValue =     S * (Value-RL)/R + SL

Square root Scaling

The equation for square root scaling is:
 

ScaledValue =   (  S * (Value-RL)/R) + SL

Where:

S = (ScaledHigh-ScaledLow)
R = (RawHigh - RawLow)
RL = RawLow
SL = ScaledLow

Exponential Filter Scaling

Tag Scaling 
Properties
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This mode implements a simple linear recursive filter to smooth values. The scale factor corresponds to 
the weight of the smoothing effect, and is a value between 0.0 and 1.0. The smaller the factor, the 
greater the degree of smoothing.

The equation for the filter is:

 

y(t) = (1-f)*y(t-1)+f*x(t)

Where:

y(t) = the output at time t
y(t-1) = the previous output
x(t) = the input value (current value)
f = the scale factor, with 0.0<=f<=1.0

Note: Only  quality values are considered for the filter.  quality values are ignored.good Bad
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1.  

2.  

3.  

Importing and Exporting Tags
Ignition can export and import tag configurations to and from  (Extensible Markup Language) or   XML CSV
(Comma Separated Value) file formats.

To import and export tags

Go to the Select the desired folder from the  that contains the tags that Designer.  Tag Browser
you want to export. 
 
On the  toolbar, click the  icon to export, or  icon to load a previously Tag Browser Export Import
exported file.
The Save (to export) or the Open (to import) window is displayed.
 
Choose the  or  to export or import your tags..xml .csv

 Note: Importing tags from XML will overwrite tags if exact match is found.

Importing and 
Exporting Tags
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XML Format

Extensible Markup Language (XML) is a markup language that defines a set of rules to encode 
documents. XML is easy for software to read and export therefore exporting tags to an XML format 
results in simple and reliable transport of all tag configuration settings.The XML format is best for cases 
where you are interested in transferring tag definitions and configurations from one Gateway to another. 
However it is not optimized for directly editing its contents. Modern variations of Microsoft Excel can open 
and display the contents of an XML file.

CSV Format

The CSV format is often used to export tags with the intent of making mass edits to the tag definitions 
and configurations in a spreadsheet program such as Microsoft Excel. The tags can be edited and 
imported back into the Gateway. Alarm properties are not included in CSV export format but are included 
in XML export format.

 

Property Values in CSV Export Files

When viewing a CSV file which has been exported from Ignition, you will see many columns each showing a configuration property value. The 
property consists of its name and its value, in some cases there might be additional attributes available.

The following table shows the configuration property names and values you will see in an exported CSV file.

Tag Properties

Property 
Name

Type Values (if 
applicable)

Description

Value     The value of the tag, dependent on the data type.

Data Type Int 0 - Int1
1 - Int2
2 - Int4
3 - Int8
4 - Float4
5 - Float8
6 - Boolean
7 - String
8 - DateTime
9 - DataSet

 

 Enabled Boolean  true/false   

 AccessRights  Int 0 - Read Only
1 - Read/Write
2 - Custom

If custom, will be defined by a P  tag.ermissions

 OPCServer String     

 OPCItemPath String     

There are many 
configuration settings for 
tags than what is displayed 
in a CSV or XML export file. 
The tag export feature only 
exports the configuration 
properties that have been 
edited in at least one of the 
tags in the selected export 
folder. Therefore, to ensure 
the desired configuration 
setting is available in the 
export file, at least one tag 
within the selected export 
folder must have that 
configuration property 
changed.
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 OPCWriteBackSer
ver

String   Write back target for expression tags.

 OPCWriteBackIte
mPath

String    

 ScaleMode Int  0 - Off
1 - Linear
2 - Square Root
3 - Exponential Filter

 

ScaleFactor Float   For exponential filter

RawLow Float   Defines scale range

RawHigh Float    

ScaledLow Float    

ScaledHigh Float    

ClampMode Int 0 - None
1 - Low
2 - High
3 - Both

 

Deadband Float    

DeadbandMode Int 0 - Absolute
1 - Percentage

 

FormatString String    

EngUnit String    

EngLow Float    

EngHigh Float    

EngLimitMode Int 0 - None
1 - Low
2 - High
3 - Both

 

Tooltip String    

Documentation String    

ExpressionType Int 0 - None
1 - Expression
2 - SQL Query

 

DriverName String   Used for external tags

ScanClass String    

HistoryEnables Boolean true/false  

PrimaryHistoryProv
ider

String   The history provider to use if storing history

HistoricalDeadband Float    

HistoricalDeadban
dMode

Int 0 - Absolute
1 - Percentage

 

HistoricalScanclass String    

InterpolationMode Int 0 - Discrete
2 - Analog (deadband)
3 - Analog (compressed)

How values are interpolated. 2 exists for backwards compatibility (and is equivalent to 1), but only 0 or 
3 should be used in the future.

HistoryTimestamp
Source

Int 0 - System
1 - Value

 

HistoryMaxAgeMo
de

Int 0 - Unlimited
1 - Limited

 

HistoryMaxAge Int   Max cycles between storage.

UDTParentType String   The path to the parent UDT type. Used by sub-types and instances.

 

 

Alarm Property Values included in XML Export Files

Property Name Type Values (if applicable) Description



Enabled Boolean true/false  

Priority String Diagnostic, Low, Medium, High, Critical May also be numeric, 0-4.

DisplayPath String    

ActivePipeline String    

ClearPipeline      

Deadband Float    

DeadbandEvalMode Integer 0 - Absolute
1 - Percentage

 

TimeOnDelaySeconds Float    

TimeOffDelaySeconds Float    

TimestampSource Int 0 - System
1 - Value

 

AckMode Int 0 - Unused
1 - Auto
2 - Manual

 

Notes String    

AckNotesReqd Boolean true/false  

ShelvingAllowed Boolean true/false  

Mode String Equality
Inequality
AboveValue
BelowValue
BetweenValues
OutsideValues
OutOfEngRange
BadQuality
AnyChange
Bit
OnCondition

 

SetpointA     The setpoint, or the  setpoint for dual value modes.low

SetpointB     The  setpoint for dual setpoint modes.high

InclusiveA Boolean    

InclusiveB Boolean    

BitOnZero Boolean   Used by the  condition, to indicate that 0 is .Bit active

BitPosition     Bit to use in  condition.Bit

ActiveCondition Boolean   The property that drives the  mode.OnCondition

AnyChange Boolean   Whether or not to apply the  behavior in applicable modes.any change
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Array and Dataset Tags
 

 

Array and Dataset data types are now available on tags. Both data types allow for multiple data points to 
be stored in a single tag. Configuring a tag as an array or dataset is as easy as changing the data type in 
the Tag Editor.
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Array Tags

Many OPC servers and drivers already support array type tags, and now each element in the array can easily be represented with the array data 
types in Ignition. Additionally, array data types can be used with devices that do not support array types, and will instead expose each bit in the value. 

Note: , and cannot be used with bi-directional bindings. You can set the value of the whole array in Individual members of Array Tags are read only
scripting (ie: writing 5 to an Integer Array will set both the 0 and 2 positions to 1 and everything else to 0) or additional (non-array type) tags can be 
created to write to those addresses.

Array Alarm Example

Because the core data type of each element in the array is the same, it is possible to apply Tag History, Alarming, or Scaling configurations onto 
the array, and these configurations will be inherited by each element. 

 

1) The WriteableInterger1 and WriteableInteger1_Copy tags below are using the same OPC Item Path, and both are currently configured as 
Integer tags. 
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2) Edit the WriteableInteger1_Copy tag, and change it's data type to an Integer Array, and click OK

 

3) Once the tag finishes re-subscribing, the value for WriteableInteger1_Copy will now show "Array[32]" instead of the previous value. Expanding 
the tag reveals a new Value section, and expanding this section will show the value of each bit. 

 

4) Next, edit the WriteableInteger1_Copy tag again, and head to the Alarming section. Create a new alarm with Mode set to Equal, but change the 
Setpoint to 1, and then click OK. This way an alarm will be active for each element that is set to 1. 



 

5) Create a new Alarm Status Table report, and you should see an alarm for each true element. 

 

 

Dataset Tags

 

Dataset Tags allow multiple rows and columns worth of data to be stored in a tag. Each column is exposed as a separate folder in the tag (i.e., the 
"name" folder in the above image). Dataset Tags can be driven by a query, so it's possible to query for multiple columns on a row in a single tag. This 
is much more efficient than using multiple query tags (and thus multiple queries) to retrieve the same data. 

Memory Tags that use the Dataset type support bi-directional bindings in tables.



Dataset Tag Write Example

The following example will write the contents of a Table component to a dataset tag.

1) Create a new Memory tag. Name it Dataset, and change the data type to Dataset. The Dataset will be empty by default.

 

2) On a new window, add a button component and table component.

 

3) Generate some test data on the Table by toggling the TestData property.



 

4) Next, the button will need a script to handle writing to the tag. Right click on the button and select Scripting. Choose the actionPerformed Event 
Handler, and click on the Script Editor tab. Use the following code:

Code Snippet

#retrieve the data on the table and store it a variable. 
data = event.source.parent.getComponent('Table').data

#write to the tag
system.tag.write("Dataset", data)

 

5) Make sure the Designer is set to Read/Write mode: Project menu > Comm Read/Write



 

6) Put the Designer into preview mode, and click on the button. The data in the table has been passed to the tag. Expanding the tag in the Tag 
Browser will show the new values on the tag.

 

 

Next ...

 

 



Browsing and Creating OPC Tags
   

There are two ways to create OPC tags.

From OPC Browser 
Using the OPC Browser to browse and find the tag and then drag it to the Tag Browser to create the tag, see . This Browsing for OPC Tags
method is the easiest and most common way to create tags.
 
From Tag Editor 
When the tag is not available for browsing from the OPC Browser, you create the tag manually, from the Tag Editor window, see Creating 

.OPC Tags Manually

   

In this section ...

 

 



1.  

2.  

Browsing for OPC Tags
 

The easiest and most common way to create Tags in Ignition is by dragging the tags from the OPC 
Browser into the Tag Browser window in the Designer.

Creating Tags

Now that you are in the Designer, a good first step is to create some Tags. You'll use these tags 
for realtime status and control and to store history with the Tags Historian. Tags are all configured in the 
Tag Browser panel.

To create tags by dragging them from OPC

If you have created  a device in the earlier step, the easiest way to create some Tags is by dragging the 
tags from the OPC Browser.

In the  , select the   folder and click the   icon.Tag Browser Tags Browse OPC Servers

 

The OPC Browser is displayed and you can browse all of your OPC connections.

By default, you've got a connection to the internal  , which has the Ignition OPC-UA Server
devices in it you created earlier. Browse the devices and find some tags that you're interested in.
 
From the  , highlight the tags (for example, as in the picture below, both folders OPC Browser
inside the   folder) and drag them to the   folder in the  .SIM Tags Tag Browser

 

You can drag individual tags or folders. When you drag folders, Ignition keeps the same 
hierarchy as the PLC. As soon as you drag the tags into Tag Browser, you can see their values 
being updated in the Tag Browser, 

That's it! You now have some Tags. You can see their values come in and start updating 
automatically. By default, they update at a rate of 1 per second.

Browsing for OPC 
Tags

Watch the Video

To Continue on the 
step-by-step simple 
workflow...

After you  , as described Create Tags
on this page, click the link below for 
Step 6 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

 

 

 

 

 

Next ...

Creating OPC Tags Manually
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1.  

2.  

3.  

Creating OPC Tags Manually
 

You can create OPC Tags manually when you can't find them by using the OPC Browser.

To create OPC Tags Manually

From  , right-click on   or a folder of your choice and select Tag Browser Tags New Tag > OPC 
.Tag

In the   window, as an example, you can set the following values:Tag Editor

Name: Temperature
Data Type: Int4
OPC Server: choose Ignition OPC-UA Server from the dropdown

OPC Item Path:  [Modbus]HR1, the Modbus device name goes in the square brackets then 

you give the address to PLC which in this case is the HR designator plus 1 as the Modbus 
address. The Modbus Specific Addressing section, explains how your can construct these 
addresses.

 

Click OK.

Now you can see the Temperature tag in the Tag Browser.

Creating OPC Tags 
Manually

Watch the Video
 

 

 

 

 

 

 

 

Next ...

Addressing Bits
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1.  

2.  

Addressing Bits
1000000000000

1000000000000

In order to address individual bits in Ignition, you must create a separate OPC tag pointing directly to the 
specific bit in the PLC. 

When the integer values that come from the OPC tags are a series of binary bits, it is then possible to 
address each bit. For example, an integer value can have a 16-bit binary representation as shown here: 

Integer Bit level representation How it works

4096 0,0,0,0,0,0,0,0,0,0,0,0,1,0,0,0 2  = 409612

1025 1,0,0,0,0,0,0,0,0,0,1,0,0,0,0,0 2  + 2  = 10250 10

To address an individual bit

Suppose a MicroLogix PLC is connected to a Gateway.

From the   window, create an OPC tag to have:Tag Editor
Data Type:   with a value of 1025Integer
OPC Item Path: [MLX]B3:0

 

Then create a new OPC tag with a Boolean value to the first bit of this tag as follows:

Data Type:   with a value of 1 or TrueBoolean
OPC Item Path: [MLX]B3:0/0 (for Micrologic, you can specify the bit as: 0

 has a value of /0 or 0.0. That is, with a slash/ or a period.) [MLX]B3:0/0

1 or a Boolean value of True

Addressing Bits

Watch the Video
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Creating Memory, Expression, and Query Tags
   

Memory tags are simply values you use as setpoints or for storing information. tags let you perform calculations based on other tags. Expression Quer
tags execute a SQL query, whose result provides the tag value, and they can reference other tags to build dynamic queries.y 

 

In this section ...

 



1.  

2.  

3.  

Creating Memory Tags
 

Memory tags are simply values. You can use them as setpoints (that are not stored in the PLC) or just for 
storing extra information. The value is specified during configuration and is stored globally when written.

To create memory tags

From , right-click on  or a folder of your choice and select Tag Browser Tags New Tag > 
.Memory Tag

 
In the , type a  (for example, Memory Tag), initial  , and  .Tag Editor Name Value Data Type

 
 
Click .OK

That’s it! You now have a memory tag that you can read from or write to. This is just like having 
a global variable for your project.

Creating Memory 
Tags

Watch the Video
 

 

 

 

 

 

Next ...

Creating Expression Tags
Creating Query Tags
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1.  

2.  

3.  

4.  

Creating Expression Tags
 

 

Expression Tags are driven by an expression. The expression syntax is the same as for property 
bindings and allows mathematical operations, references to other tags, logic operations, and more. 
Expression Tags cannot be written to.

With expression tags you can do a special calculation based on other tags. In this way, you can do the 
calculation one time and view it on any window in your project.

To create an expression tag

In the , right-click on  or a folder of your choice and select Tag Browser Tags New Tag > 
.Expression Tag

In the , type  for  and choose  for  .Tag Editor FtoC Expression Name Float4 Data Type
 
Click on the  tab on the left side of .Expression Tag Editor
 
Type in any expression using Ignition’s Expression Language. See  in the Expression Functions
Appendix for information on all expression operations and functions.

Copy in the following expression:

(5/9) * ({[~]Refrigeration/ambientTemp} - 32)

 

 

 

  

Creating 
Expression Tags

Watch the Video
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4.  

5.  

If you want to use a different tag, just replace the   tag {[~]Refrigeration/ambientTemp}
path with any Tag of your choice.

Note that instead of typing the referenced tag path (in this example Refrigeration
), you can use the Tag icon on the right side of the  /ambientTemp Tag Editor > Expression

window to select the tag path.

Click .OK

You will see the value from your calculation on the Tag. Note that the Expression tags are 
evaluated at the rate the Scan Class is set to. 
 

With an expression tag, you can also choose to write the value back to another OPC item. In the 
, simply click the check box next to  Tag Editor > Expressions Write value back to OPC item?

and select the tag you want to
write to. Every time the value is calculated, the value gets written to the selected tag.

   

Next...

Creating Query Tags

 



1.  

2.  

3.  

4.  

5.  

6.  

Creating Query Tags
 

Query Tags execute a SQL Query, whose result provides the value for the Tag. Like SQL binding in 
Vision, SQL Query Tags can reference other tags to build dynamic queries. Query Tags cannot be 
written to. The value of a SQL Query tag comes from the database through a SQL query.

To create a SQL query tag

In , right-click on  or a folder of your choice and select  .Tag Bowser Tags New Tag > Query Tag

In the  window, type  for  and choose   for .Tag Editor Current Time Name DateTime Data Type

Click on  tab on the left side of .SQL Query Tag Editor

Type in any SQL query you want.

 The query must return a scalar result because the data type is not a dataset.Note:
 
In the drop-down list, select the database to run the query through, for example .MySQL

Copy in the following query:

SELECT CURRENT_TIMESTAMP

Creating Query 
Tags

Watch the Video
 

 

 

 

Query Type
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6.  

7.  Click .OK

You will see the value from your SQL query on the  Tag.Current Time

 

 

Next ...

add link here

 

 

In certain circumstances you may want to update the database instead of querying it 
for data. The query tag will accept an update query and update the target data 
source. The value attribute of the tag becomes the number of rows affected by the 
update query.

The data source refers to the default data source of the tag provider as opposed to 
the default data source of the project.

In the Gateway  Section, go to  and edit the appropriate Configure Tags > Realtime
tag provider. Set the default database connection that this tag provider will use for its 
query tags.



1.  

2.  

Creating User Defined Types (UDTs)
   

Complex Tags, also referred to as UDTs (user defined types), offer the ability to leverage object-oriented 
data design principles in Ignition. Using complex tags, you can dramatically reduce the amount of work 
necessary to create robust systems by essentially creating parameterized "data templates".

By defining UDTs and using these essentially “data templates”, you can generate tag instances to rapidly 
build complex screens. A change to the type definition is then inherited by all instances, drastically saving 
time when making routine changes. 

The UDT data types are fully supported by Vision templates, which means you can configure templates 
for your custom data types and take advantage of drag-and-drop binding to rapidly build complex 
screens.
   

On this page ...

Primary UDT Features
UDT Terminology
Defining Data Types
Creating Data Types from Existing 
Tags or OPC
Creating Instances of Complex Types
In this section ...

 

 

 

Primary UDT Features

The primary features of UDTs are as follows:

Central Definition
Once you define your data type, you can then create instances of it. If at a later time you want to change some aspect of the tag, you can simply edit 
the type definition, and all instances of it are automatically updated.

Parameterized Settings
Define custom parameters on your data type, and then reference them inside your member tags. When it comes time to create instances, you can 
simply modify their parameter values in order to change where the underlying data comes from.

Extendable 
Data types can inherit from other data types in order to add additional members, or override settings. Instances can also override settings, allowing for 
flexibility for dealing with irregular data and corner cases.

UDT Terminology

Many terms are frequently used when discussing complex tags:

UDT or UDDT
User Defined Type or User Defined Data Type. The definition of the data type is: its structure, tags, attributes and settings.

Instances
Instances are running copies of a data type with specific data for all members. Instances are linked to their parent types and are reloaded when their 
parent type changes. Besides specifically overridden settings, all settings are inherited from the type definition.

Parameters
Parameters are custom properties on data types that you can use inside the type or instance definition to create parameterized data templates. For 
example, if a data type consists of 3 OPC tags that only differ by a number in the path, you can use a parameter for the "base address", allowing 
instances to be created with only 1 setting.

Members
Members are the tags inside of a data type or instance.

Defining Data Types

Creating a new data type is very similar to creating standard tags.

To create a new data type

Simply select the  folder in the .Tags Tag Browser

Click the  icon on the  toolbar.Tag Tag Browser
The tag creation menu is displayed.
 



3.  Select New Data Type from the menu.

The Tag Editor is displayed.
When editing complex tags, the  window appears a bit differently. The member tree structure is presented in the upper left. By Tag Editor
selecting a member, the tag property categories are displayed below the member area, and the editor for the selected category appears to 
the right.

To extend other Types

Data types can extend other data types, to add additional members, or override default values. The parent data type can be modified by selecting the 
data type itself in the tag member tree. Note that the data type can only be selected when the tag is first created. After that, it is not possible to modify 
the parent tag type.

To add members to a data type

Simply click the  icon at the toolbar above the member tree. Data types can contain standard tags like OPC and DB, as well as folders and green +
instance of other complex types.

To add parameters

Parameters, which can be used for property expansion in member tags, can be added by selecting the data type in the member tree. If a data type 
contains other complex types in it, there may be various points in the tree with custom parameters. While a data type can override the parameter 
values inherited from a parent, new parameters can only be added to the root node of the new data type. 

Configuring Member Properties

The tags inside of data types are configured much like normal tags. However, in this case, the values can be thought of more as "default values", 
which will be used unless other values are specified when the instance is created. Most of the values configured in the data type can be modified later 
in sub types or instances. Furthermore, unlike normal tags, in the context of a data type many properties (general the string based properties) can 
reference the custom attributes of the type in order to build parameterized types.

Attribute Referencing and Parameterized Types

As mentioned above, many properties in the member tag configuration can reference the parameters available in the data type. When instances are 
created, these references are replaced with the values defined for the type. Parameter references also support basic offsets and numerical formatting, 
providing a great deal of flexibility. To reference a parameter, use the syntax  , or use  to display a list of available {ParameterName} Ctrl-Space
parameters to choose from.

To offset a value, use the form .{ParameterName+offset}
To format a value, use the form . The format pattern is the same as that used for the  expression {ParameterName|format} numberFormat
function. In short, "0" can be used to require a digit, and "#" can be used for optional digits.

Example:

For this example, we'll assume that we're parameterizing the , and that the data type has an integer attribute named  OPC Item Path BaseAddress
defined. We'll pretend the  provides tags named like .OPC Server DataPoint1

Standard referencing

OPC Item Path: DataPoint{BaseAddress}

Offset

Imagine that our data type had three fields, and these were laid out sequentially in the device.
Instead of specifying each address for each tag, we can simply offset from the base address:

Member 1: DataPoint{BaseAddress+0}
Member 2: DataPoint{BaseAddress+1}
Member 3: DataPoint{BaseAddress+2}

Formatting (with offset)

Continuing from the example above, imagine that our OPC server actually provided addresses in the form , in order to stay consistent DataPoint001
up to "DataPoint999". This can be accommodated
using number formatting in the reference:

Member 1: DataPoint{BaseAddress+0|000}
Member 2: DataPoint{BaseAddress+1|000}
Member 3: DataPoint{BaseAddress+2|000}

This format of three zeros means "three required digits". If our instance has a base address of 98, the resulting paths will be DataPoint098, 
.DataPoint099, DataPoint100

Properties that can be parameterized



The following tag properties can reference parameters:

Value (for string data type only)
OPC Server
OPC Item Path
Tooltip
Documentation
Expression/SQL Query
Bindable Alarm Properties (Note: you can bind a property directly to the parameter, or use parameters in the binding expression, or directly in 
string property values)

Overriding Properties

Sub types and instances can override the properties defined in parent types. To do this, simply select the  (the small grey ball) next to override control
the property to override in the member editor.
Conversely, to remove the override, simply unselect the control.

Custom parameters can be overridden as well, but it is not required to specify that the value is an override. Simply provide a new value for the 
property. For inherited parameters, the  button next to the parameter table will simply remove the override. The parameter can only truly be delete
delete from the type that defines it.

Creating Data Types from Existing Tags or OPC

You can save time and quickly generate data types from existing structures. This is particularly useful, for example, when data types are already 
defined in the PLC.

Converting from existing Tags

To create a data type from existing Tags, simply select the tags or folders you wish to include, right-click and select .Create Data Type from Selected

The Tag Editor window is displayed with the selected tags pre-populated as members. From here you can modify the tags, add parameters, and so 
on. The original tags will not be affected.

Tip: If you select a single folder as the root to create the type from, its sub-members will be added, and its name will be the basis for the type (that is, 
the folder itself won't be included in the structure).

Creating from OPC

If you have data types defined in your PLC (or OPC server), you can short-cut the conversion step outlined above by simply dragging the tags (or the 
folder for the type) from the OPC Browser
directly onto the  folder, and selecting  from the subsequent dialog.Data Types Create Type

Creating Instances of Complex Types

Creating instances of complex types is virtually identical to creating other types of tags using the New Tag menu. Unlike standard tags, it is likely that 
you'll have to modify attribute values or override certain member properties in order to make the instance unique. The process for doing this is the 
same to that used when creating data types. Once created, instances run very much like standard Tags. If the parent data type is updated, the 
instance will automatically receive the updates and refresh.

Using the Multi-Instance Wizard

The multi-instance wizard provides a powerful but simple mechanism for rapidly generating many instances of a data type, by specifying patterns for 
parameters. To get started right-click a tag in the , then select  from the menu. Tag Browser New Tag > Data Type Instance > Multi-instance Wizard
The  window is displayed. Once you select a data type, you will see its parameters come into the table, where you can  Instance Creation Wizard
specify values for them. The size of the parameter patterns dictate how many tags are created, or if only single values are specified, you can choose 
to create multiple copies of the same configuration.

Value Patterns

In order to define values for parameters (and the tag names), you can use several different types of patterns (and combinations of patterns):

Range      number1-number2[/step]
A numeric range of values, such as . Optionally, a  parameter can be included, in order to only generate numbers at certain multiples. For 1-10 step
example,  would generate  , and so on.0-100/10 0,10,20

Repeat      value*count
A value (numerical or string), and the number of times to use it. For example, would use the parameter  for  items.North Area*10  North Area 10

List      value1, value2, value3
A comma separated list of values (or other patterns) to use.

Examples:



1-10,20-30,30-40      Results in  tags being created, with the specified value ranges (so, for example, there would be no parameter ).30 15
A,B,C                         Results in  tags, with each of the values.3
0-100/5                      Results in  tags (because range is inclusive), with values .21 0, 5, 10...100

As mentioned, the size of the pattern will dictate how many tags will be created. If some patterns are smaller than others, the last value will be 
repeated for the other tags.

Tag Names

The names of the generated instances can be specified using a system similar to that of the parameter patterns. If you just want to use sequential 
names, you don't need to specify a pattern, as values will be generated automatically starting at one. You can also set the pattern to simply be the 
starting number to generate sequential names from there.

Base Name
A string base for the tag name. This can also be a list of names, in which case the names will be used directly, and the name pattern won't be used.

Name Pattern
A pattern that will be used to generate values that will be appended to the base name.

At any time, you can use the preview button to view the tag names and parameters that will be created. Once you are satisfied, click OK to generate 
the tags under the selected folder in the tag provider.

 

In this section ...

 

 



Understanding Complex Tags (UDTs)
 

Complex Tags are created out of any of the standard tag types, but offer a variety of additional features. 
In simple terms, you can think of them as a way to create "data templates", where a particular structure 
of tags is defined, and then many instances can be created as if each were a single Tag.

Use UDTs (user-defined data types) to design re-usable, parameterized, and extendable data types. 
Then new instance tags can be created and configured in seconds, potentially saving a tremendous 
amount of time over traditional tag systems.

Understanding 
Complex Tags 
(UDTs)

Watch the Video
 

 

 

 

Next ...

Creating UDT Definition
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Creating UDT Definition
 

So far we have only dealt with simple tags. Additionally, In Ignition, you can create complex tags or 
user defined types (UDTs). These types can model UDTs in certain PLCs (such as a ControlLogix) or 
can be completely new.

You create the UDTs in a special folder in the   called  .Tags Browser Data Types

UDTs (User Defined Types) can be created in the following different ways:

from browsing OPC servers via OPC Browser
by converting them from existing tags
by manually creating them

If your PLC supports UDTs, the easiest way to create a type is from OPC. 

To create the UDT from OPC Browser

In the example here, we will use a ControlLogix which supports UDTs. We will use the second method 
from above that is, creating the UDT from OPC. In our ControlLogix PLC, lets say we already have a 
motor UDT setup and now we will create the UDT in Ignition.

From  , click the   icon.Tags Browser OPC Browse
 
Under the   folder, go to the   folder and find the   folder.CLX Global M1

 represents a motor which has four tags: AMPS, HOA, RUN_CMD, and STATUS.M1

Drag the   folder to the Data Types folder in Tags Browser.M1
A window prompts you asking if you want to create a type or tags.

 
Click on  .Create Type
The   window is displayed. Notice all four tags AMPS, HOA, RUN_CMD, and Tag Editor
STATUS are automatically part of the UDT.
 
In the Tag Editor, change the name from   to   to make the type name more of a generic M1 Motor
name.

Creating UDT 
Definition

Watch the Video
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10.  
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Right now each tag is pointing to a specific address in the PLC, select the   tag to see that AMPS
it is pointing to   in the PLC.M1

Because we are creating a UDT we don't want to point to one specific set of tags. We want 
each instance of the UDT to reference a different set of tags. To do that, we need to add a 
parameter to the UDT.
Parameters are custom properties on data types. You can use the parameters inside the type or 
instance definition to create parameterized data templates.
For example, if a data type consists of three OPC tags that only differ by a number in the path, 
you can use a parameter for the “base address”, allowing instances to be created with only one 
setting.
 
In the  , select the Motor data type and add a new parameter byTag Editor
clicking the   button and setting the following:green +
Name: MotorNumber
Data Type: String

 
 
Click  .OK
Now for each tag, we can substitute the motor number with the   parameter.MotorNumber
 
Open the Tag Editor again, select the   tag. In the  , click on   and press AMPS OPC Item Path M1

 to bring up the list of parameters, click   to replace   with Ctrl-Space MotorNumber 1 {MotorNumb
.er}

 

Do the same for the HOA tag.
The   will then show:OPC Item Path
[CLX]Global.M{MotorNumber}.HOA
 
Click   to save the UDT.OK
You will see the   UDT in the   folder.Motor Data Types



11.  
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Creating UDT Instances
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Creating UDT Instances
 

Creating instances of UDTs is virtually identical to creating other types of tags using the  menu. New Tag
Unlike standard tags, it is likely that you'll have to modify attribute values or override certain member 
properties in order to make the instance unique.

To Create a UDT Instance

Once a UDT Definition is created, you can create an instance of the UDT as an actual tag in 
Ignition. Using the Motor UDT Definition from the previous section, lets create a UDT Instance.

 

In the , right-click on  and select  to Tag Browser Tags New Tag > Data Type Instance > Motor
create a new instance.

Assign the new instance a name,  and enter a value for each parameter that is used in Motor 1
the configuration of the UDT Motor.

Assign the   parameter a value of  for ControlLogixs. DeviceName CLX 
Assign the   parameter a value of  for Motor 1.MotorNumber  1
Click  and the Motor 1 instance is created in Ignition. OK

 

 
From the , expand  to verify that the tags are working correctly. Tag Browser Motor 1

Creating UDT 
Instances

Watch the Video

https://www.inductiveuniversity.com/video/creating-udt-instances/7.8


3.  

4.  

5.  

 

To see how Ignition translated the path for each parameter and verify that they are correct and 
of good quality, check the OPC Item Path in the Tag Browser.
From the , select , click  and check  from Tag Browser Motor 1 Column Selector  OPC Item Path
the dropdown. 

  

You  can see that Ignition displays both the  and  DeviceName (CLX) MotorNumber (M1)
correctly.

To create another instance of Motor 1,  and  in the Tag folder to create copy paste Motor 1 Moto
.r 2

Open the  and modify the  value from  to  to point to a different Tag Editor MotorNumber  1 2
Motor, in this case, Motor 2. 
Click . OK



5.  

6.  

 

 To confirm Motor 2 is working correctly, open the  and expand .Tag Browser Motor 2

 

Creating UDT Instances is really simple once you have a UDT Definition in place.

 

 

 

Next ...

UDT Multi-Instance Wizard

 



1.  

2.  

3.  

4.  

UDT Multi-Instance Wizard
 

The multi-instance wizard provides a powerful but simple mechanism for rapidly generating many 
instances of a UDT at the same time by specifying patterns for UDT parameters.

To make instances of the UDT

Now that we have the Motor UDT (see  ) we can make instances of it. Creating Complex Tags (UDTs)
Instances are running copies of a data type with concrete data for all members.

In  , right-click on   and select   to create a new folder and call it Tags Browser Tags New Folder M
.otors

You can create a single instance of the motor or use the multi-instance wizard to rapidly create 
all four at the same time. Here we will use the multi-instance wizard.
 
Right-click on the Motors folder and select New Tag> Data Type Instance> Multi-Instance 
Wizard.

 
 The Instance Creation Wizard is displayed.

 From the   drop-down, select  .Step1 - Select Data Type to Create Motor

Set the following:

Base Tag Name: Motor
Tag Name Pattern:   this creates four tags  ,  , and so on1-4 Motor 1 Motor 2
Parameter:   which is what we used to reference specific tags in the PLCMotorNumber
Pattern:   so that Motor 1 tag will have a parameter of 1 and Motor 2 will have a parameter of 1-4
2 and so on

UDT Multi-Instance 
Wizard

Watch the Video

 

 

https://www.inductiveuniversity.com/video/udt-multi-instance-wizard/7.8
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5.  

6.  

7.  

8.  

9.  

Basically, you have the tag name and the parameter value to set.

Click   to see what Ignition will create for the tag name and the parameter value.Preview

Click  to see all four tags created.OK
If you expand each tag, you can see all the members of the UDT and their
respective values.

 

Now if you make a change to the UDT, all four instances are automatically updated because 
they are of that type.

Edit your Motor UDT by double-clicking on it in the Tags Browser.
The Tag Editor is displayed.

Click on the   button on the top-left of window and select  .green + New Memory Tag

  
Set the following:
 Name: MotorType
Value: basic
Data Type: String



9.  

10.  Click   to save.OK

Now each instance automatically gets the new tag.

 

 

 

Next ...

Overriding Properties in UDT Instances
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5.  

6.  

Overriding Properties in UDT Instances
 

It is possible to override properties of a UDT instance to create a different base structure as compared to 
other instances of the same data type. For example, you may have to create an instance of a UDT that 
uses a completely different OPC address scheme from the definition.

To override the properties

All the instances of the same data type definition, have the same configuration. But when there is an 
instance which needs to have a different value from the rest of them, you can override that value. Lets 
say we want to override the  property of the  tag of the   instance.OPC Item Path STATUS Motor 4

From the , you would go to , right-click on  , then selectTag Browser Tags > Data Types Motor 4  
.Edit tag(s)

The  is displayed.Tag Editor
 

Under Data Type Structure, select the STATUS tag.
You can see that none of the fields are highlight for which you can make any changes to them. 
 

Look for the circle to the right of the   box and click it so you can highlight this OPC Item Path
box.
The circle changes its color to green allowing you to edit the box. 

Edit the  and click .OPC Item Path OK

Go to , click on the  icon on the toolbar, and select the box for Tag Browser   Column selection O
.PC Item Path

See your changes in the column that displays the value of the OPC Item Path. 
 

To go back to the original configuration, you can unclick the green circle next to the OPC Item 
.Path

Overriding 
Properties in UDT 
Instances

Watch the Video

 

 

 

 

Next ...

UDT Inheritance
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1.  

2.  

3.  

4.  

UDT Inheritance
 

It is possible to setup UDT inheritance where data types extends to other data types, to add additional 
members or override default values.

To inherit property values from an existing UDT

From , right-click on , and choose .Tag Browser Data Type New Data Type
The Tag Editor window is displayed.
 
In the  box, enter a new name, and from the dropdown of the  box, choose Name Parent Type
an existing UDT.
This new UDT will automatically inherit all the properties of the parent UDT.
 
You can add new properties to this new UDT by clicking the  icon on the top-left of the green + T

 window. ag Editor
 
Click .OK
The new UDT appears in the .Tag Browser

UDT Inheritance

Watch the Video
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UDT Composition
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2.  

3.  

UDT Composition
 

You can setup UDT composition in Ignition where you use one UDT as a parent for another, or insert one 
or more UDTs inside another UDT.

In this example, a Motor data type and Tank data type were already created.  We want to create a third 
UDT called Area.  The Area UDT will contain the Motor and Tank 
data types inside of it. 

In the , right click on the  and select .Tag Browser Data Types folder New Data Type
In the , enter . Name box Area

In the , add 2 data type instances, one for Motor and the other for Tank.  Tag Editor
Click on the , select .green + icon Data Type Instance > New Motor
Click on the , select .green + icon Data Type Instance > New Tank
Rename both new data types to Motor and Tank respectively.  

 

Every UDT you add inside another UDT has paramters that need to be specified and passed in 
from the parent UDT.  Motor has 2 parameters: DeviceName and MotorNumber.  Tank has 2 
parameters: DeviceName and TankNumber.

 

UDT Composition

Watch the Video
 

 

https://www.inductiveuniversity.com/video/udt-composition/7.8


3.  

4.  

5.  

If both data types use the same parameter as in this example with the DeviceName parameter, 
you only need to enter it once in the new UDT.
In the , click  and enter the parameter from the Motor and Tank data types: Tag Editor Area  Devi

,  and .ceName  MotorNumber TankNumber
Click . OK

 

The values in the Area UDT need to pass to the Motor and Tank data types so references need 
to be added.
In the , click on  and enter the references.Tag Editor  Motor
     For the parameter DeviceName, enter the value {DeviceName}.
     For the parameter MotorNumber, enter the value {MotorNumber}.
     Click . OK

 

In the , click on   and enter the references:Tag Editior Tank
   For the DeviceName enter the value {DeviceName}.
   For the  parameter TankNumber enter the value {TankNumber}.
   Click . OK



5.  

6.  

7.  

 

Now, create a new instance of Area.  In the  , right click on the  , select Tag Browser Tags folder
.New Tag > New Data Type Instance > Area

 

In the , enter the new instance name,  .  Enter the values for each parameter:Name box Area 1
   DeviceName, enter  .CLX
   MotorNumber, enter  .1
   TankNumber, enter  .100
   Click . OK

  

From the , you can see  was created.  Expand Motor and Tank data types Tag Browser Area 1
to validate the values are pointing to the appropriate places in the PLC.



7.  

8.  

 

You can also verify the path in the Tag Tree that Motor is pointing to M1 and Tank is pointing to 
Tank 100. 
From the , click   and check the  from the dropdown.   .Tag Browser Area 1  OPC Item Path

 

 

 

 

Next ...

add link here

 



Data Type Parameters in Expressions
 

It is possible to use the value of data type parameters directly in expression bindings within a UDT.

Parameter references can be quickly inserted into expression by clicking on the UDT Parameters button 
on the right of the expression area

 

 

Syntax

The syntax for data type parameters expressions differs from tag and property references when using 
string values. . The reason for Quotation marks must be used when referencing string parameters
this is parameter references are replaced before any expressions are evaluated. This differs from tag and 
property references seen elsewhere in ignition. 

If the data type of the parameter is not a string, then quotation marks are not required, but can be used.

It does not matter if double quotation marks or single quotation marks (" versus ') are used as long as a 
matching closing quotation mark is present.

 

"{string parameter}" //This expression will evaluate successfully
'{string parameter}' //This expression will evaluate successfully as well

 

Examples

Below is an instance of a Turbine UDT. It contains a string parameter named "turbine_location".

 

Inside the Turbine UDT is an expression tag named Member Location. To show the value of the 
turbine_location parameter on Member Location, the following expression would be used on the UDT 
definition

 



 

Omitting the quotation marks would result in an evaluation error:

 

The same syntax should be applied to parameters in bindings on alarm properties. Below is an example 
using the same UDT, but the expression is instead located on the Display Path property of an alarm.

 

Additionally, non-string parameters and static values can be included in the same quotation marks.

 

Combining Parameters and Tag references

Because parameter and tag references differ in syntax, some consideration must be made when 
attempting to use both in the same expression. Tag references must not be placed inside of quotes. After 



adding a string tag to the Turbine UDT, a reference to the tag can be added to Member Location's 
expression:

 

Adding quotation marks around the tag reference would result in the literal value of the reference 
appearing in the value of the tag:

 

Quick Reference

 

Reference Type Require 
Quotes?

Expression Example

Static String Requires 
Quotes "This is a string"

String UDT Parameter Requires 
Quotes "{turbine_location}"

String Tag Reference No Quotes
{[.]String Tag}

String UDT Parameter with Static 
String

Requires 
Quotes "The turbine is located at 

{turbine_location}"

String UDT Parameter with String 
Tag Reference

Partial 
Quotes  "{turbine_location} " + {[.]

String Tag}



String Parameter, Static String, 
and String Tag Reference

 Partial 
Quotes "The Turbine " + {[.]String Tag} 

+ " {turbine_location}"

 

 

Next ...

Expression Overview and Syntax

 

https://legacy-docs.inductiveautomation.com/display/DOC/Expression+Overview+and+Syntax


Scan Classes
   

Scan classes dictate the rate of execution of tags, and therefore play a crucial role in the design of large 
and high-performance systems. It will often make sense to have more than one scan class as usually 
not all of your tags will need to be subscribed at the same rate. Some tags you may wish to see 
updated at 250-500ms, while others may not be so crucial and may only need to be subscribed at 
1500ms.

Creating different scan classes allow you to organize your tags into groups that subscribe at 
different rates. It is good practice to put some forethought and planning into the organization of your 
Tags and scan classes.

On this page ...

Tag Execution by Scan Class
Adding and Editing Scan Classes
In this section ...

Tag Execution by Scan Class

Tags are executed by scan classes inside of a tag provider. In a typical system, there are a number of scan classes and one or two tag providers: the 
internal tag provider and possibly an external tag provider. 

Internal provider keeps the tag configuration in the project. 
External provider stores tag configuration and values in a database.

Tags stored in an external provider are available to all Ignition installations that have access to that database. One of the installations can be 
specified as the tag's driver. The driving system has a copy of the scan class that it executes, which in turn evaluates the tag. The value is stored to 
the database and all of the other installations are notified of the new value.

There are several key execution modes to help create efficient projects. The different execution modes are as follows:

Direct executes based on the slow rate setting at a fixed rate.
Driven executes based on a condition.
Driven one-shot executes only once when a condition is true.
Leased executes according to on-demand polling.

Adding and Editing Scan Classes

You can add and edit scan classes by clicking on the  icon in the . The  window is displayed Edit Scan Classes Tag Browser Scan Class Editor
showing  a list of already configured Scan Classes on the left, and configuration settings on the right. To add a scan class, simply click the  green +
icon on the lower-left of the  and then specify the name and the properties for it.Scan Class Editor

Scan Class Editor

Edit Selected Scan Class

Sc
an 
Cl
as
s 
Na
me

Unique name of the scan class.

Mo
de

Direct
The scan class executes at a fixed rate, defined by the slow rate setting.

Leased
The scan class executes at the fast rate when any of the tags it contains are subscribed and visible in a Client window. If no tags are 
subscribed, the scan class runs at the slow rate.

Driven
The rate of the scan class is based on the value of a driving tag. The condition is a simple comparison between a tag value and a number. If 
the condition is true, the scan class will execute at the fast rate. If false, it will run at the slow rate. There are two exceptions to this: the Any 

 operator, and  mode. Using either of these, the scan class will not run at a rate. Instead, it will be triggered by a change in Change One-shot
the driving tag's value. Keep in mind that the driving tag can be an Expression tag that performs complex calculations and references other 
tags. In this way, it's possible to create robust scan class triggering.

Sl
ow
Ra
te

Base update rate, specified in milliseconds, at which tags will be executed.
 If the rate is set to 0, the scan class will not be executed. It is common for leased and driven modes to use 0 as a slow rate in order to Note:

achieve an   effect.on/off

Fa



st 
Ra
te

Used by the Driven and Leased modes, this is the faster rate that the tags will be executed at when those modes are active.
Note: If the rate is set to 0, the scan class will not be executed.

St
ale
Ti
me
out

How long to wait before the tags in the scan class are determined to be stale (not running). This is calculated off of the last expected 
execution time of the scan class, and is particularly important for scan classes executed by other drivers through the external Tags provider. 
This property is not used by internal providers.

Driven Properties

Used by the driven mode to determine when the scan class should run at the fast rate.

Dri
vin
g 
Tag

Which tag will determine when the rate of the scan class should be changed.

The Driving Tag should not use this same scan class. The Driving Tag should be on a separate scan class that runs at a faster rate than the 
Driven scan class. This means that changes to the Driving Tag will be recognized by the system faster, and the change in rate on the Driven 
scan class will occur faster.

Op
er
ator

How the Value property should be compared to the Driving Tag's value. If the comparison is true, then the Fast Rate will be used by the Scan 
Class. Otherwise, the Slow Rate will be used.

The Any Change operator works differently than the other operators: The scan class will execute immediately whenever the driving tag 
changes value. Using the Any Change operator means that the scan class no longer uses the Slow Rate or Fast Rate properties.

Va
lue

Used by the Operator property to determine if the Scan Class should execute at the slow or fast rate.

On
e-
sh
ot 
ex
ec
uti
on

One-shot will execute once when the comparison condition is true, and not again until the condition become false, and subsequently true.

Advanced Properties

Settings that subtly affect how the scan class operates.

O
PC
Da
ta 
Mo
de

This mode dictates how OPC values are obtained. The default mode,  , is generally recommended.Subscription

Subscribed
All OPC tags in the scan class will be subscribed according to the scan class rate. Values will come in asynchronously as they change.

Read
Tags will not be subscribed, but will instead be synchronously read each time the scan class executes. This operation is less efficient, but 
allows more precise control over when values are obtained. This mode is particularly useful when collecting data over a slow or 
expensive connection for display. When combined with the   execution mode above, and a static tag tied to a momentary button, it's one-shot
easy to create a manual refresh button on a screen that pulls data on-demand.

O
PC
Re
ad 
Aft
er 
Wr
ite

The following feature is new in Ignition version 7.8.0
 to check out the other new featuresClick here

When enabled, a read request will be sent immediately after a write request. This means that the value on the tag will be updated much 
quicker to reflect the latest written value.

Enabling this property is less efficient as a single write to a tag becomes two separate requests. This is especially helpful with slower 
scanclasses as it the tags will show the latest value quicker than the normal execution would allow.

Historical Scan Classes

Historical scan classes are simply standard scan classes used by Tags to store history. By using separate scan classes for status and history, it's 
possible to maintain a tag's status at a fast rate, without storing large amounts of history unnecessarily.

Despite the fact that there is not a technical differentiation between standard and historical scan classes, it is recommended that you create separate 
scan classes for each purpose and name them in a manner that indicates their usage. It is common to modify scan classes in order to affect a 
large number of tags, and without a consistent distinction it may be possible to affect tag execution in unexpected ways.

   

   

https://docs.inductiveautomation.com/display/DOC/New+in+this+Version#NewinthisVersion-Newin7.8.0


In this section ...

 

 



Types of Scan Classes
 

Scan classes dictate the execution schedule for tags, and therefore play a crucial role in the design of 
large, high-performance systems. Every tag has a scan class and that dictates how often that value is 
polled from a OPC location, how often an expression tag calculates its expression, or how often a query 
tag runs its query.

It is very easy to configure scan classes and there are four different types of scan classes you can use. 
From the , click on the  icon to open the ou can Tag Browser Edit Scan Class Scan Class Editor. Y
create new scan classes here and assign one of four types of scan classes. 

The four different scan classes that specify the rate of tag execution are as follows: Direct, Driven, Driven 
one-shot, and Leased. You specify these scan class types from the   setting on the Mode Scan Class 

.Editor

Direct

The scan classe executes based on the slow rate setting at a fixed rate. Every tag that uses the Direct 
direct scan class will poll the PLC at the slow rate setting 24x7x365 (at all times).

Driven

The Driven scan class executes based on a condition. The rate of the Driven scan class is 

based on the value of a driving tag which provides the condition. The condition is a simple comparison 
between a tag value and a number. If the condition is true, the scan class executes at the fast rate. If 
false, it runs at the slow rate.

There are two exceptions to this: the Any Change operator and one-shot mode. Using either of these, 
the scan class does not run at a rate. Instead, it will be triggered by a change in the driving tag's value. 
Any change will execute each time the value changes, and one-shot will execute once when the 
comparison condition is true and not again until the condition becomes false and subsequently true.

 It's useful to keep in mind that the driving tag can be an Expression tag that performs complex 
calculations and references other tags. In this way, it's possible to create robust scan class triggering.

 Every tag that uses the driven scan class, will poll the PLC at the fast rate when the condition is true and 
the slow rate when the condition is false.

Driven One-shot

The   executes only once when a condition is true.Driven one-shot

Leased

The  executes according to on-demand polling.Leased 

Types of Scan 
Classes

Watch the Video
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Setting a Tag's Scan Class
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1.  

2.  

3.  

Setting a Tag's Scan Class
 

Each tag in Ignition is assigned a scan class which dictates the polling rate and conditions on which the 
tag will be evaluated. You can specify both a realtime scan class and a historical scan class for each tag.

The four different scan classes that specify the rate of execution of tags are as follows:

Direct executes based on the slow polling rate setting at a fixed rate.
Driven executes based on a condition.
Driven one-shot executes only once when a condition is true.
Leased executes according to on-demand polling.

To set the scan class for a tag

Right-click on any tag and select . Edit tag(s)
The  window is displayed.Tag Editor
 
On the  tab, choose a scan class from the  drop-down for the selected tagGeneral Scan Class
(s).
For example, choose the  scan class.Default Historical
 
Click  to save it.OK

You will immediately see the tag updating at a different rate. The tag also uses the scan class to 
determine how fast to log data for the historian. The history scan class doesn't affect how fast 
the values get polled from the PLC, but affects how fast the data gets logged. You can select 
the history scan class on the  tab.History

 

Setting a Tag's 
Scan Class

Watch the Video
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Direct Scan Class

 

https://www.inductiveuniversity.com/video/setting-a-tags-scan-class/7.8


1.  

2.  

3.  
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Direct Scan Class
 

The direct scan class executes at a fixed rate, which is defined by the slow polling rate setting. Every tag 
that uses the direct scan class will poll the PLC at the slow rate setting 24x7x365 (at all times).

Ignition comes with two default direct scan classes called  and  . You can add Default Default Historical
new scan classes.

To add a direct scan class

Open the , in the , click on the  icon.Designer Tag Browser Timer

The  is displayed. On the left of the window, you can see the default scan Scan Class Editor
classes:  and . They are both direct scan classes. The  scan Default Default Historical Default
class is a 1 second rate and the   is a 10 second rate scan class.Default Historical

 
Click the  icon on the bottom-left of the window to create a new scan class.green +
 
From the  drop-down select  and set  to the number of milliseconds Mode Direct Slow Rate (ms)
you want to poll at.

 

Direct Scan Class

Watch the Video

 

 

https://www.inductiveuniversity.com/video/direct-scan-class/7.8


4.  Click .OK
That’s it! You have created a new direct scan class.
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Driven Scan Class - Machine State
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6.  

Driven Scan Class - Machine State
 

Driven scan classes set the polling rate (Fast Rate and Slow Rate) dynamically for tags based on a given 
condition, which is actually a logical comparison. Machine states being tied to a Boolean tag, as 
described below, is one example of a condition where the logic comparison is true when the machine 
state is ON. In simple cases, when the logic comparison is true, the Fast Rate applies, otherwise the 
Slow Rate applies.

To add a driven scan class based on the machine state

Lets add a driven scan class that updates the tags based on when the machine is ON.

In the Scan Class Editor, create a new scan class by clicking on the green + icon on the lower-
left of the window.
 
Name the scan class, for example, you can name it  , and set the  toDriven Machine State  Mode

. Driven
This scan class executes based on the condition you set on the  .Driving Tag
 
Click on the   icon next to the   box, and choose the tag you want to set the tag Driving Tag
condition on.
 
Set   to   and the   to  .Operator = Value 1
 
Set the   to 10,000 (10sec) and the   to 1000 (1sec).Slow Rate Fast Rate
When the machine is ON it will use the Fast Rate, when the machine is OFF it will use the Slow 
Rate.
 
Click  .OK
Now in the  you will see a check box next to the tag for which you have set the Tag Browser
machine state of ON and OFF on it.

Driven Scan Class - 
Machine State

Watch the Video
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Driven Scan Class - Manual Trigger
 

Driven scan classes can be used to allow operators to speed up or slow down polling rates on demand 
based on another trigger value. 

To add a driven scan class based on a trigger value

First we need to create the Trigger tag.

In the , right-click on the  folder, then go to  to Tag Browser Tags New Tag > Memory Tag
create a memory tag.
The Tag Editor window is displayed.
 
In , enter:Tag Editor
Name: Trigger
Value: false
Data Type: Boolean 

Click  to add the  tag to the . OK  Trigger  Tag Browser  
 

Now lets add a driven scan class that updates the tags based on the value of the Trigger tag we just 
created.

In the  , create a new scan class by clicking on the   icon on the lower-Scan Class Editor green +
left of the window.
 
Name the scan class, for example, you can name it  , and set the  to .Driven Manual  Mode  Driven

This scan class executes based on the condition you set on the  .Driving Tag
 
Click on the   icon next to the   box, and select the  tag you want to set tag Driving Tag Trigger
the condition on.
 
Set Operator to = and the Value to 1.

Set the Slow Rate to 4000 (4sec) and the Fast Rate to 500 (1/2sec, a very fast rate).

When the Trigger is equal to 1, it will use the  and you can see the values changing Fast Rate
very fast. When the Trigger is equal to 0, it will use the .Slow Rate
 

Click OK.
Now in the Tag Browser you will see a check box next to the Trigger tag for which you have set 
the on/off condition on it.

Driven Scan Class - 
Manual Trigger

Watch the Video
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3.  

Driven Scan Class - Time of Day
 

Driven scan classes can be used as the polling rate for tags to trigger at different rates at different times 
of the day. They can also be used as a one-shot event at a specific time.

To add a driven scan class

Let's add a driven scan class that updates the tags based on a time of day (using an expression). You 
can also use other tag values to drive the condition, for example when a machine is on.

First, we need a tag that provides the condition.

Create an  Tag in the root folder of  and call it  that is a Boolean with Expression Tags Poll Time
the following expression:

dateExtract(now(0), "hour") >= 8 &&
dateExtract(now(0), "hour") <= 17

The value will be true when the time is between 8am and 5pm and false otherwise. So with that 
tag we can poll the PLC values during that time.

Click on the  icon in the  to open the Scan Class Timer Tag Browser Editor.

Click on the  icon to add a new scan class and set the following:green +

Scan Class Name: Time Driven
Mode: Driven
Slow Rate (ms):  so we don't poll when the condition is false. If you set0
the value to 10 seconds it simply would just poll slower when the condition
is false.
Fast Rate (ms): 1000
Driving Tag:  expression tag and set the condition Operator:  and Value: .Poll Time = 1.0

Driven Scan Class - 
Time of Day

Watch the Video
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3.  

4.  
 
Click  to save.OK
Set the scan class on any tag to this one to update on this condition. If you use this scan class 
for history, the tag will only store history during those times.

 

 

Next ...

Driven Scan Class - One shot

 



1.  

2.  

3.  

Driven Scan Class - One shot
 

Driven scan classes can be configured as a . The One-Shot polling rate executes once when one shot
the comparison condition is true, and not again until the condition become false, then subsequently true.

The rate of the driven one-shot scan class is based on the value of a driving tag which provides the 
condition. The condition is a simple comparison between a tag value and a number. If the condition is 
true, the scan class executes at the fast rate. If false, it runs at the slow rate. There are two exceptions to 
this: the any change operator and one-shot mode. Using either of these, the scan class will not run at a 
rate. Instead, it will be triggered by a change in the driving tag's value. One-shot will execute once when 
the comparison condition is true, and not again until the condition become false and subsequently true.

To make a one-shot scan class

Let's make a one-shot driving scan class that only updates once when a memory tag goes to 1. We are 
using a memory tag so a user can change the value when they want to poll the PLC. Essentially, we can 
have a refresh button on the screen that allows the operator to poll the PLC once for the new values.

In the , click on the  icon to add a new scan class.Scan Class Editor green +
 
Set the following:

Scan Class Name: One Shot
Mode: Driven
Don't worry about the slow and fast rate since they are not used
Driving Tag: set to a memory tag (in this example ) and set the condition Operator: Memory Tag =
and Value: 1.0

Check the  box.One-shot execution

4. Click  to save.OK

5. Set the value of the memory tag to 1 and you will see the values update once. Set the value 
to 0 and back to 1 to see them update again.

Driven Scan Class - 
One shot

Watch the Video
 

 

 

 

 

   

 

Next ...

Leased Scan Class
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1.  

2.  

3.  

4.  

5.  

Leased Scan Class
 

Tags set to the  scan class execute/poll the PLC at the fast polling rate when they are subscribed Leased
and visible in a Client window, that is, when a Client needs the value. If the tags are not subscribed 
and the window or client is closed, the scan class runs at the slow polling rate.

To add a leased scan class

Let's add a new leased scan class that updates the tag at a 1 second rate when a client needs the tag 
and doesn't poll when the client is closed.

On the , click on the  icon to add a new scan class.Scan Class Editor green +
 
Set the following:
Scan Class Name: Leased
Mode: Leased
Slow Rate: 0
Fast Rate: 1000

 
Click  to save.OK
 
Set the scan class on the tags to use this new  scan class.Leased

The tags are only polled when a component that is bound to it is showing in a Client.
 
To verify that Ignition is working the way it should, go to the  tab of the Ignition Gateway Status
and click on the  link on the left side.OPC Connections
If nothing is active, the list is empty for the  scan class.Leased

As tags are needed, the list will fill in with only the tags that are currently being looked at.

 

 

Leased Scan Class

Watch the Video

 

 

 

 

Next ...

OPC-UA Stale Threshold
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1.  

2.  

OPC-UA Stale Threshold
 

Ignition uses the OPC-UA  setting to determine when updates from a driver have taken Stale Threshold
too long to complete. This time period will be calculated as the fastest sampling rate for that node 
multiplied by the  setting value.Stale Threshold 

Go to the  section of the Gateway, and then go to .Configure OPC-UA > Settings
The  page is displayed. Settings

Scroll down to the  section and then to the  setting.Other Stale Threshold
This is a multiplier by which the server determines that updates from a driver have become stale.

OPC-UA Stale 
Threshold

Watch the Video
 

 

 

 

 

Next ...

add link here
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System, Client, and Diagnostic Tags
 

Here is a brief description on each of the System, Client, and Diagnostic tags.

System Tags

System tags provide status about the system, such as memory usage, performance metrics, and so on. They exist for the Client and the 
Gateway. You can modify the Gateway system tags to perform alarming, history, and scaling, but you cannot modify the Client tags.

Client Tags

Client tags, as the name implies, are only available for use in the Clients. This means that their values are isolated to a Client runtime. Even 
though they are created in the Designer, each Client creates their own instances. This makes them very useful as in-project variables, for passing 
information between screens and between other parts of the Clients, such as scripting. Client tags are a hybrid of memory, expression, and SQL 
query tags. However, they do not have a scan class.

Diagnostics Tags

Every device connection in Ignition comes with several tags that provide diagnostic information, such as, if the device is connected, last time values 
were read, or last time a write occurred.

 

 

In this section ...

 



System Tags
 

System tags provide status information about the system, such as memory usage, performance metrics, 
and so on. They exist for the Client and the Gateway. You can change the Gateway System tags to 
perform alarming, history, and scaling, but you cannot change the Client tags.

Client and Gateway System Tags

Ignition comes with a number of predefined System tags to provide more information about the Client  
and the Gateway. In the , under the folder, you can see several  and Tag Browser System  Client Gateway
tags.
 

For , the System tags provide the following information:Client

Client IP Address
Client Hostname
Client OS
Who is logged in and what roles they have
Which project is opened
Gateway's address
and more...

For , the System tags provide the following information:Gateway

Database connection information
Ignition performance stats
Redundancy information
Number of client sessions opened
and more...

System Tags

Watch the Video

 

 

 

 

Next ...

Client Tags
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1.  

2.  

3.  

Client Tags
 

Client Tags, as the name implies, are only available for use in Clients. This means that their values are 
isolated to a Client runtime, and even though they are created in the Designer, each Client will create 
their own instances. This makes them very useful as in-project variables, for passing information 
between screens and between other parts of the Clients, such as scripting.

To create a Client tag

From the , right-click on the  folder and select .Tag Browser Client New tag > Client Tag

The  is displayed.Tag Editor

In the , for example, you can enter the following:Tag Editor

Name: Area
Value: Processing
Data Type: String
 
Click .OK
A new tag called   is created in the  folder.Area  Client

Client Tags

Watch the Video

 

 

 

 

Next ...

Using Client Tags for Indirection
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Using Client Tags for Indirection
 

Client tags can be used as a variable across all windows to indirectly point to a set of tags, such as an 
area of the plant. Suppose that a window has a drop-down that allows a user to select different areas of 
the plant. If the drop-down is bidirectionally bound to a Client tag's selected string value property, the 
user can change the drop-down's value, therefore resulting in the indirect binding throughout the project 
reflecting the change in the Client tag.

The Client tag can be bound to a Custom property on a window's Root Container. This Custom property 
can be bound to the Client tag. The components inside the window can have indirect binding on their 
properties that leverage the Custom property on the window. Therefore, the components on the window 
will be dependent on the Client tag. Client tags are managed inside the Client therefore each Client will 
be independent of other Clients.

 

Using Client Tags 
for Indirection

Watch the Video

 

 

Next ...

Device Diagnostic Tags
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1.  

2.  

3.  

Device Diagnostic Tags
 

Every device in Ignition's OPC-UA server exposes diagnostic tags that provide status and performance 
information about the device.

You add these tags into the tag database the same way you add tags from the actual PLC, that is 
through the . Under each device, you can see a special folder called . You OPC Browser [Diagnostics]
can drag any of the [Diagnostics] tags into the  .Tag Browser

In the [Diagnostics] folder, the most commonly used tag is the  tag because it tells whether Is Connected
Ignition is connected to the device or not.

       

Device Diagnostic 
Tags

Watch the Video

 

 

To use a diagnostic tag to show the PLC status

Let's use the   tag to show the status of each PLC.Is Connected

Create a folder in   to contain the status bits by right-clicking on the  folder and selecting .Tag Browser Tags New Folder
 
Name the folder  and click .Device Status OK
 
Drag in the  tag from the  device into the  folder.Is Connected CLX Device Status
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4.  

5.  

6.  

7.  

Right-click on the  tag and rename it to .Is Connected CLX

 
Repeat step 3 and 4 for all device connections you have in Ignition. If you have 5 devices, you will have 5 tags.

Now that we have a tag for each of the 5 PLCs, let's display the status of each PLC. For example in our  window, we can make a PLC Header
graphic and color it based on the state: , .0 = red 1 = green
 
In the , double-click the  window to open it.Project Browser Header

 
We will add a PLC graphic from Symbol Factory to the Header.
 
From the  menu, select  .Tools Symbol Factory



7.  

8.  

9.  

10.  

11.  

12.  

 
From the Symbol Factory window, select  in the list.Controllers
 
Drag any device on the window to create the component (the PLC graphic).

Symbol Factory components are made of several subcomponets or paths that make up a vector-based graphic. If you expand the component 
in the Project Browser, you can see all the paths. You can also double-click on the component in the design space to select the individual 
subcomponets. Fill color can be applied to each of these sub-components (or paths) dynamically through property binding. But there are two 
problems with applying color to the entire component. One is that you would have to change the fill color of each subcomponent dynamically 
through property binding which can take some time. Two, you will notice that you cannot bind the fill paint to a gradient color. To resolve 
these two problems we use a special method as described here to apply a tint to the entire component.
 
To apply tint to the entire component, duplicate the component by selecting it and then select  from menu or press Ctrl-D.Edit > Duplicate
 
Select the duplicated component, which is above the original component.
 
Select  from menu or click the  button in the toolbar.Shape > Union Union
This flattens the duplicated shape into a single shape.



12.  

13.  

14.  

15.  

 
Remove the outline of the shape by clicking on the pencil icon of the   property and selecting .Stroke Paint No Paint

 
Bind the  property to the  status tag. Notice when binding a color property to a tag, you get to choose a color for each state of Fill Paint CLX
the tag in . You can also make the colors to blink between two different colors.Number-to-Color Translation
 
In , set value , value , and alpha channel of each color to  (make sure each color is Number-to-Color Translation 0 = red 1 = green 30
semitransparent so you can see the actual symbol behind it).



15.  

16.  

17.  

 
Group the two components together into one by selecting both components from the Project Browser and clicking the  Component > Group
or Combine icon in the toolbar. Now they are one component.

 
 
To name the device, drag in the  component from the  tab into the window under the graphic.label Display



17.  

18.  

19.  

 
Set the label properties as follows:
Text: ControlLogix
Font: Dialog, Bold, 12
Foreground Color: 255,255,255
Horizontal Alignment: Center

Repeat for each PLC.



19.  

 
You can now see the status of each PLC based on the colors they display (0=red, 1=green).

 

 

Next ...

add link here

 



Tag Historian
   

Tag Historian™ makes it easier that ever to store and use historical data. Simply by selecting a check box on a tag, historical data is stored in 
an efficient format in your SQL database. This data is then available for querying through scripting, historical bindings, and reporting. The available 
options for partitioning and deleting old data help to ensure the system stays properly maintained with minimal extra work. Also, you can drag-and-
drop tags directly onto an Easy Chart to create trends or onto a table to display historical values. Tags Historian's robust querying features provide you 
great flexibility in how you retrieve the stored data.

The various aspects of how Tag Historian stores and queries data are described next.

Historian Providers

The settings for the Tag Historian providers are in the Gateway under . Historian providers are automatically created and removed Tags > History
according to the configured database connections. By default, they are created with a one month partition size, and will not delete old data.

Tag Configuration and Historical Value Generation

The first step to storing historical data is to configure tags to report values. This is done from the  page in the  in the Designer. The History Tag Editor
properties include a historical scan class, that will be used to check for new values. Once values surpass the specified deadband, they are reported to 
the history system, which then places them in the proper store and forward engine.

Data storage

As mentioned, the historical tag values pass through the store and forward engine before ultimately being stored in the database connection 
associated with the historian provider. The data is stored according to its datatype directly to a table in the SQL database, with its quality and a 
millisecond resolution timestamp. The data is only stored on-change, according to the value mode and deadband settings on each tag, thereby 
avoiding duplicate and unnecessary data storage. The storage of scan class execution statistics ensures the integrity of the data. While advanced 
users may change the table according to their database to be more efficient (for example, using a compressed engine), Ignition does not perform 
binary compression or encrypt the data in any way.

Table Partitioning

Ignition has the ability to automatically break up data into different tables of fixed duration. This can help make data maintenance easier, by preventing 
tables from becoming too large. Tables can easily be deleted in order to prune old data, and the database is able to better optimize access to 
frequently retrieved rows. The built-in partitioning feature can be used with any database.

It is important to note the difference between this feature and any partitioning options that the database might provide. Most modern databases offer 
their own faculties for defining "partitions", offering similar and greater benefits. While Ignition cannot use these features directly, advanced users may 
choose to apply these features on top of what Ignition currently offers.

Data Compression

As mentioned above, Ignition does not perform any binary compression on the data. That is, values are stored directly in standard database tables. 
However, to reduce the number of values stored, Ignition offers two different algorithms for pre-compressing the data (trimming unnecessary values). 
The two modes correspond to the value mode property of the tag: Discrete, and Analog.

Discrete 
The value uses a simple deadband, and is only stored when a new value is +/- the deadband value away from the previously stored value.

Analog
The deadband is used to form a corridor along the trajectory of the value. A new value is only stored when it falls outside the previous 
corridor. When this occurs, the trajectory is recalculated, and a new corridor formed.

See Value Mode, in   for more information about the difference between Discrete and Analog values.History Properties

Querying

While the data is stored openly in the database, the format does not lend itself well to direct querying. Instead, Ignition offers a range of querying 
options that are very powerful and flexible. In addition to the simple on-change querying, the system can perform advanced functions such as querying 
many tags from multiple providers, calculating their quality, interpolating their values, and coordinating their timestamps to provide fixed resolution 
returns.

Querying can be performed on tables and charts through the Historical Binding, and through scripting.

 

 

You must first install the  so that the standard Tag Historian features are added to Ignition and the Historian Tag Historian module
Providers show up in the Historian Configuration section of the Gateway.

https://legacy-docs.inductiveautomation.com/display/DOC/Tags+Intro#TagsIntro-HistoryProperties
https://legacy-docs.inductiveautomation.com/display/DOC/Tags+Intro#TagsIntro-HistoryProperties


In this section ...



Configuring Historian
 

You can configure the  in the  section of the Gateway by going to  . A History Provider is  Database Tag History Provider Configure Tags > History
created automatically for each database connection, and will be removed if the connection is removed. Although enabled by default, the providers 
won't interact with the database unless data is logged to them.

Main

Data
Con
necti
on

Name of the Data Connection for the Tag History Provider.

Ena
bled

If the check box is selected (enabled), the provider is turned on and accepts tag history data.

If disabled, the database is not shown in the list of history providers when configuring tag history from the Designer. Also, any data logged to 
the provider, will error out and be quarantined by the store and forward engine, if possible.

Data Partitioning

Ena
ble 
Parti
tioni
ng

T ag Historian can partition the data based on time. Partitions will only be queried if the query time range o improve query performance, T
includes their data, thereby avoiding partitions that aren't applicable and reducing database processing. On the other hand, the system must 
execute a query per partition. It is therefore best to avoid both very large partitions, and partitions that are too small and fragment the data 
too much. When choosing a partition size, it is also useful to examine the most common time span of queries.

Parti
tion 
Leng
th 
and 
Units

The size of each partition, the default is one month. Many systems whose primary goal is to show only recent data might use smaller 
values, such as a week, or even a day.

Data Pruning

Ena
ble 
Data
Prun
ing

Partitions with data older than a specific age are deleted. The check box is not selected/enabled by default.

   Data pruning works by deleting old partitions. Therefore, data will only be removed when a partition has no data younger than Important:
the prune age.

Prun
e 
Age 
and 
Units

The maximum age of data. As mentioned, the data is deleted by the partition, and could therefore surpass this threshold by quite a bit 
before all of the data in the partition is old enough to be dropped.
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

Set up Tags to Log
 

Logging data is easy with Tag Historian. Once you have a database connection, all you do is set the tags 
to store history and Ignition takes care of the work. Ignition creates the tables, logs the data, and 
maintains the database.

As mentioned previously, the historical tag values pass through the store-and-forward engine before 
ultimately being stored in the database connection associated with the historian provider. The data is 
stored according to its datatype directly to a table in the SQL database, along with its quality and a 
millisecond resolution time stamp. The data is only stored on-change, according to the value mode 
and deadband settings on each tag, thereby avoiding duplicate and unnecessary data storage.The 
storage of scan class execution statistics ensures the integrity of the data.

To log tag history data

Do the following steps to log history data for your tags:

Go to the Designer, from , select one or more tags.Tag Browser
For example, select all the  tags in the Sine folder.Sine
 
Right-click on the selected tags, and then select .Edit tag(s)
The Tag Editor window is displayed. Here, you can edit the tag and change the name, data 
type, scaling options, metadata, permissions, history, and alarming.

 
Click on  on the left side of .History Tag Editor
 
Click  for .Yes Store history for this tag
 
Choose a database from the  dropdown.History Provider
For example, choose  as the database you want to log to. mysql
 
Choose  for .Default Historical Scanclass
This sets the rate at which data is logged. The default is set to 1 second which means data is 
logged every second.

 
Click .OK
Now look in the , to the right of each  tag that is storing history, an icon Tag Browser Sine
appears letting you know it is setup.

Set up Tags to Log

Watch the Video

To Continue on the 
step-by-step simple 
workflow...

After you  , as History to the Tags
described on this page, click the link 
below for Step 8 to continue.

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

https://www.inductiveuniversity.com/video/set-up-tags-to-log/7.8


7.  

If you were to look in your database, you can see all the tables and data Ignition has created for 
you.

Next...

Add History to Tags in UDT

 

   



1.  

2.  

3.  

4.  

5.  

Add History to Tags in UDT
.

 

You can set the UDT to log history data, then all the instances of that UDT will log data without having to 
edit the individual instances.

To set the UDT to log history data

Right-click on the UDT (for example, a Motor UDT) and select Ed
it tag(s).
The Tag Editor is displayed. 
In Tag Editor, click a tag (for example, the AMPS tag), select His
tory, and set Store history for this tag to Yes.
Set the following in Tag Editor and click Apply:
History Provider: mysql
Historical Scanclass: Default
Value Mode: Analog
Do the same for the HOA tag but set Value Mode to Discrete 
because HOA is a discrete state.

Click OK to save.
Now every motor instance automatically starts logging data.

Add History to 
Tags in UDT

Watch the Video
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Next...

Discrete vs. Analog Mode

 

 



Discrete vs. Analog Mode
 

Ignition offers two different algorithms for pre-compressing the data (trimming unnecessary values). The 
two algorithms corresponding to the two value mode properties of the tag are: Discrete and Analog.

The value mode (Discrete or Analog) dictates the type of value that the tag represents, affects how the 
deadband is applied to values, and how interpolation is performed when querying.

Discrete 
The value uses a simple deadband and is only stored when a new value is + /- the deadband 
value away from the previously stored value.
 
Analog 
The deadband is used to form a corridor along the trajectory of the value. A new value is only 
stored when it falls outside the previous corridor. When this occurs, the trajectory is recalculated 
and a new corridor is formed.

Typically,  is used for boolean or integers that represent state, and  is used for floats or Discrete Analog
integers that change more often (which is why you want to perform compression).

You choose and set the  on the  section of the  window.Value Mode History Tag Editor

While advanced users can change the table according to their database to be more efficient (for 
example, using a compressed engine), Ignition does not perform binary compression or encrypt the data 
in any way.

Discrete vs. Analog 
Mode

Watch the Video
 

 

 

 

 

 

Next...

Store and Forward
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Store and Forward
 

The Store and Forward system provides a reliable way for Ignition to store historical data to the 
database. Systems such as the Tag Historian and Transaction Groups use this system to prevent data 
loss and store data efficiently using a record cache.

For more information on Store and Forward, see the following sections:

About Store and Forward
Using Store and Forward
Configuring Store and Forward
Controlling Quarantine Data Store and Forward

Watch the Video
 

 

 

 

 

 

Next...

Data Partitioning and Pruning

 

 

https://www.inductiveuniversity.com/video/store-and-forward/7.8


1.  
2.  

3.  

Data Partitioning and Pruning
 

Tag Historian will partition data into separate tables according to the time setting so that one table 
doesn't grow indefinitely, and then will delete old data to ensure the system is maintained for query 
performance. The data prune feature will delete partitions with data older than a specific age/time.

To partition and prune data

Go to the  section of the Gateway.Configure
Select  from the menu on the left.Tag > History
The  page is displayed. You can see the Databases that have Database Tag History Providers
Enabled tag history on and their Status shows as Running.
Click on   at the far right of the database you want make changes to.edit

Main

Dat
a 
Co
nne
ction

Name of the Data Connection for the Tag History Provider.

En
abl
ed

By default, the check box is selected (enabled) meaning the provider is turned on and 
accepts tag history data.

Data Partitioning

En
abl
e 
Par
titio
ning

By default, partitioning is enabled to improve query performance. Tag Historian 
partitions and breaks up the data into separate tables based on time. Partitions will only 
be queried if the query time range includes their data, thereby avoiding partitions that 
aren't applicable and reducing database processing. On the other hand, the system 
must execute a query per partition. It is therefore best to avoid both very large 
partitions, and partitions that are too small and fragment the data too much. When 
choosing a partition size, it is also useful to examine the most common time span of 
queries.

Par
titio
n 
Len
gth 
and
Uni
ts

The size of each partition, the default is one table per month. Many systems whose 
primary goal is to show only recent data might use smaller values, such as a week, or 
even a day.

En
abl
e 
Pre
-
pro
ces
sed
Par
titio
ns

This option is not selected by default. Pre-processed partitions will use more space in 
the database, but can improve query speed by summarizing data, reducing the amount 
that must be loaded.

Pre
-
pro
ces
sed
Wi
ndo
w 
Siz
e 
(se
con
ds)

When pre-processing is turned on, the data will be summarized into blocks of this size

Data Pruning

Data Partitioning 
and Pruning

Watch the Video
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3.  

En
abl
e 
Dat
a 
Pru
ning

The check box is not selected/enabled by default. Partitions with data older than a 
specific age are deleted and if the data is not archived, the data is then lost.

Important: Data pruning works by deleting old partitions. Therefore, data will only be 
removed when a partition has no data younger than the prune age.

Pru
ne 
Ag
e 
and
Uni
ts

The maximum age of data. As mentioned, the data is deleted by the partition, and 
could therefore surpass this threshold by quite a bit before all of the data in the partition 
is old enough to be dropped.

 

 

History Table Timestamps

If you've looked behind the scenes of SQLTags Historian, you've probably noticed the timestamps are not stored as standard SQL timestamps. They 
are stored in a variant of Unix Time, or the number of milliseconds since January 1, 1970 00:00:00. The time may come when you need to convert that 
timestamp to a more human-readable format. This article will quickly cover how to do it in MySQL and MSSQL.

MySQL
It's pretty easy to deal with unix timestamp in MySQL because they have a built-in function for doing so. The FROM_UNIXTIME() function will take in a 
unix timestamp and spit out the current timestamp.
Usage:  

SELECT FROM_UNIXTIME(t_stamp/1000) FROM sqlt_data_1_2016_08

MSSQL
In Microsoft SQL Server, it's a little more verbose. We use the DATEADD() function to figure out the timestamp.
Usage:

 

SELECT DATEADD(s,t_stamp/1000,'1970-01-01 00:00:00') FROM sqlt_data_1_2016_08

 

Next...

Tag History Splitter

 

 



1.  

2.  

3.  

4.  

5.  

Tag History Splitter
 

You can have the tag history data be logged in two different database providers by downloading and 
installing   the Tag History Splitter module.

To use the tag history splitter

Once the module is installed, to create the additional tag history provider, do the following steps:

Go to the   section of the Gateway, and choose   from the menu on the Configure Tags>History
left.
 
Go to the bottom of the  page, and click  Database Tag History Providers Create new 

.Historical Tag Provider
The Add Historical Tag Provider Step 1: Choose Type page is displayed.
 
 Select  and click .Tag History Splitter Next
The New Historical Tag Provider page is displayed. 
 
Enter a name for the , and from the dropdown choose a database for the Provider Name First 

 (for the primary data) and one for the   (for secondary data).Connection Second Connection
 
Click .Create New Historical Tag Provider
Now the splitter tag provider is created and you can use it to log the tag history data in the 
Designer.
Check this by going back to the Designer, selecting a tag and then right-clicking to select the 
Edit tags. On the Tag Editor window go to the History tab and see the new splitter provider in 
the dropdown of the History Provider.

Tag History Splitter

Watch the Video
 

 

 

 

 

 

 

 

Next...
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Historian Charts
   

Use the EasyChart™ component in the Designer to display historical data or realtime data depending on the range of your time selection. Simply drag-
and-drop history-enabled tags onto a chart to create chart pens and data trends. 

Let's look at trending tags and displaying the information in a graph. In both of the following examples, data was logged first.

Example 1

Here is an EasyChart example of raw ( ) vs. compressed ( ) data using the analog mode:blue red

 

Example 2

Here is another example:

 

 

In this section ...

   



   



1.  

2.  

3.  

Basic Easy Chart
 

The  component allows you to make powerful and runtime-configurabEasy Chart le timeseries charts
/graphs from the Tag Historian data. 

Creating a Tag History Graph

You can see the tag history data, by creating a graph. Your graph can include subplots, axes, and a 
moving average pen. You can view the runtime data in realtime or historical mode.

To create a tag history graph

Open Main Window 2, from the Charts tab of the Component Palette, drag in the Easy Chart 
component.

We can add the tags to the graph the same way we created the status and control windows, 
that is, through drag and drop.
 
Drag all the Sine tags from Tags Browser to the graph.

 
The tags are displayed on Main Window 2 but because we have just started logging data, not 
much data shows up.
 
To show more data, set the Chart Mode property of Easy Chart to Realtime.

Basic Easy Chart

Watch the Video

 

 

The step-by-step 
simple workflow...

After you Create a Graph and View 
, you have Graphs in Clients

completed the "simple workflow", so 
Congratulations!

Step 1. Launch the Gateway

Step 2. Connect to a Device

Step 3. Connect to a Database

Step 4. Launch the Designer

Step 5. Create Tags

Step 6. Launch Clients

Step 7. Add History to Tags

Step 8. Create a Graph and View 
Graphs in Clients

   

 

Next...

Easy Chart - Axes
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Easy Chart - Axes
 

The Easy Chart supports the use of multiple axes for displaying data from the Tag Historian.  Drag your 
tags over from the Tag Browser to your Easy Chart that you want to display.  Make sure your tags are 
logged in the Tag Historian.   Now, let’s look at how we can configure multiple axes on an Easy Chart 
component. 

The following chart shows 2 tags:  Sine 1 and Sine 2.  They both have completely different value 
ranges.  Sine 1’s values range between -10 and 10.  Sine 2 values range between -100 and 100.   Since 
both Sines are on the same axis, it is hard to see the details of Sine 1’s values since Sine 2 is throwing 
off the axis because of its wide range of values. 

 

You have the option of putting your tags into different axes.  You can do that in the Customizer of the 
Easy Chart component.     on the  and scroll down to Right click Easy Chart component Customizers > 
Easy Chart Customizer.

Click on the Axes tab so you can add on one or more axes to your component.   There is already one 
axis showing called Default Axis.  Both of the Sine tags are sharing the Default Axis.   

Easy Chart - Axes

Watch the Video
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On the top right of the Easy Chart Customizer screen, to add a new axis.  Call this click the green arrow 
Sine 1.  The Label is the label name that will be displayed on your chart. Call this Sine 1 as well. 

The axis can be a Numeric, Logarithmic or Symbol.  Make Sine 1 a   You can specify the ‘Numeric.’
colors on the ,  and .   In this example, make them all red. Label Tick Label Tick Color

You will notice that the  dropdown is disabled.  There is an property in  Position Auto Axis Positioning  
the Property Editor of the Easy Chart component that is true by default.  If you turn off Auto Axis 

, you can then specify the left/right position of each of the axes.Positioning

You can also specify the axis Range to be  on or not.  If you don’t set Auto Range, you can Auto Range
enter lower and upper bound values.  If you set Auto Range to , you can enter a margin value ‘True’
which is a plus or minus value for the top and bottom of the chart so you get a little padding.  The margin 
value will enable you to see the entire trend so the values don’t go all the way to the very top or bottom of 
the chart.    to  and the  to Set the Auto Range  ‘True’ Auto Range Margin ‘0.05.’ 

You can set some tick units if you want and then   Press OK.

 

Now you have 2 axes, one for Sine 1 and another for Sine 2.   , Click on the Pens tab for Sine 1 select 
then  to change the Axis.  Select the  Axis from the the Tag row click the Edit Pen icon ‘Sine 1’ 

dropdown menu and . click OK



 

Now repeat the steps for Sine 2.  You can leave the  as , Click on the Axes tab.  Name ‘Default Axis’
and enter a  and call it   Keep the  as You can specify the colors on theLabel ‘Sine 2.’ Type ‘Numeric.’    

,  and .   In this example, make them all blue and click .  Label Tick Label Tick Color  OK

 

For the Sine 2 pen, we don’t need to change the Axis because we left the default name and only 
changed the Label to   To check, , then ‘Sine 2.’ click on the Pens tab for Sine 2 select the Tag row clic

 to change the Axis, otherwise, the will remain the default.   k the Edit Pen icon ‘Default Axis’ Click OK
and now both axes are different. 



 

Once you press OK, you will immediately see Sine 1 and Sine 2 values change on the Easy Chart.  On 
the right side of the chart, you can see the Sine 1 label and values.  On the left side, you can see Sine 2 
label and values.  Now, you are using a different axis for each tag.  

 

Go to  ,   and Preview Mode uncheck Sine 2 cli
.  Now, the Easy Chart will only show ck Apply

the Sine 1 axis for the Sine 1 values. 

To see the chart for Sine 2 only,  , check Sine 2
 and  .   You will uncheck Sine 1 click Apply

only see the values for Sine 2 which is on the 
Default axis.  

 

 

When looking at both axes in  , you will see both values.  Now, one Sine is not going to Preview Mode
throw off the values for the other Sine.   Select both pens and  .click Apply

 



 

Symbol Axis Type Example

Another feature of the Easy Chart is the use of the  axis type   The second subplot in this Easy Symbol .
Chart uses a Multi-State Button component to demonstrate the use of the  type. The Multi-State Symbol
Button component is bound to a tag named 'WritableInteger2'. Instead of using the default Numeric axis 
type to record the component's state as ' ,' you can use , , and  simply by typing the text 0, 1, 2 On Off Auto
in the Symbols field.  This is helpful to an operator who immediately knows the state of the equipment 
instead of having to learn what the numeric values mean.

 

Go to the , click on the  and edit  for the WritableInteger2 pen.  In Easy Chart Customizer Axes tab Axis
this example, it is the Default Axis with the State label.  You will notice that the type of axis selected is 
Symbol, lower and upper bound limits were set to provide a little padding at the top and bottom of the 
chart, and  were entered in the  field.  When entering text in the Off, Auto, Hand Symbols/Grid Bands
Symbols/Grid Bands field, always enter the text separated by a comma, and no spaces. Click two OK 
times.   

 



 

Put your chart in and begin toggling the Multi-State buttons.  You will then begin logging Preview Mode 
data to your Easy Chart.  Data for the Multi-State Button component is collected in the second subplot 
which is using the Symbol axis type. The first subplot is data for another tag using the Numeric axis type.

This Easy Chart example shows the  of the Easy Chart component and how easy it is to subplot feature
break up the chart plot area into multiple distinct subplots sharing the same X axis. It is a good way to 
display lots of data from different tags in one Easy Chart.

  

 

Next...

Easy Chart - Subplots

 

 



Easy Chart - Subplots
 

The subplot feature of the Easy Chart component allows you to break up the chart plot area into multiple 
distinct subplots that share the 'X' axis, but they have their own 'Y' axis.  By default, the Easy Chart has 
one subplot which is the main white area shown in the example below.  Both of the Sine tags are inside 
this chart which is why you are seeing the history for both tags in this one area.  

 

It’s possible to break up your tags into multiple subplots which is often useful for digital data.  In this 
example, the Sine 1 tag represents digital data in the very center of the chart, but perhaps you may want 
it to be its own subplot.   on the   and scroll down to Right click Easy Chart component Customizers > 

. Easy Chart Customizer

 

 The Subplots tab allows you to add one or more subplots to your Easy Chart.  In this example, there is 
one subplot with a Relative Weight of 1 and a white Background.  

 

Easy Chart - 
Subplots

Watch the Video
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 to add a second Subplot and specify the Weight and the Custom Click on the green plus icon
Background.  The Weight is the ratio between all the subplots.  So, if you make the second subplot a 1:1 
ratio, both subplots will share 50% of the space on the chart.  In this example, make Subplot 2’s Relative 
Weight and Subplot 1’s Relative Weight , then Subplot 1 will be 3 times larger than Subplot 2.   This ‘1’ ‘3’
is very common for digital data.  

 

Now, we have to put one of the pens into a different subplot.    Click on the Pens tab and select Sine 1.
Since Subplot 1 contains digital data, edit that pen to put it into Subplot 2.  Increment the spinner to  or ‘2’
type the value  in the Subplot field.  .  ‘2’ Press OK

 

 again and now you have 2 different distinct plots on the Easy Chart.   The second subplot on Press OK
the chart has the digital data values and the top subplot has the Sine 2 tag values.  You are not limited to 
the number of subplots on one Easy Chart.  



You can view one subplot at a time by  in the Pens box and clicking .  The unchecking the tag  Apply
Easy Chart only shows subplots that have active tags.  

 

 

 

Next...

Easy Chart - Pen Names and Groups

 

 



Easy Chart - Pen Names and Groups
 

You can organize pens on the Easy Chart by providing custom names and groups for each pen. By   
default, when you drag tags from the Tag Browser on to the Easy Chart component, the pen name is the 
same as name as the tag name.  Also by default, all pens are placed into a single category called ‘Pens.’

You may want to customize pen names and organize pens into different groups to make it easier for the 
operator.  You can do this in the Customizer.   and Right click on the Easy Chart component scroll 
down to Customizers > Easy Chart Customizer.  

On the , you can edit each of the individual pens and give them a different name as well as put Pens tab
them inside a different group. 

Click the Edit icon and rename the first tag from  to  as shown in the following ‘Ramp0’ ‘R 0’
example.   At the bottom of the , under , create a new group called Edit Pen window Group Name ‘Ramp

If other groups exist, you can select one from the dropdown list.   In this example, this is the first s.’  
group to be created, so simply type  and . ‘Ramps’ press OK

Select the second pen and .    to  and put it under the click the Edit icon Rename ‘Ramp1’ ‘R 1’ ‘Ramps’ 
group by selecting it from the dropdown list, and .press OK

Easy Chart - Pen 
Names and Groups

Watch the Video
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 Let’s do the same for the last Ramp pen.   and   to  and put it Click the Edit icon rename ‘Ramp2’ ‘R 2’
under the group, and ‘Ramps’ click OK.

For the Sine names, keep the names the same and create a new group.   and .Select Edit the fourth pen
  Create a new  and call it and   Group Name ‘Sines,’ press OK.

Edit the remaining Sine pens and put each Sine pen into the  group using the dropdown list, and ‘Sines’ p
.  ress OK



Now that you customized the Name and the Group for each of the pens, you can see under the Pens tab 
all your updates in one view.   You can also change the pen and group names on this view by selecting 
the pen you want to update and editing the Name and/or the Group.  It’s a faster way to edit the Name 
and Group then having to go to the Edit icon for each pen.   Once all your edits are complete, click OK.

Now you see all the pen names that the operators will see on the Easy Chart as well as the 2 new groups 
for your pens:    and   ‘Ramps’ ‘Sines.’

 

Next...

Easy Chart - Pen Renderer

 

 



Easy Chart - Pen Renderer
 

You can customize the renderer of each pen on the Easy Chart to change its style, shape, weight and 
color.  When you add tags to an Easy Chart component, the default renderer or the style of each pen is a 
simple line as you can see in each of the subplots in the example below. 

 

To customize the pen renderer,  and scroll down to  right click on the Easy Chart component Customiz
. ers > Easy Chart Customizer

In the Pens tab, go to each of the pens and .  On the right side of the Edit Pen click the Edit Icon
window under Style, you can change the line color, style, weight, and shape.  The Style, by default, is ‘Lin

which means that if you lose communication to the PLC or don’t have data for a particular e with Gaps,’ 
time period, you will see a gap.  You can change the Style from ‘Line w/ Gaps’ to any other style type 
listed in the dropdown that fits your needs and preferences.   In this example, let’s change the pen 
renderer for the 3 subplots on this Easy Chart.

Select the first pen, click the Edit Icon and change the color to your choice and change the Style to ‘Ar
  You can preview your changes in the Preview field and . ea.’ press OK

Select the second pen, change the color, and set the Style to  since it’s a State tag (On or Off / ‘Digital’
0 or 1).  Preview your changes and . press OK

Easy Chart - Pen 
Renderer

Watch the Video
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Select the third pen, change the color and keep the default Style to    Preview your ‘Line w/ Gaps’.
changes and .  Once you set the Style of all 3 pens, . press OK click OK

Now, your customized changes to the pen renderer for these 3 pens will be reflected on each subplot on 
the Easy Chart.

 

 

Next...

Easy Chart - Digital Offset

 



 



Easy Chart - Digital Offset
 

Digital pens often share the same subplot on the  component. Easy Chart  You can offset digital pens in 
the subplot order to see the values better.  

The Easy Chart below shows 2 digital pens on the same subplot: State 2 and State 3.  The values are 
difficult to see because they overlap on top of each other.  

 

We can apply a digital offset on our digital renderer so we can see the values better.   on the Right click E
 and scroll down to . asy Chart component Customizers > Easy Chart Customizer

In the Pens tab, go to each of the State pens and  to and . check the ‘Digital Offset’ box ‘true’ click OK
   

 

 

 

Easy Chart - Digital 
Offset

Watch the Video
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You will see a little offset in the values between the State pens so they don’t overlap making it a lot 
easier for the operator to read the digital values.

 

 

 

 

Next...

Easy Chart - Calculated Pens

 

 



Easy Chart - Calculated Pens
 

Calculated pens display a value that is dynamically calculated based on another pen, such as a Moving 
Average or an SPC Function including a Constant value, Upper Control Limit (UCL), Upper Warning Limit 
(UWL), Average (Avg), Lower Warning Limit (LWL), Lower Control Limit (LCL), Multiply, Min, and Max.

Using calculated pens on an Easy Cart component allows you to lay a graph on the calculation based off 
of another pen selected from the Function dropdown list in the Easy Chart Customizer.

To add a calculated pen, r , and ight click on the Easy Chart component scroll down to Customizers 
> Easy Chart Customizer.   

At the bottom of the Pens tab there is a table for all the Calculated Pens.  You can add one or more 
calculated pens by clicking the green plus icon.   

As you add new pens from the the Edit Pen window, you need to give each pen a name.  They are just 
like other pens where you can specify the Style, Color, Axis and Subplot.  In the Function dropdown list, 
you can select which calculation you want to use.  The type of functions are: Constant, UCL, UWL, Avg, 
LWL, LCL, MovingAvg, Multiply, Min and Max.

In this example, add a pen called    , set the Constant ‘High SP.’ In the Function field, select ‘Constant’
value at , make the line color ,  and .   again. ’40’ ‘red’ press OK Press OK

A red horizontal line will be drawn at the value of 40 on the Easy Chart for the High SP value.  

Easy Chart - 
Calculated Pens

Watch the Video
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Add a second calculated pen and call this one a  ‘MovingAvg.’

On the Edit Pen window, name your pen , select ‘Moving Average.’  In the Function field ‘MovingAvg’
from the dropdown list.  Set the Driving Pen to    Specify the  to the percentage  ‘Realistic0.’ Window Size
of the total time period that you are going to do a Moving Average on.  For this example, set it to 20 

and .  percent (0.2) press OK

Let’s add 2 more calculated pens.  Call the third pen ’  ,  from the  ‘UCL. In the Function field select ‘UCL’
dropdown list and set the Driving Pen to .    ‘Realistic0’ Press OK.



Call the fourth pen   and set the Driving Pen to   ‘LCL.’   In the Function field, select ‘LCL’ ‘Realistic0.’ P
ress OK.

Once you added all your pens, you will see all 4 pens listed under the Calculated Pens table:  High SP, 
MovingAvg, UCL and LCL.    Press OK.

Now you see all your calculations displayed on the Easy Chart.  The green pen is your Moving Average 
of that value.  The UCL and LCL are displayed by pink and blue pens respectively, as well as the 
Constant value displayed with a red line at 40.



 

Next...

Ad Hoc Charting

 

 

Note

You cannot bind the Calculated Pen values inside the Easy Chart Customizer. To bind the 
function values, use the .Cell Update Binding



Ad Hoc Charting
 

In Designer, we can effectively make an Ad Hoc Chart where we can pick and choose which pens we 
want to put on the chart.   We can provide this same functionality for an operator in the Runtime by using 
a special built-in component called the Tag Browser Tree.  

Drag the Tag Browse Tree component  to the left from the Tables Tab of the Component Palette
side of the chart.  The Tag Browser Tree component can give an operator the same functionality as the 
Tag Browser in Runtime or Preview Mode.  Expand the folders to see all the tags in your system.  By 
default, the Tag Browser Tree component shows you all tags even those tags that are not logged in 
Historian.   

 

There are a couple of properties worth mentioning that will help you select tags on the Tag Browse Tree 
component.  There is an  property in the Property Editor on the bottom left that ‘Include Realtime Tag’
you can uncheck to not include Realtime Tags in the event you only want to see Historical tags.  In this 
example,   There is also another property called whuncheck ‘Include Realtime Tags.’ ‘Selection Mode’ 
ere you can make a single tag selection or you can select multiple tags.  Select ‘Multiple – 

from the dropdown. Discontiguous’ 

 

By adding the Tag Browse Tree component on the window, each of the components knows exactly how 
to work together.  Format the Tag Browse Tree component, pens and graph so you can see all three 
nicely on the window.   and go into the  or . Click Save Runtime Preview Mode

 

Now, you can browse for tags in the Tag Browse Tree.  Select one tag or multiple tags and drag them on 
to the chart to make an Ad Hoc Chart.  In this example, the   and  tags were randomly ‘Ramp’  ‘Sine’
selected to create the following Ad Hoc Chart. 

You can press the icon to the right of any of the pens to remove a tag from the chart.  You can also ‘X’ 
remove all pens and go back to an empty chart, and pick and choose which of the tags you want to drag 

Ad Hoc Charting

Watch the Video
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on to the chart, thus, creating an Ad Hoc Chart.   

 

When working in the Designer, whatever pens you have on your Easy Chart when you saved, the same 
pens will also be displayed on the chart when the client is opened.  

You may have multiple axes set up for your Easy Chart, but when dragging tags from the Tag Browse 
Tree component to an Easy Chart there is no way for the user to set which axis to use. Because of this 
limitation, any tag that is added in this way will attempt to match their Engineering Units property to an 
axis on the chart. If no match is found, the default axis will be used.

 

Next...

Indirect Easy Chart

 

 



Indirect Easy Chart
 

It is possible for the Easy Chart component to be indirect and point to a set of historical tags based on 
any parameter using the Cell Update Binding type.

In this exercise, we are going to use a Tank dropdown list so an operator can select a specific tank and 
see the history of the  and  tags for that tank.   We will be using Tank 101 to Tank 105 level_PV temp_PV
for this example.  Fill in your dropdown component’s data property as shown below.

Every tank is identical and has the same tags.  They have a  tag and a  tag which are level_PV temp_PV
set to log to the Historian as you can see by the scroll icon next to the tag name.  Once you have Tank 
101 selected, drag these 2 tags on to your chart so you can see the tank’s history.

Right click on the  and scroll down to  and you will Easy Chart Customizers > Easy Chart Customizer
see that the Tag Path is pointing to directly to Tank 101.  The only difference between Tank 101 and the 
other tanks is the Tank number in the Tag_Path.  You can manually point to a different Tag Path by 
replacing  in the Tag Path with a different tank number such as  ‘101’ ‘102.’  Click OK.

Now lets use the Cell Update Binding type to change the Tag_Path.  Go to your Easy Chart component 
and scroll down the  to the property called .  You will notice that the Tag Pens Property Editor Tag Pens
property is a Dataset.  

Indirect Easy Chart

Watch the Video
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1.  
2.  
3.  
4.  

5.  

6.  

7.  

8.  

Click on the  and you will see 2 rows.  The second column is the Tag_Path that you need to Dataset icon
modify for each row in order for it to change dynamically when an operator selects a different tank.  Click 
OK.

To change an individual cell of a dataset, you have to bind a dataset to a Cell Update Binding.  In a Cell 
 you can select one or more cells and dynamically bind them to a property or to an Update Binding,

existing tag in the system.  To change the  and  tag paths dynamically, use the temp_PV level_PV
following instructions:  

Click on the  for the Tag Pens property.Binding icon
When the Property Binding window opens, click  the  button.Cell Update
In the Dataset table, select the first row under the Tag_Path column for . level_PV
Click the  under the Cell Binding table.  A row will be added in the Cell Bindings green plus icon
table for .   level_PV
Repeat steps 3 and  to add a second row under the Tag_Path column for .   4  temp_PV

 
Now, you need to update the Value column in the Cell Bindings table for each tag.  Select the 
first row under the Cell Binding table and  on the right side of the window.  click the Link icon
When the property window opens, navigate to  and click on theRoot Container > Dropdown  

.   . 'Selected String Value' Click OK



8.  

9.  

10.  

Repeat steps 6 and  to add the second row under the Cell Bindings table.  7

 

Next, under the Cell Bindings table, update the Value column with the folder path and tag name 
for each row.  The first row at the top is the level_PV tag and the second row is temp_PV based 
on the row indexes.  Double click on the first row and enter the highlighted text as shown below 
to match your tag paths.  Repeat this step for the second row.   

 
 
Once you added the folder path and tag name for each row, .  click OK

Now the chart is indirect and when an operator selects a different tank, the  and  tags level_PV temp_PV
will change.  

Go to your dropdown list and change from  to . You will see the history for  Tank 101 Tank 102  Tank 102
come through on the chart.  



Once again, go to your dropdown list and select  confirming that the  and  Tank 105 level_PV temp_PV
tags are pointing to the correct values for that tank by looking at the Dataset property. 

 

 



Historian Tables
   

Use the Table component in the Designer to display the historical data. Easily drag-and-drop historian-enabled tags onto a table to display historical 
values in many different ways depending on how you have customized the table.

   

   

In this section ...  

   

   



1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

Table - Most Recent
 

You can use the  binding type to bring back the most recent history for a set of tags.Tag History

To bring back the most recent history

Drag a   (or a Power Table) from the Component Palette into your window.Table
 
In the Property Editor, go to the   property, and click the binding icon.Data
The Property Binding window is displayed. 

Select the   option.Tag History

From  , find the desired historical tags by selecting and expanding the Available Historical Tags
historical providers.
 
Once you have found the tag, drag it into to the right into  .Selected Historical Tags
 
For , select  from the drop-down list, and in the  text box, Date Range Realtime Most Recent
enter the amount of time in the past.
 
Select the appropriate  .Aggregation Mode

Set   to   to see table update at the project's Base Rate. Polling Mode Relative
 
Click  .OK

 

Table – Most Recent

Watch the Video

 

 

 

 

Next...

Table - Data Range 
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

Table - Data Range
 

You can use the  binding type to bring back the history in a certain date range.Tag History

To bring back the history in a data range

Drag a   (or a Power Table) from the Component Palette into your window.Table
 
In the Property Editor, go to the   property, and click the binding icon.Data
The Property Binding window is displayed. 

Select the   option.Tag History

From  , find the desired historical tags by selecting and expanding the Available Historical Tags
historical providers.
 
Once you have found the tag, drag it into to the right into  .Selected Historical Tags

Enter a desired start and end date in the   and   text boxes. Start Date Binding End Date Binding
If you want to enable the user to change the date range, bind these to the   and Start Date End 

 properties of a  component.Date Date
 
Select the appropriate  .Aggregation Mode

Set   to   to see table update at the project's Base Rate. Polling Mode Relative
 
Click  .OK

Table – Data Range

Watch the Video

 

Next...

Table - Fixed Sample Size
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Table - Fixed Sample Size
 

You can use the  and  on the  binding type to fix the Sample Size Aggregation Mode Tag History
number of records that are retrieved. This will ensure that the number of rows will remain the same 
without regard to the size of the data-set.

Selecting the  aggregation mode returns two rows of data for every row requested. Each pair Min/Max
represents a minimum and a maximum result from the underlying data. Therefore, a table with a fixed 
length, would return double the requested amount with Min/Max aggregation mode selected. With Min
/Max aggregation mode selected, and with a fixed row length of one, the data set returns the oldest tag 
value of the time range.

To fix the number of retrieved records

Drag a   (or a Power Table) from the Component Palette into your window.Table
 
In the Property Editor, go to the   property, and click the binding icon.Data
The Property Binding window is displayed. 

Select the   option.Tag History

From  , find the desired historical tags by selecting and expanding the Available Historical Tags
historical providers.
 
Once you have found the tag, drag it into to the right into  .Selected Historical Tags
 
Enter a desired start and end date in the   and   text boxes. Start Date Binding End Date Binding
To allow the user to change the date range, bind these to the   and   propertieStart Date End Date
s of a   component.  Date
 
Select the appropriate  .Aggregation Mode
 
For the , select from the drop-down and enter the desired number of rows to Sample Size Fixed 
be returned.

Set   to   to see table update at the project's Base Rate. Polling Mode Relative
 
Click  .OK

Table – Fixed 
Sample Size

Watch the Video

   

 

Next...

Table - Interval Sample Size
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Table - Interval Sample Size
 

Selecting  for   will return a data set with the number of rows determined by the Interval Sample Size
interval. For example, if the range of time is one hour and the interval is one minute, the number of rows 
in the data set will be sixty one. This is because there are sixty rows that represent sixty minutes in an 
hour plus an additional row that represents the current values that are building an interval.

To set the Interval Sample Size

Drag a   (or a Power Table) from the Component Palette into your window.Table
 
In the Property Editor, go to the   property, and click the binding icon.Data
The Property Binding window is displayed. 

Select the   option.Tag History

From  , find the desired historical tags by selecting and expanding the Available Historical Tags
historical providers.
 
Once you have found the tag, drag it into to the right into  .Selected Historical Tags
 
Enter a desired start and end date in the   and   text boxes. Start Date Binding End Date Binding
If you want to enable the user to change the date range, bind these to the   and Start Date End 

 properties of a   component.Date Date
 
Select the appropriate  .Aggregation Mode
 
For the  , select  from the drop-down and enter the desired number of rows Sample Size Interval 
to be returned.

Set   to   to see table update at the project's Base Rate. Polling Mode Relative
 
Click  .OK

Table – Interval 
Sample Size

Watch the Video

 

 

 

 

Next...

Indirect Tag History Binding
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Indirect Tag History Binding
 

You can use indirection to configure the tag history binding to point to a set of tags based on any 
parameter on the screen.

To set indirection on Tag History binding

Drag a  (or a Power Table) from the Component Palette into your window.Table
 
In the Property Editor, go to the   property, and click the binding icon.Data
The Property Binding window is displayed. 
 
Select the  option.Tag History
 
From , find the desired historical tags by selecting and expanding the Available Historical Tags
historical providers.
 
Once you have found the tag, drag it into to the right into  .Selected Historical Tags
 
Open the  box by clicking the plus sign next to it.Indirection
 
Double-click on one of the tags and enter a   in the part of the tag path that you want to create {1}
the indirection on.
A new reference will appear in the indirection box. Bind the variable to the location.
 
Enter a desired start and end date in the  or  text boxes. Start Date Binding End Date Binding
A better option is to bind these to the date properties of date components.
 
Select the appropriate .Aggregation Mode
 
For , select the  option from the drop-down, and enter the desired interval Sample Size Interval
spacing.
 
Set  to  to see table update at the project's base rate. Polling Mode Relative
 
Click .OK

Indirect Tag History 
Binding

Watch the Video

 

 

 

 

Next...
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Tag History Aggregates
Sample Size and Aggregation Mode

The sample size determines how the query results will look.

Natural - A Natural query will look up the logging rate for the queried tags (when possible), and 
return results spaced apart at that rate. This means that the return size will vary with the date 
range.
On Change/Raw - An On Change query will return points as they were logged, and can be 
thought of as a "raw" query mode. This means that the results may not be evenly spaced. Also, 
it is important to note that every changed value will result in a row, and therefore if you are 
querying multiple tags and once, you may end up with more rows than you anticipated. For 
example, if tag A and tag B both change, you would end up with [[A , B ],[A , B ], [A , B ]]. 0 0 1 0 1 1
Note: If you want to essentially retrieve raw values, while coalescing them down into fewer rows, 
try using the Interval sample mode, with an interval set to your largest acceptable time between 
rows, and select "prevent interpolation" from the advanced settings.
Fixed - A Fixed query will return the given number of rows. Where data was sparse, 
interpolated values will be added. Where data is dense, the Aggregation Mode will come into 
play.
Interval - Similar to fixed, but with the spacing based on time, rather than the number of 
requested results.

The aggregation mode dictates what happens when multiple raw values are encountered for a given 
sample window (the size of which is determined by the number of requested rows, or the interval size).

Min/Max - The minimum and maximum values will be returned for the window. In other words, 
two rows will be returned. If only one value is seen in the interval, only one row will be returned.
Time-weighted Average - The values are averaged together, weighted for the amount of time 
they cover in the interval.
Closest Value - The value closest to the ending time of the interval will be returned.
Simple Average - The values are summed together and divided by the number of values.
Sum - The values in the interval are summed together.
Maximum - The maximum value in the interval.
Minimum - The minimum value in the interval.
Duration On - Returns the number of seconds that the value was recorded as non-zero.
Duration Off - Returns the number of seconds that the value recorded as zero.
Count On - Returns the number of times the tag's value went from a zero value to non-zero.
Count Off - Returns the number of times the tag's value changed from a non-zero value to 
zero.

The following feature is new in Ignition version 7.8.1
 to check out the other new featuresClick here

Count - Returns the number of times a value was recorded 

The following feature is new in Ignition version 7.8.3
 to check out the other new featuresClick here

Percent Good - Time-weighted percentage of good values over the date range. 
Percent Bad - Time-weighted percentage of bad values over the date range.
Range - Returns the range between the highest and lowest value for the period.
Standard Deviation - Returns the standard deviation of values, or how much spread is present 
in the data; low standard deviation shows the values are close to the mean, and high standard 
deviation shows that the data points are spread out over a large range of values. Only good 
quality values are used when calculating. 
Variance - Returns the variance of values. Similar in concept Standard Deviation. Only good 
quality values are used when calculating. 

 

Tag History 
Aggregates

Watch the Video

 

 

 

 

Next...
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Custom Tag History Aggregates
Python Aggregation Functions

Introduction
Ignition 7.8 introduces the ability to extend the “aggregation” functions provided by the tag history system 
with custom functions written in python.  These functions are used for calculations across timeframes, 
and process multiple values in a “window” into a single result value.

For example, if a query defines a single row result, but covers an hour of time (either by requesting a 
single row, or using the Tag Calculations feature), the system must decide how to combine the 
values.  There are many built in functions, such as Average, Sum, Count, etc.  Using a custom python 
aggregate, however, allows you to extend these functions and perform any type of calculation.

Example

# this is a simple count function, called for each value in a time window
def count(qval, interpolated, finished, blockContext, queryContext):
        cnt = blockContext.getOrDefault('cnt',0)
        if qval.quality.isGood():
                blockContext['cnt']=int(cnt)+1
        
        if finished:
                return blockContext.getOrDefault('cnt', 0)

Parameters
qval - The incoming QualifiedValue. This has:

value : Object
quality : Quality (which has ‘name’, ‘isGood()’)
timestamp : Date

interpolated - Boolean indicating if the value is interpolated (true) or raw (false)
finished - Boolean indicating that the window is finished. If true, the return of this particular call is what will be used for the results. If false, the 
return will be ignored.
blockContext - A dictionary created fresh for this particular window. The function may use this as temporary storage for calculations. This 
object also has:

blockId - Integer roughly indicating the row id (doesn’t take into account aggregates that return multiple rows)
blockStart - Long UTC time of the start of the window
blockEnd - Long UTC time of the end of the window
previousRawValue - QualifiedValue, the previous non-interpolated value received before this window
previousBlockResults - QualifiedValue[], the results of the previous window.
insideBlock(long) - Returns boolean indicating if the time is covered by this window.
get(key, default) - A helper function that conforms to python’s dictionary “get with default return”.

queryContext - A dictionary that is shared by all windows in a query. It also has:
queryId - String, an id that can be used to identify this query in logging
blockSize - Long, time in ms covered by each window
queryStart - Long, the start time of the query
queryEnd - Long, the end time of the query
logTrace(), logDebug(), logInfo() - all take (formatString, Object... args). 

Return Value
Object - Turned into Good Quality qualified value
List - Used to return up to 2 values per window
Tuple - (value, quality_int)
List of quality tuples

Description
As values come in, they will be delivered to this function.  The interpolator will create and deliver values.

For each window (or “data block”, the terms are used synonymously), the function will get a fresh copy of blockContext.  The block context is a 
dictionary that can be used to as a memory space. The function should not use global variables. If values must be persisted across blocks, they can 
be stored in the queryContext, which is also a dictionary.

The function can choose what data to include, such as allowing interpolation or not, and allowing bad quality or not.

The window will receive the following values, many of which are generally interpolated (unless a raw value happens to fall exactly at the time):



1.  
2.  

3.  
4.  

1.  
2.  

The start of the window
1 ms before each raw value (due to the difference between discrete and analog interpolation.  A value equal to the previous raw value 
indicates discrete interpolation)
The raw value
The end of the window.

At the end of the window, the function will be called with “finished=true”.  The function should return the calculated value(s).  The resulting value will 
have a timestamp that corresponds to the beginning of the block timeframe.

 

Usage
Custom python aggregates can be used in two ways:

Defined as a shared script, where the full path to the function is passed to the query.
Defined as a string, prefaced with “python:”, and passed to the query.

Currently both options are only available through the system.tag.queryTagHistory/queryTagCalculations functions.  

Both of these options are used with the “aggregationMode” and “aggregationModes” parameters to system.tag.queryTagHistory, and the “calculations” 
parameter of system.tag.queryTagCalculations.  If the value is not an Enum value from the defined AggregationModes, it will be assumed to be a 
custom aggregate.  The system will first see if it’s the path to a shared script, and if not, will then try to compile it as a full function.

For performance reasons, it is generally recommended to use the shared script whenever possible.

Example

#Return tag history using a custom aggregate function you wrote. 
 
system.tag.queryTagHistory(paths=[‘MyTag’], rangeHours=1, aggregationModes=[‘shared.aggregates.
customFunction’])
 

Example

#Create a function on the fly to pass in as a custom aggregate.
 
wrapper = “””\
python:def wrapper(qval, interpolated, finished, blockContext, queryContext):
        return shared.aggregates.customFunction(qval, interpolated, finished, blockContext, queryContext)
“””
system.tag.queryTagHistory(paths=[‘MyTag’], rangeHours=1, aggregationModes=[wrapper])

Next...



Alarming
 

Alarming is a core feature of the Ignition platform. Alarms are conditions that are evaluated with respect to a specific numeric datapoint. Most 
commonly, alarms are configured on a tag or a Transaction Group item.

Any number of alarms can be attached to a datapoint. When the alarm condition becomes true, the alarm is considered to be " ". For example, active
on an analog tag you might add a high-level alarm that goes active when the tag's value is over 50.0. You could add another alarm onto the same tag 
for a high-high-level when the value is over 75.0. On a discrete tag, you might configure an alarm to be active when the value is non-zero. Each alarm 
has its own name, priority, and many other settings.

When the alarm condition becomes false after it has been true, the alarm is said to have " . Each alarm has a numeric deadband and time cleared"
delay deadbands that can affect when alarms go active and clear to prevent frequent oscillations of an alarm between active and clear when the value 
is hovering near the setpoint. At some point, an operator can   an alarm, confirming that they have seen the event.acknowledge

The history of alarms is stored in any configured . These will journal all state changes to each alarm, as well as acknowledgement, to Alarm Journals
an external SQL database of your choosing.

Information about configuring alarms can be found in  in the  section.Alarming Properties Tag Intro

 

 

In this section ...
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3.  

Setting up Alarms
   

Alarming is a core feature of the Ignition platform. Alarms are conditions that are evaluated with respect to a specific numeric data point. Most 
commonly, alarms are configured on a tag or a Transaction Group item.

To set the general properties for alarms

Go to the  section of the Gateway.Config
 
Choose  from the menu on the left. Alarming>General
The General Alarm Settings page is displayed.
 
Set the general alarm properties shown in the following table: 

Alarm Evaluation

Live Event 
Limit

Default is 5. The number of "live" events (active or unacknowledged) that can exist for a single alarm at a given time. When 
surpassed, older events will be acknowledged automatically by the system. This means as an alarm cycles on and off, 
Ignition will keep track of the last 5 times the alarm event happened until the user acknowledges them. This does not store 
history for those events.

Event Suppression 

Continuous 
Event 
Detection 
Window 
(min)

Default is 10. The amount of time to store events before shutdown to prevent new duplicate events from being created on 
startup. This setting prevents unacknowledged active events from being generated due to reboot. If set to 0, will not be used.

Notify 
Initial 
Events

Default is false. If false, active alarms caused by the "initial state" (that is, the first value checked after being created, or after 
the enabled state changes) won't be sent to the notification system. This means if you add an alarm to a tag, a notification 
won't be immediately sent when the new state is created.

   

   

In this section ...  

   



1.  

2.  

3.  

4.  

5.  

Configure Alarm on a Tag
 

Alarming is a core feature of the Ignition platform. Alarms are conditions that are evaluated with respect 
to a specific numeric data point. Most commonly, alarms are configured on a Tag.

To configure an alarm on a tag

Double-click on the tag to edit it.
The Tag Editor window is displayed. 
 
Click on , click the green plus sign   to add a  to the tag.Alarming +  New Alarm
 
Enter a  for the Alarm and set any other settings you wish.Name
 
In the  choose the appropriate logic that determines if the alarm is active Alarm Mode Settings
or not.
 
Click  or  to commit the new alarm.Apply OK
Ignition will start monitoring the alarm immediately. 

Configure Alarm on 
a Tag

Watch the Video

 

 

 

Alarm Attributes

All alarm states have a list of properties that you can edit or bind when creating or editing a tag. Here is the list of attributes paired with their scripting 
names. This is useful when using the system.tag.add() and system.tag.edit() functions.

If the attribute you want to reference is not listed, you can simply change the attribute on your tag, export it to XML, and view the reference to the 
alarm attribute. 

Group Property 
Name

Scripting 
Name

Description

Main

  Priority priority The priority (or "severity") of this alarm. Diagnostic (0), Low (1), Medium (2), High (3), Critical (4)

  Timestamp 
Source

timestampSo
urce

Dictates whether the timestamp used on the alarm comes from the system or the value. System (0), Value (1)

  Display Path displayPath An optional path (separated by "/") that will be used for display and browsing purposes.

  Ack Mode ackMode How acknowledgement works for the alarm: Auto (1) - Alarm is acknowledged when cleared. Manual (2) - Alarm 
acknowledged by user. Unused (0) - Alarm is always marked as 'acknowledged'.

  Notes notes Documentation about the alarm.

  Ack Notes 
Required

ackNotesRe
qd

Select this option to require operators to provide some explanation when the alarm is acknowledged. true or false

  Shelving 
Allowed

shelvingAllo
wed

true or false

Alarm Mode Settings

  Mode mode The alarm mode. Equal (0), Not Equal (1), Above Setpoint (2), Below Setpoint (3), Between Setpoints (4), Outside 
Setpoints (5), Out of Range (6),

Bad Quality (7), Any Change (8), Bit State (9), On Condition (10)

  Setpoint / 
Low Setpoint

setpointA The value used to initiate an alarm. If the alarm mode calls for two setpoints, this is the low value.

  Inclusive / 
Low Inclusive

inclusiveA If true, the Setpoint or Low Setpoint value is used inclusively for the condition to alarm.

  High Setpoint setpointB The high value used to initiate an alarm when the alarm mode calls for two setpoints.

  High Inclusive inclusiveB If true, the High Setpoint value is used inclusively for the condition to alarm.

  Any Change anyChange If true, will alarm on each value change given the alarm mode conditions are met.

  Bit Position bitPosition The position of the bit, starting at 0, that will be watched.

  On Zero bitOnZero If true, will alarm when the specified bit is not high, or "0".

Deadbands and Time Delays

  Deadband deadband A numeric deadband of the alarm condition. The interpretation of this value depends on the deadband mode. Note that 
his deadband is separate from, and evaluated after, the tag's deadband.

https://inductiveuniversity.com/video/configure-alarm-on-a-tag/7.8


  Deadband 
Mode

deadbandMo
de

Defines how the deadband value is used. If percent, the value (0-100) will be compared against the Eng. limits defined 
for the value. Absolute (0), Percent (1)

  Active Delay timeOnDelay
Seconds

The time, in seconds, before the alarm will be considered truly active after the active condition becomes true. Also 
known as a "rising edge time deadband".

  Clear Delay timeOffDelay
Seconds

The time, in seconds, before the alarm will be considered truly clear after the clear condition becomes true. Also know 
as a "falling edge time deadband".

       

Notifications

  Active 
Pipeline

activePipeline The pipeline that will be used to process active events generated by this alarm.

  Clear Pipeline clearPipeline The pipeline that will be used to process clear events generated by this alarm.

  Ack Pipeline ackPipeline The pipeline that will be notified when the alarm has been acknowledged.

Email Notification Settings

  Custom 
Subject

CustomEmai
lSubject

If specified, will be used for the email subject. If blank, the subject defined in the notification block to be used.

  Custom Email CustomEmai
lMessage

If specified, will be used for email message. If blank,. the message defined in the notification block will be used.

SMS Notification Settings

  Custom 
Message

CustomSms
Message

If specified, will be used for the SMS message. If blank, the message defined in the notification block will be used.

Associated Data

  yourAssociate
dData

yourAssociat
edData

 

 

Next...

Multiple Alarms on a Tag

 

 



1.  

2.  

Multiple Alarms on a Tag
 

You can configure multiple alarms on one tag.

To configure multiple Alarms on one tag

 Start by configuring an alarm and click  instead of .Apply OK
 
Configure additional alarms by selecting the green plus  sign below the existing alarm. +

The number of alarms that you can configure is virtually unlimited and will never exceed the bounds of 
reasonable design consideration.

Multiple Alarms on 
a Tag

Watch the Video
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Single Integer - Alarm on Each Bit
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Single Integer - Alarm on Each Bit

A common practice for PLC programming is to store alarm conditions as series of bits inside the PLC and 
expose them to the world as an integer value. Each bit is essentially a binary value. A series of 8 bits, for 
example, could be represented as an 8-bit integer. This integer value can be monitored by Ignition's OPC-
UA server as an integer value as a tag. This tag can then have as many alarms as the integer has bits by 
monitoring the integer's bit state.

The following table shows binary and decimal equivalents:

Binary Decimal

10001110 142

In this case the tag would be an integer with a value of 142. This tag would have eight alarms. Each one 
of these alarms become active in accordance with its Boolean value.

To create the alarms on an integer tag value

Edit the tag that has an integer value.
 
Create an alarm by selecting the  tab and clicking the green plus sign  to add an Alarming +
alarm.
 
Complete the appropriate properties, for example, enter the  of the alarm.Name
 
From the  section drop-down, select   and enter a value for the .Mode Bit State Bit Position
 
Repeat the same process for the remainder of the bits.

Next...

Dynamic Alarm Setpoints
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Dynamic Alarm Setpoints
 

You can configure alarms with dynamic setpoints inside of a tag definition. It is similar to configuring an 
alarm, however configuring an alarm with a dynamic setpoint requires additional tags to serve as these 
setpoints.

To configure dynamic setpoints on an alarm

Double-click on the tag to edit it.
The  window is displayed. Tag Editor
 
Select the  tab and the alarm that you want to edit to associate a setpoint with.Alarming
 
Find the  property, click on the binding icon next to it, and select a Tag or Expression.Setpoint
This binds the Setpoint Property to a different tag or an expression.
 
Click  .OK

Dynamic Alarm 
Setpoints

Watch the Video

 

 

 

Next...

Configure Alarm in UDT
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Configure Alarm in UDT
 

You can configure alarms inside of the UDT definitions. Every instance of the UDT will have the same 
alarm configurations, but they will be specific to that instance of UDT.

To configure an alarm on a UDT

Edit the UDT definition by accessing it in the  folder.Data Types
 
Select the tag and add an alarm inside the UDT definition. Its configurations are the same as 
the normal  . alarm configuration on a tag  
 
Click .OK

All instances of the UDT will have a similar alarm setup but each alarm will be unique to that UDT 
instance.

Configure Alarm in 
UDT

Watch the Video

 

Next...

 UDT Alarm Dynamic Setpoints
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UDT Alarm Dynamic Setpoints
 

You can configure alarms with dynamic set points inside of a UDT definition. It is similar to configuring a 
UDT alarm, however configuring a UDT alarm with dynamic set point requires additional tags to serve as 
these set points in all the deployed UDTs.

To configure dynamic set points inside a UDT 

In the Tag Browser, go to the   folder, and choose  to edit the UDT Data Types Edit tags
definition.
 
Create memory tags inside the UDT definition.
 
Select the tag and its alarm inside the UDT definition that has the alarm you want to associate 
the UDT with.
 
Bind the  property to the new UDT memory tags. Setpoint
 
Click .OK
All of the deployed UDT will have memory tags that serve as the alarm set points.

UDT Alarm 
Dynamic Setpoints

Watch the Video

 

 

 

   

   

Next...

Enabling Alarms Dynamically - Machine On
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Enabling Alarms Dynamically - Machine On

Allowing a dynamic condition to determine if an alarm is enabled or disabled is possible inside the 
alarm's properties.

To configure the alarm's enabled property

Select a tag that has the alarm you want to configure.
 
Access the alarm properties by double-clicking on the tag and selecting the alarming properties 
tag.
 
Bind the enabled property to a boolean tag or an expression that evaluates a true or false 
condition.
 
Click .OK
Now the alarm will only evaluate based upon the condition of the tag or expression.

Next...

Enabling Alarms Dynamically - Time of Day
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Enabling Alarms Dynamically - Time of Day
  

You can set alarms to automatically enable and disable at certain times of the day.

To enable the alarm dynamically

Alarms can be set to be enabled for part of the day and disabled for the remainder of the day.

From the , select the tag on which you want to configure the alarm.Tag Browser
 
Double-click on the tag, and in the Tag Editor window go to the Alarming section.
 
Bind the enabled property to an expression that evaluates a true or false condition based upon 
the current time.
For example, the following expression would return true between the hours of 5 and 12. 

dateExtract(now(0), "hour" >= 5 && dateExtract(now(0), "hour" <= 12

Click .OK

Next...

Active and Clear Delays



Active and Clear Delays

To avoid nuisance alarms, the  and  alarm settings guarantee that an alarm has Active delay Clear delay
been Active or Cleared for a specific amount of time before it actually becomes Active or Cleared.

You can access the Active and Clear delays configurations by editing the individual alarm on the tag 
using the  window.Tag Editor
 

Active delay

An Active delay will delay an alarm for as many seconds that is configured in the Active Delay property. You can bind this value to an expression or a 
tag for additional configuration.

Clear Delay

An Clear delay will delay an alarm for as many seconds that is configured in the Clear Delay. You can bind this value to an expression or a tag for 
additional configuration.

Next...

Alarm Associated Data
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3.  

Alarm Associated Data
 

You can extend the alarm properties by adding your own associated data to be associated with the 
alarm. A common scenario is to have an alarm on the Amps tag of a motor and associated data on a tag 
that is associated with the motor controls, therefore when the Amps tag becomes too high the current 
setting of the motor control will be ported with the alarm.

To create associated data

Right-click on the tag and select  .Edit tag(s)
The   window is displayed. Tag Editor
 
Go to the   section, select or create an alarm, and click the green plus sign  to add Alarming +
new associated data for the alarm.
 
Rename the , bind it to a value, and click .Associated Data OK
When the alarm becomes active, it can grab the value of the associated data and make 
it available with the alarm diagnostics and auditing.

Alarm Associated 
Data

Watch the Video

   

 

Next...

Alarm Grouping
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1.  

2.  

3.  

Alarm Grouping
 

Grouping alarms in Ignition is an important concept so you can view alarms for a particular area of your 
plant or for a specific set of alarms. A common design practice is to associate alarm groupings on the 
associated data of the alarm.

To create alarm grouping

Create an alarm.
 
Create associated data on the alarm.
The associated data should be a static value that describes the group.
 
Click .OK
The alarm will now always have the group designation associated with it. This can be used for 
filtering or part of your alarm pipeline notifications.

Alarm Grouping

Watch the Video
 

 

   

 

Next...
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Alarm Properties
Alarm Properties

An alarm event is made up of many pieces of information. The state, the value, the time, all of the configuration data for the alarm, and more are 
collectively known as the properties of the event. A "property" is generally a name, potentially along with a default value. There are many properties 
that an alarm may have, and if the property isn't present, the default value is usually assumed. 

How Properties are Used

Properties are used in a number of ways, they:

Define how an alarm behaves.
Are referenced in messages, such as the body of an email, or sms message.
Are referenced in Expressions, such as in the binding of a different property, or in an Expression block.
Are created and used in pipelines as temporary variables, such as to make a counter.
... and various other places.

While properties are always accessed the same (for example by using the  syntax in a message or Expression, or the {propertyName} getPropert
 Expression function), there are some subtle variations on where the property value comes from, and what its lifecycle will be. To understand this y()

better, consider that an Alarm Event has the following structure:

Alarm Event
   Active Event Properties
   Clear Event Properties
   Acknowledged Event Properties
   Runtime Properties

The first three collections of properties get created when the described type of event occurs.
Consequentially, it's possible for the same property to exist multiple times in an Alarm Event. For example, a bound configuration property or 
associated data is captured on both the active and clear events. When you reference a property, the alarm event will provide you with the most recent 
value. So, if you have a bound property call "MyData", and you reference it when the alarm is active, you may get a different result than when the 
reference is executed later and the alarm has cleared. The individual values are stored separately in the alarm journal, however.

Configuration Properties  

Name The name of the Alarm.

Enabled Set to False to turn off the alarm state and all associated actions.

Priority Used for sorting/filtering. 0=Diagnostic, 1=Low, 2=Medium, 3=High, 4=Critical

Display Path The unique path of the Alarm state.

Active Pipeline Which pipeline (if any) to use when the alarm goes into the Active State.

ClearPipeline Which pipeline (if any) to use when the alarm goes into the Clear State.

TimeOnDelaySeconds The amount of consecutive seconds that the alarm state must be True before the Tag enters this alarm state.

TimeOffDelaySeconds The amount of consecutive seconds that the alarm state must be False before the Tag exits this alarm state.

Notes Free-form notes for the alarm state.

 

As described in the previous section, Runtime Properties are different in that they only exist while the alarm event is in memory (still "live", that is, not 
cleared, or not acknowledged). They do not get stored in the alarm journal. In addition to properties created through the Set Property block, the 
system also has a number of defined Runtime Properties that it may use for various purposes. Though these are used internally, they are technically 
still regular properties, and can be accessed and modified through the normal means.

Runtime Properties (generated for the event)

IsInitialEvent  Set to "true" when the event is caused by the initial state of the alarm.

SystemAck Set to "true" when the alarm has been acknowledged by the system, due to an overflow of the "live event queue". Live events 
are alarm events that are active or not acknowledged, and are limited for each alarm by the general alarm settings.

ShelfExpiration When the shelf will expire for this event.

IsShelved Is the alarm currently shelved?

EventCanceled If set, the event will drop out as soon as possible from the pipelines

EventId The unique id (uuid) of this alarm event. Each event gets a completely unique id.



Source The qualified path to the item that generated this event.

DisplayPathOrS
ource

Gets the display path if defined, otherwise returns the source.

State The current overall state of the alarm: ClearUnacked (0), ClearAcked (1), ActiveUnacked (2), ActiveAcked (3)

EventState  The transitional state that caused the current event: Active (0), Clear (1), Ack (2).

EventValue The value associated with the current event.

AckUser The user who acknowledged this event.

IsAcked "True" if the event has been acknowledged.

IsActive "True" if the event is still active.

IsClear "True" if the event is not still active.

ActiveTime, 
ClearTime, 
AckTime

The timestamp for each event.

PipelineTransiti
onCount

How many transitions the event has made inside of the pipelines.

Associcated Data

You can extent alarm properties by creating your own   Associated data properties can be configured on any alarms that are already associated data.

configured in a project.  

To learn more, refer to .  Alarm Associated Data

   

Next ...

 

 

 

   

   



Alarm Status
   

In the Designer, you can use the  component in the  section of the  to display the current status of Alarm Status Table Alarming Component Palette
the alarms. You can set it up to show the active, unacknowledged, cleared, and acknowledged alarm statuses.

   

   

In this section ...  

   

   



Display Status of Single Alarm
 

You can display the status of a single alarm on a screen. Filters can be set to show active/inactive, 
cleared/uncleard, or acknowledged/unacknowledged alarms.

Tags have multiple properties related to the current state of configured alarms on the tag. It's possible to 
bind a property on a component to one of these tag properties. This way components can respond to the 
state of an alarm on a tag

 

Example

1) In the Designer, create a new Text Field component on an empty window

2) Create a tag named 'Alarm' with a datatype of Int4, and configure with an alarm to become active on a 
value of 1

3) Once the tag has been created, click on the '+' icon next to the tag in the tag browser

This will expand the tag and show all of the tag properties, including the AlertActive property

4) With the Text Field component selected, drag and drop the AlertActive property fromt the tag to the 
Visible property on the Text Field component. This will create a binding directly to that tag property.

5) You'll find that the component will appear when an alarm is active, and become hidden once all alarms 
on the tag are cleared. 

 

Display Status of 
Single Alarm

Watch the Video
 

 

 

 

 

 

Next...

Alarm Status Component
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1.  

2.  

3.  

Alarm Status Component
 

The is a built-in component in Ignition that displays the current status of all alarms in Alarm Status Table 
the system into one view.  The Alarm Status Table is highly customizable and can be configured to show 
active, unacknowledged, cleared, and acknowledged alarms.

 

The Alarm Status Table is very easy to setup.

In the , under Alarming, drag the Component Palette in Designer Alarm Status Table 
 on to your window.  You will notice that the  table is already configured to show the component

current status of all the alarms in your system.  By default, the Alarm Status Table shows all the 
Active and Unacknowledged or Acknowledged alarms, and Cleared and Unacknowledged 
alarms.  It also displays the time the alarm went Active as well as the current State and Priority 
of the alarm.  
Note: You must have  on at your tags for them to show up in the table.alarms set up

In , right click on the header to show or hide information on the Alarm Status Preview Mode
Table.  If you want to show the name of the alarm, you can add '  to the table by checking Name'
the box.  You can also reorganize the columns to display how you want the columns to look by 
dragging the column header anywhere on the table header. 

 

You can click on an individual alarm and use the buttons at the bottom of the table to 
Acknowledge or Shelve an alarm.  You can also use the icons to view the alarm Details, Notes, 
and History.

Alarm Status - 
Component

Watch the Video
 

 

 

 

 

Additional information on the Alarm Status Table component can be found on the Alarm 
Status Table page in the appendix.

https://inductiveuniversity.com/video/alarm-status-component/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Alarm+Status+Table
https://legacy-docs.inductiveautomation.com/display/DOC/Alarm+Status+Table


3.  

4.  

 

In the , there are a set of  for filtering alarms.  Using the Property Editor alarm properties Source
 and the  properties, you can filter out cleared alarms, filter for alarms Filter Display Path Filter

in a particular Tag folder, and filter for alarms matching a certain criteria. This example uses the 
Display Path to filter for all 'Machines.'

Filtering on alarms is discussed in detail in sections,   and Alarm Status General Filtering Alarm 
.Status Filter on Associated Data

As you can see, the Alarm Status Table contains a host of features already built in to the component 
which you can take advantage of to give you the current status of alarms in your system. 

 

 

 

Next...

Alarm Status - General Filtering
Alarm Status

 

 



Alarm Status - General Filtering
 

There is a lot of filtering you can do on the Alarm Status Table that comes with Ignition.  Once you drag 
the Alarm Status Table component on to a window, by default it shows you all the alarms that are 
currently 'active and unacknowledged,' 'active and acknowledged,' and 'clear and unacknowledged' with 
any priority.  

You can filter the alarm list in the table to be a shorter list using the filter properties in the Property Editor 
instead of scrolling through every single alarm in your system,  

In the , there is a group called   that you can configure to focus on only those Property Editor Filters
alarms you want to see.  You can filter on and .  Priority, State, Source or Tag Path,  Display Path

This example shows how you can filter alarms based on .  From the  field, select Priority Min Priority ‘Me
 from the dropdown list.  You will then see all the Medium priority and higher alarms displayed dium’

which creates a smaller list of alarms for an operator to view.

In this next example, select  from the dropdown list in the  field.  Now, you will see all ‘High’ Min Priority
High and Critical priority alarms in the system which gives the operator an even smaller list of alarms to 
view. 

Alarm Status - 
General Filtering

Watch the Video
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Lastly, select  from the dropdown list.   Notice how the alarm list keeps getting shorter by using ‘Critical’
the Priority filter.   

The second set of filters is based on .  There are 4 states an alarm can be in; Active and State
Unacknowledged, Active and Acknowledged, Clear and Unacknowledged, and Clear and 
Acknowledged.  Each alarm has a different color representing one of the four States.  

Let’s make our alarm list smaller by  both the  filters.  This will eliminate all the Clear  unchecking Clear
alarms from the Alarm Status Table and only show the Active alarms whether they are Acknowledged or 
Unacknowledged.  

If you uncheck , this will only show the alarms in the Alarm Status Table that Active and Acknowledged
are currently Active, and are not Acknowledged.  A good business practice is to show only the Active 
alarms that are either Unacknowledged or Acknowledged.  It also reduces the number of alarms an 
operator has to scroll through.



Ignition also has the capability to filter alarms based on the Source or Tag Path and the Display Path. 

The  is the actual  which means you can also use Tag folders in Ignition to filter for Source Tag path
specific alarms.  For example, you may want to filter for all Ramp alarms in the ‘Ramp’ folder.  Enter 

 (using * as wildcards) to look for all alarms with the Ramp Tag Path.  You can see in this *Ramp*
example, all the alarms have 'Ramp' in the Source Path.  

Essentially, you can do the same thing using the .  In this example, ‘High Alarm’  is the Display Path
name that was setup in the Alarm Configuration, and the Display Path is set to the name you want the 
operator to see.  So for example, the Alarm Status Table shows all the High Alarms.  

So, it's really easy to do some basic filtering using the alarm filter properties using the Alarm Status Table 
component.

 

Next...

Alarm Status - Filter on Associated Data

 

 



1.  
2.  

3.  
4.  

5.  

Alarm Status - Filter on Associated Data
 

Another way to filter alarms in the  is using associated data that was added to an Alarm Status Table
alarm.  You can easily and quickly search, filter, and display on specific alarms based on associated data 
configured in an alarm.

In this example,  was used and a  configured.  Associated data was ‘WriteableFloat1’ ‘High Alarm’
added to High Alarm called  with a static value called   ‘Group” ‘Group A.’

Let's create a script to filter for all the alarms in the Alarm Status Table that have the associated data 
named    Scripting allows you to use the  specifically for ‘Group A.’ 'filterAlarm' Extension Function
filtering on associated data.  

Right click on the Alarm Status Table component, and scroll down and select .  Scripting
In the Component Scripting window, under , select  for Extension Functions 'filterAlarm'
filtering on associated data.  You can filter on anything you want here, but in this example, filter 
on 'Group A.'
Click Enabled.
Enter the code below into the  script.'filterAlarm'

Extension Function - filterAlarm for 'Group A'

group = alarmEvent.get("Group")
if group == "Group A":
        return True
return False

Once your code is entered, it will look like this...

Alarm Status - 
Filter on 
Associated Data

Watch the Video
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5.  Click .  OK

This script only displays alarms matching the associated data for   For every alarm matching 'Group A.' ‘G
 it will return  and show the alarm in the Alarm Status Table.  If the associated data does roup A,’ ‘True’

not match  it will return  and the alarm will not show up in the Alarm Status Table.  ‘Group A,’  ‘False,’

Scripting gives you the ability to filter on associated data, but also gives you the freedom to filter on 
anything that you want.  

 

 

Next...

Alarm Status - Row Styles

 

 

Important Note - If an Error Filtering Script Occurs

If you have an error in this filtering script, it will return true for every alarm instance (and show 
all alarms) instead of displaying many errors to your users. You can find more information 
about the error in the Client Console.



Alarm Status - Row Styles
 

You can customize the style of alarms in different states on the   component.  By Alarm Status Table
default, the Alarm Status Table comes with a specific set of colors associated with each of the alarm 
states.  You can change each of these colors for each of the states by going to the Alarms Row Styles 
Customizer that the component provides.   

By default, the Active and Unacknowledged alarms are red and blinking, Cleared Unacknowledged 
alarms are teal, etc.

Right click on the  component, go down to  and select Alarm Status Table Customizers Alarm Row 
.   Here is where you can modify an existing style, add more styles or delete a style.  Each style Styles

has an expression, a color and if you want it to blink.  The expression allows you to do any evaluation 
you want using any parts of the alarm: Priority, State, Display Path, Active time, Clear time, etc.

This is an ordered list of alarm row styles.  The first style that returns  for a given alarm is the one  ‘True’
that is going to be used so you want to make sure the order is correct in the Alarm Rows Styles 
Customizer. 

In this example, you will notice that ’ is the first style and it is using a gray color {priority}=’Diagnostic
scheme.  This means that any alarm with the 'Diagnostic' priority will be gray, regardless of it's state.

The second style is a  alarm with a  or greater.  If this is  the State ‘ActiveUnacked’ priority of 3  ‘True,’
red color scheme will be used and it will blink. IE: any alarm that is , , and Active Unacknowledged High 

 will show as red and blinking. or Critical priority

: Priorities are numbered behind the scenes, but named when you are creating them. 0 = Note
Diagnostic, 1 = Low, 2 = Medium, 3 = High, and 4 = Critical. This allows you to use operations like '>=' 
(greater than or equal) when filtering on priority.

Alarm Status - Row 
Styles

Watch the Video
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Let’s add a new State alarm for  and  alarms.  You can copy your new Active,Unacked Critical  
expression from the second style  and paste it into your new expression and change the'Active,Unacked'

 to   Because this is a critical alarm, you want it to catch the operator’s attention, so it’s a good Priority ‘4.’
idea to make the style standout.   Make the foreground color  and the background color   Che 'white' 'red.'
ck the  and make the foreground color of  and background color of ' so it is blink box 'black' 'yellow
visible at the top of the Alarm Status Table. 

Remember what was stated earlier, that style order is important.  So, if you keep this style at the bottom, 
the alarm will never be visible to the operator because the first state to return ‘True’ is  witActiveUnacked
h a .  You need to move  with a  to the top, so it is evaluated Priority >= 3 ActiveUnacked Priority >= 4
before the others.   .Press OK

The critical alarms will now be blinking yellow and will definitely catch the operator’s attention.  



To learn more about States and Priorities, including all the alarm configuration properties, refer to the 
sections on  .  Alarm Properties

 

Next...

Alarm Status - Marquee Mode

 

 

 



Alarm Status - Marquee Mode
The Alarm Status Table can take up a lot of space on the client window as shown in this example, but if a 
small   is needed, you can turn on the   option.  Alarm Status Table Marquee Mode

In many instances, a small Alarm Status Table is displayed at the very bottom of the Ignition client 
window taking up very little space.  The problem is when an operator has quite a few Active alarms as 
shown in this example, they have to manually scroll through the list of alarms to see them all.   This can 
be a little tedious for the operator.  

The nice feature with Marquee Mode is it automatically scrolls through all the alarms when there is not 
enough vertical space on the client window to show them all at once.

In the  of the Alarm Status Table, there is a property called .  Set the Property Editor Marquee Mode
property to  and the Alarm Status Table will automatically scroll through all alarms that are ‘True’
currently visible on the Alarm Status Table component.  

Marquee Mode makes it very easy for an operator to see what’s going on without having to scroll through 
the entire alarm list to identify all the alarms that are Active or whatever state they may be looking for.

Alarm Status- 
Marquee Mode

Watch the Video
 

 

When using Marquee mode, it is even more important to pay attention to the filters on the Alarm Status Table since there is limited room. Make sure 
your operators know that it is a scrolling list.

 

Next...

Alarm Status - Acknowledgement

https://inductiveuniversity.com/video/alarm-status-marquee-mode/7.8


 

 



Alarm Status - Acknowledgement
 

Using Alarm Acknowledgement

One of the most important things an operator is going to do in the runtime is acknowledge alarms using 
the .  Alarm acknowledgement is built into the component and is very easy to use.  Alarm Status Table

As soon as the operator selects and presses the Acknowledge button, the current State of the alarm will 
change, and the operator's credentials and the time the alarm was acknowledged will be recorded in the 
Alarm Status Table.  

If you don't have the Ack'ed By or Ack Time columns in the header of the Alarm Status Table, you can 
simply add them by right clicking on the header bar, and from the dropdown list, check the boxes for Ack'

 and  ed By Ack Time.  

The Alarm Status Table component allows you to select an individual alarm, multiple alarms or use the 
select all checkbox in the header bar. Once you check all of the alarm(s) and press the Acknowledged 
button, all the alarms will be Acknowledged.  In this example, 4 alarms were checked, and all 4 alarms 
were Acknowledged at the same time. 

Alarm Status - 
Acknowledgement

Watch the Video
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1.  

This example shows all 4 alarms were Acknowledged, who acknowledged them and the time they were 
acknowledged.  

If any of the selected alarms require , a small window is displayed in which the Acknowledgement Notes
operator must add notes, otherwise, the alarm cannot be acknowledged. If the operator wants to cancel 

the Acknowledgement Notes and close the window, use the    to close the Expand button
Acknowledgement Notes window.  

Security for Alarm Acknowledgement

If you want to restrict who can use the Acknowledge button, there is the  in the Show Ack Button
Property Editor that can be set to   By setting the  to ' ,' this hides the  'False.' Show Ack Button False
Acknowledge button on the Alarm Status Table.  

In order for operators to acknowledge alarms, the correct permission must be assigned.  Permissions 
can be assigned using the Show Ack Button.  Click the    to open the Show Ack Button binding icon 
property binding window.  This example shows how to set permissions to acknowledge alarms for people 
in the  . Operator Role



1.  
2.  
3.  
4.  
5.  

Under  , select  .Property Binding Type Expression
Click the Function icon.
Scroll down to   and select ' This enters the function name.Users, hasRole.' 
Edit the expression to read: hasRole("Operator")
Click . OK  
If you currently have the "Operator" role you will notice that the   property is Show Ack Button
now true, otherwise it will be False.

 

Next...

Alarm Status - Shelving

 

 



Alarm Status - Shelving
 

Another important feature of the Alarm Status Table is the capability to shelve alarms.  Shelving alarms 
allows you to temporarily silence an alarm for a fixed period of time.  This feature is extremely handy 
when an alarm is already active and you want to temporarily silence the alarm while you're working on 
the issue.  The Alarm Status Table component will not send any notifications while the alarm is shelved, 
and will be temporarily dropped from the Alarm Status list so operators don't get confused and think it's 
active.   When the shelved time is up and if the alarm is still active, it will return into the Alarm Status list.

In this example, you can see one critical alarm which is Active and Unacknowledged.  You can select 
one alarm or multiple alarms, then press the  .  The  will automatically open Shelve button Shelving tab
so you can set a duration from 5 minutes to 4 hours in which to shelve selected alarm(s).  The shelving 
time is also customizable.  Select  and press .   The selected alarm(s) will be removed 30 minutes Apply
from the Alarm Status list.  

To view all the alarms that are currently shelved, go to the bottom right of the Alarm Status Table and 

click on the      A Shelved Alarm tab will open and you can see all the alarms Shelved Alarms icon.
that are shelved and when the shelved time on the alarm will expire.  Click the  again, and Shelved icon
the Shelved Alarm tab will disappear.  

If you want to Unshelve the alarm,  under the , click the select the alarm  Shelved Alarms tab Unshelved 
 and the alarm will return back to the Alarm Status list.  After the amount of time expires on a link,

shelved alarm, it will be evaluated, and if it is still active, it will automatically return to the Alarm Status 
list. 

Alarm Status - 
Shelving

Watch the Video
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If the alarm is fixed during this time period (i.e., tank water level is low and when the water level returns 
to the setpoint), the alarm will show up as Cleared in the Alarm Status list making it no longer Active as 
shown in this example.  

Another nice feature of the Alarm Status Table is the shelve time is totally customizable.  By default, the 
component has several shelving preset times, but you can add or remove times based on your 
requirements.  One thing to note with modifying the shelving times, is that there is no option to set a 
shelving time indefinitely. Shelving times are meant to be temporary, not long term.  

In the , there is a property called   Click on the   icon to Property Editor Shelving Times. Dataset Viewer
open the Dataset Viewer.  This is where you can add, remove or change the shelving times for 
alarms.  Once you edited the shelving times, press .  You can see in this example that   OK 90 minutes
was added to the list of shelving times.  

To verify your new time was entered correctly, select the alarm(s) you want to shelve and click the 
Shelve button. Choose the shelve time from the dropdown list and press  to temporarily silence Apply
your alarm(s).  You can see how easy it is to modify your shelve times. 



 

 

Next...

Alarm Status - Tag History and Alarm History

 

 



Alarm Status - Tag History and Alarm History
 

The  component has a unique feature built into it that lets you view the actual trend Alarm Status Table
of a tag's value and an alarm's history for any alarm that is currently active. It shows you exactly where 
the alarms occurred, when it was cleared, and when it was acknowledged.  

For the trend feature to work, you must have your tag history setup so it’s logging to the  as Tag Historian
well as an  configured so that the log history gets logged to a database.  As long as Alarm Journal Profile
both the Tag Historian and Alarm Journal are configured, you will see the trend for any given alarm that 
is currently active or in the Alarm Status Table list. 

In the Alarm Status Table, select any  and click on the     located on the bottom alarm Trend icon
right of the table.  The trend chart shows you the trend of the selected alarm's value over time.   You can 
look at the last 5 minutes, 30 minutes, 1 hour, 8 hours or up to 24 hours to view the exact history of that 
tag's value, as well as all the alarms that occurred over time.  The yellow triangles denote when the 
alarm was active, the green circles identify when the alarm was cleared, and a vertical black bar shows 
when the alarm was acknowledged.   It’s all built into the Alarm Status Table component and you don’t 
have to go to a separate window to view an alarm trend or alarm history.  

Alarm Status - Tag 
History and Alarm 
History

Watch the Video

 

 

 

 

Next...

Alarm Status Tags
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1.  
2.  
3.  
4.  

5.  

6.  

Alarm Status Tags
 

Ignition provides a set of System Tags to view information about the Ignition server which includes four 
tags that count the number of alarms in each state. A quick way to see if any alarms are currently active 
and get an alarm count is to add a label on the Navigation window.  The four system tag states 
are:  Active and Unacknowledged, Active and Unacknowledged, Clear and Acknowledged, and Clear 
and Unacknowledged. 

In the  of the Designer, scroll down to the  folder.   You can Tag Browser System > Gateway > Alarming
see all 4 of the system tags that Ignition provides.  You can also see how many alarms are currently Activ

, , , and .  e and Acked Active and Unacked Clear and Acked Clear and Unacked

The  tag is a key tag for operators so they know how many alarms are Active and Unacknowledged
currently active that they have to respond too.

Let’s setup an Active Alarm on the Navigation window using a Label component for the Active and 
 tag showing how many alarms are currently active and unacknowledged.UnAcked

Open the , drag in a  and place it under the tab strip.  Navigation window  Label component
Right click on .Customizers > Custom Properties
Create a new property and name it  with an  data type.   'activeAlarms' 'Integer'
Click  OK.

Bind the new custom property  to the following tag by navigating the .'activeAlarm' Tag Browser
 
 
    "[System]Gateway/Alarming/Active and Unacked"
 
Click .OK

Alarm Status Tags

Watch the Video
 

 

 

 

 

https://inductiveuniversity.com/video/alarm-status-tags/7.8


6.  

7.  

8.  

9.  

10.  

 

Bind the  of the  to the  by navigating to the path using the Text property Label Expression    Link 
 in the upper right corner of the Expression window.  Combine the expression with the icon

literal string value   “Active Alarms."

Combine Expression with Literal String Value

{Root Container.Label.activeAlarms} + " Active Alarms"

You want to make sure the Active Alarms label stands out on the Navigation window, so let's 

change the color to something bright and make it blink.  Right click on the  and select Label Cust
omizers > Style Customizer.
 
For the , select  and for the , select Driving Property activeAlarm, Styled Properties Backgrou

, ,  and , and click on the green arrow pointing to the nd Color Foreground Color Border Visible
right and add them to the  list.Used Properties
 
Under the , click on the green arrow at the bottom 2 times to add 2 .  Click Styles area Values

the    to open and customize the style for the Active Alarm Label.  Set the Expand buttons
following values for : Styles

Value 0
Background Color: Red
Border: Etched (Raised)
Foreground Color: White
Visible: check the box

Value 1
Click the  box.  Use the green plus icon to add 2 .  Change the values Animate animation steps
to

 Duration: Step 1 1000
Background Color: Red
Border: Etched (Raised)
Foreground Color: White



10.  

Visible: check the box

 Duration: Step 2 1000
Background Color: Red
Border: Etched (Raised)
Foreground Color: White
Visible: check the box 
 

.

Click OK.  

Now you have a label on the Navigation window that shows the number of Active Alarms.  This 
example shows 7 Active Alarms.  The Active Alarm label is easily visible to the operators and easy 
to create. 

 

 

Next...
 

 



Alarm Journal
 

An alarm journal stores historical information about alarms in a database. It can store basic data about alarms that have occurred, such as their 
source and timestamp, along with associated data on the alarm, and the values of the alarm's properties at the time the event occurred. The alarm 
journal is used by the  Component, and can be accessed through scripting functions and direct database queries.Alarm Journal Table 

The Gateway can have more than one Alarm Journal. Alarm Journals have options to filter which Alarms are stored in the journal therefore by having 
more than one alarm journal configured on the Gateway it is possible to store some alarms in one table and different alarms in a different table.

 

 

In this section ...

 



1.  

2.  

3.  

4.  

Create Alarm Journal Profile
 

In Ignition, an Alarm Journal stores historical information about alarms in a database. It can store basic 
data about alarms that have occurred, such as their source and timestamp, along with associated data 
on the alarm, and the values of the alarm's properties at the time the event occurred. The Alarm Journal 
is used by the  component that can be accessed through scripting functions and Alarm Journal Table
direct database queries.

To create a new Alarm Journal profile

Go to the   section of the Gateway.Configure
 
Choose   from the menu on the left.Alarming > Journal
The Alarm Journal Profiles page is displayed.
 
Look for the orange arrow and click on  . Create New Alarm Journal Profile...
The New Alarm Journal Profiles page is displayed.

Fill in the fields and click the  button at the bottom of the page.Create Journal
Once completed, the tables will be created for you once an alarm event occurs. It’s a good idea 
to trigger a test alarm and verify that Ignition automatically created the tables in the database 
after your Alarm Journal Profile was created. 

You can easily verify the Alarm Journal tables from the Ignition . Open it and go to the Designer
menu bar and select Tools > Database Query Browser.

The 2 tables that Ignition automatically creates are the alarm_events and 
alarm_event_data.  Alarm events consist of 2 main types of data:  the primary information about 
the alarm, such as transition state, time, etc., and the event data.  If you don’t see these 2 tables 
in your database, you need to make an alarm occur after the Alarm Journal Profile is 
created.  Make the alarm Active, take it back to Clear, Acknowledge it, and you will start seeing 
information come into these tables. 

Double click on the  , to see all the events that occurred when the alarms are alarm_events
active, when they’re cleared, and when they are acknowledged.  

Create Alarm 
Journal Profile

Watch the Video
 

 

https://www.inductiveuniversity.com/video/create-alarm-journal-profile/7.8


4.  

The   is all the associated data that is associated with each alarm. alarm_event_data

You will want to look into the Database Query Browser to simply verify that the information is 
there.  Once the information is there, close the Database Query Browser. 

Note: if the tables were not created, check the Gateway console page for any errors.

Journal Options

Main

Name The default name is Journal.

Enabled By default the journal profile is enabled.

Datasou
rce

This is the ONLY required setting which must be a valid database connection, events are stored to this datasource.

Minimu
m 
Priority

Only events equal to or greater than the specified priority will be stored. The default is Low. You can set the priority to be: Diagnostic, 
Low, Medium, High, and Critical.

Store 
Shelved 
Events

Not enabled by default. If enabled, events generated by "shelved" alarms will still be written to the journal system.

Use 
Store 
and 
Forward

Enabled by default, which means the alarm journaled events will be stored through the Store and Forward system. If not enabled, they 
will be stored directly against the database. This system protects data from being lost due to temporary database connectivity issues.

Stored Event Data

Alarm events consist of two main types of data: the primary information about the alarm, such as transition state, time, 

etc. , and the . event data
The following settings specify what type of  is stored:event data

Static 
Config

By default, it is not selected. If selected, will store the values of static alarm configuration. That is, the alarm properties that are   boundnot
. These do not change during evaluation, only when a user modifies them in the Designer, and so they are not stored by default.

Dynamic If selected, will store the values of dynamically bound alarm configuration properties. The value of these properties can change at any 



Config time, and the values at the time of the alarm are captured on the alarm event.

Static 
Associat
ed Data

If selected, will store the values of non-bound associated data (properties created by the user) properties on alarm that do not change 
during execution.

Dynamic
Associat
ed Data

If selected, will store the values of dynamically bound associated data (properties created by the user) properties.

Data Filters

Filtering 
Settings

The minimum priority and store shelved events options filter what time of alarm events are stored in the journal. "Shelved" events are 
alarms that have been temporarily silenced by operators. Though they are not displayed to users, these events continue to be 
generated, and can be stored if the journal settings permit it. When stored, they will have a special flag indicating that they were shelved 
at the time.

Filter by 
Alarm 
Source

Only events matching the source will be stored. Multiple sources to match can be comma separated. Leave blank to store events from 
all sources.

Filter by 
Display 
Path

Only events matching the display path will be stored. Multiple display paths to match can be comma separated. Leave blank to store 
events from all display paths.

Filter by 
Display 
Path or 
Source

Only events matching the display path, if defined, will be stored. Multiple matches can be comma separated. If no display path is 
defined, only events matching the source will be stored. Leave blank to store all events.

Data Pruning

Enable 
Data 
Pruning

Default is not enabled. If selected, data will be deleted after the specified time period as set by the Prune Age and Units below. Note 
that since the data is stored directly in a database, an administrator is free to manually delete data at any time.

Prune 
Age

The default is 1.

Prune 
Age 
Units

The default is YEAR. You can choose the unit to be MS, SEC, MIN, HOUR, DAY, WEEK, MONTH, and YEAR.

Advanced

These settings let you specify your own table names. This is especially useful when trying to use multiple alarm profiles 
within a single database (not common, but can happen, especially with multiple systems sharing a single database).

Table 
Name

The default is . The table name for the core event table.alarm_events

Event 
Data 
Table 
Name

The default is . The table name for event data associated with alarms.alarm_event_data

 

Table Definitions

The alarm journal system will automatically create the necessary tables for you, and scripting functions can be used to query the system without 
having to know about the table structure. However, understanding the structure of the alarm journal tables can be useful for accessing the data 
in situations where SQL queries are more convenient.

Alarm Events ( )alarm_events



This table stores the core data for each event that occurs. An event is a transition for an alarm between active, cleared, or acknowledged. Additionally, 
other events may be stored in this table that aren't directly related to an alarm, such as a system shutdown event. This table defines a primary key 
"id", that is used as a foreign key by the Alarm Event Data table, which stores additional information for each event.

 

Column 
Name

Data 
Type

Description

id integer A unique integer id for each event entry event

eventid string The UUID of the alarm event that this individual event is related to. Each  (one particular alarm event active/clear
 cycle of a defined alarm) receives a unique  in order to distinguish it from other events from the/ack id

same source.

source string The qualified path of the entity that generated the alarm event. See below for more information about qualified paths.

display path string The value set for the "Display Path" of the alarm. Generally a user defined, friendlier version of the source.

priority integer The priority or severity of the alarm:

0: Diagnostic
1: Low
2: Medium
3: High
4: Critical

eventtype integer The type of transition represented by this event:

0: Active
1: Clear
2: Acknowledgement

eventflags integer A numeric bitmask flag field providing additional information about the event.
Bit 0: System Event - See below for more information
Bit 1: Shelved Event - The alarm was "shelved" at the time that the event occurred. Shelving alarms does not prevent 
execution, so if the journal is configured to store shelved events, they will be stored even if they're not sent to the 
notification system, or shown to users.
Bit 2: System Acknowledgement - When the "live event limit" (defined in general alarm settings) is exceeded, the system 
will automatically acknowledge overflow events, and the acknowledgment event will have this flag set.

eventtime datetime The time of the event.

 

Alarm Event Data (alarm_event_data)

This table stores the properties associated with an alarm event. The individual event is referenced through the   column, against the alarm event ID
table.

Column 
Name

Data 
Type

Description

id integer The id that corresponds to the alarm event in the alarm_events table.

propname string The name of the property. May be one of the common alarm properties (a configuration setting), or the name of an 
associated data property.

dtype integer The data type of the property, indicating which data column should be used:
0: Integer
1: Float
2: String

intvalue, 
floatvalue, 
strvalue

integer, 
float 
(double), 
string

The corresponding value columns for the property. Unused columns will
receive "null" values.

 

About System Events

System events are stored in the journal to record actions that aren't directly related to a particular alarm.



Currently the following events are stored in the journal:

System Startup

System Shutdown

Alarms Shelved

Alarms Un-shelved

Qualified Paths

A qualified path in Ignition is a path to an object, described by various annotated components. Each component has a type identifier and a value, 
separated by a colon ( ), and each component is separated by colon-forward slash ( ). For example, an alarm is identified by  . : :/ alm:Alarm Name
It usually exists under a tag, in which case its fuller path would be  . Paths can be built up further depending tag:Path/To/Tag:/alm:Alarm Name
on the level of specificity required by the situation.

 

Next...

Alarm Journal Component

 

 

 



Alarm Journal Component
 

The  component provides a built-in view to explore alarm history that has been Alarm Journal Table
stored in an Alarm Journal. 

Before viewing alarm history, you must first tell Ignition to log alarms in your database by creating your Al
. arm Journal Profile

 

Alarm Journal Component

There is a pre-built component in Ignition called the Alarm Journal Table that allows the database to 

see this alarm history.  In the Component Palette, under Alarming, drag the Alarm Journal Table 
component to your window and you’ll see the history of all the alarms that occurred.  

By default, the Alarm Journal Table does not filter out any of the alarms.  The Alarm Journal Table shows 
you all the alarms stored in the default Alarm Journal.  There is no date filtering and no filtering on which 
profile that you want to pull it from.  The alarms are color coded so you know what each of the states 
represent.  You can right click in the header to hide or show columns.  You can also move columns 
around by clicking them and dragging.  You can sort by a column by left-clicking it, or sort by multiple 
columns by holding the  key while clicking the column headers. You will see small numbers to Ctrl
indicate the sort order and direction (ascending vs descending).

You can click on individual alarms, then click the buttons in the lower right corner of the component to 
view the  as well as the  to see all the information that is associated with the individual Details Notes
alarm. 

Alarm Journal 
Component

Watch the Video

 

 

Additional information on the Alarm Journal Table component can be found on the Alarm 
Journal Table page in the appendix.

https://inductiveuniversity.com/video/alarm-journal-component/7.8
https://legacy-docs.inductiveautomation.com/display/DOC/Alarm+Journal+Table
https://legacy-docs.inductiveautomation.com/display/DOC/Alarm+Journal+Table


 

 

Next...

Alarm Journal - Filter on Date Range
Alarm Journal

 

 



1.  

2.  

3.  

Alarm Journal - Filter on Date Range
 

You can filter the alarm history data stored in  component for all alarms within a Alarm Journal Table
specific start date and end date.

When you first put the Alarm Journal Table component on a window, Ignition shows you the last 8 hours 
of alarm events that are in the history table of the database.  By default, there is no filtering of 
alarms.  You typically want to filter for alarm events in a specific time period rather than scroll through a 
list of events.  You don’t want operators to see everything, but to choose a start date and end date so 
they can see the alarm history for a specific time period.  This is very easy to setup on the Date Range 
component.  

Ignition offers several types of date pickers under the Calendar tab of the Component 
Palette.  This example uses the .  The Start Date and End Date are all Date Range component
built into this one component so you can select the Start Date and End Date all in one 
place.  Drag the   from the Calendar tab to your window above the Date Range component
Alarm Journal Table.  

To link the Alarm Journal Table component to the Date Range component, first select the Alarm 
, click the , bind it to a  and select Journal Table component Start Date binding icon Property,

the Date Range’s Start Date.  Click OK. 

 

 Now, do the same for the Click the , Alarm Journal Table's End Date.   End Date binding icon
bind it to a , and select the  .  Click. . Property Date Range's End Date OK

Alarm Journal - 
Filter on Date 
Range

Watch the Video
 

 

 

 

 

https://inductiveuniversity.com/video/alarm-journal-filter-on-date-range/7.8


3.  

4.  

5.  

6.  

 

By linking the Alarm Journal Table and the Date Range components together, as soon as the 
operator changes the Start Date and End Date on the Date Range, Ignition automatically 
updates the Alarm Journal Table and all the alarm events within that time period will be 
displayed.  
 

Click on  and move the slider to the left.   You will notice there are no events in Preview Mode
that time period.  

 

Now, move the slider to the right, and you will see all the alarm events within that time period.  

 



6.  You can also zoom in or out on specific time periods to see the alarm events that exist in the 
history table.  

It is very easy to filter alarm events based on time.  It’s important to note that the Alarm Journal Table 
does not pull data unless the start or end date properties are changed and when the window is first 
opened. So if you want to see new events come in to your table, you have to change the Date 
Range.  Use the slider to move back and forward to start seeing new events come into the table.   
 

 

Next...

Alarm Journal - General Filtering

 

 

Use the Date Range slider and mouse to see new alarm events

To see new alarm events, move the slider back and release the mouse, then drag the slider 
forward to the current date/time and release the mouse.



Alarm Journal - General Filtering
 

Ignition provides a host of filters to view alarm history data.  Not only can you filter the Alarm Journal 
Table on a  to see alarm history data within a specific time period, but there are also a number date range
of other filters you can use as well.

In the Alarm Journal Table component you can filter on alarms in 2 different areas on the table; filter 
properties in the Property Editor and the filter icons located at the bottom of the Alarm Journal Table 
component.  In this section, we will focus on filtering alarm data using the filter properties in the Property 
Editor.

In the Property Editor, you will notice that you have 4 checked boxes for different type of alarm events 
that you can filter on:  , ,  and .  For System Events Active Events  Cleared Events Acked Events
example, if you uncheck the Cleared Events and Acked Events, you will only show the Active and the 
System events.  If you want to show only Active events, check Active Events and leave the other events 
unchecked.  It's easy to configure the event filters on the type of alarms you want to see.  You can also 
filter on , ,  and even create your own . Source Path Priority Display Path  Search String

This example shows a basic filter displaying all the alarm events.  Each color represents a different alarm 
state.  You can also right click in the column header to show or hide columns, reorganize the columns, 
and resize the columns.

There is also a way to filter alarms based on a tag path, tag provider and alarm name.  If you configure 
alarms in particular folders in Ignition, you can use the  to find alarms by tag path.  In this Source Filter
example,  was entered using wildcards in the Source Path field to find all the Machine alarms *Machine*
in all the Machine folders.  

 

You can also filter on alarms by name using the which was setup in the alarm Display Path Filter 
configuration.  In this example,  was entered in the Display Path field to find all the alarms in the  *Ramp*
system with a 'Ramp' name.  

Alarm Journal - 
General Filtering

Watch the Video
 

 

 

 

 

Alarm Journal Profile

 To view alarm history, an  must be created first before logging alarms to Alarm Journal Profile
the database.

https://inductiveuniversity.com/video/alarm-journal-general-filtering/7.8


 

You can also create your own  to find specific alarms, events and conditions.  In this Search String
example,  was entered in the Search String field to find all Machine B alarms in the system.  *Machine B*

 

Lastly, you can also filter alarms based on .   Typically, when you open the Alarm Journal Table, Priority
it displays every single alarm on all the priorities from Diagnostic to Critical.  If all you want to do is 
display Critical alarms, select ‘Critical’ from the  field and ‘Critical’ from the  Min Priority Max Priority
field.   Now, only the Critical alarms will be displayed in your table.  

 

All of the Alarm Journal Filter properties are bindable so you can design your windows and let the 
operator choose and filter the alarm data based on how they want to display it. 

 

 

Next...

Alarm Journal - Filter on Associated Data

 

 



Alarm Journal - Filter on Associated Data
 

You can filter the  component on an alarm's associated data to define, search, and Alarm Journal Table
display the exact data you are interested in from the alarm history data.  

Once associated data is added to an alarm, you can easily filter for specific alarms in the Alarm Journal 
, as well as the  and . Typically, the Alarm Journal Component Alarm Status Component Alarm Pipelines

Table shows you the complete history of all your alarms within a specific time period using the Date 
 component.   In this section, you will see how you can filter the Alarm Journal Table to find Range

particular alarms based on associated data configured in an alarm. 

In this example, a ' tag was used and added to an alarm.   You can see that 2 alarms 'WriteableFloat1
were configured for 'WriteableFloat1,' but only one has associated data.  Associated data was added to 
the  called ‘  and was given a static value of   You can filter on what is High Alarm Group’ ‘Group A.’ 
shown in the alarm list based on the associated data.  You can search for all the Group A’s or whatever 
associated data that was added to your alarm.   

Once your associated data is configured in your alarm, the next thing you need to do is setup your script 
to filter for all the alarms in your history that have the associated data named 'Group' with a value of 
‘Group A’.  Instead of using the properties in the Property Editor, go to the  and use an Scripting area Ext

.  ension Function

Right click on your Alarm Journal Table component and select .Scripting
Under the   folder, click Extension Functions 'filterAlarm.'
Check   and enter the following code at the bottom of the 'filterAlarm' script.  Enabled

'filterAlarm' on associated data

group = alarmEvent.get("Group")
if group == "Group A":
        return True
return False

 

Alarm Journal - 
Filter on 
Associated Data

Watch the Video
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What the ‘filterAlarm’ script is doing, is for every alarm matching ‘Group A,’ it will return ‘True,’ and show 
the alarm in the table.  If the associated data does not match ‘Group A’, it will return ‘False,’ and the 
alarm will not show up in the table.

Scripting allows you to use the 'filterAlarm' function for associated data.   Essentially, this script is only 
going to show you the alarms matching the associated data.   You can add other filters as well depending 
on your requirements.

This example shows the updated ‘filterAlarm’ script.  

Press .  By default, the script is not going to automatically use your new filter until the data is OK
updated.  This happens automatically when a window is opened, but to trigger the associated data filter 
now, you can just change the or  The easiest way is by moving the Date Range Start Date   End Date.
slider if you have one already bound.

Click   and move the  slider to initiate the associated data filter.   Preview Mode, Date Range

Now, the Alarm Journal Table will show only alarms for   So it is very easy to filter on 'Group A.'
associated data.  The associated data is outside the folder structure and outside the Display Path.  It 
allows you to filter any way you want so you can look at alarms in a particular area of the plant or for a 
certain set of alarms. 

 



 

Next...

Alarm Journal - Row Styles

 



Alarm Journal - Row Styles
 

You can customize the row styles for different states of alarm history on the  Alarm Journal Table
component.

Just like the Alarm Status Table, the Alarm Journal Table comes with a particular set of colors associated 
with each of the alarm states as shown in this example.  The Alarm Journal Table has a built-in feature to 
change the colors of each individual row based on the state of the alarm.  You can change each of these 
colors for each of the alarm states in the .Alarm Rows Styles Customizer

Right click on the  and go down to and select Alarm Journal Table Component Customizers Alarm 
The Alarm Row Styles window will open like the one in this example.Row Styles.    

You can see the default styles, colors and states.  You can add as many styles as you want.  Each style 
has an expression, a color, and if you want it to blink or not.  In this example, the SystemEvent is white, 
the Active is red, Clear is blue, and Ack is green. 

You can add more styles or modify the expressions that currently exist.  Click on the green plus icon 

 to add a new row. 

In this example, Row Styles gives you a head start for building your new expression.  You can use 
priority, state, display path, active time, cleared time, etc., in your expression. You can do any 
evaluations you want and use any parts of the alarm for building your expression.

Alarms are evaluated in sequential order, from top to bottom.   The first alarm that returns  is the  ‘True’
style that will be used.   If the alarm returns  that style will not be used.  'False,'

Alarm Journal - 
Row Styles

Watch the Video
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Once the changes are made to row styles, you can see that all the red alarms are the Active alarms, all 
the Cleared are blue, and all the Ack are the green alarms.  So you can see how easy it is to add more 
alarm states, and change the colors of each of the individual rows in Alarm Journal Row Styles.  

Refer to the  section to learn more about alarm properties and how they are used in the Alarm Properties
Alarm Row Style Customizer.

 

Next...

 

 Alarm Journal - Focusing on Alarms

 

 



Alarm Journal - Focusing on Alarms
 

Focusing on alarms is a really nice feature built into the Alarm Journal Table component that allows you 
to focus on a specific alarm in the alarm event list.  Typically, the Alarm Journal Table shows you the 
history of all your alarms within a specific time period that you selected using the   Data Range
component.  The   allows you to focus in on one specific alarm to view the history for that Focus feature
alarm. 

In this example, you can see a lot of Machine C and Machine D alarms including quite a few Ramp 
alarms.  As you can see, the Alarm Journal Table is displaying a complete list of all alarms.   

If you want to see just all Machine C alarms, click on any alarm event.  Go to the bottom of Machine C 

the Alarm Journal Table and click on the  which looks like a little target symbol.    It Focus icon
allows you to focus on the Alarm Source or the Event Id.  Select the  option.  The Target Alarm Source
Target Alarm Source is simply the name, Machine C.  

Once you click on the Target Alarm Source you will see all the Machine C alarms.  You can see all the 
alarm event activity that occurred for Machine C including the changes to the Active and Cleared 
states.  You can then remove the focus from Machine C and go back to see the complete list of all 
alarms by clicking on the  again.    Focus icon

You can also focus on a specific alarm Id; one specific event that already happened.  In this example, Ra
  was selected, and the  was mp 3/9/16 at 10:36 AM with an Active state Target Event Id

clicked.  Focusing on the Target Event Id will show you all the alarms occurring for that specific alarm 
event.  

Alarm Journal - 
Focusing on Alarms

Watch the Video
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You can see when an alarm went Active, when it was Cleared, and when it was Acknowledged.  Click the 
 to remove the focus and return to the complete list of all alarms. Focus icon

When you have a big list of all alarm events, the Active, the Cleared and the Acknowledged states are 
not going to be in sequential order depending on when the event times actually happened so it helps to 
use the Focus feature to to filter on alarms.

Using the Focus feature, you can actually focus on one Target Alarm Source or the Target Event Id to 
look at when alarms occurred.  It’s a nice way of filtering through the Alarm Journal Table without having 
to scroll through the entire list of alarms to match up the alarm events, times and states. 

 

Next...

Alarm Journal - Searching

 

 



Alarm Journal - Searching
 

Another nice feature of the  component is the ability to search through the history of Alarm Journal Table
alarms and filter for particular alarms with any criteria.  The Search feature is built into the Alarm Journal 
Table component. There are no extra components outside of the table to bind these properties too.  On 

the bottom right side of the table, you can see the little Filter icon.   Click on the Filter icon to start 
your search.

You can type in any search criteria you desire as well as filter on Priority and Event types.  This example 
shows how to find all Machine D alarms.  Enter  in the Search bar. The ‘Machine D’ Alarm Journal Table
will display only the results for Machine D, essentially, letting the operator enter their own criteria and 
perform the search without having to include other components or bindings. 

 

You can also filter on .  This example shows all the alarms with a priority from Medium to Critical. Priority

Alarm Journal - 
Searching

Watch the Video
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You can also filter based on the type of events you want to see.  If you only want to look for just the 
Active alarms, you can uncheck everything else and simply leave the  checked.   Active Events

If you only want to display the Cleared alarms, you can uncheck all the other events and leave the Cleare
 checked.d Events

 

 

Next...
 



Alarm Notification

Alarm Notification Profiles

A notification profile defines a delivery channel by which an alarm notification message is sent to a user. There are three types of delivery channels: 
Email, Phone, and SMS.

Email
The Alarm Notification Module comes with one-way and two-way email notification profiles. The one-way email notification profile simply 
sends an email containing the alarm notification message. The two-way email notification profile sends an email that contains links that allow 
that user to acknowledge the alarm(s).

Voice
The Voice Notification Module adds the ability to notify users by calling them on the phone.

SMS
The SMS Notification Module adds the ability to send text messages to users to notify them of alarms.

   

   

In this section ...  

   

   

Voice and SMS Notification may require additional hardware purchase such as a cellular modem or the subscription to a SMS texting 
service.
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2.  

3.  

4.  

5.  

Email Notification Profile
 

Alarm notification is the act of sending a message to a group of people when an alarm becomes active or 
cleared. In Ignition, this functionality is enabled by having the Alarm Notification Module installed which 
provides alarm pipelines and email notification.

Once you have your Email Notification Profile created in Ignition, you can notify people when alarms 
occur via Email.  If the two-way setting is enabled, operators can also acknowledge the alarm by clicking 
the link in the body of the email.

To create an Email Notification Profile

Go to the  section of the Gateway.Configure
Choose  from the menu on the left side.  The Alarm Notification Profile Alarming > Notification
page will be displayed. 
Click on the  link. Create new Alarm Notification Profile

Select the  and click . Email Notification Profile Next

 

 Configure the following settings in the Email alarm Notification Profile:

Enter a : EmailName
Click the  box to enable Email notifications.Enabled
Enter the :  You can use your company's SMTP server, Gmail, Yahoo, etc.Hostname
Enter the . The default is  , but your mail server may be different. Port Port 25
Enable  if you are using encryption.SSL/TLS
Enter your   and   if they are required.Username Password
Click the  box if you want to make your Email Notification Profile two-Two-way Enable
way so that the operator can acknowledge the email. There is a link to acknowledge 
the alarm in the email.     You must have a connection back to the Ignition Note:
Gateway.  So, if you are working from home and not on a VPN, you will either have to 
get on a VPN or expose your Ignition server on the internet.  You can do this with port 
forwarding, talk to your IT department about it.
Auditing: You have the option of attaching emails to an Audit profile so that Ignition 
can store all the events associated with the Email Notification Profile. (I.e,, who is 
receiving alarm and who is acknowledging an alarm).
Once you have all the settings correct, such as the SMTP server, the Two-way 
Enabled, and Auditing, you can click the  Create New Alarm Notification Profile
button.  

Email Notification 
Profile

Watch the Video
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5.  

6.  Once you created your Email Notification Profile, you will see that it exists in the list of Alarm 
Notification Profiles, and it will be running.  Now, it's available to choose when you want to notify 
certain people when alarms occur.  

 

Next...

SMS Notification Profile
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SMS Notification Profile
 

The  allows you to deliver SMS alarm notifications via a cellular modem SMS Notification Module
configured with a SIM card belonging to an active cellular account. If enabled, recipients of these 
messages can reply with a special code in order to acknowledge the alarm.

To create an SMS notification profile

Go to  section of the Gateway.Configure
Choose  from the menu on the left. Alarming > Notification
The  page is displayed.Alarm Notification Profiles
Find the orange arrow and click on  .Create new Alarm Notification Profile
Select the  profile type and click .SMS Notification Next
Set the following settings concerning your device.

Airlink Host Address: The IP address of the airlink modem.

Send Port: Configured in the device, the default port is 17341.
Receive Port: The port used by Ignition when two-way messaging is enabled. Therefore, the 
port must not already be used by the host system, and must not be blocked by a firewall. The 
default port is 17342.

Two-way Enabled: Default is not enabled. If enabled, the message recipients can acknowledge 
alarms by replying to the SMS messages received. This is communicated to Ignition via UDP 
data sent from the modem. Therefore, the Airlink modem must be configured with the IP 
address of the system.
Ack Code - The default is not enabled. Ack code must be enabled to acknowledge an SMS 
message. 
 
At the bottom of the page click on   to save the profile. Create new Alarm Notification Profile    

Device Configuration

You can do the basic configuration for the Airlink modem by importing a template settings file provided by 
Inductive Automation. Please reference the Knowledge Base article link on this page.

Multiple Systems with One Modem

You can use one SMS modem with multiple Ignition systems for one-way messaging. Only one system 
can receive responses for two-way messaging.

Twilio Module

SMS notifications can also be sent with the Twilio module. This does not require a cellular modem, but 
the gateway must have Internet access, and a Twilio account must be created ( ). Once www.twilio.com
created, the account must be defined in Ignition.

To define a Twilio account

Go to   section of the Gateway.Configure
Choose from the menu on the left. Twilio > Accounts 
Click the   link.Create new Twilio Account
Provide a  for the account as well as the   and    .Name  Twilio Account Sid, Twilio Auth Token
Both the Account SID and Auth Token can be retrieved from the Account Settings menu in 
Twilio. 
If desired, provide the  . This is the hostname or IP address that inbound Public Hostname
requests will be forwarded. If the users should be able to acknowledge alarms by responding to 
the SMS messages, then this property should list a publicly reachable hostname or IP address. 
Click the Create New Twilio Account button.

Once the account has been defined, a Twilio SMS notification profile must also be created. 

To create a Twilio SMS notification profile

Go to   section of the Gateway.Configure
Choose  from the menu on the left. Alarming > Notification
The   page is displayed.Alarm Notification Profiles
Find the orange arrow and click on  . Create new Alarm Notification Profile
Select the   profile type and click  .Twilio SMS Notification Next

SMS Notification 
Profile

Watch the Video
 

  

AirLink LS300 
Setup Guide

Link to Knowledge 
Base Article
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5.  

6.  

Provide a name for the profile, and select a  from the dropdown.Twilio Account 
enables users to respond to notifications directly from the SMS Acknowledgement Allowed 

message. if enabled, the  property in the Twilio Account must be configured Public Hostname 
(see step 5 in "To define a Twilio account" above. 
Click Create New Alarm Notification Profile

   

   

Next...

Voice Notification Profile

 

 



Voice Notification Profile

The Voice Notification Module adds the ability to deliver alarm notifications to users via telephone, using 
most SIP compatible phone system, excluding those requiring Cnonce. Messages are constructed in text 
and are delivered through a high quality text-to-speech engine. The engine supports multiple voices and 
languages.

Core Features

Deliver voice calls through any SIP compatible phone system. No dedicated hardware 
required. Messages generated by high-quality text to speech, and not a canned set of prerecorded files. 

Supports multiple languages concurrently, based on user preference.
Allows users to acknowledge events.
Supports requiring a personal identification number for additional security.
Ties into the audit log to audit call events, successful message delivery, and 
user acknowledgements.
Supports message consolidation.

Voice Notification 
Profile

Watch the Video

     

About SIP and VOIP

The Session Initiation Protocol, is a highly popular specification for implementing Voice Over IP (VOIP) based phone systems. The protocol itself, as 
the name suggests, is responsible for initiating communication sessions, and then other protocols such as SDP and RTP are used to actually 
transfer voice data. Ignition has these protocols built in, SIP is a peer-to-peer protocol, where one side talks directly to the other. However, it is 
possible to have gateways that repeat and route data between the two parties. Sometimes phone calls on VOIP networks stay purely in software, but 
often a gateway will transition the call to a traditional phone line.

By leveraging SIP, Ignition can call physical phones, soft phones, be worked into more complex PBX schemes, while avoiding the high cost of 
traditional, dedicated voice cards. To get started, though, you’ll need some sort of SIP gateway. Asterisk is a popular, open source, system that is 
used by thousands of companies worldwide. If you simply want to connect to a phone line, the Atcom IP01 FXO box is a low cost device that runs 
Asterisk.

Gateway Configuration

To get started with voice notification, add a new profile by going to Configure -> Alarming -> Notification in the Ignition gateway. You are only required 
to specify the host address of the SIP gateway, though depending on the gateway, you may be required to enter a username and password. 

There are additional settings that dictate how calls are managed, such as timeouts for answering, and the maximum amount of time that a call can 
take. Additionally, you can choose to link the notification profile to an audit profile in order to record important call lifecycle events. 

After saving the profile, you should see the status update from “Unknown” to “Registered”, indicating that the gateway has successfully registered with 
the SIP gateway. If you see an error, verify that the settings are correct, and that the username and password are correct. The system log console 
can also be useful in determining what is wrong.

Note: If you receive errors indicating that an “invalid parameter” has been used, try setting the local and public bind interface settings under the 
advanced options. These should be set to the IP address of the network card that is being used to communicate with the SIP gateway. On some 
systems, especially Linux hosts, the default empty values result in this error.

Using Skype

If you don’t have an existing VOIP system in place, using a hosted service is the quickest way to get going with the voice notification module. Skype 
offers SIP based service through their Skype Connect product. To get started, you must have a business account, which provides you access to the 
Skype Manager. From there, you can create a new Skype Connect channel. For more information, visit http://manager.skype.com

Once you have created a Skype Connect channel, configuration in the gateway is similar to that of any other PBX system. The host will be “sip.skype.
”, and the user name and password will be those provided by skype during the registration process. Note: while skype allows to you specify how com

many “channels” may be used, Ignition currently only supports one channel at a time.

Configuring Messages

The message played to the user during the phone calls is defined in the call script. The script dictates the overall structure of the call, defining the 
phrases and options, and the possible responses. The messages for each alarm are built off of a message template that can reference properties in 
the alarm. The script can be edited by selecting “manage scripts” next to the voice notification profile. Note: Although the link appears next to a 
particular profile, the scripts are shared across all voice notification profiles.

For the  to work, a compatible Voice Module must also be installed.Voice Notification Module

https://inductiveuniversity.com/video/voice-notification-profile/7.8
http://manager.skype.com
http://sip.skype.com
http://sip.skype.com


The role of each phrase in the script is explained on the settings page. Some parts of the script, such as the phrase requesting the user’s PIN number, 
will only be used if certain settings are configured on the notification block in the pipeline (in this case, the setting to require a PIN). As 
previously mentioned, the alarm message (for both active and clear) can reference any property of the alarm. The default message looks like this:

At {eventTime|hh:mm:ss}, alarm named {name} became {eventState} with a value of {eventValue}

In this case, the message refers to the alarm name, the eventState and eventValue (note: eventState is different than state. Event state is just the 
transition that triggered the alarm, such as “active”, whereas “state” is the full current state, such as “active, unacknowledged”), and the eventTime. 
Notice that the event time is formatted to only use the time, and not include the current date.

Scripts can be created for different languages. When the system attempts to deliver a notification, it will look to see if the target user has a preferred 
language. If so, and the language has both a script defined, and a compatible voice installed, the user will be notified in that language.

Note: Alarms also allow you to define a custom message, relevant to that particular state. If a custom message is defined, it will be used instead of the 
default message in the script.

The Call Lifecycle

A call is initiated when an alarm event enters the notification profile block in a pipeline. When this occurs, the target users are collected, based on the 
defined call roster, and the current schedule. Only users who have phone contact details defined will be selected for phone notification.

The voice system can only call one number at a time, and so it takes the first contact off of the queue and initiates the call. The user is given up to the 
“answer timeout” to answer. After picking up, the user will be asked to enter their pin number, or press any number to continue. The call is not 
considered “answered” until this action occurs, so the message will be repeated until the answer timeout expires. By acting in this way, the system is 
able to confirm that a human has actually answered, and the call will then be audited as successful.

Once past the initial challenge, the user will then hear the alarm messages. After each message, they will be asked to either acknowledge, ignore, or 
repeat the message. Selecting “acknowledge” will cause the alarm to be acknowledged in the alarming system, likely causing it to drop out of the 
alarm pipeline (dependant on pipeline settings). Ignoring the alarm indicates that the user has heard the message, but cannot or does not want to 
acknowledge the alarm.

Once the call has completed, the notification system will check the alarm events against the pipeline fallout conditions, and move on to the next call. 
The system will cycle through all alarms and all contacts (and all phone numbers for each contact) until everyone has been notified, or the 
pipeline settings have caused all events to drop out.

Pipeline Configuration

The voice notification system is accessed through the Notification Block in the Designer's pipeline configuration, like all other notification methods. As 
with other methods, you select a call roster, and can optionally turn on consolidation. There are only two options which can be set on the 
notification block:

Require PIN: If selected, the user will be required to enter their personal identification number in order to hear the message. The user’s PIN number is 
specified on their profile in the user management system. If false, or if the user does not have a PIN specified, the user will only be required to press 
any key to continue.

Allow Acknowledgement: If true, the user will be given the opportunity to acknowledge the alarm. If false, they will only be able to hear the alarm and 
continue.

Next...

Notification Users
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Notification Users
 

You can add users to Ignition who can receive alarms. Each user must have a name and contact 
information in order for Ignition to contact them. Users can receive alarm notifications in SMS, phone 
(voice dialout), and email.

To add a user

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Security > Users, Roles
The  page is displayed. User Sources
 
Select  from the appropriate user source.manage users
 
Look for the orange arrow and select the  link to add a user.Add User
The  page is displayed.Manage Users and Roles for Profile
 
Complete the fields that correspond to the user's information.
 
In the  section, choose the delivery method, and the appropriate value such as an Contact Info
email address.
 
Cick  .Add User

Notification Users

Watch the Video

 

 

 

   

 

Next...

User Schedules
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User Schedules
 

Schedules define the times of on-call availability and unavailability. For example, the  schedule is Always
a schedule that is active 24/7. You can set a schedule for each user in the alarm notification system. The 
notification messages are then sent only to those users with an active schedule. When a message 
reaches a notification block in a pipeline, that block's on-call roster is used to find the users with active 
schedules so they can be notified. 

To define a new schedule

Go to the  section of the Gateway.Configure

Choose  from the menu on the left.Alarming > Schedules
The Schedule Management page is displayed. Here you can see an Always and an Example 
schedule.
The  Schedule is a bAlways uilt-in schedule that is always available: 24x7x365.
The  Schedule is an example of a M-F 8am-5pm schedule with a lunch break. Click on Example
the  to see the detailed settings.edit
 
Click on .Create new Schedule

Choose a  or  schedule and click .Standard Composite Next
The  schedule is defined by hours of operation on each day, with repeating options.Standard
The  schedule is defined by the combining of two other schedules.Composite
 
On the  page, enter a , the  to be notified, and any  New Schedule Name Schedule Repeating
options, then click .Add Schedule
Each schedule is defined by which days of the week it is active for, and during what times. 
Additionally, you can define repeating patterns that repeat either weekly or daily. When defining 
time ranges, use 24-hour format and commas to break up different spans. For example, to if you 
want the schedule to be active from 8am-5pm with a 45 minute break starting at noon, you'd 
use: 8:00-12:00, 12:45-17:00.

User Schedules

Watch the Video

 

 

 

To manage schedules from the Client

You can manage schedules from a Vision Client.

Open your design project in the  .Designer
 
From the Component Palette, drag and drop a  component in your design. Schedule Management

Save your project.
Users can now manage the schedule from the Client.

Using Schedules for Alarm Notification

https://www.inductiveuniversity.com/video/user-schedules/7.8


The alarm notification system always uses the Schedules. When an alarm notification pipeline reaches a notification block, it looks at all of the users 
defined in that block's configured on-call roster. Only those users whose schedules are currently active will be notified. This way, you can group 
people in call rosters by role, not by shift. For example, suppose you have alarms that should be sent to all supervisors. You can put all of the 
supervisors in one call roster, and the scheduling system will automatically only notify those supervisors who are on-shift when the alarm goes active.

Using Schedules for Restricting Login

You can use Schedules to restrict users' ability to log in. To enable this, select the   option on the user source in question. That Schedule Restricted
user source will then reject logins for users whose schedule is inactive, even if their credentials were accurate.

 

Next...

On-Call Rosters
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On-Call Rosters
 

The On-Call Roster lets you create user groups to be notified when an alarm occurs. Each group 
includes a list of users in a specific order. Alarm pipeline's notification blocks must choose an on-
call roster which defines the users to notify for that notification block. Depending on the alarm notification 
profile used, the users can be notified one at a time (sequential), or all at once (parallel). It is important to 
remember that when an on-call roster is used for alarm notification, only those users on the roster whose 

are active will be notified.schedules 

To create and manage the on-call roster

Go to the  section of the Gateway.Configure
 
Choose  from the menu on the left.Alarming > On-Call Rosters
The On-Call Rosters page is displayed. 
 
Click on .Create New On-Call Roster
You can create as many rosters as you wish.
 
On the , enter a  , and click  .Create New On-Call Roster Name Create New On-Call Roster
 
Click on  to the right of the roster name you want to add the user list to.manage
The  page is displayed and from here you can choose one or all users from a Manage Roster
source list, drag them into the roster list, and put them in any order you wish.

To manage the roster from the Client

Roster management can take place from a Vision Client. 

Open your design project in the .Designer
 
From the Component Palette, drag and drop a  component in your design  Roster Management
window.

In the , if you have more than one user source, enter the one you want to be Property Editor
used by the roster in the  property.User Source
 
Save your project.
Client users can now manage the roster by re-arranging and adding/removing names to the 
roster.

On-Call Rosters

Watch the Video
 

 

 

 

 

 

 

   

Next...

User, Schedule, and Roster Management
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User, Schedule, and Roster Management
 

You can manage users, schedules, and rosters from the Ignition Client using components to affect the 
User Sources in the Gateway.

User, Schedule, 
and Roster 
Management

Watch the Video
 

 

 

 

 

 

Next...
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Alarm Notification Pipelines
Alarm notification pipelines are logic diagrams that control how alarm notifications are sent out, including who they are sent to and when. They can be 
used to achieve many advanced alarming scenarios, such as delays, escalation, and parallel delivery. Pipelines provide an easy to use drag and drop 
mechanism for creating complex notification scenarios.

Creating Pipelines

Before you create a pipeline in the Designer, you need to configure at least one  and at least one in the Gateway. Then alarm notification profile  roster
in the Designer, you create the Pipelines under the  node of the . Alarm Pipelines, unlike other types of resources such as Global Project Browser
windows and Transaction Groups, are global resources, and are not part of a project. A defined pipeline runs in the Gateway, and you can see 
the same pipelines available to edit regardless of the project that is currently open.

When you create a new pipeline, or select one to edit, the Designer Switches to the Pipeline Workspace. The workspace is basically a blank canvas, 
on which you arrange and connect together various . Each pipeline block has an input, and potentially has outputs. Using the mouse, Pipeline Blocks
you can draw connectors between the output of one block into the input of another. The START block, which you will see when you first create the 
pipeline, cannot be moved or deleted and is the only fixed part of the workspace. It represents the entry point for alarm events into the pipeline, and is 
treated like an output block.

Multiple outputs can be connected to a single input. Also, it is perfectly acceptable to write the output of a downstream block back to the input of an 
earlier block, creating a loop. Of course, some care should be taken when doing this, as it can easily result in unexpected behavior, like sending out 
many emails for one event!



Pipeline Blocks

Pipeline Blocks are the building blocks of the Alarm Pipelines. Each block, depending on the type, will perform some action for the pipeline, such as 
sending a notification, setting a property, or evaluating an Expression. Refer to the   secton for the different pipeline blocks that you can Pipeline Blocks
use to build your pipeline. 

Pipeline Properties

Pipelines have only a few property settings, but they are important.

To display and modify the properties

Click on the gray area of the Pipeline workspace anywhere there isn't a block. 
In the lower-left corner of the Designer, the Pipeline Properties are displayed. They are as follows:

Dropout Conditions
These dictate when alarms fall out of the pipeline. There are three possible conditions: , , and . If any of the Acknowledged Cleared Shelved
selected conditions become true for an event in a pipeline, it will "drop out" entirely, no matter where it is at. No further action will be taken for 
that event.
 
Pipeline Enabled
Indicates whether or not the pipeline is allowed to receive events.

Event Flow

Understanding how events flow through pipelines is crucial to leveraging them fully. Alarms are configured on individual tags, and each alarm can 
specify a target pipeline for active and clear conditions. When the condition for that alarm is met a new alarm event is generated and sent to the entry 
point of the associated pipeline. The alarm event then moves through the different logical elements of the pipeline until it finally reaches a pipeline 
endpoint, or until the alarm matches the pipeline's dropout condition, upon which it then exits the pipeline. There can be multiple alarm events in a 
pipeline at any given point in time and you can view the current status of the pipeline from the Alarm Pipelines status screen in the Ignition Gateway. It 
is possible to forward events from one pipeline to another, making it possible to create multipurpose and reusable pipelines. 

Each alarm event progresses sequentially through the blocks of a pipeline. However, multiple alarm events can exist in parallel in the pipeline, and 
new events may enter the pipeline at any time. Some block settings may result in alarm events being held up, such as consolidated notification, but 
one alarm event cannot affect other events in the pipeline. In this particular case, when multiple events will be collected together for notification, the 
events that don't drop out of the pipeline after notification are individually forwarded to the output of the block. 

At every transition, and occasionally inside of the block execution as well, the dropout conditions will be evaluated. If the event no longer meets the 
conditions, it will drop out of the pipeline. It is crucial to understand how this works in order to understand pipeline execution. For example, a 
common scenario is to place a Delay block directly in front of a Notification block. If the delay is 5 minutes, and "Clear" is one of the pipeline drop out 
conditions, it effectively means that only events that stay active for longer than 5 minutes will actually result in notifications. If acknowledge is one of 
the dropout conditions, it would mean that operators (or anyone viewing alarm status) would have 5 minutes to acknowledge them, and only then 
would notifications be sent.

Event Instances and Runtime Properties

As mentioned, a new "alarm event" is generated each time an alarm transitions to active. This event consists of core data, but also has arbitrary 
properties available on it. The alarm configuration properties are available, as well as associated data, but in addition there are "runtime properties", 
that only exist while the alarm event is in memory, and are only used by pipelines. These properties can be accessed by several block types, and 
runtime properties can be created and updated with the "Set Property" block type.

During an alarm event's lifetime, its properties may be updated at any time. When an alarm goes to clear, for example, the system sets information 
about that state on the alarm event. In the pipeline, if a block accessed the "state" property, it would see a different value than if it had checked just 
moments earlier.

It may be possible for a specific alarm event to exist multiple times in a pipeline. This is especially true when using the Splitter block, which takes 
events and forwards them concurrently to multiple outputs. When this occurs, the alarm event is "branched" and a new "event instance" is created. 
Each event instance will start with identical properties, but future modifications of properties will only affect the particular instance. All instances of an 
event will properly reflect properties set later by the system, such as acknowledgement or clear state.

Pipeline Lifecycle

Given the potentially long running nature of pipelines, it's important to understand how they operate when you edit them. Each pipeline normally has 
only one instance running at a time, which handles all of the events that go into it. When you edit a pipeline and save, however, a new instance 
is instantiated. The old instance is "retired", but continues to run until all of the existing events are done. The new instance only receives events 
generated after the time that it was created, it does not take over the previous instance's events.

Commonly Used Properties

The following screenshot shows how you can access the two commonly used sets of properties in the Expression Block: the   and   properties.Main State



The   properties are information about the alarm that are independent of whether the alarm is currently active, clear or acknowledged. The are:Main

Display Path
Display Path or Source
Name
Priority
Source Path

The   properties are information about the alarm that change while the alarm is changing, and some of them even change each time the alarm State
goes from active to clear to ack (acknowledged).

Ack Time
Ack'ed By
Ack'ed By (Name)
Acked?
Active Time
Active?
Clear Time
Clear?
Current State
Event State
Event Time
Event Value
Is Shelved? 

Alarms events are made up of many different properties.  Refer to the   section for information on alarm properties and how they are Alarm Properties
used.

 

   

In this section ...  

   

   





Alarm Pipeline Overview
 

 

Alarm notification pipelines are the bridge between alarms becoming active or clear to messages being 
sent out to users.   Pipelines are a graphical mechanism for building up logic, providing an easy to use, 
drag and drop mechanism for creating complex alarm notification scenarios.  Using pipelines, it is 
possible to accomplish many tasks such as alarm escalation, notification consolidation, conditional 
dispatch and more.

Let’s look at how a pipeline works.  Pipelines are created in the  of the Project Browser in the Global area
 section in the Designer.  You can right click on Alarm Notification Pipelines Alarm Notification Pipeline

to create new pipelines as well as organize pipelines into different folders.

You can build your notification pipeline from the  above yourpipeline workspace.  The Pipeline Blocks
primary goal of alarm pipelines is to notify a group of people about an active alarm.    

 

 

Every pipeline has a .  All alarms are configured to go directly into the Start Block when an Start Block
alarm becomes Active, Cleared or Acknowledged.  

In this example, we have a  and a pipeline called .  Let’s configure the  configured alarm Basic Email
specific alarm to the Basic Email pipeline.   

Click on your , open the  of the Tag Editor and click on the tag Alarming section 'High Alarm.'
In the , scroll down to the  section and select the Alarm Mode Settings Notification 'Email 

 pipeline from the dropdown list.Basic'
Click OK.

 

In this particular example, when the High Alarm becomes Active, it goes directly to the  of the Start Block
Basic Email pipeline then into the  where it notifies the roster called  using Notification Block Operators
the  notification profile.  From there, the alarm moves to the  and waits 5 minutes to Email Delay Block
see if the operators acknowledge the alarm or the alarm becomes cleared.  

When the alarm is cleared or acknowledged, it drops out of the pipeline.  After 5 minutes, if the alarm is 
still active, it notifies the Operators again.  This alarm will continue to loop around in the pipeline as long 
as it doesn't meet one of the dropout conditions.   As soon as the alarm becomes cleared or 
acknowledged, it drops out of the Basic Email pipeline. 

The next time the alarm goes active, it goes to the Start Block and kicks off the Basic Email pipeline 
again. 

Alarm Pipeline 
Overview

Watch the Video
 

 

 

 

 

This section asssumes you have a tag and a notification profile created

To learn more, refer to  and .Understanding Tags Alarm Notification

https://inductiveuniversity.com/video/alarm-pipeline-overview/7.8


 

You can use the various  to determine the logic you want to use to notify people of an pipeline blocks
alarm.  Alarm pipelines can be simple or complex based on your business process requirements.  

In the next sections, you will learn how to create your own alarm pipelines, filter on alarms, check 
pipeline status, and much more.

 

Next...

Simple Pipeline

 

 

 



1.  

2.  

3.  

Simple Pipeline
 

The most basic Alarm Notification Pipeline will simply notify users as soon as the alarm becomes active.

Let’s create a simple alarm notification pipeline in Ignition.  

In the Designer, create a new pipeline in the  by going to the Project Browser Global > Alarm 
 area.  Notification Pipelines

Select  under the Global area, and right click to create a Alarm Notification Pipelines New 
.Alarm Pipeline

When you create a new pipeline, the Designer switches to the Pipeline Workspace.  The 
workspace is essentially a blank canvas and contains various  which have Pipeline Blocks
specific functionality to help you build your pipeline.  By default, the name of the new pipeline is 
called ‘New Pipeline.’

You can rename your pipeline to anything you want that best describes your pipeline.  Select yo
 right click and  it to ur ‘New Pipeline,’  Rename ‘Notify.’  

Simple Pipeline

Watch the Video
 

 

 

 

 

Configure Alarm Notification Profile and On-Call Roster

Before you create a pipeline in the Designer, you need to configure at least one Alarm 
 and at least one  in the Gateway.Notification Profile On-Call Roster

https://inductiveuniversity.com/video/simple-pipeline/7.8


3.  

4.  

5.  

6.  

Every pipeline has a  which you will see when you create your pipeline.  When an Start Block
alarm occurs, it’s going to come to the  and from there you can use other blocks to Start Block
determine what you want to do with that alarm.  

The most basic pipeline you can create is to simply notify someone right away when an alarm 
occurs.  You will notice that there is a  above the canvas.  Drag theNotification Block  

on to your canvas and place it next to the .  Once you drag it in Notification Block Start Block
to your pipeline, it is not connected yet.   

Next, drag the output pin from the to the input pin of the .  So  Start Block  Notification Block
now the 2 blocks are connected, and when an alarm occurs, it’s going directly into the Start 
Block and then into the Notification Block.

On the , you have to configure the  that you are Notification Block Alarm Notification Profile
going use and who you are going to send it too.  You should have already configured your 
Alarm Notification Profile before creating your new pipeline. 



6.  

7.  

Click on the , and under the  choose which  Notification Block Pipeline Block Editor Notificatio
 you want to use: ,  or .  You can see that all 3 profiles are configured, n Profile Email SMS Voice

but for this example, choose . Email

Under Contacts, in the , click the  icon on the right Pipeline Block Editor  On-Call Roster
side.  Select from users and groups who you want to send this alarm too.   Your On-Call Roster 
should have already been created before creating your pipeline.

 

 
You just created a very simple Alarm Pipeline.   When this alarm becomes active, it goes directly to the 
Start Block and notifies all the operators via Email one time.   
 

Pipelines don’t do anything until an alarm is told to use it.  Once you configure your Alarm Notification 
Pipeline, the next step is to tell your alarm to use your  pipeline when the alarm becomes , ‘Notify’  Active

 or .  How to make your alarm use a pipeline is covered in the next section.Cleared ACKnowledged

 

 

Next...

Adding Pipelines to Tags

 

 



1.  

2.  

3.  

4.  

5.  

Adding Pipelines to Tags
 

Any alarm in Ignition can use an existing alarm notification pipeline. Alarms can share pipelines resulting 
in a single pipeline providing notification services to many alarms. When an alarm becomes active, 
cleared, or acknowledged it can execute a designated alarm pipeline. The information about the alarm is 
ported automatically into the alarm pipeline.

To associate a pipeline with the alarm

Double-click on a tag.
The  is displayed and you can access its properties.Tag Editor
 
Go to the  tab.Alarming
 
Select an Alarm.
 
Under the   section, select the desired alarm pipeline from the drop-down.Notification
 
Click .OK

 

Adding Pipelines to 
Tags

Watch the Video

   

 

Next...

Pipeline Blocks

 

 

https://www.inductiveuniversity.com/video/adding-pipelines-to-tags/7.8


Pipeline Blocks
 

Pipeline Blocks are the building blocks for the Alarm Pipeline Notification system.  Each block has an 
input and zero or more outputs. Each block has its own unique functionality and performs a specific 
action for the pipeline, such as sending a notification, setting a property, or evaluating an expression.

Let's look at the different pipeline blocks that come with the Alarm Notification system.  There are 8 
blocks above your Pipeline Workspace that you can choose from to build your alarm notification pipeline.  

Pipeline Blocks 

The   are described individually in this section, but here is a brief overview:Pipeline Blocks

Notification
Delivers a notification through the selected Notification Profile (i.e., Email, SMS and Voice).

Delay
Blocks the alarm event for the specified amount of time.

Splitter
Forwards a single event concurrently to multiple other blocks.

Switch
Evaluates a non-boolean Expression, and forwards to an output based on the result.

Expression
Evaluates an Expression that results in either 'T  or 'F ,' and forwards the event to that rue' alse
output.

Set Property
Evaluates an Expression, and sets the result as a runtime property on the alarm event.

Jump
Forwards the alarm event to a different pipeline.

Script
Executes a task outside the pipeline.

Start Block

When you create a new pipeline, you always get a  placed in your Pipeline Workspace.  You Start Block
cannot delete the  because it represents the entry point for alarm events into the pipeline. Start Block

Notification Block

As the name suggests, the  is responsible for sending notifications. Each notification Notification Block
block can target one particular notification profile, which represents one method of notification, such as 
Email, SMS, or Voice. Each type of notification profile will have its own relevant properties for 
configuration, although some features are common to all profile types. The various profiles will also 
behave differently, according to their capabilities, in regards to how notifications are ordered. For 
example, the Email profile is capable of sending a message to many recipients at once, while the SMS 
and Voice notification profiles must step through each contact sequentially.

Notification Block Basic Setup

There are two required settings for notification blocks: the Notification Profile and the On-Call Roster. The 
profile will dictate the method through which notifications occur, and the on-call roster will dictate who 
receives the notifications. The on-call roster provides an ordered list of contacts, which will first be pared 
down according to each user's schedule. The resulting contacts will be notified in order, based on how 
the profile operates. The settings displayed will depend on the type of profile selected.

Pipeline Blocks

Watch the Video

 

 

https://inductiveuniversity.com/video/pipeline-blocks/7.8


Email Settings

From Address  -  Email address used for the "From" field.

Message - The body of the email. Like the subject, may refer to properties of the alarm.

Message now supports HTML formatting. Simply add the <html> tag at the beginning of the 
Message property. An end tag (</html>) is not required. 

<html>This is my message. <br>That was a line break. 

Consolidated Message - The message sent when  is turned on, and more than consolidation
one alarm is being sent. Can refer to properties, and additionally support a special expansion 
syntax of "{{ ... }}", where everything inside of the double curly braces will be repeated for each 
alarm in the consolidation group.

Test Mode -  If enabled, logs to the console each time an email would be sent, instead of 
sending the actual email.

Voice Settings

Require PIN - If true, the user will need to enter their PIN in order to hear the alarm 
notification messages. The user's PIN is defined in the user management section of the 
Gateway. If false, then anyone will be allowed to hear the messages after answering the phone.

Allow Acknowledgment - If false, users will only be allowed to listen to alarms, not 
to acknowledge them.

Retries Per Contact -  The number of retry attempts per contact per alarm.  The default is set 
to 1.

Delay Between Calls - Introduces a delay between calling each contact, for each alarm. 
The pipeline dropout conditions are checked regularly between calls and while waiting, so this 
would provide time for the alarm to drop out before calling the next person. The delay is only 
enforced after following a "successful" call (a call that was answered). Unanswered or errored 
calls will move on to the next contact right away. Please note that long delays can block other 
alarms in the call queue. The delay is applied to all contacts for a particular alarm.

 The system must have For most phone systems, a delay of at least 1 second is advised.
time between each call to hang up properly before dialing again. 

 - If enabled, messages will be logged to the console indicating when and to whom Test Mode
calls would have been made, without actually making a call.

SMS Settings

Message - The message to use for single events.

Consolidated Message - Like email, the message to use when multiple events are sent 
together, due to the block's consolidation settings.

Delay Between Notification - As with voice, a delay between each message sent, to give 
the recipient time to acknowledge and prevent further notification.

Test Mode - If enabled, logs messages that would have been sent to the Gateway console, 
and does not actually send them.

Consolidation

Notification consolidation allows you to limit the number of notifications sent by specifying a delay during 
which incoming events will be collected. When the delay expires, all events that have arrived during the 
period of time will be sent together to the notification profile. The manner in which the profile implements 
consolidation will vary, but in general the result will be a shorter message, or fewer messages, than 
would have occurred otherwise.

Consolidation is defined with two parameters:

Delay - How long to wait after the first eligible alarm arrives. This setting forces a pause  before
sending a notification. The delay is used to protect against situations where an event might 
generate many alarms together. In other words, if an alarm comes into the Notification Block, it 
will be delayed for this amount of time in case there are other alarms arriving soon.

Frequency - The max frequency with which the profile can send alarms. This setting forces a 
pause  sending a notification. The frequency is used to ensure that contacts aren't notified after
too often, for example if an alarm is rapidly going in and out of the active state.



 

Drag the  to your Pipeline Workspace.  Notification Block Click the Notification tab in the Pipeline 

Block Editor.  Choose one of the Notification profiles that you configured.  For this example, choose 'Em
ail.'
 

Contacts

From the  tab, you can specify the  who you want to send the alarm notification Contacts On-Call Roster
too.  An   must first be created. In this example, several rosters were already configured. On-Call Roster
Select  as your on-call Roster.  'Operators'  

You will notice that the Notification Block is now updated with your  profile and  on-call 'Email' 'Operators'
roster.
 

 

The Contacts tab now accepts expressions, so it is possible to dynamically select a roster from the 
pipeline. The expression can make use of tag values as well as alarm properties and associated data. 

The alarm properties are accessible from the Alarm Properties button   located on the right side of 
the panel. Associated data can be manually entered using the "{" and "}" characters. 

 

if({Group}= "A","Group A","Group B")

The above expression checks for associated data on the alarm named "Group". If the value is equal to 
"A", the Group A roster is used, otherwise the Group B roster will be notified. 

When should I use quotation marks on the Roster name?

It is recommended to  . However, it is not always always place quotation marks around roster names
required for notifications to be sent out successfully. 

If the expression consists of only the name of the roster, then quotes can be omitted. For example, 
specifying that a Notification block should always use the Roster named " " could look like the Operators
following with quotes:



//This expression will evaluate successfully.
"Operators"

the expression would return the string , which is a valid Roster.Operators

However, quotation marks could be removed in this scenario. When removed, this causes a syntax error 
because strings in expressions must always be encased in quotation marks. However, instead of 
returning an error, the Notification block would assume you simply typed out the name of the roster, so 
the following example would also succesffully use the   roster:Operators

//This will fail to evaluate as an expression, so the block will instead 
look for a roster named "Operators", 
//and the users will still be notified.
Operators

However, if the expression is any more complicated than the above example, such as using an 
expression function, then quotation marks must be used. The following example would check the priority 
of the alarm. If priority was set to "critical", then the   would be notified. For all other High Priority Roster
priorities, the   would be used. Low Priority Roster

//This expression will evaluate successfully.
if({priority} > 3, "High Priority Roster", "Low Priority Roster")

However, if the quotes were removed from the roster names, the expression would fail with a syntax 
error:

//This expression will fail, so all the text is assumed to the name of a 
Roster
if({priority} > 3, High Priority Roster, Low Priority Roster)

When this expression fails, the Notification block will assume that the text is actually the name of a roster, 
and will attempt to use a roster named " ". if({priority} > 3, High Priority Roster, Low Priority Roster)
For this reason, it is a good idea to always place quotes around Roster names, as well as check your 
expressions for syntax errors. 

Delay Block

The  simply blocks alarm events for a specified period of time before moving them to the Delay Block
next block.  They are generally used to wait for the dropout condition to become satisfied for an alarm.

For example, a 5 minute delay might be used to give operators viewing control screens a chance 
to acknowledge, and only send notifications if they haven't (the "active delay" deadband on the 
alarm could be used to delay the alarm as well, but in that case it wouldn't actually be active, and 
therefore not displayed, for the delay time).

Delays are often also used to control flow in a pipeline. For example, in an "escalation" scenario, 
a notification block might be used to send emails. Since emails are sent instantly, and acknowledgment 
occurs "asynchronously" (the user must see the email and click the link or log into the system), a delay 
block could be used to provide time for the user to acknowledge, before moving on to a voice notification 
block. There is no practical limit to how long a delay can be. The delay is calculated independently for 
each event entering the block, meaning that each event will be held for the specified time.

Click the  and a spinner will appear in the Pipeline Block Editor.  You can specify the Delay Block
number of seconds to delay.  In this example, if you enter  seconds, the alarm will wait 5 minutes '300'
before sending it to the Operators.  
 



Splitter Block

The  simply forwards a single alarm event to multiple outputs at the same time.  It creates Splitter Block
a copy of the alarm event for each output and executes the alarm notifications along multiple paths in 
parallel.  You can specify as many outputs as you want.  If care is not taken, it is possible to end up with 
an exponential number of alarm event copies active in the pipelines at one time. Since each notification 
block operates on a specific on-call roster, Splitters are useful for delivering events to multiple notification 
blocks at once as shown in this example.

 

Switch Block

The   evaluates a non-boolean expression and forwards it to an output based on a given Switch Block
result.  It can be a number or string, and it will be looked up against a defined list of expected results. If a 
match is found, the alarm will follow that path, otherwise the "Catch-all" output is used.

You can create an expression and even use the alarm event's priority, associated data, value and 
more.  The following example has associated data for the 'Group' that they belong to with 'Group A' and 
'Group B' values.   The Switch Block will evaluate the expression results against these defined values, 
and if a match is found, the alarm will follow that path.  If neither of the values are met, the Catch-all 
output will be used.

This example demonstrates that a pipeline can send out an alarm to 2 different lists of people based on 
the   'Group.'

 

Expression Block

The  contains an Expression which is evaluated against each alarm that enters it. Expression Block
The result is expected to be a boolean value, either 'True' or 'False' and forwards the alarm to the 
specific output.  The Expression executed by the block is written in the same syntax as other 
Expressions in Ignition. However, in this context, it is possible to refer directly to properties of the alarm 
event that is being evaluated by using the standard "{path}" reference syntax. In addition, the following 
functions are available to quickly determine the state of the alarm.

Examples

isActive()
This single function returns whether the current event is active or not. An Expression block like this could 
be used to then dispatch to an "active" pipeline, and a "clear" pipeline (both the active and clear pipeline 
settings on the alarm would be set to this dispatch pipeline). This kind of setup allows you to later modify 
how actives are handled vs. clears in one place, without having to modify many alarms.



toInt({priority})>2 && {displayPath} like "*East Area*"
This block would forward all High and Critical alarms from the "east area" to the true path. The others 
would go to false, which may not actually be bound to another block, making this Expression block act 
like a filter.

isPropertyDefined("isEscalated")
This Expression checks if a property exists on the event. The "isEscalated" property is not a system 
defined property. Instead, in this example, it might be set using a Set Property block before forwarding 
back to the start of the pipeline. The first time through, this Expression would fail, but the next time, it 
would pass, and the "escalated" behavior could be executed.

In the , you can select the Alarm Properties from any of the icons in the Pipeline Block Editor
Expression Block.  This example uses an expression to check to see if the priority is 'Critical,' and if so, 
the alarm notification will follow the 'True' path.  If it is not 'Critical', it will follow the 'False' path.  As you 
can see, the 'False' output is not configured.  You don't have to configure every output if you don't want 
too.  

Priority Expression Example

{priority}="Critical"

Set Property Block

The  allows you to define or redefine a property on the alarm event. The value Set Property Block
is created from the Expression Block, which can refer to other properties or the same properties. 
Typically, the Set Property Block is used as a counter for the number of times the alarm has been looping 
or notifying people in your on-call roster.  Settings modified in this way will only exist while the alarm is in 
the pipeline, they will not be stored to the journal, or show up in the status table.

Examples

If you want to attempt notification up to three times before stopping, you could create a pipeline 
that looked like [Notification Block] > [Set Property] > [Expression], with the Expression looping back to 
the notification block (perhaps with a delay in between).

The Set Property block would look like:
Property Name: counter
Expression: coalesce({counter}, 0)+

Note that the first time the block is hit, the   property will not exist, and therefore the value will be counter
null. The   function returns the first non-null value, allowing us to start with 0. Another way to coalesce
write this might be:

if(isPropertyDefined("counter"), getProperty("counter"), 0)+1

The   function is functionally equivalent to simply referencing the property in brackets getProperty()
(that is,  ).{counter}

The Expression block in this example would simply be:  .{counter}<3

Here is another example where the operators are notified of an alarm event 3 times before being 
escalated to the Production Supervisors.  Drag 2  to your pipeline Set Property Blocks
workspace.  Assign the first Set Property block to a Property Name  and a Property Value of 'numCalls' '0
  The second Property Block you need to increment the counter.  Enter  as shown in .' '{numCalls} + 1'

the Pipeline Property Editor.  Each time the alarm goes through this block, the 'numCalls' variable 
increments by '1.' If no one acknowledges the alarm, it is sent to the Production Supervisor's on-call 
roster.
 



Jump Block

The  forwards an alarm event to a different pipeline.  You can breakup a pipeline into Jump Block
several different pipelines and use the Jump Block to go back and forth between pipelines. This is perfect 
for an escalation pipeline because often times they can become one massive pipeline, and the Jump 
Block can make the escalation pipeline less complicated and more compact.  

In the Pipeline Block Editor, enter the Destination pipeline called 'Escalate.'

In this simple example, the  forwards the alarm to the Escalate pipeline and ends there.  Jump Block

 

Script Block

The   allows you to execute a task outside the pipeline like writing to another alarm tag or Script Block
database.  In this example, the Script Block was used to notify the production supervisors of an alarm 
using another alarm tag as shown in the Pipeline Block Editor.  

In the next sections, you will see how to use a combination of these different pipeline blocks to create 
your own unique pipelines.

 

 

Next...

Pipeline - Filter on Alarm Priority

 

 

 



1.  

2.  

3.  

Pipeline - Filter on Alarm Priority

You can create a filter for an alarm priority in an alarm notification pipeline that notifies a different list of 
people based on the alarm's priority. 

There are two pipeline blocks that can be used for filtering, either the  or the Switch Block Expre
.  The  allows you to switch on the priority, doing something different ssion Block Switch Block

for every single priority that exists.  The  allows you to check for a specific Expression Block
priority, and it returns either a ‘True’ or ‘False’ value.   You can do something if it is ‘True’ and 
something else if it is ‘False.’  This example uses the Expression Block.

Drag in the  in to your pipeline, and connect the  to the  of the Expression Block Start IN
Expression block. You will notice that the Expression block is going to return a  or  ‘True’ ‘False’
value.   

 

 
In this expression, you want to check for the alarm’s priority.  Go to the Pipeline Property 
Editor, click the curly brace icon > Main and select the ‘Priority’ expression.  Priority is a 
placeholder until you enter the priority value you want to filter on.  When the alarm is triggered, it 
will be replaced with the actual priority of that alarm.  

 

 Alarm priorities have predefined values for filtering and sorting.  In this example, we are going 
to filter for all alarms with a priority of 'Critical.'    has a value of .  Critical 4

 

If the alarm priority is , the alarm will go to the output pin of the  value in the  Critical  'True'
Expression block.  If the priority is , the alarm will go to the output pin of the  not Critical 'False'
value.  Notice, we are doing something different for each of these conditions.  

Pipeline - Filter on 
Alarm Priority

Watch the Video
 

 

 

 

This section assumes that all alarms are configured

To learn more, go to ,  and .Configure Alarm on a Tag  Alarm Notification On-call Rosters

Alarm Priorities

0 = Diagnostic
1 = Low 
2 = Medium
3 = High
4 = Critical

 Refer to  for more information.Alarm Properties

https://inductiveuniversity.com/video/pipeline-filter-on-alarm-priority/7.8


3.  

4.  

5.  

 

Drag in a Notification Block, and connect the 'True' output pin into the IN of the Notification 
block.  

In the  under the , choose the notification type.  On the Pipeline Block Editor Notification tab C
, under the , select the   list of people you want to ontacts tab On-call Roster icon ‘Critical’

email.  

 
 
Drag in a second  and connect the output into the  of the Notification Block, 'False'   IN
Notification block.  

In the , under the , choose the notification type.   In the Pipeline Block Editor Notifications tab
, under the , select the  list.  The Critical list is a Contacts tab On-call Roster icon ‘Non Critical’

different list of people from the Non Critical list.  

 
 

As you see in this example, the alarm notification pipeline notified different lists of people based on the 
alarm's priority.   

 

Next...

Pipeline - Filter on Alarm Associated Data



1.  

2.  

3.  

Pipeline - Filter on Alarm Associated Data

 

Once associated data is added to an alarm, you can easily filter for associated data in an alarm 
pipeline.  It’s possible to add associated data that can be either static or dynamic. 

Let's look at how to filter a notification pipeline based on associated data we added to an alarm.  

For this example, the WriteableFloat1 tag is used and has 2 alarms setup; High Alarm and Low 
Alarm.  You can see the  configuration has  called  and a value of 'High Alarm' Associated Data 'Group,'
either Group A or Group B.  We are going to use this associated data to filter the alarm notification 
pipeline. 

 

Let’s create a pipeline that’s going to filter on associated data.   

There are two blocks that can be used for filtering, either the  or the Switch Block Expression 
.  The  allows you to switch on a value and do something different for Group Block Switch Block

A and Group B.  The  does the same thing, but only returns values of ‘True’ Expression Block
or ‘False.’  This example uses the Switch Block.

Drag in the  to your pipeline, and connect the  to the  of the Switch block.  Switch Block Start IN

 

In the , you have to manually enter the Expression because you will  Pipeline Property Editor
not find any of the associated data properties in the dropdown list using the curly brace 
icon.  Enter the name of the associated data property in curly braces as follows,   The ‘{Group}.’  

 associated data property acts as a placeholder for the real values.'Group'

 

Pipeline - Filter on 
Alarm Associated 
Data

Watch the Video
 

 

 

 

This section assumes you have certain objects configured

The examples in this section assume you have , , a configured alarm alarm associated data a 
, and an existing .notification profile on-call roster
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3.  

4.  

5.  

Next, you need to add some values to the Expression Block.  You can add as many values that 

you have values for.  Click on the  and add 2 values:  green plus icon ‘Group A’ and ‘Group B.’
   

Once you enter both values, you will have outputs in the Switch block for ,  Group A Group B,
and .   So now you can notify a different list of people based on each Group.  Catch-all

 

Drag a  on to your pipeline, and connect the output of Notification Block Group A in the Switch 

block to the IN of the Notification block. 

In the  under the , choose your notification type.  In the Pipeline Block Editor Notification tab C
, under the  , select the roster you want to notify.ontacts tab On-call Roster icon

 
 
Drag a second  to your pipeline, and connect  from the Switch block Notification Block Group B
to the  on the second Notification block.  IN

Choose your notification type and specify a different On-call Roster to notify a different group of 
people.    

 

So, what we have successfully done here, is notify people on the 'Critical' list based on Group A, and the 
'All' list based on Group B by filtering on alarm associated data. 

 

Next...

Pipeline - Escalation



1.  

2.  

3.  

4.  

5.  

Pipeline - Escalation
 

It is possible to setup escalation procedures in  in Ignition.  The following alarm notification pipelines
example will create a pipeline that notifies operators 3 times. If a user does not acknowledge the alarm 
after the third time, the alarm escalates to the Production Supervisor’s on-call roster. 

The following example requires that two seperate  have been configured ("Production on-call rosters
Supervisors" and "Operators"), as well as an . email notification profile

In the  under the , create a New Alarm Pipeline Project Browser Alarm Notification Pipelines
called    ‘Escalate.’
 
In order to keep track of how many times the operators get notified, create a counter using the S

 inside your pipeline.  Drag the Set Property Block to the Pipeline Workspace et Property block
and connect the  block to the IN of the Set Property block.START
In the Pipeline Block Editor, set the  to  and initialize the Property Name  ‘numCalls’ Property 

 to  Value ‘0.’

Drag the  to the Pipeline Workspace and connect the OUT from the Set Notification Block
Property block to the IN of the Notification block.

In the , set the Notification to use  and set the Contacts to use the Pipeline Block Editor ‘Email’ ‘
 on-call roster.  Operators’

 
 
Let’s add in a Delay Block so a little time is given to the operators to respond to the alarm before 
immediately sending back to the operators or escalating it the production supervisors. 
 
Drag in the    and connect the  from the Notification block to the  of the Delay Delay Block OUT  IN
block.  In the Pipeline Block Editor, set the  for  .  It will give the operators spinner '300' seconds
5 minutes to respond to the alarm before going to the next block. 

 

 
If the alarm is still active and not acknowledged, the counter will increment by 1.  In order to 
increment the counter, drag in another  and connect the  of the Set Property Block OUT
Notification block to the  of the Set Property block.  You can right click on the Set Property IN
block to .  reverse the orientation

In the Pipeline Block Editor, set the  toProperty Name  ‘numCalls.'  In the Property Value 

Pipeline - 
Escalation

Watch the Video
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5.  

6.  

7.  

 type in,   In this expression, use the curly braces to refer to that Expression ‘{numCalls} + 1.’
variable so the counter gets incremented by 1.

 
The  will check to see if    Drag in an Expression Block to Expression Block ‘numCalls’ is < 3.'
your pipeline workspace and right click on the Expression block to reverse the 
orientation.  Connect the  of the Set Property block to the  of the Expression block.  OUT IN

Since the value of ‘numCalls is < 3,' the alarm event will follow the ‘True’ path.  Connect the 
 pin to the .  ‘True’ Operator Notification block

If the  the alarm event will follow the ’False’ path and it will escalate to the 'numCalls is > 3,'
Production Supervisors.  

Drag in another    and reverse the block orientation.  In the Pipeline Block Notification Block
Editor, set the Notification to use  and set the Contacts to use the ‘Email’ ‘Production 

 on-call roster.  Supervisors’

Connect the  pin to the  of the .  ‘False’  IN Production Supervisors Notification block

 

As you can see, when the Escalate Pipeline sets the ‘numCalls’ variable to a value of 0, it’s going to 
notify the Operators on-call roster through email that the alarm is active.  It will wait 5 minutes, and if the 
alarm is still active, it will increment the counter by 1.  This will repeat until the ‘numCalls’ is > 3.  After the 
3  time, if the alarm is still active and in the pipeline, then the Production Supervisors will be rd

notified.  Keep in mind, that if the alarm at any point meets the dropout conditions, it will not go to the 
next block of the pipeline.  

 

  

 

 

Next...

Pipeline - Notification Block Consolidation



 

 

 



Pipeline - Notification Block Consolidation
Notification consolidation allows you to limit the number of notifications sent by specifying a delay 
during which incoming events will be collected. When the delay expires, all events that have arrived 
during the period of time will be sent together to the notification profile.

For Example:

Once an alarm enters the Notification block in this pipeline, it will wait for  number of seconds (in Delay
this case 15 seconds) before sending the alarm. If additional alarms enter this notification block, it will 
send using the  Message/Subject from the  tab depending on your notification Consolidated Notification
type.

Once an alarm has been sent, whether it was a consolidated notification or not, this Notification Block will 
wait for   number of seconds (in this case 60 seconds) before it can send another email.Frequency

Note that Consolidation only effects this pipeline. Any notification blocks in other pipelines will not be 
effected.

Pipeline - 
Notification Block 
Consolidation

Watch the Video
 

 

 

 

 

 

Next...

Pipeline Status
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Pipeline Status
 

It’s possible to monitor the status of your alarm notification pipelines to see exactly where your alarms 
are in the notification process in Ignition.  You can do this from the  in your Ignition Gateway Webpage
browser.  

Go to the  of your Gateway webpage and on the left side of the navigation bar, click on Status tab Alarm 
.  Pipelines

 

The Alarm Pipeline Status shows all the pipelines you created including all the active alarms and where 
they are in the system.  In this example, we have several pipelines, but let’s look at the one called . Notify
As you can see, there are no alarms in this pipeline.  

 

In this next example, you can see that there is one active alarm in the Notify pipeline.  An Out of Range 
alarm was triggered for Machine A, and it’s currently in the Delay block.  As this alarm moves through the 
pipeline, you can monitor its status.  You can even  the alarm to delete it from the pipeline.  Cancel

 

How long the alarm stays in the in the Alarm Pipeline Status depends on how the pipeline is configured, 
the type of notification (i.e., Email, SMS or Voice) and what the pipeline is doing (i.e., notifying users, 
looping, executing a script, etc.). 

Pipeline Status

Watch the Video
 

 

 

 

 

 

Next...
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Customizing Alarm Notification
   

When Ignition sends out either an email or a voice notification, by default, there is a built-in script for the email body and a text-to-speech engine for 
the voice content. You can override the default on each alarm, by simply editing your alarm and setting the custom scripts.

   

   

In this section ...  

   

   



Custom Email, SMS, and Voice Scripts
Introduction

Ignition has a built-in script that it uses when it sends out an alarm notification via Email, SMS, and 
Voice. There is a different script for each notification type.  Each notification type has it's own relevant 
properties for configuration, although, some features are common to all profile types that you will soon 
discover.
 

Alarm Notification Setup Requirements

Email, SMS and Voice scripts in Ignition are extremely easy to use and setup. Before you begin using 
alarm notifications and customizing message scripts, you need to have Email, SMS and Voice 
modules installed, alarm notification profiles created, and settings configured.  It's best to run through 
these alarm notification requirements before setting up your custom scripts so you have a smooth 
implementation of alarm notifications. You only need to install the modules and the profiles that you 
plan to use.
 

The following modules can be found on the   page.  Ignition Downloads

Email Notification Module
SMS Notification Module
Voice Notification Module
Text-to-Speech Voice (language)

Refer to each alarm notification profile below for how to create and modify a profile. 

Email Notification Profile -  is enabled here if you want users  Two-Way Acknowledgement
who receive the alarm to acknowledge the alarm.
SMS Notification Profile -  is enabled here.Two-Way Acknowledgement
Voice Notification Profile - Acknowledgement of the alarm is part of the call script, and 
provided as an instruction as part of the call.
User Profile - when setting up a Voice alarm notification, each user's profile requires a 
contact telephone number and a Security PIN. 

Alarm Notification Pipelines - controls how alarm notifications are sent out.

On-Call Rosters - are the group of users that will receive the alarm notifications. On-Call 
Rosters are available in the Contacts tab of the Notification Block.

Methods of Customizing Message Scripts and Sending Notifications

You can configure and customize scripts for Email, SMS and Voice in two locations; in the Alarm 
Configuration section of the Tag Editor, and in the  of the alarm pipeline.Notification Block

Every Notification Block in a pipeline has to have a message to send out. Here you have all the alarm 
properties to select from to build and test your script.  You can specify your Contacts, and enable 
Consolidation all from the same screen. 
The Alarm Configuration has fields to override the message sent from a Pipeline's Notification Block. 
This is particularly useful if your alarm has a dynamic Pipeline or is being sent to multiple Pipelines. If 
you're creating your alarm notification for the first time, make sure to specify a Pipeline for the alarm 
to use. 

The alarm's Custom Message property takes precedence over any Notification Block in a 
pipeline.
There are two methods of sending out alarm notifications: one notification per alarm, and notification 
consolidation (i.e., multiple alarms in a single Email or SMS). By default, alarm notifications are sent 
out one message for each alarm.  

If you want to use  , you can use the default Consolidated Message script or create a Consolidation
custom script using the alarm properties. Consolidation is enabled in the Notification Block.  When 
enabled, multiple alarm events are sent together in one message.  
Each alarm notification type has a default message script.  The Email and SMS default message 
script is found in the Notification Block shown below.  For Voice, the default call script is located in the 

.  Voice Notification Profile

Default Message Script

Custom Email, 
SMS, and Voice 
Scripts

Watch the Video
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2.  

3.  

4.  

5.  

 At {eventTime|hh:mm:ss}, alarm "{name}" at
"{displayPath}" transitioned to {eventState}

You can override the default message script on a per alarm basis by simply creating a Custom 
Message script. 

Custom Message Scripts

The following sections describe how to use the default message scripts, build your own custom message 
scripts, and send out alarm notifications for Email, SMS, and Voice.

Email

Email notifications are the most common method of sending alarm notifications.

Customizing Email Message Scripts using Alarm Configuration in the Tag Editor

To customize an Email alarm notification, select your tag, and go to the  scAlarm Configuration 
reen.   Scroll down and you will see several sections;  , Notifications Email Notification 

, and  . Properties, SMS Notification Properties Phone Call Settings

In the   section, you can specify the name of the alarm pipeline that you want to Notification
trigger when an alarm becomes Active, Cleared and Acknowledged.  Simply enter the name of 
the alarm pipeline next to the relevant state you want the email sent out from.  This example 
uses the   pipeline, and the alarm is triggered on the state.‘Basic Email’  'Active' 

Enter a  calledCustom Subject   ‘Ignition Alarm.’ 
 
Create your  . You can use static text, bring in tag values and special alarm Custom Message
properties.  You can even bind a particular property to an expression to concatenate a string 
that using other values that are in the system. This example displays the alarm name, state, and 
time in hours, minutes, and seconds.

Custom Message Script

The "{name}" alarm became {eventState} at {eventTime|hh:mm:ss} with 
a value of "{Value}"

Notice that when you select any fields in the Alarm Configuration, the Description Area at the 
bottom of the window displays details about the property's behavior.

 
When complete, press Save.

Custom Message always takes precedence over the default message

All alarm notification types allow you to define a custom message. If a custom message is 
created, it will be used instead of the default message in the script.



5.  

6.  

7.  

1.  

2.  

3.  

In the Pipeline Notification Block, go to the Contacts tab, and select the On-Call Roster that 
you want to send alarm notifications too. 
 
If Consolidation is required, enable Consolidation and edit the Delay and Frequency settings.  
For more information on the Delay and Frequency settings, refer to  .Consolidation

Customizing Email Message Scripts using the Pipeline Notification Block

Click on the Notification Block of your pipeline, and choose Email.  You can see all the default 

 for each field in the Notification Block.  Click on theEmail settings  Link icon next to the Message

 field to expand the script.

Here you can customize the default message script using the built-in alarm properties.  Click on 

the Curly Braces icon to see a list of properties to help you build your custom message script.

If you want to use Consolidation, you can use the default Consolidated Message script or 

create a custom script using the alarm properties.  Click on the Link icon to expand the 

Consolidated Message script.
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4.  

5.  

1.  

2.  

3.  

4.  

If required, go to the Consolidation tab, and enable Consolidation.  When enabled, multiple 

alarm events are sent together in one email which results in fewer messages being sent 

out.  For more information on the Delay and Frequency settings, refer to Consolidation.

Next, from the Contacts tab, choose the  that you want to send email On-Call Roster

notifications too.

 

SMS

SMS works the same way as Email except for a few subtle differences. 

Customizing SMS Message Scripts in the Alarm Configuration of the Tag Editor

To customize an SMS alarm notification, select your tag, and go to the  . Alarm Configuration
Scroll down to SMS Notification Properties.

In the   section, specify the name of the alarm pipeline that you want to use when Notification
the alarm becomes Active, Cleared and Acknowledged. In this example, the name of the 
pipeline is  and is triggered on the state.‘Basic Email’  'Active' 

Enter your   script or use the default script.  You will notice there is no Subject, Custom Message
only a Custom Message.  

When you're finished customizing the alarm configuration, click  .Save
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5.  

6.  

1.  

2.  
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Go to the  and from the Pipeline Notification Block Contacts tab, choose the On-Call Roster t
hat you want to send alarm notifications too. 

If required, go to the  tab, and  .Consolidation enable Consolidation  You can use the default 
Consolidated Message script or customize the script.  Set the Delay and Frequency settings. 

 

Customizing SMS Message Scripts in the Pipeline Notification Block

Another way to customize the default SMS alarm notification is to build your custom message in the 
Pipeline Notification Block.

Click on the Notification Block of your pipeline, and choose SMS.  You can see all the default S
MS settings in the Notification Block. Click on the Message link icon to expand the script.

You can either use the default message script or customize one using the alarm properties. 
Click on the Curly Braces to see a list of available properties.

Like Email, use the Consolidated Message when multiple alarm events are sent together.  In SMS
, click on the Throttled Message link icon to expand the consolidated script. You can either 
use the default script or create your own custom message using the alarm properties.

https://legacy-docs.inductiveautomation.com/display/DOC/Pipeline+Blocks#PipelineBlocks-SMSSettings
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4.  

5.  

From the   tab, choose the   that you want to send alarm notifications Contacts On-Call Roster
too.
 
If required, go to the Consolidation tab, and . Enter your   and enable Consolidation Delay Frequ

settings.ency 

Voice

The Voice Notification Module lets you deliver alarm notifications to users via telephone.

SIP and VOIP

Voice calls are delivered through any SIP compatible phone system. No dedicated hardware is required. 
Using a hosted service like Skype is the quickest way to implement the Voice Notification Module. For 
more information on how to configure any SIP compatible phone system, refer to the Voice Notification 
Profile.

Voice Call Script

The voice message played to the the user during the phone call is defined in the call script which is 
located in the . The voice message is built off a message template that can Voice Notification Profile
reference properties in the alarm. Be aware that the voice message is shared across all voice notification 
profiles. If you define a custom message, it will be used instead of the default message in the call script.

The default call message template is shown below.

Configuring the Voice Call Script

The Voice Notification system is primarily accessed through the Notification Block. The only settings you 
can configure in the Alarm Configuration section is the Custom Message, and the Alarm Pipeline which 
defines what state you want to trigger the alarm. All   that you need to configure are in the Voice settings
Notification Block.
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2.  

3.  
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Click on the Notification Block of your pipeline, and choose Voice.

Configure each setting for your Voice alarm notification, as required. 

PIN Required - If required, the user will need a PIN to hear the alarm notification. PINs 
are defined in the user's profile.
Allow Acknowledgement - If Acknowledgement is not required, users will only be 
allowed to listen to an alarm and not acknowledge them. 
Retries per Contact - Number attempts to contact user by phone.
Delay between Calls - Creates a delay between each contact for each alarm. For 
most phone systems, a delay of 1 second is recommended.
Test Mode - If enabled, messages will be logged to the console indicating when and to 
whom calls would have been made without actually making a call.

 
This example shows how you might configure your Voice settings, but it depends primarily on 
your business requirements. 

PIN Required - True
Allow Acknowledgement - True
Retries per contact - 1
Delay between Calls - 1
Test Mode - false

From the tab, specify your  Users in the Voice On-Call Roster must  Contacts   On-Call Roster. 
have a telephone number, and an established PIN in their user profile.
Voice notification supports message consolidation. If required, enable Consolidation and enter 
Delay and Frequency settings.

 

 

Next...

User Pin for Voice

 

 



1.  

2.  

3.  

User Pin for Voice
 

You can force an operator to enter a personal identification number (PIN) in order to hear a Voice alarm 
notification message.  It’s a good idea to validate that the person who is receiving the Voice alarm is the 
person they say they are by entering their PIN. 

When alarms are sent out via Voice, you typically want an operator to acknowledge the alarm by 
pressing  on their phone.  Requiring a PIN also prevents other people who might be sharing a phone ‘1’
from acknowledging important alarms.  

It is easy to setup Security PINs in Ignition in a couple simple steps.  First, a PIN number will need to be 
created in each user’s profile to listen to Voice messages and acknowledge SMS messages. The second 
step is to configure the Voice Notification Profiles.  

User Profile

Let’s begin by configuring a Security PIN for each user that will be receiving Voice alarm messages.  

Go to the  page, , and under Gateway Configuration Security > Users, Roles default user 
, select the  link.  sources manage users 

 

Here you will see list of all your users.  For every user that is using Voice alarm notifications, 

you will need to edit their user profile to create a PIN.  Select edit link for one of your users.  

 

The user profile screen will open.  Make sure the contact information for Email and Phone is up-
to-date.   

Create a 4-digit , and press .  Security Pin Save

Now, this PIN is associated with this user.  

User Pin for Voice

Watch the Video
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Voice Notification Profile

The next step is to configure the Voice Notification Profile to require a PIN.    

In , go to your   and open your pipeline.  This example uses the  pipeline.   Select the Designer Alarm Notification Pipelines Basic Email Noti
in the workspace.fication Block 

Click on the  tab, and choose . Notification Voice
You’ll see several settings for Voice.  Set the  to Required PIN 'true.'  

Now, when the operator receives a call, they will have to type in their PIN number followed by the pound sign to hear the message.  

 
 

Next...

Voice Languages

 

 



1.  

Voice Languages
 

In order to let Ignition make calls when alarm events happen there are several modules, the Voice 
Notification Module, and many voice language modules.  The voice notification module for Ignition 
supports making calls using male and female voices in multiple languages.  The language modules (i.e., 
English, Spanish, Italian, etc.) contain the text to speech engine that is specific for that language and 
gender.  

You can download these modules from Inductive Automation's Downloads page on the website, and 
install them in your gateway.  

The following table shows a list of the current Text-to-Speech voices that you can download after you 
have the Voice Notification Module installed. To download Text-to-Speech voices, go to the Knowledge 
Base article on  where you can also find some good information.  Voice Notification Downloads

Voices Languages

Katherine English

Laura Italian

Sara Spanish

Suzanne French

Alex German

 

Once you have installed the voice modules, you can configure the voice scripts for any language in the 
voice notification module. For example, you may want to have a different script that gets sent out when 
you’re calling someone in English verses someone that you’re calling in Spanish.  

Modifying a Voice Notification Script

From Voice Notification Profiles page, you can manage your voice scripts.  Two examples are provided 
here; one in English, and the other in Spanish.

Go to your  page, and select .  To the right of the Gateway Configuration Alarm Notifications
Voice notification profile, click on the  link.    manage scripts

Vocie Languages

Watch the Video
 

 

 

 

 

 

Important!

On this page we mention " " a lot. These scripts have  to do with the scripting scripts nothing
language (Python) that you write code with. When we say "script" on this page, we are talking 
about a speech or a dialog for Ignition to read to your users over the phone.
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Here you can manage all the scripts for every language, and can even create new scripts.  The 
languages that come with Ignition are English, Italian, French and Spanish.  There are a host of 
other languages that Ignition supports, as you will soon see.  For this example, click on the  Edit
link for .   English

 

Default voice scripts are the same in all supported languages. This is the default script for 
English.  It consists of a number of little scripts.  Each script is what the recipient of the call will 
hear over the phone.  These are instructions informing the recipient of one or more the alarm(s) 
depending on how the alarm notification is configured.  When you receive a voice notification, 
you will hear each script or instruction one at a time.  For example, the first script you will hear is 
“Hello this is an Ignition alarm notification” which, of course, is the greeting.   It will then go 
through each script and inform the recipient of the alarm name, date and time of the alarm, 
alarm status, and how to acknowledge the alarm.   You can edit this default script to your 

requirements. When you're finished editing, click .Save

 

Here is an example of the default scripts in Spanish.  Once again, you can edit the scripts to 

your requirements.  When editing is complete, click .Save



4.  

5.  

6.  

 

As you can see, you can attach a different script for every language depending on the user, and 
whatever that user is setup to do.  So, if the script is in Spanish, the user will receive the voice 
notification in Spanish assuming the Spanish voice module is installed in Ignition.  

Once you have the appropriate voice module and language module(s) installed, go to Security 
.  Select the  link for the default user source.   > Users and Roles manage users

 

You can edit every single user, and put each user into a different language, as long as the 
language that you select for each user has the voice module for that language installed.  In this 
example, let’s edit a user, Sally.  Put Sally into the Spanish language.  If the voice module is 
installed for the Spanish language, Ignition will automatically choose the Spanish script. 

 

Now, when the alarm notification is received, the voice message will be in Spanish.  You can 
also change a user's language preferences from the  component.User Management

 

   

 

Next...
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Transaction Groups
   

Transaction groups are configured through the Ignition Designer. They are units of execution that perform actions such as storing data historically, 
synchronizing database values to OPC, and loading recipe values. While they are stored in a project, they execute on the Gateway. This ensures that 
only one instance of each Transaction Group is run at all times, regardless of the number of Clients being open.

 

 

In this section ...
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2.  

3.  

4.  

Understanding Transaction Groups
 

Transaction Groups are the heart of the SQL Bridge module. They are units of execution that perform a variety of actions, such as storing data 
historically, synchronizing database values to OPC, or loading recipe values. A variety of group types, items types, and options means that 
Transaction Groups can be configured to accomplish almost any task.

The Transaction Group Workspace

Transaction groups are edited through the Ignition Designer. When a group is selected, you are presented with the transaction group workspace. 

The workspace is broken into several parts:

Title bar - Shows the name of the currently selected group, as well as options to set it as Enabled or Disable, and to Pause, if it's currently 
executing.
Item configuration - Shows all of the items configured in the selected group. Many settings can be modified directly through the display, the 
rest by double-clicking the item, or selecting "edit" in the context menu.
Action / Trigger / Options tabs - Define how and when a group executes. Holds most of the options that apply to the group in general, such as 
the update rate, and which data connection it uses.
Status / Events tabs - Provides information about the executing group, including the most recent messages that have been generated.

Enabling Group Execution

In order for groups to be evaluated, they must first be enabled. This is done by selecting "enabled" in the group title bar, and then saving the project. 
The group executing can be stopped by reversing the procedure and selecting "disabled" before saving. If you want to quickly and temporarily stop the 
group's evaluation, toggle the "pause" button. This will prevent execution until the group is unpaused, or until the system is restarted.

Editing Group Settings

Group settings may be modified at any time, regardless of whether or not the group is executing. Modifications will be applied when the project is 
saved, and the group will be started or stopped as required. Some changes such as modifying items may cause features like live values to appear 
to be incorrect. It is therefore important to note the modified icon that appears next to the group, and to save often. If you would prefer to stop the 
group before making edits you can simply pause the group. Execution will begin again after the project is saved.

How Groups Execute

Generally speaking, groups work on a timer. They are set to run at a certain rate, and at that rate, the check the rest of the settings. If the trigger 
conditions pass, the group is executed fully. The following section provides a fuller outline of the execution cycle.

   

   

In this section ...  
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About Transaction Groups

Transaction Groups allow you to perform tasks such as: database to OPC synchronization, recipe 
management, and historical data logging.

Execution Cycle

All of the groups follow a similar execution cycle. The core evaluation may differ, but the general cycle is 
the same.

Timer executes, group enters execution
Is the group paused? Break execution.
Is the Gateway part of a redundant pair? If so, is it active? If not active, break execution. 
Groups only execute on the active node.
Evaluate "run-always" items: OPC items, tag references, and Expression items set to ignore the 
trigger (or placed in the "run always" section of the configuration window). 
Is trigger set/active? If there is a trigger defined, but it is not active, break execution.
Evaluate "triggered" expression items.
If applicable, read values from the database.
Execute a comparison between items and their targets.
Execute any writes to other Tags or the Database that result from execution.
Report alerts.
Acknowledge the trigger, if applicable.
Write handshake value, if applicable.

If an error occurs at any stage besides the last stage, execution will break and the failure handshake will 
be written if configured. The group will attempt execution again after the next update rate period.

   

About Transaction 
Groups

Watch the Video

Anatomy of a Group

Action Settings

The  of a group define how often the group will be evaluated, as well as important settings that apply to the group as a whole.action settings

They are found on the  tab, the first of the tabs on the right side of the Transaction Group workspace.Action

Common Settings

The settings vary for the different types of groups, but a few setting are common to most of them:

Execution 
scheduling 

How often the group is evaluated. For a number of reasons, the group may not execute during the evaluation. The most common 
reason is the trigger, but see  above for more possible reasons why evaluation will exit.Execution Cycle

Data 
source

The data connection to use for the group. Can be , which will use the default connection for the project.Default

Update 
mode

For groups that support it, sets the default for how items are compared to their targets.

Store 
timestamp

Stores a timestamp along with the data any time the group executes.

Store 
quality 
code

Stores an aggregate quality for the group along with the regular data. The aggregate quality is a bit-wise AND of the qualities of the 
items in the group.

Execution Scheduling

There are two ways to specify when the group should execute: timer and schedule mode. 

Timer Mode

In this mode, the group is evaluated regularly at the provided rate. As mentioned in the previous sections, due to trigger settings, full execution may 
not occur, but the trigger will at least be evaluated at this rate.

Schedule Mode
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With schedule mode, you are providing a list of time (or time ranges) that the group should run at. If the pattern specified includes a time range, at rate 
must be provided, and the group will execute as in timer mode during that period.

The schedule pattern

The schedule is specified as a comma separated list of times or time ranges. You may use the following formats:

24-hour times. Ie. "8:00, 15:00, 21:00", for execution at 8am, 3pm, and 9pm.

12-hour with am/pm (if not specified, "12" is considered noon): "8am, 3pm, 9pm" 

Ranges, "8am-11am, 3pm-5pm"

Notes

It is allowed for time ranges to span over midnight, such as "9pm - 8am"

When using ranges, the execution times will be aligned to the start time. For example, if you specify a schedule of "9am - 5pm" with a rate of "30 
minutes", the group will execute at 9, 9:30, 10, etc., regardless of when it was started. This is a useful difference compared to the Timer Mode, which 
runs based on when the group was started. For example, if you wanted a group that ran every hour, on the hour, you could specify a 1 hour rate with 
a range of "0-24".

Trigger and Handshake Settings

The trigger settings determine when a group will actually execute. They are examined each time the group evaluates (according to the update rate of 
the group). If they pass, the group will run and perform its action against the database.

The trigger settings are the same for all group types. They are found on the second tab (labeled "Trigger"), in the right side of the Transaction Group 
workspace.

Only execute when value have changed (asynchronous trigger)

These settings are evaluated first. If set, the group will examine whether the values in the specified tags have changed, and if not, will exit evaluation.

It is possible to monitor all Run-Always tags in the group, or only specific ones.

Execute this group on a trigger

Enables trigger on a specific item in the group. The trigger item can be any Run-Always item, such as an OPC item, Tag reference, or an Expression 
item set to "Run-Always" mode.

In addition to the numeric settings that define the trigger, there are several other options:

Only execute once while trigger is active - The group will only execute once when the trigger goes into an active state, and will not 
execute again until the trigger goes inactive first. If unselected, the group will execute each time the trigger conditions evaluate to true.
Reset trigger after execution - If using the ">0" or "=0" trigger modes, the trigger can be set to write an opposite value after the group has 
executed successfully. This is useful for relaying the execution back to the PLC.
Prevent trigger caused by group start - If selected, the group will not execute if the trigger is active on the first evaluation of the group. In 
the course of designing a group, it is common to stop and start it many times, and sometimes it is not desirable to have the group execute as 
a result of this. Selecting this option will prevent these executions, as well as executions caused by system restarts.

Handshake Settings

Group handshakes are also defined on the trigger tab. It is possible to specify both a success and failure handshake. The success handshake will 
write the specified value to the given item when the group has finished all other triggered execution without error.

The failure handshake, on the other hand, will be written when the group execution is cut short due to an error, such as an error writing to the 
database or an item.

Advanced Settings

Transaction groups offer several advanced settings that affect how execution occurs. These settings can be found under the  tab for a group.Options

OPC Data Mode

This setting modifies how the group receives data from OPC.

Subscribe - Data points are registered with the OPC server, and data is received by the group . This is the default setting and generally on-change
offers the best performance, as it reduces unnecessary data flow and allows the OPC server to optimize reads.  

Note: Data is received by the group asynchronously, meaning that it can arrive at any time. When the group executes, it "snapshots" the last values 
received and uses those during evaluation. If some values arrive after execution begins, they will not be used until the following execution cycle.
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 - Each time the group executes it will first read the values of OPC items from the server. This operation takes more time and involves more Read
overhead than subscribed evaluation, but ensures that all values are updated together with the latest values. It is therefore commonly used with 
batching situations, where all of the data depends on each other and must be updated together. It's worth noting that when using an OPC item as the 
trigger, the item will be subscribed, and the rest of the values read when the trigger condition occurs. Note: This option was previously referred to as 
"polled reads" in earlier versions of the software.

Bypass Store and Forward System

Only applicable to groups that insert rows into the database. Causes groups to target the database directly instead of going through the store-and-
forward system. If the connection becomes unavailable, the group will report errors instead of logging data to the cache.

Override OPC Subscription Rate

Specifies the rate at which OPC items in the group will be subscribed. These items are normally subscribed at the rate of the group, but by modifying 
this setting it is possible to request updates at a faster or slower rate.

Creating a Transaction Group

Transaction groups are used to store history, log events, synchronize databases tables with PLC, perform calculations, and many more data-centric 
tasks.

To create a transaction group

Let's create a basic History Group and start logging some PLC values to your database.

Click on the   in the   panel to switch the Designer's workspace to the Transaction Group workspace.Transaction Groups Project Browser
 
Click on  to make a new Historical Group. File > New > New Standard Group
Your new group, named  will be selected. The  panel is now docked to the lower-left of the screen.Group OPC Browser
 
Browse your OPC device and drag some OPC tags to the  section.Basic OPC/Group Items
Your group starts out disabled by default.
 
Click the  button above the item tables to enable logging.Enabled
 
Go to the   tab and change the  in your table to something interesting.Action Table Name
Right now your group only exists in the Designer.
 
Save the project to start the group.
Your group is now running and logging data to your database connection. To see the data, you can use the Ignition Designer's built-in 

database query browser. The easiest way to do this is to click on the Query Browser (  ) button to the right of your group's Table Name 
field. The Query Browser is a convenient way to directly query your database connection without leaving the Ignition Designer. Of course - 
you can also use any query browser tools that came with your database.

Next...

Types of Groups



Types of Groups
The SQL Bridge Module provides four different types of transaction groups:

Standard
Block
Historical
Stored Procedure

See an overview of these different types of groups, and how they vary in their operation and use for data 
logging and database to PLC synchronization.
              Types of Groups

Watch the Video

 

 

Standard Group

The standard group is called such because it's a flexible, general use group that can be adapted to a variety of situations. The data model is row 
based, with items mapping to columns and the data corresponding to a specific row of a table.

General Description

The standard group contains items, which may be mapped to the database, or used internally for features such as triggering or handshakes. Items 
that are mapped to the database target a specific column of a single specific row, chosen according to the group settings. Items can be mapped in 
a one-way fashion, or bi-directionally, in which the value of the database and the item will be synchronized.

The group may also insert new rows instead of updating a specific row. In this manner, data can be inserted for historical purposes based on a timer, 
with an optional trigger.

Group Settings

The standard group uses a timer-based execution model shared by all groups, and the normal trigger settings.

Additionally, there are several settings specific to the group type:

Automatically create table - If the target table does not exist, or does not have all of the required columns, it will be created/modified on group 
startup. If not selected and the table doesn't match, an error will be generated on startup.

Store timestamp - Specifies whether or not to store a timestamp with the record, and the target column. The timestamp will be generated by the 
group during execution. For groups that update a row, the timestamp will only be written if any of the values in the group is also written.

Store quality code - If selected, stores an aggregate quality for the group to the specified column. The aggregate quality is the combined quality of all 
of the items that write to the table. For more information about quality values, see Data Quality Delete records older than - If selected, records in the 
target table will be deleted after they reach the specified age. This setting is useful for preventing tables from growing in an unbounded manner, which 
can cause disk space and performance problems over time.

Table action - This section details how the group interacts with the table. The group can insert a new row each execution, or update the first, last or 
custom record. A custom update clause is essentially the where clause of the SQL query that will be generated to read and write the group. In addition 
to standard SQL syntax, you can bind to items in the group in order to inject dynamic values.

Typical Uses

Standard groups can be used any time you want to work with a single row of data. This can include:

Historical logging - set the group to insert new records, and log data historically either on a timer, or as the result of a trigger. Flexible trigger settings 
and handshakes make it possible to create robust transactions.

Maintain status tables - Keep a row in the database updated with the current status values. Once in the database, your process data is now 
available for use by any application that can access a database, dramatically opening up possibilities.

Manage recipes - Store recipe settings in the database, where you have a virtually unlimited amount of memory. Then, load them into the PLC by 
mapping DB-to-OPC using a custom where clause with an item binding in order to dynamically select the desired recipe.

Sync PLCs - Items in the group can be set to target other items, both for one-way and bidirectional syncing. By adding items from multiple PLCs to 
the group, you can set the items of one PLC to sync with the others. By creating expression items that map from one PLC item to the other, you can 
manipulate the value before passing it on.

Block Group

The block group is so named because it writes "blocks" of data to a database table, consisting of multiple rows and columns.
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General Description

A block group contains one or more block items. Each block item maps to a column in the group's table, and then defines any number of values (OPC 
or SQLTag items) that will be written vertically as rows under that column. The values may be defined in the block item in two modes. The first, List 
mode, lets a list of value-defining items to be entered. These value items may either by OPC items, SQLTag items, or static values. The second 
mode, Pattern mode, can be useful when OPC item paths or tag paths contain an incrementing number. You may provide a pattern for the item's path, 
using the wildcard marker {?} to indicate where the number should be inserted.

Block groups are very efficient, and can be used to store massive amounts of data to the database (for example, 100 columns each with 100 rows- 
10,000 data points- will often take only a few hundred milliseconds to write, depending on the database). They are also particularly useful for mirroring 
array values in the database, as each element will appear under a single column, and share the same data type.

Like the standard group, the block group can insert a new block, or update the first, last or a custom block. Additionally, the group can be set to only 
insert rows that have changed in the block.

In addition to block items, the group can have other OPC items, tag references, and Expression items. These items can be used for triggers, 
handshakes, etc. They may also target a column to be written, and will write their single value to all rows in the block.

Group Settings

Beyond the differences in the data, namely that the block group works with multiple rows instead of just 1, this group type shares many similarities 
with the Standard Group.

The unique settings are:

Store row id - Each row will be assigned a numeric id, starting at 0. If selected, this id will also be stored with the data. 

Store block id - If selected, an incremental block id will be stored along with the data. This number will be 1 greater than the previous block id in the 
table. 

Insert new block vs. Insert changed rows - If "insert new block" is selected, each row of the block will be inserted when the group executes, even if 
the data has not changed. By contrast, "insert changed rows" will only insert the rows that have new data. The latter mode is particularly useful for 
recording history for many data points on a "on change" basis, provided there is a unique id column defined. The "store row id" feature is useful for 
this, as well as the ability to reference the item path in an item's value property.

Update Custom block - Like standard groups, this setting allows you to target a specific section of the table, using SQL where clause syntax, with the 
ability to bind to dynamic item values. Unlike standard groups, however, the where clause specified should result in enough rows to cover the block. 
Excess rows will not be written to, but fewer rows will result in a group warning indicating that some data could not be written.

Typical Uses

Block groups are useful in a number of situation where you need to deal with a lot of data efficiently. Mirroring/Synchronizing array values to DB - 
Arrays are often best stored vertically, which makes them perfect for block groups. Pattern mode makes configuration a breeze by allowing to you 
specify the array as a pattern, and set the bounds.

Recipe management - Like standard groups, but when set points are better stored vertically than horizontally.

Vertical history tables - Group data points by data type (int, float, string), create a copy of the item that stores item path, and then use the insert 
changed rows option to create your own vertically storing historical tables. Create additional copies of the block item that refer to quality and 
timestamp in order to get further information about the data point.

Historical Group

The historical group makes it easy to quickly log data historically to a SQL database.

General Description

The historical group inserts records of data into a SQL database, mapping items to columns. Full support for triggering, expression items, hour & event 
meters and more means that you can also set up complex historical transactions. Unlike the standard group, the historical group cannot update rows, 
only insert. It also cannot write back to items (besides trigger resets and handshakes).

Group Settings

The settings of the historical group are identical to the settings in the Standard Group, but limited to inserting rows.

Typical Uses

Basic historical logging - Recording data to a SQL database gives you incredible storage and querying capabilities, and makes your process data 
available to any application that has DB access.

Shift tracking - Use an expression item to track the current shift based on time, and then trigger off of it to record summary values from the PLC. Use 
a handshake to tell the PLC to reset the values.

Stored Procedure Group



The stored procedure group lets you quickly map values bi-directionally to the parameters of a stored procedure.

General Description

The stored procedure group is similar to the other groups in terms of execution, triggering, and item configuration. The primary difference is that unlike 
the other group types, the target is not a database table, but instead a stored procedure.

Items in the group can be mapped to input (or inout) parameters of the procedure. They also can be bound to output parameters, in which case the 
value returned from the procedure will be written to the item. Items can be bound to both an input and output at the same time.

Group Settings

The stored procedure group's settings look and act the same as those of the Historical Group. The primary difference, of course, is that instead of 
specifying a table name and column names, you'll specify parameter names.

Parameters may be specified using either  or . That is, in any location where you can specify a parameter, you can parameter names numerical index
either use the name defined in the database, or a 0-indexed value specifying the parameter's place in the function call.  You cannot mix Important:
names and indices. That is, you must consistently use one or the other.

If using parameter names, the names should not include any particular identifying character (for example, "?" or "@", which are used by some 
databases to specify a parameter).

Typical Uses

 Call stored procedures - The stored procedure group is the obvious choice when you want to bind values to a stored procedure. It can also be used 
to call procedures that take no parameters (though this can also be accomplished from Expression Items/SQLTags.

Replace RSSQL - The stored procedure group is very popular among users switching from RSSQL, given that application's heavy use of stored 
procedures.

Known Issues

When using Oracle, you must use indexed parameters.

 

Next...

Group Update Rate

 

 



Group Update Rate
 

The execution schedule controls the rate at which the transaction group executes. On the  tab of a Action
group you have selected, under , there are two options: Timer and Schedule. Execution Scheduling
Timer, executes the group at a certain rate. Schedule, executes the group at specific times. When the 
Schedule option spans across a period of time, you must specify the rate at which the group executes 
during that time. 

Timer

The Timer acts as the heartbeat of the transaction group. It can run at millisecond, second, minute, hour, 
or day rates. The Timer specifies the OPC tag subscription rate for the OPC tags. When a Timer is 
running the transaction group first analyzes the tags inside the  section of the Basic OPC/Group Items
transaction group. Then it looks at the trigger configuration and evaluates for tag changes. Then it 
evaluates the specific trigger conditions and decides to execute on a trigger. If the triggered condition is 
true, the transaction group proceeds to the on Items section of the transaction group. Triggered Expressi
Only after this flow is complete, will the transaction group interacts with the database and for example, 
insert the tag values into the database.

Schedule

An important difference between the Timer and the Schedule options is that the schedule option 
will automatically align to the specified start time on the update rate. For example, if the Schedule option 
is selected and the times are entered as  and the update rate is , the transaction 8,12pm-3pm 15 minutes
group will execute at 8am and then at 12pm, 12:15pm, 12:30pm and so on.

Group Update Rate

Watch the Video
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Item Types
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Item Types
 

Items are the core elements of a group. They are executed, and the values are then used by the 
group for logic purposes, by other items, and to write to the database. They can be written to from 
the database or from other items.

Type 
of 
Item

Description

OPC Item Directly subscribed to an OPC server at the rate of the group. Executed by the group, so 
alarms are evaluated when the group is executed. These items are executed even when 
the trigger isn't active.

Run-
Always 
Expression

Item

Much like an expression tag, can be either a static value, an expression, or a database 
query. Run-Always expression items are evaluated at each group interval, before the 
trigger state is evaluated.

Triggered
Expressio
n Item

Same as Run-Always expression items, except that they are only executed after the 
trigger has been evaluated and is active.

Tag 
Referenc
e

A reference to a Tag. Allows a Tag to be used in a group like any other item type, except 
that the tag is evaluated by its scan class instead of by the group. For more information, 
see .Tag References vs. OPC Items

Execution Order

Items generally aren't executed in a reliable order, with the exception of  items. Expression
Expression items can be ordered using the up and down arrows located to the right of the list where the 
items are displayed. This can be crucial for performing complex operations that require a specific 
sequence.

Item Types

Watch the Video
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Tag References vs. OPC Items
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Tag References vs. OPC Items
   

It is easy to confuse the definition and purpose of Tag reference items (Scan Class) and direct OPC 
items (Timer) in transaction groups, though they have distinct benefits.

Tags may be referenced inside of groups, however it is critical to remember that they are executed by the 
Ignition Gateway, according to their scan classes, and independent of the group. Adding a tag into a 
group is like creating a shortcut to that tag. However, once in the group, the item can be used like any 
other item. That is, it may be mapped bi-directionally to the database, used as a trigger, be the target of 
another item, and so on. It is even possible to create an hour meter out of the item. Core properties of the 
tag such as alarming and scaling, however, are defined in the actual tag, not in the group. 

OPC Items in groups (as well as expression items in groups), however, are completely executed by the 
group. They do not exist outside of the group in which they are defined. They are subscribed 
and evaluated according to the rate of the group. Generally speaking, it is most common to create OPC 
items in groups, even if a particular point might already exist in tags. This leads to more understandable 
group execution, as all evaluation occurs in the group according to the timer and trigger settings. Tag 
references are useful when it is necessary to have a single value in multiple groups, for example, as a 
trigger in order to coordinate execution.
 

Tag References vs. 
OPC Items

Watch the Video

 

 

OPC Item

OPC Items are the backbone of a group. They get their values from PLCs and the values are then used by other items in the group and/or to write to 
the database. They are directly subscribed to an OPC server at the rate of the group and are executed by the group so their alarms are evaluated 
when the group is executed. These items are executed even when the trigger isn't active.

To create a new OPC Item

In the Designer, go to Project Browser, and click on .Transaction Groups
The workspace now changes to the Transaction Group workspace.

Right-click on  to create a New Transaction Group, or click on a group you have previously created.Transaction Group
You will now see the workspace changes to look like:

 

Right-click in the white area, and choose .New Item > New OPC Item
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 The  window is displayed as follows:Edit group tag



3.  

 

The following table describes all the properties on the   window.Edit group tag

OPC Item General Properties

General Properties

Name The name of the OPC item in the group. There cannot be duplicate names within a group.

Data 
Type

The datatype used to read values from the PLC.

OPC Properties
Click on the  button, in this section, select the tag you want, and Ignition fills out the following Browse OPC
fields for you.

OPC 
Server

The Selected OPC Server. This is a drop-down list showing all the OPC Servers added in the Ignition Gateway.

OPC 
Item 
Path

The OPC Item's address Including Device name or Channel if required.



Value Mode

Proper
ty

Which property of the OPC item you want to use.

Value - Item value
Quality - Quality code from OPC Server (192 = GOOD_DATA)
Timestamp - The last time the item value changed
Name - The SQLBridge Item Name property of this Item

Mode Options for displaying values based on the Item value.

Direct Value - Item value
Hour Meter - Record the amount of time the Item value is non-zero. This accumulation will reset to zero when the item value goes to 
zero. The datatype should be set to integer or float when using an Hour Meter regardless of the OPC Item type.

On Zero - Use a zero value to accumulate time instead of a non-zero value
Retentive - Retain the Hour Meter value when it is not accumulating.
Units - The time units to display.

Event Meter - Record the number or times the Item value is non-zero. The datatype should be set to integer when using an Event 
Meter regardless of the OPC Item type.

On Zero - Use a zero value to accumulate events instead of a non-zero value

Write Target

Mode Changes the items directional read/write option.

Use group's mode - Inherit the Update Mode from the Item's Group.
OPC to DB - Only read from the OPC server and write to the database.
DB to OPC - Only read from the database and write to the OPC Server.
Bi-directional OPC wins - Read and Write to both the database and OPC Server. On group start, write OPC Server values to the 
database.
Bi-directional DB wins - Read and Write to both the database and OPC Server. On group start, write database values to the 
database.

Target 
Type

This is the selection for what the Item will write to when the group executes.

None, read-only item - Do not write this value to the database.
Database field - Write the Item value to the specified column in the database table. This list will populate with all the column names 
from the Group's target table after the first time the group is run.

Target 
Name

The name of the column in the database that this Item will write to when the group executes. The Target Name list will populate with all 
the column names from the Group's target table if the Target Type is Database field.

Alarming

The Alarming settings for the OPC items. See   for a full explanation.Alarming Properties

Tag Reference

Tag References are used just like OPC Items, adding the convenience of using a Tag that has already been set up with scaling and alarm data.

Tag Item

General

Name The name of the OPC item in the group. There cannot be duplicate names within a group.

Tag 
Path

The path to the tag being referenced. This value is not editable except by clicking the Insert Tag button. There cannot be duplicate names 
within a group.

Data 
Type

The datatype to write to into the database if this item is not read-only.

Value Mode

Prope
rty

Which property of the Tag you want to use.

Value - Item value
Quality - Quality code of the Tag (192 = GOOD_DATA)
Timestamp - The last time the item value changed
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Name - The SQLBridge Item Name property of this Item.

Mode Options for displaying values based on the Item value.

Direct Value - Item value
Hour Meter - Record the amount of time the Item value is non-zero. This accumulation will reset to zero when the item value goes to 
zero. The datatype should be set to integer or float when using an Hour Meter regardless of the OPC Item type.
On Zero - Use a zero value to accumulate time instead of a non-zero value
Retentive - Retain the Hour Meter value when it is not accumulating.
Units - The time units to display.
Event Meter - Record the number or times the Item value is non-zero. The datatype should be set to integer when using an Event 
Meter regardless of the OPC Item type.
On Zero - Use a zero value to accumulate events instead of a non-zero value

Write Target

Mode Changes the items directional read/write option. This is only editable when the target Type is set to Database field.

Use group's mode - Inherit the Update Mode from the Item's Group.
OPC to DB - Only read from the OPC server and write to the database.
DB to OPC - Only read from the database and write to the OPC Server.
Bi-directional OPC wins - Read and Write to both the database and OPC Server. On group start, write OPC Server values to the 
database.
Bi-directional DB wins - Read and Write to both the database and OPC Server. On group start, write database values to the database.

Targe
t Type

This is the selection for what the Item will write to when the group executes.

None, read-only item - Do not write this value to the database.
Database field - Write the Item value to the specified column in the database table.

Targe
t 
Name

The name of the column in the database that this Item will write to when the group executes. The Target Name list will populate with all the 
column names from the Group's target table if the Target Type is Database field.
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Expression Items
 

Expression Items are used for executing comparisons, simple math and querying additional 
database tables. They get their values from an expression made up of static values or other items, or 
from SQL Queries. They can have alarms and can be executed when the trigger is active or every time 
the group executes.

Expression items are items in groups that handle an expression much like an expression tag. The main 
difference between the two is that expression items in transaction groups only exist within the transaction 
group and they only update at the rate of the transaction group. You can use expression items to perform 
calculations and create complex triggers.

Expression Items

Watch the Video

 

 

To create an Expression Item

From the Transaction Gourps node of the Project Browser, select a group.
 

In the white area of Basic OPC/Group Items, Run-Always or Triggered Expression Items, right-click and select New Item > New 
Expression Item.

The  window is displayed and you can set the following properties:Edit group tag

Expression Item General Properties

General Properties

Name The name of the OPC item in the group. There cannot be duplicate names within a group.

Value The static value of this Expression item. This will be overwritten by an Expression/SQL binding.

Datat
ype

The datatype values are stored as.

Value Mode

Prope
rty

Which property of the OPC item you want to use.

Value - Item value
Quality - Quality code of the expression/SQL Query (192 = GOOD_DATA)
Timestamp - The last time the item value changed
Name - The SQLBridge Item Name property of this Item.

Mode Options for displaying values based on the Item value.

Direct Value - Item value
Hour Meter - Record the amount of time the Item value is non-zero. This accumulation will reset to zero when the item value 
goes to zero. The datatype should be set to integer or
float when using an Hour Meter regardless of the OPC Item type.
On Zero - Use a zero value to accumulate time instead of a non-zero value
Retentive - Retain the Hour Meter value when it is not accumulating.
Units - The time units to display.
Event Meter - Record the number or times the Item value is non-zero. The datatype should be set to integer when using an 
Event Meter regardless of the OPC Item type.
On Zero - Use a zero value to accumulate events instead of a non-zero value

Evalu
ation 
Mode

Run-always (ignore Trigger) - When selected, this causes the group to evaluate at each group interval, before the trigger state is 
evaluated.

Write 
Target

Target Type - This is the selection for what the Item will write to when the group executes.

None, read-only item - Do not write this value to the database.
Database field - Write the Item value to the specified column in the database table.
Other tag - Write the Expression Item's value back to an OPC item or Tag Reference.
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Targe
t 
Name

The name of the column in the database that this Item will write to when the group executes. The Target Name list will populate 
with all the OPC Item and Tag Reference names from this Group, or the column names from the Group's target table depending 
on the Target Type selected.

Numeric

These are the Numeric properties for Expression Items. For a full description, see .Tag Scaling Properties

Alarming

These are the Alarming settings for the OPC items. See  for a full explanation.Alarming Properties

Expression

These are the Expression/SQL Query options for Expression Items. See  for a Expression/SQL Properties
full explanation.

 
Select the   tab from the menu on the left of the  window.Expression/SQL Edit group tag
 
Select  from the dropdown menu. Expression
Expression items can use the same functions as other expression items in Ignition. An expression item returns in accordance with the 
created expression. The resulting value can be written to a transaction group Item such as a tag or it can be written to a database. 
 
Select the  tab and configure the  to instruct the transaction group what to do after the expression is complete.General Write target

To use an Expression Item as a transaction group trigger

In the  location of the transaction group, right-click and select . Run-Always Expression Items New Item > New Expression Item
 
On the  window, set the following properties to create a new expression item that returns a boolean true or false depending on Edit group tag
the result of the expression item:
Data Type: Boolean
Mode: Direct value
 
Select the  tab of the transaction group's properties on the right of the transaction group.Trigger
 
Select the  box, and from the drop-down of  select the name of the new expression item.Execute this group on a trigger Trigger on Item
 
Properly configure the .Trigger conditions

 

 

Next...

SQL Query Expression Items
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SQL Query Expression Items
 

Expression items can be SQL statements that handle select, update, insert, or delete statements from a 
database. More complicated queries can require you to set the query type manually. If the query is 
simple, Ignition automatically detects the query type. SQL query expression items can serve as triggers 
for the transaction group or they can only execute when the transaction group is triggered.

To trigger a transaction group with a SQL query Expression item

In the Transaction Group workspace, create a  .New Expression item
 
On the  , go to the   tab, and select   from the Edit group tag Expression/SQL SQL Query
dropdown list.

Enter a SQL query into the Expression item, and click  .OK
The SQL query must return a numerical value.
 
Go to the   tab, from the   dropdown list, select the Expression item that Trigger Trigger on item
has the SQL query.
 
Properly configure the trigger conditions and start the transaction group.

SQL Query 
Expression Items

Watch the Video

 

 

   

Next...

 Run Always vs. Triggered Items

 

 

SQL Statements in Transaction Groups

It is important to be mindful of expression items that perform SQL statements. A transaction 
group that executes repeatedly can also be executing multiple expression items. If these 
expression items are executing a SQL statement, the query count on a database can increase 
dramatically.
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Run Always vs. Triggered Items
 

In the Transaction Group workspace, you can set the Expression items in a group to execute in two 
different ways:

Run-Always in which the Expression items will execute at the groups rate (based on the Execut
 settings on the  tab).ion Scheduling Action

Triggered in which the Expression items run when the group is triggered (based on the settings 
on the  tab). Trigger

If on the  tab, the option  is not selected, the items in the Trigger Execute this group on a trigger Run-
 area and  area will all execute at the same time.Always Expression Item Triggered Expression Items

The advantage selecting the   option is that is gives you flexibility on Execute this group on a trigger
when the expression items are executed which may result in easing the load on a database.

Run Always vs. 
Triggered Items

Watch the Video

 

 

 

Next...

Hour and Event Meters
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Hour and Event Meters
Hour meter and   refer to the  option settings on tags in Transaction Groups. Event meter Value Mode
The Value mode drives values that are used to create values that determine how long a value was true. 
While the selected Value Mode for most transactions is , however, the  mode Direct Hour meter
accumulates value for the duration of a condition, and the  accumulates count in response Event meter
to the condition.

Hour Meter

It is common to write to a tag during the time when a tag's value is true. An hour meter simplifies this 
effort. Hour meters can be meters that accumulate the millisecond, second, minute, hour, or day.

To count the duration of a tag being true

From OPC Browser or Tag Browser, drag a boolean tag into the   areaBasic OPC/Groups Items
of a   transaction group.Standard
 
From OPC Browser or Tag Browser, drag a memory tag or OPC tag (must be a numeric data 
type) into the  portion of the   transaction group. Basic OPC/Groups Items Standard

Right-click on the boolean tag in the transaction group and select   to edit it.Edit
The   window is displayed.Edit group tag

In the   window, for  , select  .Edit group tag Value Mode Hour meter

In the   window, for   select   from the dropdown menu, and Edit group tag Target Type Other tag
in   enter the name of the memory tag as the target, and click  .Target Name OK
 
In the   area where the tags are located, go to the   columBasic OPC/Groups Items Target Name
n, left-click on each tag to get the dropdown menu, and set the following:

For the boolean tag, select the memory tag from the dropdown which is set previously 
as the target tag to write the hour meter to.
For the memory tag, select Read-only from the dropdown.

Click   at the top of the page, and do a   to start the group. Enabled File > Save

Make the boolean tag true to the start the Hour meter.

 

Hour and Event 
Meters

Watch the Video

 

 

Event Meter

Another common scenario is to count the number of times an event occurred. For example, where there is boolean tag and you want to count the 
number of cycles the boolean tag has experienced.

To count in response to a tag being true

From OPC Browser or Tag Browser, drag a boolean tag into the   area of a   transaction group.Basic OPC/Groups Items Standard
 
From OPC Browser or Tag Browser, drag a memory tag or OPC tag (must be a numeric data type) into the  portion Basic OPC/Groups Items
of the   transaction group.Standard

Right-click on the boolean tag in the transaction group and select   to edit it.Edit
The   window is displayed.Edit group tag

In the   window, for  , selectEdit group tag Value Mode  Event meter.

In the   window, for   select   from the dropdown menu, and in   enter the name of the Edit group tag Target Type Other tag Target Name
memory tag as the target, and click  .OK
 
In the   area where the tags are located, go to the   column, left-click on each tag to get the dropdown Basic OPC/Groups Items Target Name
menu, and set the following:

For the boolean tag, select the memory tag from the dropdown which is set previously as the target tag to write the hour meter to.
For the memory tag, select Read-only from the dropdown.

Click   at the top of the page, and do a   to start the group. Enabled File > Save
 
Make the boolean tag true to start the Event meter.
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Next...

Resetting Hour and Event Meters
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3.  

4.  

5.  

Resetting Hour and Event Meters
 

You can set the hour or event meter based on a condition.

To reset an hour or event meter based on a condition

In the  section, right-click and  a tag that is serving as the Hour or Basic OPC/Group Items Edit
Event meter.
The   window is displayed.edit group tag

In the   area, select the   check box, click the  icon to display Value Mode Reset on condition tag
the  window, and select a from the pop-up windowChoose Tag Group Tag .
 
Click .OK
 
Next to the  icon, choose the  sign, and enter a number. tag operator
 
Click .OK
The target tag will now reset in response to the condition.

 

Resetting Hour and 
Event Meters

Watch the Video

 

 

Next...

Trigger - On Value Change
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Trigger - On Value Change
 

It is often useful to execute a group only when the values of the group's tags have changed, or when a 
particular tag within the group has changed. In either case, the transaction group will execute every time 
the value or values change.

To execute only when the tag values change

In the  tab, select at the very top the  Trigger Only evaluate when values have changed
checkbox. 
Now the group executes only when all the tags change. But you may want to execute the group 
when only one tag changes.
 

To execute when only one tag changes, select from the Tags to watch for change dropdown,  C
ustom, click on Select tags, select the tag from the pop-up window, and click . OK
You can select more than one tag at a time in order to monitor more than one tag for value 
changes.
 
From the   dropdown, select the appropriate tagTrigger on item  to execute the tag on a trigger.
 

Select the  radio button.Active on value change

Trigger – On Value 
Change

Watch the Video

 

 

   

   

Next...

 

 Trigger - While Condition is True
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Trigger - While Condition is True
 

Groups can execute while a condition is true resulting in the transaction group continuing to execute for 
the duration of this condition.

To continue execution while the condition is true

Create a transaction group, and drag a numeric or boolean tag into the Basic OPC/Group Items
section.

From the  column dropdown, select .Target Name Read Only
 
Go to the  tab, and select the  checkbox.Trigger Execute this group on a trigger
 
In the   area, set the trigger conditions which will determine under what Trigger conditions
condition the group executes.

Trigger – While 
Condition is True

Watch the Video

 

 

   

 

Next...

Trigger - Rising Edge (Once)
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Trigger - Rising Edge (Once)
 

Groups can execute only when the trigger is increasing in value. This is known as a rising edge trigger 
and it will only execute once and will not execute again until the trigger repeats the same cycle.

To execute the group only on the rising edge

Create a standard transaction group with any number of tags as long as one of them is a 
boolean tag that will serve at the trigger for the group.

 Set the  for the boolean tag to by selecting read-only from its drop Write Target Read-only 
down in the Target Name column.

Go to the  tab and select the check box to . Select the Trigger Execute this group on a trigger
boolean tag from the drop down menu and select to have the group only execute once while the 
trigger is active.

Save the transaction group to start the group.

Trigger – Rising 
Edge (Once)

Watch the Video

 

 

 

 

   

   

Next...

Trigger - Reset Trigger
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Trigger - Reset Trigger
 

Resetting a trigger after execution of a triggered transaction group will result in the transaction group 
writing once to the targets followed by writing back to the trigger to reset it.
 

To reset the trigger after execution

Create a transaction group with a boolean tag. The write target for this tag should be read only.
 
Select the  tab and select the   check box.Trigger Execute this group on a trigger
 
Select the  check box.Reset trigger after execution
 
Press save to start the transaction group.

Trigger – Reset 
Trigger

Watch the Video

 

 

   

 

Next...

Trigger - Handshakes
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Trigger - Handshakes
 

When a group executes, it either completes successfully or an error prevents its execution. The outcome 
of an execution can be handled in the handshake section of the trigger section of the transaction group. 
When a group executes successfully or fails to execute, the handshake can write a value back to a tag to 
alert the user that the group executed successfully or unsuccessfully.

To set handshake values for alerting the user

Create a transaction group with a boolean and a numeric tag.
 
Set the boolean and the numeric tag to read only.
 
Go to the  tab and choose to .Trigger Execute this group on a trigger
 
Select the boolean tag as the trigger In the  drop down, and select the Trigger on item
appropriate execution conditions.
 
In the bottom section, select , select the numeric tag to write to, Write handshake on success
and choose a number that signifies success.
 
Likewise, in the bottom section, select , select the numeric tag to Write handshake on failure
write to, and choose a number that signifies failure.

Trigger – 
Handshakes

Watch the Video

 

 

   

   

Next...
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Transaction Groups Example
 

There are four types of transaction groups: , , , and . This examples in this section shows the different Historical Standard Block Stored Procedure
ways that you can use them.

 

In this section...

 

 



1.  

2.  

3.  

Basic Historical Group
 

A basic historical transaction group is any transaction group that logs data to a database.

To create a Historical Group

In the Project Browser, right-click on the , and select Transaction Groups New Historical 
.Group

 
Select tags from the OPC Browser and drag them into the  area of the Basic OPC/Group Items
transaction group.
The target databases are represented in the  column and when the group Target Name
executes, the data will be stored in the columns of these names.
 
Go to the  tab and select  to specify how often the group executes.Action Timer

There are other options that help configure the data as it enters the database. For example, 
having an additional column for the time stamp.

Basic Historical 
Group

Watch the Video

 

 

 

Next...

Scheduled Group
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Scheduled Group
 

You can log data to a database at specific times using the execution scheduling. You create the Schedul
 group the same way as you create a basic  group. But instead of executing on a , you ed Historical Timer

select the  radio button, and eSchedule nter the times in the text box and the rate.

The following table shows examples of how you can enter numbers in the text box:

Times Rate Result

8, 11, 
5pm

n/a Group will execute 3 times at 8 in the morning, 11 in the morning, and finally at 
5pm.

8 n/a Group will execute once at 8 in the morning.

8-10 1 hour Group will execute at 8, 9, and 10 in the morning.

8-10, 17 1 hour Group will execute at 8, 9, and 10 in the morning and once at 5pm.

Scheduled Group

Watch the Video

 

 

   

 

Next...

Realtime Group
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Realtime Group
   

Using transaction groups to update specific rows in a database is an easy way to expose OPC data to 
systems that cannot access OPC server but can query a SQL database.

To update the first row in a database

Create a new Standard group and drag your OPC tags into the  area.Basic OPC/Group Items
 
On the  tab, select the appropriate Timer, Data source, Table name, and other various Action
settings.
 
In the  area of the  tab, select , andTable action Action update/select  first which 
will continue to update the first row of the database according to the timer.
To update a specific row rather than the first row in the database, select the   or the custom key

 options./value pairs
 
Select the group, click  and do a  to start it.Enabled File > Save
The transaction group will only write the values that have changed to the database thus 
reducing the overhead.

Realtime Group

Watch the Video

 

 

   

   

Next...

Bi-directional Group
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Bi-directional Group
 

A bidirectional transaction is any transaction that synchronizes data between sources. It is not a 
transaction that inserts values into a database like a historical group. Bidirectional transactions are useful 
in a number of cases. A bidirectional transaction can update a database table with the values from an 
OPC location thus making the values accessible to systems that have the ability to read from databases 
but not OPC locations. Likewise, bidirectional transactions allow external systems to update OPC 
locations by interacting with the database.

A transaction group designed for bi-direction synchronization evaluates and handles the updates at the 
group's rate, for example every second. In the event that both the database and the OPC locations 
experience a change between the executions of the transaction group the group decides 
to synchronize the database and the OPC location in accordance with the selected update mode. The 
update modes can also be individually tailored for each tag and database column by choosing the correct 
update mode in the Mode column of the Basic OPC/Group Items section.

To create an bidirectional transaction group

Create a  and drag tags from the OPC server or the Tag Browser into the New Standard Group
group's .Basic OPC/Group Items
 
Go to the  tab, and set the following:Action

: either  or Update mode   Bi-directional OPC wins Bi-directional DB wins
: the appropriate sourceData source
: the appropriate nameTable name

: select the check box so a table is automatically created if the table Automatically create table
name does not already exist

 area: select   and  . You can also, synchronize the OPC and Table Action update/select first
database locations based on a condition by choosing  or the   options.custom key/value pairs
 
Click   and do a   to start the group.Enabled File > Save

Bi-directional Group

Watch the Video

 

 

   

   

Next...

Stored Procedure Group
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Stored Procedure Group
 

A stored procedure group will interact with a database stored procedure. A stored procedure in a 
database is like a function. The procedure has a name and it may or may not take parameters. Once the 
procedure is called and the parameters passed into the procedure, the query executes on the database 
server and a the resultset is returned. The actual text of the query is stored and managed on the 
database server. Stored procedure provide an increased level of security and maintenance that make 
them ideal for certain scenarios.  

Suppose the following stored procedure already exists on the database server:

CREATE DEFINER=`root`@`localhost` PROCEDURE `tankCount`(in invar varchar
(45), out outvar integer)
BEGIN
        select count(area) into outvar from test.tanks where area = 
marker1;
END

And suppose the procedure is called with the following SQL statement and returns the number of tanks 
that are associated with Area A.

call tankCount("Area A")

Stored Procedure 
Group

Watch the Video

 

 

This is a very simple scenario. Often stored procedures contain very long or complicated queries. Lets say you want to use a transaction group to call 
this stored procedure and then to handle the result by writing to a tag location.

To use a transaction group to call a stored procedure

Create a new   transaction group.Stored Procedure
 
Drag two tags into the   section of the group. The two tags must be of the   as the stored procedure's Basic OPC/Group Items same datatype
parameters. In this case the two tags will be a   type.string and an integer
 
Go to the   tab of the transaction group, select the appropriate Action Data source. Select the procedure name from the procedure name drop 
down menu.
 
In the   section, from the   column dropdown of the string tag, select the input parameter, Basic OPC/Group Items Target Name
and select None for the output.
 
In the  section, from the   column drop down of the integer tag, select Read-only, and select the output Basic OPC/Group Items Target Name
parameter for the output.
 
Click  and do a  to save the project and to start the transaction group.Enabled File > Save

 

Note: When running a Stored Procedure from an Oracle database, you cannot use named parameters. Instead you must use the index (number) 
arguments. IE: 1 is the first argument, 2 is the second, etc.

 

Next...

Block Group

 

 

 

https://inductiveuniversity.com/video/stored-procedure-group/7.8


1.  

2.  

3.  

4.  

5.  

Block Group
 

The Block group is a type of transaction group that stores data vertically. Whereas, a Standard group 
stores the information horizontally in a single row. Block groups share many of the same features as the 
Standard group. They can be bidirectional, insert into a database, or simply update the database. All the 
rows in a Block group are associated with a single database transaction therefore the process of writing 
to the database is very efficient.

To create a Block group

Create a new transaction group.Block 
 
Drag a tag folder into the  section of the new transaction group.Block Items
 
Select the item in the Block group, right-click and select . Edit
 
Change the , enter the  to anything appropriate, Name Target Name and configure the 
remainder of the group settings under the  tab.Action
 
Select the group, click   and do a   to start it.Enabled File > Save

Block Group

Watch the Video

   

 

Next...

Recipe Group
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Recipe Group
 

You can use Standard or Block Transaction Groups to create recipe management system with bi-
directional communication to pass database information to the PLC when requested. The main 
advantage of using transaction groups to design the recipe management group is that the group will write 
to all the OPC locations.

To use transaction groups to create recipes

Create a new  transaction group.Standard
 
Drag a set of tags into the group's .  Basic OPC/Group Items
One of these tags should be a recipe index tag and needs to be read-only. 
 
Change the recipe index tag to read-only by selecting  from the drop-down in the Read-only Tag

 column.et Name
 
Go to the   tab, and set the following:Action

Update mode: choose  .OPC to DB
Table name: select the table name that contains the recipes. This table should have 
an index.
Use custom index column: select the check box and choose the column that is the 
index from the table.
Store timestamp to a column: deselect the check box.
 

In the  area of the  tab, click  and   to create a custom  Table action  Action update/select custom
clause that references the read-only tag. The read-only tag and the name of the index column of 
the database must be the same. Do not include the word "where" because it is assumed to be 
part of the enclosed statement.
 
Click  to enable the group and do a  to save the project and start the Enable File > Save
transaction group. 
 
Test the recipe group by entering a new value into the recipe number (for example, the tag that 
is mapped to the index of the recipe database). 
The recipe values will download to the appropriate tags. 

Recipe Group

Watch the Video

 

 

   

 

Next...

Update or Insert Group
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Update or Insert Group
 

You can update a row or insert a new row into the database when a key pair combination does not exist. 
This eliminates the need to have a database that has every possible option considered in its original 
design. Because of the  setting, the group will insert a new record insert row when not present
whenever the designated ID doesn't exist. Afterwards, it will update the rows in the table that are 
associated with the key/value references as shown in this example.

To update or insert a new row into the database

Create a .New Standard Group
 
Drag a group of tags into the groups  section.Basic OPC/Group Items
 
Change one of the tags to be read-only by selecting  from the tag's  Read Only Target Name
column.
 
Select the appropriate settings under the groups  tab.Action
 
In the group's  tab, in the  area, select the  radio button.Action Table action update/select
 
In addition, select the  radio button.key/value pairs

For the  select the database table ID column.Column
For the  column, select the read-only tag.Value
Select  check box at the bottom of the  area.Insert row when not present Table action
 

Click  and do a  to save the project and to start the group.Enable File > Save

Update or Insert 
Group

Watch the Video

 

 

   

 

Next...
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Reporting
See  for 7.7 Reporting module.legacy documentation

Welcome to Ignition Reporting!

Ignition Reporting is a module for creating dynamic reports! These reports may be generated from 
existing Adobe Acrobat (pdf) files or created totally from scratch. Data is introduced through Ignition, 
providing access to any SQL database!

Ignition Reporting makes creating professional reports easy with a rich library including: images, graphs, 
tables, and a variety of basic shape tools.  The new Report Scheduler allows automatic report generation 
at any time you'd like, and automated distribution means it gets where you need it without lifting a 
finger.  Access to live reports available through the web based Ignition runtime, a Java application, 
providing authenticated users access from anywhere, all based on networking standards that your IT 
department can support.  Reports are printer friendly and can easily be exported to a variety of formats 
including pdf! Here are some common uses of dynamic reports:

 

Production Management
Efficiency Monitoring
Downtime Tracking
Statistical Process Control
Quality Assurance
Overall Equipment Effectiveness (OEE) Management
Historical Data Analysis

Benefits

Ignition Reporting enables managers to increase productivity, decrease waste, reduce costs, and 
increase quality with existing resources by providing a view of their manufacturing process. Managers 
often save time by automating reporting processes that were once done by hand. Often valuable man 
hours that went into creating spreadsheets or reports can be recovered! These reports are trivial to 
manage since they are generated on the fly from existing SQL database data.

Features

 

                Complete Reports on 
Existing PDFs

New in Ignition 7.8, with Reporting Module v3!

The Schedule Engine allows you to schedule when reports 
run, and what to do with the report when it's 
complete.  Email, FTP, Save as File, use in a Script!  
Easy to use WYSIWYG (What you see is what you get) 
designer that includes an intuitive   and   toolslayout drawing
New Charting components are easier to configure!
Barcodes now have 2D encoders for things like QR codes, 
Data Matrix and PDF417!

 

 

The most noteworthy feature of the Reporting Module is the fact that is integrated into the Ignition system. This provides access to Ignition data 
including any SQL database, allows as many concurrent clients as the hardware can handle, and shares authentication with your 
existing Ignition project all through simple but secure web-based access.

Other features:

Powerful   tool that creates new pages to fit your data. It supports a wide range of features.table
Crosstab tool lets you quickly create cross-reference tables to visualize and identify relationships in your data.
Reports are printer friendly.
Every report can be saved by the user in a variety of formats including pdf.
The Reporting Module includes the   and   components. Both are very useful when working with DataSets. They Row Selector Column Selector
work especially well with Ignition graph and table components as well as  .the Report Viewer
The Reporting Module includes the   components. These are very useful for viewing machine maintenance    and File Explorer PDF File Viewer 
manuals or any other PDFs from within your project.

 

   

https://support.inductiveautomation.com/usermanuals/ignition/
https://legacy-docs.inductiveautomation.com/display/DOC/Report+Designer#ReportDesigner-ReportLayout
https://legacy-docs.inductiveautomation.com/display/DOC/Report+Drawing+Shapes
https://legacy-docs.inductiveautomation.com/display/DOC/Row+Selector
https://legacy-docs.inductiveautomation.com/display/DOC/Column+Selector
https://legacy-docs.inductiveautomation.com/display/DOC/Report+Viewer
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Reporting Basics
We've taken advantage of Ignition 7.8's powerful platform to bring you the Reporting Module v3.  This new module is nearly a complete rewrite, with 
an upgraded reporting engine, completely new design interface, new components, and powerful data collection utilities.  We know that Reports are 
increasingly important in modern automation projects and this new Module makes it easy for you to create engaging, informative reports that are 
easily tailored to fit your data.  We look forward to seeing what you can build!

 

What's New?

This documentation is a great way to get familiar with all the new features in the Reporting v3.  We'll 
cover all these and more in greater depth, this is just a partial list of what is new in the Reporting Module:

New Upgraded Report Engine
Completely New Report Workspace
Reports as Project-level Resources
Powerful Data Collection Utilities
Drag-and-Drop Query Builder
Improved Charting Components
2D Barcode Generation
Powerful Scheduled Report generation
Familiar Property Editing
Scheduled Distribution Actions to Email, Save, FTP and More!
New Scripting Capabilities

Easily Collect Structured Data!

 

Backwards Compatibility!

We've built Reporting Module v3 to be completely backwards compatible.  If you have existing Report Viewers running in a project, they will continue 
to work as they always have without any modification.  If you need to modify an existing report, you'll still have access to the same customizer and as 
you always did.

However, if you look at the Reporting Components in Vision, you'll notice some changes.  The Report Viewer icon has changed and now creates a 
new version of the component.   This new Report Viewer acts as a viewer for your Report Resources, meaning you won't be able to create new 
Reports based on the old Component.  We've also replaced the old PDF Viewing component with one based on our much more powerful IA-Labs PDF 
Viewer module.

We have made the upgrade seamless by maintaining your existing reports -- but old reports aren't   Reports!  To encourage users to utilize the new
power of the new system, we've also provided a Report Converter.  After you've gone through the documentation and have an idea of how the new 
Reports operate, take a look at our Conversion Notes page to see how you can port your existing Vision report to a new Project Resource to take 
advantage of all the new features.

 

 

 

In this section ...



Reporting Interface
 

Reporting v3 brought some significant changes to the way Reports are structured.  No longer is the 
Reporting Module simply a Vision add-on.  Of course, you retain the ability to add reports to Vision 
Windows, but it's also possible to create complete reports without having dependencies on other 
modules because Reports are now Project-Level Resources.  Once you install the module, you'll be able 
to open the Ignition Designer and immediately see a new root resource folder.  To create a new report, 
right-click on the root Report node in the Project Browser and a new Report Resource will be created.  

Reports as Project Resources means that you are no longer reliant on Ignition Clients to generate 
reports.  Reports now run on the Ignition Gateway, allowing completely headless generation and 
distribution.  As detailed in the   section, your reports can now run automatically!Scheduled Reports

 

New Resource Means New Workspace

When we set out to create a new Reporting Module, we took a step back and tried to imagine what the 
ideal report system could provide.  We thought about the different stages of report design, the features 
needed for powerful reports, the many types of data that we may want.  We also listened to a lot of user 
feedback.   We were amazed in the variety and quality of reports people created with the old Report 
Module, but repeatedly heard customers ask for something easier, something that felt more like the rest 
of Ignition.  Trying to distill all these requirements into a singular workflow was no small task, but we 
believe this new workflow will be understandable to the new developer, yet powerful enough for a 
seasoned analyst.  Make no mistake, reports have a lot of moving parts, but fear not!  You'll be able to 
leverage our new tools to create impressive reports faster than ever!

 

 

Reporting Interface

Watch the Video

 

 

Reports are Project-Level Resources in 
Ignition 7.8

A New yet Familiar Workspace

So how do you create reports in Reporting v3?  The new Report Workspace is the answer!   Built from 
the ground-up to be intuitive and familiar, the new workspace has a logical workflow which makes it easy 
for anyone to create meaningful reports.   From the first informative panel to full previews of the report 
you are creating, we believe this product will significantly cut the time it takes to design, edit and 
distribute reports.  Lets take a look at the different parts of the new workspace.

The Reporting Workspace

 

Report Overview

The first tab should be fairly self-explanatory – it provides some valuable quick-glance information about 
your report.  There isn't much to see in a new report, but it can be a great introduction to an existing 
report for those new to a project, or if someone wants to quickly verify the schedule execution status of 
the report.  There is space to add notes, which is a good place to provide background information and 
context about the report.   The Overview will also show a thumbnail of the most recent report, its last 
execution time, and the next scheduled execution. The Report Snapshot is generated per visit to the 
Preview Panel.

 

Data Panel

The Data panel is the first stop for configuring a new report.  You'll notice the list on the left that has 
labels for Parameters and Data Sources, as well as some buttons.  It is on this page where we can 
configure what data we want to make available to our report.  The emptiness of a fresh Data Panel is very
 deceiving!  We'll dive more into Parameters and Data Sources, but for now go ahead and click the   butt+

https://inductiveuniversity.com/video/reporting-interface/7.8


on.  You'll see a list of built-in Data Sources and Parameters.  Selecting any one of them will open the 
configuration screen for that Data Source type and allow you to start configuring the data you'll supply to 
your report.

By the end of this guide, you'll be comfortable adding data sources to power your dynamic report.

The Data Panel

 

 

Design Panel

The Design Panel is something we expect to be a relief to those who felt the previous Vision Reporting 
Component didn't   like Ignition.  If you've ever designed a Vision Window, this should feel right at feel
home.  Starting from the top-left – the structure of a Report is now represented in the Project Browser 
tree, allowing easily visualization of the tree of elements on your report.  But, we didn't stop there!  Grab 
a component off the vision-like reporting palette and add it to the page.  You'll see on the bottom left that 
we've completely re-written how you configure report objects.  For complex components, we have built 
custom configuration panels to supplement the Property Inspector table that all the design objects 
have.  In place of the Tag Browser, we now have a Datakey Browser that gives you an easy way to add 
the data sources you configured in the Data panel to the Report. 

The Design Panel

The Preview Panel

The Preview Panel, while not one of our 3 Steps, is a huge help while building your Report.  By choosing 
to limit the amount of Preview data to return on the Data Panel, you'll be able to get fast visual feedback 
on your report without long-running queries.  Not only does it provide you an instant example of what 
your report looks like, but it also gives you the ability to view the actual data that is being sent to your 
report!  Having a snapshot of your data can be incredibly helpful when trying to figure out why your report 
doesn't appear as you expect it to.  Whether you have a error in your Query, or a bad Data Key in a 
component, you'll be able to figure out the structure of the data your report is getting and quickly find 
ways to solve any problems.  

The Preview Panel

The Schedule Panel

If you tried to schedule the execution of a Report on previous version of the Report Module, you likely 
found that there really wasn't a simple way to succeed.  With the new Reporting module, scheduled 
reports are a built-in and easy to use.  The Schedule panel is an incredibly powerful way to automate the 
execution and delivery of your Reports.  Whether you have extremely long running queries that you don't 
want tying up a window, need to deliver to multiple file servers via FTP, or want to simply email to an 
existing roster, this panel provides you the means to do it.  It's broken up into two major areas.  On top, 
you find a simple table of schedules that have been established.  To add a schedule, click the   button.  +
With a schedule added, you can now choose when and how that scheduled Action will occur.  Our 
schedules use the common Chron format, but don't worry if you aren't familiar with it.  The preset options 
and combo-box configurability allow you to easily create just about any schedule you can imagine.  

Once you selected your schedule, you can add parameters that may affect your Actions.  Actions are 
incredibly powerful and allow you to choose how you want to distribute or act on your finished 
reports.  Whether saving a file locally, posting to an FTP server, or emailing (after you have configured 
your email connections in the gateway), you should be able to get your report where it needs to be.  If our 
normal distribution Actions somehow fall short, you can choose to act on the finished report by triggering 
a script!  We've also given you a convenient way of immediately testing your Action by simply clicking the

button on the Action tab.

The Schedule Panel

 

Next ...

Report Data Basics
Report Data
Report Schedules
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Report Data Basics
 

The Data Panel is an incredibly powerful tool for gathering data for your reports.  In this section we'll go 
through some of the ways we can use the tools in the Data Panel to collect data from any source you 
may have. 

Parameters

As we covered in the overview, the Data Panel is pretty simple at first glance.  When creating a new 
report, there is an empty list of Data Sources as well as pre-made Parameters.     are Ignition Parameters  

. These parameters resolve at report execution time and provide a convenient way to  Expressions
dynamically specify content for your report.  These expressions are expected to resolve to specific 
types.  

The Parameter Types available in the ComboBox will be familiar to anyone who has used Expressions, 
and include:

Date
String
Long
Double
Boolean
Dataset

What are Parameters Useful For?

Parameters share some similarities to Custom Properties in Vision components in that they allow an 
Ignition user to specify dynamic data to be used in reports at runtime.  For example, a manufacturer may 
want to generate reports for the active production lines every Monday morning, but you don't know ahead 
of time which production lines will be running.  We can create a parameter called  aactiveProductionLines 
nd use an expression or tag value to determine which lines were active, and only use the parameter in a 
SQL Query datasource to only include data from active lines.   

Parameters can be declared with an empty (null) value.  In this event, it can be fed values from the Vision 
Report Viewer component, or in the Report Scheduling panel.  Similar to how custom properties work 
with the old Report Component, the new Report Viewer can use parameters to bind to data through 
Ignition Bindings.  If a parameter is supplied a default value in the Report Data panel (we call these defaul

, that value will be automatically be supplied to the Report Viewer component.  If a t parameters)
parameter has no default, the Report Viewer and Preview Panel will notify the user that a parameter is 
undefined.  It is important to note that both Scheduled Report and Vision component parameters take 

  So any default parameter can easily be overridden while also precedence over default parameters.
providing a baseline value.

  

 

 

Report Data

Watch the Video

 

 

 

The Parameter Editor

 A Query Data Source Panel

Data Sources

Data Sources are the primary means of getting data out of where it lives and into a report.   There are 
seven Data Sources included in the Reporting Module.  There are five Query types, a Script data 
source and Static CSV.  Each data source offers a unique method of collecting (or amending in the case 
of   Source) data.  Aside from the  datasource, all will require you to specify a  The Script Script  Data Key. D

 is a unique identifier that represents the top-level of the data collected through this source – think ata Key
of it as the label for the data source, or as the parent node of your source's collected 'data tree'.  When 
your report is generated, the data collected under this identifier is passed to the reporting engine, which 
utilizes this identifier to appropriately place your data in the final report.  We'll take a closer look at how to 
configure and reference this data in the    section.Reporting Workflow 

Query Datasources

Query Data Sources are the foundation on which most reports will be built.  We have five query sources --

SQL Query 
Basic SQL Query
Tag Historian Query
Tag Calculation Query
Alarm Journal Query 

Queries share some common features in the UI, and in the fact that they all return what is essentially a 
Dataset.   If you take a look at the image on the left, you'll see we outlined two main areas of the Basic 
SQL Query data source type.  By default the largest part of any Query panel is taken up by the central 

Developer Tip

Give your Data Keys 
readable names that say 
something about the table or 
data they represent. It will 
make it easier to build 
meaningful reports!

https://legacy-docs.inductiveautomation.com/display/DOC/Expression+Overview+and+Syntax
https://www.inductiveuniversity.com/video/report-data/7.8
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Editor Area. This space is tailored for each query type.  On the right, we have a "Query Configuration" 
area.  In the screenshot,  there are options for the  ,  and Data Key Query Type, Database, Sample Limit  Ne

.  Of these,  ,   and   are shared among all Queries, while sted Queries Data Key Query Type Nested Queries
are conveniently available in SQL query types.  Here is some brief information on each:Sample Limits 

Data Key  The identifier we will reference when we design our reports.  The Data Key needs to - 
be unique, can not contain special characters (spaces, underscores, dashes are allowed), and 
must start with a letter.  We have added a convenient validator to help detect poor data keys.
Query Type - gives you a convenient place to change the type of query
Nested Queries - This is one of the most powerful aspects of the new Reporting System.  We 
will get into more detail on how they work in the next section, but in short: nested queries allow 
you to run queries that are dependent on return values from other queries.  Utilizing a Parent-
Child relationship, you a child query will execute for each row of its parent, and the parent's 
columns can then be referenced in the child.
Sample Limit - Allow you to choose to limit the number of rows returned from a query when a 
report is being generated in the Preview Panel, and when data is sampled for the purposes of 
generating Data Keys in our Designer.  If supported by your database, this makes it much 
easier to craft and preview deep query structures without the overhead and wait-times of long-
running queries.  

Queries allow you to pull data from any connected database, historian and even alarm history.

Query Types

Here is a brief rundown on each query type.

SQL Query

The SQL Query allows you to craft parameterized queries that run as a prepared statement.  In addition, 
it also features the new  , which is a powerful Drag-and-Drop query building GUI that allows Query Builder
you to make complex queries from your connected databases.  As Prepared Statements, these queries 
are more resistant to SQL injection offering additional security over basic queries.  Craft your query, and 
for each variable you wish to evaluate, substitute a '?' and a new editor will be added below in which you 
can add static values, expressions, or references. 

Basic SQL Query

This query type is the common type historically seen through much of Ignition. You can write queries 
which include tag path references, expressions, or report parameters which resolve at run time.

Tag Historian Query

Provides a simple way to query data from Tag Historians.  Utilizing a user interface familiar to Tag 
Historian users, you can collect data from Historical tags for specific date ranges, using aggregations, or 
for fixed sample sizes.

Tag Calculation Query

A new part of the Ignition Platform in 7.8, Tag Calculations is an extensible part of the API that provide 
values from calculations run against Tags. You can easily run several calculations on your historical tags, 
including Average, Sum, Maximum value, and many more. 

Static CSV Datasource

The Static CSV data source is exactly what it sounds like – an opportunity to provide your report with a 
static set of CSV data.   We found this source to be helpful when trying to design reports without having 
database access.  You can generate or create a simple CSV model of some of your data and test the 



visual layout of your report.  Alternatively, it also provides a means of adding data from, for example, 
Excel or Access CSV exports.  While not the most powerful datasource, it does make it easy to add 
external data.

Script Datasource

Always a popular choice for power users, a script can be used to collect data that is otherwise difficult to 
get through the Query types.  Whether you need to pull data from files, crunch data collected from 
Queries using specialized Python libraries, or alter datasets from converted Reports, scripting is always a 
flexible way to accomplish your goals.  In general, we recommend using alternatives when they exist, but 
if all else fails, a script will provide the flexibility you need to get data to the reporting engine.

 

Next...

Report Designer
Report Data
Parameters
Basic SQL Query
SQL Query
Tag Historian Query
Tag Calculation Query
Alarm Journal Query
Static CSV
Data Sources - Scripting

 



Report Designer
 

New Design Interface

The new Report Workspace's Design tab feels right at home in Ignition and has significant improvements 
in usability.  Strides were taken to maximize the native feel of the workspace's Design tab while not 
requiring experienced Report module users to abandon their hard-earned knowledge.  At the same time, 
our goal was to simplify the process and remove much the mystery of report design.  

Looking at our screenshot of our Report Designer, you'll notice that an open Report Resource in the 
Project Browser can now be expanded to provide information at a glance.  This tree lets you visualize the 
relationship and hierarchy of Report Design elements on the page.  Find an element in the tree by 
selecting items on the page, or find an element on the page by selecting it from the tree.  As you do so, 
you'll notice that the bottom left of the default Report Designer will change to provide configuration panels 
and/or property tables depending on the selected item.  In between these two panels on the left is the Key

which provides the   and parameters we use to reference data in our report.  Browser  Data Keys

The right of the panel is where our design palette lives, providing a number of powerful components, 
charts, and shapes which we use to build the layout and visualization of our report.

New Design Components in Reporting v3

While some of the components in the Report Designer are unchanged, we refreshed some and created a 
new configuration interface that is much simpler (and much more familiar) for Ignition users. 

Barcodes

New Barcode component added support for 2D barcodes, including QR Codes, PDF 417 and Aztec and 
Data Matrix.

Charts

Charts were rebuilt from the ground up with simpler configuration, and more options.  Plot report data in 
Timeseries, XY, Pie or Bar Graphs.  Configure pens, axis and appearances in a familiar interface!

 

New Key Browser

Just below the Project Browser is the  .  The Key Browser is home to all your Data Sources, Key Browser
the new  , as well as a number of built-in calculation keys to speed you through the report Parameters
design process.  When you configure a data source and switch to the Design tab, a sample of all your 
queries is run on the Gateway to get information about the structure of your data.  Columns in your data 
are represented as children in the Key Browser tree.

 

 

Report Designer

Watch the Video

 

 

The Design Panel

   

Object Layout

Object layout is an important aspect in creating a professional report. Ignition Reporting uses a WYSIWYG (what you see is what you get) approach.

Headers and Footers

Creating headers and footers is just like creating any other set of objects on your report. There is no explicit header or footer section. The key is sizing 
and positioning of components within your page around your header or footer.  Each new page that the table creates will have that same header and 
footer. 

Z Order

Z order defines relative order of objects when they overlap. Simply select the object and click "Bring to front" or "Send to back" in the Component menu

Object Grouping

Grouping makes a set of object behave as one with respect to: selection, moving, and resizing. To "drill down" to individual objects, superselect the 
grouped object.

Selection and Alignment

https://www.inductiveuniversity.com/video/report-designer/7.8


Selection is done with the selection tool, which is the default tool in the Report Designer whenever another tool is not activated.

Reporting has a "deeper" selection model than the Ignition designer. Simple object selection is done by single clicking an object. "Selecting deep" is 
done by double-clicking to get into the report hierarchy. For instance, if you group two rectangles together, you can select the individual rectangles by 
double clicking "into" the group.  With the release of Reporting v3 in Ignition 7.8, visualizing selection is simplified by viewing the Project Browser to 
see which node in the Report Resource tree is selected.

 

Superselection

Superselection refers to an editing state that some shapes go into when double clicked. Text is the most common of these. When a text box is 
selected you can move and resize it. When it's super-selected, you can place the text cursor or select a range of characters and insert or delete text. 
The polygon and pencil are two other basic tools that support superselection.

Multiple Selection

Multiple Selection can be done two ways:

Clicking and dragging the mouse over a range of the report. Everything the selection rectangle touches becomes selected.
Hold the shift key while making a selection or dragging a selection rectangle. Shapes hit by that action will be added or removed from the 
currently selected shapes.

 

Resizing and Moving objects

To resize or move an object first select it with a single click. To resize left click and drag one of the 8 resizing handles. To move the object, left click 
and drag anywhere on the object when it is selected. Both operations support  .shift dragging

 

Alignment

Alignment is accomplished by selecting multiple objects, then choosing "Make ..." from the   or right click menu.Component menu

 



Menu Items Function

Make Row Top/Center
/Bottom

Quickly align several shapes in a row, either by their top, center, or bottom border. Useful when shapes are of 
different heights.

Make Column Left/Center
/Right

Same as above, but for columns, aligning their sides or center.

Make Same Size, Width, 
Height

Make several shapes the same width, height or both.

Equally Space Row/Column Equalizes the distance between shapes horizontally or vertically.

Shift Drag

Holding the shift key while you drag shapes will constrain movement to: horizontal, vertical, or 45 degrees.

 

Design Toolbar and Menus

 

The Ignition Designer menu bar provide quick access to many common Reporting Design functions.  As can be seen in the screenshot above, the Com
 and   menu items are added to the when the Report Design Panel is open.  ponent Pages

 

Edit

The Edit menu provides functions like cut, copy and paste.

Menu Item Function

Undo Undoes the last action.

Redo Re-does the last undo (assuming nothing was changed after the last undo).

Cut/Copy/Paste Allows you to easily duplicate or import document elements using the system clipboard.

Select All Selects all elements at the current level of selection (or all text, if editing a text field).

 

Pages

The pages menu allows you to add or remove pages in the report.

Menu Item Function

Add Page Adds a page to the current open document, after the currently selected page.

Add Page Previous Adds a page to the current open document, before the currently selected page.

Remove Page Removes the currently selected/visible page in the current open document.

 

Component

This shapes menu allows you to modify the layout of objects in a report

Menu Item Function

Group/Ungroup Allows you to merge the currently selected shapes into a single shape for convenient management. Contained shapes are still 



accessible, via double-click super-select. Ungroup separates grouped shapes.

Bring to Front
/Send to Back

All shapes have an order on the page that determines what is drawn on top when two shapes overlap. These options allow 
you to alter that order.

Make Row Top
/Center/Bottom

Quickly align several shapes in a row, either by their top, center, or bottom border. Useful when shapes are of different heights.

Make Column Left
/Center/Right

Same as above, but for columns, aligning their sides or center.

Make Same Size, 
Width, Height

Make several shapes the same width, height or both.

Equally Space 
Row/Column

Equalizes the distance between shapes horizontally or vertically.

Group in Switch
/3D Shape

This feature groups selected shapes in a Switch Shape, which has the same features as Table Row Versions. It's a powerful 
way to conditionally provide a different look for a specific element.

Combine/Subtract 
Paths

Takes multiple overlapping shapes (such as a rectangle and an oval) and combines them into a single shape using the 
combined paths. A powerful tool to construct complex shapes.

Convert Into 
Image

Converts the selected shape into an image. Be sure to group shapes first if you want to convert multiple shapes into a single 
image.

Toolbar

The toolbar provides a variety of functions to assist in editing while designing a report.

 

Toolbar Item Function

Toggles bold of the selected text

Toggles Italic the selected text

Toggles underline of the selected text

Aligns the selected text left

Centers selected text

Aligns the selected text right

Adds a $ to the data key

Adds a % to the data key

Forces a decimal place on an integer value in a text shape

Add the number of allowed decimal digits

Subtract the number of allowed decimal digits

Increase the size of the report in view



Decrease the size of the report in view

Have the report fill the available space

Next...

Simple Report
Report Charts

 



Simple Report
 

Reports in the runtime

Once created, you can view the report from the Ignition runtime or Designer preview mode with the 
Vision Report Viewer component.

 

Saving a report from the Vision Report Viewer is simply a matter of right-clicking on the report in the 
Ignition runtime or preview mode of the designer and selecting the format you wish to save it 
as.  Selecting from the menu will open a Save or Print dialog in the Client window. 

 

The Vision Report Viewer component supports the following options:

Print - send your report to a connected printer
PDF - formatted for viewing in PDF Viewers
HTML -  an HTML document viewable in your web browser
PNG - save as an image

 

Simple Report

Watch the Video
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Built-in Keys
Other Reporting Module Components

 

https://www.inductiveuniversity.com/video/simple-report/7.8


Built-in Keys
 

 

Built-In Keys

A number of useful Data Keys are included by default.  These tables lists the keys and provides a brief 
summary.

Built-In Report Data Keys

Key  Description 

Gateway Name of the Report's Ignition Gateway

Name Name of the Report

Path Path to the Report in the Project Browser

Timestamp The Gateway's current timestamp

Built-In Data Keys

Key Description

Date The current date/time

Row The current row number (only in tables)

Page The current page

PageMax The total number of pages in the generated report

PageBreak The number of explicit page breaks encountered

PageBreakMax The total number of explicit page breaks in generated report

PageBreakPage The number of pages since last explicit page break

PageBreakPageMax The total number of pages in current explicit page break

Row Shows the current row number. Must be used in a table

 

The "total2" key

An aggregate calculation will result in null if any of the individual values are null (rather than return a 
value that is technically incorrect). You can work around this by implementing a derived method that 
returns a default value if the original attribute is null and aggregating using that key/method. Also, most of 
the aggregates contain a second version ("total2") that assume that null is equal to zero.

 

The "count" and "countDeep" keys

The count keys tell us how many objects are in a given list or group. This is most commonly used for 
tables with one or more levels of grouping. If, for instance, you have a table of Movies grouped by their 
studio and you add the @count@ key to the studio details, it will display the number of movies for each 
studio. So it might make sense to have a text field with "@studio.name@ has released @count@ 
movies" (Warner Brothers has released 15 movies).

 

The count key only counts the next level of grouping. If you have multiple levels of grouping and want to 
count all the root entities use the countDeep key. Suppose you have movies grouped by their category 
and their studio, and want to display a top level summary. You could use: "@studio.name@ has released 
@countDeep@ movies in @count@ different categories" (Warner Brothers has released 36 movies in 7 
categories).

 

 

 

Built-in Keys

Watch the Video
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Heritage Keys (Running Totals, percentage totals)

 

There is an additional set of keys in the Attributes Browser which are used to access upper level groups: 
Up, Running, Remaining. @Up.count@ would tell us how many objects are in the current level of 
grouping.

The text field "Row @Row@ of @Up.count@" might show "Row 1 of 5".

By doing some simple arithmetic and using the "Up" key, we can calculate a percentage total: "% Total: 
@revenue/Up.total.revenue@"

The running key references a virtual array containing all of the objects processed thus far in a lower level 
grouping. This is useful to get a running total. For example, in a ledger: "Credit/Debit: @amount@ 
Current balance: @Running.total.amount@"

The remaining key is conceptually the same, but results in a virtual array of remaining objects.For 
example: "Credit/Debit: @amount@ Remaining Activity: @Remaining.total.amount@"

 

Next...

Reporting Component Properties

 



Reporting Component Properties
Reporting components, just like Vision components, have many different properties.  Some properties 
are unique to certain components so it's always a good idea to look through all the properties of a 
component to see how they can be used to enhance your reports. 

Some Report components, when selected, have an additional tab in the Property Inspector as you will 
see.  The Reporting components that have an additional tab in the Property Inspector are shown here 
along with a brief description of their respective properties.

 
Reporting 
Component 
Properties

Watch the Video

Components

Table Component

The  allows you to display tabular data in a variety of ways using the Table properties. Some of these same properties may also be Report Table
modified from the Properties tab.

Configure Table 
Tab

 

 Configure 
Table 
Properties

Property Description

Data Key Unique identifier or 
placeholder that points to 
your data. Typically a Data 
source is used for this 
property.

Grouping Matches the name in the 
Data Key row that points to 
your data

Rows Rows in a table. There are 
three types:

Header Row: A single row 
inserted at the start of the 
Detail Rows. Commonly used 
to display column headers.

Details Row: Represents the 
majority of the data on a table.

Summary Row: A single row 
inserted after all the Detail 
Rows. Commonly used to 
display totals or summary 
values.

Sorting Orders data in the table. 
Sorting occurs after the data 
has already been retrieved in 
the data source. There are 
three options:

Default: Data sorted based 
on the order in which it is 
retrieved. When selected, the 
table will not sort the rows.

Basic: Allows a list of keys to 
be configured. The data is 
sorted in the order the keys 
are selected.
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TopN: Uses a single key 
path, with a Count value that 
allows a limit to the number of 
rows that are processed

Page 
Break Creates a page break 

between each grouping

Make 
Table 
Group

Can create 'child' and 'peer' 
tables.

 

 

Labels Component

Labels can be used to print out a host of different types of labels depending on how you configure the Label properties.  You can create mailing labels, 
name tags, generic labels, and more. You can even use the Avery Label sheets. Some of these same properties may also be modified from the 
Properties tab.

 

Configure Labels 
Tab

 

Configure 
Labels 
Properties

Property Description

Data Key Name of the key that will 
populate the Labels.

Label 
Formatting

Choose from a list of Avery 
Label Formats, or create a 
custom sized label.

Rows / 
Columns

Defines the number of rows 
and columns per page

Label 
Width / 
Height

Width and height of labels in 
pixels.

Spacing 
Width / 
Height

Distance between Labels on 
the page in pixels.

 

Barcode Component

The  allows reports to contain dynamically generated barcoded based on the how Barcode component
you configure the Barcode properties. Some of these same properties may also be modified from the 
Properties tab.

 

 

Configure 
Barcode Tab

 

Configure 
Barcode 
Properties

Property Description

Data Key Key that will populate the 
barcode.

Barcode 
Format Barcode format to display

Show Text Determines if the value of the 
Data Key should appear on 
the barcode.
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Graph and Chart Components

The Chart Options tab contains all the same properties for both the  and . You Timeseries Chart XY Chart
will notice that the reporting properties for the Timeseries and XY Chart components contain some of the 
same properties that are in the Easy Chart Customizer. These same properties may also be modified 
from the Properties tab.

Timeseries Chart & XY Chart Components

 

Chart Options Tab

 

Timeseries Chart 
Chart Option 
Properties

Property 
/ Symbol Description

Data Key Unique identifier or 
placeholder to the data 
source that will populate the 
chart.

Domain 
Key

The data key that should 
represent the X axis on the 
chart. The Timeseries Chart 
expects a timestamp, while 
the XY chart can use any 
numeric value as the domain 
key.

Pens Pens represent a series of 
data. There are several 
properties for each pen 
exposed on the Chart 
Options tab:

Range Key: The key the pen 
should retrieve data from.

Pen Name: The name of the 
pen that should appear on 
the chart.

Preview: Visual 
representation of how the 
pen will be rendered. The 
trend is simply a preview, 
and does not take the data 
from the range key into 
account.

 Edit 
Pen

Opens Pen Configuration 
area for editing.

 Add 
Pen

Adds a pen.

 
Remove 
Pen

Deletes a pen.

Axes There are several properties 
for each axis exposed on the 
Chart Options tab:

Name: The name of the axis.

Label: Text next to the axis. 
Commonly used to describe 
what the values of each pen 
represent.

Auto?: Determines if the 
axis should automatically 
adjust the upper and lower 

 



bound of the axis to include 
all data from each pen. 
When enabled, the High and 
Low properties are ignored. 
When disabled, High and 
Low will be used.

Low: The low range value 
the axis will use when 'Auto?' 
is disabled.

High: The high range value 
the axis will use when 'Auto?' 
is disabled.

 Add 
Axis

Add an axis.

 Edit 
Axis

Opens Axis Configuration 
area for editing.

 
Remove 
Axis

Deletes an axis.

Enable 
Scripting Enables the script for the 

component to run.

Edit Script
Allows the chart to be 
modified before the report is 
rendered.

     

Bar Chart Component

The Configure tab is present when using the   and   components. Bar Chart Pie Chart The Configure 
properties are just as the name suggests; how to configure the look and feel of a chart; rows, columns, 
and segment colors on a chart.  Some of these same properties may also be modified from the 
Properties tab.

 

Configure 
Tab

   

 

 

 

Bar 
Chart 
Confi
gure 
Prope
rties

Property
/Symbol

Description

Data Key Unique identifier or 
placeholder to the data 
source that will populate the 
chart.

Extract 
Order

The order in which the data 
should be extracted from the 
data key. Two options are 
available:

Row: Data is extracted by 
row. Use this when columns 
in the data key define the 
series of data.

Column: data is extracted by 
column. Use this when rows 
in the data key define the 
series of data; each column is 
a new value for the same 
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series. This is sometimes 
referred to as data 'turned on 
its side'

Options 3D: Columns and bars with 
3D appearance using angle 
and depth.

Pareto: When enabled, turns 
the chart into a Pareto chart. 
Contains both lines and a bar 
graph where values are in 
descending order.

Render 
Style

Provides three rendering 
styles:

Bars: Displays data as 
individual colored bars

Stacked: Displays data as a 
stacked bar in different colors

Layered: Displays data as a 
layered bar in different colors

Segment 
Colors

A unique color in the RGBA 
color space for each segment 
(bar)

 
Color 
Wheel

Tool for creating color 
combinations for bars

 Add 
Segment

Adds a color / row

 Rem
ove 
Segment

Deletes a color / row

Scripting 
Enabled Enables the script for this 

component to run

Edit Script Allows the chart to be 
modified before the report is 
rendered.

 

 

 

Pie Chart Component    

Configure Tab

 

 Pie Chart 
Configure 
Properties

Property Description

Data Key Unique identifier or 
placeholder to the data 
source that will populate the 
chart.

Label Key Key that will list the names of 
each segment in the legend 
on the chart.

Value Key The key that will populate the 
chart with data.

Segment A unique color in the RGBA 

 



Colors color space for each segment 
(wedge).

 Add 
Segment

Adds a color wedge to the 
chart

Rem
ove 
Segment

Deletes a color wedge from 
the chart

Shapes

The reporting component properties for  uses the Property Inspector. There are no other tabs for Shapes
additional properties. The reporting component properties are used just like the ones in the Vision 
Module.  Drag any of the properties on to your Design workspace to use in your report.

 

Property 
/ 
Symbol

Description

Click and drag to create a shape that will contain text.

Click and drag to create a line

Click and drag to create rectangle

Click and drag to create n ellipse

Click and drag to create a star

Click points so that lines will be joined with straight lines

Click and draw free-hand segments

 

 

Text Shape Component

The Edit Text tab is pretty straightforward to use. Text Shape properties can be modified by the buttons 
on the right side of the Property Inspector. These same properties may also be modified from the 
Properties tab. Properties that are modified will usually affect all text in that object regardless of specific 
text selection.

 

Edit Text 
Tab

 Text Shape Component Properties

Property 
/ 
Symbol

Description

Data Key search

Font, Font & Style

Bold

Italic

Underline

Superscript
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Subscript

Font Color

   

   

   

   

Next...

Key Calculations
Report Tables
Report Designer

 



Key Calculations
 

It's possible to perform calculations on data keys. This section documents the various operators and 
functions that are available. 

 

 

Key Calculations

Watch the Video

 

 

Keychain Expressions

Keychains have their own expression language that is largely similar in syntax to Java.  You can type in expressions within the "@" symbols to 
perform calculations on the keys. Here are the operators in order of precedence.

Operator Function Example

Parenthesis (expr) Nested 
expressions

Any portion of a Key Chain can be enclosed with parenthesis to guarantee precedence.

Multiplicative *, /, % Multiply, 
divide, modulo

These are the most common and intuitive operators. You might want to display @quantity*price@ in an invoice 
line-item or calculate a percent like this @profit/revenue*100@.

Additive +, - Add, subtract See multiplicative above

Relational >, <, >=, <= 
Greater-than, less-
than, greater/less-
than-equal

These are most useful for conditionals: @amount>=0? "Credit" : "Debit"@ or @name=="this"? "that" : name@

Equality ==, != Equal, not-
equal

See Relational above

Logical AND && These operators make it possible to test multiple conditions: @revenue>100 && budget<50? "Winner!"@ or 
@name=="Jack" || name=="Sam"? "Good Name!"@.

Logical OR || See and above

Conditional ? : If/then - with 
form "expr? 
true_expr : 
false_expr"

Provides IF/THEN/ELSE expressions. Note: a false expression is optional. 'null' will be evaluated to false and 
non-null as true. You can provide null substitutions like this: @name? name : "(None provided)"@. You can 
also nest conditionals for more conditions. For example, @age>=21?"Adult":(age>12?"Teen":"Child")@.

Assignmen
ts

=, += For the brave, you can create temporary variables for use in a report. Most of the functionality you might use 
this for is covered in more intuitive ways (such as the Running key), but it is possible to define a variable in a 
header row: @revTotal=0@ and update it in details rows @revTotal+=revenue@.

 

Math Functions

The following functions return floats.

Menu Item Function

floor(float) Round input down to the nearest whole number.

ceil(float) Round input up to the nearest whole number.

round(float) Round input to the nearest whole number.

abs(float) Returns the absolute value of the input (if number < 0 return number * -1).
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min(float, float) Returns the input number with the least value.

max(float, float) Returns the input number with the greatest value.

pow(float, float) Returnsfirstnumber to the second number power.

 

String Functions

The following functions return strings.

Menu Item Function

startsWith(String, String) Returns true if the first string starts with the second.

endsWith(String, String) Returns true if the first string ends with the second.

substring(String, int start) Returns a substring of String beginning at position start.

join(List aList, String 
aKeyChain, String 
aDelimeter)

Used to display an individual attribute of individual objects as a single String. Suppose you have a list of movies and 
want to show their titles in a comma separated list: @join(getMovies, "getTitle", ", ")@

substring(Object aString, int 
start, int end)

Obtain a subset of a given string. This could be useful if you wanted to restrict a text field to a certain number of 
chars:@substring(title, 0, 10)@

 

 

 

Next...

Use Dynamic Data Key

 



Use Dynamic Data Key
 

 

It's possible to bind properties on Reporting components to parameters. It's as simple as dragging-and-
dropping the parameter to the property, or right clicking the property and clicking on 'use dynamic data 
key'.

 

 

 

Use Dynamic Data 
Key

Watch the Video

 

 

 

Next...

Converting Legacy Reports
Report Data
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Converting Legacy Reports
 

The complete rebuild of the Reporting Module in Ignition 7.8 brought many improvements that would 
have been impossible to add to the legacy module.  To preserve report functionality and prevent 
problems with backward compatibility, any existing reports will function as they always have.  To get the 
most out of your reports and enable new functionality in such as Scheduled Reports, you'll have to 
convert your old Vision Report Panel components to new Report Resources.  In an effort to minimize 
barriers, we created a Report Conversion process that will attempt to convert Ignition 7.7- reports into 7.8
+ reports. We encourage people to convert their reports to new resources if they feel they would benefit 
from the added functionality, but in doing so, it's important to keep some things in mind:

Some Components have Imperfect Conversion

There are a number of components that have been upgraded or completely rebuilt. Due to the changes, 
some components and/or configurations may not convert perfectly to the new module. Specifically, the 
upgrade to the Barcode component and addition of 2D barcodes utilizes a new encoding system that 
does not have perfect parity with the legacy encoder. The new component does not explicitly support 
encoders for some of the Narrow and Extended codes, as well as MSI. Reports which require the Narrow 
or Extended Code 39/Codabar or MSI barcodes will not convert perfectly. Lastly, the changes to the 
Charts brought many improvements, but will look a little different and may require some configuration.

Data Sources will need Configuration

Data Sources are a huge improvement in the new module. It's now far easier to collect and use data from 
nearly anywhere in Ignition. Unfortunately, the custom properties in the legacy Report module do not 
directly map over to the new Data Sources. When a report is converted, its custom properties will be 
converted to  . Parameters are great in that they allow for a quick conversion and enable Parameters
things like  , but Data Sources will need to be manually configured if desired.Scheduled Reports

 

These are the two major caveats to be aware of when converting. The conversion tool has been tested 
with a variety of legacy reports, but there may be additional factors preventing conversion. We encourage 
users to visit the   and let us know – improvements to the conversion tool can Inductive Automation forum
only occur if we are made aware of errors!

Conversions are Non-Destructive

With the potential issues covered, it's important to note that report conversions   destroy or alter the do not
original report. If the conversion isn't successful for some reason, the new report can simply be deleted 
and the old one exists as it always did. If the conversion is successful, the old report can be saved to an 
unused window or exported as a backup before being deleted. Conversions may not always be perfect, 
but there is no risk in trying.  

 

 

Converting Legacy 
Reports

Watch the Video

   

How to Convert
Converting a legacy report is quite simple.   In the Ignition Designer, open the window where the Report 
Viewer component exists.  If you right click on the component, the new "Convert..." option is at the top of 
the popup menu.  Selecting it will start the conversion process which first prompts for the "OK" to 
proceed, then asks what the new Report Resource should be called.  Upon conversion, a new Report 
Viewer will be added to the existing window in addition to the old report.  If you check the Project 
Browser, you'll see the new report under the Reports tree node.  Open the newly created Report 
Resource for any edits, to add data sources, or add Scheduled Actions!
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Next...

Sample Legacy Report Conversion
Report Data
Parameters

 



Sample Legacy Report Conversion
 

Title
 

Sample Legacy 
Report Conversion

Watch the Video

 

Next...
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Report Data
Data Keys

 

The most critical part of any report is data.  Without data, there is nothing to report!  In the Reporting Module, we use   and (optionally) Data Keys Keych
 to feed the report from the data sources.  The simplest reference to data is a simple Data Key.  A Data Key is a reference that points ain Expressions

to the data it represents. At report generation time, these keys resolve to the values (or sets of values) provided by the data source.   In simple terms, 
Data Keys are placeholders for your data.

 

 

 

In this section ...



Data Keys and Keychain Expressions
Data Keys

 

The most critical part of any report is data.  Without data, there is nothing to report!  In the Reporting 
Module, we use   and (optionally)   to feed the report from the data Data Keys Keychain Expressions
sources.  The simplest reference to data is a simple Data Key.  A Data Key is a reference that points to 
the data it represents. At report generation time, these keys resolve to the values (or sets of values) 
provided by the data source.   In simple terms, Data Keys are placeholders for your data.

 

 

 

Example

If we created a data source named  , we can experiment with Data Keys to see how they resolve.  Create a table in the Report Countries
Designer.  Drag the Countries data source from the Key Browser to the Data Key field in the Table Configuration Panel as seen below.  In the image, 
you can also see that we enabled the Table's Header, and typed header descriptions for each column we wanted to display.  Then we dragged and 
dropped keys from the Key Browser into the Details columns.  We can tell which items in the Report Designer reference data keys because they are 
surrounded by "@" symbols.

"Countries" data source

Country, Capital, Population
"China", "Beijing", 20693000
"Japan", "Tokyo", 13189000
"Russia", "Moscow", 11541000
"South Korea", "Seoul", 10528774
"Mexico", "Mexico City", 8851080
"Italy", "Rome", 2858104
"Germany", "Berlin", 3520000

If we click to the Preview tab, you will see a simple table that neatly displays a row for each entry in Countries data source.  Looking at the XML in this 
tab, you can see that the Countries data source sent a single row of data for each entry.  You'll notice that the headers are printed exactly as they 
were in the Design panel.  As an experiment, you can surround these header values with "@" symbols to see what happens.



Data Key Usage

 

All text fields in Report Design elements are able to resolve Data Keys.  In fact, you can freely mix plain text and data keys anywhere.  In our table 
example above, we could substitute "@Population@" with "@Population@ people" and the data key portion would be swapped out for the appropriate 
data.  This can be a very powerful feature when trying to create reports. For example, you could have a text field at the bottom of a report that displays 
"@Page@ of @PageMax@".   If for some reason your Data Key can't be found, your report will display a Substitution String (which defaults to "<N
/A>" but can be configured in the Report's Property Table by selecting the Report in the Project Browser).   

 

 

Data Keys as Paths

Data Keys are   and use 'dot notation' to reference children.  Meaning, if we have a nested data structure, we can use Data Key paths (also relative,   
known as  ) to reference the nested data.  In the key browser image below, we have a nested data source called Downtime.  Downtime Keychains
contains a number of columns, and then contains a reference to additional data called  .  If we wanted to access the highlighted   runInfo operator
data, we could use the keychain dot notation in the designer -  Nested data sources are outside the scope of this @Downtime.runInfo.operator@ .  
page, but you can learn about Data Source nesting in the   section.Nested Queries

Array Index of Data

For more information on Data Key syntax, please see the  pageKey Calculations



You can reference an individual object in a list using standard array indexing syntax (brackets) like this: , where Data is a @Data[0].firstName@
data source that contains a child data key named In this case, we would be accessing the first in the set of data.  firstName.   firstName  

 

 

 

 

Next ...

Parameters
Static CSV
Table Header, Details and Summary Rows

 



Parameters
Adding Parameters function similar to custom properties on Vision windows and components. Their value 
can be shown directly on your report, or be referenced by data sources and other 
parameters. Parameters are given a default value when first created, but this value can be overridden 
once the report runs.

Default Starting Parameters
When you first create a report, you start with two parameters: StartDate and EndDate. EndDate will 
have a default value of 'now()', while StartDate will have a default value of 'dateArithmetic(now(), -8, 
"hr")'. Notice how I have changed the default value of the StartDate to be a difference of 10 days instead 
of 8 hours by modifying the Default Value expression. You can also delete both StartDate and EndDate 
parameters if you do not need date parameters in your report.

 

 

 

 

Parameters

Watch the Video

 

 

Adding New Parameters
In addition to expressions, you can also have your default value reference a tag, like I have done with this StringParameter.

 

 
You can also use a literal value, like I have done for this IntegerParameter.
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Finally, you can reference other parameters, like I have in this BoolParameter. It is important to note that when referencing other parameters, you 
must type the name of the parameter exactly within a set of curly braces { }. Also, you can only reference parameters that are above the current 
parameter. So while I can reference the IntegerParameter in the BoolParameter, I can not reference the Bool Parameter in the String Parameter.

 

 

 

 

Designing with Parameters
Now that we have created our parameters, we are ready to put together a report using those parameters. I have made a report and have dragged all 
of the parameters we created, including the start and end date onto the design section of the report. This way, we can see how all of our parameters 
behave within the report itself.



 
Switching over to the preview tab, we can see that each one of our parameters is now displaying its default value. The end date is showing March 
18th, which was the current date at the time, and the start date is showing March 8th, which is 10 days before the current date. Our string parameter is 
displaying the word "Testing" which is the word that is stored in my string tag, the integer parameter is displaying the static number we placed in as a 
default value, and the boolean parameter has a value of 0 or false, because our integer parameter is not equal to 1000.

 



 

 

Manipulating the Parameters in the Report Viewer
When we view our report in the Report Viewer component on a vision window, we will at first see our default parameter values on the report. All of our 
parameters are listed in the property editor under the Report Parameters section. You will notice that I have manually entered in a value for the string 
parameter, and that parameter on our report updates to reflect the new value. You can also see that our string tag has not changed, nor will changing 
the string tag change our parameter. It is important to distinguish that setting the default value of a parameter is not the same as binding it. The default 
value will be used if there is no value in that parameter. Since I have placed a static value of "My Test into that string parameter, the report viewer on 
this page will always display "My Test" as the value of that parameter, regardless of what the value of the tag is.

 
We can also bind values to the report parameters to make them dynamic. This allows us to use other on screen components to manipulate the reports 
parameters. I have bound the start date and end date parameters to the start and end date properties of a Date Range component. You can see that 
by moving the date range slider, we can easily manipulate the start and end date parameters of our report.

 

I have also bound the integer parameter to the numeric text field. You will notice that the value of the parameter reflects the value of the numeric text 
field. We can also see that because we have not put in a value for our bool parameter, it is still using the default value, which is true when the integer 
parameter is 1000. You can see that the bool parameter has updated in the report to reflect that.



 

Next...

Basic SQL Query

 



Basic SQL Query
 

 

This query type is the common type typically seen through much of Ignition before version 7.8. You can 
write queries which include tag path references, expressions, or report parameters which resolve at run 
time. 

 

 

Basic SQL Query

Watch the Video

 

 

   

Next...

SQL Query
Report Tables
Report Charts
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1.  
2.  

SQL Query
The SQL Query Data Source allows you to craft parameterized queries that run as a prepared 
statement.  In addition, it also features the new  , which is a powerful Drag-and-Drop query Query Builder
building GUI that allows you to make complex queries from your connected databases.  As Prepared 
Statements, these queries are more resistant to SQL injection offering additional security over basic 
queries.  Craft your query, and for each variable you wish to evaluate, substitute a '?' and a new editor 
will be added below in which you can add static values, expressions, or references.

Using the SQL Query Datasource

SQL Query Data Sources are created by selecting it from the   button menu on the Data tab of our 
Report Workspace.   As with all Query data sources, at minimum you will want to verify the  and Database 
give the Query a meaningful name in the right column's  field.Data Key 

 

 

SQL Query

Watch the Video

 

 

Examples

Using Parameters in Queries

Parameterized Queries are an easy way to create Queries which can be safely configured to utilized dynamic values when a Report is executed in a 
schedule or Vision  .  When we write a Query of this type, we can substitute '?' anywhere we want to utilize a parameter value.  As we Report Viewer
add ? placeholders, the configuration panel will add editors for each placeholder.  These editors allow you a ton of options.  They can reference report 
Parameters, get values from Tag paths or utilize Ignition Expressions.  

 

In this example, we'll use a simple parameter to alter the results of a Query at runtime in a Vision Report Viewer.   Specifically, we are going to use 
Parameterized Query to alter the results displayed in a Table in the Vision component.  

We'll be using a query that returns two columns of data:

The name of Customer
The city in which they are located.  

The results from the base query look just like the image below.

The first thing we will need is a Parameter for the report, so we start by creating a parameter through our Data panel and name it CustomerLocation.  N
ext, we'll create the actual SQL Query datasource and add our query.  

SELECT 
        CompanyName AS customer_company_name, City AS customer_location FROM Customers
WHERE
        City = ?
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Now in the   editor below the query box, we want to add a reference to our Parameter, which we can do using curly braces like Parameter 1 {Customer
}.  Here is what the finished data source looks like.Location

When the Report executes, it is going to substitute the value of the ? for whatever value is used for    Remember that parameter CustomerLocation.
values can be entered in the Parameter configuration of the Report Data panel, as a property in the Vision Report Viewer component, or in the Report 
Schedule panel, or any mixture of the three.  If a value is not selected as a default in the Report Data panel, one will need to be specified in the Vision 
component to generate a report view in the Viewer, or in the Report Schedule for successful generation via schedule Action.  If a default is provided, 
any values entered in those respective areas with override the default.  In our case, we intend to use the Report only in a Vision component, so we will 
forgo the default and let the operator enter a value to see the result.

Now we'll create a simple table in the design panel by dragging the table component onto the page and dropping our CustomerLocations data source 
key into the DataKey config field.  We'll set Header and a Details rows to visible and unstructured and add and then add some simple text.  The 
header will let us know which city the parameter is set to, and we will simple print a line for each customer name we find that match the city in the 
details row.  If we click over to the Preview panel now, we'll find the Report blank.  This is expected since we have no default parameter and have yet 
to specify one. 

Now we shift to the Vision workspace to create a new Window and add a Report Viewer component.  If we select the Report we created in the 
Property Inspector of the Report Viewer component, we should see a similar Data Collection Error to the one in the Reporting Workspace Preview 
panel.



 

To correct the error, we simple need to add a value to the parameter field for CustomerLocation.  We know there are some Customers in Madrid, so 
we try that and we get the following result.

These parameter properties and bindable, so you can use text fields, tag values, or any other Ignition binding to set the value.  By using parameters in 
this way, we allow a lot of flexibility while at the same time significantly reducing the risk of SQL injection.  This is a simple example, but using this 
same process you can create complex reports in a similarly simple process!

 

Crafting Queries with the Query Builder

The SQL Query data source includes our first release of the powerful SQL   tool.  The Query Builder is a graphic tool for building Query Builder
queries.  While a basic understanding of SQL helps make the most of Query Builder powerful tool, most people will have no problem creating effective 
queries after a brief tutorial.  

To activate the Query Builder, start by selecting the SQL Syntax version from the drop down menu beneath the 

 button.  If your Database type isn't available (or you aren't sure), you can likely get most of the general 
functionality selecting the   option.  Then push the button to show the    The Query builder has a lot of functionality and can Universal Query Builder.
consume a lot of space in the Designer.  As a result, we recommend using it on larger monitors if possible.  

 



 

 

Next...

Tag Historian Query
Parameters

 



Tag Historian Query
The Tag Historian Query provides a simple way to query data from Tag Historians.  Utilizing a user 
interface familiar to Tag Historian users, you can collect data from Historical tags for specific date ranges, 
using aggregations, or for fixed sample sizes.

 

 

Tag Historian Query

Watch the Video

 

 

 

Next...

Tag Calculation Query
Report Charts

 

https://www.inductiveuniversity.com/video/tag-historian-query/7.8


Tag Calculation Query
Tag Calculations are executed by the Tag Historian, providing multiple calculated values for each tag path. Calculations such as Sum, Duration On

 and more are available./Off, Average

   

 

Tag Calculation 
Query

Watch the Video

 

 

 

Next...

Alarm Journal Query
SQL Bridge Module

 

https://www.inductiveuniversity.com/video/tag-calculation-query/7.8


Alarm Journal Query
 

 

The Alarm Journal Query data source is a simple way to access Alarming data within a report.  It 
provides a straight-forward interface to select StartDate and EndDate, Event types, Filters and Priority.

 

 

Alarm Journal 
Query

Watch the Video

 

 

 

Next...

Static CSV
Report Tables

 

https://www.inductiveuniversity.com/video/alarm-journal-query/7.8


Static CSV
 

 

The Static CSV data source allows you to quickly craft a data source to use in your report. This data 
source is ideal when you need some test data to begin creating a new report. 

 

Example

1) In the Data Panel of a report, click on the   and select Static CSV

2) Give the data source a name by filling in the Data Key property with the following: Downtime_By_Site

3) Copy the following data and paste it into the Data field:

Downtime_By_Site

Equipment,Time,Site
Motor,15,Site A
Motor,23,Site A
Conveyor Line,148,Site B
Pallet Wrapper,58,Site A
Motor,96,Site C
Conveyor Line, 23, Site B
Palletizer,40,Site B
Palletizer,30,Site D
Conveyor Line,56,Site A
Pallet Wrapper,45,Site C
Motor,43,Site C
Conveyor Line,87,Site D
Motor,23,Site D

 

4) The data source should look like the picture below:

 

5) Switch to the Design panel, expand Datasources in the Key Browser, and you'll see the Static CSV 
available for use

 

 

Static CSV

Watch the Video

 

 

https://www.inductiveuniversity.com/video/static-csv/7.8


 

Next...

Nested Queries

 



1.  

2.  

3.  

1.  

2.  

3.  

4.  

Nested Queries
 

Query Nesting turns complex data relationships into easily reportable structures and will undoubtedly be 
one of the most useful Reporting v3 features for.  So what is a Nested Data Source?  The simple 
definition is that a   uses the results of a previously executed query to collect data.  The Nested Query
general structure of a Nested Data Source is one in which you have a Parent queries and child 
queries.  Those well-versed in SQL are probably thinking that this sounds like a   and in fact, there JOIN
are some similarities.  There are also some major differences which allow Nested Data to be both easier 
and more powerful to accomplish: 

Nesting relationships are not restricted to data in a single schema, database or even 
source!  Nesting is easy to configure across tables, between different databases, or even with 
sources like the Tag Historian! 
Writing queries for nested query sources can be far simpler and easier to maintain than writing 
complex JOIN operations
Nested structures allow more control in how data is collected, allowing data structures and 
relationships that are more expressive

 

 

 

Nested Queries

Watch the Video

 

 

How Nesting Works

 

Let's use a simple data relationship to help illustrate how nesting occurs.

 

Imagine we have data collected from two unrelated sources that look the ones seen in this table.

Codes Frequency

CodePK Code

1 ZG

2 GB

3 DC

4 PD

5 JE

6 FO

7 QT

... ...

5436 POE

FrequencyID CodeID Frequency

1 6 11

2 7 41

3 5 13

4 4 26

5 3 13

6 2 32

7 1 11

... ... ...

3456 5345 34

 

We want to create a data source connecting all these things for reporting using nesting. The 
process to accomplish this is:

Create a new data source to be the query. The parent query will likely depend on Parent 
what your data looks like. For this example, we'll just use the  data.Codes
Give your data source a meaningful name, will work for us.CodeFrequency 

Create a  by clicking the  button in right configuration pane of your data Child Query
source, also giving it a name. We will call this nested data .NEST
In the Child query, reference one or more column values from the parent.

Nest Query Configuration

https://www.inductiveuniversity.com/video/nested-queries/7.8


 

Example of what these queries could look like:

-- Parent Query
 
SELECT * FROM Codes
 
-- In the Child Query, accessed by clicking on the NEST leaf of the Nested Queries Tree
-- This assumes the value of Parameter 1 would be equal to {CodePK}
SELECT FrequencyID, Frequency FROM Frequency WHERE CodeID = ?
 
 

How Nesting Works

With this simple example, what happens is that first the parent query is called, and a set of results is returned to the reporting system with the name of 
our parent  . Only after this data has returned, the Child query will execute, once for each row of the parent, substituting the value of CodeFrequency

 into the child query where we have the } reference.CodePK {CodePK

The resulting first two rows of data will have a structure like this:

CodeFrequency
           |
           |-Row 1
           |     |_ CodePK - 1
           |     |_ Code   - ZG
           |     |_ NEST



           |            |_ FrequencyID - 1
           |            |_ Frequency   - 11
           |
           |-Row 2
           |     |_ CodePK - 2
           |     |_ Code   - GB
           |     |_ NEST
           |            |_ FrequencyID - 6
           |            |_ Frequency   - 32
                                

Each row returns the CodePK and Code from the parent query, but also the results of the child query, that apply to the  we get from the parent CodeID
PK.

It may be easier to see the data returned in a flatter form like a table that relates the values by row, ignoring the tree structure:

Parent Query Row CodePK Code FrequencyID Frequency

1 1 ZG 1 11

2 2 GB 6 32

Now, in our Report Design, we will have access to our datasource FrequencyData that has linked these two sets of data together through a shared 
value.

 

Special Considerations

Nested Queries are powerful and easy to use, but users should be aware of runtime implications.  Imagine the scenario above, where we have two 
sets of data, each with 5000+ rows.  When our child query executes, each row of its query is going to require a lookup from the parent.  For most 
common sets of data and database sizes, this won't be an issue, but it's possible to imagine that instead of just one child query, we have a dozen.  In 
addition, some of those children   have many children.   It's very easy to see in this scenario how exponential growth occurs and our system also
performance may suffer.  Most report designers will limit query sizing as oversized data structures are simply not as easy to work with.  However, if 
you feel an urge to generate massive complex trees of million line queries, you may be waiting a while.

 

 

Next...

Table Grouping - Child Tables
Charts Inside of Tables



Report Charts
Report charts allow for the visual representation of reportable data.  Charts can be driven by any data source provided to a report.  

   

 

In this section ...



Timeseries Chart
 

The  is a type of XY chart whose domain or X-Axis represents time series 
data and range can be one or more pens.  The Timeseries Chart is a great way to display visual from 
Tag History, or similar time related data sources.

 

 

Timeseries Chart

Watch the Video

 

 

Usage

To use the chart, drag the component from the Report Palette to your report.  Type or drag a data key 
from the key browser into the   field of the Chart Options Config. Select a time series domain Data Key
(for example a   column of your query).  The Y axis (value) can be modified in the property t_series
inspector but the X axis (time range) is based on the data in the 'data key' that powers the chart dataset.  

To add pens to your query, simply click the   button on the Configure Chart panel of the property 

inspector.  Double clicking or selecting a pen then clicking the   button will toggle the Pen 
Configuration area.  

 

https://www.inductiveuniversity.com/video/timeseries-chart/7.8


 

Next...

XY Chart



XY Chart
   

The   is will generate an X vs Y plot of your data.  XY charts can have multiple Pens 
and Axes per data source, each easily configurable in the custom configuration panel for the component.

 

 

 

XY Chart

Watch the Video

 

 

Usage

To use the chart, drag the component from the Report Palette to your report.  Type or drag a data key 
from the key browser into the   field of the Chart Options Config.  Select a time series domain Data Key
(for example a   column of your query).  t_series

To add pens to your query, simply click the   button on the Configure Chart panel of the property 

inspector.  Double clicking or selecting a pen then clicking the   button will toggle the Pen 
Configuration area.  

 

https://www.inductiveuniversity.com/video/xy-chart/7.8


 

Next...

Report Bar Chart



Report Bar Chart

The  component can be used to add bar charts to a report. 
 

 

Bar Chart

Watch the Video

 

 

Usage

To create a bar chart, simply drag the button from the Report Palette and drop onto your page, Table 
Row, or other shape capable of containing children.  Bar charts are quite easy to configure, requiring a 
data source whose first column generally contains the name or identifier the bar represents, and the 
following one or more columns represent some numerical value to be plotted. 

 

Examples

A Bar Chart example can be found in the  .Report Workflow Tutorial

 

Next...

Report Pie Chart

https://www.inductiveuniversity.com/video/bar-chart/7.8


Report Pie Chart
The   adds a Pie Chart based on a simple two column data structure.   

 

 

Pie Chart

Watch the Video

 

 

 

Usage

To create a new Pie Chart, drag the pie chart palette item from the Report Design Palette onto your 
Report Page or Parent Shape.  A pie chart has a simple configuration consisting of label values 
(generally Strings) and numeric quantity values.  Color segments can be added or removed by clicking 

the   button on the Configuration panel.

 

 

Example

The Pie chart in the images above was created using a simple data source which had just two columns, the first which represented our Label, the 
second being a column of values.  

https://www.inductiveuniversity.com/video/pie-chart/7.8


Fruits, Amount
"Bananas", 52
"Grapes", 154
"Apples", 58
"Pineapples", 25
"Other", 265

 

While this example may seem simple, any data source containing values can be used in similar way by simply using two relevant data keys from a 
more complex source.

 

Next...

Report Tables



Report Tables
 

Tables are a major part of Ignition Reporting.  They are composable and highly flexible, giving Reporting users the ability to flexibly layout and 
organize tabular data. 

Overview

Tables are objects that display data in a structured, repetitious format. Their complexity can range from 
trivially simple to complicated, but fundamentally they do the same thing - take the data given to them 
and repeat structured row for each row or set of data provided. The Reporting engine will automatically 
create new pages to fit all data within the table's boundaries while applying your formatting preferences 
(such as font, size, layout and alignment) each step along the way. Combine that feature with powerful 
data manipulation and expressive layout tools, and you get an object that often forms the basis of your 
reports.  

We'll start by taking a look at the various parts of the base table component and move into more features 
and example.

The Table Component

The Table   component can be created by dragging it from the Report Design Palette, 
or by simply dragging a Data Source from the Key Browser to a page in your report.  A new Table with no 
bound Data Key is fairly simple looking, but hides a wealth of functionality.  To best understand how to 
use a table, you'll want to have some familiarity with the Report Design Concepts (Version 7.7) we cover 
in the design introduction.  Selection and   are particularly important when dealing with Super Selection
Tables.

 

When you create a table, by default you will see something like this on the page.  

 

 

Basic Table Example

Anatomy of a Table

While not exactly complex, it's important to understand the different parts of a table and how they 
interact.  First, the size of the component on the design page dictates how large the table can be on the 
generated report.  Second, in this table, we have a single dark bar with the text "Object Details" on it, with 
four fields we can super select above.  These dark bars are called  , we will talk about them soon.Rows

If you look at the Table Configuration panel, you will see that it has a default data key of "Objects", which 
matches the Details row on the component.  Changing the Data Key will also change the name on the 
row making it easier to determine what you are looking at when editing multiple tables or  .Grouping

Get Familar with the 
Table's Features!

https://legacy-docs.inductiveautomation.com/display/DOC/Report+Designer#ReportDesigner-SuperSelection


 

 

Sorting

Sorting orders your data by a key or list of keys. There are three types of Sorting in Tables.  

Default - data is sorted based on the order in which it is retrieved.
Basic    -  takes a list of keys and sorts by the first one.  If the sort results in a tie, the tie will be resolved by the next key in the list, and so 
on.  
TopN    - uses a single key path, with a   value that allows a limit to the number of rows that are processed.Count

  

Basic and TopN sorts can be configured for either ascending ( ) or descending ( ) sorts.  They can also utilize aggregate (calculation) keys.

The TopN option  will include all values outside of the specified   range by compressing them into a Include Others   Count
single row.

Basic Sort Example 

We will look at the same table using different sorts.  Both have the same exact layout (we made the first, and simply copy/paste to replicate).   The 
first uses Default sort, the second will use a Basic Sort as configured in the image.

To alternate to descending, we could click the   icon and it would toggle to a descending sort.

 

These are our resulting tables, showing the left table sorted by its primary key (OrderID) and the right sorted by Ascending Subtotal.



Filtering

Filtering gives the option of processing data based on an expression.  The Filtering property can be found in the Property Inspector under the Properti
 tab.es

 

If the expression resolves false, the row will be skipped. Note: you do not need @ symbols to reference keys.

 

Filtered TopN Sort Example

This example is sorted descending by downtime and filtered by downtime greater than 20 minutes.



 

 

In this section ...  

 

 



Table Header, Details and Summary Rows
 

Rows are an important fundamental aspect of tables. The different types of rows can be independently 
enabled for each level of Grouping, and for each table in a Table Group Adding or removing rows is as . 
simple as selecting the Row boxes in the Table Configuration tab of the Property Inspector. Additionally, T
able Row Versioning gives you the option of conditionally displaying rows with a different format

Row Types

Header Row

The header row is used to add such report features as column labels. An interesting feature of the 
header is Reprint When Wrapped, which allows a different header on every page after the first. The main 
data in a table has one header row. Each subgroup of data can have its own row header.

With grouping, the "top" level Header is the first row for the entire report. Lower level Headers fall 
immediately below higher level Details. In many cases where one is used, the other could be used 
equivalently in its case.

Detail Rows

The detail rows typically represent the majority of the data on a table or the "middle" rows. You might 
disable detail rows in unusual situations such as only displaying aggregate summaries in a grouped 
report. With grouping, the Detail rows appear below the same level Header and above the Header of the 
next level.

Summary Row

The summary row works like the header row. It prints at the bottom of the table. With 
grouping, Summary rows are always last, always in the opposite order of the Headers.

 

 

Table Header, 
Details and 
Summary Rows

Watch the Video

 

 

Row Configuration

Configuring rows is easy with just a little know-how.  Rows are best understood with a simple example, 
so we'll reference the design table on the right as an example.

To begin making changes to a row, you first need to select the row you'd like to modify by clicking the 
row on the component or the selecting the row's node in the Project Browser tree.  In the image, the 
Header row has been selected.  We can tell by looking at the Project Browser tree, or by looking at the 
red outline of the fields above where it says  (the row's content is laid out above its SalesData Header 
respective row bar).

The four text fields that are above the   row comprise what we call a  .  A structured Details Structured Row
row can have a variable number of fields, and can be configured in the   tab of the Properties
component's Property Inspector panel.  To view the properties of our Details row (or any row), we will first 
need to super-select the row by clicking on the dark bar in the component or the "Details" node in the 
Project Browser.   We can confirm that this row is structured by looking at the Property table for the 
"Structured Columns" checkbox, or by looking for the Jail Bars   icon next to the row version label 
for the  row version.Standard 

Structured rows can provide more control over the layout, wrapping, and organization of your text based 
table data.   Since structured rows are intended for text layouts, they can not contain things like images 
and barcodes.  To embed things like images and charts, we'll want to use  An Unstructured Rows.  
unstructured row is functionally very similar to structured rows, except that it doesn't offer the 
same column based text constraints.  The header of the image shows an example of using an 
unstructured row.  In this case, we have added multiple Text shapes to add our logo, a title, and the a 
date   in the corner to add the date every time a report is executed.  A Line shape was used to Key
underline our column headers, which are also in a Text shape.

We can alter between Structured and Unstructured rows in the Properties tab when the desired row is 
selected, or by clicking the white box on the row we'd like to toggle.

Next...

https://support.inductiveautomation.com/usermanuals/ignition/reporting_tables_grouping.htm
https://www.inductiveuniversity.com/video/table-header-details-and-summary-rows/7.8


Table Row Versioning

 



Table Row Versioning
 

Row versions allow you to conditionally display   of data in different format. They are used to make rows
certain data stand out or to make your report more legible.

Row versions are either builtin or user defined and may be specified with a version key expression. They 
are applicable to header, detail, and summary rows

Builtin Row Versions

By default reports use the Standard row version. Here are the builtin row versions:

Row 
Veresions

Description

Standard Default row version

First Only Applies only to the first instance of the row. Good for showing header information 
without using an upper level detail row.

Reprint Applies every page after the first. Good for one time headers or (continued) indications 
to save space.

Alternate Applies every other row. Good for grey-bar reports by changing the background color.

TopN Others Applies to count number of rows in a TopN sort. Using "include others" will then 
distinguish between TopN and non-TopN rows.

Split Header Applies to headers that has been split due to excessive height. Good for providing 
"Continued" type indicators.

Custom  Create your own. Must be selected manually or in conjunction with the row's Version 
Key property

 

 

Table Row 
Versioning

Watch the Video

 

 

User Defined Row Versions

User defined row versions are identified by a string based name. They will be used when the Row Version Key expression is a string that matches the 
row version name.

 

Row Version Key

The Row Version Key is an expression that must return a string. If that string equals the name of a row version, either builtin or user defined, that 
version will be used. An invalid string will default back to normal builtin row version behavior.

Row Version Example

1. Add a custom row version. scheduled, in this case.

https://www.inductiveuniversity.com/video/table-row-versioning/7.8


2. Select your row and customize it

3. Specify Table Row Version Key. Tip: start with the expression "scheduled" to try out your custom row version before using more complex 
expressions. In this case we use: IF comment = "Scheduled maintenance" THEN use our custom row version.

comment=="Scheduled maintenance"?"scheduled"

Tip When using an IF condition for row versioning leave out the ELSE. Your table will then still respect builtin row versions. If you defaulted the 
ELSE to "Standard", none of the builtin versions such as Alternate would ever appear.

Tip Make sure that you're happy with the Standard row version before you create other row versions. This will save you time as other versions 
begin as a copy of Standard.

Next...

Table Row - Structured vs Unstructured

 



Table Row - Structured vs Unstructured
 

 

Structured rows are by far the most commonly used table row setting. It makes it convenient to add Data 
Keys, and resizing one column is automatically compensated for by the adjoining column. However 
structured rows only allow for text shapes.

 

Unstructured rows allow for much more freedom on what can be placed in the table row. It is possible to 
have images and charts placed into an unstructured row, as well as place text shapes anywhere within 
the row.

 

 

 

Table Row - 
Structured vs 
Unstructured

Watch the Video

 

 

 

Next...

Dataset Grouping

 

https://www.inductiveuniversity.com/video/table-row-structured-vs-unstructured/7.8


1.  

2.  
3.  
4.  

Dataset Grouping
 

Dataset Grouping breaks tables down by keys that share a common value. Tables support an arbitrary 
level of groups. Each can have its own Header, Detail, and Summary  . Additionally, totals and other rows k

 are supported for any level of grouping.eychain functions

Separating Groups with Page Breaks

Selecting the   option will create breaks between each Grouping. Each new 
instance of that level of grouping will create a new page in the report.

In the example above, separating the equipment level of grouping by page would create separate report 
pages for the following:  ,  ,  , and  .labeler filler palletizer converyor line

 

 

Dataset Grouping

Watch the Video

 

 

Example

This example begins with a table similar to that created in the Table Basics tutorial. We'll group our 
existing downtime report table by equipment.

Drag the equipment   from the Key Browser to the Grouping field of the Table data key

Configuration panel, or select the   button.
Enable Header, Detail and Summary rows.
Add your header and details.
Use   for both summary rows. Notice that the total respects grouping.@total.time@

 

In the equipment Summary row total.time is a sum of all time at that level of grouping, which 
includes all downtime events. In the Data Summary row total.time is a sum of all downtime at that level of 
grouping, total time that has already been grouped by equipment, equivalently, total downtime by 
equipment.

 

 Drag and drop a key from 
the Key Browser to the 
selected Table's Grouping 
configuration list to add it to 
the Group.

https://www.inductiveuniversity.com/video/dataset-grouping/7.8


 

   

Next...

Charts Inside of Tables

 



Charts Inside of Tables
 

When a table row is made  it is possible to place a chart inside the row. unstructured

Example

1) Create a Static CSV data source named "Fruit Data" with the following data:

Fruit, Apples,Oranges,Melons
Quantity,15,30,23

 

2) Place a Table on the report. Set the Data Key property to "Fruit Data", and place the @Apples@, 
@Melons@, and @Oranges@ keys ineach data source key in a separate column on the table.

 

3) Select the Fruit Data Details row and uncheck the Structured Columns property

 

4) Click and drag the Fruit Data Details row to make some room for the chart. 

5) With Fruit Data Details still selected, drop a Bar Chart component onto the window. Set the Bar Chart's 
Data Key property to the "Fruit Data" data source.

 

6) Switch to the Preview Panel. You'll see the chart in the same unstructured row.

 

 

Charts Inside of 
Tables

Watch the Video

 

 

https://www.inductiveuniversity.com/video/charts-inside-of-tables/7.8


 

 

 

Next...

Table Groups
Dataset Grouping

 



Table Groups
 

Table groups allow you to specify child tables for each object in the master list (using a list key found in each of those objects). It also allows you to specify 
additional "peer" tables that pick-up exactly where the first table ends (note: multiple tables can also be configured as multiple- page templates, providing a 
page break between tables).  

Table groups and Nested Data Sources in Ignition 7.8 are particularly well suited for each other.  We've made it easier than ever before to create things 
like Summary Tables for categories of items, or drill-down charts.  

Usage

To turn a table into a table group, simply select the table and click the  button in the Table Configuration tab of 
the selected Table. The table is actually a child of a "Table Group" element, which has its own configuration panel in the Property Inspector.

 

To add a Child or Peer table, click the  button. This will add a whole new table for this "child" list key. You can use the arrow buttons to change the 

hierarchy of the tables in the group, or remove them with the trash icon.  To ungroup, select the  button.  

You can edit each of the different tables in the table hierarchy by clicking their node in the table tree, and then clicking the body component on the page to 
activate its configuration. Double-click a node to get its table inspector (or double click on the table template in the open document).

You can get back to the table group inspector by clicking on the "Table Group" button at the bottom left corner of the table template, or by selecting the 
table group node in the Project Browser.

Parent Reference

To reference the parent row object from a child table, you can simply use the key prefix "Parent". So if a row in a movie role child table wanted to display 
the movie title, it could use the key "@Parent. getTitle@".

 

Next...

 Table Grouping - Peer Tables



Table Grouping - Peer Tables
 

Title
   

 

Table Grouping - 
Peer Tables

Watch the Video

 

 

 

Next...

Table Grouping - Child Tables
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Table Grouping - Child Tables
 

 

Child tables are inserted in between each row of the parent table. One table could potentially show 
details for each piece of equipment, with the child table could show all downtime occurrences for the row 
on the parent table. 

 

 

Table Grouping - 
Child Tables

Watch the Video

 

 

 

Next...

Simple Table
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Simple Table
 

 

The Simple Table   is a grid-like structure that dynamically creates new rows and 
columns for row returned by the Data Keys on the component.  

 

 

Simple Table

Watch the Video

 

 

Example

 

First we'll create a Static CSV data source named equipment_downtime. This data source will contain the following data:

equipment,downtime
conveyor line,78
filler, 68
labeler,84
palletizer,27
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Next, head over to the Design panel. Add a new Simple Table to your report. With the Simple Table selected, set the Data Key property to the 
equipment_downtime data source. Then change the number of Rows and Columns to 1.

 

Lastly, drag the @equipment@ Data Key to the top row of the Simple Table, and the @downtime@ Data Key to the 2nd row. The table should look 
like the following:

Switch to the Preview panel and the table should look like the following:

   

 

Next...

CrossTab Table

 



CrossTab Table
 

 

The Cross-Tabulation or CrossTab  component is a tabular data element like the Ta
 and  .  Also known as  they are commonly used to summarize the ble Charts Contingency Tables, 

relationship between two categories of data by showing summaries of cross sections of the data source. 
To be useful, crosstab data should have the following:

Lots of repetitious data.  Sums, Averages, and other Aggregating functions are well represented 
by crosstabs.
A data source that provides at least two columns of data which are repetitious compared to the 
number of rows.  
One or more columns that represent a value that requires calculation.   Examples are: summing 
money, displaying average response times, counting occurrences, etc.   These calculations may 
be provided as columns or calculations of the data source, or as  .Keychain Expressions

Usage

The CrossTab template is much simpler than the table template. By default it just shows one cell of a 
simple table. This is usually configured with an aggregate key, like "@total.getAmount@". After that, 
grouping keys are dragged to the horizontal and vertical axis.

CrossTab Table

Watch the Video

Example

First, create a Static CSV data source with the following data. Name the data source "Downtime_By_Site"

Downtime_By_Site

Equipment,Time,Site
Motor,15,Site A
Motor,23,Site A
Conveyor Line,148,Site B
Pallet Wrapper,58,Site A
Motor,96,Site C
Conveyor Line, 23, Site B
Palletizer,40,Site B
Palletizer,30,Site D
Conveyor Line,56,Site A
Pallet Wrapper,45,Site C
Motor,43,Site C
Conveyor Line,87,Site D
Motor,23,Site D

 

Next, switch to the Design panel and create a new CrossTab component. With the CrossTab component still selected, drag-and-drop 
Downtime_By_Site from the Key Browser to the Data Key property in the Property Inspector

https://www.inductiveuniversity.com/video/crosstab-table/7.8


 

Now we need to add some data keys to the cells in the CrossTab component. We'll add @Equipment@ to the top cell, @Site@ to the leftmost cell, 
and @count@ to the remaining cell. This will show a count of each piece of equipment by site. The CrossTab should look like the following:

 

Switch to the Preview panel and your cross tab will display the results

 

 

Next...

Report Schedules



 



1.  
2.  

Report Schedules
Run and Deliver Reports Automatically

Perhaps one of the most compelling additions of the Reporting v3 module is the new Scheduling system. 
It gives you total flexibility on when reports should run, and how they should be delivered.

How it works

For any Scheduled Report, there are two settings which require configuration:

When the Report executes
The Action which occurs following Report Generation

Additionally, parameters can be optionally overridden by scheduled reports. Reports can have multiple 
Schedules, and multple Actions per Schedule. Schedules run with minute resolution, meaning that we 
can schedule a report down to a specific minute (if second resolution is required, scripting can fill that 
void). It is important to note that  . This means that schedules Schedules execute on the Ignition Gateway
should be created to Gateway local time, NOT Client/Designer time.

 

Configuring Report Schedules

 

Schedules

Creating a scheduled report is easy. On the Schedule tab, you'll notice the UI is split. On the top is a 
table which contains a list of all your schedules and a description of the schedule, as well as the Actions 

that will occur following report generation. To add a new schedule click on the  button on the top-
right corner of the Schedule tab. In doing so, you've created a new Schedule which can now configure.

Schedules are driven via Chron formatted strings, a popular scheduling format used in computing. If you 
aren't familiar with Chron, don't worry, we've created an intuitive UI that will allow you to set schedules 
easily without having to learn anything new. The Schedule UI provides some convenient pre-made 
Common Settings. If there isn't a setting for you in the Common Settings combo box, choose one that is 
close and then simply customize it using any of the selection boxes below. You can also enable or 
disable the schedule by checking the Enabled option.

Parameters

The Scheduler presents an additional opportunity to set parameter values. Alter default values to tailor 
scheduled reports without having to change the Report's design or configuration. For instance, imagine a 
report which summarizes how many Widgets a factory produced during a given shift. Rather than create 
a separate report for each shift, we can create multiple schedules (one for each shift) and simply alter a 
shift parameter. Using Parameters and Schedules, users can avoid creating multiple reports while 
keeping projects more maintainable.

Overriding Parameters in a 

Scheduled Report

The Parameter "Line" is being 
overridden by the value of the 
"Reporting/ActiveRun" tag.

Actions

Actions are triggered following the generation of a scheduled report. There can be any number of Actions associated with a Schedule, covering 
virtually any requirement for automatically storing, distributing or notifying upon completion of the report. Each action has its own custom configuration 
interface to make adding and editing Actions simple. Here is a brief summary of each Action:

Print File

Configure print settings which execute when the report is generated.

Email

Your report can be emailed to a list of emails, Rosters, or Roles of a roster.

FTP

Send your report to a file server for backups or storage.

Save File

An easy way to save a report to a location on your local gateway. 

Run Script



A Run Script Action provides the ability to fully customize how a finished report is handled. The Run script Action provides the report's data as well as 
the bytes generated according to the   option in the configuration panel.Format

 

 

In this section ...



Scheduling Basics
 

 

Schedules Table

 

Schedule Tab

 

Parameter Tab

 

Action Tab

 

 

Scheduling Basics

Watch the Video

 

 

 

Next...

Scheduling Actions - Save

 

https://www.inductiveuniversity.com/video/scheduling-basics/7.8


Scheduling Actions - Save
 

 

   

 

Scheduling Actions 
- Save

Watch the Video

 

 

FTP

Print File

Schedule a Print Job to a connected printer when report is generated.

Save

If a report is saved as HTML, it will output both <report>.html and an images folder containing a .png of the report. Both parts need to be present to 
view the report properly.

Next...

Scheduling Actions - Email
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Scheduling Actions - Email
 

Email Action
The Scheduled Email Action will distribute a Report via email when it is finished. Emails can be provided 
either by adding a list of email addresses in the Action interface, or by choosing from configured Rosters 
and User Roles. The sending address, email subject, email body and file name are all configurable. 
Subject, Filename and Body editors can utilize Expressions to dynamically add content or change 
names.  

 

Usage

Email Server settings must first be established in the Gateway by going to Configuration > Email 
. Once you have created and saved an SMTP profile you can test your email settings on the Settings

Email settings page.  

With an SMTP profile functional, simply fill out the fields of your Email Action for scheduled reports to be 
emailed on completion.  

 

 

 

Scheduling Actions 
- Email

Watch the Video

 

 

 

Next...

Other Reporting Module Components

 

https://www.inductiveuniversity.com/video/scheduling-actions-email/7.8


Other Reporting Module Components
 

The Reporting Components for Vision are fairly similar to the previous Reporting module but do have some notable differences.  The most obvious 
difference is that with Reports, now being Project-level resources, the   has been replaced with a  .  We've maintained Report Component Report Viewer
100% backward compatibility for those who already have Reports through the previous version.  If you have a report component on a project, don't 
worry, it will be there exactly as it was before upgrading!  

Vision Reporting Components

Report Viewer

The new   lets you visualize Reports in much the same way the old version did.  Similarly, it also allows you to configure bindings to Report Viewer
report parameters in a way similar to the old module's Report Component could have bound custom properties.  

Row Selector

The     is a component that acts like a visual filter for datasets. It takes one dataset, chops it up into various ranges based on its row selector
configuration, and lets the user choose the splices. Then it creates a virtual dataset that only contains the  s that match the selected splices.row

The most common way to splice the data is time. You could feed the     an input dataset that represents a large time range, and have it row selector
break it up by Month, Day, and then Shift, for example. Then you could power a report with the output dataset, and that would let the user dynamically 
create reports for any time range via an intuitive interface. 

To configure the    , first you set up the appropriate bindings for its input dataset. Then you use its Customizer to alter the levels that it uses row selector
to break up the data. In the customizer, you add various filters that act upon columns in the input dataset, sorting them by various criteria. For 
example, you could choose a date column, and have it break that up by quarter. Then below that, you could have it use a discrete filter on a product 
code. This would let the user choose quarterly results for each product. Each level of filter you create in the customizer becomes a level in the 
selection hierarchy. Note, that the output data is completely unchanged other than the fact that  s that don't match the current user selection aren't row
present.

Column Selector

The     component is conceptually similar to the Row  , except that instead of filtering rows, it filters  s from its output column selector Selector column
dataset. Each   from the input dataset is shown as a checkbox. As the user checks and un-checks  s, the output dataset has those column column column
s added or removed. This is very handy for driving the   and   components.Table Classic Chart

File Explorer

 

The     component displays a  system tree to the user. It can be rooted at any folder, even network folders. It can also filter the types of File Explorer file file
s that are displayed by their   extension (For example, "pdf"). The path to the   that the user selects in the tree is exposed in the bindable file file
property Selected Path.

This component is typically used in conjunction with the  , in order to create a PDF viewing window. This is very useful for viewing IA Labs PDF Viewer
things like maintenance manuals from within your project. To create a window like the one shown below follow these steps:

PDF Viewer

 

The PDF Viewer has been retooled for Ignition 7.8.  Built on the same architecture our popular IA-Labs PDF Viewer module, the new PDF Viewer is 
much more capable of viewing pdfs from a wider variety of sources, and includes improved controls.  

Component Reference

Reference documentation for Vision components is available in the   section of the User Manual  .Reporting Components Appendix

In this section...
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Row Selector Component
 

 

The Row Selector is a component that allows users to filter a DataSet based on unique values of one or 
more columns. Each level in the sorting tree is based on these properties.

 

The user will see a dynamically generated expandable tree that groups their data by any number of 
choices. As they click down the tree, objects bound to the DataSet will indicate the filtered data. Here are 
a few examples.

 

A line graph bound to a Row Selector. Set up grouping to be first by month and year, then day, 
then hour, like the top left illustration. Clicking on a month and year will dynamically update the 
graph for that time period. Further clicking to a specific day or hour will re-filter the graph for that 
period.
A Report Viewer bound to a Row Selector. Grouping by department (String) would allow 
selection by department, automatically regenerating the Report on selection.
An "alarm history" table bound to a Row Selector. This could first be broken down severity level 
(Integer), then broken into "Alarm Acknowledged" / "Not Acknowledged" (Boolean based). 
Clicking "Severity 3" would filter the table to all Severity 3 alarms. Selecting "Unacknowledged" 
would then filter the table to unacknowledged alarms of severity 3

 

 

 

Row Selector

Watch the Video

 

 

 

Next...

Column Selector Component
Row Selector

 

Additional information on the Row Selector can be found on the Row Selector page in the 
appendix.
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Column Selector Component
 

 

 

The Column Selector is a component that takes DataSets in, allows users to show or hide variables in 
the DataSets (Columns) via checkboxes, then outputs the resulting DataSet.

The Column Selector allows users to choose which columns in a DataSet that they wish to use. If an 
object is bound to the Column Selector it will update itself whenever a user checks or unchecks a 
column. This allows users to dynamically show/hide: Table columns, "pens" on a graph, data in a Report 
Viewer, or any other component set up to use a DataSet.

 

 

 

 

Column Selector

Watch the Video

 

 

 

Next...

File Explorer and PDF Viewer
Column Selector

 

Additional information on the Column Selector can be found on the Column Selector page in 
the appendix.
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1.  
2.  
3.  

File Explorer and PDF Viewer
 

The File Explorer component displays a filesystem tree to the user. It can be rooted at any folder, even 
network folders. It can also filter the types of files that are displayed by their file extension (For example, "
pdf"). The path to the file that the user selects in the tree is exposed in the bindable property Selected 
Path.

This component is typically used in conjuction with the PDF Viewer component, in order to create a PDF 
viewing window. This is very useful for viewing things like maintenance manuals from within your project. 
To create a window like the one shown below follow these steps:

 

Bind the PDF Viewer's Filename property to the File Explorer's Selected Path property
Set the File Explorer's File extension filter to "pdf"
Set the File Explorer's Root Directory to a network folder that has your maintenance manuals in 
it. (Use a network folder so that all clients will be able to access the manuals).

 

 

 

File Explorer and 
PDF Viewer

Watch the Video

 

 

 

Next...

Scripting in Reporting
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Scripting in Reporting
 

In this Section ...



Data Sources - Scripting
 

 

The Script data source allows you to add additional data into a report. Script data sources are able to 
reference data keys from other data sources. This allows you to modify keys from one data source, and 
return a new altered data source. 

 

Example

Say we have a query data source named "Area Data" which contains four columns: month, north_area, 
south_area, and t_stamp. If we need to build a new data source without the t_stamp column we can use 
the following code:

 

Script data source

        #build a header and initialize a pydataset
        header = ['month', 'north_area', 'south_area']
        filteredDataset = []
        
        #get the results from the Area Data data source
        rawDataset = data['Area Data'].getCoreResults()
        
        #build the new pydataset out of only some of the Area Data's data 
keys
        for row in range(rawDataset.rowCount):
                valCategory = rawDataset.getValueAt(row,'month')
                valNorthArea = rawDataset.getValueAt(row,'north_area')
                valSouthArea = rawDataset.getValueAt(row,'south_area')
                filteredDataset.append([valCategory,valNorthArea,
valSouthArea])
                
        #convert the pydataset to a standard dataset
        filteredDataset = system.dataset.toDataSet(header, filteredDataset)
        
        #create a new data source with the filtered results
        data['updated Area Data'] = filteredDataset

 

The above code would create a new data source in the Design panel named 'updated Area Data'. Note 
that .getCoreResults() is only applicable when the raw data source is a query. If 'Area Data' in the 
example above was a static CSV then you could get the data into a 'new data source' with the following:

 

 

 

Data Sources - 
Scripting

Watch the Video
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Static CSV example

data['new data source'] = data['Area Data']

 

What if our 'Area Data' query has a nested query called 'Area Details' that we would like to manipulate in 
a script?

Script data source for nested query

nested = data['Area Data'].getNestedQueryResults()    # Gets results from 
our parent query
subQuery = nested['Area Details']    #Gets the subquery we want -- there 
can be more than one
header = ['productName', 'cost', 'triple']
alteredDataset = []
for child in subQuery:
    children = child.getCoreResults()    # children is a dataset
    for row in range(children.rowCount):
        valProductName = children.getValueAt(row,'productName')
        valCost = children.getValueAt(row,'cost')
        valTimesThree =  None
        if valCost != None:
            valTimesThree = 3 * valCost
        alteredDataset.append([valProductName,valCost,valTimesThree])
            
            
#convert the pydataset to a standard dataset
alteredDataset = system.dataset.toDataSet(header, alteredDataset)
             
#create a new data source with the altered results
data['Updated Area Details'] = alteredDataset

 

Next...

Scheduling - Run Script

 



Scheduling - Run Script
 

 

The Run Script action is a scripting event that executes based on the schedule. This action does not 
inherently email, save, or otherwise distribute a report unless you do so in the script. However you can 
easily use  to send out the report. system.report.executeAndDistribute()

 

Example

The following would insert a copy of the report into a database table, and then save the report on the 
gateway's desktop as a PNG

Run Script example

#save a copy of the report
query = "INSERT INTO report_log (name, data) VALUES (?,?)"
system.db.runPrepUpdate(query, [reportName,reportBytes])
 
#distribute the report
system.report.executeAndDistribute(path='my report', project='my project',
action='save', actionSettings = {'path':'C:
\\Users\\User\\Desktop','fileName':'SavedReport.png','format':''png'})

 

 

 

 

 

Scheduling - Run 
Script

Watch the Video

 

 

 

Next...

Report Module Scripting Functions
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Report Module Scripting Functions
The Reporting Module 7.8+ provides convenient scripting functions in   that enable report generation from scripting.system.reporting

 

system.report.executeReport(path, project, 
 )[parameters], fileType

Will immediately execute a report on use and return a  [] array of the results.byte

See   in the appendix.executeReport()

 

system.report.executeAndDistribute(path, project, 
[parameters], action, [actionSettings])

Will generate a report and distribute it by the configured  .Report Schedule Actions

See   in the appendix.executeAndDistribute()

 

 

Scripting Functions

Watch the Video

 

 

 

Next...

Charts in Reporting - Scripting
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Charts in Reporting - Scripting
 

 

The most common configuration options for charts are found in the properties panel, but almost every 
part of a chart can be configured through scripting. To turn on configuration scripting in a chart, select the 
chart, scroll to the bottom of the Chart Options tab, enable scripting and click on Edit Script.

 

Example

Say we want to change the font used in a charts labels. We can use the following code:

 

Configure Chart

def configureChart(chart):
   # This configures the legend on a report chart to use a large, bold, 
monospaced font
   from java.awt import Font

   legend = chart.getLegend()   # http://www.jfree.org/jfreechart/api
/javadoc/org/jfree/chart/JFreeChart.html
   font = Font(Font.MONOSPACED, Font.BOLD, 48)   # https://docs.oracle.com
/javase/7/docs/api/java/awt/Font.html
   legend.setItemFont(font)   # http://www.jfree.org/jfreechart/api/javadoc
/org/jfree/chart/title/LegendTitle.html

 

The above code would change the font used in the chart's legend to a 48 point bold monospaced font. 
The comments give links to the APIs used in each line of the code.

 

 

 

 

Data Sources - 
Scripting

Watch the Video

 

 

 

Next...

Converting Legacy Reports
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Reporting Tutorials
This section contains some Tutorials that will help get you started in achieving some common tasks in the Reporting Module. 

 



1.  
2.  
3.  

Tutorial: The Report Workflow
 Steps to Amazing Reports

 There are 3 fundamental steps to creating a Report in Ignition 7.8:

Gather your Data
Design your Report
Schedule Delivery

Simple, right?  This workflow is really the gist of what it means to create a report in the Reporting Module.  Conveniently, the Report Workspace 
interface makes it simple to complete each step and view your result.  This tutorial will provide a walkthrough of creating a simple report, and reinforce 
some of the concepts and terminology involved.  If you are already familiar with the basics of how to create a Report, you may be interested in the Rep

.  If you are in the right spot, lets go ahead and get started.orting Technical References

 

Your First Report

To create your first report, you will need an Ignition 7.8 installation, as well as the Reporting Module.  We recommend following along with the core 
modules installed. If your installation is configured and Gateway running, launch the and right-click on the   node in the Ignition Designer Reports

Project Browser to create a new Report and open the Report Workspace.  

 

 With a new report open, you can take a look at the new Report Workspace.   The top of the workspace has a series of stylized tabs which guide you 
through the creation of a new report.  It's no coincidence that our Report Workspace is laid out in a way that lets you intuitively follow our 3 Steps with 
a little help along the way.  There isn't much to see on the of a new Report, so click over to the   tab to get started.Overview  Data

Set Up Data Sources

For any Report, you will first need to specify one or more Data Sources.  Click the + button to add a data source.  We'll start by adding a simple Static 
CSV source, but if you have a database connected with a table you'd like to use for the tutorial, feel free to add a SQL Query (a simple SELECT * 

 is all that is needed to pull in all the data a table contains).FROM <YOUR_TABLE_NAME>

https://legacy-docs.inductiveautomation.com/display/DOC/Report+Viewer
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You'll now have a Static CSV Data Source editor open.  Lets delete the example values and add our own.  We are going to model data collected from 
international Widget Factories, complete with production capacity, the number of Widgets produced, and the number of minutes it took to produce 
them.  Copy and paste this CSV data into your data source editor and give your data a meaningful name in the field.Data Key 

Facility, Capacity, Produced, Minutes
"California", 2000, 665,  345
"Texas", 3424, 1674, 924
"South Africa", 734, 232, 154
"Brazil", 1131, 882, 325
"China", 5324, 2764, 297
"Norway", 436, 143, 383
"Kenya", 1431, 423, 164
"Italy", 543, 524, 234
"Romania", 154, 78, 45
"Peru", 624, 523, 732

 

Now switch over to the Design tab, and take a look at your Key Browser panel on the left.  Expand the Data sources and you'll see that each column 
of data is represented by its own Data Key.  These Data Keys are automatically generated based on the table of data fed to the report system and are 

Accessing the data from a child key is accomplished using the path of a key in relation to its parent, sometimes referred to as  .  Achild-keys.   keychains
keychain is simply the path to your data key using 'dot notation'.   For instance, the keychain for our  key would be  .   Facility WidgetProduction.Facility

Now that you have some data, lets create simple design and see how our data keys can be used to create dynamic reports.

 



1.  
2.  
3.  
4.  

Design the Report

Designing a report is the act of deciding how you want the end result to look, and laying out the pages to accomplish your vision.  Each type of Design 
component has strengths and weaknesses in how it presents data.  You may want a line-item table to look at sales of each product, or a Pareto Chart 
to quickly identify high-impact targets for next year's mining investment.  To create comprehensive reports, you will likely find yourself combining 
different components.  Fortunately, this is pretty easy to do using the visual designer, so lets continue our first report and see how easy it is.

For our report, we'd like to have:

A Header
A Table that gives us a summary of how many Widgets each factory produced, and the totals for each data column.  
Factory efficiency on a units/minute basis, which we will need to calculate.  
 Page numbers will be helpful if our report gets too long, so we'll add those too.

The table will offer a lot of detail, but we know our Widget Management doesn't do well with numbers, so we'd also like to give them a chart that shows 
the production of each facility.   To really impress, we'll use the new Pareto chart so we can point out which factories are accounting for 80% of our 
production.

 

Add A Text Header for the Page

With an idea of what we want to accomplish, as well as the data to do it, we can start designing.  To start we'll give our report a header with a title.  We 

use Text shapes anywhere we need to add text to the page.  Activate the Text Shape  and click-drag near the top of the 
page to create a field for text.  Go ahead and give your report a title by typing into the field of the shape.  You'll notice the text field in the lower left 
corner of the Designer, along with some buttons that let you customize the look and layout of the text. This configuration area will change depending 
on the selected component on the report. In the same area, you'll notice there is a tab titled "Properties" behind the Text Area's custom editor.   This 
table provides access to a component's various properties.  Feel free to experiment with the settings in the editor or property table to customize your 
title.

 

Text Shape 

Configuration

In addition to a title, providing some meta-data about the report can provide context or 
make it more readable.  For instance, adding the date the report was generated is a very 
common task.  However, we don't want to type the date into the text field, because all 
reports we run (could be today, tomorrow or next year!) will show what we type.  Instead, 
we want the date to reflect the day the report was generated.  If you look at your key 
browser, you'll see a folder called "Built In".  This folder provides a number keys that are 
common in reports.  Go ahead and grab the "Date" key and drop it in the same text field as 
your title.

You'll notice that the key you dropped into the text field is surrounded by '@' 
symbols.  The @ symbols tell the report engine that text inside (in this case Date) is a key, 
and it should try and find value when the report is generated.   If you click over to the 
Preview tab, you should see today's date where   is.  In addition, you'll see that the @Date@
text is in the same place it was in the designer.  As our report gets more complex, we'll 
want to think about the layout of the items on the page to accomplish the look we want.

Adding text on a page shared with a repeating component (such as a table) will add the 
text to all pages created by the component.  In some cases, like page numbers, this is 
desirable.  In others, you may only want a single header for your table.  Tables themselves 
have headers, which we'll briefly talk about, but you can read about them in more depth in 
the Reporting Table documentation.

Adding a Table

The Power 
of Data Keys

You can 
have multiple 
keys in a text 
field.  In 
addition, you 
can use 
multiple keys 
and common 
numeric 
operators to 
do 
calculations w

 the @ ithin
symbols!  The
se are called 
Keychain 

. Expressions
 Expressions 
are not 
something 
this 
introductory 
tutorial will 
cover, but 
you can 
head over to 
the data key 
documentation
page for 
more 
information. 



Grab a Table component off the palette and add it to the page.  With the Table selected, look in the bottom left corner under the Key Browser, and you 
will see the configuration panel for the Table.  We want the Table to show us data about our Widgets Factories, so go ahead and grab the parent Data 
Key from the browser, and drag it to the Data Key field of the Table Config Panel.  You'll notice that the Data Key field updates, as does the Table 
itself.  Our WidgetProduction data key is now providing data for the table, so lets set up our table.

We want a header and summary, so check those boxes and lay out your table however you like.  To calculate the efficiency in terms of Units per 
Minute of runtime, we use the    Here is what we came up with, and the generated report.keychain expression @Produced/Minutes@.  

 

To finish the report, we just need to add a chart, we can just resize the table a little bit and add our chart right under the page header.  Drag the bar 
chart into the space above our table, size it and the table to suite.  Add the Data Key, for our data and take a look at the preview.  Instantly, you'll 
notice the bar chart adds a bar for each column in the data, where our goal is to only show the number of widgets produced.  

 

Edit Data Sources to Accommodate Requirements

If we were using Query data sources, we'd create an additional source use a nested source to get the two rows we want.  For this example, we'll go 
ahead and create an additional data source using another static CSV source that includes only the columns we are interested in.

FacilityProduced Data Source

Facility, Produced
"California",665
"Texas", 1674
"South Africa", 232
"Brazil", 882
"China", 2764
"Norway", 143
"Kenya", 423



"Italy", 524
"Romania", 78
"Peru", 523

 

Now when we generate our report with the new data, we get a chart with the items produced, and a table summary of the different locations.

Final Product

We configured our bar chart to use the new data source, and got a result that seems to meet our goals.  

 

Scheduling Reports

Last by not least, we finish by setting up our report to run on a schedule.    are easy to setup and allow you to define a number of Scheduled Reports
different Actions to occur on a schedule.  For our schedule, we simply want to create a PDF of the report and save it to a local folder at the end of the 
work week.  

 

Adding a Schedule

Adding a schedule is as easy as clicking on the   button of the Report Schedule panel in our workspace.  

 

With the schedule added, use the dropdown options to determine when it should run.  We set ours to run on the 5th weekday (Friday) at 23:59, or one 
minute before midnight.   Keep in mind, this report will execute on our Gateway, so the schedule will be according to Gateway Local Time.  We didn't 



use parameters in this report, so we can click over to the Actions tab to set up the actions for this Schedule.  Here we will click the   next to the 
empty Action list, and select Save File.  That presents us with Folder Path and FileName configuration space.  We change the path from default to 

something that works for our system.  Once happy with the settings, you can test run clicking the  . 

Congratulations!  You've completed your first report!

 



Sequential Function Charts
 

A Sequential Function Chart (SFC) uses a graphical programming language based on the IEC 61131-1 standard. This language may be familiar to 
PLC programmers, as it is one of the languages commonly available for programming PLCs.

SFCs are used to execute logic in ways that are more convenient to structure than with Python scripts or PLC programming alone. Because of their 
inherently visual depiction, they help to illuminate logic to users, and facilitate intuitive development and refinement. Charts can be monitored as they 
run visually, making troubleshooting easier than with scripting alone.

SFCs simplify complex task like running tasks in parallel, writing long-running or slow tasks, and structuring tasks that must wait for conditions before 
proceeding.

A single SFC in Ignition can be called multiple times resulting in the same logical engine, the SFC, influencing different tags. This allows the developer 
to recycle the logic to different parts of the project or to run similar systems with a single SFC without having to duplicate the SFC.

The Ignition Designer allows for managing the SFC as it runs. Simple HMI interfaces can be developed to manage the SFC. An SFC can be started 
with a simple button or it can be fully managed with the   component.SFC Monitor

An Example SFC

 

 

In this section ...

https://legacy-docs.inductiveautomation.com/display/DOC/SFC+Monitor


SFC Basics
 

Architecture

SFCs are designed through drag-and-drop manipulation in the Designer. The charts can be found under the Global folder in the Designer's Project 
Browser. Charts are not part of any specific project; they are shared by all projects.

SFCs are  in the Gateway. While any scope (Client, Designer, or Gateway) can start a new chart instance, the chart instance always executed 
executes in the Gateway.

SFC instances can be  in either the Client or the Designer. To monitor a running chart instance in the Designer, you can open that chart in monitored 
the SFC workspace and double-click on the running instance. To monitor a running chart in the Client, a Vision project must be designed that uses the 
SFC module's monitoring panel component.

SFC Execution in Gateway

Scripting Reference

For information about    .the scripting API methods available for sequential function charts, see Scripting Functions

 

 

In this section ...

 

https://legacy-docs.inductiveautomation.com/display/DOC/Scripting+Functions


Introduction to Sequential Function Charts
 

Each sequential function chart can be configured to use one of the following Execution Modes:

Callable
This chart can be started via scripting or another chart's enclosing step on-demand. Any 
number of instances of this chart can be simultaneously running.

RunAlways
This chart can be started by the Gateway upon startup. It can not be executed in any other way. 
It is probable that this chart be designed to never end, the idea being that there will always be 
exactly one instance of this chart running.
 
Disabled
This chart is not available for execution.

   

Introduction to 
Sequential 
Function Charts

Watch the Video

 

 

Next ...

Chart Elements

 

https://inductiveuniversity.com/video/introduction-to-sequential-function-charts/7.8


Chart Elements
 

     

Chart Elements

Watch the Video

 

 

 

Next...

Designing Charts

 

https://inductiveuniversity.com/video/chart-elements/7.8


Designing Charts
 

Proper Structure

Before a chart is executed, it must have a correct structure. When designing a chart, the Designer will 
constantly let you know whether or not your chart is valid or not. If your chart is not valid, you may 
choose to show the errors. The error shows up as red triangles in the corner of any element which has a 
problem. Hover your mouse over these elements to discover what is wrong with them.

Here are some rules about structure to keep in mind:

Everything must be fully connected (except for Notes).
Flow typically moves from top to bottom. All elements must be entered from the top and exit 
from the bottom (not the sides).
There can be any number of end steps. If flow reaches an end step, the chart is stopped. If 
there are no end steps, it means that your chart must loop back upon itself to satisfy the 
connected rule.
End steps are not allowed inside parallel sections.

   

Designing Charts

Watch the Video

 

 

Next ...

Chart Flow Steps and Transitions

 

https://inductiveuniversity.com/video/designing-charts/7.8


Chart Flow Steps and Transitions
     

Chart Flow Steps 
and Transitions

Watch the Video

 

 

Next ...

Chart Scope
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Chart Scope
 

Chart Scope Variables

There are a number of built-in variables maintained by the SFC engine that can be read through the chart
 scope.

SFC built-in 
Variables

Description

chart.instanceId The string UUID of the running chart instance

chart.startTime A  object that indicates when the java.util.Date chart instance started 
running.

chart.runningTime An integer representing the number of seconds the chart has been running for.

chart.parent The   scope of the enclosing   (if any). null if this   was not chart chart chart
executed as part of an enclosing step.

chart.running Returns true if the   is in the running statechart

chart.state An integer representing the state of the chart as the following: 
 

0 Aborted 

1 Aborting

 2 Cancelled

3 Canceling

4 Initial

5 Paused

6 Pausing

7 Resuming

8 Running

9 Starting

10 Stopped

11 Stopping

   

Chart Scope

Watch the Video

Scripting system.sfc.* Functions

See the following links for a description of each function:

 

Next ...

Chart Rules

 

Certain chart scoped variables may interfere with the internal functions of the chart. For 
example, creating a variable like chart.values will conflict with a pyDictionary's values() 
method and therefore the chart will show an error. Since SFC charts use Python Dictionaries 
to manage chart scoped variables the methods associated with Python Dictionary's act like 
reserved words.

https://inductiveuniversity.com/video/chart-scope/7.8


Chart Rules
 

 

 

 

 

 

 

  

Chart Rules

Watch the Video

 

 

 

Next...

 Chart Properties
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Chart Properties
     

Chart Properties

Watch the Video

 

 

Next ...

Chart Lifecycle

 

https://inductiveuniversity.com/video/chart-properties/7.8


Chart Lifecycle
 

The chart has three terminal states: stopped, aborted, and canceled, and each has a different meaning:

Stopped
This means the chart stopped normally by reaching an End Step.

Aborted
This means the chart stopped abnormally because of an error.
 
Canceled
This means that the chart was canceled by a user or a call to  .system.sfc.cancelChart()

The chart can have scripts configured to run during some transitions between states.

onStart
This script runs before the chart moves to the Running state.

onStop
This script runs in the Stopping state before the chart moves to Stopped state.
 
onAbort
This script runs in the Aborting state before the chart moves to Aborted state. If this script 
creates an error, it is logged, and then the chart moves to Aborted state.
 
onCancel
 This script runs in the Canceling state before the chart moves to Canceled state.

The figure shows the states a chart can be in, and how it flows from one state to 
another

   

Chart Lifecycle

Watch the Video

 

 

 Next ...

SFC Elements
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SFC Elements
   

The Chart

The chart itself is a grid of cells upon which elements are placed. The chart has some configuration that can determine how and when the chart is 
started up, as well as opportunities to respond to chart lifecycle events with scripting, such as onStart, onStop, onCancel, and onAbort, see Chart 
Lifecycle for details.

Steps

Steps are the parts of the chart that do useful work. Steps are represented as a rectangle that occupies a one-cell region of the chart, except for the 
begin and end steps, which are triangles. Steps might run scripts, or execute other charts.

There are four types of steps: 

Begin Step
End Step
Action Step
Enclosing Step

SFC Chart Elements

 

   

In this section ...  

https://legacy-docs.inductiveautomation.com/display/DOC/SFC+Basics#SFCBasics-ChartLifecycle
https://legacy-docs.inductiveautomation.com/display/DOC/SFC+Basics#SFCBasics-ChartLifecycle


Begin Step
 

The  is where all charts start, and cannot be removed, cut, or copied. The begin step is where Begin Step
you can define initial values for your chart's scope. These initial values are also hints as to what 
parameters your chart expects. If the chart receives any of these parameters as starting parameters, the 
initial values are ignored.

One of the chart parameters defined on the begin step can be marked as the  . This means Key Param
that this parameter is used as an identifier for the chart. For example, suppose your chart defined the 
automation process for a car through an assembly line. You can define the car's VIN as the key param, 
which means that instances of this chart are identified by the VIN they were started with.

   

Begin Step

Watch the Video

 

 

Next ...

End Step
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End Step
 

The  of a chart has no configuration. This is used to mark the termination of the chart. There End Step
can be many end steps in a chart, although only one is ever reached for a given chart instance. End 
steps are not allowed inside parallel sections.

   

End Step

Watch the Video

 

 

Next ...

Action Step
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Action Step
 

The action step can have any number of scripts associated with it. Each of these scripts is called an 
action. There are various kinds of actions. The different kinds of actions execute at different times in the 
step’s lifecycle. During the lifecycle of the step, many actions can run, but only one action is ever allowed 
to run at a time.

The scripts configured in the action step have access to the chart's scope, as well as a special scope that 
is private to the step. This scope, called "step scope" is initialized when the step starts and destroyed 
when the step stops, but retained while the step is running. This is a good place for timer actions to store 
intermediate results.

On Start

This action runs when the step is started. These actions always run to completion before flow can move 
beyond the step, and before any other scripts on the action step will run.

On Stop

When flow is ready to move beyond the step, it is told to stop. The step will then wait for any currently 
executing action, for example,   or   actions, to finish. Then it will execute its   actionOn Start Timer On Stop
, if configured. Only after these actions complete will the chart be allowed to move on.

Timer

Timer actions run every so often while the action step is running. The timer actions only start running 
after the On Start action finishes (if there is one). In addition to the timer action's script, it must have a 
rate, specified in milliseconds. This is the amount of time to wait between running the timer action's 
script. The clock starts after the   action finishes.On Start

 It is important to realize that, unlike   and   scripts, a timer action can not run at all for an On Start On Stop
action step. If the step is ready to stop before the timer is ready, it will never run.

Error Handler

This action will run only if any of the other actions throw an unexpected error. This provides a chance for 
chart designers to do their own error handling, and gracefully recover from an error. If this script throws 
an error, the chart will abort, see Chart Concepts for more information.

Design Tips

When designing SFCs, the Action step will be the primary workhorse of your charts. There are a few tips 
to keep in mind while writing your scripts for the action step:

Tip 1: Don't Block/Pause/Wait/Sleep
This is the primary rule for SFCs. You want your scripts to run as quickly as possible. This means that 
you don't want to use any sort of sleep() or wait() call. Pausing or waiting is the job of transactions in an 
SFC.

Some sorts of blocking is, of course, unavoidable. For example, running a SQL query that takes some 
time to execute, or writing to a device over a slow radio connection. These sorts of activities are fine, 
however, this brings us to tip 2.

Tip 2: Refractor Loops
This is really just an extension of the don't block rule. Imagine that you have 100 widgets that need 
processing. Each widget takes some non-trivial amount of time, let's say, 20seconds, to process. The 
most obvious way to handle this would be with an   script that had a  loop from 1 to 100, On Start  while
processing each widget. This script would take about 33 minutes to run.
 

   

Action Step

Watch the Video

Instead of processing the 100 items in a  loop, you can solve this problem in two different ways while 
with SFCs:

Option 1: Timer Action
In this option, you have a single action step, but instead of having your loop from 1 to 100 in a wh

 loop, you initialize a counter to 1 in the On Start action. Then you write a timer action with a ile
rate of 0ms. The timer action processes one widget, and then increments the counter. You 
place a transition beneath the step whose expression is: {counter} >= 100

 
Option 2: Chart Loop
Similar to option 1, you can design the loop in the chart itself. Have one action step do your 
initialization work, in our example: chart.counter = 0

https://legacy-docs.inductiveautomation.com/display/DOC/SFC+Module#SFCModule-ChartConcepts
https://support.inductiveautomation.com/usermanuals/ignition/chart_concepts.htm
https://inductiveuniversity.com/video/action-step/7.8


Have another step do the processing work for one item in its On Start script. Use two 
transitions, the one on the left set to  and the one on the  set to  {counter} < 100 right  true
. The loop action will run 100 times, and then the flow will continue down the other path.
 

Rationale

By now you should understand that you want to keep your individual script duration to a minimum. You 
may be wondering why this is so important. After all, in the example above, it still takes 33 minutes to 
complete the given work after refactoring the loop as shown.

The reason this is important is to support pausing, persistence, and redundancy. Charts can only be 
paused after any running script finishes. Similarly, a chart's state only gets synchronized with the 
redundancy system between script executions. If you had a script that took half an hour to run, you 
couldn't pause that chart until the script ended, and the redundancy system would be very out of date 
and not able to recover as well if the Gateway went offline.

As a bonus, breaking your work up into smaller units helps make the chart easier to debug and more 
visible for monitoring.

Option 2 Illustrated

 

 

Next ...

Transition

 



Transition
 

Transitions control the flow of the chart. A transition serves to either block or allow flow, depending on its 
value. All transitions have a value: true or false, which is determined by an expression. Transitions 
occupy a one-cell region of the chart, and are represented by a short horizontal bar in the middle of the 
cell. Read more about how transitions control chart flow in the Chart Flow Steps and Transitions section.

In addition to their expression, a transition can also specify a timeout. If enabled, the transition will set a 
flag after a certain amount of time has passed. This flag is a boolean variable set in chart scope, and 
can be used to make the expression or another expression close.

Links

A link is simply a line that connects other elements. Links are created in the Designer by dragging the 
arrows that appear next to unconnected elements. Links cannot cross above or below other elements or 
links. Links only travel in a single direction. This direction is determined by what the link is connecting to. 
Most elements such as steps and transitions only accept incoming links from above and outgoing links 
from below.

   

Transition

Watch the Video

 

 

Next ...

Enclosing Step
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Enclosing Step
 

The  references another SFC defined on the same Gateway. This is an important tool for Enclosing Step
SFC design, because it lets the chart designer create reusable blocks of logic encapsulated into charts, 
which can make chart design more modular.

When talking about enclosing steps, the chart that the enclosing step references is called 
its enclosed chart, or  . The chart that the enclosing step is in is called the  .subchart parent chart

When flow reaches an enclosing step, it starts its enclosed chart. Using the enclosing step's Execution 
Mode property, the step can be configured to work in one of two very different ways:

Execution Mode = Block
Let the enclosed chart run to completion. This means that the enclosed chart should have an   inEnd Step
it, and that flow will not be able to move beyond the enclosing step until the enclosed chart stops by 
reaching its end step.

 Execution Mode = Cancel
Cancel the subchart when the enclosing step is ready to stop. This means that the subchart is canceled 
when flow is ready to move beyond the enclosing step. Any running steps in the enclosed chart are told 
to stop, and flow ceases in the enclosed chart.

Parameter Passing

When invoking a subchart via an enclosing step, you have the opportunity to define how variables are 
passed and returned between the parent and child chart’s scopes.

The enclosing step can define a list of parameters to be passed into the enclosed chart’s scope. The 
values for the parameters will be expressions, thus they can be literal values or they can be references to 
variables in the enclosing chart’s scope.

The enclosing step can also define a list of   to receive from the enclosed chart. This is a return values
mapping of variable names from the enclosed chart’s scope to variable names in the parent chart’s 
scope.

   

Enclosing Step

Watch the Video
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Parallel Section
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Parallel Section
 

A parallel section is a rectangular section of the chart that can contain other chart elements inside it. The 
top and bottom of the parallel section is demarcated by two thick, parallel lines. The top lines are called 
the "parallel branch" and the bottom are the "parallel sync". These sections are used to execute multiple 
branches of the chart at the same time.

   

Parallel Section

Watch the Video
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Jump and Anchor
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Jump and Anchor
 

A jump is an element that moves the flow to its matching anchor. This is a convenience for when a link 
would be unsightly or impossible due to crossing other links. Each jump and anchor element is identified 

by a single character; jumps identified by X will jump to the anchor also identified by X. There can be 
many jumps on a chart that all jump to the same anchor.

   

Jump and Anchor

Watch the Video
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Note
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Note
 

Notes are elements which have no import or function, but serve as documentation. Note elements can be 
placed anywhere except that they can not overlap other elements.

   

Note

Watch the Video
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SFCs in Action
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SFCs in Action
Chart Flow

All charts start at their begin step. The begin step can define initial values for variables in the chart's scope. These initial values are defined as 
expressions.

Flow always moves downward out of chart elements, except for links, which can move flow in any direction.

When flow hits a step, that step is started. The step continues to execute until the transition beneath it becomes true. If there is no transition beneath a 
step, the step starts and is told to stop as soon as possible. In practice, this means that an action step's onStart and onStop scripts will be run, but no 
timer scripts.

Examples

Example 1

In this example, step S1 executes as soon as the chart starts, and continues executing until the transition 
beneath it becomes true. Once that transition becomes true, Step S1 is told to stop, which means it 
finishs executing any scripts that are currently running, and then it executes its onStop action (if any).

After S1 has stopped, step S2 starts. It is immediately told to stop, which means that if it has any timer 
actions, they will not run, but the start and stop actions will run.

After S2 is finished, the chart stops.

Example 2

In this example, step S1 executes as above, except that it has two transitions beneath it. This is how you 
do conditional logic in a chart. S1 runs until either of these transitions becomes true. When one transition 
becomes true, flow will follow that branch of of the chart. If both transitions are true, the transition on the 
left is chosen. Position is meaningful for charts - transition precedence goes from left to right.

Only one of S2 or S3 will run, but never both.

Example 3

In this example, S1 executes as above, but can execute multiple times. This is how you configure 
repeating logic in a chart. The two transitions determine whether this chart continues running (possibly 
indefinitely) or stops.



Example 4

In this example, steps S1 and S2 execute simultaneously. They both continue to run until the transitions 
beneath them become true.

Flow only moves past the parallel sync (the bottom of the parallel section) once both transitions become 
true. Step S3 then runs, and then the chart stops.

   

   

In this section ...



1.  

2.  

3.  

4.  

Starting a Chart
 

A chart can be started in one of four ways:

From Scripting
Using the   method of the scripting API, a chart can be started from system.sfc.startChart
anywhere. The chart must be in  execution mode.Callable 

From an Enclosing Step
  .A chart can spawn an instance of another chart using an Enclosing Step

 
Automatically
A chart whose execution mode is   is automatically started when the Gateway starts RunAlways
up. If the chart stops, the Gateway does not re-execute it. If you want a chart that runs all the 
time, it should be designed to never stop, for example, by looping back upon itself continuously.
 
From the Designer
While designing a chart, you can start instances of it  from the   panel in the Chart Control
Designer using the  link.Start 

   

Starting a Chart

Watch the Video
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Monitoring Charts
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Monitoring Charts
 

While a chart is running, it can be monitored visually in the Designer or via a Vision Client.

In the Designer

Open the chart you wish to monitor, and any running instances of that chart will appear in the list to the 
right of the design space with the heading  .Chart Control

Double-click on an instance to enter monitoring mode. While in monitoring mode, you'll view the current 
state of the chart elements. There is a banner at the top of the Designer which will bring you back to 
design mode.

In a Vision Client

The SFC module adds a component to the Vision module under the   category called the Admin SFC 
. Add this component to a window to be able to monitor SFC instances from your project.Monitor

This component can either display a pick-list on its left side to pick which instance to monitor, or you can 
give it the ID of a specific chart to monitor and hide the pick list.

Element Legend

   

Monitoring Charts

Watch the Video
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Pause, Resume, and Cancel
 

     

Pause, Resume, 
and Cancel

Watch the Video
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Interacting with a Client

 

https://inductiveuniversity.com/video/pause-resume-and-cancel/7.8


Interacting with a Client
 

     

Interacting with a 
Client

Watch the Video

 

 

Notes ...

Action Step Best Practices

 

https://inductiveuniversity.com/video/interacting-with-a-client/7.8


Action Step Best Practices
 

     

Action Step Best 
Practices

Watch the Video
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Enterprise Administration
 

The Enterprise Administration Module allows you to create a single Controller that creates and manages Agents throughout your network.

 

 

In this section ...



Enterprise Administration Basics
 

Learn how to set up Controllers and Agents

 

 

In this section ...



Introduction to Enterprise Administration Module
Overview

The Enterprise Administration Module (hereafter abbreviated to EAM) allows a user to control and 
monitor any number of Ignition Gateways from a central Gateway. In EAM terminology, the central 
Gateway is called a controller, and the monitored Gateways are called agents. The EAM takes 
advantage of the Gateway Network system to seamlessly deliver data between Gateways.

Task Management

EAM allows you to schedule common Gateway tasks to execute against remote agent Gateways. Tasks 
include agent Gateway restart, backup collection, system restoration, module installation, license key 
activation/unactivation, and project distribution. Tasks can be scheduled to run once at a later time, or as 
part of a recurring schedule.

Agent Events

Every EAM agent sends information to the controller about its general health status. Whenever problems 
occur on an agent, the controller is notified of the agent’s status in the form of agent events. Problems 
can include high CPU usage on the agent, large numbers of system errors in a short timeframe, and 
unusually high usage of database connections. Loss of connectivity to the agent also triggers an agent 
event on the controller. Agent events are recorded in an external database for analysis and reporting 
later. Agent events can also be directly configured in the controller to automatically issue alarms to a 
specified alarm pipeline.

Introduction to 
Enterprise 
Administration 
Module

Watch the Video

 

 

 

Archival and System Recovery

The Collect Backup gateway task does more than simply collect a gateway backup from agents. Whenever the task runs, the gateway backup, all 
installed modules and the current license are collected from the agent and stored in the archive system on the controller. This system allows for quick 
recovery later if an agent machine catastrophically fails and must be reinstalled.

 

Next...

Gateway Area Network Settings
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Gateway Area Network Settings
Overview

The Gateway Network allows you to connect multiple Gateways together over a wide area network. The 
Gateway Network provides the following features:

Websockets provide fast, firewall-friendly 2-way communication over a single configured 
connection.
A dedicated http data channel that can handle multiple streams of message data.
The ability to set up a node to act as a proxy for another node.
Security settings that restrict incoming connections based on a white list or on manual approval 
of the connection. Incoming connections can also be disabled entirely.
SSL mode available. When enabled, connections must send SSL certificates to prove their 
identity. A connection will not be accepted until its SSL certificate is approved.

Currently, the   (EAM) takes advantage of the Gateway Network. The Enterprise Administration Module
EAM uses the Gateway Network for message and file transfer, and can monitor network connections for 
availability. The EAM reports whenever a comm link is lost via alarm events and system tags. Many other 
features are planned to use the Gateway Network in the near future.

Gateway Area 
Network Settings

Watch the Video

General Settings

Main

The Gateway Area Network General Settings set the basic rules for the system. By default, these settings are lenient to allow for easy setup but can 
be set for security.

Enabled: uncheck this checkbox to disable using the Gateway Area Network on this Ignition.

Web Sockets Enabled: If true, the system will attempt to use websockets in order to increase performance.

Require SSL: If true, only connections that use SSL to encrypt traffic will be allowed.

Require Two Way Auth: Controls whether both sides must explicitly trust each other before successful handshake. If you check this setting, you will 
need to provide the remote machine's certificate. To do this, manually export a certificate from the remote machine's Metro KeyStore, located in 
<installdir>/webserver/metro-keystore. Default KeyStore password is , and the alias is . Then place the certificate on the local metro metro-key
machine, in data/certificates/gateway_network

Overload Control

If there is too much traffic on the GAN, then it can tell Agents to stop sending messages for a specified amount of time.

Receive Queue Max: Number of received messages that can be held until they are processed by the local system. When this capacity is exceeded, 
the local system will start sending WAIT messages to remote machines.

Overload Wait Seconds: The number of seconds that a remote machine is instructed to wait before resuming message delivery. This setting is used 
when an overload is detected on the local machine.

Security

By default, the security level for incoming connections is set to “Unrestricted”, meaning that every remote machine that attempts to connect to the local 
machine will be accepted without question. You have several options to control security from the Gateway Network settings. Note that these settings 
are independent of SSL mode, which is detailed below. To change security settings, navigate to Configure -> Configuration -> Gateway Network and 
select the General Settings tab.

Allow Incoming Connections: uncheck this checkbox to disable all remote machines from being able to establish an incoming connection. To 
establish any connections with remote machines, you will need to create outgoing connections from this machine.

Connection Policy:

Unrestricted: default mode, allows all incoming connection unless the Allow Incoming Connections checkbox is unchecked
ApprovedOnly: incoming connections are created, but cannot be used to send or receive data until you approve the connection under 
Gateway Network -> Incoming Connections tab. To approve an incoming connection, click the Approve link on the right side of the 
connection. You can also deny a previously approved connection by clicking the deny link. Note that the approve and deny links will appear 
next to a connection only if you have enabled the ApproveOnly setting.
SpecifiedList: an incoming connection will only be allowed if its server name is on this list. Separate server names with a comma.

: Specified List Connections with an ID in this list are automatically allowed if the security mode is set to SpecifiedList. Separate Gateway names with 
a comma.
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Outgoing vs. Incoming Connections

When using the Gateway Network, you will be working with two type of connections. To establish communications, you create an outgoing connection 
on the local machine. The outgoing connection always begins the connection process to a remote machine. After the outgoing connection is created, 
the local machine will attempt to use the connection to establish communications with the remote machine. On the remote machine, 
an incoming connection will automatically be created when the new connection attempt is detected. For connections where security settings require 
manual approval, you will need to approve the incoming connection before it can be used. If no security controls have been set, the incoming 
connection will automatically accept the connection from the local machine and begin sharing data.

Connections and Servers

Every machine on the Gateway Network is known as a Server. When you establish a connection to a remote machine, the remote Server sends data 
about itself and also sends data about any other Servers known to that machine. For example, assume your local machine is Server A. The remote 
machine is known as Server B. Server B also knows about another remote machine named Server C. As soon as your local Server A establishes a 
connection with Server B, Server B also sends information about the existence of Server C. Modules such as the EAM are aware of this relationship 
and allow communication between Server A and Server C, even though there is no direct connection from the local machine to Server C.

Basic Setup 

To establish a basic comm link between two Gateways, log into the Gateway where you want to establish the outgoing connection. Navigate to 
Configure -> Configuration -> Gateway Network and click on the Outgoing Connections tab. Click the “Create new” link.

On the New Outgoing Connection page, you will need to enter the network address and port of the remote machine. Click the Create New Connection 
button at the bottom of the page.

On the Outgoing Connections tab, your new connection will be shown. After a few moments, the Gateway Name field will be updated with the name of 
the remote server and the status will be set to “Running”.

To view the incoming connection, log into the other Gateway and navigate to Configure -> Configuration -> Gateway Network and click on the 
Incoming Connections tab. Your new connection will be shown with “Connected” status.

Deleting Connections

Outgoing and incoming connections can be deleted for cases when the connection no longer exists on the other side. To delete a connection, 
navigate to Configure -> Configuration -> Gateway Network and click on either the Outgoing Connections tab or the Incoming Connection tab. Then 
click the delete link next to the connection. Note that for incoming connections, if a remote machine is still connected to the local machine with an 
outgoing connection, a new incoming connection will be created after deletion. For these cases, you must log into the remote Gateway and delete the 
outgoing connection. Then you can delete the local incoming connection.

Certificates

SSL and Certificates

When a remote machine establishes an incoming connection, its Gateway server name is transmitted and appears in the Server Name field under 
Gateway Network -> Incoming Connections. However, there no identity authentication is performed when the connection is created. The local system 
accepts the remote system id without question. To perform identity authentication on a connection, you must use Secure Socket Layer (SSL) and 
certificates.

To enable SSL on the Gateway Network, you must enable SSL in two places. On the machine that will receive incoming connections (which 
we will call Server A), you must navigate to Configure -> Configuration -> Gateway Network, click on the General Settings tab, and check the 
Require SSL checkbox. This mode requires all incoming connections to use SSL mode. Any existing incoming connections will become 
faulted as they are not using SSL. Click the Save Changes button.



 Next, log into a Gateway where you wish to establish an outgoing connection. We will call this Server B. Navigate to Configure -> 
Configuration -> Gateway Network and click on the Outgoing Connections tab and click the “Create new” link. As you are entering the 
settings for the new connection, check the Use SSL checkbox. Also, change the Port to the SSL port used by the other machine. By default 
this is set to 8060 (which is defined /data/gateway.xml). Save the new connection.
 

At this point, Server B has transmitted its certificate to Server A. But Server A has never seen this certificate, and so the incoming connection 
is not yet allowed. Note that the Server B’s connection will NOT show up under the Incoming Connections tab until AFTER the certificate has 
been approved. But if you click on the Certificates tab, Server B’s certificate should be present. 

Note that this port is different from the default SSL port an Ignition Gateway would use when communicating to a client (default 
port 8043).



The certificate Common Name field holds the network address of the machine that transmitted the certificate. The Serial field holds a numeric string 
that is automatically generated when the certificate is created, and is unique to every certificate. Click the approve link to approve the certificate. After 
certificate approval, the incoming connection will be accepted, and will eventually appear on the Incoming Connections tab. It make take up to 30 
seconds for the connection to appear, as reconnect attempts are made every 30 seconds by default (controllable by the Missed Pings outgoing 
connection setting).

After a certificate has been approved, and the incoming connection is established, you can view the certificate information for a specific incoming 
connection under the Certificate field in the Incoming Connections tab. The certificate common name and serial number are displayed here, and 
reflect the actual certificate that was sent by the remote machine.

You can deny a certificate under the Certificates tab by clicking the deny link to the right of the certificate. The connection that has been using that 
certificate will not longer be allowed to connect. You can delete certificates that are no longer in use. Keep in mind that if you delete a certificate, and a 
remote machine is still using that certificate, it will reappear on the Certificates page. In this case, you must navigate to the remote Gateway and 
delete its outgoing connection. Then you can permanently delete the certificate from the Certificates page.

Gateway Area Network Technical Information

Web Sockets

The web socket protocol rides on top of the TCP protocol, and allows 2-way communications between machines. Either side can send a message to 
the other side at any time. If web sockets cannot be used on your network, or your network setup does not require a high-speed low-latency 
connection, the Gateway Network connections can use a pure HTTP long polling system for communications. This mode uses standard HTTP GET 
and POST messages for communication, and is appropriate for situations when an always-on connection is not practical. An example would be a 
Gateway that communicates once every 15 minutes over a cell connection. Message retrieval is not as efficient as web sockets, as regular polling of 
the remote machine is required to learn of new messages. To enable HTTP long polling, you must either disable web sockets under either Gateway 
Network General Settings (to disable for all connections) or disable web sockets on an outgoing connection.

Next...

Agent Event Threshold Settings
Creating a Controller
Adding an Agent



Agent Event Threshold Settings
Overview

One of the main functions of the controller is to keep track of connected agents and report when an agent 
starts to experience performance problems, logs many errors in a short time, or unexpectedly goes 
offline. Agent events are held in the controller's configured database in the   table. Within agent_events
this table, you can find three types of event categories:  ,  , and  . The agent event agent metric task
category is used for major connectivity events, such as loss of connectivity from an agent. The metric 
event category is used for events that report abnormal agent health statistics, such as abnormally high 
CPU usage. The task event category does not affect metrics, and is detailed in the Gateway Task 
Results section. 

General Settings

Alarm Evaluation

This section is for activity and metric events, you can configure alarms to trigger when an event is 
reported at the warning or error level. You can also set the alarm pipeline that will process the generated 
alarms.

Enable Activity Alarms: If true, alarms will be generated for agent activity events, such as when an 
agent stops responding.

: Enable Metrics Alarms If true, alarms will be generated for agent metric events.

: The priority assigned to all of the   thresholds. Options are: Diagnostic, Low, Warning Priority warning
Medium, High, Critical.

:  Diagnostic, Low, Medium, Error Priority The priority assigned to all of the   thresholds. Options are: error
High, Critical.

Active Pipeline: The Pipeline assigned to all of the warning thresholds. Note that this Pipeline must be 
created before the alarm event happens, and that the name is case-sensitive.

Ack Pipeline: The Pipeline assigned to all of the error thresholds. Note that this Pipeline must be 
created before the alarm event happens, and that the name is case-sensitive.

Agent Event 
Threshold Settings
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Activity Monitor

The Activity Monitor configures how agent inactivity is reported. When contact is lost with an agent, an inactivity warning or error event is fired if the 
configured time in minutes has elapsed since last contact.

: The nInactivity Warning (Minutes) umber of minutes before a  threshold alarm is activated. (default 5)warning

: Inactivity Error (Minutes) The number of minutes before an  threshold alarm is activated. error (default 15)

System Metric Tresholds

In addition to inactivity alarms, alarms can be set on all agents when certain metrics like CPU usage, number of clients, error rates, and more are 
reached. Each one has both a  and an  level.warning error

: The  level of an Agent's CPU usage. CPU Usage Warning (%) warning (default 70)

CPU Usage Error (%): The error level of an Agent's CPU usage. (default 90)

 Usage Warning (%)Memory : The warning level of an Agent's memory (RAM) usage. (default 70)

 Usage Error (%)Memory : The error level of an Agent's memory (RAM) usage. (default 90)

WarningErrors Per Minute : The warning level of an Agent's error rate (minute). The contents of the Agent's errors can be checked in the Agent's 
console. (default 2)

ErrorErrors Per Minute  : The error level of an Agent's error rate . errors can be checked in the Agent's console. (minute) The contents of the Agent's   (
default 5)
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WarningErrors Per Hour  : The warning level of an Agent's hourly error rate. The contents of the Agent's errors can be checked in the Agent's 
console. (default 20)

Errors Per Hour Error: The error level of an Agent's hourly error rate. The contents of the Agent's errors can be checked in the Agent's console. (defa
ult 60)

WarningConnected Clients : The number of clients connected to that Agent required to raise a warning alarm. (default 50)

ErrorConnected Clients  : The number of clients connected to that Agent required to raise an error alarm. (default 100)

Warning Queries Per Sec : The number of SQL queries per second from that Agent required to raise a warning alarm. (default 5)

 ErrorQueries Per Sec : The number of SQL queries per second from that Agent required to raise an error alarm. (default 10)

Query Duration Warning (MS): The average duration of a SQL query on an Agent (in milliseconds) to raise a warning alarm. (default 10000ms or 10 
seconds)

Query Duration Error (MS): The average duration of a SQL query on an Agent (in milliseconds) to raise an error alarm. (default 30000ms or 30 
seconds)

DB Connections Warning: The number of currently active database connections on an Agent to raise a warning alarm. (default 8)

DB Connections Error: The number of currently active database connections on an Agent to raise an error alarm. (default 12)

Active Queries Warning: The number of currently active SQL queries on an Agent to raise a warning alarm. (default 60)

Active Queries Error: The number of currently active SQL queries on an Agent to raise an error alarm. (default 100)

 

Next...
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EAM in the Designer
Agent System Tags

System tags are created on the controller for each agent, allowing you to build EAM monitoring clients, 
set alarms on individual tags, and many other tag-related operations. To view EAM tags, launch a 
Designer on the controller Gateway. In the tag browser, navigate to System -> Gateway -> EAM -> 
Agents. A tag folder is created for each agent. As with other system tag values, all EAM system tag 
values are read-only.

Property Binding Functions

The EAM adds its own binding functions to the standard property binding functions, allowing you to 
quickly add agent information to a component such as a table. The following binding functions are 
available:

Agent Status: reports some basic information about each agent, such as platform version, connection 
status, and the last time a message was received from the agent.

Agent History: reports agent events from the the   table in the controller’s configured agent_events
database. Agent events include gateway task results, abnormal health statistics, and agent 
communication status events.

Scripting Functions

There are several scripting functions that are included in the system.eam package:

getGroups(): returns a String list of all agent groups configured in the controller
queryAgentHistory(): returns a Dataset of agent events from the controller's configured 
database
queryAgentStatus(): returns a Dataset with some basic information about each agent, such as 
platform version, connection status, and the last time a message was received from the agent

EAM in the 
Designer
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 More details and examples can be found in the  section of the .system.eam Appendix
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Configuring Controllers and Agents
 

Learn how to set up Controllers and Agents

 

In this section ...

Tips for Configuring Controllers and Agents

If you have any existing installations of Ignition running, it's a good idea to perform a backup before you begin this process.
If you have 2 or more Gateway Webpages open in your browser, you may want to have the Controller and Agents on separate 
monitors so you don't get confused which one you are working on.
It's always a good idea to verify that all your modules are loaded correctly. Go to Configure > Modules to check which modules 
you have installed.

 



Creating a Controller
Controller Setup

To set up the EAM, you must first designate one machine as the controller. Keep track of the IP address 
of this machine, as you must enter this address on each agent during agent installation.

Install the EAM module in the Gateway if it has not already been installed. After module installation, you 
must designate a database connection that will be used by the controller to store agent event history. 
Navigate to Configure -> Databases -> Connections, and set up a connection to the database that you 
intend to use. After the database connection has been set up, navigate to Configure -> Enterprise 
Administration -> Setup. You will now enter the EAM Setup Wizard.

Step 1: Select Controller or Agent

Since you are installing the controller, select “Controller” on this screen. Click the Next button.

Step 2: Controller Setup

Default Database- for the default database, you must select the database connection that you created 
before entering the EAM Setup Wizard. If you forgot to create the database connection, you can do so 
now and return to the EAM Setup Wizard later.

Archive Path- this is a file path on the Gateway’s local machine where all archived files will be stored. 
You can use a locally mounted network share for archiving. Use a value such as “E:\eam-archive”. It is 
strongly recommended that you put a system into place to externally monitor the free size of the disk that 
contains the archive. Gateway backups can potentially be many megabytes in size, and can eat up large 
volumes of space when using many agents.

After you have determined your settings, click the Finish button to save the controller settings and exit 
the wizard. This machine is now ready to accept agents.

Creating a 
Controller
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Next...

Adding an Agent
Agent Event Threshold Settings
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Adding an Agent
Agent Setup

To communicate with the controller, agents send data across a Gateway Network connection. If your 
Gateway Network setup requires that connections be manually approved in advance on the controller 
Gateway, you will need to set up the Gateway Network connection before starting the EAM Setup 
Wizard. You will be able to select the existing Gateway Network connection within the wizard.  Navigate 
to Configure -> Enterprise Administration -> Setup to begin the EAM Setup Wizard. 

Step 1: Select Controller or Agent

Since you are installing an agent, select “Agent” on this screen. Click the Next button.

Step 2: Agent Installation Mode

Select New Agent or Agent Recovery. Select “New Agent” if you are setting up a machine that is 
unknown to the controller. Select “Agent Recovery” if you are reinstalling an existing agent (possibly on a 
different machine), and the machine has been known to the controller in the past. This option also gives 
an opportunity to perform a system recovery (restore Gateway backup, reinstall missing modules and 
license) if possible. After you have made your selection, click the Next button.

Adding an Agent

Watch the Video

 

 

 

Step 3: Gateway Network Setup

As mentioned previously, a Gateway Network connection is required to communicate with a controller. On this page, you can either enter the settings 
to create a new Gateway Network connection, or select an existing connection from the dropdown. Use the Test Connection button to test the settings 
you have selected. Note that you cannot create a new SSL connection on this page. When using SSL, you must create the Gateway Network 
connection before entering the EAM Setup Wizard.
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Step 4: Agent Settings

Gateway Network Server- select your controller machine from this dropdown list.

System Name- when running in New Agent mode, you have the opportunity here to set the Gateway System Name. This name is used to reference 
the agent on the controller Gateway pages. Note that changing the name here will also change the system name under general Gateway Settings. 
When running in Agent Recovery mode, you must choose the Gateway System Name from the System Name dropdown. This dropdown holds all the 
agents for which the controller has lost contact. If you are running an Agent Recovery, then the agent you are trying to recover should be on this list.

Perform System Recovery- this checkbox is only shown when running in Agent Recovery mode. After you click the Finish button, the Gateway will 
attempt to download the most recent gateway backup, previously installed modules, and the license file.

After you have made your selections, click the Finish button.

Agent Post Setup 

The EAM module will now attempt to register the local Gateway as an EAM agent on the controller, and download files if performing a system 
recovery.

If you are running in New Agent mode, you will see the agent status check on the screen. When the agent status check is complete, you will need to 
navigate to the controller Gateway and approve the agent on the Gateway Agents page. Click the Retry button to recheck agent status on the 
controller if the first status check failed.

If you are running in Agent Recovery mode, and you have selected the System Recovery option, you will see the download status of the license file, 
installed modules, and the most recently collected Gateway backup file. Depending on the contents of your archive, some files may not be available. 
Click the Apply Files button to apply downloaded files. Note that this operation will require a Gateway restart if a Gateway backup file needs to be 
applied. Click the Ignore Files button to close this page and not apply downloaded files. Note that the agent settings have already been saved, so it is 
safe to not apply downloaded files if you choose. Click the Retry button to attempt to download the recovery files again.

 After you have set up your agents, it is very strongly recommended that you set up a regularly scheduled Collect Backup task for your [IMPORTANT]
agents. System recovery thru the EAM Setup Wizard will not work if there are no archived backup files!

 

Agent Approval

When an unknown agent first contacts the controller, it is saved in pending status. No interaction with the controller is allowed until you approve the 
agent. Agent version and license information fields will remain empty until the agent is approved. To approve the agent, click on the “approve” link on 
the right side. After a few moments, the agent’s status should change to “Connected”. To remove an agent, click the “delete” link on the right side. If 
the agent machine is still active, the agent will reappear on the list in pending status, but will no longer be able to interact with the controller. To 
remove the agent permanently, you must navigate to the agent Gateway and uninstall the agent via the Agent Settings page.



Agent Groups

Agents can be grouped into agent groups that you create. This allows you to organize agent lists by location or agent function. Agent groups can also 
be selected in gateway tasks. For example, you can create an agent group for a location that collects backups every night at 3AM. Any new agent that 
is added to the group will automatically be included when the gateway tasks executes. To create an agent group, click the “Edit Groups” link at the 
bottom of the page. You will now be on the Groups page, where you can add groups, edit a group name, and delete a group. If you delete a group that 
contains agents, the agent will be automatically reassigned to the default group.

To assign an agent to a group, check the checkbox on the left side next to the agent name. Then locate the agent groups dropdown on the right side 
next to the “Move selected Agents to” link. Select the new group from the dropdown. Then click the “Move selected Agents to” link to move the agents.

Agent Actions

Each agent row is expandable with a arrow link on the left side. When the row is expanded, you will see some actions that can be taken on the 
agent.

: creates a gateway task that immediately restarts the agent Gateway. After clicking the link, you will be asked to confirm that you really want Restart
to restart the agent.

: opens a page which compares the agent’s current license to the license key on file at Inductive Automation. This page is handy when License Detail
you have purchased new software for a license, and you need to verify that  your agent’s license key is up to date. You can update the license for this 
agent by clicking the “Update Agent License” link at the bottom of the screen. This will schedule a gateway task to immediately update the license on 
the agent.

: opens a page that allows you to view all gateway backups and modules that have been archived for this agent. You can schedule a View Archive
gateway task to restore a specified gateway backup from this page by clicking the “Restore Backup” link on the right side.

: opens a page that displays all modules that are currently installed in the agent Gateway. The module version and the current state Installed Modules
of each module is also displayed

: opens a  page that displays all projects that currently exist on the agent. The Project Source field is populated by the controller name Projects Detail
if the project was deployed to the agent by the controller via a gateway task.



 

Next...

Agent Recovery
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Agent Recovery
 

Once the Controller is up and running, you can use it to perform recoveries on Agents.  For example, if 
one of your computers crashed that is running Ignition, you can do a fresh install from a previous backup 
collection that was performed on your Agent.  When the recovery is complete, the Agent will immediately 
pick up where it left off like nothing ever happened.  

 

In this example, let’s assume that the Agent computer crashed.  To check the status, go to your Controlle
navigate to  and check the status of the Gateway r,  Enterprise Administration > Agent Management

Agent.  You can see that Agent133 is disconnected.   

Agent Recovery

Watch the Video

First: on your  computer,  and make sure the EAM Module  (it is not added by default if you use the 'Typical' Agent install Ignition is also installed
selection during installation).

 

On your , go to the  tab and select the .  The EAM wizard will walk you through each step of the Agent Configure Enterprise Administration Setup
Agent recovery process. 
Select  to configure.  Press . Agent Next

 

In order to continue with the Agent Recovery procedure, you must have a backup collection of the Agent.  When you initially setup your Agent on the 
Controller, you created an Archive Path where the backup files are stored.  EAM will automatically know where to retrieve the backup files.  
Click on  and press .  Agent Recovery Next

Backup Required to Perform Agent Recovery

Agent recovery requires that a backup collection was performed, otherwise, you will not be 
able to use this procedure to recover your Agent’s instance of Ignition. 
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Since Agent133 existed previously, the EAM remembered the Agent’s prior settings.  Choose from the list of names in the dropdown lists for the 
Controller and Agent. 
In this example, select your controller from the dropdown list, and select this Agent from the System Name dropdown list (or you can type it in).  Press 

.  Finish

 

The Agent will go through a series of steps: check the Agent status on the Controller, retrieve the Ignition license file, and download Ignition modules 
and the latest Gateway backup to the Agent.
When you get a message that this step is complete, press .  Apply Files



Once you press the Apply Files button, you will see two consecutive progress bars; one for stopping the Gateway and one for starting.  It will take 
about a minute to bring the Gateway up.  The screen will refresh once the Gateway is up and running.   
Click on the tab.  You will be prompted to log into the Designer. Configure 

 

After logging in, you will see the System Status window.  Click on and you will notice that all your projects are restored. Configure > Projects 

 

It's also a good idea to verify that all your modules are activated by going to the   tab and selecting  .  Configure Modules



 

Next...

License Management

 



License Management
License Management

The License Management page acts as a central repository for managing Ignition licenses. You can 
preload a list of licenses, view details of a license as it appears on file at Inductive Automation , assign 
licenses to individual agents, and bulk assign free licenses in the Activate License gateway task. To visit 
the License Management page, navigate to Configure -> Enterprise Administration -> License 
Management.

Agent License Reporting

Whenever an approved agent contacts the controller, it sends its license information. The License 
Management page is automatically updated whenever new or updated license information is received 
from an agent. This means that even if you install a license directly in an agent Gateway, the license 
installation will still be known to the controller.

License Details

You can click on the “details” link on the right side of each license to view modules and versions currently 
assigned to the license. Note that the information displayed on the License Detail page reflects the 
license as it appears on file at Inductive Automation. This functionality allows you to confirm exactly 
which modules and versions are currently assigned to a license.

Activate and unactivate a license

The controller acts as a license proxy on behalf of agents. This means that only the controller requires 
Internet access to the Inductive Automation licensing servers. Whenever you use the License 
Management page or a gateway task to assign, update or unactivate a license, the controller will request 
system information from the agent and forward the information to the licensing servers. If performing an 
activation, the activation data is sent back to the agent after the data is received from the licensing 
servers.

Preloading Licenses

You can preload a list of license keys in the controller. After the license list is loaded, you can individually 
assign licenses to agents, or assign all free licenses to agents in one step via the Activate License task. 
To preload a license list, navigate to the License Management page and click the “Add Licenses” link.

The license list must be formatted like so: 

AAA-AAA, xxx-xxx, ABC-123, cde-456

Click the Add button to save preloaded licenses.

License 
Management

Watch the Video
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Deleting Licenses

You can remove unused licenses from the License Management page, but only if the license is not 
currently assigned to any agent. If you want to delete an assigned license, click the “unactivate” link on 
the right side of the license. After the Assigned Agent field changed to “Unassigned,” you can delete the 
license.

 

Next...

Agent Task Scheduling

 



Agent Task Scheduling
Agent Gateway Tasks

Agent gateway tasks are enormously useful for applying an action to many agent 
gateways at once. To create a new task, or to view running tasks, navigate to 
Config -> Enterprise Administration -> Agent Tasks. The Gateway Tasks page will 
display scheduled tasks, currently executing tasks, and unscheduled tasks that 
can be run on demand. To create a new task, Click the “Create new Gateway 
Task” link. You will enter the Gateway Task wizard.

Step 1: Choose Type

You must select the type of task that you wish to execute. After you have 
selected a type of task, click the Next button.

Step 2: Task Scheduling

Set the task name to a descriptive name of your choice. The following scheduling 
options are available:

: the task will begin execution as soon as you complete the Execute immediately
wizard.

: the task will not be scheduled, but is available for Execute on demand
immediate execution at any time after you complete the wizard.

:  the task will run once at the date and time that you Execute once, scheduled
specify.

: the task will run once after the specified number of Execute once, delayed
seconds, minutes, hours, or days.

: this type of schedule uses UNIX cron type scheduling, Execute on schedule
where a pattern of 5 numbers determines the recurring schedule. For example, 
“30 3 * * *” means run a task every day at exactly 3:30 AM. Use the dropdowns 
next to the pattern textboxes to build out the pattern for the schedule.

After you have determined your task schedule, click the Next button.

Agent Task 
Scheduling

Watch the Video
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Step 3: Agent Selection

In this step, you will select the agent groups or individual agents that will be included when the task executes. You can select agents that are not 
currently connected, but you cannot select pending agents.

Depending on the type of task, you may need to complete another page to add some information required for that task. If not, you can click the Finish 
button to schedule the task.

Gateway Task Results



Gateway task execution is reported in the agent_events table in the controller’s configured database. The individual result of the task execution for 
each agent is report as a separate entry. For example, the following query will return the results of all task executions:

select * from agent_events where event_category = 'task' order by event_time desc;

A task that completed normally for an agent will contain the text NORMAL in the event_level field. If an error occurred for an agent, the event_level 
field is set to ERROR, and the error message is recorded in the message field.

Running a task outside its schedule

You can run any task outside the task’s normal schedule by clicking the “run now” link on the right side of the task. Keep in mind:

Tasks that have been scheduled to run immediately are already running, and the “run now” link will not be visible.
A task that has been scheduled to execute only once at a scheduled time or after a delay will be rescheduled to run immediately. The task 
will not run again after it has been rescheduled.
A scheduled task will continue to run at its normally scheduled time, even if you run the task now.

Pausing and Cancelling Tasks (7.8.1)

Pause and Resume

After most tasks are created, they are put onto the task schedule. The exception to this is on demand tasks, which are not put on the schedule until 
you click the "run now" link. After a task has been added to the schedule, you can pause and resume the task. The state of the task (scheduled, 
running, waiting) and the scheduling configuration affect how the task is paused and resumed.

Task 
configuration

Pause action Resume Action

Task is currently 
running or 
waiting

System will attempt to 
cancel outstanding calls 
to remote servers.

System will run task again against any servers that were outstanding when task was paused.

Task is 
scheduled once 
at a specific date 
and time

The task will be 
temporarily taken off the 
schedule.

If the specified time has not yet arrived, the task will be put back onto the schedule at the original 
time. If the specified time has already passed, the task will execute immediately upon resume.

Task is 
scheduled once 
after a specified 
delay

The task will be 
temporarily taken off the 
schedule.

The task will be put back onto the schedule at the original calculated time. For example, if the delay 
is set to 2 hours, and the task is paused for 1 hour, the task will fire in 1 hour after resume. If the 
delay period has already passed, it will fire immediately after resume.

Task is on a 
recurring 
schedule

All future iterations of the 
task will be temporarily 
taken off the schedule.

The task will  fire if task iterations have been missed when the task was paused. The task will not
return to firing on its normal schedule.

Cancel

Scheduled one-shot tasks can be cancelled at any time before the task starts. Scheduled one-shot tasks include tasks that are scheduled to fire once 
after a delay or fire at a specific time. Running tasks can also be cancelled, but there are no guarantees about how much of the task is processed at 
the time of cancel. Keep in mind that cancelling a task will cause also delete the task at the same time, and it cannot be retrieved after cancel.

 



Next...

Agent Task - Licensing

 



1.  

2.  

Agent Task - Licensing
One of the many tasks that Enterprise Administration Module (EAM) allows you to perform is license key 
(CD Key) activation and unactivation.  This section demonstrates how to Activate, Unactivate and Update 
licenses from the Controller.

 

Agent Task - 
Licensing

Watch the Video

Activate License

On your , go to the  tab and select .  You can see that no license is currently installed. Agent Configure Licensing

 Activating a license on an Agent must be done from the Controller.  Go to your  and select Controller Configure > Enterprise 
. Click on the  link. Administration > Agent Tasks 'Create new Gateway Task' 

Before Activating a License

This section assumes you already have your Controller and Agent created.
Make sure you know your License Key serial number.
For clarity, each screenshot is identified with either a Controller or Agent label in the 
header so it's clear which machine you are working on.
Refer to  for some more useful tips with this Configuring Controllers and Agents
section.

https://inductiveuniversity.com/video/agent-task---licensing/7.8


2.  

3.  

4.  

 Activating a License key is one of several tasks you can perform under .  Click the  button and press . Gateway Tasks Activate License Next
 The EAM wizard will walk you through each step of the activation process. 

 The Activate License task has several scheduling options.  For this example, select and press .   Execute Immediately  Next



4.  

5.  

6.  

Now, select the  you want to activate the license on and press .  In this example, Agent133 was selected. Agent Next

Enter your license key.  You can enter it one of two ways: type it in the  if you know it, or press  License Key field Auto Assign the License
and the license key will auto populate.   . Press Next



6.  

7.   The Activate License page will refresh so you can validate your licensing information.  Press . Finish

The screen will refresh to the Gateway Tasks window.  A message will be displayed stating that the license was activated successfully.  



7.  

8.  

9.  

 Now go to the  to validate that the Agent license was activated.  You may see an Access Denied message.  This is because the page Agent
was automatically updated. Don't panic!  Click on the  link to refresh the Ignition Home page on your Agent.  'Return to home page'

 Click on  and verify your License Key on the Agent. This page shows all the modules on your license as well as the Configure > Licensing
versions they are licensed for.

If you are running Ignition in Trial Mode

If you are running Ignition in Trial Mode on your Agent, there is a chance that the trial timer expired, and the license activation will 
fail. If this happens, reset the trial timer and resume the activation for the Agent. You can check the status of the installed modules 
by going to . Modules you are licensed for will not expire, only the modules that are being used in Trial Configure > Modules
Mode.



10.  It's a good idea to check to see if all your modules are Activated.  Go to your  tab and select . If any are still in trial mode, Configure Modules
that means your license key either didn't include those modules or they are a newer version than your license allows.

Update a License

In the event you need to reload or update a license on your Agent, go to the , navigate to Controller Configure > Enterprise Administration > Agent 
.  Click the  link.Tasks 'Create new Gateway'



Select  and press .  The wizard will guide you through the license update steps.  Refer to steps 4 through 10.Update License Next

 

Unactivate a License

If you need to unactivate a license, go to your , navigate to  .  Click the Controller Configure > Enterprise Administration > Agent Tasks 'Create 
 link.  new Gateway Task'

Select   and press  .  Once again, the wizard will guide you through the unactivate license steps.  Refer to steps 4 through 9.Unactivate License Next

 

 

 



Next...

Agent Task - Backup and Restore

 



1.  

2.  

3.  

Agent Task - Backup and Restore
   

 

The Backup and Restore tasks are an extremely important part of the Enterprise Administration 
Module.  Performing a Collect Backup is required if you want to do an Agent recovery.

The Gateway Tasks we are going to discuss in this section are the , , Collect Backup Restore Backup Insta
 and .ll Modules Restart Agent

Collect Backup

Collect Backup is a Gateway Task that performs a Gateway backup on the selected Agent's machine.  

On the , navigate to , and Controller Configure > Enterprise Administration > Agent Tasks
click on .Create new Gateway Task

Collect Backup is one of the several Gateway tasks you can perform.  Select  Collect Backup,
and press .  The EAM task wizard will walk you through each step of the Collect Backup Next
process.

There are several different task scheduling options available.  For this Collect Backup example, 

choose to Execute Immediately, and press Next.  If you need more information on other 
scheduling options, refer to .  Task Scheduling

Agent Task - 
Backup and Restore

Watch the Video

https://inductiveuniversity.com/video/agent-task---backup-and-restore/7.8


3.  

4.  

5.  

6.  

 

 Select the Agent you want to perform the Collect Backup on, and press Next.

The EAM task wizard will prompt you if you want to do a Force Backup even if nothing changed 
since the last backup. This step is optional, but it is useful when your backups are performed on 
a regular schedule.  It captures the changes between the time the last backup was performed 
and the unscheduled backup. To be safe, check the box, and press .Force Backup  Next

 Review the Collect Backup Task Summary information, and press Finish. 



6.  

7.  

1.  

 

Once the Collect Backup task is complete, a successful message will be displayed.  You can 
even check the history by opening the Task History tab.

 

Your new Gateway backup will be stored wherever your Controller settings are pointing to when 
the Controller was initially created.  To check, go to the  and navigate to  Controller, Configure 

.  You can have your Archive Path set to > Enterprise Administration > Controller Settings
Automatic or Manual.  If you have it set to Automatic, you can find your backups inside the 
directory for Ignition, otherwise, it will be the folder location that is specified in the Controller 
Settings. To learn more about controller settings, refer to . Creating a Controller

 

Restore Backup

Now, let’s restore a Gateway backup on the selected Agent.

Go to the  and navigate to .  Click on the link.Controller, Configure > Enterprise Administration > Agent Tasks Create new Gateway Task 
Select the   task, and press  .   Restore Backup Next



1.  

2.  
3.  
4.  

Schedule the  task to , and press . Restore Backup Execute Immediately Next
Select the , and press .Agent Next
If your Archive Path was set to Manual when you created your Controller, you will have to select the  button, and navigate to the Choose File
folder on your computer to locate the Gateway Backup file. If you are unsure about your Archive Path, refer to your . Controller Settings

 

Navigate to the folder on your computer to locate the Gateway Backup file.   and PSelect the backup.gwbk,  click Open.   ress Next on the 
Restore Backup task.  

Screenshots

Some screenshots will not be duplicated. You can refer to the screenshots in Collect Backup as you work your way through each 
section.



4.  

5.  

6.  

1.  

2.  
3.  
4.  

 

Review the Restore Backup Task Summary, and press Finish.  Once the Restore Backup task completes, you will receive a successful 
message from the Gateway Task.  
Now go to your  and click .  It takes a few moments to bring up the Gateway.  You will see a progress bar while the Gateway is Agent, Home
starting up. Once it’s complete, you will see all your projects uploaded and ready to go.   

Install Modules

As an example, suppose you accidentally uninstalled the Symbol Factory and Vision Modules from your Agent.  Let's go ahead and reinstall them 
using the Install Modules task.  

Go to the  and navigate to .  Click the  link.Controller, Configure > Enterprise Administration > Agent Tasks Create new Gateway Task
Select the  task, and press .  Install Module Next

 

 Schedule the  task to , and press .Install Module Execute Immediately Next
 Select the , and press .Agent Next
 From the list of , click the  buttons for  and the .  You will notice, that once you click Archived Modules Add Symbol Factory Vision Module
the  button next to a module, it will show up in the  box.  You can choose as many modules as you need, and when Add Selected Modules
you're finished, press . Next



4.  

5.  

6.  

 

 Review the   , and press .  Once the Install Module task completes, you will get a successful message Install Modules Task Summary Finish
from the Gateway Task. 
 Go back to your , and navigate to  to verify that both the Symbol Factory and Vision Modules were successfully Agent Configure > Modules
installed.  



6.  

1.  

 

Restart Agent

Let’s go back to the  and create one more new Gateway Task called Restart Agent. This task will stop the Ignition service on the Agent and Controller
start it back up again.

Go to the  and navigate to .  Click on the  link. Controller, Configure > Enterprise Administration > Agent Tasks Create new Gateway Task  
 
Select the  and press  Restart Agent, Next.



1.  

2.  
3.  
4.  

5.  

 

 Schedule the  task to , and press .Restart Agent Execute Immediately Next
 Select the  and press .Agent, Next
 Review the , and press .  Once the Restart Agent task completes, you will receive a successful  Restart Agent Task Summary Finish
message from the Gateway Task.
 Go to your  and refresh your page.  You will see a progress bar while the Gateway is starting up.  This will take a few moments, and Agent
once this task completes, your Agent will be up and running. 

Next...

Agent Task - Send Project

 



1.  

2.  

3.  

4.  

Agent Task - Send Project
 

Agent Tasks have the ability to send projects and project resources from a Controller to an Agent.     

Send Project Task

On the  , under the   tab go to  . Here you Controller Configure Enterprise Administration > Agent Tasks
can create a Gateway Task to send a project from the Controller to an Agent.

The following example demonstrates how to create a Gateway Task and send a project to an 
agent.  Click the  link.  The EAM wizard will guide you through ‘Create new Gateway Task’
each step of the Send Project task.   

Not only will the Send Project send a project from the Controller to the Agent, but if the project 
already exists on the Agent, it will replace it.  
Scroll down the list of Gateway Tasks and select .  Press .  Send Project Next

Just like with all Gateway Tasks, the Send Project task needs to be scheduled.  Schedule the 
task to and press . Execute Immediately Next

 Select the Agent where you want to send your project and press .Next

Agent Task - Send 
Project

Watch the Video
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4.  

5.  

6.  

7.  

The EAM knows your controller and agent configuration.  It’s going to prompt you to choose the 
machine where your project is located.  In this example, the project that you want to send is 
located on the Controller or Gateway source so select  and press .   Local System Next

 

The wizard displays all your projects from your local system.  Select the project you want to 
send to your Agent.  In this example, select the   project and press  .Parameters Next
(If you select your Agent on the previous screen, the wizard will display all your projects running 
on your Agent that were sent over previously from the Controller).

 

The EAM wizard summarizes all the information for you to review.  Press  and the Finish
Parameters project will be sent from the  to yourController  Agent.



7.  

8.  

9.  

1.  

 The EAM will execute the task, the screen will refresh, and a message will popup stating that 
your Send Project task was created successfully.

To verify  tab that the Parameters project was sent, go  to your Agent, click on the Configure 
and select Projects.  You can see that the Parameters project was created by the EAM 

controller.  If you can't see your sent project, refresh the screen by clicking Projects.  

 

Send Project Resources Task

You can also send project resources, such as project templates, windows, transaction groups, pipelines 
and even script modules from the Controller to an Agent.   

On the  , under the  tab, go to .  Controller Configure Enterprise Administration > Agent Tasks
Let’s create another Gateway Task to send resources from the Controller to the Agent.   Click 
the  link.  Once again, the EAM wizard will guide you through each ‘Create new Gateway Task’

MySQL Warning Message

Notice that for the Parameters project there is an warning icon next to MySQL 
database. This means that MySQL database was used on the Controller and 
currently is not configured on the Agent.



1.  

2.  

3.  

4.  

5.  

6.  

step of the Send Project Resources task.   

Click on the   button and press Send Project Resources Next.

Schedule the Send Project Resources task to  and press . Execute Immediately Next

Let's select the resources from a project on the Controller.  Select  and press Local System Next
. 

This example sends selected resources from the Training project on the Controller to the 
Agent.  Select  and press . Training Next

 You can see all the resources inside of the Training Project.   Of course, real projects will have 
many more useful project resources than are shown here.  It can include templates, windows, 
transaction groups, pipelines and script modules.  Choose whatever resources you want to send 
to the agent, and press . Next

Reference screenshots in the Send Project section

You can refer to some of the screenshots in the Send Project Task section as you 
work your way through the examples in this Send Project Resources Task.



6.  

7.  

8.  

9.  

10.  

You have the option of either merging the project resources into an existing project or creating a 
new project on the Agent.   In this example, let's create a new project.  Select  and enter Other,
a new project name. Press .   Finish

 The EAM wizard summarizes all the information for you to review.  Press Finish. 

 

 The Gateway Task for Send Project Resources will execute, the screen will refresh, and a 
successful message will popup stating that your Send Project Resources task was sent.

To verify that the Training project resources were sent, go to your click on the Agent,  Configure 
tab, and .  You can see in this example that  was created by the  select Projects 'NewProject2'
EAM controller.  If you cannot see your new project, refresh the screen by clicking . Projects



So once your project and project resources are sent to the Agent, you need to complete the installation of 
your project.  You need to setup your authentication profile, database, and tag providers. Once this is 
completed, you are ready to use the project and project resources on your Agent.   

 

 

Next...

Automated Agent Installation

 



Automated Agent Installation
Automated agent installation 

The EAM allows an agent Gateway to be automatically configured from text files the first time the 
Gateway is started. This capability is enormously useful when installing multiple agent Gateways in your 
network, as otherwise you must install each Gateway, log in, and install and configure the EAM agent. To 
automatically configure an agent, you must add two files to the Ignition /data folder before startup: init.
properties and eam-install.properties. Example contents are below. After the files have been read, they 
are renamed to .init.properties.bak and .eam-install.properties.bak. A typical application for this capability 
would be a script that creates the init files and adds them to an ignition.zip that is distributed to many 
machines.

: For init.properties, you are not required to use all the settings shown below. The Gateway will Note 1
use its standard default settings instead.

: Multiple Gateway Network connection settings are managed by numbering each setting. The first Note 2
set of connection settings must contain “0” in the setting name after “gateway.network.” . For example, 
you can create two outgoing connections with different IP addresses like so:

 

gateway.network.0.Host=10.20.11.18
gateway.network.1.Host=10.20.15.23

 

 

Example init.properties
# SystemName: sets the Gateway name in Gateway Settings

SystemName=Agent1

# AutoDetectLocal: set to true to check the first found network interface to determine local IP address. Set 
to false to manually set the IP address of the Gateway.

AutoDetectLocal=false

# LocalInterface: manually sets the IP address of the Gateway. If set, the AutoDetectLocal setting must be set 
to false

LocalInterface=10.20.11.17

# UseSSL: set to true to force all connecting web browsers to connect to the Gateway over SSL

UseSSL=false

# PingRate: how often in milliseconds to ping the remote machine

gateway.network.0.PingRate=1000

# Enabled: set to false to disable the gateway connection after it is created

gateway.network.0.Enabled=true

# Host: the address of the remote machine

gateway.network.0.Host=10.20.11.18

# Port: the port of the remote machine.

gateway.network.0.Port=8088

# Enable SSL: set to true to use SSL to connect to the remote machine. Note that you must change the Port 
setting to use the Gateway Network SSL port. This port is 8060 by default.

gateway.network.0.EnableSSL=false

# PingTimeout: how long in milliseconds to wait for a ping request to be processed by the remote machine

gateway.network.0.PingTimeout=300

# PingMaxMissed: the number of failed pings allowed before the connection state is set to Faulted.

gateway.network.0.PingMaxMissed=30

# EnableWebSockets: set to true to allow faster asynchronous communications with the remote machine.

gateway.network.0.EnableWebSockets=true



# WebsocketTimeout: how long to wait in milliseconds for a message to be processed over the web socket

gateway.network.0.WebsocketTimeout=10000

# HttpConnectTimeout: how long to wait in milliseconds to initially connect the http data channel

gateway.network.0.HttpConnectTimeout=10000

# HttpReadTimeout: how long to wait in milliseconds to read data from the http data channel

gateway.network.0.HttpReadTimeout=60000

Example eam-install.properties
# installSelection: always set this setting to Agent

setup.installSelection=Agent

# controllerServerName: the Gateway Network server name of the controller

agent.controllerServerName=Ubuntu-Controller

# sendStatsInterval: the amount in seconds that the agent will wait before sending new metrics and 
configuration data to the controller. Note that if there are currently no interesting metrics or updated 
config data to send, the agent will not send any data.

agent.sendStatsInterval=5

 

Next...

Redundant EAM Configuration (7.8.1)

 

 



Redundant EAM Configuration (7.8.1)

Redundant Controller Setup

To set up redundant EAM controllers, you first follow the normal setup process for a redundant master and backup. The main difference with EAM is that 
each agent requires separate Gateway Network connections to both the master controller and the backup controller. The agent will automatically route 
messages to the active controller. Some items to keep in mind:

As with any redundant configuration, you cannot make any changes on the backup controller. This includes approving new agents and running 
agent tasks.
Agent metrics are only sent to the active controller. This means that EAM agent system tags will not process data  until the on a backup controller
backup becomes active.
Scheduled and running agent tasks on the master controller will be automatically suspended if control is transferred to the backup controller. The 
tasks will never run on the backup controller. The tasks will resume on the master controller after it resumes control.

Redundant Agent Setup

As with the redundant controller setup, you follow the same redundant master and backup setup process. Then run the Agent Setup wizard in the same 
way as you set up a standard agent. After the Agent Setup wizard completes, you must navigate to the controller Gateway and approve both the master 
and backup pending agents. Some items to keep in mind:

Both the master agent and the backup agent will send agent metrics. The controller will create a Master folder and a Backup folder of system 
tags, allowing you to create a project that monitors both sets of system tags at the same time.
Agent tasks list the master agent and the backup agent separately. Tasks that do not change any configuration on an agent can be run without 
errors on both the master agent and the backup agent (such as the Restart Gateway task and the license tasks). But tasks that do change 
configuration (such as the Send Project task) will fail on the backup agent, due to the fact that Gateway configuration cannot be changed on a 
redundant backup.

 



Versioning
   

Ignition stores several versions of a project so you can go back to a previous version or test out changes before being sent to the production 
environment.

   

   

In this section ...  

   



Staging and Publishing
 

Each project can have two distinct versions at once:

Staging version
Published version

By default, a new project is configured to be in Auto publish mode, which means that the two versions 
are always identical. However, if you change a project to be in Manual publish mode, you can then 
explicitly publish a project in the Designer.

Published vs Staging

Each project can have two distinct versions at the same time: the   version and the   verStaging Published
sion. Having a published version and a staging version allows you to make changes to a project, save 
the changes, and test out the changes before "publishing" it to a production environment.

Usually, Vision module Clients run the published version of a project. However, by launching a Client in a 
special mode (from the Designer or from the Config section of the Gateway), you can launch a Client that 
runs the staging version of that project. This staging Client will receive updates on every save, where the 
production Clients receive updates only on publish. This lets you test out your changes to the project in 
an actual Client, which is more realistic than the Designer's preview mode. 

Not all aspects that comprise a project use this system. It is primarily intended for systems such as the 
Vision module's Clients. Features that run persistently on the Gateway, such as Tags, the SQL Bridge's 
Transaction Groups, and Gateway-side scripting always run the most recently saved changes (the 
Staging version). Since these features by definition must run in exactly one place, they cannot be 
effectively "tested out" by simultaneously running a staging version alongside a published version.

In the Designer, choose the   menu item, then go to the   page to Project > Properties Project > General
set the  . By default, a new project is configured to be in  publish mode, however you Publish Mode Auto 
can change it to  publish mode. Manual 

In the default Auto mode, when you want to save your project, Designer lets you do a File > 
, which means both the Staging and the Published versions will be the same Save and Publish

and identical.

In mode, when you want to save your project, Designer lets you do both a   o Manual  File > Save
r a  .   updates the Staging version, and   updates the File > Publish File > Save File > Publish
Published version.

Publish Selected Resources

It is also possible to publish individual resources on a project as they are finished instead of publishing 
the entire project.  This is particularly helpful if you want to get resource updates to users quicker rather 
than waiting for the whole project to be published.  To learn more, refer to Project Creation and Publishing
.  

Project Versioning and History

Each project keeps a log of recent changes. These include both saves and publishes. Every 
save increments a number called the "edit count" for the project, which can be used like a serial 
number. The user, time, affected resources, and a commit message (see next) are logged as well. 

Staging and 
Publishing

Watch the Video

 

 

   

 

Next...

Project Versioning and Rollback

 

 

 

https://inductiveuniversity.com/video/staging-and-publishing/7.8
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Project Versioning and Rollback
   

Each project keeps a log of recent changes. These include both saves and publishes. The user, time, 
affected resources, and a commit message are logged and you can rollback to a previous version. 
Ignition keeps track of the previous 10 saved versions of your project. You can restore any one of these 
versions with the roll back feature.

To restore a previous version of your project

In the Designer, select  .File > Rollback
The Rollback window is displayed showing the edit dates, user name, edit count, and edit type.
 
Select the version you want to roll back to and click .Rollback

On the  dialog box, click .Confirm Yes
The Designer reloads the previous version of the project.

 

Project Versioning 
and Rollback

Watch the Video

   

 

Next...

Production and Development Server

https://inductiveuniversity.com/video/project-versioning-and-rollback/7.8


Production and Development Server
 

Once you complete your project and have it in production, it is a good idea to have a separate Ignition 
development server for making future changes. That way, the changes will not affect the plant floor and 
can be completely tested before rolling out to the production environment. Also, it is important to have a 
development server to perform any Ignition upgrades on so that any problems can be addressed before 
moving to a production environment.

There are a few things to consider when having a production and development server. First, the 
development server should have its own PLCs and SQL databases. You do not want the development 
server to point to the live PLCs because it would be possible to accidentally write values to PLCs that 
may start or stop equipment. Likewise, you do not want the development server to point to the production 
database or else you may risk duplicating data.

Second, the development server does not need a license because you can run the server in its two hour 
trial mode.

Third, you should never move a Gateway backup from the development server to the production server.
The development server is pointing to the development PLCs and databases. If you move the Gateway 
backup, these connections will be saved inside the backup and restored on the production server. Which 
is bad because the production server should be pointing to the live PLCs and databases. Instead you 
should backup individual projects and tags separately and move them to the production server.

Ignition projects use database connections and tags but only by name so the production server and the 
development server will have the same PLC and database names. But behind the scenes, they will point 
to different places. You cannot simply backup and restore a project from the development server to the 
production server because the projects contain the windows and the templates and not the tag 
information. You will have to transport the tags as well in addition to keeping track of changes on the 
production and the development server to ensure that the tag folder path coincide with the ported project.

Production and 
Development Server

Watch the Video

 

 

 

 

Next...
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Module Descriptions
 

What are Modules?

Modules are applications that are built on the Ignition platform and integrate into the platform in order to offer functionality. Most of the main features of 
Ignition are actually provided by different modules such as the Vision and SQL Bridge modules.

Modules integrate seamlessly into the system and provide things like new Designer workspaces, new Gateway settings, new drivers, and much more.

Why Modules?

The modules in Ignition offer many benefits.

Flexible Licensing
Only license the modules that you need, saving money and reducing complexity compared to big monolithic applications that try to do 
everything. At the same time, the modules have been designed to offer a broad swath of functionality, to avoid having too many pieces.
 
Hot-Swappable
Modules can be dynamically loaded and unloaded, allowing you to install, remove, and upgrade them without affecting other parts of the 
system. This can have huge implications for big projects where up-time is important.

Increase System Stability
Building modules on a common platform means fewer bugs, better isolation, and all around increased stability.
 
Pluggable Module Architecture
The pluggable module architecture allows quick integration of new modules into the Ignition platform. From time to time new modules will be 
released which add additional features. Third-party modules that provide a wide range of functionality are also available.

Installing, Upgrading, Uninstalling, or Restarting a Module

All module configuration is done from Gateway in the   section. From here you can add, remove, and restart Configuration > Modules
modules. Modules integrate their settings into the Gateway configuration tree, and therefore do not offer settings in this section.

Installing or Updating a Module

On the   page, go to the bottom of the list, find the orange arrow, and click the   link.Configuration > Modules Install or Upgrade a Module
 
Click  , select the   fileChoose File .modl .
 
Click  .Install
You can now see the module you installed in the list of modules. 

Note: Modules can be running side-by-side in both Trial mode and Activated mode, see   for more information. Also when installing a About Licensing
module, there is no need to restart the server.

Uninstalling a Module

After you select the module, click the   link on the far-right next to the module entry in the table, then click  .uninstall Confirm

Modules are hot-swappable, this means these actions can be performed while the system is running. Furthermore, the isolated nature of modules 
ensures that performing one of these actions only affects that particular module, and any modules which depend on it. For example, uninstalling the 
SQL Bridge module will not affect any running Vision module clients.

Restarting a Module

Modules can be restarted by clicking the   button next to their entries on the   page. Because of the isolated nature of restart Configuration > Modules
modules, the other modules are not affected by the   (unless they depend on that particular module).restart

Module Status

The installed module list on the   page also provides some basic information about the   of the module. The  , Configuration > Modules State Version Li
, and   columns are all displayed in the list. Module licensing is performed centrally in  , so the values here are only for cense State System > Licensing

information purposes.

The module   can be either   or  . Running means the module programs are actively performing tasks, for example, the Alarm State Running Loaded
Notification modules shows as Running because it is continually checking for condition changes that need to set the alarm on or off. Loaded means 
the module program or resources are available but nothing is running, for example, the Symbol Factory module makes all the symbol images available 
for your use.



Third-Party Modules

Third Party Modules are Ignition modules that were were produced by someone other than Inductive Automation. Our open SDK allows anyone to 
create and test your own modules. Be aware that loading any modules from an untrusted source could potentially do harm to your projects or your 
data. 

 

 

In this section ...



Standard Modules
 

In Ignition, the Standard modules are those modules that are automatically installed when you choose the  installation option, they are the core Typical
modules.

 

 

In this section ...

 



SQL Bridge Module
 

The SQL Bridge module is a robust and flexible tool to map between OPC data and Database data.   are the heart of the SQL Transaction Groups
Bridge module. Transaction groups configured through the Ignition Designer, are units of execution that perform actions such as, storing data 
historically, synchronizing database values to OPC, and loading recipe values.                               

Transaction Groups

Transaction groups are configured in the Ignition Designer. Each Transaction Group is associated with a table in a database Ignition is connected to, 
and is made up of one or more Items. The group will then execute at a specific interval of time, or on a user-defined schedule. Generally each 
execution will  create a new row in the database table with a separate column for each Item in the group. However it is possible for some types of 
Transaction Groups to take values from the database and write to specific tags. 

Additionally the Transaction Group can be configured to conditionally synchronize values by using a trigger. The trigger is evaluated every execution, 
and if the trigger condition is met, then synchronization will occur. If the trigger condition has not been met then the group will wait until the next 
execution to re-evaluate the trigger. 

There are several types of , (Standard, Block, Historical and Stored Procedure) and each offers different functionality. For example Transaction Groups
the Historical Group allows you to quickly configure a group that reads OPC data and push it to the database. While the additional flexibility of a 
Standard Group allows you take values from the database and write them to 

Items 

Each Item in the Transaction Group consists of several properties, but the key properties are the Value and Target Name. 

Value: The Value can be a reference to an OPC value such as a tag in the Tag Browser. However you can instead use a direct OPC Item 
Path without having to create a tag in Ignition first. Additionally the Value can be derived using Ignition's Expression Language. 
Target Name: In most cases the Target Name is a column on the database table the Transaction Group is associated with. However it is 
possible to have the Target Name 'Read-only'. When set to 'Read-only' the value of the item will not be tied to any columns in the database, 
but is still visible from the Transaction Group and can be used as a trigger. 

SQL Bridge Limited

The limited version of SQL Bridge only allows the use of Historical Groups.  It only passes data from PLC to the database.  It is not bi-directional. 
There is no limit on the number of groups you can create. 

For more information about whether a limited license is right for you, contact Inductive Automation.

 



Vision Module
 

The   module provides the visual elements of Ignition.   offers a wide range of functionality, and can be used to create HMI style control Vision Vision
systems, data analysis and trending applications, executive dashboards, and more. The projects are designed using the Ignition Designer, and clients 
are web-launched with zero installation from any Java capable computer. 

Create your Ideal Control System in Minutes

Combined with the power of Tags, it's never been easier to build effective status and control systems. Drag and drop tags on the screen to create 
automatically bound buttons, HOA toggles, LED displays, value entry fields, and more. Drag tags directly onto component properties to bind bi-
directionally in seconds. The innovative overlay system provides intuitive data quality feedback with no additional configuration.

Vector Graphics

Powerful vector-graphics drawing tools allow you to create inviting graphics for your project. Vector graphics are screen-resolution independent, 
allowing screens to look great on any size monitor. Advanced graphics features like gradients, Bézier curves, transparency, are easily accessible with 
the intuitive drawing tools. Create your own symbols, import them from *.svg files using drag-and-drop, or use the Symbol Factory module to access 
nearly 4,000 ready to use, professional-quality vector symbols.

World-Class Charting Capabilities

The Ignition   module offers a variety of charting and trending options. The Easy Chart, as its name suggests, makes it incredibly easy to create Vision
useful and powerful charts. The charts support multiple axes, sub-plots, many pens, and hundreds of thousands of data points. Using Tag Historian, 
creating charts is as simple as drag-and-drop, and charts intelligently pull just the data they need, making clients more efficient.

Integrated Database Connectivity

The Ignition   module is the world's most database friendly HMI/SCADA application. Working with SQL databases is integrated into many Vision
aspects of the project design process, allowing you to integrate process and business data effortlessly.

Unlimited Growth Potential

Web-launched clients, the ability to seamlessly connect multiple projects through Retargeting, and no licensing restrictions on screens, tags, 
components or clients means the system can grow over time.

Vision Limited License

Under Limited Licensing, the Vision Module can support scaling down to running five (or fewer) concurrent Clients.  There are no restrictions on the 
number of tags, providers or projects.  The limited version does not come with the Symbol Factory image library.  

For more information about whether a limited license is right for you, contact Inductive Automation.

 



Symbol Factory Module
 

The Symbol Factory module integrates Symbol Factory 2.5 from Software Toolbox into the Ignition Designer. The intuitive interface allows you to 
browse and search  through nearly 4,000 high quality vector graphics symbols. Once you find the symbol you're looking for, simply drag-and-drop it 
onto a Vision window to use it right away. Double-click on the symbol to change it, or dynamically animate parts of it to bring your project to life.

 

 



Reporting Module
 

The Reporting module adds dynamic reporting functionality to the Vision module, allowing you to display reports to Vision clients or to generate PDF 
files. The reporting module offers flexible report generation, with a variety of components, charts and tables. Additionally, it supports the import of 
existing forms and images, allowing you to migrate from paper-based tracking systems to an electronic system. Easily create dynamic, database-
driven PDF reports with pixel-perfect layout. Import existing PDF-based forms and overlay dynamic data on top to achieve a paperless factory.

Dynamic PDF Reports

Data changes quickly, so why not your reports? With the Reporting module, putting together comprehensive reports is a snap. Want a report for a 
different time range or a different equipment, no problem You can create a report to suit your needs and make it dynamic enough to be changed on 
the fly without a redesign.

 

Automatic Reports

Create reports that automatically show your users the information pertinent to their shift, access level, area, or pre-determined times-of-interest.

Utilize Existing Forms
Already have existing forms or reports? You can bring those into the report designer and keep your paperwork consistent.

Paperless Factory
Achieve a greener, paperless facility by using Ignition to generate an unlimited number of PDF reports, which can easily be stored digitally.

 

Reporting Module Limited Version

Limited Licensing

With a limited version of the Reporting Module, you can define as many reports as you want, but you will only be able to run (schedule) 2 
reports.  You must be at your limit or under before the Reporting Module knows which report to run.  If you go over the limit, you will get a 
warning message, and it will not run  reports until you delete enough reports to be at the limit.any
Saving, printing, FTP and email schedules all count as running a report. 

On the Vision Module

A report that you create with the Reporting Module can be displayed using the Vision component either in the Designer or the Client.
You can print and save a report through scripting.  You can also right click on the component to print or save which is very useful in the 
Client.  To learn more, refer to the  . Report Viewer

On the Trial Version

All Report functionality is available. 
There is no limit on the number of reports or how you can view or distribute them.  
The only limitation is the watermark on each page. 

For more information about whether a limited license is right for you, contact Inductive Automation.

 

 

 

 

https://legacy-docs.inductiveautomation.com/display/DOC/Report+Viewer


OPC-UA Module
The Ignition OPC-UA module offers OPC-UA server functionality with a variety of device drivers and a robust, open driver API.

OPC-UA Server Functionality

This module turns Ignition into an OPC-UA server, capable of handling connections from any OPC-UA compatible client. Outgoing connections can also be 
made to 3rd-party OPC-UA servers. In this way Ignition functions as both an OPC-UA server and an OPC-UA client.

Built-in Device Drivers

The OPC-UA module offers a number of device drivers for common protocols out-of-the box, and is easily expandable thanks to the hot-swappable 
module architecture in Ignition. New drivers can be downloaded and installed in minutes without requiring a system restart or otherwise affecting other 
parts of the Ignition platform.

Redundancy Support

The OPC-UA module ties into the Ignition redundancy in order to provide efficient access to device data along with failover redundancy, with no additional 
configuration.

Public Driver API

Anyone can create new drivers thanks to the open driver API, and users can download and install drivers created by other developers. This is the first time 
such an API has been made publicly available for a product like Ignition. For more information about creating drivers for Ignition, visit the Inductive 
Automation website.

Driver Modules

Drivers for the OPC-UA module are deployed as modules themselves. While they don't add a visible element to the system, they are loaded and upgraded 
in the same manner as other Ignition modules.

Available Drivers:



Allen-Bradley Drivers Module
 

The Allen-Bradley brand of programmable logic controllers (PLC) is a popular choice in many industries. Ignition can connect to the following Allen-
Bradley controllers:

PLC Capability

CompactLogix Connect to CompactLogix firmware v20 and prior processors.

ControlLogix Connect to ControlLogix firmware v20 and prior processors.

Logix Driver Connect to Allen-Bradley Logix family devices, including devices with firmware v21+.

MicroLogix Connect to MicroLogix 1100, 1200, and 1400 series PLCs.

PLC5 Connect to PLC5s via Ethernet.

SLC Connect to SLC 5/05s via Ethernet.

 

See the following links for detailed step-by-step instructions on how to connect to these PLCs:

Connecting to CompactLogix
Connecting to ControlLogix
Connecting to ControlLogix v21
Connecting to MicroLogix
Connecting to PLC5
Connecting to SLC
ControlNet Example
An ENBT Example
A DH+ Example

 

 



Modbus Driver Module
 

The Modbus Driver module allows the Ignition OPC-UA server to communicate with any device that supports the Modbus protocol, that is, the M
odbus TCP and Modbus RTU over TCP protocols.

The   Driver module can connect directly to devices that support Ethernet communications or it can also connect to   devices through a Modbus Modbus
Gateway device.

See the following sections for detailed step-by-step instructions:

Connecting to Modbus Device
About Modbus Addressing
About Modbus Address Mapping

 

 



Siemens Drivers Module
 

The   Drivers module provides support for connecting to S7-300, S7-400, and S7-1200 PLCs via TCP/IP using the S7 protocol.Siemens

See the following sections for step-by-step instructions on how to connect to these PLCS:

Connecting to S7 Devices
About Siemens Addressing

 

 



UDP and TCP Drivers Module
 

The UDP is a strictly passive listener. The UDP driver is configured to  to one or more ports on a given IP address.listen

The   driver is configured to  to one or more ports on a given IP address. This driver can listen, as well as write back to the connected port.TCP connect

Rules are configured that dictate how the incoming data is interpreted.

For step-by-step instructions on how to connect to TCP Drivers, see .Connecting to TCP Device
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DNP3 Driver Module
 

The DNP3 module allows the Ignition OPC-UA server to communicate with other devices that support the DNP3 protocol (DNP3 outstations).

To connect Ignition to a DNP3 device

Go to the  section of the  webpage.Configure  Gateway
 
Scroll down and select  .OPC-UA > Devices
 
On the  page, find the orange arrow and click on  .Devices  Create new Device
 
On the page, select  , and click  . Add Device Step 1: Choose Type  DNP3 Driver Next
 
On the  page, leave all the default values and type in the following fields:New Device 

Name:DNP3
Hostname: type the IP address, for example 74.125.224.72
Check the box for Show advanced properties? to see the additional settings, but you can keep all the defaults.
 

 Click .Create New Device
The   Devices page is displayed showing the DNP3 device is successfully created and added to Ignition. The Status will show as 
Disconnected and then Connected.

Gateway Settings

General

Name  

Enabled  

Main

Hostname  

Port The port used, default is 20000.

Source Address The address of the master station, default is 3.

Destination Address The address of the outstation, default is 4.

Integrity Poll Interval The interval at which to perform an integrity poll, in millis  3,600,000., default is

Direct Operate Enabled When true, the Direct-Operate function code is used on a write, otherwise Select-Operate is used  true., default is

Unsolicited Messages Enabled When true, the outstation may send unsolicited messages for Class 1, 2, and 3 data  false., default is

Advanced  

Message Fragment Size The maximum size of a message fragment in the application layer, default is 249.

Message Timeout The amount of time to wait for a message response from the outstation, default is 5,000.

Retries The number of retries on a message timeout, default is 0.

Link Layer Confirmation When true, a link layer confirmation will be required from the outstation when sending messages, default is false.

Aliased Points

Aliased points allow the user to assign meaningful names and descriptions to DNP3 points. They are also useful for addressing any points that were 
not returned by the initial integrity-poll on connection.

Point Address The group, variation, and index that fully describe a point.  A full address consists of all three parts:

Group – An integer prefixed with  .  For example, g g40
Variation – An integer prefixed with  . For example, v v2
Index – An integer prefixed with  . For example, i i5

Example: g30v1i20



Path A “/” separated folder hierarchy in which to create the aliased point.
 Example: Facility1/Voltage

Description  A user-defined description of the point mapping.

Point Types

Type Name Group Supported Variations

SinglBitBinaryInput 1 1 - Packed format

2 - With flags

DoubleBitBinaryInput 3 1 - Packed format

2 - With flags

BinaryOutput 10 1 - Packed format

2 - With flags

Counter 20 1 - 32-bit with flags

2 - 16-bit with flags

5 - 32-bit

6 - 16-bit

FrozenCounter 21 1 - 32-bit with flags

2 - 16-bit with flags

5 - 32-bit with flags and time

6 - 16-bit with flags and time

9 - 32-bit

10 - 16-bit

AnalogInput 30 1 - 32-bit with flags

2 - 16-bit with flags

3 - 32-bit

4 - 16-bit

5 - Float with flags

6 - Double with flags

FrozenAnalogInput 31 1 - 32-bit with flags

2 - 16-bit with flags

3 - 32-bit with time of freeze

4 - 16-bit with time of freeze

5 - 32-bit

6 - 16-bit

7 - Float with flags

8 - Double with flags

AnalogOutput 40 1 - 32-bit with flags

2 - 16-bit with flags

3 - Float with flags

4 - Double with flags

OctetString 110 0 - 255



 

When the driver (master) connects to a device (outstation), an integrity poll is performed. Any DNP3 objects returned in the response that fall under 
the above point type categories are mapped to the OPC server with the appropriate index. For example, g40v1i2 corresponds to an analog output 
point, variation 1, index 2.

Internal Indicators

Each response received from a connected outstation will contain an Internal Indication (IIN) bit field.  This field indicates certain states or error 
conditions in the outstation. IINs are mapped to read-only points, indicating the following:

Broadcast message received ( )Broadcast
Additional Class 1, 2, or 3 event data is available ( )Class 1 Events, Class 2 Events, Class 3 Events
Time synchronization required in the outstation ( )Need Time
Some output points are in local mode ( )Local Control
An abnormal condition exists ( )Device Trouble
The outstation device has restarted ( )Device Restart
Function code not implemented ( )No Func Code Support
Object Unknown ( )Object Unknown
Request parameter error ( )Parameter Error
Outstation event buffer overflow ( )Event Buffer Overflow
An operation is already executing ( )Already Executing
Configuration corrupt ( )Config Corrupt

 

Terminology

unsolicited response: An Application Layer message from an outstation to a master for which no explicit request was received.  The request is 
implied by the act of a master enabling unsolicited reporting of various points within an outstation.

integrity poll: Requests all event data, followed by the static data of all points assigned to one of the four classes (static Class 0 or event Class 1, 2, 
or 3).

DNP3TIME: Univeral Coordinated Time (UTC) time expressed as the number of milliseconds since the start of January 1, 1970.  The effective date for 
using the UTC time base is January 1, 2008.  Prior to this, DNP3 did not require a specific time reference.
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Omron Driver
 

The Omron Driver module allows the Ignition OPC-UA server to communicate with NJ-series controllers.

To connect Ignition to an Omron device

Go to the  section of the   webpage.Configure  Gateway
 
Scroll down and select  .OPC-UA > Devices
 
On the  page, find the orange arrow and click on  .Devices  Create new Device
 
On the page, select  , and click  . Add Device Step 1: Choose Type  Omron Driver Next
 
On the  page, leave all the default values and type in the following fields:New Device 

Name: Omron
Hostname: type the IP address, for example 74.125.224.72
Check the box for Show advanced properties? to see the additional settings, but you can keep all the defaults.
 

 Click .Create New Device
The   Devices page is displayed showing the Omron device is successfully created and added to Ignition. 

On the  page, click the tags link next to the newly created device.Devices
The  page is displayed, allowing you to configure which variables in the device will show up as tags in Ignition.Manage Tags

Gateway Settings

General  

Name  

Enabled  

Main  

Hostname The hostname or IP address of the device.

Timeout The request timeout, specified in milliseconds. The default is 2,000.

Concurrency The number of concurrently issued requests allowed. There is a 1:1 correlation between concurrency and the number of CIP 
connections used.

Advanced  

Connection 
Size

The CIP connection size to use. The default (and maximum) is 1,994 bytes.

Slot Number The slot number in the backplane in which the CPU is located.

 

Exporting from the Device

To export variables from Sysmac Studio, navigate to the global variables and select Tools > Export Global Variables > CX-Designer.



The variables will be saved to the clipboard in tab-separated format.  You can now paste the contents into an empty text file for use with importing into 
the Ignition Gateway.

 

Managing Tags

In order to browse tags in the Designer, you must first create a mapping for the device in the gateway.  The  page can be accessed by Manage Tags
navigating to the Omron device and clicking the  link.tags

Importing Tags

Once on the  page, you can manually enter the tags, or import them from a tab-separated file.Manage Tags

When importing, first choose a file, then click the  button.  The default option when importing is to replace the  table with tags from the Import Tags
import.  Select the append option to append tags to the table.



Once you save any changes made to the tag mapping, you can view the tags in the Designer OPC Browser.

Addressing

In the  table of the  page, we have four columns of configuration per tag:Tags Manage Tags

Name - The corresponding address of the variable found in the Omron device.  Struct members are separated with periods.
Datatype - The datatype of the variable found in the Omron device.
Chars - The maximum number of characters that a String tag will contain.
Elements - Denotes whether the tag is considered a scalar or array.  See below for more detail on specifying the number of elements to read 
from the device.
R/W - Specifies read / write access permissions on the tag.

 

Scalars

Leaving the  column blank will result in a scalar tag.  When reading from the device, only one element will be requested.Elements

Arrays

Specify the number of elements in an array in the form of  .  The initial index 0 is always included, so an array mapped with 0..4 elements is a 5 0..N
element array.



Multi-Dimensional Arrays

Multi-dimensional arrays are specified in the same way as arrays, with each group of indices separated with a comma.

 

 

Strings

The number of characters for String variables is specified in the  field.Chars

String arrays are mapped using both the  and  field.Chars Elements

 

Optional Format

Array elements may also be specified with a single number equaling the total number of elements.



Mobile Module
 

The   module adds the ability to launch Vision module projects on modern smartphones. This lets you keep track of your control system while Mobile
moving around your facility. The   module can be combined with remote-access networking architecture to allow global on-the-go access to your Mobile
control system.

How it works

Normally, you can't launch Vision projects on mobile devices. This is because of the technical limitation of Java SE (Standard Edition) which does not 
run on mobile devices. The Mobile module gets around this limitation by launching the Client on the Gateway in a special headless (invisible) 
mode, and then using HTML5 and AJAX to show the Client's screen on the mobile device's browser.

Networking

Typically, the mobile device connects to the Ignition Gateway via the facility's wireless LAN (802.11) infrastructure. To launch a mobile client, the 
mobile device simply connects to the Ignition Gateway by pointing its web browser to the Gateway's LAN address. It is important to understand that 
normally, the traffic is not going over the device's cellular connection. This wouldn't work, because the cellular connection connects to the internet, and 
without explicit setup, an Ignition Gateway is not accessible from the outside internet.

Remote (as in, beyond the reach of 802.11 wireless LAN) mobile access can be enabled through the same networking strategies that enable remote 
access for standard Vision clients. Somehow, the mobile device must be able to access the Ignition Gateway via its cellular connection. One 
strategy would be to set up a VPN router and configure the mobile device as a VPN client. This way, the mobile device could directly access the LAN 
address of the Gateway as if it were on-site. Another technique would be to put the Ignition Gateway in a DMZ so that at least one NIC had a public IP 
address. Or, an edge router could be configured to port-forward the HTTP and HTTPS ports to the Gateway. Coordination with your IT is advised 
when attempting to set up remote access.

 

 



Alarm Notification Module
   

The Alarm Notification module adds the ability to send out email notification messages when alarms 
become active, cleared, or shelved. This module includes several features.

Notification Pipelines

Alarm notification pipelines are logic diagrams that control how alarm notifications are sent out, including 
who they are sent to and when. They can be used to achieve many advanced alarming scenarios, such 
as delays, escalation, and parallel delivery. They are designed using a drag-and-drop designing interface 
through the Ignition Designer.

On-call Roster  

An  (or simply 'roster') is a group of users that will receive the alarm notification. The Alarm on-call roster
Notification Module allows you to configure multiple rosters so only the users you want to receive the 
notifications will be notified. Rosters are created on the Gateway webpage, but can be modified from a 
Client with the Roster Management component. 

User Schedule Integration 

The Alarm Notification Module takes User Schedules  into account. Users on a 
roster that are considered active will be notified, while inactive users will be 
skipped. This way you do not have to change your roster every time a user 
starts or ends their shift.

Two-Way Acknowledgement

The Alarm Notification Module includes the ability to send alarm notifications via email. Users 
who receive these emails are also able to acknowledge the alarm by visiting a link contained in the email.

Product Data Sheet

To see the Product Data Sheet,

click on .Alarm Notification Modules

   

   

http://pages.inductiveautomation.com/rs/inductiveautomation/images/Alarm_Notification_Modules-300DPI.pdf


SMS Notification Module
   

The SMS Notification module adds the ability to send alarm notifications via SMS. The SMS messages 
are sent through a cellular modem, which must be purchased separately and configured with a SIM card 
belonging to an active cellular account. If SMS alarm notification is enabled, recipients of these 
messages can reply with a special code in order to acknowledge the alarm.

Note: The Alarm Notification module is required for the SMS Notification module to work.

Alarm Notification Module Compatibility

The SMS Notification Module is fully compatiblewith the Alarm Notification Module, so all pre-existing on-
call rosters and pipelines will work with SMS notification.

Two-Way Acknowledgement

The SMS Notification Module can be configured to allow users to acknowledge alarms by simply 
responding to the message. With the Two-Way property enabled, the notification is sent out with a 
response code in the message. The user simply replies with the response code and the alarm will be 
acknowledged. 

Audit Log Integration

The SMS Notification module can be configured to log successful message delivery and user 
acknowledgement into any connected database. Once recorded, a simply query will return all notification 
activity.

Product Data Sheet

To see the Product Data Sheet,

click on .Alarm Notification Modules

   

   

http://pages.inductiveautomation.com/rs/inductiveautomation/images/Alarm_Notification_Modules-300DPI.pdf


SFC Module
 

The SFC module adds a powerful programming ability to Ignition called "Sequential Function Charts" or SFCs. A SFC is a series of elements that 
execute in sequential order. The most common of these elements is the Action Step, which can execute any number of python scripts. The chart can 
be configured to execute each Action Step only once, or loop indefinitely.

Easy Flow Control

The chart only proceeds through each element after all tasks in that element have finished. This means that SFCs are perfect for long running tasks 
that must complete in sequence.

Multiple instances

Multiple instances of a chart may be invoked simultaneously, and each instance of the chart runs independently of the other instances. Furthermore 
each chart may be invoke with different starting parameters that may be passed in at will. 

Visualize Work Flow

The SFC module also includes a Vision component: the SFC Monitor. This component allows you to view the realtime status of all running charts, as 
well as the value of any parameters. This way you can easily determine the status of all running charts.

Parallel Tasks

Controlling the execution of multiple scripts that must run in parallel is normally very difficult to achieve, especially if any of those scripts take an 
inconsistent amount of time to complete. However the Parallel Section allows you to run multiple elements simultaneously, and only move on once all 
are finished. You'll never have to worry about checking the status of each element before moving on.

 

 



Enterprise Administration Module
Overview

The Enterprise Administration Module (hereafter abbreviated to EAM) allows a user to control and monitor any number of Ignition Gateways from a central 
Gateway. In EAM terminology, the central Gateway is called a controller, and the monitored Gateways are called agents. The EAM takes advantage of the 
Gateway Network system to seamlessly deliver data between Gateways.

Task Management

EAM allows you to schedule common Gateway tasks to execute against remote agent Gateways. Tasks include agent Gateway restart, backup collection, 
system restoration, module installation, license key activation/unactivation, and project distribution. Tasks can be scheduled to run once at a later time, or 
as part of a recurring schedule.

Agent Events

Every EAM agent sends information to the controller about its general health status. Whenever problems occur on an agent, the controller is notified of the 
agent’s status in the form of agent events. Problems can include high CPU usage on the agent, large numbers of system errors in a short timeframe, and 
unusually high usage of database connections. Loss of connectivity to the agent also triggers an agent event on the controller. Agent events are recorded 
in an external database for analysis and reporting later. Agent events can also be directly configured in the controller to automatically issue alarms to a 
specified alarm pipeline.

Archival and System Recovery

The Collect Backup gateway task does more than simply collect a gateway backup from agents. Whenever the task runs, the gateway backup, all installed 
modules and the current license are collected from the agent and stored in the archive system on the controller. This system allows for quick recovery later 
if an agent machine catastrophically fails and must be reinstalled.



Tag Historian Module
 

The Tag Historian module allows users to quickly and easily setup history logging on any tag. At its core, the  gives a user the ability to Tag Historian
select which tags to store history on, then drag those tags onto a chart or table for viewing. The Tag Historian will automatically partition its data into 
multiple tables, allowing for faster loading of large time spans of data. The Tag Historian module includes the functionality of the Tag History 
Splitter module, allowing you to store history to two separate database connections at the same time.

Tag History

Tag History is configured in the designer on each tag. By opening the tag editor for a tag and navigating to the History section, a user can quickly 
setup tag history by selecting a History Provider, which are automatically created for each database connection that is set up, and opting to store 
history on that tag. There are other settings there such as the Historical Scanclass that determines how often the historian will scan the tag, or the 
Historical Deadband, that is used to determine when a value has actually changed enough to store a historical value.

The Tag Historian uses the scanclass configured on each tags history setting to determine how quickly to scan the tag. When the tag does get 
scanned, the historian uses the Historical Deadband, Historical Deadband Mode, and the Value mode to determine if the value has changed enough 
to store a value to the database. If the value has changed enough, the tag historian will automatically create any necessary tables that have not been 
created, and store the history appropriately.

Gateway Configuration

In addition to the configuration that can be done on an individual tag by tag basis, the historian allows you set some properties that pertain to that 
entire historical provider so that all data that goes through a certain tag provider and onto the database all follow a set of rules. By default, the history 
providers start with partitioning turned on, but this can be turned off, or modified to change how big a partition should be in regards to time. The history 
providers also allow data pruning to be setup, so that all data that is older than a specified time will be deleted automatically. This makes maintaining 
space on the database a little easier, knowing that the historian will always keep itself in check with how large it grows.

Tag History Splitter

The Tag Historian now comes with the Tag History Splitter included in the module. The Tag History Splitter works in the same way that a regular 
historical provider linked to a database works, in that you get to change some settings like data pruning and table partitioning. The difference is that 
when setting up a tag history splitter tag provider, the splitter provider allows you to select two other history providers to forward data to instead of a 
single database connection. So, when setting up history on a tag, the newly created history splitter provider can be selected for that tags historical 
provider allowing that tags history to automatically be stored in two databases at the same time.

The Tag History Splitter is unique in that it allows you to select any two other historical tag providers, even other splitter providers. You could have a 
splitter provider looking at two other splitter providers, allowing for data storage in four different database connections at once.

 

 

 

https://docs.inductiveautomation.com/display/DOC/Tag+Historian+in+Ignition


Additional Modules
 

When we speak of "Addition Modules", we are referring to those Modules that belong to the following two groups of Modules:

1. Modules that are included with the installer but are not automatically installed with the   installation option.Typical

Voice Notification Module
OEE Downtime Module
SPC Module
Recipe/Changeover Module
Track and Trace Module
Web Service Module
Barcode Scanner Module
HASP

2. Modules that are not included with the installer but are available for download.

Voice Notification Module
OPC COM Module
OPC COM Tunneller Module
Web Browser Module
Barcode Scanner Module
WebDev Module
Tag History Splitter Module
Twilio Integration and Alarm Notification
Serial Modules

 

 

In this section ...

 

#
#
#
#
#


Voice Notification Module
   

The Voice Notification module adds the ability to deliver alarm notifications 
to users via telephone, using any SIP compatible phone system. 
Messages are constructed in text, and are delivered through a high quality 
text-to-speech engine. The engine supports multiple  voices and languages 
. Therefore, in order for the voice notification module to work, a compatible 
voice module must also be installed.

 Alarm Notification Module Compatibility

The Voice Notification Module is fully compatible with the Alarm Notification Module, so all pre-existing 
on-call rosters and pipelines will work with Voice notification.

Two-Way Acknowledgement

The Voice Notification Module can be configured to allow users to quickly acknowledge alarms. With the 
Two-Way property enabled, the notification is sent out a response code in the message. The user simply 
replies with the response code and the alarm will be acknowledged.

Custom Notification Messages

The High-Quality Text-to-Speech Engine allows you to customize the alarm message the user hears, so 
you are not limited to a number of pre-recorded messages.

 Audit Log Integration

The Voice Notification module can be configured to log successful message delivery and user 
acknowledgement into any connected database. Once recorded, a simply query will return all notification 
activity.

Multi-Language Support

The following is a list of the different languages in both female and male voices that are offered by 
the Voice Notification module:

Australian Voice Module (Nicole)
Dutch Voice Module (Ruben)
English Voice Module (Salli)
English Voice Module (Jennifer)
English Voice Module (Kimberly)
British English Voice Module (Amy)
Spanish Voice Module (Miguel)
Spanich Voice Module (Penelope)
European Spanish Voice Module (Conchita)
European Spanish Voice Module (Enrique)
French Voice Module (Celine)
French Voice Module (Mathieu)
German Voice Module (Hans)
German Voice Module (Marlene)
Italian Voice Module (Carla)
Italian Voice Module (Giorgio)
Russian Voice Module (Tatyana)

Product Data Sheet

To see the Product Data Sheet,

click on .Alarm Notification Modules

 

   

http://pages.inductiveautomation.com/rs/inductiveautomation/images/Alarm_Notification_Modules-300DPI.pdf


OPC COM Module
   

The OPC-COM module offers Ignition the ability to connect to legacy ("classic") COM-based OPC-
DA servers. It supports OPC-DA 2.0 and 3.0.

Connecting to Classic OPC Servers

With the  -  module installed, there will be a new option for  based   servers when OPC COM COM- OPC
creating a server connection in the Gateway. The  -  module is primarily intended for use with OPC COM
local   servers, although it also provides basic support for remote connections.OPC

Even when connecting locally, the application may run into the traditional difficulties of connecting to   servers. D  security settings on the OPC COM
machine can interfere with connections, and the   Core  ponents package must be properly installed before connections can be established.OPC Com

Using Data from Classic OPC Servers

After a connection to a server has been defined, the server will appear along side of other   servers (both   and UA based) in the   Tag OPC COM OPC
Browser. You can use these tags like any other ones - bring them into Tags, use them in Transaction Groups, and so on.

   

   

Tip

The OPC Com Tunneller 
 simplifies connecting Module

to remote OPC-COM 
servers.



OPC COM Tunneller Module
   

The OPC-COM Tunneler module eliminates many difficulties associated with establishing remote OPC-
COM connections. The OPC-COM Tunneler module exposes OPC-COM connections to Ignition's OPC-
UA server. The connections appear and behave as devices connected to Ignition's OPC-UA server. In 
this way, Ignition manages the OPC-COM connection in the context of the OPC-UA standard resulting 
easier access over the network, eliminating the need to establish remote DCOM connections, and 
incorporating the security benefits of the OPC-UA standard such as authentication and encryption. This 
module can be considered a "UA wrapper" for classic OPC servers.

The following picture illustrates how this module can fit into your architecture.

OPC Com Tunneller

Learn how to configure 
the OPC Com Tunneller 
module.

Link to Knowledge 
Base Article

 

   

   

https://support.inductiveautomation.com/index.php?/Knowledgebase/Article/View/80/0/a-primer-to-the-opc-com-tunneler-module
https://support.inductiveautomation.com/index.php?/Knowledgebase/Article/View/80/0/a-primer-to-the-opc-com-tunneler-module


Web Browser Module
 

The Web Browser module adds a web-browser component to the Vision module. This component allows you to embed other webpages from the 
internet or from your local intranet inside of your projects. The browser is based on the open source project Chromium, and supports modern web 
technology such as HTML5, CSS, and Javascript.

Web Browser Module

About

This module allows users have a web browser component in the Vision module.

System Requirements

Client machines need to meet the following minimum requirements to use this component. The component may not work properly if the requirements 
are not met.

Windows

Microsoft Windows XP (SP2), 7, 8, Vista, Server 2003 (SP1), Server 2008/2012, 32-bit and 64-bit.
Windows version 8 and 8.1 require Java 6 update 38 or greater

Oracle (Sun) JRE 1.6.x and higher, 32-bit and 64-bit.

Linux

Ubuntu 12.04+, Debian 7.7, RedHat Enterprise Linux 7, openSUSE 13.1, Fedora 20, 32-bit and 64-bit
Oracle (Sun) JRE 1.6.x and higher, 32-bit and 64-bit.

Mac OS X

Mac OS X 10.7.x - 10.10.x (Intel)
Apple or Oracle (Sun) JRE 1.6.x and higher, 32-bit and 64-bit.

 

 



Barcode Scanner Module
 

This Barcode Scanner module presents a simple webpage meant for handheld barcode scanners that have an integrated web browser, for example, 
the Intermec CK71. When items are scanned, they queue up to be sent back to the Ignition Gateway, where a python script is called to handle the 
incoming scan. The scanner page is designed to be tolerant of wireless dead zones, queueing up scans until connectivity is restored.

Unique Identifier for each Scanner

Each scanner that navigates to the webpage can be given a unique identifier which ties to a specific scanner. This way multiple scanners can be out 
in the field at once, and the scanned data can be easily tracked to a certain identifier

Custom Actions

Received scans trigger a python script. From this script you can achieve any number of tasks, such as writing to a tag, or inserting a new row into a 
database table.

 

 



WebDev Module
This module allows users to directly program against the web server inside the Ignition Gateway. Webpages can be build by hand using a combination 
of python programming and static web resources such as images, css files, javascript files, and html files.  Likewise, this module allows you to build 
RESTful web service APIs that allow external systems to interact with the Ignition server. This module follows the normal installation process.

Basic Usage

Each type of resource may specify its  . It is important to specify the correct content type for the contents of the resource. When the content type
WebDev module is installed, a new kind of project resource heading will apear in the Designer's project browser called "Web Dev". Right-clicking on 
this heading will allow the creation of three new types of project resources:

Python Resource

Python resources are dynamic web resources. Each time a user browses to the URL associated with a python resource, the script will run and 
generate a response.

File Resource

A file resource is a static resource, usually a binary resources such as an image.

Text Resource

A text resource is a static resource much like a file resource, except that its contents may be directly edited from within the Ignition designer. These 
are useful for static HTML, CSS, and JavaScript files.

URL

Each resource will be directly accessible over HTTP and mounted beneath the/main/system/webdev path.

For example, if you created a Text Resource directly beneath the "Web Dev", it would be mounted at:

http://host:port/main/system/webdev/project/resource_name

Notice that the project name and resource name are part of the path. If your resource is nested inside a folder, it will be part of the path too, for 
example:

http://host:port/main/system/webdev/project/folder_name/resource_name

Web dev resources may have periods in their name. This meas that if you upload an image file, you may include its extension directly in its name so 
that its path is more natural, for example, you might name an image resource "my_image.png" so that its URL is:

http://host:port/main/system/webdev/project/my_image.png

The Web Dev module respects the published vs. staging system of Ignition. If your project is set up to have separate staging and published verions, 
you may access your staging version resources via the URL:

http://host:port/main/system/webdev_staging/project/resource_name

Requests to the root of your project, i.e. will attempt to load a resource named "index.html". If no such resource exists, a 404 response code will be 
returned instead.

http://host:port/main/system/project

Disclaimer

The Web Dev module requires specialized web-programming knowledge. The Inductive Automation support team is unable to provide 
detailed advice about creating a particular site. Furthermore, they are unable to provide troubleshooting beyond the basic functionality of 
the module.



Python Resources

Python resources are the heart of the functionality of the Web Dev module. These resources are completely dynamic, and can handle all parts of the 
HTTP protocol, formulating any type of response.

Each time an incoming HTTP request arrives an a URL where a python resource is mounted, the corresponding python script will be run. Each python 
resource may have up to seven scripts, one for each HTTP method (GET, POST, HEAD, TRACE, etc.). In practice, most python resources will 
probably only implement one or two of these, usually doGet or doPost at a minimum.

Parameters

Each do* method receives the same two parameters: 'request' and 'session'.

Request Parameter

The request parameter is a dictionary with a bunch of information about the incoming web request.

>request['params']

Any URL parameters such as the following:

/main/system/webdev/project/foo?param1=value&param2=other_value

This will be contained in a dictionary accessible via request['params'].  For the given example, request['params'] = {'param1':'value', 
'param2':'other_value'}

request['postData']

This parameter is only present for the doPost method, and its value is different based upon the value of the incoming HTTP request's Content-
Type header. If the content type is application/json, then the request['postData'] will be a python dictionary structure which is the result of parsing the 
json document that was posted. If the content type starts with text/, then the value of request['postData']will be the text which was posted, as a string.

request['headers']

The HTTP   will be in a dictionary under request['headers']. For example, you could read the User-Agent string with request['headers']request headers
['User-Agent'].

request['scheme']

The scheme is available via request['scheme']. The value will be 'http' or 'https'.

request['remoteAddr'] / request['remoteHost']

These two parameters give the remote IP address and host of the entity that made the web request. Note that these are from the perspective of the 
web server, and so may not be what you expect due to the effects of things like NAT-ing routers.

request['servletRequest'] / request['servletResponse']

These two parameters give you direct access to the underlying Java servlet   and   objects.request['context']. This provides direct request response
access to the Ignition GatewayContext. More information about this object may be found in the Ignition SDK developer guide and associated 
JavaDocs.

request['context']

This provides direct access to the Ignition GatewayContext. More information about this object may be found in the Ignition SDK developer guide and 
associated JavaDocs.

Session Parameter

The session parameter is a Python dictionary which may be used to hold information which persists across multiple different calls to your Web Dev 
Python Resource, or across multiple Python Resources. Session management is handled automatically, and this dictionary is created for each new 
client session (the client must have cookies enabled for sessions to work). You may place any key-value pairs in the session dictionary you'd like, just 
make sure that the values are things that can be serialized. All normal python types (scalar, dictionary, lists, and tuples) are serializable.

Return Value

Each do* function on a python resource must generate some sort of HTTP response. This is done by returning a value from the function. The return 
value should always be a dictionary, in which the following keys are recognized. The keys are listed here in the order they are evaluated. For example, 
if you have both file and bytes, only file will take effect. The exception is the contentType key, which may be included with any of the other keys to 
override the default content type.

http://en.wikipedia.org/wiki/List_of_HTTP_header_fields
http://docs.oracle.com/javaee/6/api/javax/servlet/http/HttpServletRequest.html
http://docs.oracle.com/javaee/6/api/javax/servlet/http/HttpServletResponse.html


File:  The value should be a string, which should be the path to a file on the server's filesystem. If no contentType is specified, then the system will 
attempt to probe the content type from the operating system using java.nio.Files.probeContentType. If thefile key is present, but the value points to a 
file that doesn't exist, an HTTP 404 will be returned.

Bytes:  The value should be a byte array. The default content type is application/octet-stream, but you probably want to specify your own.

HTML: The value should be a string, which should be the source of an HTML document. Content type is assumed to be text/html.

JSON: The value is assumed to either be a string (which should be valid json) or to be a python object, which will then be encoded into a json string. 
Content type will beapplication/json

Response: If none of the other keys are present, the system will look for the key response which will be stringified and then returned with the content 
type text/plain.

If your implementation of the do* function returns a dictionary with none of the above keys, an HTTP 500 error will be returned. However, if you return 
None, no HTTP 500 error will be returned. In this case, it is assumed that you used therequest['servletResponse'] parameter to directly formulate your 
HTTP response.

Security Settings

Each python resource can configure its own optional security settings.

Require HTTPS

If this is checked, then the resource will only be accessible via an SSL connection. If a non-secure HTTP transport is used, the browser will be sent a 
redirect to the the gateway's SSL port. The gateway must have SSL enabled, of course.

Require Authentication

 

If this is checked, the resource will require authentication before it executes. This uses HTTP BASIC auth, and so should really be combined with 
the Require HTTPSoption so that the credentials are encrypted. The username/password combination sent through the HTTP BASIC authentication 
headers will then be passed through the chosen User Source. If roles are specified, the user must have at least one of the roles. Specify multiple 
acceptible roles using a comma separated list. If the credentials are missing, an HTTP 401 will be returned with the WWW-Authenticateheader. If the 
credentials are present but incorrect, an HTTP 403 will be returned.

 

If the credentials succeed, the python resource will execute. In addition, the authenticated user object returned by the User Source will be accessible 
inside the session object as session['user']. Since the user is stored in session, if the client has cookies enabled, then further requests against the 
same session will use the stored user object and will not require additional authentication.



Tag History Splitter Module
 

The Tag History Splitter module adds a new type of tag history provider that simply points to two other providers at the same time. Data stored to the 
new provider is "split" to both, storing the same data in each provider.

Record Tag History to Multiple Databases

The Tag History Splitter Module allows data recorded by the Tag Historian module to be inserted into multiple databases simultaneously by way of a 
new "Splitter" Historical Tag Provider. Normally this type of architecture would require scheduled bulk-inserts from one database to another at regular 
intervals, or duplicate tags.

Nested History Providers

It is possible for Splitter providers to record data against other Splitter providers. This allows the history to be recorded in more than two separate 
database connections.

 

 

 



Twilio Integration and Alarm Notification
 

The Twilio Integration and Alarm Notification module adds integration with Twilio via an SMS Alarm Notification Profile and scripting functions to send 
SMS.

Send SMS messages through Scripts

This module unlocks the system.twilio functions. These allow you to send SMS message via python script, and without the use of Alarming.

 

 



Serial Modules
Serial support

The Serial Modules module add serial comm support and system.serial functions to python scripts. These functions allow you to open, read from, write 
to, and close serial ports. More information on these function can be found in the   section of the appendix. system.serial

Multiple Scopes

There are two variants of the Serial Module. Both perform similar functionality, but at different scopes:

The Serial Module Client allows the system.serial functions to be accessed from client based scripts, as well as connect to serial devices 
plugged into the computer running the client
The Serial Module Gateway allows the system.serial functions to be accessed from gateway based scripts, as well as connect to serial 
devices plugged into the gateway server

 

 

 

https://docs.inductiveautomation.com/display/DOC/system.serial


HASP
 

HASP module is a hardware activation key.

 

 



OPC-UA Drivers
 

OPC-UA Driver modules are different than the regular modules because they require the OPC-UA module, and they are focus on establishing 
communications to specific devices.

 

OPC-UA Drivers:
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Tutorials & Helpful Tricks
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Best Practices when Upgrading
Steps to Upgrade

The Ignition installer also doubles as an upgrader. Simply download the executable installer from our website for your operating system.
See the the  for instructions specific to Windows, Linux, and Mac OS X operating systems.upgrade pages

 

 

Regardless of which Operating System you are using, you should follow these steps prior to running the Ignition installer:

Check your versions
Update your License (if needed)
Make a Gateway Backup (most important!)
Update on a Test Server
Upgrade the Production Server

For more information about the changes in each version, see the  page.New in this Version

 

 

Check Versions

Is this is a Major version update or a Minor version update? You can check the version of your Ignition in several ways. The easiest is to log into the C
 section of the  . The version is listed in the main Status page.onfigure Gateway Webpage

Reminder

The bit architecture of the Java and Ignition have to match; servers with only a 64-bit version of Java should use a 64-bit Ignition installer.

https://legacy-docs.inductiveautomation.com/display/DOC/New+in+this+Version


 

It is a   upgrade if only the last number changes. IE: from   to  .MINOR VERSION 7.8.1 7.8.3

Minor version changes are mostly bug fixes. These are minor changes to Ignition and will fall under your existing license.

You   have to update your license.do not

 

It is a   upgrade if one of the first two version numbers changes. IE: from   to  , or from   to  .MAJOR VERSION 7.6 7.7 7.8 8.1

Major version changes are very large changes to Ignition. These will add functionality or change the way some of the systems in Ignition work.

You   have to update your license.do

 

 

Update your License

1) Let us know.

You can reach Inductive Automation by phone at  .(800) 266-7798

Some Major upgrades include new modules or have modified the functionality available in each module. If your license needs to be updated, 
call us and we can guide you through it. If you are updating from one version to the next, or from 7.0.0 all the way to the latest version, we can 



1.  
2.  
3.  
4.  

talk you though what is different and what new functionality is available. See the  page for more specifics about what was New in this Version
updated in the various versions.

There are several ways to get discounted or free Major upgrades, ask your rep for more information.

 

2) Reload your license.

Once your license is updated in our system, go to your Gateway webpage and click the   link there.Update License

See   for a detailed guide.this page

 

 

Make a Gateway Backup

This is the most important step!

Upgrading Ignition is very easy, but you always want to make a backup before any major changes.

Go to the   section of the   and make a backup before changing anything.Configure Gateway Webpage

 

 

Update on a Test Server
 

One of the great things about Ignition is that you can run any Gateway in Trial mode (without a license). That means all you need to do is install on 
another computer and load your backup.

You can download any version of Ignition from the Inductive Automation downloads  .archive page

To load the project on another computer, follow these steps:

Install your original version of Ignition.
Restore the Gateway Backup you just made.
Run the new installer to upgrade your test system (see next step).
Check you projects for errors.

 

It is always a good idea to test your changes before running them in a production environment!

https://legacy-docs.inductiveautomation.com/display/DOC/New+in+this+Version
https://inductiveautomation.com/downloads/archive


 

Upgrade the Production Server

Once you've made a backup, just run the Ignition installer!

The Ignition installer doubles as an upgrader and will automatically check for an existing installation and upgrade any installed modules.



Mapping a Network Drive
 

Windows makes it possible to map drives on network servers to local drive letters so they can be accessed by users as if they were a local drive. The 
problem, however, is that Windows is not very consistent about how it handles such mapped drives when accessed from a Windows Service, such as 
the Ignition Gateway. When the service is started manually, the drives will be available, but when the system is rebooted, the service will no longer be 
able to access them. There may be users that wish to read or write data in Ignition using shared drives, and don't want to manually set up shared 
drives each time.

 

 

To make shared drives available to Ignition on startup, place the following lines in the ignition.conf file, which is located in the data folder of the main 
Ignition installation folder (usually C:\Program Files\Inductive Automation\Ignition\data for Windows users):

//Note that target "Z:" is the drive letter assigned to the mapped drive. 
 
wrapper.share.1.location=\\fileserver\folder
wrapper.share.1.target=Z: 
wrapper.share.1.type=DISK

 

Change the appropriate data for location and target to match the computer's actual setup. If your shared drives require authentication, add the 
following lines, filling in the appropriate data for user, domain, and password:

wrapper.ntservice.account=user
wrapper.ntservice.password=password
wrapper.share.1.account=domain\user
wrapper.share.1.password=password

 

To turn on debugging to see what is causing network share connection issues, make sure to enable wrapper.debug = TRUE by removing the pound 
(#) sign in front of that line of code. The location of the log file is in the main Ignition installation folder as wrapper.log.

 

 

Other Notes:

Un-map drive on shutdown

wrapper.share.1.shutdown.unmap=TRUE

How often to retry server connection:

wrapper.share.1.startup.max_retries=2

What interval (seconds) between retries:

wrapper.share.1.startup.retry_interval=10

Set wrapper to fail to startup if network share not found:

Must be using Ignition at least 7.5 and Java Service Wrapper 3.5.4



 wrapper.share.1.startup.failure=SHUTDOWN

 

Troubleshooting:

Here a couple of the common problems that are encountered when mapping network shares:

 

Server not found
The debug output will show something like this if a drive can't be reached

wrapper | Attempting to map the "\\fileserver\folder" share to "S:"...
wrapper | Unable to map "S:". Attempt #1 (The network name cannot be found. (0x43))
wrapper | Attempting to map the "\\fileserver\folder" share to "S:"...
wrapper | Unable to map "S:". Trying to continue. (The network name cannot be found. (0x43))

Incorrect Login Data
If the configured account or password are incorrect (or are missing) then the mapping will fail with a message like the following:

wrapper | Attempting to map the "\\myfileserver\commonshare" share to "S:"...
wrapper | Unable to map "S:". Trying to continue. (Access is denied. (0x5))
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